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API 文档

简介
最近更新时间：2021-06-04 10:43:59

腾讯云对象存储 COS 使用 XML API，这是一种轻量级的、无连接状态的接口，调用此接口您可以直接通过 

HTTP/HTTPS 发出请求和接受响应，实现与腾讯云对象存储后台的交互操作。

由于使用了不同的数据传输框架，对象存储 COS 提供了独立于云 API 的接口和独立的 SDK，您可直接前往 COS 

的 API 操作列表  了解详情，或前往 COS 的 SDK 列表  下载您需要的 SDK。云 API 的指南和对应的 SDK 不包

含对象存储 COS 的操作功能。

您也可以通过以下视频了解对象存储 API：

注意

如您已开始使用腾讯云 COS API，即代表您已阅读并同意 《腾讯云服务协议》  和 《腾讯云对象存储

服务等级协议》 。

COS 的可用地域（Region）的详细信息请查阅 地域和访问域名  文档。 

在使用 API 或 SDK 发起请求前，建议您阅读 创建请求概述  文档了解发起访问的域名、安全鉴权概念

以及内外网访问检查等信息。

COS 存在 XML 和 JSON 两个不同版本的 API，两个版本的接口协议并不相同，但访问的数据互

通，需要注意的是历史版本的 JSON API 将不再提供继2018年之后推出的新功能。

如果您需要获得 JSON 格式的响应，推荐您使用 COS SDK ，在 SDK 中可以设置响应体为 JSON 

格式的响应。

其他腾讯云产品的 API 格式，请参见 API 中心介绍 。

https://cloud.tencent.com/document/product/436/10111
https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/301/1967
https://cloud.tencent.com/document/product/436/6227
https://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/31315
https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/api
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COS 支持的 API 接口请参见 操作列表 。

使用 API 接口时会出现一些主要概念和术语，请见下表：

API 概览

术语信息

名称 描述

APPID
开发者访问 COS 服务时拥有的用户维度唯一资源标识，用以标识资源，可在 API 密钥管理  

页面获取

SecretI

d
开发者拥有的项目身份识别 ID，用于身份认证，可在 API 密钥管理  页面获取

Secret

Key
开发者拥有的项目身份密钥，可在 API 密钥管理  页面获取

Bucket 存储桶，COS 中用于存储数据的容器。有关存储桶的进一步说明，请参见 存储桶概述  文档

Bucket

Name-

APPID

存储桶名称格式，用户在使用 API、SDK 时，需要按照此格式填写存储桶名称。例如 

examplebucket-1250000000，含义为该存储桶 examplebucket 归属于 APPID 为

1250000000的用户

Object 对象，COS 中存储的具体文件，是存储的基本实体

Object

Key

对象键，对象（Object）在存储桶（Bucket）中的唯一标识。有关对象与对象键的进一步说

明，请参见 对象概述  文档

Region
地域信息，枚举值可参见 可用地域  文档，例如：ap-beijing、ap-hongkong、eu-

frankfurt 等

ACL
访问控制列表（Access Control List），是指特定 Bucket 或 Object 的访问控制信息列

表

CORS
跨域资源共享（Cross-Origin Resource Sharing）指发起请求的资源所在域不同于该请

求所指向资源所在的域的 HTTP 请求

Multipa

rt 

Upload

s

分块上传，腾讯云 COS 服务为上传文件提供的一种分块上传模式

https://cloud.tencent.com/document/product/436/10111
https://console.cloud.tencent.com/capi
https://console.cloud.tencent.com/capi
https://console.cloud.tencent.com/capi
https://cloud.tencent.com/document/product/436/13312
https://cloud.tencent.com/document/product/436/13324
https://cloud.tencent.com/document/product/436/6224
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要使用腾讯云对象存储 API，需要先执行以下步骤：

1. 在腾讯云 对象存储控制台  开通腾讯云对象存储（COS）服务。

2. 在腾讯云 对象存储控制台  创建一个 Bucket。

3. 在访问管理控制台中的 API 密钥管理  页面里获取 APPID，并创建 SecretId、SecretKey。

4. 编写一个请求签名算法程序（或使用任何一种服务端 SDK），详情请参见 请求签名  文档。

5. 计算签名，调用 API 执行操作。

请查看 历史版本 API 简介 。

Object 

Conten

t

Object Content 是上传文件的二进制内容

快速入门

历史版本 API

https://console.cloud.tencent.com/cos5
https://console.cloud.tencent.com/cos5
https://console.cloud.tencent.com/capi
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/6052
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公共请求头部
最近更新时间：2023-08-07 17:05:31

此篇文档将为您介绍在使用 API 时候会使用到的公共请求头部（Request Header），下文提到的头部在之后的

具体 API 文档中不再赘述。

描述

请求头部列表

Header 名称 描述
类

型
是否必选

Authorizati

on

携带鉴权信息，用以验证请求合法性的签名信

息；

针对公有读的对象可不携带此头部，如通过请

求参数传递鉴权信息也无需携带此头部，详情

请参见 请求签名  文档

str

ing

是，

针对公有读的对象或通过请

求参数传递鉴权信息，此头

部为可选项

Content-

Length

RFC 2616中定义的 HTTP 请求内容长度

（字节）

int

eg

er

针对 PUT 和 POST 请

求（指定 Transfer-

Encoding 请求头部的 

PUT Object 请求除

外），此头部是必选项

针对 GET、HEAD、

DELETE 和 

OPTIONS 请求，不能

指定此头部

Content-

Type

RFC 2616中定义的 HTTP 请求内容类型

（MIME）例如application/xml 或 

image/jpeg

str

ing

针对有请求体的 PUT 和 

POST 请求，此头部是

必选项

针对 GET、HEAD、

DELETE 和 

OPTIONS 请求，不能

指定此头部

Content-

MD5

RFC 1864中定义的请求体内容的16字节二进

制 MD5 哈希值的 Base64 编码形式，用于

完整性检查，验证请求体在传输过程中是否发

生变化，最终的取值长度应为24个字符，请注

意在编写代码时使用正确的方法和参数，例如 

ZzD3iDJdrMAAb00lgLLeig==

str

ing

针对有请求体的 PUT 和 

POST 请求（除 POST 

Object），此头部是必

选项

针对 GET、HEAD、

DELETE 和 

https://cloud.tencent.com/document/product/436/7778
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对于支持服务端加密（Server Side Encryption，SSE）的接口，根据不同的加密方式适用如下请求头部，请参

阅具体的接口文档确定是否适用 SSE。下列头部的是否必选仅针对使用 SSE 的场景，如果请求不支持 SSE 的接

口或不使用 SSE ，则以下头部均无需携带。详情请参见 服务端加密概述 。

OPTIONS 请求，不能

指定此头部

Date
RFC 1123中定义的 GMT 格式当前时间，例

如 Wed，29 May 2019 04:10:12 GMT

str

ing
否

Host
请求的主机，形式为<BucketName-

APPID>.cos.<Region>.myqcloud.com

str

ing
是

x-cos-

security-

token

使用临时安全凭证时需要传入的安全令牌字

段，详情请参见 临时安全凭证  相关说明

str

ing

否，

当使用临时密钥并通过 

Authorization 携带鉴权信

息时，此头部为必选项

服务端加密专用头部

SSE-COS

Header 名称 描述 类型 是否必选

x-cos-server-

side-

encryption

服务端加密算

法，使用 

SSE-COS 时

指定为：

AES256

stri

ng

上传或复制对象（包括简单上传/复制与分块上传/复

制）时携带此头部则使用 SSE-COS 加密，不携带

此头部会以存储桶加密配置来加密。下载对象时不能

指定此头部

SSE-KMS

Header 名称 描述
类

型
是否必选

x-cos-server-side-

encryption

服务端加密算法，使用 SSE-KMS 时

指定为：cos/kms

str

ing

上传或复制对象

（包括简单上传/

复制与分块上传/

复制）时携带此

头部则使用 

SSE-KMS 加

密，不携带此头

部会以存储桶加

密配置来加密。

下载对象时不能

指定此头部

https://cloud.tencent.com/document/product/436/18145
https://cloud.tencent.com/document/product/436/31315#.E4.B8.B4.E6.97.B6.E5.AE.89.E5.85.A8.E5.87.AD.E8.AF.81
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对于支持设置对象锁定的接口，支持使用以下对象锁定头部用于在上传对象的同时添加锁定。下列头部的是否必选仅

针对使用对象锁定的场景，详情请参见 对象锁定概述。

x-cos-server-side-

encryption-cos-kms-

key-id

当 x-cos-server-side-

encryption 值为 cos/kms 时，用于

指定 KMS 的用户主密钥 CMK，如不

指定，则使用 COS 默认创建的 CMK，

更多详细信息可参见 SSE-KMS 加密

str

ing
否

x-cos-server-side-

encryption-context

当 x-cos-server-side-

encryption 值为 cos/kms 时，用于

指定加密上下文，值为 JSON 格式加密

上下文键值对的 Base64 编码。

例如

eyJhIjoiYXNkZmEiLCJiIjoiMTIzMzIxI

n0=

str

ing
否

SSE-C

Header 名称 描述 类型
是否必

选

x-cos-server-side-

encryption-customer-

algorithm

服务端加密算法，目前仅支持 AES256
strin

g
是

x-cos-server-side-

encryption-customer-key

服务端加密密钥的 Base64 编码

例如

MDEyMzQ1Njc4OUFCQ0RFRjAxMjM0N

TY3ODlBQkNERUY=

strin

g
是

x-cos-server-side-

encryption-customer-key-

MD5

服务端加密密钥的 MD5 哈希值，使用 

Base64 编码

例如 U5L61r7jcwdNvT7frmUG8g==

strin

g
是

对象锁定专用头部

名称 描述 类型 是否必选

x-cos-

object-

lock-

retain-

until-date

设定对象锁定期限。时间戳，用于设置保留期限的具体时

间，以 ISO8601 标准表示，并需要使用 UTC 时间。例

如 2022-02-17T10:30:09.000Z

Stri

ng
是

https://cloud.tencent.com/document/product/436/55294
https://cloud.tencent.com/document/product/436/18145#sse-kms-.E5.8A.A0.E5.AF.86
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x-cos-

object-

lock-

mode

设定对象锁定的模式，支持 COMPLIANCE  模式。 Stri

ng

是
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公共响应头部
最近更新时间：2021-06-16 17:06:40

此篇文档将为您介绍在使用 API 时会出现的公共响应头部（Response Header），下文提到的头部在后续的具

体 API 文档中不再赘述。

描述

响应头部列表

Header 名

称
描述 类型

Content-

Length
RFC 2616 中定义的 HTTP 响应内容长度（字节）。

stri

ng

Content-

Type
RFC 2616 中定义的 HTTP 响应内容类型（MIME）。

stri

ng

Connecti

on

RFC 2616 中定义，表明响应完成后是否会关闭网络连接。枚举值：keep-

alive，close。

enu

m

Date
RFC 1123 中定义的 GMT 格式服务端响应时间，例如Wed, 29 May 2019 

04:10:12 GMT。

stri

ng

ETag

ETag 全称为 Entity Tag，是对象被创建时标识对象内容的信息标签，可用于检

查对象的内容是否发生变化，例

如"8e0b617ca298a564c3331da28dcb50df"。此头部并不一定返回对象的 

MD5 值，而是根据对象上传和加密方式而有所不同。如果您需要校验上传到云端

的文件和本地文件的一致性，我们推荐您使用 x-cos-hash-crc64ecma 头部

中的 CRC64编码进行校验。

stri

ng

Last-

Modified
对象的最近一次上传的时间，例如Fri, 10 Apr 2020 18:17:25 GMT。

stri

ng

Server 接收请求并返回响应的服务器的名称，默认值：tencent-cos。
stri

ng

Transfer-

Encoding
RFC 2616 中定义的传输编码格式。

stri

ng

x-cos-

hash-

crc64ec

ma

对象的 CRC64 值，详情请参见 CRC64 校验  文档。
inte

ger

https://cloud.tencent.com/document/product/436/40334
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对于支持服务端加密（Server Side Encryption，SSE）且在请求中使用了服务端加密的接口，将根据具体的加

密类型返回以下响应头，详情请参见 服务端加密概述 。

x-cos-

request-

id

每次请求发送时，服务端将会自动为请求生成一个 ID。 stri

ng

x-cos-

trace-id

每次请求出错时，服务端将会自动为这个错误生成一个 ID。仅当请求出错时才会

在响应中包含此头部。

stri

ng

服务端加密专用头部

SSE-COS

Header 名称 描述
类

型

x-cos-

server-

side-

encryption

当上传对象时使用了 SSE-COS，或者下载经过 SSE-COS 加密的对象时，

请求的响应均会返回此头部，用于表明对象上传时使用的服务端加密算法。

str

ing

SSE-KMS

Header 名称 描述
类

型

x-cos-server-side-

encryption

当上传对象时使用了 SSE-KMS，或者下载经过 SSE-KMS 加密的

对象时，请求的响应均会返回此头部，用于表明对象上传时使用的服务

端加密算法。

s

tr

in

g

x-cos-server-side-

encryption-cos-

kms-key-id

返回 KMS（密钥管理系统）的用户主密钥 CMK。如未指定，则返回 

COS 默认创建的 CMK。

s

tr

in

g

SSE-C

Header 名称 描述
类

型

https://cloud.tencent.com/document/product/436/18145
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x-cos-server-side-

encryption-customer-

algorithm

当上传对象时使用了 SSE-C，或者下载经过 SSE-C 加密的对象

时，请求的响应均会返回此头部，用于表明对象上传时使用的服务端

加密算法。

s

tr

in

g

x-cos-server-side-

encryption-customer-

key-MD5

对象上传时使用的服务端加密密钥的 MD5 哈希值，使用 Base64 

编码

例如 U5L61r7jcwdNvT7frmUG8g== 。

s

tr

in

g
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错误码
最近更新时间：2022-03-29 10:28:13

本文将为您介绍请求出错时返回的错误码和对应错误信息。

Content-Type：application/xml

对应 HTTP 状态码：3XX，4XX，5XX。对于 PUT Object - Copy  接口，即使 HTTP 状态码为200也有可

能在响应体中包含错误。

具体的节点描述如下：

Container 节点 Error 的内容：

概述

错误响应

响应体

<?xml version='1.0' encoding='utf-8' ?>

<Error>

            <Code>string</Code>

            <Message>string</Message>

            <Resource>string</Resource>

            <RequestId>string</RequestId>

            <TraceId>string</TraceId>

</Error>

节点名称（关键字） 父节点 描述 类型

Error 无 包含所有的错误信息 Container

节点名称

（关键字）

父

节

点

描述
类

型

Code

Er

ro

r

错误码，用来定位唯一的错误条件和确定错误场景，具体错误码见下文

str

in

g

Message Er

ro

具体的错误信息 str

in

https://cloud.tencent.com/document/product/436/10881
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r g

Resource

Er

ro

r

请求的资源，存储桶地址或对象地址

str

in

g

RequestId

Er

ro

r

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题时，该 ID 

能更快地协助 COS 定位问题

str

in

g

TraceId

Er

ro

r

每次请求出错时，服务端将会自动为这个错误生成一个 ID，遇到问题时，

该 ID 能更快地协助 COS 定位问题

str

in

g

错误码列表

4XX 类型错误

HTTP 状态

码
错误码 描述

400 Bad 

Request

ActionAccel

erateNotSu

pported

加速域名不支持该操作

400 Bad 

Request

Attachment

Full
ACL 和 Policy 数量到达上限。详情请参见 规格与限制

400 Bad 

Request
BadDigest

提供的 Content-MD5  值与服务端收到的请求体的 MD5 哈希值不

一致

400 Bad 

Request
BadRquest 参数错误

400 Bad 

Request

BucketAcc

elerateNotE

nabled

该存储桶未启用加速域名

400 Bad 

Request

BucketNam

eTooLong
存储桶名称过长。详情请参见 存储桶命名规范

400 Bad 

Request

BucketVers

ionNotOpen
存储桶未启用版本控制

400 Bad 

Request

DNSRecord

VerifyFailed

DNS 记录验证失败，请添加 CNAME 或 TXT 记录。DNS 记录可能

需要最多10分钟生效

https://cloud.tencent.com/document/product/436/14518
https://cloud.tencent.com/document/product/436/7728#.E8.AF.B7.E6.B1.82.E5.A4.B4.E9.83.A8.E5.88.97.E8.A1.A8
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
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400 Bad 

Request

EntitySizeN

otMatch

请求体大小与 Content-Length  请求头不符

400 Bad 

Request

EntityTooLa

rge
上传的对象大小超过规定的最大值。详情请参见 规格与限制

400 Bad 

Request

EntityTooS

mall

上传的对象大小不足规定的最小值，常见于分块上传。详情请参见 规

格与限制

400 Bad 

Request

ExpiredTok

en
临时密钥 Token 已过期

400 Bad 

Request

ImageResol

utionExcee

d

图片分辨率超出限制或动图帧数过多

400 Bad 

Request

ImageTooL

arge
图片超过限制大小

400 Bad 

Request

Incomplete

Body
请求体大小小于 Content-Length  请求头

400 Bad 

Request

IncorrectNu

mberOfFile

sInPostReq

uest

POST Object 请求每次只允许上传一个对象

400 Bad 

Request

InvalidArgu

ment
请求参数不合法，请确认是否允许携带该请求参数

400 Bad 

Request

InvalidBuck

etName
存储桶名称不合法。详情请参见存储桶 命名规范

400 Bad 

Request

InvalidCopy

Source
复制对象源不合法

400 Bad 

Request

InvalidDelim

iter
分隔符（delimiter）参数不合法，分隔符只能为一个字符

400 Bad 

Request

InvalidDiges

t
给定的 Content-MD5  值不合法

400 Bad 

Request

InvalidImag

eFormat
图片格式不合法

400 Bad 

Request

InvalidImag

eSource
图片源不合法

https://cloud.tencent.com/document/product/436/7728#.E8.AF.B7.E6.B1.82.E5.A4.B4.E9.83.A8.E5.88.97.E8.A1.A8
https://cloud.tencent.com/document/product/436/14518
https://cloud.tencent.com/document/product/436/14518
https://cloud.tencent.com/document/product/436/7728#.E8.AF.B7.E6.B1.82.E5.A4.B4.E9.83.A8.E5.88.97.E8.A1.A8
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
https://cloud.tencent.com/document/product/436/7728#.E8.AF.B7.E6.B1.82.E5.A4.B4.E9.83.A8.E5.88.97.E8.A1.A8
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400 Bad 

Request

InvalidLocat

ionConstrai

nt

指定的 location 不合法

400 Bad 

Request

InvalidObje

ctName
对象名称不合法。详情请参见 对象键

400 Bad 

Request
InvalidPart 分块缺失

400 Bad 

Request

InvalidPart

Order
分块的编号不连续

400 Bad 

Request

InvalidPicO

perations
Pic-Operations 请求头不合法

400 Bad 

Request

InvalidPolic

yDocument
POST Object 请求中的策略（Policy）不合法

400 Bad 

Request

InvalidRegi

onName
不合法的地域名。详情请参见 地域和访问域名

400 Bad 

Request

InvalidRequ

est
请求不合法

400 Bad 

Request

InvalidSHA1

Digest
请求内容 SHA1 校验不合法

400 Bad 

Request
InvalidTag 存储桶标签不合法。详情请参见 存储桶标签概述 

400 Bad 

Request

InvalidTarg

etBucketFo

rLogging

用于存放日志的目标存储桶不合法，目标存储桶必须与当前存储桶在同

一个地域

400 Bad 

Request

InvalidUplo

adStatus
当启用版本控制时不能使用 JSON API 上传对象，请使用 XML API

400 Bad 

Request
InvalidURI URI 不合法

400 Bad 

Request

InventoryFu

ll
清单任务数量已达到限制。清单任务上限1000条

400 Bad 

Request

JsonAPINot

SupportOn

MAZBucket

JSON API 不支持操作多 AZ 存储桶，请使用 XML API

https://cloud.tencent.com/document/product/436/13324#.E5.AF.B9.E8.B1.A1.E9.94.AE
https://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/34834
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400 Bad 

Request

KeyTooLon

g

对象键过长。详情请参见 对象键

400 Bad 

Request

KmsExcepti

on
密钥管理服务异常

400 Bad 

Request

KmsKeyDis

abled
提供的密钥已被禁用

400 Bad 

Request

KmsKeyNot

Exist
提供的密钥不存在

400 Bad 

Request

ListPartUpl

oadIdIsEmp

ty

UploadId 为空

400 Bad 

Request

LoggingCon

fExists
日志配置已存在

400 Bad 

Request

LoggingPref

ixInvalid
日志前缀参数不合法

400 Bad 

Request

MalformedP

olicy
策略格式不合法

400 Bad 

Request

MalformedP

OSTReques

t

该 POST 请求的请求体内容不合法

400 Bad 

Request

Malformed

XML
请求体的 XML 格式不符合 XML 语法

400 Bad 

Request

MAZOperati

onNotSupp

ortOnOAZB

ucket

单可用区（单 AZ）存储桶不支持多可用区（多 AZ）操作。关于多 

AZ 特性及使用限制的说明请参见 多 AZ 特性概述  

The multiple availability zones operation is not supported 

by single availability zone bucket

400 Bad 

Request

MissingReq

uestBodyEr

ror

请求体缺失

400 Bad 

Request

MultiAZFeat

ureNotSupp

ort

当前地域不支持多可用区

400 Bad 

Request

MultiBucket

NotSupport
跨地域复制只能设置一个目的存储桶

https://cloud.tencent.com/document/product/436/13324#.E5.AF.B9.E8.B1.A1.E9.94.AE
https://cloud.tencent.com/document/product/436/40548
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400 Bad 

Request

NotifyRuleE

ventConflict

通知规则 Event 冲突

400 Bad 

Request

NotifyRuleP

refixConflict
通知规则 Prefix 冲突

400 Bad 

Request

NotifyRuleS

uffixConflict
通知规则 Suffix 冲突

400 Bad 

Request

NotSupport

edStorageC

lass

指定的 存储类型  不支持

400 Bad 

Request

OAZOperati

onNotSupp

ortOnMAZB

ucket

多可用区存储桶不支持单可用区操作。关于多 AZ 特性及使用限制的说

明请参见 多 AZ 特性概述  

The single availability zone operation is not supported by 

multiple availability zones bucket

400 Bad 

Request
PolicyFull ACL 和 Policy 数量到达上限。详情请参见 规格与限制

400 Bad 

Request

PolicyVersi

onFull
Policy 版本数量到达上限

400 Bad 

Request

RequestTim

eout
请求超时

400 Bad 

Request

SsecDecryp

tHeaderInv

alid

源文件使用 SSE-C 加密，需要在请求头中提供相同的密钥

400 Bad 

Request

SSEConten

tNotSuppor

ted

加密方式不支持

400 Bad 

Request

SSEHeader

NotAllowed
该操作不支持指定的服务端加密头部

400 Bad 

Request

TargetBuck

etNameInva

lid

目标存储桶名称不合法。详情请参见存储桶 命名规范

400 Bad 

Request

TooManyBu

ckets
存储桶数目达到上限200

400 Bad 

Request

Unexpected

Content
请求不支持相关内容

https://cloud.tencent.com/document/product/436/33417
https://cloud.tencent.com/document/product/436/40548
https://cloud.tencent.com/document/product/436/14518
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
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400 Bad 

Request

UserCname

Invalid

用户指定的 CNAME 不存在或不合法

400 Bad 

Request

UserNetwor

kTooSlow
用户的网络速度过慢

400 Bad 

Request

VerifyAlgori

thmNotSup

ported

校验算法不支持

400 Bad 

Request

WebsiteUR

LInvalid
自定义域名 URL 不合法

400 Bad 

Request

XMLSizeLi

mit
XML 长度超过限制

402 

Payment 

Required

PaymentRe

quired
超出费用配额限制

403 

Forbidden

AccessDeni

ed
签名或者权限不正确，拒绝访问。请参考 请求签名  和 ACL 概述

403 

Forbidden

AccessForb

idden

跨域资源共享（CORS）请求被拒绝，请检查请求方法或请求头部中的 

Origin、Access-Control-Request-Method、Access-

Control-Request-Headers 是否在配置的 CORS 白名单中

403 

Forbidden

InvalidAcce

ssKeyId
SecretID 不存在

403 

Forbidden

InvalidObje

ctState
对象存储类型与操作请求冲突

403 

Forbidden

NoProcess

Authority
没有处理图片的权限

403 

Forbidden

RequestTim

eTooSkewe

d

本地时间与服务器时间相差过大，超过15分钟

403 

Forbidden

Request 

has expired

发起请求的时间超过了签名的有效时间，或者本地系统时间和所在时区

的时间不一致。详情请参见 常见问题

403 

Forbidden

SignatureD

oesNotMat

ch

客户端计算的签名与 COS 服务端计算的签名不一致。请参阅 请求签

名  文档并借助 COS 请求签名工具  检查自行实现的签名过程

403 UserNotSo 当前用户不是源存储桶的拥有者

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/30752
https://cloud.tencent.com/document/product/436/30746#.E8.B0.83.E7.94.A8-api-.E6.8E.A5.E5.8F.A3.E6.97.B6.EF.BC.8C.E5.87.BA.E7.8E.B0.E2.80.9Crequest-has-expired.E2.80.9D.E7.AD.89.E9.94.99.E8.AF.AF.E4.BF.A1.E6.81.AF.EF.BC.8C.E8.AF.A5.E5.A6.82.E4.BD.95.E5.A4.84.E7.90.86.EF.BC.9F
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/30442
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Forbidden urceBucket

Owner

403 

Forbidden

UserNotTar

getBucketO

wner

当前用户不是目标存储桶的拥有者

404 Not 

Found

InventoryC

onfiguration

NotFoundEr

ror

清单配置未找到

404 Not 

Found

NoBucketQ

uotaPolicy
存储桶配额策略不存在

404 Not 

Found

NoSuchBuc

ket
指定的存储桶不存在

404 Not 

Found

NoSuchCop

ySource
复制对象源不存在

404 Not 

Found

NoSuchCO

RSConfigur

ation

指定的跨域资源共享配置不存在

404 Not 

Found

NoSuchEnc

ryptionConfi

guration

指定的存储桶加密配置不存在

404 Not 

Found
NoSuchJob 指定的批量处理任务不存在

404 Not 

Found
NoSuchKey 指定的对象键不存在。检查对象是否存在请使用 HEAD Object  接口

404 Not 

Found

NoSuchLife

cycleConfig

uration

指定的生命周期配置不存在

404 Not 

Found

NoSuchObj

ectLockCon

figuration

指定的对象锁定配置不存在

404 Not 

Found

NoSuchPoli

cyVersion
指定的策略版本不存在

404 Not 

Found

NoSuchTag

Set

指定的标签集合不存在

https://cloud.tencent.com/document/product/436/7745
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404 Not 

Found

NoSuchUpl

oad
分块上传时指定的 UploadId 不存在

404 Not 

Found

NoSuchVer

sion
指定版本不存在

404 Not 

Found

NoSuchWe

bsiteConfig

uration

指定的静态网站配置不存在

404 Not 

Found

OriginConfi

gurationNot

FoundError

回源配置未找到

404 Not 

Found

Replication

Configurati

onNotFoun

dError

跨地域复制配置未找到

405 

Method 

Not 

Allowed

MethodNot

Allowed
此资源不支持该 HTTP 方法

405 

Method 

Not 

Allowed

RestoreNon

ArchiveObj

ect

不允许对非归档对象进行回热（恢复）

405 

Method 

Not 

Allowed

UploadIdNo

tSupported
指定的 UploadId 由 JSON API 生成，不能使用 XML API 操作

409 

Conflict

AppendPosi

tionErr
Append 操作时，对象长度和 Position 不一致

409 

Conflict

BucketAlre

adyExists
指定的存储桶已存在

409 

Conflict

BucketAlre

adyOwned

ByYou

指定的存储桶已存在且由当前帐户创建

409 

Conflict

BucketLock

ed
存储桶已锁定，不能操作跨地域复制或生命周期
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409 

Conflict

BucketNotE

mpty

存储桶不为空

409 

Conflict

DomainCon

figConflict
域名配置冲突，请删除冲突的记录

409 

Conflict

InvalidBuck

etState
存储桶状态与操作请求冲突，例如版本控制管理与跨地域复制的冲突

409 

Conflict

InvalidLock

edTime
对象锁定时间无效

409 

Conflict

ObjectLock

ed

对象已锁定，不允许覆盖上传或删除该对象，也不允许通过复制修改该

对象的元数据

409 

Conflict

InvalidObje

ctState
对象状态与操作请求冲突

409 

Conflict

PathConflic

t
存在同名对象的毫秒级并发冲突

409 

Conflict

QuotaConfli

ct
配额冲突

409 

Conflict

QuotaOper

ationConflic

t

该存储桶的状态不适用于该操作

409 

Conflict

RecordAlre

adyExist
DNS 记录冲突，请删除冲突的记录，或添加 CNAME/TXT 记录

409 

Conflict

RestoreAlre

adyInProgr

ess

该对象正在回热（恢复）中

409 

Conflict

UploadConf

lict
同一个对象键频繁上传会导致冲突

409 

ObjectNot

Appendale

ObjectNotA

ppendable
指定的对象不能追加

411 Length 

Required

MissingCon

tentLength
Content-Length  请求头部缺失

412 

Preconditi

on Failed

Preconditio

nFailed
前置条件不匹配

https://cloud.tencent.com/document/product/436/7728#.E8.AF.B7.E6.B1.82.E5.A4.B4.E9.83.A8.E5.88.97.E8.A1.A8
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416 

Requeste

d Range 

Not 

Satisfiable

InvalidRang

e

请求的对象范围不合法

451 

Unavailabl

e For 

Legal 

Reasons

DomainAudi

tFailed
域名未备案

451 

Unavailabl

e For 

Legal 

Reasons

Unavailable

ForLegalRe

asons

当前服务不可用，请检查账号是否欠费，若无欠费可通过 内容合规  查

看是否存在违规内容

5XX 类型错误

HTTP 状态码 错误码 描述

500 Internal Server 

Error
InternalError 服务端内部错误

500 Internal Server 

Error

KmsInternalExceptio

n
查询密钥管理服务时发生服务端内部错误

501 Not Implemented NotImplemented 请求尚未实现

503 Service Unavailable KmsFreqControl
请降低使用密钥管理服务的请求的访问频

率

503 Service Unavailable ServiceUnavailable 服务暂不可用，请重试

503 Service Unavailable SlowDown 请降低访问频率

数据处理相关错误码

图片下载时处理错误码

错

误

码

说明 处理措施

-1 无效的请求；请求报文无法识别。 请检查请求内容。

https://console.cloud.tencent.com/cos5/compliance
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03

-1

04

无效的 APPID，URL 中包含的 APPID 无效，或者域

名没有和 APPID 绑定。
请检查 APPID 是否正确。

-1

05

无效的样式名，URL 中指定的样式名或者别名没有配

置。
请检查样式配置或样式名内容。

-1

06
无效的 URL，URL 格式不符合格式要求。 请检查 URL 格式。

-1

07
无效的 Host 头域。 请检查 Host 是否正确。

-1

08
无效的 Referer。 请检查相关 Referer 配置。

-1

09

无效的样式名 ID。没有找到该样式名对应的图片。可能

是上传该图片后，新增的样式名， 因此图片上传时不能

生成该样式名对应的数据。

-

-11

0
该图片在黑名单中。 -

-11

3
该文档的类型不支持

文档预览目前所支持的输入文件类型，

请参见 规则与限制

-1

20

回源到源站获取数据时，源站返回的数据有异常，无法

正常获取到图片数据。
请检查源站数据。

-1

24

下载偏移错误。HTTP 请求的 Range 断点续传偏移量

可能设置错误。
请检查断点续传偏移量的相关配置。

-1

54
原图保护机制禁止该 URL 下载。 请使用样式访问。

-1

56
强制执行302流程。 -

-1

62
业务配置为欠费，禁止下载图片。 请及时充值。

-1

63
业务配置不存在。 请检查相关配置项。

-1

64
热图下载，限制。

请降低请求频率，或 提交工单  联系我

们处理。

https://cloud.tencent.com/document/product/460/36620
https://console.cloud.tencent.com/workorder/category
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-1

65

攻击性下载请求，限制。 -

-1

66
消息格式错误。 -

-1

67
文件太大，无法支持图片下载。 请降低图片大小。

-1

68
文件太大，无法支持图片下载。 请降低图片大小。

-4

41
图片格式不符，无法进行压缩。

请使用数据万象支持的图片格式进行图

片处理操作。具体支持格式为 jpg、

bmp、gif、png、webp。

-4

42
图片超过限制大小。 请将图片长宽限制在9999像素以内。

-4

43
图片格式不满足处理限制。

请使用支持的图片格式进行处理，详情

请参见 规则与限制

-4

47
图片分辨率超出限制或动图帧数过多。

请将图片长宽限制在9999像素以内

（动图请限制帧数）。

-9

01
压缩超时。 -

-9

02

回源超时，镜像存储功能把请求转发到开发商源站，但

没有收到响应，超时了。
请检查源站数据或回源配置。

-3

00

6

该文档被加密，无法解析。 -

-3

00

8

该文件为空文件，无法解析。 -

-3

011
该文档的类型不支持。

文档预览目前所支持的输入文件类型，

请参见 规则与限制

-3

01

5

请求的页码不存在。 -

-3

07

该文档超过100MB，无法解析。 输入文件大小需限制在100MB之内

https://cloud.tencent.com/document/product/460/36620
https://cloud.tencent.com/document/product/460/36620
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5

-5

06

2

图片涉嫌违禁。 请检查图片内容是否违规。

-6

101
图片不存在、图片没有上传或者图片已经删除。 请检查请求源数据。

-2

90

33

下载请求无有效的 range。 -

-2

90

34

下载的 offset 大于文件 size。 -

-2

92

14

触发频控。
请降低请求频率，或 提交工单  联系我

们处理。

-4

01

68

原图为空数据。 请检查请求源数据。

-4

61

52

非法的 bucketName。 请检查存储桶名称是否正确。

-4

61

54

非法的 APPID。 请检查 APPID 是否正确。

-4

66

14

文件尚未上传完成，禁止下载。 请等待文件上传成功后请求。

-4

66

17

命中黑名单。 请检查图片内容是否违规。

-4

66

18

签名校验失败。 请检查签名是否准确。

-4

66

19

签名过期。 请更新签名。

https://console.cloud.tencent.com/workorder/category
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-4

66

20

Bucket 被封禁。
您的 Bucket 已被封禁，请 提交工单  

联系我们处理。

-4

66

21

文件被封禁。
您的资源已被封禁，请 提交工单  联系

我们处理。

-4

66

27

用户目前在黑名单中。
您的账号已被封禁，请 提交工单  联系

我们处理。

-4

66

28

文件不存在。 请确认请求下载的文件是否真实存在。

-4

66

42

APPID 不存在。 请检查 APPID 是否正确。

-4

66

46

文件已封禁。
文件已被封禁，请检查文件内容是否违

规。

-4

66

61

无权访问 请联系资源所有者授予权限。

图片持久化处理错误码

错误码 说明 处理措施

-6099

8

图片处理参数无

效。
请检查图片处理规则是否正确。

-6099

7

图片处理规则过

多。
持久化处理当前最多支持五条规则，请控制在五条以内。

-6099

6

文件太大，无法处

理。
请将文件控制在32MB以内。

-6098

7
图片获取失败。 请检查图片 URL。

-6098

3
无效的 Host。 请检查 Host。

https://console.cloud.tencent.com/workorder/category
https://console.cloud.tencent.com/workorder/category
https://console.cloud.tencent.com/workorder/category
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-6097

2

无效地域。 请检查请求地域是否支持数据万象服务。数据万象现有地域详见 地域与

域名 。

-6096

7
图片样式不存在。 请检查图片样式。

-6095

7

样式数量超过上

限。
当前样式数量上限为100条，如需更多样式请 提交工单  联系我们。

-6095

5
无效的 URL。 请检查 URL 是否正确。

-6095

0
未指定文件。 请在请求中指定需要处理的文件。

-6094

9
请求频率过高。 请放缓请求频率。如有需要请 提交工单  联系我们提升频率限制。

-6094

8
账号涉嫌违规。 您的 APPID 已被封禁，请 提交工单  联系我们处理。

-6093

8
签名信息不完整。 请检查签名信息中的必选项。

-6093

6
请求被拒绝。 AccessDenied。

-6093

2
签名错误。 签名无效，请检查签名信息是否匹配。

-6299

9
无效的图片格式。 请检查图片格式是否正确。

文档预览错误码

错误

码
说明 处理措施

-300

6
文档为加密文件 建议使用已解密的文档。

-300

8
文档长度为0 请确认文档是否正常。

-301

1
文档类型不支持

请确认文档是否在支持范围内，支持的文档类型详情请参见 规则与

限制 。

-301 请求的页数超过了文档总 请检查请求页数是否正确。

https://cloud.tencent.com/document/product/460/31066
https://console.cloud.tencent.com/workorder/category
https://console.cloud.tencent.com/workorder/category
https://console.cloud.tencent.com/workorder/category
https://cloud.tencent.com/document/product/460/36620
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5 页数

内容审核错误码

错误

码
说明 处理措施

-61

011
文件不存在。 请检查文件是否存在。

-65

007
文件内容错误，解码失败。 请检查文件格式是否正确。

-65

010
下载文件失败。

请检查文件链接是否正确，私有读文件

需要携带签名。

-65

011
文件过大，无法处理。 当前不支持审核过大的文件。

-65

012
图片分辨率过小，无法处理。 当前不支持分辨率过小的图片。

-65

013

不符合要求（例如不支持识别的文件后缀、文件过大

等），未进行处理。
请检查文件是否符合规则。

-65

014
没有数据万象角色 CI_QCSRole。 请绑定数据万象角色。

-65

015
未启用审核场景。 请使用至少一种审核场景进行审核。

-65

016
使用的 BizType 不存在。 请填写正确的 BizType。

其他 内部错误 无。
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请求签名
最近更新时间：2023-08-07 10:39:21

使用腾讯云对象存储（Cloud Object Storage，COS）时，可通过 RESTful API 对 COS 发起 HTTP 匿名请

求或 HTTP 签名请求，对于签名请求，COS 服务器端将会进行对请求发起者的身份验证。

COS 基于密钥 HMAC（Hash Message Authentication Code）的自定义方案进行身份验证。

COS SDK 已经实现签名，在使用 SDK 发起请求或通过 SDK 获取签名时无需关注签名问题。如果您需要自行实

现签名或了解各语言的具体实现，可参考各语言 SDK 的签名实现文件：

注意

此文档仅适用于 COS XML 版本。

此文档不适用于 POST Object 的 HTTP 请求。

简介

匿名请求：HTTP 请求不携带任何身份标识和鉴权信息，通过 RESTful API 进行 HTTP 请求操作。

签名请求：HTTP 请求时携带签名，COS 服务器端收到消息后，进行身份验证，验证成功则可接受并执行请

求，否则将会返回错误信息并丢弃此请求。

SDK 签名实现

SDK 签名实现文件

Android SDK COSXmlSigner.java

C SDK cos_auth.c

C++ SDK auth_tool.cpp

.NET(C#) SDK IQCloudSigner.cs  (class CosXmlSigner)

Go SDK auth.go

iOS SDK QCloudAuthentationV5Creator.m

Java SDK COSSigner.java

JavaScript SDK util.js  (getAuth)

Node.js SDK util.js  (getAuth)

PHP SDK Signature.php

https://github.com/tencentyun/qcloud-sdk-android/blob/master/QCloudFoundation/foundation/src/main/java/com/tencent/qcloud/core/auth/COSXmlSigner.java
https://github.com/tencentyun/cos-c-sdk-v5/blob/master/cos_c_sdk/cos_auth.c
https://github.com/tencentyun/cos-cpp-sdk-v5/blob/master/src/util/auth_tool.cpp
https://github.com/tencentyun/qcloud-sdk-dotnet/blob/master/QCloudCSharpSDK/COSXML/Auth/IQCloudSigner.cs
https://github.com/tencentyun/cos-go-sdk-v5/blob/master/auth.go
https://github.com/tencentyun/qcloud-sdk-ios/blob/master/QCloudCore/Classes/Base/QCloudClientBase/Authentation/QCloudAuthentationV5Creator.m
https://github.com/tencentyun/cos-java-sdk-v5/blob/master/src/main/java/com/qcloud/cos/auth/COSSigner.java
https://github.com/tencentyun/cos-js-sdk-v5/blob/master/src/util.js
https://github.com/tencentyun/cos-nodejs-sdk-v5/blob/master/sdk/util.js
https://github.com/tencentyun/cos-php-sdk-v5/blob/master/src/Signature.php
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COS 目前支持的各语言 SDK  都提供了生成签名链接的功能，生成的链接 URL 中附带有一定有效期的签名，且该

签名支持 PUT 请求或 GET 请求，因此您可以直接使用该链接上传或下载对象而不需要额外生成签名。

各语言 SDK 生成签名链接的详细介绍，请参见下列各语言 SDK 文档：

Python SDK cos_auth.py

小程序 SDK util.js  (getAuth)

生成签名链接

在生成用于上传的签名链接时，还可以指定 Content-Type 或 Content-MD5 等头部，以便限制上传的媒体

类型或限制上传的内容必须为指定内容。有关上传时的请求头部设置，请参阅 PUT Object  文档。

在生成用于下载的签名链接时，还可以指定 response-xxx 请求参数，以便在下载时临时修改响应中的相关头

部。有关下载时的请求参数设置，请参阅 GET Object  文档。

说明

建议用户使用临时密钥生成预签名，通过临时授权的方式进一步提高预签名上传、下载等请求的安全

性。申请临时密钥时，请遵循 最小权限指引原则 ，防止泄漏目标存储桶或对象之外的资源。

如果您一定要使用永久密钥来生成预签名，建议永久密钥的权限范围仅限于上传或下载操作，以规避风

险。

SDK 预签名文档

Android SDK 生成预签名链接

C SDK 预签名 URL

C++ SDK 预签名 URL

.NET(C#) SDK 生成预签名链接

Go SDK 预签名 URL

iOS SDK 生成预签名链接

Java SDK 预签名 URL

JavaScript SDK 预签名 URL

Node.js SDK 预签名 URL

PHP SDK 预签名 URL

Python SDK 预签名 URL

小程序 SDK 预签名 URL

https://cloud.tencent.com/document/product/436/6474
https://github.com/tencentyun/cos-python-sdk-v5/blob/master/qcloud_cos/cos_auth.py
https://github.com/tencentyun/cos-wx-sdk-v5/blob/master/src/util.js
https://cloud.tencent.com/document/product/436/7749
https://cloud.tencent.com/document/product/436/7753
https://cloud.tencent.com/document/product/436/38618
https://cloud.tencent.com/document/product/436/46421
https://cloud.tencent.com/document/product/436/35560
https://cloud.tencent.com/document/product/436/35163
https://cloud.tencent.com/document/product/436/32873
https://cloud.tencent.com/document/product/436/35059
https://cloud.tencent.com/document/product/436/46388
https://cloud.tencent.com/document/product/436/35217
https://cloud.tencent.com/document/product/436/35651
https://cloud.tencent.com/document/product/436/36121
https://cloud.tencent.com/document/product/436/34284
https://cloud.tencent.com/document/product/436/35153
https://cloud.tencent.com/document/product/436/36162
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COS 目前提供了 COS 签名工具 ，用户可使用该工具临时生成签名或参考签名生成过程，详细的使用方法请参见 

COS 签名工具  文档。

在 COS 服务使用的场景中，对于需要对外发布类的数据，通常可将对象设置为公有读私有写。即所有人可查看，

通过 ACL 策略指定账号可写入。此时，可将 ACL 策略与 API 请求签名相结合，对访问进行身份验证，并对操作

进行权限和有效期的控制。

在以上场景中，可对 API 请求进行多方面的安全防护：

1. 请求者身份验证。通过访问者唯一 ID 和密钥确定请求者身份。

2. 防止传输数据篡改。对数据签名并检验，保障传输内容完整性。

3. 防止签名被盗用。对签名设置时效，避免签名盗用并重复使用。

1. APPID、SecretId 和 SecretKey。  

在访问管理控制台的 API 密钥管理  页面中获取。

2. 确定开发语言：

支持但不限于 Java、PHP、.NET、C++、Node.js、Python，根据不同的开发语言，确定对应的 

HMAC-SHA1、SHA1 和 UrlEncode 函数。 

其中，HMAC-SHA1 和 SHA1 函数以 UTF-8 编码字符串为输入，以16进制小写字符串为输出。

UrlEncode 基于 UTF-8 编码，此外对于 ASCII 范围内的可打印字符，下列特殊符号也应被编码：

在线签名工具

签名使用场景

注意

 本文所描述的 API 请求签名，如果您使用 SDK 进行开发，则已包含在内。仅在您希望通过原始 API 进行

二次开发时，需要根据本文所描述步骤进行操作。

准备工作

字符 十进制 十六进制 字符 十进制 十六进制

(空格) 32 20 ; 59 3B

! 33 21 < 60 3C

" 34 22 = 61 3D

# 35 23 > 62 3E

$ 36 24 ? 63 3F

% 37 25 @ 64 40

https://cos5.cloud.tencent.com/static/cos-sign/
https://cloud.tencent.com/document/product/436/30442
https://console.cloud.tencent.com/cam/capi


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第42 共1701页

1. 获取当前时间对应的 Unix 时间戳 StartTimestamp，Unix 时间戳是从 UTC（协调世界时，或 GMT 格林

威治时间）1970年1月1日0时0分0秒（北京时间 1970年1月1日8时0分0秒）起至现在的总秒数。

2. 根据上述时间戳和期望的签名有效时长算出签名过期时间对应的 Unix 时间戳 EndTimestamp。

3. 拼接签名有效时间，格式为 StartTimestamp;EndTimestamp ，即为 KeyTime。例如：

1557902800;1557910000 。

使用 HMAC-SHA1  以 SecretKey  为密钥，以 KeyTime  为消息，计算消息摘要（哈希值，16进制小写形

式），即为 SignKey，例如： eb2519b498b02ac213cb1f3d1a3d27a3b3c9bc5f 。

1. 遍历 HTTP 请求参数，生成 key 到 value 的映射 Map 及 key 的列表 KeyList：

& 38 26 [ 91 5B

' 39 27 \ 92 5C

( 40 28 ] 93 5D

) 41 29 ^ 94 5E

* 42 2A ` 96 60

+ 43 2B { 123 7B

, 44 2C | 124 7C

/ 47 2F } 125 7D

: 58 3A 无 无 无

签名步骤

步骤1：生成 KeyTime

步骤2：生成 SignKey

步骤3：生成 UrlParamList 和 HttpParameters

key 使用 UrlEncode  编码并转换为小写形式。

value 使用 UrlEncode  编码。若无 value 的参数，则认为 value 为空字符串。例如请求路径为 /?acl

，则认为是 /?acl= 。

说明

 HTTP 请求参数，即请求路径中 ? 以后的部分，例如请求路径为 

/?versions&prefix=example-folder%2F&delimiter=%2F&max-keys=10 ，则请求参数为

versions&prefix=example-folder%2F&delimiter=%2F&max-keys=10 。
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2. 将 KeyList 按照字典序排序。

3. 按照 KeyList 的顺序拼接 Map 中的每一个键值对，格式为 key1=value1&key2=value2&key3=value3

，即为 HttpParameters。

4. 按照 KeyList 的顺序拼接 KeyList 中的每一项，格式为 key1;key2;key3 ，即为 UrlParamList。

1. 遍历 HTTP 请求头部，生成 key 到 value 的映射 Map 及 key 的列表 KeyList，key 使用 UrlEncode  编

码并转换为小写形式，value 使用 UrlEncode  编码。

2. 将 KeyList 按照字典序排序。

3. 按照 KeyList 的顺序拼接 Map 中的每一个键值对，格式为 key1=value1&key2=value2&key3=value3

，即为 HttpHeaders。

4. 按照 KeyList 的顺序拼接 KeyList 中的每一项，格式为 key1;key2;key3 ，即为 HeaderList。

请求头：

示例：

示例一：

请求路径： /?prefix=example-folder%2F&delimiter=%2F&max-keys=10  

UrlParamList： delimiter;max-keys;prefix  

HttpParameters： delimiter=%2F&max-keys=10&prefix=example-folder%2F

注意

 请求路径中的请求参数在实际发送请求时也会进行 UrlEncode，因此要注意不要重复执行 

UrlEncode。

示例二：

请求路径： /exampleobject?acl  

UrlParamList： acl  

HttpParameters： acl=

步骤4：生成 HeaderList 和 HttpHeaders

注意：

遍历 HTTP 请求头部时，不需要处理全部头部，用户可按需筛选。

示例：

Host: examplebucket-1250000000.cos.ap-shanghai.myqcloud.com

Date: Thu, 16 May 2019 03:15:06 GMT

x-cos-acl: private
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计算得到：

根据 HTTP 方法（HttpMethod）、HTTP 请求路径（UriPathname）、 HttpParameters  和 

HttpHeaders  生成 HttpString，格式为 HttpMethod\nUriPathname\nHttpParameters\nHttpHeaders\n

。

其中：

根据 KeyTime  和 HttpString  生成 StringToSign，格式为 sha1\nKeyTime\nSHA1(HttpString)\n 。 

其中：

使用 HMAC-SHA1  以 SignKey  为密钥（字符串形式，非原始二进制），以 StringToSign  为消息，计算消

息摘要，即为 Signature，例如： 01681b8c9d798a678e43b685a9f1bba0f6c01234 。

根据 SecretId 、 KeyTime 、 HeaderList 、 UrlParamList  和 Signature  生成签名，格式为：

x-cos-grant-read: uin="100000000011"

HeaderList = date;host;x-cos-acl;x-cos-grant-read

HttpHeaders = 

date=Thu%2C%2016%20May%202019%2003%3A15%3A06%20GMT&host=examplebucket-

1250000000.cos.ap-shanghai.myqcloud.com&x-cos-acl=private&x-cos-grant-

read=uin%3D%22100000000011%22

步骤5：生成 HttpString

HttpMethod 转换为小写，例如 get 或 put。

UriPathname 为请求路径，例如 / 或 /exampleobject 。

\n 为换行符。如果其中有字符串为空，前后的换行符需要保留，例如 get\n/exampleobject\n\n\n 。

步骤6：生成 StringToSign

sha1 为固定字符串。

\n 为换行符。

SHA1(HttpString) 为使用 SHA1  对 HttpString  计算的消息摘要，16进制小写形式，例如：

54ecfe22f59d3514fdc764b87a32d8133ea611e6 。

步骤7：生成 Signature

步骤8：生成签名

q-sign-algorithm=sha1

&q-ak=SecretId

&q-sign-time=KeyTime

&q-key-time=KeyTime

&q-header-list=HeaderList
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通过 RESTful API 对 COS 发起的 HTTP 签名请求，可以通过以下几种方式传递签名：

1. 通过标准的 HTTP Authorization 头，例如 

Authorization: q-sign-algorithm=sha1&q-ak=...&q-sign-time=1557989753;1557996953&...&q-

signature=...

2. 作为 HTTP 请求参数，请注意 UrlEncode，例如 

/exampleobject?q-sign-algorithm=sha1&q-ak=...&q-sign-

time=1557989753%3B1557996953&...&q-signature=...

如果在计算签名时使用了临时安全凭证，那么在发送请求时还应传入安全令牌字段 x-cos-security-token，根

据签名使用方式不同，安全令牌字段的传入方式也有所不同：

1. 当通过标准的 HTTP Authorization 头传入签名时，应同时通过 x-cos-security-token 请求头部传入安

全令牌字段，例如：

2. 当通过 HTTP 请求参数传入签名时，应同时通过 x-cos-security-token 请求参数传入安全令牌字段，例

如：

&q-url-param-list=UrlParamList

&q-signature=Signature

注意

 上述格式中的换行仅用于更好的阅读，实际格式并不包含换行。

签名使用

说明

 上述示例中使用 ... 省略了部分具体签名内容。

使用临时安全凭证（临时密钥）

Authorization: q-sign-algorithm=sha1&q-ak=...&q-sign-time=1557989753;155799695

x-cos-security-token: ...

/exampleobject?q-sign-algorithm=sha1&q-ak=...&q-sign-time=1557989753%3B15579

说明

 上述示例中使用 ... 省略了部分具体签名和安全访问令牌内容。

代码示例
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不同语言如何调用 HMAC-SHA1 可以参考下面的示例：

伪代码

KeyTime = [Now];[Expires]

SignKey = HMAC-SHA1([SecretKey], KeyTime)

HttpString = [HttpMethod]\n[HttpURI]\n[HttpParameters]\n[HttpHeaders]\n

StringToSign = sha1\nKeyTime\nSHA1(HttpString)\n

Signature = HMAC-SHA1(SignKey, StringToSign)

消息摘要算法示例

PHP

$sha1HttpString = sha1 'ExampleHttpString'

$signKey = hash_hmac 'sha1'  'ExampleKeyTime'  'YourSecretKey'

( );

( , , );

Java

import DigestUtils

import HmacUtils

String sha1HttpString = DigestUtils sha1Hex "ExampleHttpString"

String signKey = HmacUtils hmacSha1Hex "YourSecretKey"  "ExampleKeyTime"

org.apache.commons.codec.digest. ;

org.apache.commons.codec.digest. ;

. ( );

. ( , );

Python

import hmac

import hashlib

sha1_http_string = hashlib sha1 'ExampleHttpString' encode 'utf-8' hexdigest

sign_key = hmac new 'YourSecretKey' encode 'utf-8'  'ExampleKeyTime' encode 'utf-8'  

. ( . ( )). ()

. ( . ( ), . ( ),

Node.js

var crypto = require('crypto');

var sha1HttpString = crypto.createHash('sha1').update('ExampleHttpString').digest('hex'
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登录访问管理控制台的 API 密钥管理  页面获取其 APPID、SecretId 和 SecretKey，举例如下：

var signKey = crypto.createHmac('sha1', 'YourSecretKey').update('ExampleKeyTime').dige

Go

import 

    "crypto/hmac"

    "crypto/sha1"

h := sha1 New

h Write byte "ExampleHttpString"

sha1HttpString := h Sum nil

var hashFunc = sha1 New

h = hmac New hashFunc  byte "YourSecretKey"

h Write byte "ExampleKeyTime"

signKey := h Sum nil

(

)

. ()

. ([] ( ))

. ( )

.

. ( , [] ( ))

. ([] ( ))

. ( )

实际案例

准备工作

APPID SecretId SecretKey

1250000000 AKXXXXXXXXXXXXXXXXXXX BQXXXXXXXXXXXXXXXXXXXX

上传对象

原始请求

PUT /exampleobject(%E8%85%BE%E8%AE%AF%E4%BA%91) HTTP/1.1

Date: Thu, 16 May 2019 06:45:51 GMT

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Content-Type: text/plain

Content-Length: 13

Content-MD5: mQ/fVh815F3k6TAUm8m0eg==

x-cos-acl: private

x-cos-grant-read: uin="100000000011"

ObjectContent

https://console.cloud.tencent.com/cam/capi
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其中，(empty string) 代表长度为0的空字符串， \n 代表换行符。

中间变量

KeyTime = 1557989151;1557996351

SignKey = eb2519b498b02ac213cb1f3d1a3d27a3b3c9bc5f

UrlParamList = (empty string)

HttpParameters = (empty string)

HeaderList = content-length;content-md5;content-type;date;host;x-cos-acl;x-cos-grant-read

HttpHeaders = 

content-length=13&content-md5=mQ%2FfVh815F3k6TAUm8m0eg%3D%3D&content-

type=text%2Fplain&date=Thu%2C%2016%20May%202019%2006%3A45%3A51%20GMT&host

=examplebucket-1250000000.cos.ap-beijing.myqcloud.com&x-cos-acl=private&x-cos-grant-

read=uin%3D%22100000000011%22

HttpString = 

put\n/exampleobject(腾讯云)\n\ncontent-length=13&content-

md5=mQ%2FfVh815F3k6TAUm8m0eg%3D%3D&content-

type=text%2Fplain&date=Thu%2C%2016%20May%202019%2006%3A45%3A51%20GMT&host

=examplebucket-1250000000.cos.ap-beijing.myqcloud.com&x-cos-acl=private&x-cos-grant-

read=uin%3D%22100000000011%22\n

StringToSign = 

sha1\n1557989151;1557996351\n8b2751e77f43a0995d6e9eb9477f4b685cca4172\n

Signature = 3b8851a11a569213c17ba8fa7dcf2abec6931234

签名后的请求

PUT /exampleobject(%E8%85%BE%E8%AE%AF%E4%BA%91) HTTP/1.1

Date: Thu, 16 May 2019 06:45:51 GMT

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Content-Type: text/plain

Content-Length: 13

Content-MD5: mQ/fVh815F3k6TAUm8m0eg==

x-cos-acl: private

x-cos-grant-read: uin="100000000011"

Authorization: q-sign-algorithm=sha1&q-ak=AKIDQjz3ltompVjBni5LitkWHFlFpwkn****&q-

ObjectContent

下载对象

原始请求
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其中， \n   代表换行符。

GET /exampleobject(%E8%85%BE%E8%AE%AF%E4%BA%91)?response-content-type=ap

Date: Thu, 16 May 2019 06:55:53 GMT

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

中间变量

KeyTime = 1557989753;1557996953

SignKey = 937914bf490e9e8c189836aad2052e4feeb35eaf

UrlParamList = response-cache-control;response-content-type

HttpParameters = 

response-cache-control=max-age%3D600&response-content-type=application%2Foctet-stream

HeaderList = date;host

HttpHeaders = 

date=Thu%2C%2016%20May%202019%2006%3A55%3A53%20GMT&host=examplebucket-

1250000000.cos.ap-beijing.myqcloud.com

HttpString = 

get\n/exampleobject(腾讯云)\nresponse-cache-control=max-age%3D600&response-content-

type=application%2Foctet-

stream\ndate=Thu%2C%2016%20May%202019%2006%3A55%3A53%20GMT&host=exampleb

ucket-1250000000.cos.ap-beijing.myqcloud.com\n

StringToSign = 

sha1\n1557989753;1557996953\n54ecfe22f59d3514fdc764b87a32d8133ea611e6\n

Signature = 01681b8c9d798a678e43b685a9f1bba0f6c01234

签名后的请求

GET /exampleobject(%E8%85%BE%E8%AE%AF%E4%BA%91)?response-content-type=ap

Date: Thu, 16 May 2019 06:55:53 GMT

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Authorization: q-sign-algorithm=sha1&q-ak=AKIDQjz3ltompVjBni5LitkWHFlFpwkn****&q-
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操作列表
最近更新时间：2022-12-05 14:56:55

腾讯云对象存储服务（COS）相关接口及说明如下：

Service 接口

API 操作名 操作描述

GET Service（List Buckets） 查询存储桶列表 查询指定账号下所有存储桶列表

Bucket 接口

基本操作接口

API 操作名 操作描述

PUT Bucket 创建存储桶 在指定账号下创建一个存储桶

GET Bucket（List 

Objects）
查询对象列表 查询存储桶下的部分或者全部对象

HEAD Bucket
检索存储桶及其权

限
确认存储桶是否存在且是否有权限访问

DELETE Bucket 删除存储桶 删除指定账号下的空存储桶

GET Bucket Object 

versions
查询对象版本

查询存储桶下的部分或者全部对象及其历史版本

信息

访问控制（acl）接口

API 操作名 操作描述

PUT Bucket acl 设置存储桶 ACL 设置指定存储桶访问权限控制列表

GET Bucket acl 查询存储桶 ACL 查询存储桶的访问控制列表

跨域资源共享（cors）接口

API 操作名 操作描述

PUT Bucket cors 设置跨域配置 设置存储桶的跨域访问权限

GET Bucket cors 查询跨域配置 查询存储桶的跨域访问配置信息

https://cloud.tencent.com/document/product/436/8291
https://cloud.tencent.com/document/product/436/7738
https://cloud.tencent.com/document/product/436/7734
https://cloud.tencent.com/document/product/436/7735
https://cloud.tencent.com/document/product/436/7732
https://cloud.tencent.com/document/product/436/35521
https://cloud.tencent.com/document/product/436/7737
https://cloud.tencent.com/document/product/436/7733
https://cloud.tencent.com/document/product/436/8279
https://cloud.tencent.com/document/product/436/8274
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DELETE Bucket cors 删除跨域配置 删除存储桶的跨域访问配置信息

生命周期（lifecycle）接口

API 操作名 操作描述

PUT Bucket lifecycle 设置生命周期 设置存储桶生命周期管理的配置

GET Bucket lifecycle 查询生命周期 查询存储桶生命周期管理的配置

DELETE Bucket lifecycle 删除生命周期 删除存储桶生命周期管理的配置

存储桶策略（policy）接口

API 操作名 操作描述

 PUT Bucket policy 设置存储桶策略 设置指定存储桶的权限策略

GET Bucket policy 查询存储桶策略 查询指定存储桶的权限策略

DELETE Bucket policy 删除存储桶策略 删除指定存储桶的权限策略

防盗链（referer）接口

API 操作名 操作描述

PUT Bucket referer 设置存储桶 referer 设置存储桶 Referer 白名单或者黑名单

GET Bucket referer 查询存储桶 referer 查询存储桶 Referer 白名单或者黑名单

存储桶标签（tagging）接口

API 操作名 操作描述

PUT Bucket tagging 设置存储桶标签 为已存在的存储桶设置标签

GET Bucket tagging 查询存储桶标签 查询指定存储桶下已有的存储桶标签

DELETE Bucket tagging 删除存储桶标签 删除指定的存储桶标签

静态网站（website）接口

API 操作名 操作描述

PUT Bucket website 设置静态网站 为存储桶配置静态网站

https://cloud.tencent.com/document/product/436/8283
https://cloud.tencent.com/document/product/436/8280
https://cloud.tencent.com/document/product/436/8278
https://cloud.tencent.com/document/product/436/8284
https://cloud.tencent.com/document/product/436/8282
https://cloud.tencent.com/document/product/436/8276
https://cloud.tencent.com/document/product/436/8285
https://cloud.tencent.com/document/product/436/32492
https://cloud.tencent.com/document/product/436/32493
https://cloud.tencent.com/document/product/436/34838
https://cloud.tencent.com/document/product/436/34837
https://cloud.tencent.com/document/product/436/34836
https://cloud.tencent.com/document/product/436/31930
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GET Bucket website 查询静态网站配置 查询与存储桶关联的静态网站配置信息

DELETE Bucket website 删除静态网站配置 删除指定存储桶的静态网站配置信息

智能分层（IntelligentTiering）接口

API 操作名 操作描述

PUT Bucket IntelligentTiering 设置智能分层配置 启用存储桶的智能分层存储配置

GET Bucket IntelligentTiering 查询智能分层配置 查询存储桶的智能分层配置信息

清单（inventory）接口

API 操作名 操作描述

PUT Bucket inventory 设置清单任务 在存储桶中创建清单任务

POST Bucket inventory
创建一次性清单任

务

对一个存储桶创建一个一次性清单任

务

GET Bucket inventory 查询清单任务 查询存储桶的指定清单配置信息

List Bucket Inventory 

Configurations
查询所有清单 查询存储桶的所有清单任务

DELETE Bucket inventory 删除清单任务 删除存储桶中指定的清单任务

版本控制（versioning）接口

API 操作名 操作描述

PUT Bucket versioning 设置版本控制 启用或者暂停存储桶的版本控制功能

GET Bucket versioning 查询版本控制 查询存储桶的版本控制信息

存储桶复制（replication）接口

API 操作名 操作描述

PUT Bucket replication 设置存储桶复制 对已启用版本控制的存储桶配置存储桶复制规则

GET Bucket replication 查询存储桶复制 查询存储桶的存储桶复制配置信息

DELETE Bucket replication 删除存储桶复制 删除存储桶的存储桶复制配置信息

日志管理（logging）接口

https://cloud.tencent.com/document/product/436/31929
https://cloud.tencent.com/document/product/436/31928
https://cloud.tencent.com/document/product/436/48348
https://cloud.tencent.com/document/product/436/48349
https://cloud.tencent.com/document/product/436/33707
https://cloud.tencent.com/document/product/436/83382
https://cloud.tencent.com/document/product/436/33705
https://cloud.tencent.com/document/product/436/33706
https://cloud.tencent.com/document/product/436/33704
https://cloud.tencent.com/document/product/436/19889
https://cloud.tencent.com/document/product/436/19888
https://cloud.tencent.com/document/product/436/19223
https://cloud.tencent.com/document/product/436/19222
https://cloud.tencent.com/document/product/436/19221
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API 操作名 操作描述

PUT Bucket logging 设置日志管理 为源存储桶开启日志记录

GET Bucket logging 查询日志管理 查询源存储桶的日志配置信息

全球加速（accelerate）接口

API 操作名 操作描述

PUT Bucket Accelerate 设置全球加速 启用或暂停存储桶的全球加速功能

GET Bucket Accelerate 查询全球加速 查询存储桶的全球加速功能配置信息

存储桶加密（encryption）接口

API 操作名 操作描述

PUT Bucket encryption 设置存储桶加密 设置指定存储桶下的默认加密配置

GET Bucket encryption 查询存储桶加密 查询指定存储桶下的默认加密配置

DELETE Bucket encryption 删除存储桶加密 删除指定存储桶下的默认加密配置

对象锁定（ObjectLock）接口

API 操作名 操作描述

PUT Bucket 

ObjectLockConfiguration
设置对象锁定

为已存在的存储桶设置对象锁

定

GET Bucket 

ObjectLockConfiguration
查询对象锁定 查询已生效的对象锁定配置

GET Object retention
查询对象锁定的到期日

期
查询对象锁定的到期日期

Object 接口

基本操作接口

API 操作名 操作描述

PUT Object 简单上传对象 上传一个对象至存储桶

PUT Object - Copy 设置对象复制 复制文件到目标路径

https://cloud.tencent.com/document/product/436/17054
https://cloud.tencent.com/document/product/436/17053
https://cloud.tencent.com/document/product/436/38869
https://cloud.tencent.com/document/product/436/38868
https://cloud.tencent.com/document/product/436/40136
https://cloud.tencent.com/document/product/436/40137
https://cloud.tencent.com/document/product/436/40138
https://cloud.tencent.com/document/product/436/55290
https://cloud.tencent.com/document/product/436/55291
https://cloud.tencent.com/document/product/436/55292
https://cloud.tencent.com/document/product/436/7749
https://cloud.tencent.com/document/product/436/10881
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POST Object 表单上传对象 使用表单请求上传对象

GET Object 下载对象 下载一个对象至本地

HEAD Object 查询对象元数据 查询对象的元数据信息

DELETE Object 删除单个对象 在存储桶中删除指定对象

DELETE Multiple Objects 删除多个对象 在存储桶中批量删除对象

OPTIONS Object 预请求跨域配置 用预请求来确认是否可以发送真正的跨域请求

POST Object restore 恢复归档对象 将归档类型的对象取回访问

SELECT Object Content 检索对象内容 检索指定对象的内容

访问控制接口

API 操作名 操作描述

PUT Object acl 设置对象 ACL 设置存储桶中某个对象的访问控制列表

GET Object acl 查询对象 ACL 查询对象的访问控制列表

对象标签接口

API 操作名 操作描述

PUT   Object tagging 设置对象标签 为已上传的对象设置标签

GET   Object tagging 查询对象标签 查询指定对象下已有的对象标签

DELETE   Object tagging 删除对象标签 删除指定对象下已有的对象标签

分块上传接口

API 操作名 操作描述

Initiate Multipart Upload 初始化分块上传 初始化分块上传任务

Upload Part 上传分块 分块上传文件

Upload Part - Copy 复制分块 将其他对象复制为一个分块

Complete Multipart Upload 完成分块上传 完成整个文件的分块上传

Abort Multipart Upload 终止分块上传 终止一个分块上传操作并删除已上传的块

https://cloud.tencent.com/document/product/436/14690
https://cloud.tencent.com/document/product/436/7753
https://cloud.tencent.com/document/product/436/7745
https://cloud.tencent.com/document/product/436/7743
https://cloud.tencent.com/document/product/436/8289
https://cloud.tencent.com/document/product/436/8288
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/436/37641
https://cloud.tencent.com/document/product/436/7748
https://cloud.tencent.com/document/product/436/7744
https://cloud.tencent.com/document/product/436/42997
https://cloud.tencent.com/document/product/436/42998
https://cloud.tencent.com/document/product/436/42999
https://cloud.tencent.com/document/product/436/7746
https://cloud.tencent.com/document/product/436/7750
https://cloud.tencent.com/document/product/436/8287
https://cloud.tencent.com/document/product/436/7742
https://cloud.tencent.com/document/product/436/7740
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数据处理接口包括图片处理、AI 内容识别、媒体处理、文档处理、文件处理等接口类别，详情请参见 数据处理接

口 。

内容审核接口包括图片审核、视频审核、音频审核、文本审核、文档审核、网页审核、直播审核等接口类别，详情请

参见 内容审核接口 。

任务与工作流接口包括工作流接口、工作流实例、任务接口、模板接口、批量任务接口等接口类别，详情请参见 任

务与工作流接口 。

List Multipart Uploads 查询分块上传 查询正在进行中的分块上传信息

List Parts 查询已上传块 查询特定分块上传操作中的已上传的块

批量处理（batch）接口

API 操作名 操作描述

CreateJob 创建任务 用于在存储桶中创建批量处理任务

DescribeJob 描述任务 用于获取已创建的批量处理任务的参数和任务执行状态

ListJobs 查询任务 用于列出已创建的批量处理任务

UpdateJobPriority 更新任务优先级 用于更新已创建任务的优先级

UpdateJobStatus 更新任务状态 用于更新已创建任务的状态

公共元素 — 批量处理功能的公共元素

错误响应 — 批量处理功能的错误响应

数据处理接口

数据处理接口

内容审核接口

任务与工作流接口

云查毒接口

API 操作描述

提交病毒检测任务 对云上的文件进行文件病毒（例如木马病毒、蠕虫病毒等）检测

查询病毒检测任务结果 用于查询一个病毒检测任务的状态或结果

https://cloud.tencent.com/document/product/436/44878
https://cloud.tencent.com/document/product/436/54061
https://cloud.tencent.com/document/product/436/76836
https://cloud.tencent.com/document/product/436/7736
https://cloud.tencent.com/document/product/436/7747
https://cloud.tencent.com/document/product/436/38608
https://cloud.tencent.com/document/product/436/38609
https://cloud.tencent.com/document/product/436/38611
https://cloud.tencent.com/document/product/436/38612
https://cloud.tencent.com/document/product/436/38613
https://cloud.tencent.com/document/product/436/38607
https://cloud.tencent.com/document/product/436/38610
https://cloud.tencent.com/document/product/436/63961
https://cloud.tencent.com/document/product/436/63962
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Service 接口

GET Service（List Buckets）
最近更新时间：2023-05-25 16:16:04

GET Service 接口是用来查询请求者名下的所有存储桶列表或特定地域下的存储桶列表。

示例一

示例二

GetService 支持通过请求参数根据存储桶标签、地域、创建时间过滤存储桶。其中，根据存储桶标签过滤存储

桶，仅支持传入一个存储桶标签。当存储桶包含多个存储桶标签时，只要其中任意一个为用户指定的存储桶标签，就

会返回该存储桶。

功能描述

请求

请求示例

GET / HTTP/1.1

Host: service.cos.myqcloud.com

Date: GMT Date

Authorization: Auth String

GET / HTTP/1.1

Host: cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

Host: 查询全部存储桶列表指定为 service.cos.myqcloud.com ，查询特定地域下的存储桶列表指定

为 cos.<Region>.myqcloud.com，其中 <Region> 为 COS 的可用地域，可参阅 地域和访问域

名  文档。

请求参数

名 描述 类 是

https://cloud.tencent.com/document/product/436/7778
http://cloud.tencent.com/document/product/436/6224
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称 型 否

必

选

t

a

g

k

e

y

支持根据存储桶标签过滤存储桶，仅支持传入一个存储桶标签，tagkey 用于传入标签

键

s

tr

in

g

否

t

a

g

v

al

u

e

支持根据存储桶标签过滤存储桶，仅支持传入一个存储桶标签，tagvalue 用于传入标

签值

s

tr

in

g

否

r

e

gi

o

n

支持根据地域过滤存储桶，例如 region=ap-beijing ，COS 支持的地域可参考 地域

和访问域名

s

tr

in

g

否

c

r

e

a

t

e

-

ti

m

e

GMT 时间戳，和 range 参数一起使用，支持根据创建时间过滤存储桶，例如 

create-time=1642662645

T

i

m

e

s

t

a

m

p

否

r

a

n

g

e

和 create-time 参数一起使用，支持根据创建时间过滤存储桶，支持枚举值 lt（创建

时间早于 create-time）、gt（创建时间晚于 create-time）、lte（创建时间早于

或等于 create-time）、gte（创建时间晚于或等于create-time）

s

tr

in

g

否

m

a

r

k

起始标记，从该标记之后（不含）按照 UTF-8 字典序返回存储桶条目 s

tr

in

g

否

https://cloud.tencent.com/document/product/436/6224
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当存储桶标签授权情况与 GetService 授权不同时，GetService 请求的鉴权和返回情况如下。关于标签鉴权的

授权方法 ，可参见 授权子账号按照存储桶标签拉取存储桶列表 。

e

r

m

a

x

-

k

e

y

s

单次返回最大的条目数量，默认值为2000，最大为2000。如果单次响应中未列出所有

存储桶，COS 会返回 NextMarker 节点，其值作为下次 GetService 请求的 

marker 参数

in

t

e

g

e

r

否

存储桶标签授权情况
GetService 

授权情况

GetServic

e 请求
请求返回

主账号通过存储桶标签授权，授权了子账号存储

桶标签 tagA 的资源操作权限。

没有授权 

GetService 

权限

携带存储桶

标签参数 

tagA

包含存储桶标签 

tagA 的存储桶列

表

不携带存储

桶标签参数
Access Denied

额外授权 

GetService 

权限

携带存储桶

标签参数 

tagA

包含存储桶标签 

tagA 的存储桶列

表

不携带存储

桶标签参数
所有存储桶列表

主账号没有通过存储桶标签授权，没有授权子账

号存储桶标签 tagA 的资源操作权限。

没有授权 

GetService 

权限

携带存储桶

标签参数 

tagA

Access Denied

不携带存储

桶标签参数
Access Denied

额外授权 

GetService 

权限

携带存储桶

标签参数 

tagA

包含存储桶标签 

tagA 的存储桶列

表

不携带存储

桶标签参数
所有存储桶列表

请求头

https://cloud.tencent.com/document/product/436/34694
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

此接口无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

查询成功，返回 application/xml 数据，包含所有或特定地域下的存储桶列表。

具体的节点描述如下：

Container 节点 ListAllMyBucketsResult 的内容：

请求体

响应

响应头

响应体

<ListAllMyBucketsResult>

    <Owner>

        <ID>string</ID>

        <DisplayName>string</DisplayName>

    </Owner>

    <Marker></Marker>

    <NextMarker></NextMarker>

    <IsTruncated></IsTruncated>

    <Buckets>

        <Bucket>

            <Name>string</Name>

            <Location>Enum</Location>

            <CreationDate>date</CreationDate>

        </Bucket>

        <Bucket>

            <Name>string</Name>

            <Location>Enum</Location>

            <CreationDate>date</CreationDate>

        </Bucket>

    </Buckets>

</ListAllMyBucketsResult>

节点名称（关键字） 父节点 描述 类型

ListAllMyBucketsResult 无 保存 GET Service 结果的所有信息 Container

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
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Container 节点 Owner 的内容：

Container 节点 Buckets 的内容：

Container 节点 Buckets.Bucket 的内容：

节点名称

（关键

字）

父节点 描述 类型

Owner
ListAllMyBu

cketsResult
存储桶持有者信息

Con

tain

er

Buckets
ListAllMyBu

cketsResult
存储桶列表

Con

tain

er

Marker
ListAllMyBu

cketsResult
表示本次 GetService（ListBuckets）的起点

stri

ng

IsTrunca

ted

ListAllMyBu

cketsResult

是否所有的结果都已经返回。true：表示本次没有返回全部结

果。false：表示本次已经返回了全部结果

stri

ng

NextMar

ker

ListAllMyBu

cketsResult

未返回所有结果时，作为下次 GetService 请求的 marker 

参数

stri

ng

节点名称

（关键字）
父节点 描述

类

型

ID
ListAllMyBucketsR

esult.Owner

存储桶持有者的完整 ID，格式为 

qcs::cam::uin/[OwnerUin]:uin/[OwnerUin]

例如

qcs::cam::uin/100000000001:uin/100000000

001

st

rin

g

DisplayN

ame

ListAllMyBucketsR

esult.Owner
存储桶持有者的名字

st

rin

g

节点名称（关键字） 父节点 描述 类型

Bucket ListAllMyBucketsResult.Buckets 存储桶信息 Container

节点名称

（关键字）
父节点 描述

类

型
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

Name ListAllMyBucketsResult.

Buckets.Bucket

存储桶的名称，格式为 

<BucketName-APPID>

例如 examplebucket-1250000000

st

ri

n

g

Location
ListAllMyBucketsResult.

Buckets.Bucket

存储桶所在地域，枚举值请参见 地域和访问域

名  文档

例如 ap-beijing，ap-hongkong，eu-

frankfurt 等

E

n

u

m

Creation

Date

ListAllMyBucketsResult.

Buckets.Bucket

存储桶的创建时间，为 ISO8601 格式，例如 

2019-05-24T10:56:40Z

da

te

错误码

实际案例

案例一：查询所有存储桶列表

请求

GET / HTTP/1.1

Host: service.cos.myqcloud.com

Date: Fri, 24 May 2019 11:59:50 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 805

Connection: close

Date: Fri, 24 May 2019 11:59:51 GMT

Server: tencent-cos

x-cos-request-id: NWNlN2RjYjdfOGFiMjM1MGFfNTVjMl8zMmI1****

<ListAllMyBucketsResult>

    <Owner>

        <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

        <DisplayName>100000000001</DisplayName>

    </Owner>

    </Marker>

https://cloud.tencent.com/document/product/436/7730
https://cloud.tencent.com/document/product/436/6224
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    </NextMarker>

    <IsTruncated>false</IsTruncated>

    <Buckets>

        <Bucket>

            <Name>examplebucket1-1250000000</Name>

            <Location>ap-beijing</Location>

            <CreationDate>2019-05-24T11:49:50Z</CreationDate>

        </Bucket>

        <Bucket>

            <Name>examplebucket2-1250000000</Name>

            <Location>ap-beijing</Location>

            <CreationDate>2019-05-24T11:51:50Z</CreationDate>

        </Bucket>

        <Bucket>

            <Name>examplebucket3-1250000000</Name>

            <Location>eu-frankfurt</Location>

            <CreationDate>2019-05-24T11:53:50Z</CreationDate>

        </Bucket>

        <Bucket>

            <Name>examplebucket4-1250000000</Name>

            <Location>eu-frankfurt</Location>

            <CreationDate>2019-05-24T11:55:50Z</CreationDate>

        </Bucket>

    </Buckets>

</ListAllMyBucketsResult>

案例二：查询特定地域下的存储桶列表（通过域名筛选）

请求

GET / HTTP/1.1

Host: cos.ap-beijing.myqcloud.com

Date: Fri, 24 May 2019 11:59:51 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 495

Connection: close

Date: Fri, 24 May 2019 11:59:51 GMT

Server: tencent-cos
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x-cos-request-id: NWNlN2RjYjdfZjhjODBiMDlfOWNlNF9hYzc2****

<ListAllMyBucketsResult>

    <Owner>

        <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

        <DisplayName>100000000001</DisplayName>

    </Owner>

    </Marker>

    </NextMarker>

    <IsTruncated>false</IsTruncated>

    <Buckets>

        <Bucket>

            <Name>examplebucket1-1250000000</Name>

            <Location>ap-beijing</Location>

            <CreationDate>2019-05-24T11:49:50Z</CreationDate>

        </Bucket>

        <Bucket>

            <Name>examplebucket2-1250000000</Name>

            <Location>ap-beijing</Location>

            <CreationDate>2019-05-24T11:51:50Z</CreationDate>

        </Bucket>

    </Buckets>

</ListAllMyBucketsResult>

案例三：查询特定地域下的存储桶列表（根据请求参数筛选）

请求

GET /?region=ap-beijing HTTP/1.1

Host: service.cos.myqcloud.com

Date: Fri, 24 May 2019 11:59:51 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 495

Connection: close

Date: Fri, 24 May 2019 11:59:51 GMT

Server: tencent-cos

x-cos-request-id: NWNlN2RjYjdfZjhjODBiMDlfOWNlNF9hYzc2****
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存储桶 examplebucket-1250000000 的标签为 <key1, value1> ，存储桶 examplebucket1-

1250000000 的标签为 <key1, value1>  和 <key2, value2> 。

<ListAllMyBucketsResult>

    <Owner>

        <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

        <DisplayName>100000000001</DisplayName>

    </Owner>

    </Marker>

    </NextMarker>

    <IsTruncated>false</IsTruncated>

    <Buckets>

        <Bucket>

            <Name>examplebucket1-</Name>

            <Location>ap-beijing</Location>

            <CreationDate>2019-05-24T11:49:50Z</CreationDate>

        </Bucket>

        <Bucket>

            <Name>examplebucket2-1250000000</Name>

            <Location>ap-beijing</Location>

            <CreationDate>2019-05-24T11:51:50Z</CreationDate>

        </Bucket>

    </Buckets>

</ListAllMyBucketsResult>

案例四：根据指定标签过滤存储桶列表

请求

GET /?tagkey=key1&tagvalue=value1 HTTP/1.1

Host: service.cos.myqcloud.com

Date: Fri, 24 May 2019 11:59:51 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Length: 378

Content-Type: application/xml

Server: tencent-cos

Connection: keep-alive

Date: Thu, 20 Oct 2022 07:29:40 GMT

x-cos-request-id: NjM1MGY4ZTRfMWViMjM1MGFfYjg3MV8xNjdk****
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列出创建时间早于 2022-1-20 15:10:45  的存储桶。

<ListAllMyBucketsResult>

    <Owner>

        <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

        <DisplayName>100000000001</DisplayName>

    </Owner>

    </Marker>

    </NextMarker>

    <IsTruncated>false</IsTruncated>

    <Buckets>

        <Bucket>

            <Name>examplebucket-1250000000 </Name>

            <Location>ap-guangzhou</Location>

            <CreationDate>2022-04-11T03:01:49Z</CreationDate>

            <BucketType>cos</BucketType>

        </Bucket>

    </Buckets>

    <Buckets>

        <Bucket>

            <Name>examplebucket1-1250000000 </Name>

            <Location>ap-guangzhou</Location>

            <CreationDate>2022-04-12T03:01:49Z</CreationDate>

            <BucketType>cos</BucketType>

        </Bucket>

    </Buckets>

</ListAllMyBucketsResult>

案例五：根据创建时间过滤存储桶列表

请求

GET /?range=lt&create-time=1642662645 HTTP/1.1

Host: service.cos.myqcloud.com

User-Agent: curl/7.64.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDYv3vWrwkHXVDfqk*****&q-sign-time=1

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 5566
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Connection: keep-alive

Date: Thu, 03 Nov 2022 04:14:23 GMT

Server: tencent-cos

x-cos-request-id: NjM2MzQwMWZfMmJiMjM1MGFfYTc******

<ListAllMyBucketsResult>

    <Owner>

        <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

        <DisplayName>100000000001</DisplayName>

    </Owner>

    </Marker>

    </NextMarker>

    <IsTruncated>false</IsTruncated>

    <Buckets>

        <Bucket>

            <Name>examplebucket-1250000000</Name>

            <Location>ap-beijing</Location>

            <CreationDate>2021-11-23T03:02:12Z</CreationDate>

            <BucketType>cos</BucketType>

        </Bucket>

    </Buckets>

</ListAllMyBucketsResult>

案例六：分页查询存储桶列表

请求

GET /?max-keys=1 HTTP/1.1

Host: service.cos.myqcloud.com

User-Agent: curl/7.64.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDYv3vWrwkHXVDfqk*****&q-sign-time=1

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 5566

Connection: keep-alive

Date: Thu, 03 Nov 2022 04:14:23 GMT

Server: tencent-cos

x-cos-request-id: NjM2MzQwMWZfMmJiMjM1MGFfYTc******

<ListAllMyBucketsResult>
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    <Owner>

        <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

        <DisplayName>100000000001</DisplayName>

    </Owner>

    </Marker>

    <NexMarker>1</NextMarker>

    <IsTruncated>true</IsTruncated>

    <Buckets>

        <Bucket>

            <Name>examplebucket-1250000000</Name>

            <Location>ap-beijing</Location>

            <CreationDate>2021-11-23T03:02:12Z</CreationDate>

            <BucketType>cos</BucketType>

        </Bucket>

    </Buckets>

</ListAllMyBucketsResult>
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Bucket 接口

基本操作

PUT Bucket
最近更新时间：2022-12-19 15:35:18

PUT Bucket 接口请求可以在指定账号下创建一个存储桶。该 API 接口不支持匿名请求，您需要使用带 

Authorization 签名认证的请求才能创建新的 Bucket 。创建存储桶的用户默认成为存储桶的持有者。

示例一

示例二

功能描述

说明

创建存储桶时，如果没有指定访问权限，则默认使用私有读写（private）权限。

如需创建多 AZ 存储桶，那么应当通过请求体指示存储桶配置，否则无需传入请求体。

请求

请求示例

PUT / HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-Length: 0

Authorization: Auth String

PUT / HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-Type: application/xml

Content-Length: Content Length

Content-MD5: MD5

Authorization: Auth String

[Request Body]
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此接口无请求参数。

此接口除使用公共请求头部外，还支持以下请求头部，了解公共请求头部详情请参见 公共请求头部  文档。

访问控制列表（ACL）相关头部

在创建存储桶时可以通过指定下列请求头部来设置存储桶的访问权限：

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

名称 描述
类

型

是否

必选

x-cos-

tagging

在创建存储桶的同时，为存储桶添加标签，最多可设置50个标签。例如 

key1=value1&key2=value2 。

str

in

g

否

名称 描述
类

型

是

否

必

选

x-

cos-

acl

定义存储桶的访问控制列表（ACL）属性。枚举值请参见 ACL 概述  文档中存储

桶的预设 ACL 部分，如 private，public-read 等，默认为 private

E

n

u

m

否

x-

cos-

grant

-read

赋予被授权者读取存储桶的权限，格式为 id="[OwnerUin]"，如 

id="100000000001"，可使用半角逗号（,）分隔多组被授权者，如 

id="100000000001",id="100000000002"

s

tr

in

g

否

x-

cos-

grant

-write

赋予被授权者写入存储桶的权限，格式为 id="[OwnerUin]"，如 

id="100000000001"，可使用半角逗号（,）分隔多组被授权者，如 

id="100000000001",id="100000000002"

s

tr

in

g

否

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/30752#.E9.A2.84.E8.AE.BE.E7.9A.84-acl
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仅当需要创建多 AZ 存储桶时提交 application/xml 请求数据，包含创建存储桶的配置信息，否则无需传入请求

体。

具体的节点描述如下：

Container 节点 CreateBucketConfiguration 的内容：

x-

cos-

grant

-

read-

acp

赋予被授权者读取存储桶的访问控制列表（ACL）和存储桶策略（Policy）的权

限，格式为 id="[OwnerUin]"，如 id="100000000001"，可使用半角逗号

（,）分隔多组被授权者，如 id="100000000001",id="100000000002"

s

tr

in

g

否

x-

cos-

grant

-

write-

acp

赋予被授权者写入存储桶的访问控制列表（ACL）和存储桶策略（Policy）的权

限，格式为 id="[OwnerUin]"，如 id="100000000001"，可使用半角逗号

（,）分隔多组被授权者，如 id="100000000001",id="100000000002"

s

tr

in

g

否

x-

cos-

grant

-full-

contr

ol

赋予被授权者操作存储桶的所有权限，格式为 id="[OwnerUin]"，如 

id="100000000001"，可使用半角逗号（,）分隔多组被授权者，如 

id="100000000001",id="100000000002"

s

tr

in

g

否

请求体

<CreateBucketConfiguration>

    <BucketAZConfig>string</BucketAZConfig>

</CreateBucketConfiguration>

节点名称（关键字）
父节

点
描述 类型

是否必

选

CreateBucketConfigura

tion
无

包含 PUT Bucket 操作的所有请

求信息

Contain

er
否

节点名称（关

键字）
父节点 描述

类

型

是否

必选

BucketAZ

Config

CreateBucketConfi

guration

存储桶 AZ 配置，指定为 MAZ 以创建

多 AZ 存储桶。

stri

ng
是
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

响应

响应头

响应体

错误码

实际案例

案例一：简单案例（单 AZ 存储桶）

请求

PUT / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Sun, 26 May 2019 14:51:38 GMT

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Sun, 26 May 2019 14:51:37 GMT

Server: tencent-cos

x-cos-request-id: NWNlYWE3ZjlfZDQyNzVkNjRfMzg1N18yNzFh****

案例二：指定公有读并授权特定用户读取权限和写入对象

请求

PUT / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 14 Jun 2019 13:48:59 GMT

x-cos-acl: public-read

x-cos-grant-write: id="100000000002"

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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x-cos-grant-read-acp: id="100000000002"

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Fri, 14 Jun 2019 13:49:00 GMT

Server: tencent-cos

x-cos-request-id: NWQwM2E1Y2NfZjBhODBiMDlfOTM1YV83NDRi****

案例三：创建多 AZ 存储桶

请求

PUT / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 04 Jun 2020 06:06:09 GMT

Content-Type: application/xml

Content-Length: 96

Content-MD5: R1ES/YbddhKJK/wcN+f4yg==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<CreateBucketConfiguration>

    <BucketAZConfig>MAZ</BucketAZConfig>

</CreateBucketConfiguration>

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Thu, 04 Jun 2020 06:06:10 GMT

Server: tencent-cos

x-cos-request-id: NWVkODhmNTFfM2JiODJhMDlfMjg4NmFfMzA5ZmE2****

案例四：创建存储桶同时添加存储桶标签
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以下请求示例，用于在北京地域创建存储桶 examplebucket-1250000000 ，同时为存储桶添加两个存储桶标签 

<a,a>  和 <b,b> 。

请求

PUT / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

x-cos-tagging: a=a&b=b

Authorization: q-sign-algorithm=sha1&q-ak=AKIDYv3vWrwkHXVDf******&q-sign-time=16

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Thu, 03 Nov 2022 03:43:30 GMT

Server: tencent-cos

x-cos-request-id: NjM2MzM4ZTJfZDRiNTE0M********
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GET Bucket（List Objects）
最近更新时间：2023-05-09 15:00:54

GET Bucket 请求等同于 List Objects 请求，可以列出该存储桶内的部分或者全部对象。该 API 的请求者需要

对存储桶有读取权限。

功能描述

说明

 如果您往存储桶中上传了一个对象，并立即调用 GET Bucket 接口，由于此接口的最终一致性特性，返

回的结果中可能不会包含您刚刚上传的对象。

请求

请求示例

GET / HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

名

称
描述

类

型

是

否

必

选

p

r

e

fi

x

对象键匹配前缀，限定响应中只包含指定前缀的对象键 s

tr

in

g

否

https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

此接口无请求体。

d

el

i

m

it

e

r

一个字符的分隔符，用于对对象键进行分组。所有对象键中从 prefix 或从头（如未指

定 prefix）到首个 delimiter 之间相同的部分将作为 CommonPrefixes 下的一个 

Prefix 节点。被分组的对象键不再出现在后续对象列表中，具体场景和用法可参考下面

的实际案例

s

tr

in

g

否

e

n

c

o

di

n

g

-

t

y

p

e

规定返回值的编码方式，可选值：url，代表返回的对象键为 URL 编码（百分号编码）

后的值，例如“腾讯云”将被编码为 %E8%85%BE%E8%AE%AF%E4%BA%91

s

tr

in

g

否

m

a

r

k

e

r

起始对象键标记，从该标记之后（不含）按照 UTF-8 字典序返回对象键条目

s

tr

in

g

否

m

a

x

-

k

e

y

s

单次返回最大的条目数量，默认值为1000，最大为1000

注意：该参数会限制每一次 List 操作返回的最大条目数，COS 在每次 List 操作中将

返回不超过 max-keys 所设定数值的条目（即 CommonPrefixes 和 Contents 

的总和），如果单次响应中未列出所有对象，COS 会返回 NextMarker 节点，其值

作为您下次 List 请求的 marker 参数，以便您列出后续对象

in

t

e

g

e

r

否

请求头

请求体

响应

https://cloud.tencent.com/document/product/436/7728
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此接口除返回公共响应头部外，还返回以下响应头部，了解公共响应头部详情请参见 公共响应头部  文档。

查询成功，返回 application/xml 数据，包含存储桶中的对象信息。不同场景下的响应体请参见下方的实际案例。

响应头

名称 描述
类

型

x-cos-

bucket-

region

存储桶所在地域。枚举值请参见 地域和访问域名  文档，例如 ap-beijing，

ap-hongkong，eu-frankfurt 等

En

u

m

响应体

<?xml version='1.0' encoding='utf-8' ?>

<ListBucketResult>

            <Name>string</Name>

            <EncodingType>string</EncodingType>

            <Prefix>string</Prefix>

            <Marker>string</Marker>

            <MaxKeys>integer</MaxKeys>

            <Delimiter>string</Delimiter>

            <IsTruncated>boolean</IsTruncated>

            <NextMarker>string</NextMarker>

            <CommonPrefixes>

                <Prefix>string</Prefix>

            </CommonPrefixes>

            <CommonPrefixes>

                <Prefix>string</Prefix>

            </CommonPrefixes>

            <Contents>

                <Key>string</Key>

                <LastModified>date</LastModified>

                <ETag>string</ETag>

                <Size>integer</Size>

                <Owner>

                    <ID>string</ID>

                    <DisplayName>string</DisplayName>

                </Owner>

                <StorageClass>Enum</StorageClass>

                <StorageTier>Enum</StorageTier>

                <RestoreStatus>Enum</RestoreStatus>

            </Contents>

            <Contents>

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/6224
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具体的节点描述如下：

Container 节点 ListBucketResult 的内容：

                <Key>string</Key>

                <LastModified>date</LastModified>

                <ETag>string</ETag>

                <Size>integer</Size>

                <Owner>

                    <ID>string</ID>

                    <DisplayName>string</DisplayName>

                </Owner>

                <StorageClass>Enum</StorageClass>

                <StorageTier>Enum</StorageTier>

                <RestoreStatus>Enum</RestoreStatus>

            </Contents>

</ListBucketResult>

节点名称（关键字） 父节点 描述 类型

ListBucketResult 无 保存 GET Bucket 结果的所有信息 Container

节点

名称

（关

键

字）

父节

点
描述

类

型

Nam

e

List

Buc

ketR

esul

t

存储桶的名称，格式为 <BucketName-APPID> ，例如

examplebucket-1250000000

s

tr

in

g

Enc

odin

gTy

pe

List

Buc

ketR

esul

t

编码格式，对应请求中的 encoding-type 参数，且仅当请求中指定了 

encoding-type 参数才会返回该节点

s

tr

in

g

Prefi

x

List

Buc

ketR

esul

t

对象键匹配前缀，对应请求中的 prefix 参数

s

tr

in

g
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Mar

ker

List

Buc

ketR

esul

t

起始对象键标记，从该标记之后（不含）按照 UTF-8 字典序返回对象键条目，

对应请求中的 marker 参数

s

tr

in

g

Max

Key

s

List

Buc

ketR

esul

t

单次响应返回结果的最大条目数量，对应请求中的 max-keys 参数

in

t

e

g

e

r

Deli

mite

r

List

Buc

ketR

esul

t

分隔符，对应请求中的 delimiter 参数，且仅当请求中指定了 delimiter 参数

才会返回该节点

s

tr

in

g

IsTr

unc

ated

List

Buc

ketR

esul

t

响应条目是否被截断，布尔值，例如 true 或 false

b

o

ol

e

a

n

Nex

tMar

ker

List

Buc

ketR

esul

t

仅当响应条目有截断（IsTruncated 为 true）才会返回该节点，该节点的值为

当前响应条目中的最后一个对象键，当需要继续请求后续条目时，将该节点的值

作为下一次请求的 marker 参数传入

s

tr

in

g

Com

mon

Prefi

xes

List

Buc

ketR

esul

t

从 prefix 或从头（如未指定 prefix）到首个 delimiter 之间相同的部分，定义

为 Common Prefix。仅当请求中指定了 delimiter 参数才有可能返回该节点

C

o

n

t

ai

n

e

r

Con

tent

s

List

Buc

ketR

esul

t

对象条目 C

o

n

t

ai

n
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Container 节点 CommonPrefixes 的内容：

Container 节点 Contents 的内容：

e

r

节点名称（关键

字）
父节点 描述 类型

Prefix
ListBucketResult.CommonPrefi

xes

单条 Common Prefix 的

前缀

strin

g

节

点

名

称

（

关

键

字

）

父

节

点

描述
类

型

K

e

y

Lis

tBu

ck

etR

es

ult.

Co

nte

nts

对象键

s

tr

in

g

L

a

s

t

M

o

di

fi

e

d

Lis

tBu

ck

etR

es

ult.

Co

nte

nts

对象最后修改时间，为 ISO8601 格式，例如2019-05-24T10:56:40Z

d

a

t

e

E

T

Lis

tBu

对象的实体标签（Entity Tag），是对象被创建时标识对象内容的信息标签，可用于

检查对象的内容是否发生变化

s

tr
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a

g

ck

etR

es

ult.

Co

nte

nts

例如“8e0b617ca298a564c3331da28dcb50df”，此头部并不一定返回对象

的 MD5 值，而是根据对象上传和加密方式而有所不同

in

g

S

iz

e

Lis

tBu

ck

etR

es

ult.

Co

nte

nts

对象大小，单位为 Byte

in

t

e

g

e

r

O

w

n

e

r

Lis

tBu

ck

etR

es

ult.

Co

nte

nts

对象持有者信息

C

o

n

t

ai

n

e

r

S

t

o

r

a

g

e

C

la

s

s

Lis

tBu

ck

etR

es

ult.

Co

nte

nts

对象存储类型。枚举值请参见 存储类型  文档，例如 STANDARD_IA，

ARCHIVE

E

n

u

m

S

t

o

r

a

g

Lis

tBu

ck

etR

es

ult.

当对象存储类型为智能分层存储时，指示对象当前所处的存储层，枚举值：

FREQUENT（标准层），INFREQUENT（低频层）。仅当 StorageClass 为 

INTELLIGENT_TIERING（智能分层）时才会返回该节点

E

n

u

m

https://cloud.tencent.com/document/product/436/33417
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Container 节点 Contents.Owner 的内容：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

e

T

ie

r

Co

nte

nts

R

e

s

t

o

r

e

S

t

a

t

u

s

Lis

tBu

ck

etR

es

ult.

Co

nte

nts

当对象存储类型为归档存储或深度归档存储时，指示对象的回热状态，支持枚举值 

ONGOING、DONE、FAILED。当未向对象发起回热请求时，该字段为空；当发

起回热请求后，回热进行中为 ONGING，回热已完成为 DONE，回热失败为 

FAILED。仅当 StorageClass 为 ARCHIVE （归档）或 DEEP_ARCHIVE

（深度归档）时才会返回该节点

E

n

u

m

节点名称（关键字） 父节点 描述 类型

ID ListBucketResult.Contents.Owner 对象持有者的 APPID string

DisplayName ListBucketResult.Contents.Owner 对象持有者的名称 string

错误码

实际案例

案例一：简单案例

请求

GET / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 10 Dec 2020 03:37:41 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

https://cloud.tencent.com/document/product/436/7730
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 2931

Connection: close

Date: Thu, 10 Dec 2020 03:37:41 GMT

Server: tencent-cos

x-cos-bucket-region: ap-beijing

x-cos-request-id: NWZkMTk4MDVfNjViODJhMDlfNDZkYl8xNzU0****

<?xml version='1.0' encoding='utf-8' ?>

<ListBucketResult>

      <Name>examplebucket-1250000000</Name>

      <Prefix/>

      <Marker/>

      <MaxKeys>1000</MaxKeys>

      <IsTruncated>false</IsTruncated>

      <Contents>

          <Key>example-folder-1/example-object-1.jpg</Key>

          <LastModified>2020-12-10T03:37:30.000Z</LastModified>

          <ETag>&quot f173c1199e3d3b53dd91223cae16fb42&quot </ETag>

          <Size>37</Size>

          <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

          </Owner>

          <StorageClass>STANDARD</StorageClass>

      </Contents>

      <Contents>

          <Key>example-folder-1/example-object-2.jpg</Key>

          <LastModified>2020-12-10T03:37:30.000Z</LastModified>

          <ETag>&quot c9d28698978bb6fef6c1ed1c439a17d3&quot </ETag>

          <Size>37</Size>

          <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

          </Owner>

                <StorageClass>INTELLIGENT_TIERING</StorageClass>

                <StorageTier>FREQUENT</StorageTier>

      </Contents>

                .

      <Contents>

          <Key>example-object-2.jpg</Key>

          <LastModified>2020-12-10T03:37:30.000Z</LastModified>

          <ETag>&quot 51370fc64b79d0d3c7c609635be1c41f&quot </ETag>

          <Size>20</Size>

; ;

; ;

..

; ;
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          <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

          </Owner>

          <StorageClass>STANDARD_IA</StorageClass>

      </Contents>

      <Contents>

          <Key>example-object-3.jpg</Key>

          <LastModified>2020-12-10T04:37:30.000Z</LastModified>

          <ETag>&quot 51370fc64b79d0d3c7c609635be1c41f&quot </ETag>

          <Size>20</Size>

          <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

          </Owner>

          <StorageClass>ARCHIVE</StorageClass>

          <RestoreStatus>DONE</RestoreStatus>

      </Contents>

</ListBucketResult>

; ;

案例二：带 encoding-type 参数（对象键使用 URL 编码）

请求

GET /?encoding-type=url HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 08 Dec 2020 13:54:16 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1220

Connection: close

Date: Wed, 09 Dec 2020 15:28:29 GMT

Server: tencent-cos

x-cos-bucket-region: ap-beijing

x-cos-request-id: NWZkMGVkMWRfZjdjNzJhMDlfMjJhYTlfYmJk****

<?xml version='1.0' encoding='utf-8' ?>

<ListBucketResult>

      <Name>examplebucket-1250000000</Name>
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      <EncodingType>url</EncodingType>

      <Prefix/>

      <Marker/>

      <MaxKeys>1000</MaxKeys>

      <IsTruncated>false</IsTruncated>

      <Contents>

                <Key>Tencent%20Cloud.jpg</Key>

                <LastModified>2020-12-09T15:28:19.000Z</LastModified>

                <ETag>&quot ee8de918d05640145b18f70f4c3aa602&quot </ETag>

                <Size>16</Size>

                <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

                <StorageClass>STANDARD</StorageClass>

      </Contents>

      <Contents>

                <Key>%E7%85%A7%E7%89%87/2020%E5%B9%B4/IMG0001.jpg</Key>

                <LastModified>2020-12-09T15:28:19.000Z</LastModified>

                <ETag>&quot ee8de918d05640145b18f70f4c3aa602&quot </ETag>

                <Size>16</Size>

                <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

                <StorageClass>STANDARD</StorageClass>

      </Contents>

      <Contents>

                <Key>%E8%85%BE%E8%AE%AF%E4%BA%91.jpg</Key>

                <LastModified>2020-12-09T15:28:19.000Z</LastModified>

                <ETag>&quot ee8de918d05640145b18f70f4c3aa602&quot </ETag>

                <Size>16</Size>

                <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

                <StorageClass>STANDARD</StorageClass>

            </Contents>

</ListBucketResult>

; ;

; ;

; ;

案例三：带 delimiter 参数（列出根目录下的对象和子目录）

请求

GET /?delimiter=%2F HTTP/1.1
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Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 10 Dec 2020 03:37:41 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1011

Connection: close

Date: Thu, 10 Dec 2020 03:37:41 GMT

Server: tencent-cos

x-cos-bucket-region: ap-beijing

x-cos-request-id: NWZkMTk4MDVfNjRiMDJhMDlfOTZjZV8xOTgw****

<?xml version='1.0' encoding='utf-8' ?>

<ListBucketResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix/>

            <Marker/>

            <MaxKeys>1000</MaxKeys>

            <Delimiter>/</Delimiter>

            <IsTruncated>false</IsTruncated>

            <CommonPrefixes>

                <Prefix>example-folder-1/</Prefix>

            </CommonPrefixes>

            <CommonPrefixes>

                <Prefix>example-folder-2/</Prefix>

            </CommonPrefixes>

            <Contents>

                <Key>example-object-1.jpg</Key>

                <LastModified>2020-12-10T03:37:30.000Z</LastModified>

                <ETag>&quot 0f0cd12c48979d1bf3f95255a36cb861&quot </ETag>

                <Size>20</Size>

                <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

                <StorageClass>STANDARD</StorageClass>

            </Contents>

            <Contents>

                <Key>example-object-2.jpg</Key>

                <LastModified>2020-12-10T03:37:30.000Z</LastModified>

; ;



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第86 共1701页

                <ETag>&quot 51370fc64b79d0d3c7c609635be1c41f&quot </ETag>

                <Size>20</Size>

                <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

                <StorageClass>STANDARD_IA</StorageClass>

            </Contents>

</ListBucketResult>

; ;

案例四：带 prefix 和 delimiter 参数（列出指定子目录下的对象和子目录）

请求

GET /?prefix=example-folder-1%2F&delimiter=%2F HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 10 Dec 2020 03:37:41 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1142

Connection: close

Date: Thu, 10 Dec 2020 03:37:41 GMT

Server: tencent-cos

x-cos-bucket-region: ap-beijing

x-cos-request-id: NWZkMTk4MDVfZGZjNzJhMDlfMzJiMjRfMTY0****

<?xml version='1.0' encoding='utf-8' ?>

<ListBucketResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix>example-folder-1/</Prefix>

            <Marker/>

            <MaxKeys>1000</MaxKeys>

            <Delimiter>/</Delimiter>

            <IsTruncated>false</IsTruncated>

            <CommonPrefixes>

                <Prefix>example-folder-1/sub-folder-1/</Prefix>

            </CommonPrefixes>

            <CommonPrefixes>

                <Prefix>example-folder-1/sub-folder-2/</Prefix>
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            </CommonPrefixes>

            <Contents>

                <Key>example-folder-1/example-object-1.jpg</Key>

                <LastModified>2020-12-10T03:37:30.000Z</LastModified>

                <ETag>&quot f173c1199e3d3b53dd91223cae16fb42&quot </ETag>

                <Size>37</Size>

                <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

                <StorageClass>STANDARD</StorageClass>

            </Contents>

            <Contents>

                <Key>example-folder-1/example-object-2.jpg</Key>

                <LastModified>2020-12-10T03:37:30.000Z</LastModified>

                <ETag>&quot c9d28698978bb6fef6c1ed1c439a17d3&quot </ETag>

                <Size>37</Size>

                <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

                <StorageClass>INTELLIGENT_TIERING</StorageClass>

                <StorageTier>FREQUENT</StorageTier>

            </Contents>

</ListBucketResult>

; ;

; ;

案例五：需分页时获取第一页（案例中限制了 max-keys，如不限制则默认为 1000）

请求

GET /?max-keys=3 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 08 Dec 2020 12:05:10 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1195

Connection: close

Date: Tue, 08 Dec 2020 12:05:10 GMT

Server: tencent-cos
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x-cos-bucket-region: ap-beijing

x-cos-request-id: NWZjZjZiZjZfZGRjODJhMDlfMWFjZDVfMTlmZTY5****

<?xml version='1.0' encoding='utf-8' ?>

<ListBucketResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix/>

            <Marker/>

            <MaxKeys>3</MaxKeys>

            <IsTruncated>true</IsTruncated>

            <NextMarker>example-object-3.jpg</NextMarker>

            <Contents>

                <Key>example-object-1.jpg</Key>

                <LastModified>2020-12-08T12:05:00.000Z</LastModified>

                <ETag>&quot 0f0cd12c48979d1bf3f95255a36cb861&quot </ETag>

                <Size>20</Size>

                <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

                <StorageClass>STANDARD</StorageClass>

            </Contents>

            <Contents>

                <Key>example-object-2.jpg</Key>

                <LastModified>2020-12-08T12:05:00.000Z</LastModified>

                <ETag>&quot 51370fc64b79d0d3c7c609635be1c41f&quot </ETag>

                <Size>20</Size>

                <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

                <StorageClass>STANDARD</StorageClass>

            </Contents>

            <Contents>

                <Key>example-object-3.jpg</Key>

                <LastModified>2020-12-08T12:05:00.000Z</LastModified>

                <ETag>&quot b2f1d893c5fde000ee8ea6eca18ed81f&quot </ETag>

                <Size>20</Size>

                <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

                <StorageClass>STANDARD</StorageClass>

            </Contents>

</ListBucketResult>

; ;

; ;

; ;
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案例六：需分页时获取后续页（续接案例五）

请求

GET /?max-keys=3&marker=example-object-3.jpg HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 08 Dec 2020 12:05:11 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 859

Connection: close

Date: Tue, 08 Dec 2020 12:05:11 GMT

Server: tencent-cos

x-cos-bucket-region: ap-beijing

x-cos-request-id: NWZjZjZiZjdfMjRhZjJhMDlfMjc2NV8xYmE2****

<?xml version='1.0' encoding='utf-8' ?>

<ListBucketResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix/>

            <Marker>example-object-3.jpg</Marker>

            <MaxKeys>3</MaxKeys>

            <IsTruncated>false</IsTruncated>

            <Contents>

                <Key>example-object-4.jpg</Key>

                <LastModified>2020-12-08T12:05:00.000Z</LastModified>

                <ETag>&quot e9ec8bcb980d2e4d8526c346eb3b2585&quot </ETag>

                <Size>20</Size>

                <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

                <StorageClass>STANDARD</StorageClass>

            </Contents>

            <Contents>

                <Key>example-object-5.jpg</Key>

                <LastModified>2020-12-08T12:05:00.000Z</LastModified>

                <ETag>&quot 201669a14bdf051d8a9d6f9828d3f4c4&quot </ETag>

                <Size>20</Size>

; ;

; ;



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第90 共1701页

                <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

                <StorageClass>STANDARD</StorageClass>

            </Contents>

</ListBucketResult>

案例七：需分页时获取第一页（带 delimiter 参数，CommonPrefixes 与 Contents 合计条目数

不超过 max-keys 指定的值）

请求

GET /?delimiter=%2F&max-keys=3 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 09 Dec 2020 03:22:38 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 486

Connection: close

Date: Wed, 09 Dec 2020 03:22:38 GMT

Server: tencent-cos

x-cos-bucket-region: ap-beijing

x-cos-request-id: NWZkMDQyZmVfYTJjMjJhMDlfYmQwOF8xYjkw****

<?xml version='1.0' encoding='utf-8' ?>

<ListBucketResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix/>

            <Marker/>

            <MaxKeys>3</MaxKeys>

            <Delimiter>/</Delimiter>

            <IsTruncated>true</IsTruncated>

            <NextMarker>example-folder-3/</NextMarker>

            <CommonPrefixes>

                <Prefix>example-folder-1/</Prefix>

            </CommonPrefixes>

            <CommonPrefixes>

                <Prefix>example-folder-2/</Prefix>
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            </CommonPrefixes>

            <CommonPrefixes>

                <Prefix>example-folder-3/</Prefix>

            </CommonPrefixes>

</ListBucketResult>

案例八：需分页时获取后续页（带 delimiter 参数，续接案例七）

请求

GET /?delimiter=%2F&max-keys=3&marker=example-folder-3%2F HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 09 Dec 2020 03:22:39 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 956

Connection: close

Date: Wed, 09 Dec 2020 03:22:39 GMT

Server: tencent-cos

x-cos-bucket-region: ap-beijing

x-cos-request-id: NWZkMDQyZmZfZmNhODBiMDlfZmM4N19jYmQz****

<?xml version='1.0' encoding='utf-8' ?>

<ListBucketResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix/>

            <Marker>example-folder-3/</Marker>

            <MaxKeys>3</MaxKeys>

            <Delimiter>/</Delimiter>

            <IsTruncated>false</IsTruncated>

            <CommonPrefixes>

                <Prefix>example-folder-4/</Prefix>

            </CommonPrefixes>

            <Contents>

                <Key>example-object-1.jpg</Key>

                <LastModified>2020-12-09T03:22:28.000Z</LastModified>

                <ETag>&quot 0f0cd12c48979d1bf3f95255a36cb861&quot </ETag>

                <Size>20</Size>

                <Owner>

; ;
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                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

                <StorageClass>STANDARD</StorageClass>

            </Contents>

            <Contents>

                <Key>example-object-2.jpg</Key>

                <LastModified>2020-12-09T03:22:28.000Z</LastModified>

                <ETag>&quot 51370fc64b79d0d3c7c609635be1c41f&quot </ETag>

                <Size>20</Size>

                <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

                <StorageClass>STANDARD</StorageClass>

            </Contents>

</ListBucketResult>

; ;
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HEAD Bucket
最近更新时间：2021-07-22 10:06:52

HEAD Bucket 请求可以确认该存储桶是否存在，是否有权限访问。有以下几种情况：

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

此接口无请求体。

功能描述

存储桶存在且有读取权限，返回 HTTP 状态码为200。

无存储桶读取权限，返回 HTTP 状态码为403。

存储桶不存在，返回 HTTP 状态码为404。

请求

请求示例

HEAD / HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

请求体

响应

响应头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口除返回公共响应头部外，还返回以下响应头部，了解公共响应头部详情请参见 公共响应头部  文档。

此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

名称 描述
类

型

x-cos-

bucket-az-

type

存储桶 AZ 类型，当存储桶为多 AZ 存储桶时返回此头部，值固定为 MAZ。

En

u

m

x-cos-

bucket-region

存储桶所在地域。枚举值请参见 地域和访问域名  文档，例如 ap-beijing，

ap-hongkong，eu-frankfurt 等

En

u

m

响应体

错误码

实际案例

案例一：单 AZ 存储桶

请求

HEAD / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 28 May 2019 03:16:12 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: close

Date: Tue, 28 May 2019 03:16:12 GMT

Server: tencent-cos

x-cos-bucket-region: ap-beijing

x-cos-request-id: NWNlY2E3ZmNfZjhjMDBiMDlfMTBjOWRfZDcz****

案例二：多 AZ 存储桶

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
https://cloud.tencent.com/document/product/436/6224
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请求

HEAD / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 04 Jun 2020 06:43:03 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: close

Date: Thu, 04 Jun 2020 06:43:03 GMT

Server: tencent-cos

x-cos-bucket-az-type: MAZ

x-cos-bucket-region: ap-beijing

x-cos-request-id: NWVkODk3ZjdfZjI4NWQ2NF9hODhkXzRhNmQ0****
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DELETE Bucket
最近更新时间：2021-07-22 10:06:56

DELETE Bucket 请求用于删除指定的存储桶。该 API 的请求者需要对存储桶有写入权限。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

注意

 删除存储桶前，请确保存储桶内的数据和未完成上传的分块数据已全部清空，否则会无法删除存储桶。

请求

请求示例

DELETE / HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

请求体

响应

响应头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

响应体

错误码

实际案例

请求

DELETE / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 28 May 2019 03:19:13 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 204 No Content

Content-Length: 0

Connection: close

Date: Tue, 28 May 2019 03:19:14 GMT

Server: tencent-cos

x-cos-request-id: NWNlY2E4YjFfNjljMDBiMDlfMmNiZTlfZGE0****

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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GET Bucket Object versions
最近更新时间：2021-07-22 10:07:00

GET Bucket Object versions 接口用于拉取存储桶内的所有对象及其历史版本信息，您可以通过指定参数筛选

出存储桶内部分对象及其历史版本信息。该 API 的请求者需要对存储桶有读取权限。

功能描述

请求

请求示例

GET /?versions HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

名称 描述
类

型

是

否

必

选

pref

ix
对象键匹配前缀，限定响应中只包含指定前缀的对象键

stri

ng
否

deli

mit

er

一个字符的分隔符，用于对对象键进行分组。所有对象键中从 prefix 或从头（如

未指定 prefix）到首个 delimiter 之间相同的部分将作为 CommonPrefixes 

下的一个 Prefix 节点。被分组的对象键不再出现在后续对象列表中，具体场景和

用法可参考下面的实际案例

stri

ng
否

enc

odin

规定返回值的编码方式，可选值：url，代表返回的对象键为 URL 编码（百分号

编码）后的值，例如“腾讯云”将被编码为

stri

ng

否

https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

此接口无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

查询成功，返回 application/xml 数据，包含存储桶中的对象版本信息。不同场景下的响应体请参见下方的实际案

例。

g-

typ

e

%E8%85%BE%E8%AE%AF%E4%BA%91

key

-

mar

ker

起始对象键标记，从该标记之后（不含）按照 UTF-8 字典序返回对象版本条目
stri

ng
否

ver

sion

-id-

mar

ker

起始版本 ID 标记，从该标记之后（不含）返回对象版本条目，如果上一次 List 

结果的 NextVersionIdMarker 为空，则该参数也指定为空

stri

ng
否

max

-

key

s

单次返回最大的条目数量，默认值为1000，最大为1000

注意：该参数会限制每一次 List 操作返回的最大条目数，COS 在每次 List 操作

中将返回不超过 max-keys 所设定数值的条目（CommonPrefixes、

Version 和 DeleteMarker 合计），如果单次响应中未列出所有对象，COS 

会返回 NextKeyMarker 和 NextVersionIdMarker 节点，其值分别为您下

次 List 请求的 key-marker 和 version-id-marker 参数，以便您列出后续

版本

int

eg

er

否

请求头

请求体

响应

响应头

响应体

<ListVersionsResult>

        <EncodingType>string</EncodingType>

        <Name>string</Name>

        <Prefix>string</Prefix>

        <KeyMarker>string</KeyMarker>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
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        <VersionIdMarker>string</VersionIdMarker>

        <MaxKeys>integer</MaxKeys>

        <IsTruncated>boolean</IsTruncated>

        <NextKeyMarker>string</NextKeyMarker>

        <NextVersionIdMarker>string</NextVersionIdMarker>

        <Delimiter>string</Delimiter>

        <CommonPrefixes>

            <Prefix>string</Prefix>

        </CommonPrefixes>

        <CommonPrefixes>

            <Prefix>string</Prefix>

        </CommonPrefixes>

        <Version>

            <Key>string</Key>

            <VersionId>string</VersionId>

            <IsLatest>boolean</IsLatest>

            <LastModified>date</LastModified>

            <ETag>string</ETag>

            <Size>integer</Size>

            <StorageClass>Enum</StorageClass>

            <StorageTier>Enum</StorageTier>

            <Owner>

                <ID>string</ID>

                <DisplayName>string</DisplayName>

            </Owner>

        </Version>

        <DeleteMarker>

            <Key>string</Key>

            <VersionId>string</VersionId>

            <IsLatest>boolean</IsLatest>

            <LastModified>date</LastModified>

            <Owner>

                <ID>string</ID>

                <DisplayName>string</DisplayName>

            </Owner>

        </DeleteMarker>

        <Version>

            <Key>string</Key>

            <VersionId>string</VersionId>

            <IsLatest>boolean</IsLatest>

            <LastModified>date</LastModified>

            <ETag>string</ETag>

            <Size>integer</Size>

            <StorageClass>Enum</StorageClass>

            <StorageTier>Enum</StorageTier>
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具体的节点描述如下：

Container 节点 ListVersionsResult 的内容：

            <Owner>

                <ID>string</ID>

                <DisplayName>string</DisplayName>

            </Owner>

        </Version>

        <DeleteMarker>

            <Key>string</Key>

            <VersionId>string</VersionId>

            <IsLatest>boolean</IsLatest>

            <LastModified>date</LastModified>

            <Owner>

                <ID>string</ID>

                <DisplayName>string</DisplayName>

            </Owner>

        </DeleteMarker>

</ListVersionsResult>

节点名称（关键字）
父节

点
描述 类型

ListVersionsResu

lt
无

保存 GET Bucket Object versions 结果的所有

信息

Containe

r

节点

名称

（关

键

字）

父节

点
描述 类型

Enc

odin

gTy

pe

List

Ver

sion

sRe

sult

编码格式，对应请求中的 encoding-type 参数，且仅当请求中指定了 

encoding-type 参数才会返回该节点

strin

g

Na

me

List

Ver

sion

sRe

sult

存储桶的名称，格式为 <BucketName-APPID> ，例如

examplebucket-1250000000

strin

g

Pref List 对象键匹配前缀，对应请求中的 prefix 参数 strin
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ix Ver

sion

sRe

sult

g

Key

Mar

ker

List

Ver

sion

sRe

sult

起始对象键标记，从该标记之后（不含）按照 UTF-8 字典序返回对象版本

条目，对应请求中的 key-marker 参数

strin

g

Ver

sion

IdM

ark

er

List

Ver

sion

sRe

sult

起始版本 ID 标记，从该标记之后（不含）返回对象版本条目，对应请求中的 

version-id-marker 参数

strin

g

Max

Key

s

List

Ver

sion

sRe

sult

单次响应返回结果的最大条目数量，对应请求中的 max-keys 参数
integ

er

IsTr

unc

ate

d

List

Ver

sion

sRe

sult

响应条目是否被截断，布尔值，例如 true 或 false
bool

ean

Nex

tKe

yMa

rker

List

Ver

sion

sRe

sult

仅当响应条目有截断（IsTruncated 为 true）才会返回该节点，该节点的

值为当前响应条目中的最后一个对象键，当需要继续请求后续条目时，将该节

点的值作为下一次请求的 key-marker 参数传入

strin

g

Nex

tVer

sion

IdM

ark

er

List

Ver

sion

sRe

sult

仅当响应条目有截断（IsTruncated 为 true）才会返回该节点，该节点的

值为当前响应条目中的最后一个对象的版本 ID，当需要继续请求后续条目

时，将该节点的值作为下一次请求的 version-id-marker 参数传入。该节

点的值可能为空，此时下一次请求的 version-id-marker 参数也需要指定

为空。

strin

g

Deli

mit

er

List

Ver

sion

sRe

sult

分隔符，对应请求中的 delimiter 参数，且仅当请求中指定了 delimiter 参

数才会返回该节点

strin

g
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Container 节点 CommonPrefixes 的内容：

Container 节点 Version 的内容：

Co

mm

onP

refi

xes

List

Ver

sion

sRe

sult

从 prefix 或从头（如未指定 prefix）到首个 delimiter 之间相同的部分，

定义为 Common Prefix。仅当请求中指定了 delimiter 参数才有可能返回

该节点

Cont

ainer

Ver

sion

List

Ver

sion

sRe

sult

对象版本条目
Cont

ainer

Del

ete

Mar

ker

List

Ver

sion

sRe

sult

对象删除标记条目
Cont

ainer

节点名称（关键

字）
父节点 描述 类型

Prefix
ListVersionsResult.CommonPrefi

xes

单条 Common Prefix 的

前缀

strin

g

节点

名称

（关

键

字）

父节点 描述 类型

Key

ListV

ersion

sResu

lt.Ver

sion

对象键 string

Ver

sion

Id

ListV

ersion

sResu

lt.Ver

sion

对象的版本 ID

当未启用版本控制时，该节点的值为空字符串

当启用版本控制时，启用版本控制之前的对象，其版本 ID 为 null

当暂停版本控制时，新上传的对象其版本 ID 为 null，且同一个对象

最多只存在一个版本 ID 为 null 的对象版本

string
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Container 节点 Version.Owner 的内容：

IsLa

test

ListV

ersion

sResu

lt.Ver

sion

当前版本是否为该对象的最新版本
boole

an

Last

Mod

ified

ListV

ersion

sResu

lt.Ver

sion

当前版本的最后修改时间，为 ISO8601 格式，例如2019-05-

24T10:56:40Z
date

ETa

g

ListV

ersion

sResu

lt.Ver

sion

对象的实体标签（Entity Tag），是对象被创建时标识对象内容的信息

标签，可用于检查对象的内容是否发生变化

例如"8e0b617ca298a564c3331da28dcb50df"。此头部并不一定

返回对象的 MD5 值，而是根据对象上传和加密方式而有所不同

string

Size

ListV

ersion

sResu

lt.Ver

sion

对象大小，单位为 Byte
integ

er

Stor

age

Clas

s

ListV

ersion

sResu

lt.Ver

sion

对象存储类型。枚举值请参见 存储类型  文档，例如 

STANDARD_IA，ARCHIVE
Enum

Stor

age

Tier

ListV

ersion

sResu

lt.Ver

sion

当对象存储类型为智能分层存储时，指示对象当前所处的存储层，枚举

值：FREQUENT（标准层），INFREQUENT（低频层）。仅当 

StorageClass 为 INTELLIGENT_TIERING（智能分层）时才会返

回该节点

Enum

Ow

ner

ListV

ersion

sResu

lt.Ver

sion

对象持有者信息
Conta

iner

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/436/33417


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第105 共1701页

Container 节点 DeleteMarker 的内容：

Container 节点 DeleteMarker.Owner 的内容：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

ID ListVersionsResult.Version.Owner 对象持有者的 APPID string

DisplayName ListVersionsResult.Version.Owner 对象持有者的名称 string

节点名称

（关键字）
父节点 描述 类型

Key
ListVersionsResult.

DeleteMarker
对象键

strin

g

VersionI

d

ListVersionsResult.

DeleteMarker
对象的删除标记的版本 ID

strin

g

IsLatest
ListVersionsResult.

DeleteMarker
当前删除标记是否为该对象的最新版本

bool

ean

LastModi

fied

ListVersionsResult.

DeleteMarker

当前删除标记的删除时间，为 ISO8601 格式，例

如2019-05-24T10:56:40Z
date

Owner
ListVersionsResult.

DeleteMarker
对象持有者信息

Cont

ainer

节点名称（关键

字）
父节点 描述 类型

ID
ListVersionsResult.DeleteMarker.Own

er

对象持有者的 

APPID

strin

g

DisplayName
ListVersionsResult.DeleteMarker.Own

er
对象持有者的名称

strin

g

错误码

实际案例

案例一：未启用版本控制

请求

GET /?versions HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

https://cloud.tencent.com/document/product/436/7730
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Date: Thu, 10 Dec 2020 03:35:34 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 952

Connection: close

Date: Thu, 10 Dec 2020 03:35:34 GMT

Server: tencent-cos

x-cos-request-id: NWZkMTk3ODZfZDUyNzVkNjRfNDgxYl8xNjU5****

<ListVersionsResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix/>

            <KeyMarker/>

            <VersionIdMarker/>

            <MaxKeys>1000</MaxKeys>

            <IsTruncated>false</IsTruncated>

            <Version>

                <Key>example-object-1.jpg</Key>

                <VersionId/>

                <IsLatest>true</IsLatest>

                <LastModified>2020-12-10T03:35:24.000Z</LastModified>

                <ETag>&quot 0f0cd12c48979d1bf3f95255a36cb861&quot </ETag>

                <Size>20</Size>

                <StorageClass>STANDARD</StorageClass>

                <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

            <Version>

                <Key>example-object-2.jpg</Key>

                <VersionId/>

                <IsLatest>true</IsLatest>

                <LastModified>2020-12-10T03:35:24.000Z</LastModified>

                <ETag>&quot dcffaafe67632b2bd2dd0b9456eafca7&quot </ETag>

                <Size>23</Size>

                <StorageClass>INTELLIGENT_TIERING</StorageClass>

; ;

; ;
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                <StorageTier>FREQUENT</StorageTier>

                <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

</ListVersionsResult>

案例二：启用版本控制（续接案例一，在启用版本控制前上传的对象，其版本 ID 为 null）

请求

GET /?versions HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 10 Dec 2020 03:36:05 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 2070

Connection: close

Date: Thu, 10 Dec 2020 03:36:05 GMT

Server: tencent-cos

x-cos-request-id: NWZkMTk3YTVfYjFiODJhMDlfNTg0MDZfMTdj****

<ListVersionsResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix/>

            <KeyMarker/>

            <VersionIdMarker/>

            <MaxKeys>1000</MaxKeys>

            <IsTruncated>false</IsTruncated>

            <Version>

                <Key>example-object-1.jpg</Key>

                <VersionId>null</VersionId>

                <IsLatest>true</IsLatest>

                <LastModified>2020-12-10T03:35:24.000Z</LastModified>

                <ETag>&quot 0f0cd12c48979d1bf3f95255a36cb861&quot </ETag>

                <Size>20</Size>

; ;
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                <StorageClass>STANDARD</StorageClass>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

            <Version>

                <Key>example-object-2.jpg</Key>

                <VersionId>MTg0NDUxMzY1MDIzNjQ3NTcwMDk</VersionId>

                <IsLatest>true</IsLatest>

                <LastModified>2020-12-10T03:35:44.000Z</LastModified>

                <ETag>&quot 51ffadb19b3bf062ecd0c6f044a4d4ce&quot </ETag>

                <Size>23</Size>

                <StorageClass>STANDARD_IA</StorageClass>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

            <Version>

                <Key>example-object-2.jpg</Key>

                <VersionId>null</VersionId>

                <IsLatest>false</IsLatest>

                <LastModified>2020-12-10T03:35:24.000Z</LastModified>

                <ETag>&quot dcffaafe67632b2bd2dd0b9456eafca7&quot </ETag>

                <Size>23</Size>

                <StorageClass>INTELLIGENT_TIERING</StorageClass>

                <StorageTier>FREQUENT</StorageTier>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

            <DeleteMarker>

                <Key>example-object-3.jpg</Key>

                <VersionId>MTg0NDUxMzY1MDIzNTQ1ODM2NjE</VersionId>

                <IsLatest>true</IsLatest>

                <LastModified>2020-12-10T03:35:54.000Z</LastModified>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </DeleteMarker>

            <Version>

                <Key>example-object-3.jpg</Key>

; ;

; ;
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                <VersionId>MTg0NDUxMzY1MDIzNjQ3NjM2MDY</VersionId>

                <IsLatest>false</IsLatest>

                <LastModified>2020-12-10T03:35:44.000Z</LastModified>

                <ETag>&quot b2f1d893c5fde000ee8ea6eca18ed81f&quot </ETag>

                <Size>20</Size>

                <StorageClass>STANDARD</StorageClass>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

</ListVersionsResult>

; ;

案例三：暂停版本控制（续接案例二，暂停版本控制后新上传的对象其版本 ID 为 null，且同一个对

象最多只存在一个版本 ID 为 null 的对象版本）

请求

GET /?versions HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 10 Dec 2020 03:36:25 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 2396

Connection: close

Date: Thu, 10 Dec 2020 03:36:25 GMT

Server: tencent-cos

x-cos-request-id: NWZkMTk3YjlfNDhhOTBiMDlfMTYzNTZfMTIw****

<ListVersionsResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix/>

            <KeyMarker/>

            <VersionIdMarker/>

            <MaxKeys>1000</MaxKeys>

            <IsTruncated>false</IsTruncated>

            <Version>
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                <Key>example-object-1.jpg</Key>

                <VersionId>null</VersionId>

                <IsLatest>true</IsLatest>

                <LastModified>2020-12-10T03:35:24.000Z</LastModified>

                <ETag>&quot 0f0cd12c48979d1bf3f95255a36cb861&quot </ETag>

                <Size>20</Size>

                <StorageClass>STANDARD</StorageClass>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

            <Version>

                <Key>example-object-2.jpg</Key>

                <VersionId>null</VersionId>

                <IsLatest>true</IsLatest>

                <LastModified>2020-12-10T03:36:15.000Z</LastModified>

                <ETag>&quot 51ffadb19b3bf062ecd0c6f044a4d4ce&quot </ETag>

                <Size>23</Size>

                <StorageClass>STANDARD</StorageClass>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

            <Version>

                <Key>example-object-2.jpg</Key>

                <VersionId>MTg0NDUxMzY1MDIzNjQ3NTcwMDk</VersionId>

                <IsLatest>false</IsLatest>

                <LastModified>2020-12-10T03:35:44.000Z</LastModified>

                <ETag>&quot 51ffadb19b3bf062ecd0c6f044a4d4ce&quot </ETag>

                <Size>23</Size>

                <StorageClass>STANDARD_IA</StorageClass>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

            <Version>

                <Key>example-object-3.jpg</Key>

                <VersionId>null</VersionId>

                <IsLatest>true</IsLatest>

                <LastModified>2020-12-10T03:36:15.000Z</LastModified>

                <ETag>&quot b2f1d893c5fde000ee8ea6eca18ed81f&quot </ETag>

                <Size>20</Size>

; ;

; ;

; ;

; ;
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                <StorageClass>STANDARD</StorageClass>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

            <DeleteMarker>

                <Key>example-object-3.jpg</Key>

                <VersionId>MTg0NDUxMzY1MDIzNTQ1ODM2NjE</VersionId>

                <IsLatest>false</IsLatest>

                <LastModified>2020-12-10T03:35:54.000Z</LastModified>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </DeleteMarker>

            <Version>

                <Key>example-object-3.jpg</Key>

                <VersionId>MTg0NDUxMzY1MDIzNjQ3NjM2MDY</VersionId>

                <IsLatest>false</IsLatest>

                <LastModified>2020-12-10T03:35:44.000Z</LastModified>

                <ETag>&quot b2f1d893c5fde000ee8ea6eca18ed81f&quot </ETag>

                <Size>20</Size>

                <StorageClass>STANDARD</StorageClass>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

</ListVersionsResult>

; ;

案例四：带 encoding-type 参数（对象键使用 URL 编码）

请求

GET /?versions&encoding-type=url HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 10 Dec 2020 04:54:22 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK
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Content-Type: application/xml

Content-Length: 2167

Connection: close

Date: Thu, 10 Dec 2020 04:54:22 GMT

Server: tencent-cos

x-cos-request-id: NWZkMWE5ZmVfZTdjODJhMDlfMzgxZl8xMzQ1****

<ListVersionsResult>

            <EncodingType>url</EncodingType>

            <Name>examplebucket-1250000000</Name>

            <Prefix/>

            <KeyMarker/>

            <VersionIdMarker/>

            <MaxKeys>1000</MaxKeys>

            <IsTruncated>false</IsTruncated>

            <Version>

                <Key>Tencent%20Cloud.jpg</Key>

                <VersionId>MTg0NDUxMzY0OTc2NjcxNzE4NjA</VersionId>

                <IsLatest>true</IsLatest>

                <LastModified>2020-12-10T04:54:02.000Z</LastModified>

                <ETag>&quot ee8de918d05640145b18f70f4c3aa602&quot </ETag>

                <Size>16</Size>

                <StorageClass>STANDARD</StorageClass>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

            <DeleteMarker>

                <Key>%E7%85%A7%E7%89%87/2020%E5%B9%B4/IMG0001.jpg</Key>

                <VersionId>MTg0NDUxMzY0OTc2NTY5MDU3OTc</VersionId>

                <IsLatest>true</IsLatest>

                <LastModified>2020-12-10T04:54:12.000Z</LastModified>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </DeleteMarker>

            <Version>

                <Key>%E7%85%A7%E7%89%87/2020%E5%B9%B4/IMG0001.jpg</Key>

                <VersionId>MTg0NDUxMzY0OTc2NjcwNjMwMDQ</VersionId>

                <IsLatest>false</IsLatest>

                <LastModified>2020-12-10T04:54:02.000Z</LastModified>

; ;
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                <ETag>&quot ee8de918d05640145b18f70f4c3aa602&quot </ETag>

                <Size>16</Size>

                <StorageClass>STANDARD</StorageClass>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

            <Version>

                <Key>%E8%85%BE%E8%AE%AF%E4%BA%91.jpg</Key>

                <VersionId>MTg0NDUxMzY0OTc2NTY5MDA4NzU</VersionId>

                <IsLatest>true</IsLatest>

                <LastModified>2020-12-10T04:54:12.000Z</LastModified>

                <ETag>&quot 8bb76a43f75d3b96442c470f8ec23b89&quot </ETag>

                <Size>16</Size>

                <StorageClass>STANDARD</StorageClass>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

            <Version>

                <Key>%E8%85%BE%E8%AE%AF%E4%BA%91.jpg</Key>

                <VersionId>MTg0NDUxMzY0OTc2NjcxNzA2ODg</VersionId>

                <IsLatest>false</IsLatest>

                <LastModified>2020-12-10T04:54:02.000Z</LastModified>

                <ETag>&quot dcc880c5eba9e002bc4567c733b0e63e&quot </ETag>

                <Size>13</Size>

                <StorageClass>STANDARD</StorageClass>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

</ListVersionsResult>

; ;

; ;

; ;

案例五：带 delimiter 参数（列出根目录下的对象版本和子目录）

请求

GET /?versions&delimiter=%2F HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 10 Dec 2020 07:04:03 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1893

Connection: close

Date: Thu, 10 Dec 2020 07:04:03 GMT

Server: tencent-cos

x-cos-request-id: NWZkMWM4NjNfNzFjODJhMDlfMjlhZTRfMTg5****

<ListVersionsResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix/>

            <KeyMarker/>

            <VersionIdMarker/>

            <MaxKeys>1000</MaxKeys>

            <IsTruncated>false</IsTruncated>

            <Delimiter>/</Delimiter>

            <CommonPrefixes>

                <Prefix>example-folder-1/</Prefix>

            </CommonPrefixes>

            <CommonPrefixes>

                <Prefix>example-folder-2/</Prefix>

            </CommonPrefixes>

            <DeleteMarker>

                <Key>example-object-1.jpg</Key>

                <VersionId>MTg0NDUxMzY0ODk4NzYzNTE4Nzk</VersionId>

                <IsLatest>true</IsLatest>

                <LastModified>2020-12-10T07:03:53.000Z</LastModified>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </DeleteMarker>

            <Version>

                <Key>example-object-1.jpg</Key>

                <VersionId>MTg0NDUxMzY0ODk4ODY2NTcxMzY</VersionId>

                <IsLatest>false</IsLatest>

                <LastModified>2020-12-10T07:03:42.000Z</LastModified>

                <ETag>&quot 0f0cd12c48979d1bf3f95255a36cb861&quot </ETag>

                <Size>20</Size>

                <StorageClass>STANDARD</StorageClass>

; ;
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                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

            <Version>

                <Key>example-object-2.jpg</Key>

                <VersionId>MTg0NDUxMzY0ODk4NzYzODYyODA</VersionId>

                <IsLatest>true</IsLatest>

                <LastModified>2020-12-10T07:03:53.000Z</LastModified>

                <ETag>&quot 51ffadb19b3bf062ecd0c6f044a4d4ce&quot </ETag>

                <Size>23</Size>

                <StorageClass>INTELLIGENT_TIERING</StorageClass>

                <StorageTier>FREQUENT</StorageTier>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

            <Version>

                <Key>example-object-2.jpg</Key>

                <VersionId>MTg0NDUxMzY0ODk4ODY2NTA0Mjk</VersionId>

                <IsLatest>false</IsLatest>

                <LastModified>2020-12-10T07:03:42.000Z</LastModified>

                <ETag>&quot dcffaafe67632b2bd2dd0b9456eafca7&quot </ETag>

                <Size>23</Size>

                <StorageClass>STANDARD_IA</StorageClass>

                <Owner>

                 <ID>1250000000</ID>

                 <DisplayName>1250000000</DisplayName>

                </Owner>

            </Version>

</ListVersionsResult>

; ;

; ;

案例六：带 prefix 和 delimiter 参数（列出指定子目录下的对象版本和子目录）

请求

GET /?versions&prefix=example-folder-1%2F&delimiter=%2F HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 10 Dec 2020 07:04:03 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1960

Connection: close

Date: Thu, 10 Dec 2020 07:04:03 GMT

Server: tencent-cos

x-cos-request-id: NWZkMWM4NjNfZWVjODJhMDlfNTNmN18xNWNj****

<ListVersionsResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix>example-folder-1/</Prefix>

            <KeyMarker/>

            <VersionIdMarker/>

            <MaxKeys>1000</MaxKeys>

            <IsTruncated>false</IsTruncated>

            <Delimiter>/</Delimiter>

            <CommonPrefixes>

             <Prefix>example-folder-1/sub-folder-1/</Prefix>

            </CommonPrefixes>

            <CommonPrefixes>

             <Prefix>example-folder-1/sub-folder-2/</Prefix>

            </CommonPrefixes>

            <DeleteMarker>

             <Key>example-folder-1/example-object-1.jpg</Key>

             <VersionId>MTg0NDUxMzY0ODk4NzYzNjE4NzA</VersionId>

             <IsLatest>true</IsLatest>

             <LastModified>2020-12-10T07:03:53.000Z</LastModified>

             <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

             </Owner>

            </DeleteMarker>

            <Version>

             <Key>example-folder-1/example-object-1.jpg</Key>

             <VersionId>MTg0NDUxMzY0ODk4ODY2NTAzOTY</VersionId>

             <IsLatest>false</IsLatest>

             <LastModified>2020-12-10T07:03:42.000Z</LastModified>

             <ETag>&quot f173c1199e3d3b53dd91223cae16fb42&quot </ETag>

             <Size>37</Size>

             <StorageClass>STANDARD</StorageClass>

             <Owner>

; ;
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                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

             </Owner>

            </Version>

            <Version>

             <Key>example-folder-1/example-object-2.jpg</Key>

             <VersionId>MTg0NDUxMzY0ODk4NzYzNzc2ODY</VersionId>

             <IsLatest>true</IsLatest>

             <LastModified>2020-12-10T07:03:53.000Z</LastModified>

             <ETag>&quot f52cc0bc2042d201b852385927bcab95&quot </ETag>

             <Size>40</Size>

             <StorageClass>STANDARD</StorageClass>

             <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

             </Owner>

            </Version>

            <Version>

             <Key>example-folder-1/example-object-2.jpg</Key>

             <VersionId>MTg0NDUxMzY0ODk4ODY2NjQ2NDc</VersionId>

             <IsLatest>false</IsLatest>

             <LastModified>2020-12-10T07:03:42.000Z</LastModified>

             <ETag>&quot 7b3be6c39746a970d628e6ab9f250342&quot </ETag>

             <Size>40</Size>

             <StorageClass>STANDARD</StorageClass>

             <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

             </Owner>

            </Version>

</ListVersionsResult>

; ;

; ;

案例七：需分页时获取第一页（案例中限制了 max-keys，如不限制则默认为 1000，Version 与 

DeleteMarker 合计条目数不超过 max-keys 指定的值）

请求

GET /?versions&max-keys=3 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 08 Dec 2020 12:46:40 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1390

Connection: close

Date: Tue, 08 Dec 2020 12:46:40 GMT

Server: tencent-cos

x-cos-request-id: NWZjZjc1YjBfYjBhODBiMDlfZDU5Yl9jYjBl****

<ListVersionsResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix/>

            <KeyMarker/>

            <VersionIdMarker/>

            <MaxKeys>3</MaxKeys>

            <IsTruncated>true</IsTruncated>

            <NextKeyMarker>example-object-2.jpg</NextKeyMarker>

            <NextVersionIdMarker>MTg0NDUxMzY2NDIxMjk3MzMwOTM</NextVersionIdMark

            <Version>

             <Key>example-object-1.jpg</Key>

             <VersionId>MTg0NDUxMzY2NDIxNTAwOTk4NzA</VersionId>

             <IsLatest>true</IsLatest>

             <LastModified>2020-12-08T12:45:59.000Z</LastModified>

             <ETag>&quot 15f0f671f04af108023b5603bea2bfda&quot </ETag>

             <Size>23</Size>

             <StorageClass>STANDARD</StorageClass>

             <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

             </Owner>

            </Version>

            <Version>

             <Key>example-object-1.jpg</Key>

             <VersionId>MTg0NDUxMzY2NDIxNjAyODcyNzk</VersionId>

             <IsLatest>false</IsLatest>

             <LastModified>2020-12-08T12:45:49.000Z</LastModified>

             <ETag>&quot 601389434817e2781d8efb35c0e44717&quot </ETag>

             <Size>23</Size>

             <StorageClass>STANDARD</StorageClass>

             <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

             </Owner>

            </Version>

; ;

; ;
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            <DeleteMarker>

             <Key>example-object-2.jpg</Key>

             <VersionId>MTg0NDUxMzY2NDIxMjk3MzMwOTM</VersionId>

             <IsLatest>true</IsLatest>

             <LastModified>2020-12-08T12:46:19.000Z</LastModified>

             <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

             </Owner>

            </DeleteMarker>

</ListVersionsResult>

案例八：需分页时获取后续页（续接案例七，使用 key-marker 和 version-id-marker 请求参

数）

请求

GET /?versions&max-keys=3&key-marker=example-object-2.jpg&version-id-marker=MTg

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 08 Dec 2020 12:46:41 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1052

Connection: close

Date: Tue, 08 Dec 2020 12:46:41 GMT

Server: tencent-cos

x-cos-request-id: NWZjZjc1YjFfNjljMDBiMDlfNjQwOV8xYjM2****

<ListVersionsResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix/>

            <KeyMarker>example-object-2.jpg</KeyMarker>

            <VersionIdMarker>MTg0NDUxMzY2NDIxMjk3MzMwOTM</VersionIdMarker>

            <MaxKeys>3</MaxKeys>

            <IsTruncated>false</IsTruncated>

            <Version>

             <Key>example-object-2.jpg</Key>
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             <VersionId>MTg0NDUxMzY2NDIxMzk5MDk1NzU</VersionId>

             <IsLatest>false</IsLatest>

             <LastModified>2020-12-08T12:46:09.000Z</LastModified>

             <ETag>&quot 51370fc64b79d0d3c7c609635be1c41f&quot </ETag>

             <Size>20</Size>

             <StorageClass>STANDARD</StorageClass>

             <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

             </Owner>

            </Version>

            <Version>

             <Key>example-object-3.jpg</Key>

             <VersionId>MTg0NDUxMzY2NDIxMTk1NTEyNDI</VersionId>

             <IsLatest>true</IsLatest>

             <LastModified>2020-12-08T12:46:30.000Z</LastModified>

             <ETag>&quot b2f1d893c5fde000ee8ea6eca18ed81f&quot </ETag>

             <Size>20</Size>

             <StorageClass>STANDARD</StorageClass>

             <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

             </Owner>

            </Version>

</ListVersionsResult>

; ;

; ;

案例九：使用 key-marker 指定起始对象（续接案例七，但仅使用 key-marker 请求参数而不使

用 version-id-marker 请求参数）

请求

GET /?versions&max-keys=3&key-marker=example-object-2.jpg HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 08 Dec 2020 12:46:41 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 610

Connection: close

Date: Tue, 08 Dec 2020 12:46:42 GMT
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Server: tencent-cos

x-cos-request-id: NWZjZjc1YjJfZGZjMTBiMDlfNzAyYl8xMzkx****

<ListVersionsResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix/>

            <KeyMarker>example-object-2.jpg</KeyMarker>

            <VersionIdMarker/>

            <MaxKeys>3</MaxKeys>

            <IsTruncated>false</IsTruncated>

            <Version>

             <Key>example-object-3.jpg</Key>

             <VersionId>MTg0NDUxMzY2NDIxMTk1NTEyNDI</VersionId>

             <IsLatest>true</IsLatest>

             <LastModified>2020-12-08T12:46:30.000Z</LastModified>

             <ETag>&quot b2f1d893c5fde000ee8ea6eca18ed81f&quot </ETag>

             <Size>20</Size>

             <StorageClass>STANDARD</StorageClass>

             <Owner>

              <ID>1250000000</ID>

              <DisplayName>1250000000</DisplayName>

             </Owner>

            </Version>

</ListVersionsResult>

; ;

案例十：需分页时获取第一页（带 delimiter 参数，CommonPrefixes、Version 与 

DeleteMarker 合计条目数不超过 max-keys 指定的值）

请求

GET /?versions&delimiter=%2F&max-keys=3 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 09 Dec 2020 13:40:24 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 503
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Connection: close

Date: Wed, 09 Dec 2020 13:40:24 GMT

Server: tencent-cos

x-cos-request-id: NWZkMGQzYzhfYmIwMmEwOV83OGU4XzZj****

<ListVersionsResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix/>

            <KeyMarker/>

            <VersionIdMarker/>

            <MaxKeys>3</MaxKeys>

            <IsTruncated>true</IsTruncated>

            <NextKeyMarker>example-folder-3/</NextKeyMarker>

            <NextVersionIdMarker/>

            <Delimiter>/</Delimiter>

            <CommonPrefixes>

             <Prefix>example-folder-1/</Prefix>

            </CommonPrefixes>

            <CommonPrefixes>

             <Prefix>example-folder-2/</Prefix>

            </CommonPrefixes>

            <CommonPrefixes>

             <Prefix>example-folder-3/</Prefix>

            </CommonPrefixes>

</ListVersionsResult>

案例十一：需分页时获取后续页（带 delimiter 参数，续接案例十，因为第一页返回的 

NextVersionIdMarker 为空，所以本次请求的 version-id-marker 参数也指定为空）

请求

GET /?versions&delimiter=%2F&max-keys=3&key-marker=example-folder-3%2F&version

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 09 Dec 2020 14:02:32 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1115

Connection: close

Date: Wed, 09 Dec 2020 14:02:32 GMT
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Server: tencent-cos

x-cos-request-id: NWZkMGQ4ZjhfZmVhODBiMDlfMTI3NzVfMTBj****

<ListVersionsResult>

            <Name>examplebucket-1250000000</Name>

            <Prefix/>

            <KeyMarker>example-folder-3/</KeyMarker>

            <VersionIdMarker/>

            <MaxKeys>3</MaxKeys>

            <IsTruncated>true</IsTruncated>

            <NextKeyMarker>example-object.jpg</NextKeyMarker>

            <NextVersionIdMarker>MTg0NDUxMzY1NTExNzc4NTYzMTk</NextVersionIdMarke

            <Delimiter>/</Delimiter>

            <CommonPrefixes>

             <Prefix>example-folder-4/</Prefix>

            </CommonPrefixes>

            <Version>

             <Key>example-object.jpg</Key>

             <VersionId>MTg0NDUxMzY1NTExNjc2OTk4MjE</VersionId>

             <IsLatest>true</IsLatest>

             <LastModified>2020-12-09T14:02:21.000Z</LastModified>

             <ETag>&quot 3979f6bb23f827d258be64cc0d8df5fb&quot </ETag>

             <Size>21</Size>

             <StorageClass>STANDARD</StorageClass>

             <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

             </Owner>

            </Version>

            <DeleteMarker>

             <Key>example-object.jpg</Key>

             <VersionId>MTg0NDUxMzY1NTExNzc4NTYzMTk</VersionId>

             <IsLatest>false</IsLatest>

             <LastModified>2020-12-09T14:02:11.000Z</LastModified>

             <Owner>

                    <ID>1250000000</ID>

                    <DisplayName>1250000000</DisplayName>

             </Owner>

            </DeleteMarker>

</ListVersionsResult>

; ;
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访问控制（acl）

PUT Bucket acl
最近更新时间：2022-12-15 14:51:05

PUT Bucket acl 接口用来写入存储桶的访问控制列表（ACL），您可以通过请求头 x-cos-acl  和 

x-cos-grant-*  传入 ACL 信息，或者通过请求体以 XML 格式传入 ACL 信息。

示例一

示例二

功能描述

注意

通过请求头设置 ACL 和通过请求体设置 ACL 两种方式只能选择其中一种。

PUT Bucket acl 是一个覆盖操作，传入新的 ACL 将覆盖原有 ACL。

支持对腾讯云 CAM 主账号、匿名用户、子用户授予权限，如需授予用户组权限请参见 为用户组添加/

解除策略 。有关 ACL 的详细说明，请参见 ACL 概述 。

该 API 的请求者需要对存储桶有写入 ACL 权限。

请求

请求示例

PUT /?acl HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-Length: 0

Authorization: Auth String

PUT /?acl HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-Type: application/xml

Content-Length: Content Length

Content-MD5: MD5

Authorization: Auth String

Request Body[ ]

https://cloud.tencent.com/document/product/598/37299
https://cloud.tencent.com/document/product/436/30752
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此接口无请求参数。

此接口除使用公共请求头部外，还支持以下请求头部，了解公共请求头部详情请参见 公共请求头部  文档。

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

名称 描述
类

型

是

否

必

选

x-

cos-

acl

定义存储桶的访问控制列表（ACL）属性。枚举值请参见 ACL 概述  文档中存储

桶的预设 ACL 部分，例如 private, public-read 等，默认为 private

En

um
否

x-

cos-

gran

t-

read

赋予被授权者读取存储桶的权限。若被授权者为主账号，格式为 id="

[OwnerUin]"，如 id="100000000001"；若被授权者为子账号，格式为 id="

[OwnerUin/GrantsUin]"，如 id="100000000001/100000000011"。可使

用半角逗号（,）分隔多组被授权者，如 

id="100000000001",id="100000000002"

str

ing
否

x-

cos-

gran

t-

write

赋予被授权者写入存储桶的权限。若被授权者为主账号，格式为 id="

[OwnerUin]"，如 id="100000000001"；若被授权者为子账号，格式为 id="

[OwnerUin/GrantsUin]"，如 id="100000000001/100000000011"。可使

用半角逗号（,）分隔多组被授权者，如 

id="100000000001",id="100000000002"

str

ing
否

x-

cos-

gran

t-

read

-acp

赋予被授权者读取存储桶的访问控制列表（ACL）的权限。若被授权者为主账

号，格式为 id="[OwnerUin]"，如 id="100000000001"；若被授权者为子账

号，格式为 id="[OwnerUin/GrantsUin]"，如 

id="100000000001/100000000011"。可使用半角逗号（,）分隔多组被授权

者，如 id="100000000001",id="100000000002"

str

ing
否

x- 赋予被授权者写入存储桶的访问控制列表（ACL）的权限。若被授权者为主账 str 否

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/30752#.E9.A2.84.E8.AE.BE.E7.9A.84-acl
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提交 application/xml 请求数据，包含存储桶所有者和完整的授权信息。

具体的节点描述如下：

cos-

gran

t-

write

-acp

号，格式为 id="[OwnerUin]"，如 id="100000000001"；若被授权者为子账

号，格式为 id="[OwnerUin/GrantsUin]"，如 

id="100000000001/100000000011"。可使用半角逗号（,）分隔多组被授权

者，如 id="100000000001",id="100000000002"

ing

x-

cos-

gran

t-

full-

cont

rol

赋予被授权者操作存储桶的所有权限。若被授权者为主账号，格式为 id="

[OwnerUin]"，如 id="100000000001"；若被授权者为子账号，格式为 id="

[OwnerUin/GrantsUin]"，如 id="100000000001/100000000011"。可使

用半角逗号（,）分隔多组被授权者，如 

id="100000000001",id="100000000002"

str

ing
否

请求体

<AccessControlPolicy>

    <Owner>

        <ID>string</ID>

    </Owner>

    <AccessControlList>

        <Grant>

            <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="G

                <URI>string</URI>

            </Grantee>

            <Permission>Enum</Permission>

        </Grant>

        <Grant>

            <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="C

                <ID>string</ID>

            </Grantee>

            <Permission>Enum</Permission>

        </Grant>

    </AccessControlList>

</AccessControlPolicy>

节点名称（关键字）
父节

点
描述 类型

是否必

选

AccessControlPoli

cy
无

包含 PUT Bucket acl 操作的所有请求

信息

Contain

er
是
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Container 节点 AccessControlPolicy 的内容：

Container 节点 Owner 的内容：

Container 节点 AccessControlList 的内容：

Container 节点 AccessControlList.Grant 的内容：

节点名称（关键字） 父节点 描述 类型
是否必

选

Owner
AccessControlPoli

cy
存储桶持有者信息

Containe

r
是

AccessControlLi

st

AccessControlPoli

cy

被授权者信息与权限信

息

Containe

r
是

节点名

称（关

键字）

父节点 描述
类

型

是否

必选

ID

AccessC

ontrolPol

icy.Own

er

存储桶持有者的完整 ID，格式为 

qcs::cam::uin/[OwnerUin]:uin/[OwnerUin] ，如 

qcs::cam::uin/100000000001:uin/100000000001

stri

ng
是

节点名称

（关键字）
父节点 描述 类型 是否必选

Grant

AccessControl

Policy.AccessC

ontrolList

单个授权信息，一个 

AccessControlList 最多只能拥有100

条 Grant

Con

tain

er

是

节点

名称

（关

键

字）

父节点 描述
类

型

是否

必选

Gran

tee

AccessCont

rolPolicy.Ac

cessControl

List.Grant

被授权者信息， xsi:type  可指定为 Group 或 

CanonicalUser，当指定为 Group 时子节点包括且

仅允许包括 URI，当指定为 CanonicalUser 时子节

点包括且仅允许包括 ID

Co

nta

ine

r

是

Per

missi

AccessCont

rolPolicy.Ac

授予的权限信息。枚举值请参见 ACL 概述  文档中存储

桶的操作部分，如 WRITE，FULL_CONTROL 等

En

um

是

https://cloud.tencent.com/document/product/436/30752#.E6.93.8D.E4.BD.9C-permission
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Container 节点 AccessControlList.Grant.Grantee 的内容：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

on cessControl

List.Grant

节

点

名

称

（

关

键

字

）

父节点 描述
类

型
是否必选

U

RI

AccessContr

olPolicy.Acce

ssControlList.

Grant.Grante

e

预设用户组。请参见 ACL 概述  文档中预设用户组部

分，如 

http://cam.qcloud.com/groups/global/AllUsers  

或 

http://cam.qcloud.com/groups/global/Authent

icatedUsers

s

tr

in

g

当 

Grantee  

的 

xsi:type  

指定为 

Group  时

必选

I

D

AccessContr

olPolicy.Acce

ssControlList.

Grant.Grante

e

被授权者的完整 ID，格式为 

qcs::cam::uin/[OwnerUin]:uin/[OwnerUin] ，如 

qcs::cam::uin/100000000001:uin/100000000

001

s

tr

in

g

当 

Grantee  

的 

xsi:type  

指定为 

Canonic

alUser

时必选

响应

响应头

响应体

错误码

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
https://cloud.tencent.com/document/product/436/30752#.E8.BA.AB.E4.BB.BD-grantee
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实际案例

案例一：通过请求头设置 ACL

请求

PUT /?acl HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Mon, 17 Jun 2019 08:30:12 GMT

x-cos-acl: public-read

x-cos-grant-write: id="100000000002"

x-cos-grant-read-acp: id="100000000002"

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Mon, 17 Jun 2019 08:30:13 GMT

Server: tencent-cos

x-cos-request-id: NWQwNzRmOTRfODhjMjJhMDlfMWRlYl81Mzc0****

案例二：通过请求体设置 ACL

请求

PUT /?acl HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Mon, 17 Jun 2019 08:30:13 GMT

Content-Type: application/xml

Content-Length: 812

Content-MD5: 1qS+8SqnivarcO6Z11R0nw==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<AccessControlPolicy>

    <Owner>

        <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

    </Owner>

    <AccessControlList>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第130 共1701页

        <Grant>

            <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="G

                <URI>http://cam.qcloud.com/groups/global/AllUsers</URI>

            </Grantee>

            <Permission>READ</Permission>

        </Grant>

        <Grant>

            <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="C

                <ID>qcs::cam::uin/100000000002:uin/100000000002</ID>

            </Grantee>

            <Permission>WRITE</Permission>

        </Grant>

        <Grant>

            <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="C

                <ID>qcs::cam::uin/100000000002:uin/100000000002</ID>

            </Grantee>

            <Permission>READ_ACP</Permission>

        </Grant>

    </AccessControlList>

</AccessControlPolicy>

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Mon, 17 Jun 2019 08:30:13 GMT

Server: tencent-cos

x-cos-request-id: NWQwNzRmOTVfMzBjMDJhMDlfOTM3MF8yNzdj****
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GET Bucket acl
最近更新时间：2021-07-22 10:07:07

GET Bucket acl 接口用来获取存储桶的访问控制列表（ACL）。该 API 的请求者需要对存储桶有读取 ACL 权

限。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

请求

请求示例

GET /?acl HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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查询成功，返回 application/xml 数据，包含存储桶所有者和完整的授权信息。

具体的节点描述如下：

Container 节点 AccessControlPolicy 的内容：

Container 节点 Owner 的内容：

<AccessControlPolicy>

    <Owner>

        <ID>string</ID>

        <DisplayName>string</DisplayName>

    </Owner>

    <AccessControlList>

        <Grant>

            <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="G

                <URI>string</URI>

            </Grantee>

            <Permission>Enum</Permission>

        </Grant>

        <Grant>

            <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="C

                <ID>string</ID>

                <DisplayName>string</DisplayName>

            </Grantee>

            <Permission>Enum</Permission>

        </Grant>

    </AccessControlList>

</AccessControlPolicy>

节点名称（关键字） 父节点 描述 类型

AccessControlPolicy 无 保存 GET Bucket acl 结果的所有信息 Container

节点名称（关键字） 父节点 描述 类型

Owner AccessControlPolicy 存储桶持有者信息 Container

AccessControlList AccessControlPolicy 被授权者信息与权限信息 Container

节点名

称（关

键字）

父节点 描述
类

型

ID AccessC 存储桶持有者的完整 ID，格式为 st
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Container 节点 AccessControlList 的内容：

Container 节点 AccessControlList.Grant 的内容：

Container 节点 AccessControlList.Grant.Grantee 的内容：

ontrolPoli

cy.Owner
qcs::cam::uin/[OwnerUin]:uin/[OwnerUin] ，如 

qcs::cam::uin/100000000001:uin/100000000001

ri

n

g

Displa

yName

AccessC

ontrolPoli

cy.Owner

存储桶持有者的名字

st

ri

n

g

节点名称（关键

字）
父节点 描述 类型

Grant
AccessControlPolicy.AccessControlLis

t

单个授权信

息
Container

节点

名称

（关

键

字）

父节点 描述
类

型

Gra

nte

e

AccessControl

Policy.AccessC

ontrolList.Gran

t

被授权者信息， xsi:type  为 Group 或 CanonicalUser，当为 

Group 时子节点包括且仅包括 URI，当指定为 CanonicalUser 

时子节点包括且仅包括 ID 和 DisplayName

C

o

n

t

ai

n

e

r

Per

mis

sio

n

AccessControl

Policy.AccessC

ontrolList.Gran

t

授予的权限信息，枚举值请参见 ACL 概述  文档中存储桶的操作部

分，如 WRITE，FULL_CONTROL 等

E

n

u

m

节点

名称

（关

键

字）

父节点 描述 类

型

https://cloud.tencent.com/document/product/436/30752#.E6.93.8D.E4.BD.9C-permission
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

URI

AccessControl

Policy.Access

ControlList.Gr

ant.Grantee

预设用户组，请参见 ACL 概述  文档中预设用户组部分，如 

http://cam.qcloud.com/groups/global/AllUsers  或 

http://cam.qcloud.com/groups/global/AuthenticatedUse

rs

stri

ng

ID

AccessControl

Policy.Access

ControlList.Gr

ant.Grantee

被授权者的完整 ID，格式为 

qcs::cam::uin/[OwnerUin]:uin/[OwnerUin] ，如 

qcs::cam::uin/100000000001:uin/100000000001

stri

ng

Displ

ayNa

me

AccessControl

Policy.Access

ControlList.Gr

ant.Grantee

被授权者的名字
stri

ng

错误码

实际案例

请求

GET /?acl HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Mon, 17 Jun 2019 08:37:35 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1035

Connection: close

Date: Mon, 17 Jun 2019 08:37:36 GMT

Server: tencent-cos

x-cos-request-id: NWQwNzUxNTBfMzdiMDJhMDlfOWM0Nl85NDFk****

<AccessControlPolicy>

    <Owner>

        <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

        <DisplayName>qcs::cam::uin/100000000001:uin/100000000001</DisplayName>

    </Owner>

https://cloud.tencent.com/document/product/436/7730
https://cloud.tencent.com/document/product/436/30752#.E8.BA.AB.E4.BB.BD-grantee
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    <AccessControlList>

        <Grant>

            <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="G

                <URI>http://cam.qcloud.com/groups/global/AllUsers</URI>

            </Grantee>

            <Permission>READ</Permission>

        </Grant>

        <Grant>

            <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="C

                <ID>qcs::cam::uin/100000000002:uin/100000000002</ID>

                <DisplayName>qcs::cam::uin/100000000002:uin/100000000002</DisplayNam

            </Grantee>

            <Permission>WRITE</Permission>

        </Grant>

        <Grant>

            <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="C

                <ID>qcs::cam::uin/100000000002:uin/100000000002</ID>

                <DisplayName>qcs::cam::uin/100000000002:uin/100000000002</DisplayNam

            </Grantee>

            <Permission>READ_ACP</Permission>

        </Grant>

    </AccessControlList>

</AccessControlPolicy>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第136 共1701页

跨域资源共享（cors）

PUT Bucket cors
最近更新时间：2021-07-22 10:07:16

PUT Bucket cors 请求用于为存储桶配置跨域资源共享（CORS）访问控制，您可以通过传入 XML 格式的配置

文件来实现配置，文件大小限制为64KB。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

提交 application/xml 请求数据，包含完整的存储桶跨域资源共享（CORS）配置信息。

功能描述

请求

请求示例

PUT /?cors HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-Type: application/xml

Content-Length: Content Length

Content-MD5: MD5

Authorization: Auth String

[Request Body]

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

请求体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体的节点描述如下：

Container 节点 CORSConfiguration 的内容：

Container 节点 CORSRule 的内容：

<CORSConfiguration>

    <CORSRule>

        <AllowedOrigin>string</AllowedOrigin>

        <AllowedMethod>enum</AllowedMethod>

        <AllowedMethod>enum</AllowedMethod>

        <AllowedHeader>string</AllowedHeader>

        <AllowedHeader>string</AllowedHeader>

        <ExposeHeader>string</ExposeHeader>

        <ExposeHeader>string</ExposeHeader>

        <MaxAgeSeconds>integer</MaxAgeSeconds>

    </CORSRule>

    <CORSRule>

        <ID>string</ID>

        <AllowedOrigin>string</AllowedOrigin>

        <AllowedOrigin>string</AllowedOrigin>

        <AllowedMethod>enum</AllowedMethod>

        <AllowedMethod>enum</AllowedMethod>

        <AllowedHeader>string</AllowedHeader>

        <ExposeHeader>string</ExposeHeader>

        <ExposeHeader>string</ExposeHeader>

        <MaxAgeSeconds>integer</MaxAgeSeconds>

    </CORSRule>

</CORSConfiguration>

节点名称（关键字）
父节

点
描述 类型

是否必

选

CORSConfigurati

on
无

包含 PUT Bucket cors 操作的所有请求

信息

Contain

er
否

节点名称

（关键

字）

父节点 描述 类型

是

否

必

选

CORSRu

le

CORSConf

iguration

说明单条跨域资源共享（CORS）配置的所有信息，

最多可以包含100条 CORSRule

Cont

aine

r

是
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节

点

名

称

（

关

键

字

）

父

节

点

描述 类

型

是

否

必

选

Al

lo

w

e

d

O

ri

gi

n

CO

RS

Co

nfi

gur

ati

on.

CO

RS

Rul

e

允许的访问来源，单条 CORSRule 可以配置多个 AllowedOrigin。

配置支持 * ，表示全部域名都允许，但不推荐。

支持单个具体域名，例如 http://www.example.com 。

支持 *  通配符，通配符可出现在任何位置，包括协议、域名和端口，

可匹配0个或多个字符，但是只能有一个 * 。请谨慎使用通配符，因为

可能意外匹配到非预期的来源

注意不要遗漏协议名 http 或 https，若端口不是默认的80(http)或

443(https)，还需要带上端口，例如 https://example.com:8443

。

st

ri

n

g

是

Al

lo

w

e

d

M

et

h

o

d

CO

RS

Co

nfi

gur

ati

on.

CO

RS

Rul

e

允许的 HTTP 操作方法（Method），对应 CORS 请求响应中的 

Access-Control-Allow-Methods 头部，单条 CORSRule 可以配

置多个 AllowedMethod。枚举值：PUT、GET、POST、

DELETE、HEAD。

e

n

u

m

是

Al

lo

w

e

d

H

e

a

d

er

CO

RS

Co

nfi

gur

ati

on.

CO

RS

Rul

e

在发送预检（OPTIONS）请求时，浏览器会告知服务端接下来的正式请

求将使用的自定义 HTTP 请求头部，此配置用于指定允许浏览器发送 

CORS 请求时携带的自定义 HTTP 请求头部，不区分英文大小写，单条 

CORSRule 可以配置多个 AllowedHeader。

可以配置 * ，代表允许所有头部，为了避免遗漏，推荐配置为 * 。

如果不配置为 * ，那么在预检（OPTIONS）请求中 Access-

Control-Request-Headers 头部出现的每个 Header，都必须在 

AllowedHeader 中有对应项。

st

ri

n

g

是
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

E

x

p

o

s

e

H

e

a

d

er

CO

RS

Co

nfi

gur

ati

on.

CO

RS

Rul

e

允许浏览器获取的 CORS 请求响应中的头部，不区分大小写，单条 

CORSRule 可以配置多个 ExposeHeader。

默认情况下浏览器只能访问简单响应头部：Cache-Control、

Content-Type、Expires、Last-Modified，如果需要访问其他

响应头部，需要添加 ExposeHeader 配置。

不支持配置为 * ，必须明确配置具体的 Header。

根据浏览器的实际需求确定，默认推荐填写 ETag，可参考各 API 文

档的响应头部分及 公共响应头部  文档。

st

ri

n

g

是

M

a

x

A

g

e

S

e

c

o

n

d

s

CO

RS

Co

nfi

gur

ati

on.

CO

RS

Rul

e

跨域资源共享配置的有效时间，单位为秒，在有效时间内，浏览器无须为同

一请求再次发起预检（OPTIONS）请求，对应 CORS 请求响应中的 

Access-Control-Max-Age 头部，单条 CORSRule 只能配置一个 

MaxAgeSeconds。

in

te

g

er

是

ID

CO

RS

Co

nfi

gur

ati

on.

CO

RS

Rul

e

单条 CORSRule 配置的 ID，用于在 GET Bucket cors 时查找指定 

CORSRule。可选填，单条 CORSRule 最多配置一个 ID。

st

ri

n

g

否

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7729
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此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

错误码

实际案例

请求

PUT /?cors HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 09 Jul 2020 11:15:01 GMT

Content-Type: application/xml

Content-Length: 1185

Content-MD5: ZNkhBxyjkaZcs1j7/cIE2A==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<CORSConfiguration>

    <CORSRule>

        <AllowedOrigin>*</AllowedOrigin>

        <AllowedMethod>GET</AllowedMethod>

        <AllowedMethod>HEAD</AllowedMethod>

        <AllowedHeader>Range</AllowedHeader>

        <AllowedHeader>x-cos-server-side-encryption-customer-algorithm</AllowedHeader

        <AllowedHeader>x-cos-server-side-encryption-customer-key</AllowedHeader>

        <AllowedHeader>x-cos-server-side-encryption-customer-key-MD5</AllowedHeader>

        <ExposeHeader>Content-Length</ExposeHeader>

        <ExposeHeader>ETag</ExposeHeader>

        <ExposeHeader>x-cos-meta-author</ExposeHeader>

        <MaxAgeSeconds>600</MaxAgeSeconds>

    </CORSRule>

    <CORSRule>

        <ID>example-id</ID>

        <AllowedOrigin>https://example.com</AllowedOrigin>

        <AllowedOrigin>https://example.net</AllowedOrigin>

        <AllowedMethod>PUT</AllowedMethod>

        <AllowedMethod>GET</AllowedMethod>

        ...

        <AllowedMethod>HEAD</AllowedMethod>

        <AllowedHeader>*</AllowedHeader>

        <ExposeHeader>Content-Length</ExposeHeader>

        <ExposeHeader>ETag</ExposeHeader>

        <ExposeHeader>x-cos-meta-author</ExposeHeader>

        <MaxAgeSeconds>600</MaxAgeSeconds>

https://cloud.tencent.com/document/product/436/7730
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    </CORSRule>

</CORSConfiguration>

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Thu, 09 Jul 2020 11:15:01 GMT

Server: tencent-cos

x-cos-request-id: NWYwNmZjMzVfMzFiYjBiMDlfZjgzYV8xZDky****
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GET Bucket cors
最近更新时间：2021-07-22 10:07:21

GET Bucket cors 请求用于查询存储桶的跨域资源共享（CORS）访问控制。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

此接口无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

请求

请求示例

GET /?cors HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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查询成功，返回 application/xml 数据，包含完整的存储桶跨域资源共享（CORS）配置信息。

具体的节点描述如下：

Container 节点 CORSConfiguration 的内容：

Container 节点 CORSRule 的内容：

<?xml version='1.0' encoding='utf-8' ?>

<CORSConfiguration>

    <CORSRule>

        <AllowedOrigin>string</AllowedOrigin>

        <AllowedMethod>enum</AllowedMethod>

        <AllowedMethod>enum</AllowedMethod>

        <AllowedHeader>string</AllowedHeader>

        <AllowedHeader>string</AllowedHeader>

        <ExposeHeader>string</ExposeHeader>

        <ExposeHeader>string</ExposeHeader>

        <MaxAgeSeconds>integer</MaxAgeSeconds>

    </CORSRule>

    <CORSRule>

        <ID>string</ID>

        <AllowedOrigin>string</AllowedOrigin>

        <AllowedOrigin>string</AllowedOrigin>

        <AllowedMethod>enum</AllowedMethod>

        <AllowedMethod>enum</AllowedMethod>

        <AllowedHeader>string</AllowedHeader>

        <ExposeHeader>string</ExposeHeader>

        <ExposeHeader>string</ExposeHeader>

        <MaxAgeSeconds>integer</MaxAgeSeconds>

    </CORSRule>

</CORSConfiguration>

节点名称（关键字） 父节点 描述 类型

CORSConfiguration 无 保存 GET Bucket cors 结果的所有信息 Container

节点名称（关键

字）
父节点 描述 类型

CORSRule
CORSConfigurat

ion

说明单条跨域资源共享（CORS）配置的所

有信息

Contain

er

节

点

父节点 描述 类

型
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名

称

（

关

键

字

）

All

ow

ed

Ori

gin

CORSC

onfigura

tion.CO

RSRule

允许的访问来源，可能为 *  或包含 *  的通配格式，单条 CORSRule 可

以配置多个 AllowedOrigin

s

tr

in

g

All

ow

ed

Me

tho

d

CORSC

onfigura

tion.CO

RSRule

允许的 HTTP 操作方法（Method），对应 CORS 请求响应中的 

Access-Control-Allow-Methods 头部，单条 CORSRule 可以配置

多个 AllowedMethod。枚举值：PUT、GET、POST、DELETE、

HEAD

e

n

u

m

All

ow

ed

He

ad

er

CORSC

onfigura

tion.CO

RSRule

允许浏览器发送 CORS 请求时携带的自定义 HTTP 请求头部，不区分英文

大小写，可能为 * ，单条 CORSRule 可以配置多个 AllowedHeader。

s

tr

in

g

Ex

po

se

He

ad

er

CORSC

onfigura

tion.CO

RSRule

允许浏览器获取的 CORS 请求响应中的头部，不区分英文大小写，单条 

CORSRule 可以配置多个 ExposeHeader。

s

tr

in

g

Ma

xA

ge

Se

co

nd

s

CORSC

onfigura

tion.CO

RSRule

跨域资源共享配置的有效时间，单位为秒，对应 CORS 请求响应中的 

Access-Control-Max-Age 头部，单条 CORSRule 只能配置一个 

MaxAgeSeconds

in

t

e

g

e

r

ID CORSC

onfigura

tion.CO

RSRule

单条 CORSRule 配置的 ID，该节点的存在与否取决于使用 PUT Bucket 

cors 设置存储桶跨域资源共享配置时是否指定了 ID，单条 CORSRule 最

多配置一个 ID

s

tr

in

g
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

错误码

实际案例

请求

GET /?cors HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 09 Jul 2020 11:15:12 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1196

Connection: close

Date: Thu, 09 Jul 2020 11:15:12 GMT

Server: tencent-cos

x-cos-request-id: NWYwNmZjNDBfN2ViMTJhMDlfZDNjOV8xYjdk****

<?xml version='1.0' encoding='utf-8' ?>

<CORSConfiguration>

    <CORSRule>

        <AllowedOrigin>*</AllowedOrigin>

        <AllowedMethod>GET</AllowedMethod>

        <AllowedMethod>HEAD</AllowedMethod>

        <AllowedHeader>Range</AllowedHeader>

        <AllowedHeader>x-cos-server-side-encryption-customer-algorithm</AllowedHeader

        <AllowedHeader>x-cos-server-side-encryption-customer-key</AllowedHeader>

        <AllowedHeader>x-cos-server-side-encryption-customer-key-MD5</AllowedHeader>

        <ExposeHeader>Content-Length</ExposeHeader>

        <ExposeHeader>ETag</ExposeHeader>

        <ExposeHeader>x-cos-meta-author</ExposeHeader>

        <MaxAgeSeconds>600</MaxAgeSeconds>

    </CORSRule>

    <CORSRule>

        <ID>example-id</ID>

        <AllowedOrigin>https://example.com</AllowedOrigin>

        <AllowedOrigin>https://example-1.com</AllowedOrigin>

https://cloud.tencent.com/document/product/436/7730
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        <AllowedMethod>PUT</AllowedMethod>

        <AllowedMethod>GET</AllowedMethod>

        ...

        <AllowedMethod>HEAD</AllowedMethod>

        <AllowedHeader>*</AllowedHeader>

        <ExposeHeader>Content-Length</ExposeHeader>

        <ExposeHeader>ETag</ExposeHeader>

        <ExposeHeader>x-cos-meta-author</ExposeHeader>

        <MaxAgeSeconds>600</MaxAgeSeconds>

    </CORSRule>

</CORSConfiguration>
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DELETE Bucket cors
最近更新时间：2021-07-22 10:07:27

DELETE Bucket cors 请求用于删除存储桶的跨域资源共享（CORS）访问控制。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

此接口无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

请求

请求示例

DELETE /?cors HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

错误码

实际案例

请求

DELETE /?cors HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 09 Jul 2020 11:52:50 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 204 No Content

Connection: close

Date: Thu, 09 Jul 2020 11:52:50 GMT

Server: tencent-cos

x-cos-request-id: NWYwNzA1MTJfNjRiODJhMDlfMWMyMzlfMWMyNzhl****

x-cos-trace-id: OGVmYzZiMmQzYjA2OWNhODk0NTRkMTBiOWVmMDAxODczNTBmNjMwZm

Content-Length: 0

https://cloud.tencent.com/document/product/436/7730
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生命周期（lifecycle）

PUT Bucket lifecycle
最近更新时间：2022-12-16 15:55:35

COS 支持用户以生命周期配置的方式来管理 Bucket 中 Object 的生命周期。生命周期配置包含一个或多个将应

用于一组对象规则的规则集（其中每个规则为 COS 定义一个操作）。 

这些操作分为以下两种：

PUT Bucket lifecycle 用于为 Bucket 创建一个新的生命周期配置。

功能描述

转换操作：定义对象转换为另一个存储类的时间。例如，您可以选择在对象创建30天后将其转换为低频存储

（STANDARD_IA，适用于不常访问）存储类别。同时也支持将数据沉降到智能分层存储

（INTELLIGENT_TIERING，访问模式不固定）和归档存储（ARCHIVE，成本更低）。具体参数查看请求

示例说明中 Transition 项。

过期操作：指定 Object 的过期时间。COS 将会自动为用户删除过期的 Object。

细节分析

注意

如果该 Bucket 已配置生命周期，使用该接口创建新的配置的同时则会覆盖原有的配置。

同一条生命周期规则中不可同时支持 Days 和 Date 参数，请分成两条规则分别传入，具体请参见下

文 实际案例 。

开启了 多 AZ  配置的存储桶，不支持将多 AZ 存储类型沉降到单 AZ 存储类型。

每个存储桶最多可添加1000条生命周期规则。

请求

请求示例

PUT /?lifecycle HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Content-Length: length

Date: GMT Date

Authorization: Auth String 

Content-MD5: MD5

说明

https://cloud.tencent.com/document/product/436/40548
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该 API 接口请求的请求体具体节点内容为：

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

<LifecycleConfiguration>

    <Rule>

        <ID></ID>

        <Filter>

            <And>

                <Prefix></Prefix>

                <Tag>

                    <Key></Key>

                    <Value></Value>

                </Tag>

            </And>

        </Filter>

        <Status></Status>

        <Transition>

            <Days></Days>

            <StorageClass></StorageClass>

        </Transition>

        <NoncurrentVersionExpiration>

            <NoncurrentDays></NoncurrentDays>

        </NoncurrentVersionExpiration>

    </Rule>

    <Rule>

        <ID></ID>

        <Filter>

            <Prefix></Prefix>

        </Filter>

        <Status></Status>

        <Transition>

            <Days></Days>

            <StorageClass></StorageClass>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体内容描述如下：

        </Transition>

        <NoncurrentVersionTransition>

            <NoncurrentDays></NoncurrentDays>

            <StorageClass></StorageClass>

        </NoncurrentVersionTransition>

    </Rule>

    <Rule>

        <ID></ID>

        <Filter>

            <Prefix></Prefix>

        </Filter>

        <Status></Status>

        <Expiration>

            <ExpiredObjectDeleteMarker></ExpiredObjectDeleteMarker>

        </Expiration>

        <NoncurrentVersionExpiration>

            <NoncurrentDays></NoncurrentDays>

        </NoncurrentVersionExpiration>

        <AbortIncompleteMultipartUpload>

            <DaysAfterInitiation></DaysAfterInitiation>

        </AbortIncompleteMultipartUpload>

    </Rule>

</LifecycleConfiguration>

节点名

称（关

键字）

父节点 描述 类型

是

否

必

选

Lifecy

cleCo

nfigur

ation

无 生命周期配置
Cont

ainer
是

Rule
LifecycleConfigura

tion
规则描述

Cont

ainer
是

ID
LifecycleConfigura

tion.Rule
用于唯一地标识规则，长度不能超过255个字符

Strin

g
否

Filter
LifecycleConfigura

tion.Rule
Filter 用于描述规则影响的 Object 集合

Cont

ainer
是

And LifecycleConfigura 对象筛选器中的一个子集，仅当需要指定多种筛 Cont 否
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tion.Rule

.Filter

选规则时才需要

此元素，例如：同时指定 Prefix 和 Tag 筛选，

或同时指定多个 Tag 筛选。

ainer

Prefix

LifecycleConfigura

tion.Rule

.Filter.And

指定规则所适用的前缀。匹配前缀的对象受该规

则影响，Prefix 

最多只能有一个

Strin

g
否

Tag

LifecycleConfigura

tion.Rule

.Filter.And

标签集合，最多支持10个标签
Cont

ainer
否

Key

LifecycleConfigura

tion.Rule

.Filter.And.Tag

标签的 Key，长度不超过128字节，支持英文字

母、数字、空格、加号、

减号、下划线、等号、点号、冒号、斜线

Strin

g
否

Value

LifecycleConfigura

tion.Rule

.Filter.And.Tag

标签的 Value，长度不超过256字节, 支持英文

字母、数字、空格、加号、

减号、下划线、等号、点号、冒号、斜线

Strin

g
否

Statu

s

LifecycleConfigura

tion.Rule

指明规则是否启用，枚举值：Enabled，

Disabled

Strin

g
是

Expir

ation

LifecycleConfigura

tion.Rule
规则过期属性

Cont

ainer
否

Trans

ition

LifecycleConfigura

tion.Rule

规则转换属性，用于描述对象何时进行存储类型

的转换和转换的存储类型

Cont

ainer
否

Days

LifecycleConfigura

tion.Rule

.Transition 或 

Expiration

指明规则对应的动作在对象最后的修改日期过后

多少天操作：

如果是 Transition，该字段有效值是非负整

数

如果是 Expiration，该字段有效值为正整

数，最大支持3650天

Integ

er
否

Expir

edObj

ectDe

leteM

arker

LifecycleConfigura

tion.Rule

.Expiration

删除过期对象删除标记，枚举值 true，false
Strin

g
否

AbortI

ncom

plete

Multip

LifecycleConfigura

tion.Rule

设置允许分片上传保持运行的最长时间 Cont

ainer

否
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体为空。

artUpl

oad

Days

AfterI

nitiati

on

LifecycleConfigura

tion.Rule

.AbortIncomplete

MultipartUpload

指明分片上传开始后多少天内必须完成上传
Integ

er
是

Nonc

urrent

Versi

onEx

pirati

on

LifecycleConfigura

tion.Rule
指明非当前版本对象何时过期

Cont

ainer
否

Nonc

urrent

Versi

onTra

nsitio

n

LifecycleConfigura

tion.Rule

指明非当前版本对象何时进行存储类型的转换和

转换的存储类型

Cont

ainer
否

Nonc

urrent

Days

LifecycleConfigura

tion.Rule

.NoncurrentVersio

nExpiration 

或

NoncurrentVersio

nTransition

指明规则对应的动作在对象变成非当前版本多少

天后执行

如果是 Transition，该字段有效值是非负整

数

如果是 Expiration，该字段有效值为正整

数，最大支持3650天

Integ

er
否

Stora

geCla

ss

LifecycleConfigura

tion.Rule

Transition 或 

NoncurrentVersio

nTransition

指定 Object 沉降后的存储类型，枚举值： 

STANDARD_IA，

MAZ_STANDARD_IA，

INTELLIGENT_TIERING，

MAZ_INTELLIGENT_TIERING，

ARCHIVE，DEEP_ARCHIVE。关于存储类

型的介绍，请参见 存储类型概述

Strin

g
是

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/33417
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

错误码

实际案例

请求

PUT /?lifecycle HTTP/1.1

Host:examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 16 Aug 2017 11:59:33 GMT

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Content-MD5: LcNUuow8OSZMrEDnvndw1Q==

Content-Length: 348

Content-Type: application/x-www-form-urlencoded

<LifecycleConfiguration>

      <Rule>

            <ID>id1</ID>

            <Filter>

                  <Prefix>documents/</Prefix>

            </Filter>

            <Status>Enabled</Status>

            <Transition>

                  <Days>100</Days>

                  <StorageClass>ARCHIVE</StorageClass>

            </Transition>

      </Rule>

      <Rule>

            <ID>id2</ID>

            <Filter>

                  <Prefix>logs/</Prefix>

            </Filter>

            <Status>Enabled</Status>

            <Transition>

                  <Days>10</Days>

                  <StorageClass>STANDARD_IA</StorageClass>

            </Transition>

      </Rule>

</LifecycleConfiguration>

响应

https://cloud.tencent.com/document/product/436/7730
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Date: Wed, 16 Aug 2017 11:59:33 GMT

Server: tencent-cos

x-cos-request-id: NTk5NDMzYTRfMjQ4OGY3Xzc3NGRf****
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GET Bucket lifecycle
最近更新时间：2021-09-24 18:32:30

GET Bucket lifecycle 用于查询 Bucket 的生命周期配置。如果该 Bucket 没有配置生命周期规则会返回 

NoSuchLifecycleConfiguration。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应体中各个元素的内容及含义与 PUT Buket lifecycle 时的请求体一致。详情请参见 PUT Bucket 

lifecycle  文档中的请求体节点描述内容。

功能描述

请求

请求示例

GET /?lifecycle HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/8280
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

错误码

实际案例

请求

GET /?lifecycle HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 16 Aug 2017 12:23:54 GMT

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 312

Date: Wed, 16 Aug 2017 12:23:54 GMT

Server: tencent-cos

x-cos-request-id: NTk5NDM5NWFfMjQ4OGY3Xzc3NGRf****

<LifecycleConfiguration>

  <Rule>

    <ID>id1</ID>

    <Filter>

       <Prefix>documents/</Prefix>

    </Filter>

    <Status>Enabled</Status>

    <Transition>

      <Days>100</Days>

      <StorageClass>STANDARD_IA</StorageClass>

    </Transition>

  </Rule>

  <Rule>

    <ID>id2</ID>

    <Filter>

       <Prefix>logs/</Prefix>

    </Filter>

    <Status>Enabled</Status>

    <Expiration>

      <Days>10</Days>

    </Expiration>

https://cloud.tencent.com/document/product/436/7730
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  </Rule>

</LifecycleConfiguration>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第159 共1701页

DELETE Bucket lifecycle
最近更新时间：2021-07-22 10:09:02

DELETE Bucket lifecycle 用于删除存储桶的生命周期配置。如果该 Bucket 未配置生命周期规则，将返回 

NoSuchLifecycleConfiguration。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体为空。

功能描述

请求

请求示例

DELETE /?lifecycle HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

响应体

错误码

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

实际案例

请求

DELETE /?lifecycle HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 16 Aug 2017 12:59:09 GMT

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98JM&q-

响应

HTTP /1.1 204 No Content

Content-Type: application/xml

Date: Wed, 16 Aug 2017 12:59:09 GMT

Server: tencent-cos

x-cos-request-id: NTk5NDQxOWNfMjQ4OGY3Xzc3NGRf****

https://cloud.tencent.com/document/product/436/7730
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存储桶策略（policy）

PUT Bucket policy
最近更新时间：2023-06-08 14:40:19

PUT Bucket policy 请求可以向 Bucket 写入权限策略。当存储桶已存在权限策略时，该请求上传的策略将覆盖

原有的权限策略。如果需要增量写入策略，可以先调用 GET Bucket Policy  获取之前的策略，在之前的策略上再

添加新策略，然后再调用 PUT Bucket Policy。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

下面的示例表示给主账号100000000001下的子账号100000000011授权，以允许访问存储桶名为 

examplebucket-1250000000 中的对象列表。关于访问策略中的元素介绍，请参见 访问策略语言概述 ，以及

授权策略示例请参见 COS API 授权策略使用指引 。

功能描述

请求

请求示例

PUT /?policy HTTP/1.1

Host:<BucketName-APPID>.cos.<Region>.myqcloud.com

Date: date

Content-Type:application/json

Content-MD5:MD5

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

  "Statement": 

{

[

https://cloud.tencent.com/document/product/436/8276
https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/18023
https://cloud.tencent.com/document/product/436/31923
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该请求的响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

    

      "Principal": 

        "qcs": 

          "qcs::cam::uin/100000000001:uin/100000000011"

        

      ,

      "Effect": "allow",

      "Action": 

        "name/cos:GetBucket"

      ,

      "Resource": 

        "qcs::cos:ap-guangzhou:uid/1250000000:examplebucket-1250000000/*"

      

    

  ,

  "version": "2.0"

{

{

[

]

}

[

]

[

]

}

]

}

响应

响应头

响应体

错误码

实际案例

请求

PUT /?policy HTTP/1.1

Host: examplebucket-1250000000.cos.ap-guangzhou.myqcloud.com

Authorization:q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUj****

Content-Type: application/json

Content-Length: 233

  "Statement": 

    

      "Principal": 

{

[

{

{

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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        "qcs": 

          "qcs::cam::uin/100000000001:uin/100000000001"

        

      ,

      "Effect": "allow",

      "Action": 

        "name/cos:GetBucket"

      ,

      "Resource": 

        "qcs::cos:ap-guangzhou:uid/1250000000:examplebucket-1250000000/*"

      

    

  ,

  "version": "2.0"

[

]

}

[

]

[

]

}

]

}

响应

HTTP/1.1 204 No Content

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Thu Jan 19 16:19:22 2017

Server: tencent-cos

x-cos-request-id: NTg4MDc2OGFfNDUyMDRlXzc3NTlf****
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GET Bucket policy
最近更新时间：2022-12-16 15:31:53

GET Bucket policy 请求可以向 Bucket 读取权限策略。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应返回权限策略。

功能描述

请求

请求示例

GET /?policy HTTP/1.1

Host:<BucketName-APPID>.cos.<Region>.myqcloud.com

Date:date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参见 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参见 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

响应体

{

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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关于访问策略中的元素介绍，请参见 访问策略语言概述 。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

  "Statement": 

    

      "Principal": 

        "qcs": 

          "qcs::cam::uin/100000000001:uin/100000000001"

        

      ,

      "Effect": "allow",

      "Action": 

        "name/cos:GetBucket"

      ,

      "Resource": 

        "qcs::cos:ap-guangzhou:uid/1250000000:examplebucket-1250000000/*"

      

    

  ,

  "version": "2.0"

[

{

{

[

]

}

[

]

[

]

}

]

}

错误码

实际案例

请求

GET /?policy HTTP/1.1

Host:examplebucket-1250000000.cos.ap-guangzhou.myqcloud.com

Authorization:q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUj****

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 237

Connection: keep-alive

Date: Thu Jan 19 16:21:46 2017

Server: tencent-cos

x-cos-request-id: NTg4MDc3MWFfOWIxZjRlXzZmNDVf****

{

https://cloud.tencent.com/document/product/436/18023
https://cloud.tencent.com/document/product/436/7730
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  "Statement": 

    

      "Principal": 

        "qcs": 

          "qcs::cam::uin/100000000001:uin/100000000001"

        

      ,

      "Effect": "allow",

      "Action": 

        "name/cos:GetBucket"

      ,

      "Resource": 

        "qcs::cos:ap-guangzhou:uid/1250000000:examplebucket-1250000000/*"

      

    

  ,

  "version": "2.0"

[

{

{

[

]

}

[

]

[

]

}

]

}
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DELETE Bucket policy
最近更新时间：2021-07-22 10:09:19

DELETE Bucket policy 请求可以向存储桶删除权限策略。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

注意

 只有存储桶所有者有权限发起该请求。如果权限策略不存在，将返回204 No Content。

请求

请求示例

DELETE /?policy HTTP/1.1

Host:<BucketName-APPID>.cos.<Region>.myqcloud.com

Date: date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第168 共1701页

该响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

错误码

实际案例

请求

DELETE /?policy HTTP/1.1

Host: examplebucket-1250000000.cos.ap-guangzhou.myqcloud.com

Authorization:q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUj****

响应

HTTP/1.1 204 No Content

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Thu Jan 19 16:30:21 2017

Server: tencent-cos

x-cos-request-id: NTg4MDc5MWRfNDQyMDRlXzNiMDRf****

https://cloud.tencent.com/document/product/436/7730
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防盗链（referer）

PUT Bucket referer
最近更新时间：2023-08-07 10:39:21

PUT Bucket referer 接口用于为存储桶设置 Referer 白名单或者黑名单。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体具体节点内容为：

功能描述

请求

请求示例

PUT /?referer HTTP 1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Content-Length: length

Content-MD5: MD5

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

<RefererConfiguration>

  <Status>Enabled</Status>

  <RefererType>White-List</RefererType>

  <DomainList>

    <Domain>*.qq.com</Domain>

    <Domain>*.qcloud.com</Domain>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体内容描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

  </DomainList>

  <EmptyReferConfiguration>Allow</EmptyReferConfiguration>

</RefererConfiguration>

名称 父节点 描述 类型 必选

RefererConfig

uration
无 防盗链配置信息

Cont

aine

r

是

Status
RefererCon

figuration

是否开启防盗链，枚举值：Enabled、

Disabled

Strin

g
是

RefererType
RefererCon

figuration

防盗链类型，枚举值：Black-List、

White-List

Strin

g
是

DomainList
RefererCon

figuration

生效域名列表， 支持多个域名且为前缀匹

配， 支持带端口的域名和 IP， 支持通配符

* ，做二级域名或多级域名的通配

Cont

aine

r

是

Domain DomainList

单条生效域名

例如 www.qq.com/example ，

192.168.1.2:8080 ， *.qq.com

Strin

g
是

EmptyReferC

onfiguration

RefererCon

figuration

是否允许空 Referer 访问，枚举值：

Allow、Deny，默认值为 Deny

Strin

g
否

响应

响应头

响应体

错误码

实际案例

请求

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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PUT /?referer HTTP 1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 25 Feb 2017 04:10:22 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Content-MD5: kOz7g54LMJZjxKs070V9jQ==

Content-Type: application/xml

<RefererConfiguration>

  <Status>Enabled</Status>

  <RefererType>White-List</RefererType>

  <DomainList>

    <Domain>*.qq.com</Domain>

    <Domain>*.qcloud.com</Domain>

  </DomainList>

  <EmptyReferConfiguration>Allow</EmptyReferConfiguration>

</RefererConfiguration>

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Fri, 25 Feb 2017 04:10:22 GMT

Server: tencent-cos

x-cos-request-id: NTg3ZjFjMmJfOWIxZjRlXzZmNDhf****
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GET Bucket referer
最近更新时间：2023-08-07 10:39:22

GET Bucket referer 接口用于读取存储桶 Referer 白名单或者黑名单。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /?referer HTTP 1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

响应体

<RefererConfiguration>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体的节点描述如下：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

    <Status>Enabled</Status>

    <RefererType>White-List</RefererType>

    <DomainList>

        <Domain>*.qq.com</Domain>

        <Domain>*.qcloud.com</Domain>

    </DomainList>

    <EmptyReferConfiguration>Allow</EmptyReferConfiguration>

</RefererConfiguration>

名称 父节点 描述 类型
是否

必选

RefererConfig

uration
无 防盗链配置信息

Con

tain

er

是

Status
RefererCon

figuration

是否开启防盗链，枚举值：Enabled，

Disabled

Stri

ng
是

RefererType
RefererCon

figuration

防盗链类型，枚举值：Black-List，

White-List

Stri

ng
是

DomainList
RefererCon

figuration

生效域名列表。 支持多个域名且为前缀匹

配， 支持带端口的域名和 IP， 支持通配符

* ，做二级域名或多级域名的通配

Con

tain

er

是

Domain DomainList

单条生效域名，例如 

www.qq.com/example ，

192.168.1.2:8080 ， *.qq.com

Stri

ng
是

EmptyReferC

onfiguration

RefererCon

figuration

是否允许空 Referer 访问，枚举值：

Allow，Deny，默认值为 Deny

Stri

ng
否

错误码

实际案例

请求

GET /?referer HTTP 1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 25 Feb 2017 04:10:22 GMT

https://cloud.tencent.com/document/product/436/7730
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Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 260

Connection: keep-alive

Date: Fri, 25 Feb 2017 04:10:22 GMT

Server: tencent-cos

x-cos-request-id: NTg3ZjFjMmJfOWIxZjRlXzZmNDhf****

<RefererConfiguration>

    <Status>Enabled</Status>

    <RefererType>White-List</RefererType>

    <DomainList>

        <Domain>*.qq.com</Domain>

        <Domain>*.qcloud.com</Domain>

    </DomainList>

    <EmptyReferConfiguration>Allow</EmptyReferConfiguration>

</RefererConfiguration>
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标签（tagging）

PUT Bucket tagging
最近更新时间：2022-06-07 17:54:49

COS 支持为已存在的 Bucket 设置标签（Tag）。PUT Bucket tagging 接口用于为存储桶设置键值对作为存

储桶标签，可以协助您管理已有的存储桶资源，并通过标签进行成本管理。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

注意

 目前存储桶标签功能最多支持一个存储桶下设置50个不同的标签。

请求

请求示例

PUT /?tagging HTTP 1.1

Host:<BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Content-MD5: MD5

Content-Length: Content Length

Content-Type: application/xml

[Request Body]

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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该请求需要设置如下标签集合：

具体的数据描述如下：

<?xml version="1.0" encoding="UTF-8" ?>

<Tagging>

    <TagSet>

        <Tag>

            <Key>age</Key>

            <Value>18</Value>

        </Tag>

        <Tag>

            <Key>name</Key>

            <Value>xiaoming</Value>

        </Tag>

    </TagSet>

</Tagging>

节点名称

（关键

字）

父节点 描述 类型
是否

必选

Tagging 无 标签集合

Con

tain

er

是

TagSet Tagging 标签集合

Con

tain

er

是

Tag
Tagging

.TagSet
标签集合，最多支持50个标签

Con

tain

ers

是

Key

Tagging

.TagSet

.Tag

标签的 Key，长度小于128字节, 支持英文字母、数字、

空格、加号、减号、下划线、等号、点号、冒号、斜线

Stri

ng
是

Value

Tagging

.TagSet

.Tag

标签的 Value，长度小于256字节, 支持英文字母、数

字、空格、加号、减号、下划线、等号、点号、冒号、斜

线

Stri

ng
是

响应

响应头



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第177 共1701页

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

如下请求向存储桶 examplebucket-1250000000 中写入了{age:18}和{name:xiaoming}两个标签。COS 配

置标签成功并返回204成功请求。

响应体

错误码

实际案例

请求

PUT /?tagging HTTP/1.1

User-Agent: curl/7.29.0

Accept: */*

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Authorization: q-sign-algorithm=sha1&q-ak=AKIDrbAYjEBqqdEconpFi8NPFsOjrnX4****&q-

Content-MD5: LIbd5t5HLPhuNWYkP6qHcQ==

Content-Length: 127

Content-Type: application/xml

<Tagging>

    <TagSet>

        <Tag>

            <Key>age</Key>

            <Value>18</Value>

        </Tag>

        <Tag>

            <Key>name</Key>

            <Value>xiaoming</Value>

        </Tag>

    </TagSet>

</Tagging>

响应

HTTP/1.1 204 No Content

Content-Type: application/xml

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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Content-Length: 0

Connection: keep-alive

Date: Fri, 19 Jan 2018 11:40:22 GMT

Server: tencent-cos

x-cos-request-id: NWE2MWQ5MjZfMTBhYzM1MGFfMTA5ODVfMTVj****
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GET Bucket tagging
最近更新时间：2022-06-07 17:54:44

COS 支持为已存在的存储桶查询标签（Tag）。GET Bucket tagging 接口用于查询指定存储桶下已有的存储

桶标签。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

说明

 若您使用子账号调用此项接口，请确保您已经在主账号处获取了 GET Bucket tagging 这个接口的权

限。

请求

请求示例

GET /?tagging HTTP 1.1

Host:<BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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查询成功，返回 application/xml 数据，包含存储桶下已有的标签信息。

具体的节点描述如下：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

响应体

<Tagging>

    <TagSet>

        <Tag>

            <Key>string</Key>

            <Value>string</Value>

        </Tag>

        <Tag>

            <Key>string</Key>

            <Value>string</Value>

        </Tag>

    </TagSet>

</Tagging>

节点名称

（关键

字）

父节点 描述 类型

Tagging 无 标签集合
Conta

iner

TagSet Tagging 标签集合
Conta

iner

Tag
Tagging.T

agSet
标签集合, 最多支持50个标签

Conta

iners

Key

Tagging.T

agSet.Ta

g

标签键, 长度小于128字节，支持英文字母、数字、空格、加

号、减号、下划线、等号、点号、冒号、斜线
String

Value

Tagging.T

agSet.Ta

g

标签值, 长度小于256字节，支持英文字母、数字、空格、加

号、减号、下划线、等号、点号、冒号、斜线
String

错误码

实际案例

https://cloud.tencent.com/document/product/436/7730
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如下请求申请查询存储桶 examplebucket-1250000000 下的标签信息，COS 解析该请求后，并返回了该存储

桶下已有的 {age:18} 和 {name:xiaoming} 两个标签。

请求

GET /?tagging HTTP/1.1

User-Agent: curl/7.29.0

Accept: */*

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Authorization: q-sign-algorithm=sha1&q-ak=AKIDrbAYjEBqqdEconpFi8NPFsOjrnX4****&q-

Content-Length: 127

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Connection: close

Date: Fri, 19 Jan 2018 11:40:22 GMT

Server: tencent-cos

<Tagging>

    <TagSet>

        <Tag>

            <Key>age</Key>

            <Value>18</Value>

        </Tag>

        <Tag>

            <Key>name</Key>

            <Value>xiaoming</Value>

        </Tag>

    </TagSet>

</Tagging>
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DELETE Bucket tagging
最近更新时间：2021-07-22 10:09:59

COS 支持为已存在的 Bucket 删除标签（Tag）。DELETE Bucket tagging 接口用于删除指定存储桶下已有

的存储桶标签。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

说明

 如您使用子账号调用此项接口，请确保您已经在主账号处获取了 DELETE Bucket tagging 这个接口的

权限。

请求

请求示例

DELETE /?tagging HTTP 1.1

Host:<BucketName-APPID>.cos.<Region>.myqcloud.com

Date:date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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该响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

如下请求申请删除存储桶 examplebucket-1250000000 下已有的标签信息。COS 解析该请求后删除该存储桶

下所有标签。

响应体

错误码

实际案例

请求

DELETE /?tagging HTTP/1.1

User-Agent: curl/7.29.0

Accept: */*

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Authorization: q-sign-algorithm=sha1&q-ak=AKIDrbAYjEBqqdEconpFi8NPFsOjrnX4****&q-

Content-Md5: LIbd5t5HLPhuNWYkP6qHcQ==

Content-Length: 127

Content-Type: application/xml

响应

HTTP/1.1 204 No Content

Content-Type: application/xml

Connection: close

Date: Fri, 19 Jan 2018 11:40:22 GMT

https://cloud.tencent.com/document/product/436/7730
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静态网站（website）

PUT Bucket website
最近更新时间：2021-07-22 10:10:03

PUT Bucket website 请求用于为存储桶配置静态网站，您可以通过传入 XML 格式的配置文件进行配置，文件

大小限制为64KB。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

提交 application/xml 请求数据，包含完整的存储桶静态网站配置信息。

功能描述

请求

请求示例

PUT /?website HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-Type: application/xml

Content-Length: Content Length

Content-MD5: MD5

Authorization: Auth String

[Request Body]

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参见 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参见 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

请求体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体的节点描述如下：

<WebsiteConfiguration>

    <IndexDocument>

        <Suffix>String</Suffix>

    </IndexDocument>

    <RedirectAllRequestsTo>

        <Protocol>String</Protocol>

    </RedirectAllRequestsTo>

    <AutoAddressing>

        <Status>Enabled|Disabled</Status>

    </AutoAddressing>

    <ErrorDocument>

        <Key>String</Key>

        <OriginalHttpStatus>Enabled|Disabled</OriginalHttpStatus>

    </ErrorDocument>

    <RoutingRules>

        <RoutingRule>

            <Condition>

                <HttpErrorCodeReturnedEquals>Integer</HttpErrorCodeReturnedEquals>

            </Condition>

            <Redirect>

                <Protocol>String</Protocol>

                <ReplaceKeyWith>String</ReplaceKeyWith>

            </Redirect>

        </RoutingRule>

        <RoutingRule>

            <Condition>

                <KeyPrefixEquals>String</KeyPrefixEquals>

            </Condition>

            <Redirect>

                <Protocol>String</Protocol>

                <ReplaceKeyPrefixWith>String</ReplaceKeyPrefixWith>

            </Redirect>

        </RoutingRule>

    </RoutingRules>

</WebsiteConfiguration>

节点名称（关键字）
父节

点
描述 类型

是否必

选

WebsiteConfigura

tion
无

包含 PUT Bucket website 操作的所有

请求信息

Contain

er
否
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Container 节点 WebsiteConfiguration 的内容：

Container 节点 IndexDocument 的内容：

Container 节点 RedirectAllRequestsTo 的内容：

节点名称（关键

字）
父节点 描述 类型

是否

必选

IndexDocument
WebsiteConfig

uration
索引文档配置

Conta

iner
是

RedirectAllRequ

estsTo

WebsiteConfig

uration
重定向所有请求配置

Conta

iner
否

AutoAddressing
WebsiteConfig

uration
用于配置是否忽略扩展名

Conta

iner
否

ErrorDocument
WebsiteConfig

uration
错误文档配置

Conta

iner
否

RoutingRules
WebsiteConfig

uration

重定向规则配置，最多设置100条 

RoutingRule

Conta

iner
否

节

点

名

称

（

关

键

字

）

父节点 描述
类

型

是

否

必

选

Su

ffix

WebsiteC

onfigurati

on.IndexD

ocument

指定索引文档的对象键后缀。例如指定为 index.html ，那么当访

问到存储桶的根目录时，会自动返回 index.html 的内容，或者当

访问到 article/  目录时，会自动返回 article/index.html  的内

容

S

tr

in

g

是

节点名称

（关键字）
父节点 描述

类

型

是否

必选

Protocol
WebsiteConfiguration.Redire

ctAllRequestsTo

指定重定向所有请求的目标协

议，只能设置为 https

St

rin

g

是
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Container 节点 AutoAddressing 的内容：

Container 节点 ErrorDocument 的内容：

Container 节点 RoutingRules 的内容：

Container 节点 RoutingRules.RoutingRule 的内容：

节点名称

（关键

字）

父节点 描述
类

型

是

否

必

选

Status
WebsiteConfigurati

on.AutoAddressing

用于配置是否忽略 HTML 拓展名，可选值为 

Enabled 或 Disabled，默认为 Disabled

S

tr

in

g

否

节点名称

（关键

字）

父节点 描述
类

型

是

否

必

选

Key

WebsiteConfigur

ation.ErrorDocu

ment

指定通用错误文档的对象键，当发生错误且未命中重

定向规则中的错误码重定向时，将返回该对象键的内

容

S

tr

in

g

是

Origina

lHttpSt

atus

WebsiteConfigur

ation.ErrorDocu

ment

用于配置命中错误文档的 HTTP 状态码，可选值为 

Enabled 或 Disabled，默认为 Enabled

S

tr

in

g

否

节点名称（关键

字）
父节点 描述 类型

是否必

选

RoutingRule
WebsiteConfiguration.Routing

Rules

单条重定向规则

配置

Contain

er
是

节点名称

（关键字）
父节点 描述 类型

是否

必选

Condition
WebsiteConfiguration.RoutingRul

es.RoutingRule
重定向规则的条件配置

Cont

ainer
是

Redirect WebsiteConfiguration.RoutingRul 重定向规则的具体重定 Cont 是
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Container 节点 RoutingRules.RoutingRule.Condition 的内容：

Container 节点 RoutingRules.RoutingRule.Redirect 的内容：

es.RoutingRule 向目标配置 ainer

节点名

称（关

键字）

父节点 描述
类

型
是否必选

HttpEr

rorCod

eRetu

rnedE

quals

Website

Configur

a

tion.Rou

tingRule

s.

Routing

Rule.Co

ndition

指定重定向规则的错误码匹配条

件，只支持配置4XX返回码，例如

403或404

I

n

t

e

g

e

r

HttpErrorCodeReturnedE

quals 与 KeyPrefixEquals 

必选其一

KeyPr

efixEq

uals

Website

Configur

a

tion.Rou

tingRule

s.

Routing

Rule.Co

ndition

指定重定向规则的对象键前缀匹配

条件

S

tr

in

g

HttpErrorCodeReturnedE

quals 与 KeyPrefixEquals 

必选其一

节点

名称

（关

键

字）

父节点 描述
类

型
是否必选

Prot

ocol

WebsiteConfigur

a

tion.RoutingRule

s.

RoutingRule.Red

irect

指定重定向规则的目标协议，只能设置为 

https

S

tr

in

g

否

Repl

ace

WebsiteConfigur

a

指定重定向规则的具体重定向目标的对象键，

替换方式为替换整个原始请求的对象键

S

tr

ReplaceKe

yWith 与 

ReplaceKe
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

Key

With

tion.RoutingRule

s.

RoutingRule.Red

irect

in

g

yPrefixWith

必选其一

Repl

ace

Key

Pref

ixWi

th

WebsiteConfigur

a

tion.RoutingRule

s.

RoutingRule.Red

irect

指定重定向规则的具体重定向目标的对象键，

替换方式为替换原始请求中所匹配到的前缀部

分，仅可在 Condition 为 

KeyPrefixEquals 时设置

S

tr

in

g

ReplaceKe

yWith 与 

ReplaceKe

yPrefixWith

必选其一

URL

Redi

rect

WebsiteConfigur

a 

tion.RoutingRule

s. 

RoutingRule.Red

irect

重定向规则中 URL 是否跟随替换内容做更

改。枚举值：Enabled、Disabled。默认值

为 Enabled

S

tr

in

g

否

响应

响应头

响应体

错误码

实际案例

请求

PUT /?website HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 20 May 2020 09:33:38 GMT

Content-Type: application/xml

Content-Length: 1209

Content-MD5: VHzj4Uwb++HLyCJp7jUzWg==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<WebsiteConfiguration>

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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    <IndexDocument>

        <Suffix>index.html</Suffix>

    </IndexDocument>

    <RedirectAllRequestsTo>

        <Protocol>https</Protocol>

    </RedirectAllRequestsTo>

    <ErrorDocument>

        <Key>pages/error.html</Key>

    </ErrorDocument>

    <RoutingRules>

        <RoutingRule>

            <Condition>

                <HttpErrorCodeReturnedEquals>403</HttpErrorCodeReturnedEquals>

            </Condition>

            <Redirect>

                <Protocol>https</Protocol>

                <ReplaceKeyWith>pages/403.html</ReplaceKeyWith>

            </Redirect>

        </RoutingRule>

        <RoutingRule>

            <Condition>

                <HttpErrorCodeReturnedEquals>404</HttpErrorCodeReturnedEquals>

            </Condition>

            <Redirect>

                <ReplaceKeyWith>pages/404.html</ReplaceKeyWith>

            </Redirect>

        </RoutingRule>

        <RoutingRule>

            <Condition>

                <KeyPrefixEquals>assets/</KeyPrefixEquals>

            </Condition>

            <Redirect>

                <ReplaceKeyWith>index.html</ReplaceKeyWith>

            </Redirect>

        </RoutingRule>

        <RoutingRule>

            <Condition>

                <KeyPrefixEquals>article/</KeyPrefixEquals>

            </Condition>

            <Redirect>

                <Protocol>https</Protocol>

                <ReplaceKeyPrefixWith>archived/</ReplaceKeyPrefixWith>

            </Redirect>

        </RoutingRule>

    </RoutingRules>
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</WebsiteConfiguration>

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Wed, 20 May 2020 09:33:38 GMT

Server: tencent-cos

x-cos-request-id: NWVjNGY5NzJfOThjMjJhMDlfMjg5Ml8yYzNi****
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GET Bucket website
最近更新时间：2021-07-22 10:10:06

GET Bucket website 请求用于查询与存储桶关联的静态网站配置信息。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

此接口无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

请求

请求示例

GET /?website HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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查询成功，返回 application/xml 数据，包含完整的存储桶静态网站配置信息。

具体的节点描述如下：

Container 节点 WebsiteConfiguration 的内容：

<WebsiteConfiguration>

    <IndexDocument>

        <Suffix>string</Suffix>

    </IndexDocument>

    <RedirectAllRequestsTo>

        <Protocol>string</Protocol>

    </RedirectAllRequestsTo>

    <ErrorDocument>

        <Key>string</Key>

    </ErrorDocument>

    <RoutingRules>

        <RoutingRule>

            <Condition>

                <HttpErrorCodeReturnedEquals>integer</HttpErrorCodeReturnedEquals>

            </Condition>

            <Redirect>

                <Protocol>string</Protocol>

                <ReplaceKeyWith>string</ReplaceKeyWith>

            </Redirect>

        </RoutingRule>

        <RoutingRule>

            <Condition>

                <KeyPrefixEquals>string</KeyPrefixEquals>

            </Condition>

            <Redirect>

                <Protocol>string</Protocol>

                <ReplaceKeyPrefixWith>string</ReplaceKeyPrefixWith>

            </Redirect>

        </RoutingRule>

    </RoutingRules>

</WebsiteConfiguration>

节点名称（关键字） 父节点 描述 类型

WebsiteConfiguration 无 保存 GET Bucket website 结果的所有信息 Container

节点名称（关键字） 父节点 描述 类型

IndexDocument WebsiteConfiguration 索引文档配置 Container
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Container 节点 IndexDocument 的内容：

Container 节点 RedirectAllRequestsTo 的内容：

Container 节点 ErrorDocument 的内容：

Container 节点 RoutingRules 的内容：

Container 节点 RoutingRules.RoutingRule 的内容：

RedirectAllRequestsTo WebsiteConfiguration 重定向所有请求配置 Container

ErrorDocument WebsiteConfiguration 错误文档配置 Container

RoutingRules WebsiteConfiguration 重定向规则配置 Container

节点

名称

（关

键

字）

父节点 描述
类

型

Suf

fix

WebsiteCo

nfiguration.I

ndexDocum

ent

指定索引文档的对象键后缀。例如指定为 index.html ，那么当访问到

存储桶的根目录时，会自动返回 index.html 的内容，或者当访问到

article/ 目录时，会自动返回 article/index.html 的内容

s

tr

in

g

节点名称（关键

字）
父节点 描述 类型

Protocol
WebsiteConfiguration.RedirectAllReq

uestsTo

指定重定向所有请求的目

标协议

stri

ng

节点名称（关键

字）
父节点 描述 类型

Key
WebsiteConfiguration.ErrorDocum

ent

指定通用错误文档的对象

键

strin

g

节点名称（关键

字）
父节点 描述 类型

RoutingRule
WebsiteConfiguration.RoutingRule

s

单条重定向规则配

置

Containe

r
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Container 节点 RoutingRules.RoutingRule.Condition 的内容：

Container 节点 RoutingRules.RoutingRule.Redirect 的内容：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

节点名称（关

键字）

父节点 描述 类型

Condition
WebsiteConfiguration.RoutingRules.

RoutingRule
重定向规则的条件配置

Contai

ner

Redirect
WebsiteConfiguration.RoutingRules.

RoutingRule

重定向规则的具体重定向

目标配置

Contai

ner

节点名称（关键字） 父节点 描述 类型

HttpErrorCodeReturn

edEquals

WebsiteConfiguration.Rou

tingRules.

RoutingRule.Condition

指定重定向规则的错误码匹

配条件

inte

ger

KeyPrefixEquals

WebsiteConfiguration.Rou

tingRules.

RoutingRule.Condition

指定重定向规则的对象键前

缀匹配条件

strin

g

节点名称（关

键字）
父节点 描述

类

型

Protocol

WebsiteConfigurati

on.RoutingRules.

RoutingRule.Redire

ct

指定重定向规则的目标协议

s

tr

in

g

ReplaceKe

yWith

WebsiteConfigurati

on.RoutingRules.

RoutingRule.Redire

ct

指定重定向规则的具体重定向目标的对象键，替换方

式为替换整个原始请求的对象键

s

tr

in

g

ReplaceKe

yPrefixWith

WebsiteConfigurati

on.RoutingRules.

RoutingRule.Redire

ct

指定重定向规则的具体重定向目标的对象键，替换方

式为替换原始请求中所匹配到的前缀部分

s

tr

in

g

错误码

实际案例

https://cloud.tencent.com/document/product/436/7730
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请求

GET /?website HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 20 May 2020 09:33:49 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1163

Connection: close

Date: Wed, 20 May 2020 09:33:49 GMT

Server: tencent-cos

x-cos-request-id: NWVjNGY5N2RfYTdjMjJhMDlfNjZkY18yYWUx****

<WebsiteConfiguration>

    <IndexDocument>

        <Suffix>index.html</Suffix>

    </IndexDocument>

    <RedirectAllRequestsTo>

        <Protocol>https</Protocol>

    </RedirectAllRequestsTo>

    <ErrorDocument>

        <Key>pages/error.html</Key>

    </ErrorDocument>

    <RoutingRules>

        <RoutingRule>

            <Condition>

                <HttpErrorCodeReturnedEquals>403</HttpErrorCodeReturnedEquals>

            </Condition>

            <Redirect>

                <Protocol>https</Protocol>

                <ReplaceKeyWith>pages/403.html</ReplaceKeyWith>

            </Redirect>

        </RoutingRule>

        <RoutingRule>

            <Condition>

                <HttpErrorCodeReturnedEquals>404</HttpErrorCodeReturnedEquals>

            </Condition>

            <Redirect>

                <ReplaceKeyWith>pages/404.html</ReplaceKeyWith>
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            </Redirect>

        </RoutingRule>

        <RoutingRule>

            <Condition>

                <KeyPrefixEquals>assets/</KeyPrefixEquals>

            </Condition>

            <Redirect>

                <ReplaceKeyWith>index.html</ReplaceKeyWith>

            </Redirect>

        </RoutingRule>

        <RoutingRule>

            <Condition>

                <KeyPrefixEquals>article/</KeyPrefixEquals>

            </Condition>

            <Redirect>

                <Protocol>https</Protocol>

                <ReplaceKeyPrefixWith>archived/</ReplaceKeyPrefixWith>

            </Redirect>

        </RoutingRule>

    </RoutingRules>

</WebsiteConfiguration>
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DELETE Bucket website
最近更新时间：2021-07-22 10:10:10

DELETE Bucket website 请求用于删除存储桶中的静态网站配置。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

此接口无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

请求

请求示例

DELETE /?website HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

错误码

实际案例

请求

DELETE /?website HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 19 May 2020 07:57:10 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 204 No Content

Connection: close

Date: Tue, 19 May 2020 07:57:10 GMT

Server: tencent-cos

x-cos-request-id: NWVjMzkxNTZfY2ZhZjJhMDlfNWI2OV8yYWFh****

Content-Length: 0

https://cloud.tencent.com/document/product/436/7730
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智能分层（IntelligentTiering）

PUT Bucket IntelligentTiering
最近更新时间：2022-10-31 10:35:25

PUT Bucket IntelligentTiering 接口用于启用存储桶的智能分层存储配置。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

说明

启用智能分层配置后，将无法关闭或修改。

只有主账号或者被授权 PUT Bucket IntelligentTiering 接口权限的子账号可以调用该接口。

您可以通过 查询对象元数据  接口返回的 x-cos-storage-tier 获取对象所处的存储层。

请求

请求示例

PUT /?intelligenttiering HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Connection: keep-alive

Authorization: authorization string

Content-Type: text/plain

Content-Length: Int

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7745
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体的数据内容如下：

请求体

<IntelligentTieringConfiguration xmlns="cos xmlns/"> 

  <Status>Enabled</Status>

  <Transition>

    <Days>30|60|90</Days>

    <RequestFrequent>1</RequestFrequent>

  </Transition>

</IntelligentTieringConfiguration>

名称 父节点 描述 类型

是

否

必

选

Intellig

entTier

ingCon

figurati

on

无 智能分层存储配置的具体信息

Con

tain

er

是

Status

Intelligent

TieringCon

figuration

说明智能分层存储配置是否开启，枚举值：Enabled
Enu

m
是

Transit

ion

Intelligent

TieringCon

figuration

指定智能分层存储配置中有关数据转换的配置信息

Con

tain

er

是

Days

Intelligent

TieringCon

figuration

.Transition

指定智能分层存储配置中标准层数据转换为低频层数据的

天数限制，可选天数为30、60、90。默认值为30
Int 是

Reque

stFreq

uent

Intelligent

TieringCon

figuration

.Transition

指定配置中标准层数据转换为低频层数据的访问次数限

制，默认值为1次，和天数搭配使用可以实现转换效果。例

如设置该参数为1，访问天数为30，代表连续30天访问次

数小于1次的对象会从标准层降到低频层

Int 是

响应

响应头
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

响应体

错误码

实际案例

请求

PUT /?intelligenttiering HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: python-requests/2.12.4

Content-Type: application/xml

Authorization: q-sign-algorithm=sha1&q-ak=AKID15IsskiBQKTZbAo6WhgcBqVls9Sm****&

Content-Length: 83

<IntelligentTieringConfiguration xmlns="cos xmlns/"> 

  <Status>Enabled</Status>

  <Transition>

    <Days>30</Days>

    <RequestFrequent>1</RequestFrequent>

  </Transition>

</IntelligentTieringConfiguration>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Sun, 23 Aug 2020 08:14:53 GMT

Server: tencent-cos

x-cos-request-id: NTk5ZDM5N2RfMjNiMjM1MGFfMmRiX2Y0****

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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GET Bucket IntelligentTiering
最近更新时间：2022-05-09 15:38:04

GET Bucket IntelligentTiering 接口用于查询存储桶的智能分层配置信息。

功能描述

说明

只有主账号或者被授权 GET Bucket IntelligentTiering 接口权限的子账号可以调用该接口。

该配置有未启用和启用两种状态：

如果您从未在存储桶上启用智能分层存储配置，则响应为：

<IntelligentTieringConfiguration/>

如果您启用了存储桶的智能分层配置，则响应为：

<IntelligentTieringConfiguration xmlns="cos xmlns/"> 

       <Status>Enabled</Status>

       <Transition>

          <Days>30</Days>

          <RequestFrequent>1</RequestFrequent>

       </Transition>

</IntelligentTieringConfiguration>

请求

请求示例

GET /?intelligenttiering HTTP 1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
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此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

具体的节点描述如下：

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

请求体

响应

响应头

响应体

<IntelligentTieringConfiguration xmlns="cos xmlns/"> 

  <Status>Enabled</Status>

  <Transition>

    <Days>30|60|90</Days>

    <RequestFrequent>1</RequestFrequent>

  </Transition>

</IntelligentTieringConfiguration>

名称 父节点 描述 类型

Intellige

ntTierin

gConfig

uration

无 智能分层存储配置的具体信息

Con

tain

er

Status

Intelligent

TieringCon

figuration

说明智能分层存储配置是否开启，枚举值：Enabled
Enu

m

Transiti Intelligent 指定智能分层存储配置中有关数据转换的配置信息 Con

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

on TieringCon

figuration

tain

er

Days

Intelligent

TieringCon

figuration.

Transition

指定智能分层存储配置中标准层数据转换为低频层数据的天数限

制，可选值为30、60和90，默认值为30天
Int

Reques

tFreque

nt

Intelligent

TieringCon

figuration.

Transition

指定配置中标准层数据转换为低频层数据的访问次数限制，默认

值为1次，和天数搭配使用可以实现转换效果。例如设置该参数为

1，访问天数为30，代表连续30天访问次数小于1次的对象会从标

准层降到低频层

Int

错误码

实际案例

请求

GET /?intelligenttiering HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: python-requests/2.12.4

Authorization: q-sign-algorithm=sha1&q-ak=AKID15IsskiBQKTZbAo6WhgcBqVls9Sm****&

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 120

Connection: keep-alive

Date: Sun, 23 Aug 2020 08:15:16 GMT

Server: tencent-cos

x-cos-request-id: NTk5ZDM5OTRfZDNhZDM1MGFfMjYyMTFfZmU3****

<IntelligentTieringConfiguration xmlns="cos xmlns/"> 

  <Status>Enabled</Status>

  <Transition>

    <Days>30</Days>

    <RequestFrequent>1</RequestFrequent>

  </Transition>

https://cloud.tencent.com/document/product/436/7730


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第206 共1701页

</IntelligentTieringConfiguration>
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清单（inventory）

PUT Bucket inventory
最近更新时间：2023-08-14 16:10:12

PUT Bucket inventory 用于在存储桶中创建清单任务，您可以对清单任务命名后，使用该请求创建清单任务，

详细信息请参见 清单功能概述 。

调用 PUT Bucket inventory 需要使用清单任务名称的参数。该参数格式如下：

功能描述

注意

COS 支持在每个存储桶中创建最多1000条清单任务。

您必须在目标存储桶中写入存储桶策略，以供 COS 将清单任务的结果文件写入该存储桶中。

调用该请求时，请确保您有足够的权限对存储桶的清单任务进行操作。存储桶所有者默认拥有该权限，

若您无该项权限，请先向存储桶所有者申请该项操作的权限。授权流程请参见 使用方法 。

如果您指定了清单投递的前缀，COS 后端会自动在您指定的前缀后边加上 / 。如您指定了 Prefix 作为

前缀，则 COS 后端投递的清单报告路径为 Prefix/inventory_report 。

请求

请求示例

PUT /?inventory&id=inventory-configuration-ID HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Content-MD5: MD5

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

https://cloud.tencent.com/document/product/436/33703
https://cloud.tencent.com/document/product/436/33703#.E4.BD.BF.E7.94.A8.E6.96.B9.E6.B3.95
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第208 共1701页

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

用户在请求体中使用 XML 语言设置清单任务的具体配置信息。配置信息包括清单任务分析的对象，分析的频次，

分析的维度，分析结果的格式及存储的位置等信息。 

参数 描述 类型 是否必选

id
清单任务的名称。缺省值：None

合法字符： a-z，A-Z，0-9，-，_，.
String 是

请求头

请求体

<InventoryConfiguration>

    <Id>list1</Id>

    <IsEnabled>true</IsEnabled>

    <Destination>

        <COSBucketDestination>

            <Format>CSV</Format>

            <AccountId>100000000001</AccountId>

            <Bucket>qcs::cos:ap-guangzhou::examplebucket-1250000000</Bucket>

            <Prefix>list1</Prefix>

            <Encryption>

                <SSE-COS></SSE-COS>

            </Encryption>

        </COSBucketDestination>

    </Destination>

    <Schedule>

        <Frequency>Daily|Weekly|Monthly</Frequency>

        <MonthlyDate></MonthlyDate>

    </Schedule>

    <Filter>

        <Prefix>myPrefix</Prefix>

    </Filter>

    <IncludedObjectVersions>All</IncludedObjectVersions>

    <OptionalFields>

        <Field>Size</Field>

        <Field>LastModifiedDate</Field>

        <Field>ETag</Field>

        <Field>StorageClass</Field>

        <Field>IsMultipartUploaded</Field>

        <Field>ReplicationStatus</Field>

        <Field>Tag</Field>

        <Field>Crc64</Field>

https://cloud.tencent.com/document/product/436/7728
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具体的节点描述如下：

        <Field>x-cos-meta-*</Field>

    </OptionalFields>

</InventoryConfiguration>

节点名 父节点 描述 类型 是否必选

InventoryCon

figuration
无 包含清单的配置参数

Cont

ainer
是

Id
InventoryCon

figuration
清单的名称，与请求参数中的 id 对应

Cont

ainer
是

IsEnabled
InventoryCon

figuration

清单是否启用的标识：

如果设置为 true，清单功能将生效

如果设置为 false，将不生成任何

清单

Strin

g
是

IncludedObje

ctVersions

InventoryCon

figuration

是否在清单中包含对象版本：

如果设置为 All，清单中将会包含

所有对象版本，并在清单中增加 

VersionId，IsLatest，

DeleteMarker 这几个字段

如果设置为 Current，则清单中不

包含对象版本信息

Strin

g
是

Filter
InventoryCon

figuration

筛选待分析对象。清单功能将分析符合

Filter 中设置的前缀的对象

Cont

ainer
否

And Filter
筛选待分析对象时，如果同时需要前缀

与对象标签条件，需要用 And 包装

Cont

ainer
否

Prefix And 需要分析的对象的前缀
Strin

g
否

Tag And
筛选待分析对象时，可以用对象标签

（支持多个）作为过滤条件

Cont

ainer
否

Period Filter 需要分析的对象的创建时间范围
Cont

ainer
否

StartTime Period
需要分析的对象创建的起始时间，参数

为秒级时间戳，如1568688761

Strin

g
否

EndTime Period 需要分析的对象创建的结束时间，参数 Strin 否
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为秒级时间戳，如1568688762 g

OptionalField

s

InventoryCon

figuration
设置清单结果中应包含的分析项目

Cont

ainer
否

Field
OptionalField

s

清单结果中可选包含的分析项目名称，

可选字段包括： Size ，

LastModifiedDate ，

StorageClass ， ETag ，

IsMultipartUploaded ，

ReplicationStatus ， Tag ，

Crc64 ， x-cos-meta-*

注意，如果筛选条件里使用了对象标

签，在这里也必须添加 Tag

此外，也支持用户填写

x-cos-meta-* 形式的自定义头部，

如 x-cos-meta-testheader 。清单

会将相应的对象元数据输出，若对象不

包含该元数据，则为空。

Strin

g
否

Schedule
InventoryCon

figuration
配置清单任务周期

Cont

ainer
是

Frequency Schedule

清单任务周期，可选项为按日、按周或

按月，枚举值：Daily、Weekly。其

中，按月需要指定清单产出的日期

Strin

g
是

MonthlyDate Schedule

如果清单任务周期选择了按月，需要明

确指定清单产出的日期。支持填入 1～

28 范围内的整数

Integ

er
否

Destination
InventoryCon

figuration
描述存放清单结果的信息

Cont

ainer
是

COSBucketD

estination
Destination 清单结果导出后存放的存储桶信息

Cont

ainer
是

Bucket
COSBucketD

estination
清单分析结果的存储桶名

Strin

g
是

AccountId
COSBucketD

estination

存储桶的所有者 uin，例如

100000000001。可在  

账号信息  中查看

Strin

g
否

Prefix
COSBucketD

estination
清单分析结果的前缀

Strin

g
否

https://console.cloud.tencent.com/developer
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该请求的响应体返回为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

该示例向存储桶 examplebucket-1250000000 中添加一条名为 list1 的清单任务。

Format COSBucketD

estination

清单分析结果的文件形式，可选项为 

CSV 格式

Strin

g

是

Encryption
COSBucketD

estination
为清单结果提供服务端加密的选项

Cont

ainer
否

SSE-COS Encryption COS 托管密钥的加密方式，无需填充
Cont

ainer
否

响应

响应头

响应体

错误码

实际案例

案例一：添加指定了对象前缀的清单任务

请求

该清单任务分析存储桶中前缀为 myPrefix 的对象及其所有版本。

分析频次为每天一次。

分析维度包括 Size ， LastModifiedDate， StorageClass，ETag，IsMultipartUploaded， 

ReplicationStatus。

分析结果将以 CSV 格式文件存储在存储桶 examplebucket-1250000000  中，文件添加前缀 list1 且用 

SSE-COS 加密。

PUT /?inventory&id=list1 HTTP/1.1

Date: Mon, 28 Aug 2018 02:53:38 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Content-MD5: AAq9nzrpsz5LJ4UEe1f6Q==

Host: examplebucket-1250000000.cos.ap-guangzhou.myqcloud.com

Content-Length: 1024

<?xml version = "1.0" encoding = "UTF-8">

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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上述请求后，COS 返回以下响应，表明该清单任务 list1 已经成功设置完毕。

<InventoryConfiguration xmlns = "http://....">

    <Id>list1</Id>

    <IsEnabled>true</IsEnabled>

    <Destination>

        <COSBucketDestination>

            <Format>CSV</Format>

            <AccountId>100000000001</AccountId>

            <Bucket>qcs::cos:ap-guangzhou::examplebucket-1250000000</Bucket>

            <Prefix>list1</Prefix>

            <Encryption>

                <SSE-COS></SSE-COS>

            </Encryption>

        </COSBucketDestination>

    </Destination>

    <Schedule>

        <Frequency>Daily</Frequency>

    </Schedule>

    <Filter>

        <Prefix>myPrefix</Prefix>

      <Period>

        <StartTime>1568688761</StartTime>

        <EndTime>1568688762</EndTime>

      </Period>

    </Filter>

    <IncludedObjectVersions>All</IncludedObjectVersions>

    <OptionalFields>

        <Field>Size</Field>

        <Field>LastModifiedDate</Field>

        <Field>ETag</Field>

        <Field>StorageClass</Field>

        <Field>IsMultipartUploaded</Field>

        <Field>ReplicationStatus</Field>

    </OptionalFields>

</InventoryConfiguration>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Date: Mon, 28 Aug 2018 02:53:38 GMT

Server: tencent-cos

x-cos-request-id: NTlhMzg1ZWVfMjQ4OGY3MGFfMWE1NF8****
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该示例向存储桶 examplebucket-1250000000 中添加一条名为 list2 的清单任务。

案例二：添加指定了对象前缀和对象标签的清单任务

请求

该清单任务分析存储桶中前缀为 myPrefix ，且有对象标签含有{age:18}的对象及其所有版本。

分析频次为每天一次。

分析维度包括 Size ，LastModifiedDate，StorageClass，ETag，Tag。

分析结果将以 CSV 格式文件存储在存储桶 inventorybucket-1250000000  中。

PUT /?inventory&id=list2 HTTP/1.1

Date: Mon, 28 Aug 2018 02:53:38 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Content-MD5: AAq9nzrpsz5LJ4UEe1f6Q==

Host: examplebucket-1250000000.cos.ap-guangzhou.myqcloud.com

Content-Length: 1024

<?xml version = "1.0" encoding = "UTF-8">

<InventoryConfiguration xmlns = "http://....">

    <Id>list2</Id>

    <IsEnabled>true</IsEnabled>

    <Destination>

        <COSBucketDestination>

            <Format>CSV</Format>

            <AccountId>100000000001</AccountId>

            <Bucket>qcs::cos:ap-guangzhou::inventorybucket-1250000000</Bucket>

        </COSBucketDestination>

    </Destination>

    <Schedule>

        <Frequency>Daily</Frequency>

    </Schedule>

    <Filter>

        <And>

            <Prefix>myPrefix</Prefix>

            <Tag>

                <Key>age</Key>

                <Value>18</Value>

            </Tag>

        </And>

    </Filter>

    <IncludedObjectVersions>All</IncludedObjectVersions>

    <OptionalFields>

        <Field>Size</Field>
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上述请求后，COS 返回以下响应，表明该清单任务 list2 已经成功设置完毕。

该示例向存储桶 examplebucket-1250000000 中添加一条名为 list3 的清单任务。

        <Field>LastModifiedDate</Field>

        <Field>StorageClass</Field>

        <Field>ETag</Field>

        <Field>Tag</Field>

    </OptionalFields>

</InventoryConfiguration>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Date: Mon, 28 Aug 2018 02:53:38 GMT

Server: tencent-cos

x-cos-request-id: NTlhMzg1ZWVfMjQ4OGY3MGFfMWE1NF8****

案例三：清单支持输出对象的自定义头部

请求

该清单任务分析存储桶中前缀为 myPrefix ，且有对象标签含有{age:18}的对象及其所有版本。

分析频次为每天一次。

分析维度包括 Size ， LastModifiedDate， StorageClass，ETag，Tag，x-cos-meta-

myheader。

分析结果将以 CSV 格式文件存储在存储桶 inventorybucket-1250000000  中。

PUT /?inventory&id=list2 HTTP/1.1

Date: Mon, 28 Aug 2018 02:53:38 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Content-MD5: AAq9nzrpsz5LJ4UEe1f6Q==

Host: examplebucket-1250000000.cos.ap-guangzhou.myqcloud.com

Content-Length: 1024

<?xml version = "1.0" encoding = "UTF-8">

<InventoryConfiguration xmlns = "http://....">

    <Id>list3</Id>

    <IsEnabled>true</IsEnabled>

    <Destination>

        <COSBucketDestination>

            <Format>CSV</Format>
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上述请求后，COS 返回以下响应，表明该清单任务 list3 已经成功设置完毕。

            <AccountId>100000000001</AccountId>

            <Bucket>qcs::cos:ap-guangzhou::inventorybucket-1250000000</Bucket>

        </COSBucketDestination>

    </Destination>

    <Schedule>

        <Frequency>Daily</Frequency>

    </Schedule>

    <Filter>

        <And>

            <Prefix>myPrefix</Prefix>

            <Tag>

                <Key>age</Key>

                <Value>18</Value>

            </Tag>

        </And>

    </Filter>

    <IncludedObjectVersions>All</IncludedObjectVersions>

    <OptionalFields>

        <Field>Size</Field>

        <Field>LastModifiedDate</Field>

        <Field>StorageClass</Field>

        <Field>ETag</Field>

        <Field>Tag</Field>

        <Field>Crc64</Field>

        <Field>x-cos-meta-myheader</Field>

    </OptionalFields>

</InventoryConfiguration>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Date: Mon, 28 Aug 2018 02:53:38 GMT

Server: tencent-cos

x-cos-request-id: NTlhMzg1ZWVfMjQ4OGY3MGFfMWE1NF8****
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POST Bucket inventory
最近更新时间：2022-11-28 08:51:41

POST Bucket inventory 可以对一个存储桶创建一个一次性清单任务。区别于 PUT Bucket inventory，这

个清单任务创建后将立即开始执行，每个任务只会执行一次，而不会周期性地重复执行。通过使用此功能，您能够更

加灵活地获取到存储桶的对象清单，进而更精细化地管理对象。

调用 POST Bucket inventory 需要使用清单任务名称的参数。该参数格式如下：

功能描述

注意

您必须在目标存储桶中写入存储桶策略，以供 COS 将清单任务的结果文件写入该存储桶中。

调用该请求时，请确保您有足够的权限对存储桶的清单任务进行操作。存储桶所有者默认拥有该权限，

若您无该项权限，请先向存储桶所有者申请该项操作的权限。  

如果您指定了清单投递的前缀，COS 后端会自动在您指定的前缀后边加上 /  。如您指定了 Prefix  

作为前缀，则 COS 后端投递的清单报告路径为 Prefix/inventory_report 。

在清单任务未完成前，再次重复提交相同 ID 的清单任务，或者使用与周期性清单任务相同的 ID，服务

端会返回重复清单任务的错误。

请求

请求示例

POST /?inventory&id=inventory-id HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Content-MD5: MD5

说明

Host：<BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参见 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参见 

地域和访问域名  文档。

Authorization：Auth String（详情请参见 请求签名  文档）。

请求参数

https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

用户在请求体中使用 XML 语言设置清单任务的具体配置信息，示例如下：

参

数
描述 类型

是否必

选

id

清单任务的名称。缺省值：None

合法字符： a-z，A-Z，0-9，-，_，.

注意：ID 建议不要与周期清单任务 ID 相同。一天内不允许提交重复的 ID，否

则会返回失败。

Stri

ng
是

请求头

请求体

注意

区别于传统的周期任务形式的清单规则，一次性清单不允许携带参数 IsEnabled 与 Schedule。

其余参数与 PUT Bucket inventory  中的参数完全一致。  

一次性清单报告存储路径与周期性清单一致，详情请参见 清单报告存储路径 。

<InventoryConfiguration>

    <Id>inventory-id</Id>

    <Destination>

        <COSBucketDestination>

            <Format>CSV</Format>

            <AccountId>100000000001</AccountId>

            <Bucket>qcs::cos:ap-guangzhou::examplebucket-1250000000</Bucket>

            <Prefix>cos_bucket_inventory</Prefix>

            <Encryption>

                <SSE-COS></SSE-COS>

            </Encryption>

        </COSBucketDestination>

    </Destination>

    <Filter>

        <And>

            <Prefix>myPrefix</Prefix>

            <Tag>

                <Key>string</Key>

                <Value>string</Value>

            </Tag>

        </And>

    </Filter>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/33707
https://cloud.tencent.com/document/product/436/33703
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该请求的响应体返回为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

该示例向存储桶 examplebucket-1250000000  中发起一条名为 disposable 的清单任务。

    <IncludedObjectVersions>All</IncludedObjectVersions>

    <OptionalFields>

        <Field>Size</Field>

        <Field>LastModifiedDate</Field>

        <Field>ETag</Field>

        <Field>StorageClass</Field>

        <Field>IsMultipartUploaded</Field>

        <Field>ReplicationStatus</Field>

        <Field>Tag</Field>

        <Field>Crc64</Field>

        <Field>x-cos-meta-*</Field>

    </OptionalFields>

</InventoryConfiguration>

响应

响应头

响应体

错误码

实际案例

案例：使用特定前缀过滤对象生成一次性清单

请求

该清单任务分析存储桶中前缀为 myPrefix ，且有对象标签含有 {age:18} 的对象及其所有版本。

分析维度包括 Size、LastModifiedDate、StorageClass、ETag、Tag。

分析结果将以 CSV 格式文件存储在存储桶 inventorybucket-1250000000 中。

假设清单发起时间为2022年11月20日，清单 Manifest 相关文件会发布在目标存储桶以下路径。

cos_bucket_inventory/1250000000/examplebucket/disposable/20221120/manifest.json

cos_bucket_inventory/1250000000/examplebucket/disposable/20221120/manifest.checks

POST /?inventory&id=disposable HTTP/1.1

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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上述请求后，COS 返回以下响应，表明该清单任务已经成功提交。

Date: Mon, 28 Aug 2018 02:53:38 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Content-MD5: AAq9nzrpsz5LJ4UEe1f6Q==

Host: examplebucket-1250000000.cos.ap-guangzhou.myqcloud.com

Content-Length: 1024

<?xml version = "1.0" encoding = "UTF-8">

<InventoryConfiguration xmlns = "http://....">

    <Id>disposable</Id>

    <Destination>

        <COSBucketDestination>

            <Format>CSV</Format>

            <AccountId>100000000001</AccountId>

            <Bucket>qcs::cos:ap-guangzhou::inventorybucket-1250000000</Bucket>

            <Prefix>cos_bucket_inventory</Prefix>

        </COSBucketDestination>

    </Destination>

    <Filter>

        <And>

            <Prefix>myPrefix</Prefix>

            <Tag>

                <Key>age</Key>

                <Value>18</Value>

            </Tag>

        </And>

    </Filter>

    <IncludedObjectVersions>All</IncludedObjectVersions>

    <OptionalFields>

        <Field>Size</Field>

        <Field>LastModifiedDate</Field>

        <Field>StorageClass</Field>

        <Field>ETag</Field>

        <Field>Tag</Field>

    </OptionalFields>

</InventoryConfiguration>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Date: Mon, 28 Aug 2018 02:53:38 GMT

Server: tencent-cos
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x-cos-request-id: NTlhMzg1ZWVfMjQ4OGY3MGFfMWE1NF8****



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第221 共1701页

GET Bucket inventory
最近更新时间：2022-11-16 16:36:32

GET Bucket inventory 接口用于查询存储桶中用户的清单任务信息。用户在发起该请求时，需要用户提供清单

任务的名称，发起该请求时需获得请求签名，表明该请求已获得许可。有关清单的详细特性，请参见 清单功能概

述 。

调用 GET Bucket inventory 需要使用清单任务名称的参数。该参数格式如下：

功能描述

注意

调用该请求时，请确保您有足够的权限对存储桶的清单任务进行操作。

存储桶所有者默认拥有该权限，若您无该项权限，请先向存储桶所有者申请该项操作的权限。

如果您指定了清单投递的前缀，COS 后端会自动在您指定的前缀后边加上 / 。如您指定了 Prefix 作为

前缀，则 COS 后端投递的清单报告路径为 Prefix/inventory_report 。

请求

请求示例

GET /?inventory&id=inventory-configuration-ID HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

参数 描述 类型 是否必选

id 清单任务的名称。缺省值：None

合法字符： a-z，A-Z，0-9，-，_，. 

String 是

https://cloud.tencent.com/document/product/436/33703
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

请求头

请求体

响应

响应头

响应体

<InventoryConfiguration>

    <Id>list1</Id>

    <IsEnabled>true</IsEnabled>

    <Destination>

        <COSBucketDestination>

            <Format>CSV</Format>

            <AccountId>1250000000</AccountId>

            <Bucket>qcs::cos:ap-guangzhou::examplebucket-1250000000</Bucket>

            <Prefix>list1</Prefix>

            <Encryption>

                <SSE-COS></SSE-COS>

            </Encryption>

        </COSBucketDestination>

    </Destination>

    <Schedule>

        <Frequency>Daily</Frequency>

    </Schedule>

    <Filter>

        <Prefix>myPrefix</Prefix>

    </Filter>

    <IncludedObjectVersions>All</IncludedObjectVersions>

    <OptionalFields>

        <Field>Size</Field>

        <Field>LastModifiedDate</Field>

        <Field>ETag</Field>

        <Field>StorageClass</Field>

        <Field>IsMultipartUploaded</Field>

        <Field>ReplicationStatus</Field>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
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具体的节点描述如下：

        <Field>Tag</Field>

        <Field>Crc64</Field>

        <Field>x-cos-meta-*</Field>

    </OptionalFields>

</InventoryConfiguration>

节点名 父节点 描述 类型

Invent

ory 

Config

uration

无 包含清单的配置参数 Container

Id

Inventory 

Configura

tion

清单的名称，与请求参数中的 ID 对应 Container

IsEnab

led

Inventory 

Configura

tion

清单是否启用的标识：

如果设置为 true，清单功能将生效

如果设置为 false，将不生成任何清单

String

Includ

edObje

ct 

Versio

ns

Inventory 

Configura

tion

是否在清单中包含对象版本：

如果设置为 All ，清单中将会包含所有对象版本，并在

清单中增加 VersionId， IsLatest， 

DeleteMarker 这几个字段

如果设置为 Current，则清单中不包含对象版本信息

String

Filter

Inventory 

Configura

tion

筛选待分析对象。清单功能将分析符合 Filter 中设置的前

缀的对象
Container

And Filter
筛选待分析对象时，如果同时需要前缀与对象标签条件，需

要用 And 包装
Container

Prefix And 需要分析的对象的前缀 String

Tag And
筛选待分析对象时，可以用对象标签（支持多个）作为过滤

条件
Container

Period Filter 需要分析的对象的创建时间范围 Container

StartTi

me
Period

需要分析的对象创建的起始时间，参数为秒级时间戳，如

1568688761
String
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EndTi

me

Period 需要分析的对象创建的结束时间，参数为秒级时间戳，如

1568688762

String

Option

alField

s

Inventory 

Configura

tion

设置清单结果中应包含的分析维度 Container

Field
OptionalF

ields

清单结果中可选包含的分析项目名称，可选字段包括：

Size ， LastModifiedDate ， StorageClass ， ETag

， IsMultipartUploaded ， ReplicationStatus ， Tag

， Crc64 ， x-cos-meta-*

注意，如果筛选条件里使用了对象标签，在这里也必须添加 

Tag

此外，也支持用户填写 x-cos-meta-* 形式的自定义头

部，如 x-cos-meta-testheader 。清单会将相应的对象

元数据输出，若对象不包含该元数据，则为空

String

Sched

ule

Inventory 

Configura

tion

配置清单任务周期 Container

Freque

ncy
Schedule 清单任务周期，可选项为按日或者按周 String

Destin

ation

Inventory 

Configura

tion

描述存放清单结果的信息 Container

COSB

ucket 

Destin

ation

Destinati

on
清单结果导出后存放的存储桶信息 Container

Bucket

COSBuck

et 

Destinati

on

清单分析结果的存储桶名 String

Accou

ntId

COSBuck

et 

Destinati

on

存储桶的所有者 ID String

Prefix COSBuck

et 

清单分析结果的前缀 String
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

下述请求示例展示了从存储桶 examplebucket-1250000000 中获取清单任务为 list1 的配置信息。

上述请求后，COS 返回以下响应，表明当前该存储桶内的清单任务 list1 处于启用状态。

Destinati

on

Forma

t

COSBuck

et 

Destinati

on

清单分析结果的文件形式，可选项为 CSV 格式和 ORC 格

式
String

Encryp

tion

COSBuck

et 

Destinati

on

为清单结果提供服务端加密的选项 Container

SSE-

COS

Encryptio

n
COS 托管密钥的加密方式 Container

错误码

实际案例

案例一：获取指定对象前缀的清单任务

请求

GET /?inventory&id=list1 HTTP/1.1

Date: Mon, 28 Aug 2018 02:53:38 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-guangzhou.myqcloud.com

响应

该清单任务分析存储桶 examplebucket-1250000000 中前缀为 myPrefix 的对象及其所有版本。

分析频次为每天一次。

分析维度包括 Size，LastModifiedDate， StorageClass，ETag，IsMultipartUploaded， 

ReplicationStatus。

分析结果将以 CSV 格式文件存储在存储桶 examplebucket-1250000000 中，文件添加前缀 list1 且用 

SSE-COS 加密。

HTTP/1.1 200 OK

https://cloud.tencent.com/document/product/436/7730
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下述请求示例展示了从存储桶 examplebucket-1250000000 中获取清单任务为 list2 的配置信息。

Content-Type: application/xml

Content-Length: 331

Date: Mon, 28 Aug 2018 02:53:39 GMT

Server: tencent-cos

x-cos-request-id: NTlhMzg1ZWVfMjQ4OGY3MGFfMWE1NF84Y2M

<?xml version = "1.0" encoding = "UTF-8">

<InventoryConfiguration xmlns = "http://....">

    <Id>list1</Id>

    <IsEnabled>true</IsEnabled>

    <Destination>

        <COSBucketDestination>

            <Format>CSV</Format>

            <AccountId>1250000000</AccountId>

            <Bucket>qcs::cos:ap-guangzhou::examplebucket-1250000000</Bucket>

            <Prefix>list1</Prefix>

            <Encryption>

                <SSE-COS></SSE-COS>

            </Encryption>

        </COSBucketDestination>

    </Destination>

    <Schedule>

        <Frequency>Daily</Frequency>

    </Schedule>

    <Filter>

        <Prefix>myPrefix</Prefix>

    </Filter>

    <IncludedObjectVersions>All</IncludedObjectVersions>

    <OptionalFields>

        <Field>Size</Field>

        <Field>LastModifiedDate</Field>

        <Field>ETag</Field>

        <Field>StorageClass</Field>

        <Field>IsMultipartUploaded</Field>

        <Field>ReplicationStatus</Field>

    </OptionalFields>

</InventoryConfiguration>

案例二：获取指定对象前缀和对象标签的清单任务

请求

GET /?inventory&id=list2 HTTP/1.1

Date: Mon, 28 Aug 2018 02:53:38 GMT
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上述请求后，COS 返回以下响应，表明当前该存储桶内的清单任务 list2 处于启用状态。

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-guangzhou.myqcloud.com

响应

该清单任务分析存储桶 examplebucket-1250000000 中前缀为 myPrefix，且含有对象标签{age:18}的对

象及其所有版本。

分析频次为每天一次。

分析维度包括 Size，LastModifiedDate， StorageClass，ETag，Tag。

分析结果将以 CSV 格式文件存储在存储桶 inventorybucket-1250000000 中。

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 331

Date: Mon, 28 Aug 2018 02:53:39 GMT

Server: tencent-cos

x-cos-request-id: NTlhMzg1ZWVfMjQ4OGY3MGFfMWE1NF84Y2M

<?xml version = "1.0" encoding = "UTF-8">

<InventoryConfiguration xmlns = "http://....">

    <Id>list2</Id>

    <IsEnabled>true</IsEnabled>

    <Destination>

        <COSBucketDestination>

            <Format>CSV</Format>

            <AccountId>1250000000</AccountId>

            <Bucket>qcs::cos:ap-guangzhou::inventorybucket-1250000000</Bucket>

        </COSBucketDestination>

    </Destination>

    <Schedule>

        <Frequency>Daily</Frequency>

    </Schedule>

    <Filter>

        <And>

            <Prefix>myPrefix</Prefix>

            <Tag>

                <Key>age</Key>

                <Value>18</Value>

            </Tag>

        </And>

    </Filter>

    <IncludedObjectVersions>All</IncludedObjectVersions>

    <OptionalFields>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第228 共1701页

        <Field>Size</Field>

        <Field>LastModifiedDate</Field>

        <Field>StorageClass</Field>

        <Field>ETag</Field>

        <Field>Tag</Field>

    </OptionalFields>

</InventoryConfiguration>
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List Bucket Inventory Configurations
最近更新时间：2022-06-29 15:55:13

List Bucket Inventory Configurations 用于请求返回一个存储桶中的所有清单任务。每一个存储桶中最多配

置1000条清单任务。  

该请求支持列表分页，每页一次最多返回100条清单任务。请确认请求中的 IsTruncated 节点的值：

有关清单的详细特性，请参见 清单功能概述 。

请求参数格式如下：

功能描述

如果 IsTruncated 为 false，则表明已经将存储桶中的所有清单任务全部列出。

如果 IsTruncated 为 true，且 NextContinuationToken 节点中存在参数值，则您可以将 

NextContinuationToken 节点的值传递至 continuation-token 节点中，获取下一分页的清单任务信息。

注意

 调用该请求时，请确保您有足够的权限对存储桶的清单任务进行操作。存储桶所有者默认拥有该权限，如

您无该项权限，请先向存储桶所有者申请该项操作的权限。

请求

请求示例

GET /?inventory HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

参数 描述 类

型

是

否

https://cloud.tencent.com/document/product/436/33703
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

必

选

contin

uation

-

token

当 COS 响应体中 IsTruncated 为 true，且 NextContinuationToken 节

点中存在参数值时，您可以将这个参数作为 continuation-token 参数值，以

获取下一页的清单任务信息。

缺省值：None

S

tr

in

g

否

请求头

请求体

响应

响应头

响应体

<ListInventoryConfigurationResult>

    <InventoryConfiguration>

        <Id>list1</Id>

        <IsEnabled>True</IsEnabled>

        <Destination>

            <COSBucketDestination>

                <Format>CSV</Format>

                <AccountId>1250000000</AccountId>

                <Bucket>qcs::cos:ap-beijing::examplebucket-1250000000</Bucket>

                <Prefix>list1</Prefix>

                <SSE-COS></SSE-COS>

            </COSBucketDestination>

        </Destination>

        <Schedule>

            <Frequency>Daily</Frequency>

        </Schedule>

        <Filter>

            <Prefix>myPrefix</Prefix>

        </Filter>

        <IncludedObjectVersions>All</IncludedObjectVersions>

        <OptionalFields>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
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具体的节点描述如下：

            <Field>Size</Field>

            <Field>LastModifiedDate</Field>

            <Field>ETag</Field>

            <Field>StorageClass</Field>

            <Field>IsMultipartUpload</Field>

            <Field>ReplicationStatus</Field>

        </OptionalFields>

    </InventoryConfiguration>

    <InventoryConfiguration>

        <Id>list2</Id>

        <IsEnabled>True</IsEnabled>

        <Destination>

            <COSBucketDestination>

                <Format>CSV</Format>

                <AccountId>1250000000</AccountId>

                <Bucket>qcs::cos:ap-beijing::examplebucket-1250000000</Bucket>

                <Prefix>list2</Prefix>

                <SSE-COS></SSE-COS>

            </COSBucketDestination>

        </Destination>

        <Schedule>

            <Frequency>Weekly</Frequency>

        </Schedule>

        <Filter>

            <Prefix>myPrefix2</Prefix>

        </Filter>

        <IncludedObjectVersions>All</IncludedObjectVersions>

        <OptionalFields>

            <Field>Size</Field>

            <Field>LastModifiedDate</Field>

            <Field>ETag</Field>

            <Field>StorageClass</Field>

        </OptionalFields>

    </InventoryConfiguration>

    <IsTruncated>false</IsTruncated>

    ------If ContinuationToken was provided in the request---

    <ContinuationToken> .</ContinuationToken>

    <IsTruncated>true</IsTruncated>

    <NextContinuationToken>1ueSDFASDF1Tr/XDAFdadEADadf2J/wm36Hy4vbOwM=</Nex

</ListInventoryConfigurationResult>

..

节点名 父节点 描述
类

型
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

下述请求示例展示了从存储桶 examplebucket-1250000000 中获取清单任务为 list1 的配置信息。

List 

InventoryCo

nfigurationR

esult

无 存储桶中所有清单任务信息的列表

C

o

nt

ai

n

er

InventoryCo

nfiguration

ListInventor

yConfigurati

onResult

包含清单任务的详细信息，其 XML 结构请参见 GET 

Bucket inventory

C

o

nt

ai

n

er

IsTruncated

ListInventor

yConfigurati

onResult

是否已列出所有清单任务信息的标识。如果已经展示完则为 

false，否则为 true

B

o

ol

e

a

n

Continuation

Token

ListInventor

yConfigurati

onResult

当页清单列表的标识，可理解为页数。该标识与请求中的 

continuation-token 参数对应

St

ri

n

g

NextContinu

ationToken

ListInventor

yConfigurati

onResult

下一页清单列表的标识。如果该参数中有值，则可将该值作

为 continuation-token 参数并发起 GET 请求以获取下

一页清单任务信息

St

ri

n

g

错误码

实际案例

请求

GET /?inventory HTTP/1.1

Date: Mon, 28 Aug 2018 02:53:38 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98JM&q

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

https://cloud.tencent.com/document/product/436/7730
https://cloud.tencent.com/document/product/436/33705
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请求后，COS 返回以下响应，表明当前该存储桶内存在清单任务 list1 和 list2 。  

清单任务 list1

清单任务 list2

假设本页有100条清单任务，当 IsTruncated 为 true 时，COS 将会进一步返回 NextContinuationToken 

，其中的值可作为 GET 请求中 continuation-token 的参数，以获取下一页信息。

响应

分析存储桶 examplebucket-1250000000 中前缀为 myPrefix 的对象及其所有版本。

分析频次为每天一次。

分析维度包括 Size、LastModifiedDate、StorageClass、ETag、IsMultipartUploaded、

ReplicationStatus。

分析结果将以 CSV 格式文件存储在存储桶 inventorybucket-1250000000 中，文件添加前缀 list1 且用 

SSE-COS 加密。

分析存储桶 examplebucket-1250000000 中前缀为 myPrefix2 ，且含有对象标签{age:18}的对象及其

所有版本。

分析频次为每周一次；分析的维度包括 Size ， LastModifiedDate ，  StorageClass ， ETag， Tag。

分析结果将以 CSV 格式文件存储在存储桶 inventorybucket-1250000000 中。

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 331

Date: Mon, 28 Aug 2018 02:53:39 GMT

Server: tencent-cos

x-cos-request-id: NTlhMzg1ZWVfMjQ4OGY3MGFfMWE1NF8****

<?xml version = "1.0" encoding = "UTF-8">

<ListInventoryConfigurationResult xmlns = "http://....">

    <InventoryConfiguration>

        <Id>list1</Id>

        <IsEnabled>True</IsEnabled>

        <Destination>

            <COSBucketDestination>

                <Format>CSV</Format>

                <AccountId>1250000000</AccountId>

                <Bucket>qcs::cos:ap-beijing::inventorybucket-1250000000</Bucket>

                <Prefix>list1</Prefix>

                <SSE-COS></SSE-COS>

            </COSBucketDestination>

        </Destination>

        <Schedule>

            <Frequency>Daily</Frequency>

        </Schedule>

        <Filter>
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            <Prefix>myPrefix</Prefix>

        </Filter>

        <IncludedObjectVersions>All</IncludedObjectVersions>

        <OptionalFields>

            <Field>Size</Field>

            <Field>LastModifiedDate</Field>

            <Field>ETag</Field>

            <Field>StorageClass</Field>

            <Field>IsMultipartUpload</Field>

            <Field>ReplicationStatus</Field>

        </OptionalFields>

    </InventoryConfiguration>

    <InventoryConfiguration>

        <Id>list2</Id>

        <IsEnabled>True</IsEnabled>

        <Destination>

            <COSBucketDestination>

                <Format>CSV</Format>

                <AccountId>1250000000</AccountId>

                <Bucket>qcs::cos:ap-beijing::inventorybucket-1250000000</Bucket>

            </COSBucketDestination>

        </Destination>

        <Schedule>

            <Frequency>Weekly</Frequency>

        </Schedule>

        <Filter>

            <And>

                <Prefix>myPrefix2</Prefix>

                <Tag>

                    <Key>age</Key>

                    <Value>18</Value>

                </Tag>

            </And>

        </Filter>

        <IncludedObjectVersions>All</IncludedObjectVersions>

        <OptionalFields>

            <Field>Size</Field>

            <Field>LastModifiedDate</Field>

            <Field>StorageClass</Field>

            <Field>ETag</Field>

            <Field>Tag</Field>

        </OptionalFields>

    </InventoryConfiguration>

    <IsTruncated>false</IsTruncated>

    ------If ContinuationToken was provided in the request---
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    <ContinuationToken> .</ContinuationToken>

    <IsTruncated>true</IsTruncated>

    <NextContinuationToken>1ueSDFASDF1Tr/XDAFdadEADadf2J/wm36Hy4vbOwM=</Nex

</ListInventoryConfigurationResult>

..
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DELETE Bucket inventory
最近更新时间：2021-07-22 10:10:37

DELETE Bucket inventory 用于删除存储桶中指定的清单任务，用户需提供待删除的清单任务的名称。 

有关清单的详细特性，请参见 清单功能概述 。

调用 DELETE Bucket inventory 需要使用清单任务名称的参数。该参数格式如下：

功能描述

注意

调用该请求时，请确保您有足够的权限对存储桶的清单任务进行操作。

存储桶所有者默认拥有该权限，如您无该项权限，请先向存储桶所有者申请该项操作的权限。

请求

请求示例

DELETE /?inventory&id=inventory-configuration-id HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

参数 描述 类型 必选

id
清单任务的名称。缺省值：None

合法字符： a-z，A-Z，0-9，-，_，. 
String 是

请求头

https://cloud.tencent.com/document/product/436/33703
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

下述请求示例展示了从存储桶 examplebucket-1250000000 中删除清单任务 list1。

上述请求后，COS 返回 204 No Content 的响应表明已成功删除了该存储桶内的清单任务 list1。

请求体

响应

响应头

响应体

错误码

实际案例

请求

DELETE /?inventory&id=list1 HTTP/1.1

Date: Mon, 28 Aug 2018 02:53:38 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 204 No Content 

Server: tencent-cos

Date: Mon, 28 Aug 2018 02:53:40 GMT

x-cos-id-2:0dfafa/DAPDIFdafdsfDdfSFFfdfKKJdafasiuKJK2

x-cos-request-id: NTlhM2I3M2JfMjQ4OGY3MGFfMWE1NF84****

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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版本控制（versioning）

PUT Bucket versioning
最近更新时间：2021-07-22 10:10:43

PUT Bucket versioning 接口实现启用或者暂停存储桶的版本控制功能。

1. 如果您从未在存储桶上启用过版本控制，则 GET Bucket versioning 请求不返回版本状态值。

2. 开启版本控制功能后，只能暂停，不能关闭。

3. 设置版本控制状态值为 Enabled 或者 Suspended，表示开启版本控制和暂停版本控制。

4. 设置存储桶的版本控制功能，您需要有存储桶的写权限。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

细节分析

请求

请求示例

PUT /?versioning HTTP 1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

<VersioningConfiguration>

  <Status></Status>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体的数据内容如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

</VersioningConfiguration>

节点名称（关键字） 父节点 描述 类型

VersioningConfig

uration
无 说明版本控制的具体信息

Contai

ner

Status
VersioningConfig

uration

说明版本是否开启，枚举值：

Suspended、Enabled
Enum

响应

响应头

响应体

错误码

实际案例

请求

PUT /?versioning HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: python-requests/2.12.4

Content-Type: application/xml

Authorization: q-sign-algorithm=sha1&q-ak=AKID15IsskiBQKTZbAo6WhgcBqVls9Sm****&

Content-Length: 83

<VersioningConfiguration>

    <Status>Enabled</Status>

</VersioningConfiguration>

响应

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Wed, 23 Aug 2017 08:14:53 GMT

Server: tencent-cos

x-cos-request-id: NTk5ZDM5N2RfMjNiMjM1MGFfMmRiX2Y0****
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GET Bucket versioning
最近更新时间：2021-07-22 10:10:49

GET Bucket versioning 接口用于实现获得存储桶的版本控制信息。

1. 获取存储桶版本控制的状态，需要有该存储桶的读权限。

2. 有三种版本控制状态：未启用版本控制、启用版本控制和暂停版本控制。

功能描述

细节分析

如果您从未在存储桶上启用（或暂停）版本控制，则响应为：

<VersioningConfiguration/>

如果您启用了存储桶的版本控制功能，则响应为：

<VersioningConfiguration>

  <Status>Enabled</Status>

</VersioningConfiguration>

如果您暂停了存储桶的版本控制功能，则响应为：

<VersioningConfiguration>

 <Status>Suspended</Status>

</VersioningConfiguration>

请求

请求示例

GET /?versioning HTTP 1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

具体的节点描述如下：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

响应体

<VersioningConfiguration>

    <Status></Status>

</VersioningConfiguration>

节点名称（关键字） 父节点 描述 类型

VersioningConfig

uration
无 说明版本控制的具体信息

Contai

ner

Status
VersioningConfig

uration

说明版本是否开启，枚举值：

Suspended、Enabled
Enum

错误码

实际案例

请求

GET /?versioning HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Connection: keep-alive

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: python-requests/2.12.4

Authorization: q-sign-algorithm=sha1&q-ak=AKID15IsskiBQKTZbAo6WhgcBqVls9Sm****&

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 120

Connection: keep-alive

Date: Wed, 23 Aug 2017 08:15:16 GMT

Server: tencent-cos

x-cos-request-id: NTk5ZDM5OTRfZDNhZDM1MGFfMjYyMTFfZmU3****

<?xml version='1.0' encoding='utf-8' ?>

<VersioningConfiguration>

    <Status>Enabled</Status>

</VersioningConfiguration>
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存储桶复制（replication）

PUT Bucket replication
最近更新时间：2023-02-10 15:22:04

PUT Bucket replication 用于向已启用版本控制的存储桶中配置存储桶复制规则。如果存储桶已经配置了存储桶

复制规则，那么该请求会替换现有配置。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

注意

使用该接口时，需确保存储桶已经开启版本控制，开启版本控制的 API 文档请参见 PUT Bucket 

versioning   接口文档。

开启了多 AZ 配置的存储桶，不支持将多 AZ 存储类型复制为单 AZ 存储类型，例如标准存储（多 

AZ）类型不支持复制为标准存储类型。

请求

请求示例

PUT /?replication HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-MD5: MD5

Authorization: Auth String

request body

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参见 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参见 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/19889
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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用户在请求体中设置存储桶复制的具体配置信息。配置信息包括存储桶复制规则的启用状态、优先级、复制内容、筛

选范围、目标存储桶的存储桶名称和存储地域等信息。

具体内容描述如下：

<ReplicationConfiguration>

    <Role>qcs::cam::uin/<OwnerUin>:uin/<SubUin></Role>

    <Rule>

        <Status></Status>

        <ID></ID>

        <Prefix></Prefix>

        <Destination>

            <Bucket>qcs::cos:<Region>::<BucketName-APPID></Bucket>

            <StorageClass></StorageClass>

        </Destination>

        <DeleteMarkerReplication>

            <Status></Status>

        </DeleteMarkerReplication>

    </Rule>

</ReplicationConfiguration>

节点名称

（关键字）
父节点 描述

类

型

是

否

必

选

Replicati

onConfig

uration

无 说明所有复制配置信息

C

o

nt

ai

n

er

是

Role
ReplicationConfiguratio

n

发起者身份标示：

qcs::cam::uin/<OwnerUin>:uin/<S

ubUin>

St

ri

n

g

是

Rule
ReplicationConfiguratio

n
具体配置信息，最多支持1000个

C

o

nt

ai

n

er

是
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

ID ReplicationConfiguratio

n.Rule

用来标注具体 Rule 的名称 St

ri

n

g

否

Status
ReplicationConfiguratio

n.Rule

标识 Rule 是否生效，枚举值：

Enabled、Disabled

St

ri

n

g

是

Prefix
ReplicationConfiguratio

n.Rule
需要复制的对象前缀

St

ri

n

g

否

Destinati

on

ReplicationConfiguratio

n.Rule
目标存储桶信息

C

o

nt

ai

n

er

是

Bucket
ReplicationConfiguratio

n.Rule.Destination

资源标识符：

qcs::cos:<Region>::

<BucketName-APPID>

St

ri

n

g

是

DeleteM

arkerRep

lication

ReplicationConfiguratio

n.Rule
是否同步删除标记

C

o

nt

ai

n

er

否

Status

ReplicationConfiguratio

n.Rule. 

DeleteMarkerReplicatio

n

是否同步删除标记，支持 Disabled  或 

Enabled 。默认值为 Enabled ，即同

步删除标记

St

ri

n

g

否

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/7729
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该响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

以下请求是对存储桶 originbucket-1250000000  添加一条存储桶复制配置。该存储桶复制配置中，指定复制对

象前缀为 testPrefix  的对象，目标存储桶为广州的 destinationbucket-1250000000 。

上述请求后，COS 返回以下响应，表明当前该跨地域配置已经成功设置完毕。

错误码

实际案例

请求

PUT /?replication HTTP/1.1

Date: Mon, 28 Aug 2017 02:53:38 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Content-MD5: AAq9nzrpsz5LJ4UEe1f6Q==

Host: originbucket-1250000000.cos.ap-guangzhou.myqcloud.com

Content-Length: 312

<ReplicationConfiguration>

    <Role>qcs::cam::uin/100000000001:uin/100000000001</Role>

    <Rule>

        <Status>Enabled</Status>

        <ID>RuleId_01</ID>

        <Prefix>testPrefix</Prefix>

        <Destination>

            <Bucket>qcs::cos:ap-guangzhou::destinationbucket-1250000000</Bucket>

        </Destination>

    </Rule>

</ReplicationConfiguration>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Fri, 14 Apr 2019 07:06:19 GMT

Server: tencent-cos

x-cos-bucket-region: ap-guangzhou

x-cos-request-id: NWQwMzQ3NmJfMjRiMjU4NjRfOTM4NV82ZDU1****

x-cos-trace-id: OGVmYzZiMmQzYjA2OWNhODk0NTRkMTBiOWVmMDAxODc0OWRkZjk0ZD

https://cloud.tencent.com/document/product/436/7730
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GET Bucket replication
最近更新时间：2023-02-10 15:22:11

GET Bucket replication 接口用于查询存储桶中用户存储桶复制配置信息。用户发起该请求时需获得请求签名，

表明该请求已获得许可。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /?replication HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参见 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参见 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体的节点描述如下：

<ReplicationConfiguration>

    <Role>qcs::cam::uin/<OwnerUin>:uin/<SubUin></Role>

    <Rule>

        <Status></Status>

        <ID></ID>

        <Prefix></Prefix>

        <Destination>

            <Bucket>qcs::cos:<Region>::<BucketName-APPID></Bucket>

            <StorageClass></StorageClass>

        </Destination>

        <DeleteMarkerReplication>

            <Status></Status>

        </DeleteMarkerReplication>

    </Rule>

</ReplicationConfiguration>

节点名称

（关键

字）

父节点 描述
类

型

Replica

tionCo

nfigura

tion

无 说明所有复制配置信息

C

o

n

t

ai

n

e

r

Role
ReplicationConfigur

ation

发起者身份标示：

qcs::cam::uin/&lt;OwnerUin>:uin/&lt;SubUin>

S

tr

in

g

Rule
ReplicationConfigur

ation

具体配置信息，最多支持1000个，所有策略只能指向一

个目标存储桶

C

o

n

t

ai

n

e

r
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ID ReplicationConfigur

ation.Rule

用来标注具体 Rule 的名称 S

tr

in

g

Status
ReplicationConfigur

ation.Rule
标识 Rule 是否生效，枚举值：Enabled，Disabled

S

tr

in

g

Prefix
ReplicationConfigur

ation.Rule

前缀匹配策略，不可重叠，重叠返回错误，前缀匹配根目

录为空

S

tr

in

g

Destin

ation

ReplicationConfigur

ation.Rule
目标存储桶信息

C

o

n

t

ai

n

e

r

Bucket

ReplicationConfigur

ation.Rule.Destinati

on

资源标识符：

qcs::cos:[region]::[BucketName-APPID]

S

tr

in

g

Storag

eClass

ReplicationConfigur

ation.Rule.Destinati

on

存储类型，枚举值：STANDARD，

INTELLIGENT_TIERING，STANDARD_IA，

ARCHIVE，DEEP_ARCHIVE，默认值：原存储类型

S

tr

in

g

Delete

Marker

Replica

tion

ReplicationConfigur

ation.Rule
是否同步删除标记

C

o

n

t

ai

n

e

r

Status ReplicationConfigur

ation.Rule. 

DeleteMarkerReplic

ation

是否同步删除标记，支持 Disabled  或 Enabled 。默

认值为 Enabled ，即同步删除标记

S

tr

in

g
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

下述请求示例展示了从存储桶 originbucket-1250000000 中查询配置信息。

上述请求后，COS 返回以下响应，表明当前该存储桶内的存储桶复制配置处于启用状态。该规则配置信息中，复制

的内容为存储桶 originbucket-1250000000  内包含 testPrefix  前缀的所有对象。对象副本的存储类型默认跟

随源存储桶内对象的存储类型。

错误码

实际案例

请求

GET /?replication HTTP/1.1

Date: Fri, 14 Apr 2019 07:17:19 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98JM&q

Host: originbucket-1250000000.cos.ap-guangzhou.myqcloud.com

Content-Length: 0

响应

Content-Type: application/xml

Content-Length: 309

Connection: keep-alive

Date: Fri, 14 Apr 2019 07:17:19 GMT

Server: tencent-cos

x-cos-replication-rule-creation-time: Fri, 14 Apr 2019 07:06:19 GMT

x-cos-request-id: NWQwMzQ5ZmZfMjBiNDU4NjRfNjAwOV84MzA2****

<ReplicationConfiguration>

    <Role>qcs::cam::uin/100000000001:uin/100000000001</Role>

    <Rule>

        <Status>Enabled</Status>

        <ID>RuleId_01</ID>

        <Prefix>testPrefix</Prefix>

        <Destination>

            <Bucket>qcs::cos:ap-guangzhou::destinationbucket-1250000000</Bucket>

        </Destination>

    </Rule>

</ReplicationConfiguration>

https://cloud.tencent.com/document/product/436/7730
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DELETE Bucket replication
最近更新时间：2023-02-10 15:22:18

DELETE Bucket replication 用来删除存储桶中的存储桶复制配置。用户发起该请求时需获得请求签名，表明该

请求已获得许可。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体为空。

功能描述

请求

请求示例

DELETE /?replication HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参见 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参见 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

响应体

错误码

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

下述请求示例展示了从存储桶 originbucket-1250000000  中删除配置信息。

上述请求后，COS 返回 204 No Content 的响应表明已成功删除了该存储桶内的存储桶复制配置。删除存储桶复

制配置后，COS 将不再复制源存储桶中的对象到目标存储桶中，目标存储桶中已有的对象数据将被保留。

实际案例

请求

DELETE /?replication HTTP/1.1

Date: Fri, 14 Apr 2019 07:47:35 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: originbucket-1250000000.cos.ap-chengdu.myqcloud.com

响应

Content-Length: 0

Connection: keep-alive

Date: Fri, 14 Apr 2019 07:47:35 GMT

Server: tencent-cos

x-cos-request-id: NWQwMzUxMTdfMjBiNDU4NjRfNWZlZF84Mjdm****

x-cos-trace-id: OGVmYzZiMmQzYjA2OWNhODk0NTRkMTBiOWVmMDAxODc0OWRkZjk0ZD

https://cloud.tencent.com/document/product/436/7730
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日志管理（logging）

PUT Bucket logging
最近更新时间：2021-07-22 10:11:06

PUT Bucket Logging 接口用于为源存储桶开启日志记录，将源存储桶的访问日志保存到指定的目标存储桶中。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有请求体。带所有节点的请求体内容示例如下：

功能描述

注意

只有源存储桶拥有者才可进行该请求操作。

开启访问日志功能，需要授予日志服务（CLS）产品写入 COS 的权限，授权流程请参见 启用日志管

理 。

请求

请求示例

PUT /?logging HTTP 1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date:date

Content-Length: length

Content-Type: application/xml

Content-MD5: MD5

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/16920#.E5.90.AF.E7.94.A8.E6.97.A5.E5.BF.97.E7.AE.A1.E7.90.86
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体的数据描述如下：

Container 节点 BucketLoggingStatus 的内容：

Container 节点 LoggingEnabled 的内容：

<BucketLoggingStatus>

  <LoggingEnabled>

    <TargetBucket>examplebucket-1250000000</TargetBucket>

    <TargetPrefix>prefix</TargetPrefix>

  </LoggingEnabled>

</BucketLoggingStatus>

节点名称（关键

字）

父

节

点

描述 类型
是否

必选

BucketLogging

Status
无

说明日志记录配置的状态，如果无子节点信息则意

为关闭日志记录

Contai

ner
是

节点名称（关

键字）
父节点 描述 类型

是否

必选

LoggingEn

abled

BucketLogging

Status

存储桶 logging 设置的具体信息，主要

是目标存储桶

Contai

ner
否

节点名称

（关键字）
父节点 描述

类

型

是否

必选

TargetBu

cket

Logging

Enable

d

存放日志的目标存储桶，可以是同一个存储桶（但不推

荐），或同一账户下、同一地域的存储桶

St

ri

n

g

否

TargetPre

fix

Logging

Enable

d

日志存放在目标存储桶的指定路径

St

ri

n

g

否

说明

用户指定存放日志的存储桶和路径后，生成的日志文件名格式为：

目标存储桶/路径前缀{YYYY}/{MM}/{DD}/{time}_{random}_{index}.gz 。
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

响应

响应头

响应体

错误码

实际案例

请求

PUT /?logging HTTP 1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2017 09:45:46 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUj***

Content-Type: application/xml

Content-Length: 147

<BucketLoggingStatus>

  <LoggingEnabled>

    <TargetBucket>examplebucket-1250000000</TargetBucket>

    <TargetPrefix>prefix</TargetPrefix>

  </LoggingEnabled>

</BucketLoggingStatus>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Fri, 10 Mar 2017 09:45:46 GMT

Server: tencent-cos

x-cos-request-id: NTg4MDdiZWRfOWExZjRlXzQ2OWVf****

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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GET Bucket logging
最近更新时间：2021-07-22 10:11:10

GET Bucket logging 用于获取源存储桶的日志配置信息。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

注意

只有源存储桶拥有者才可进行该请求操作。

请求

请求示例

GET /?logging HTTP 1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第259 共1701页

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 BucketLoggingStatus 的内容：

Container 节点 LoggingEnabled 的内容：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

<BucketLoggingStatus>

  <LoggingEnabled>

    <TargetBucket>examplebucket-1250000000</TargetBucket>

    <TargetPrefix>prefix</TargetPrefix>

  </LoggingEnabled>

</BucketLoggingStatus>

节点名称（关键字） 父节点 描述 类型

BucketLoggingStatus 无 存储桶日志状态信息 Container

节点名称（关键字） 父节点 描述 类型

LoggingEnabled BucketLoggingStatus 存储桶日志记录配置详细信息 Container

节点名称（关

键字）
父节点 描述 类型

TargetBuc

ket

Logging

Enabled

存放日志的目标存储桶，可以是同一个存储桶（但不推荐），

或同一账户下、同一地域的存储桶
String

TargetPref

ix

Logging

Enabled
日志存放在目标存储桶的指定路径 String

错误码

实际案例

请求

GET /?logging HTTP 1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 28 Oct 2017 21:32:00 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5O****&q-sign-time=1484815

https://cloud.tencent.com/document/product/436/7730
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 142

Connection: keep-alive

Date: Wed, 28 Oct 2017 21:32:00 GMT

Server: tencent-cos

x-cos-request-id: NTg4MDdlNGZfNDYyMDRlXzM0YWFf****

<BucketLoggingStatus>

  <LoggingEnabled>

    <TargetBucket>examplebucket-1250000000</TargetBucket>

    <TargetPrefix>prefix</TargetPrefix>

  </LoggingEnabled>

</BucketLoggingStatus>
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全球加速（accelerate）

PUT Bucket accelerate
最近更新时间：2023-05-25 15:02:29

PUT Bucket accelerate 接口实现启用或者暂停存储桶的全球加速功能。

细节分析

1. 如果您从未在存储桶上启用过全球加速功能，则 GET Bucket accelerate 请求不返回全球加速功能配置状

态。

2. 开启全球加速功能后，只能暂停，不能关闭。

3. 设置全球加速功能状态值为 Enabled 或 Suspended，表示开启或暂停全球加速功能。

4. 如果您是子账号，需要设置存储桶的全球加速功能，您需要有该配置的写入权限。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

请求

请求示例

PUT /?accelerate HTTP 1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

<AccelerateConfiguration xmlns="cos xmlns/"> 

  <Status>Enabled</Status> 

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体的节点描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

</AccelerateConfiguration>

节点名称（关键字） 父节点 描述 类型

AccelerateConfi

guration
无 全球加速的具体信息

Conta

iner

Status
AccelerateConfi

guration

说明全球加速功能是否开启，枚举值：

Suspended、Enabled
Enum

响应

响应头

响应体

错误码

实际案例

请求

PUT /?accelerate HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Connection: keep-alive

Authorization: authorization string

Content-Type: text/plain

Content-Length: 83

<AccelerateConfiguration>

    <Status>Enabled</Status>

</AccelerateConfiguration>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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Content-Length: 0

Connection: keep-alive

Date: Wed, 23 Aug 2019 08:14:53 GMT

Server: tencent-cos

x-cos-request-id: NTk5ZDM5N2RfMjNiMjM1MGFfMmRiX2Y0****
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GET Bucket accelerate
最近更新时间：2021-08-24 16:44:44

GET Bucket accelerate 接口实现查询存储桶的全球加速功能配置。

细节分析

1. 如果您从未在存储桶上启用过全球加速功能，则 GET Bucket accelerate 请求不返回全球加速功能配置状

态。

2. 全球加速功能状态值合法返回值为 Enabled 或者 Suspended，表示开启全球加速功能和暂停全球加速功能。

3. 如果您是为子账号，需要查询存储桶的全球加速功能配置信息，您需要有该配置的读取权限。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

功能描述

请求

请求示例

GET /?accelerate HTTP 1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体的节点描述如下：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

响应体

<AccelerateConfiguration xmlns="cos xmlns/"> 

  <Status>Enabled</Status> 

  <Type>COS</Type>

</AccelerateConfiguration>

节点名称（关键字） 父节点 描述 类型

AccelerateConfi

guration
无 全球加速的具体信息

Conta

iner

Status
AccelerateConfi

guration

说明全球加速功能是否开启，枚举值：

Suspended、Enabled
Enum

Type
AccelerateConfi

guration
指定全球加速功能的类型，枚举值：COS Enum

错误码

实际案例

请求

GET /?accelerate HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Connection: keep-alive

Authorization: authorization string

Content-Type: text/plain

响应1（开启全球加速状态）

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 73

Connection: keep-alive

Date: Wed, 23 Aug 2019 08:14:53 GMT

Server: tencent-cos

x-cos-request-id: NTk5ZDM5N2RfMjNiMjM1MGFfMmRiX2Y0****

https://cloud.tencent.com/document/product/436/7730
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<AccelerateConfiguration>

  <Status>Enabled</Status>

  <Type>COS</Type>

</AccelerateConfiguration>

响应2（暂停全球加速状态）

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 73

Connection: keep-alive

Date: Wed, 23 Aug 2019 08:14:53 GMT

Server: tencent-cos

x-cos-request-id: NTk5ZDM5N2RfMjNiMjM1MGFfMmRiX2Y0****

<AccelerateConfiguration>

  <Status>Disabled</Status>

  <Type>COS</Type>

</AccelerateConfiguration>

响应3（未开启全球加速状态）

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 73

Connection: keep-alive

Date: Wed, 23 Aug 2019 08:14:53 GMT

Server: tencent-cos

x-cos-request-id: NTk5ZDM5N2RfMjNiMjM1MGFfMmRiX2Y0****

<AccelerateConfiguration/>
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存储桶加密（encryption）

PUT Bucket encryption
最近更新时间：2022-11-15 16:55:47

PUT Bucket encryption 接口用于设置指定存储桶下的默认加密配置。

要执行此接口，必须拥有 PutBucketEncryption 权限。默认情况下，Bucket 的持有者直接拥有权限使用该 

API 接口，Bucket 持有者也可以将权限授予其他用户。

请求示例

请求参数

此接口无请求参数。

请求头

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

请求体

用户在请求体中使用 XML 语言设置存储桶默认加密配置信息。加密配置信息主要为加密项。

以下是用于设置 SSE-COS 的请求体：

功能描述

请求

PUT /?encryption HTTP 1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

<ServerSideEncryptionConfiguration>

      <Rule>

         <ApplyServerSideEncryptionByDefault>

             <SSEAlgorithm>AES256|KMS</SSEAlgorithm>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体元素如下：

响应头

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应体

该请求的响应体返回为空。

错误码

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

             <KMSMasterKeyID>String</KMSMasterKeyID>

         </ApplyServerSideEncryptionByDefault>

      </Rule>

</ServerSideEncryptionConfiguration>

元素名称 父节点 描述 类型

是

否

必

选

ServerSi

deEncry

ptionCo

nfigurati

on

无 包含默认加密的配置参数
Cont

ainer
是

Rule
ServerSideEncryptio

nConfiguration
默认的服务端加密配置规则

Cont

ainer
是

ApplySe

rverSide

Encrypti

onByDef

ault

ServerSideEncryptio

nConfiguration.Rule
服务端加密的默认配置信息

Cont

ainer
是

SSEAlgo

rithm

ServerSideEncryptio

nConfiguration.Rule.

ApplyServerSideEncr

yptionByDefault

支持枚举值 AES256、KMS，AES256 

代表使用 SSE-COS 模式，加密算法为 

AES256；KMS 代表 SSE-KMS 模式

Strin

g
是

KMSMas

terKeyID

ServerSideEncryptio

nConfiguration.Rule.

ApplyServerSideEncr

yptionByDefault

当 SSEAlgorithm 的值为 KMS 时，用

于指定 KMS 的用户主密钥 CMK，如不

指定，则使用 COS 默认创建的 CMK，更

多详细信息可参见 SSE-KMS 加密

Strin

g
是

响应

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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请求

以下示例表示给存储桶 examplebucket-1250000000 设置 SSE-COS 加密。

响应

实际案例

PUT /?encryption HTTP 1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Mon, 17 Jun 2019 08:37:35 GMT

Authorization: signatureValue

<ServerSideEncryptionConfiguration>

      <Rule>

         <ApplyServerSideEncryptionByDefault>

             <SSEAlgorithm>AES256</SSEAlgorithm>

         </ApplyServerSideEncryptionByDefault>

      </Rule>

</ServerSideEncryptionConfiguration>

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Date: Mon, 17 Jun 2019 08:37:36 GMT

Server: tencent-cos

x-cos-request-id: NWQwNzUxNTBfMzdiMDJhMDlfOWM0Nl85NDFk****
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GET Bucket encryption
最近更新时间：2022-11-15 16:55:06

GET Bucket encryption 接口用于查询指定存储桶下的默认加密配置。

要执行此接口，必须拥有 GetBucketEncryption 权限。默认情况下，Bucket  的持有者直接拥有权限使用该 

API 接口，Bucket  持有者也可以将权限授予其他用户。

请求示例

请求参数

此接口无请求参数。

请求头

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

请求体

此接口无请求体。

响应头

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应体

以下是返回 SSE-COS 加密的响应体：

功能描述

请求

GET /?encryption HTTP 1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

响应

<ServerSideEncryptionConfiguration>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体元素如下：

错误码

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

请求

      <Rule>

            <ApplyServerSideEncryptionByDefault>

                <SSEAlgorithm>AES256|KMS</SSEAlgorithm>

                <KMSMasterKeyID>String</KMSMasterKeyID>

            </ApplyServerSideEncryptionByDefault>

      </Rule>

</ServerSideEncryptionConfiguration>

元素名称 父节点 描述 类型

ServerSid

eEncrypti

onConfig

uration

无 包含默认加密的配置参数
Conta

iner

Rule
ServerSideEncryption

Configuration
默认的服务端加密配置规则

Conta

iner

ApplySer

verSideE

ncryption

ByDefault

ServerSideEncryption

Configuration.Rule
服务端加密的默认配置信息

Conta

iner

SSEAlgori

thm

ServerSideEncryption

Configuration.Rule.

ApplyServerSideEncry

ptionByDefault

支持枚举值 AES256、KMS，AES256 代

表使用 SSE-COS 模式，加密算法为 

AES256；KMS 代表 SSE-KMS 模式

String

KMSMast

erKeyID

ServerSideEncryption

Configuration.Rule.

ApplyServerSideEncry

ptionByDefault

当 SSEAlgorithm 的值为 KMS 时，用于

指定 KMS 的用户主密钥 CMK，如不指

定，则使用 COS 默认创建的 CMK，更多

详细信息可参见 SSE-KMS 加密

String

实际案例

GET /?encryption HTTP 1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Mon, 17 Jun 2019 08:37:35 GMT

Authorization: signatureValue

https://cloud.tencent.com/document/product/436/7730
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: xxxx

Date: Mon, 17 Jun 2019 08:37:36 GMT

Server: tencent-cos

x-cos-request-id: NWQwNzUxNTBfMzdiMDJhMDlfOWM0Nl85NDFk****

<?xml version = "1.0" encoding = "UTF-8">

<ServerSideEncryptionConfiguration>

      <Rule>

            <ApplyServerSideEncryptionByDefault>

                <SSEAlgorithm>AES256</SSEAlgorithm>

            </ApplyServerSideEncryptionByDefault>

      </Rule>

</ServerSideEncryptionConfiguration>
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DELETE Bucket encryption
最近更新时间：2021-07-22 10:13:34

DELETE Bucket encryption 接口用于删除指定存储桶下的默认加密配置。

要执行此接口，必须拥有 DeleteBucketEncryption 权限。默认情况下，Bucket 的持有者直接拥有权限使用

该 API 接口，Bucket 持有者也可以将权限授予其他用户。

请求示例

请求参数

此接口无请求参数。

请求头

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

请求体

该请求的请求体为空。

响应头

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应体

该请求的响应体返回为空。

错误码

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

功能描述

请求

DELETE /?encryption HTTP 1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

响应

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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请求

以下示例表示从存储桶 examplebucket-1250000000 中删除默认 SSE-COS 加密配置。

响应

实际案例

DELETE /?encryption HTTP 1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Mon, 17 Jun 2019 08:37:35 GMT

Authorization: signatureValue

HTTP/1.1 204 No Content

Server: tencent-cos

Date: Mon, 17 Jun 2019 08:37:36 GMT

x-cos-request-id: NWQwNzUxNTBfMzdiMDJhMDlfOWM0Nl85NDFk****
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对象锁定（ObjectLock）

PUT Bucket

ObjectLockConfiguration
最近更新时间：2023-04-11 17:33:12

COS 支持为已存在的存储桶设置对象锁定。PUT Bucket ObjectLockConfiguration 接口用于为存储桶设置

对象锁定功能，以满足合规需求。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

请求

请求示例

PUT /?object-lock HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String 

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

<?xml version="1.0" encoding="UTF-8" ?>

<ObjectLockConfiguration>

       <ObjectLockEnabled>Enabled</ObjectLockEnabled> 

              <Rule> 

                    <DefaultRetention>

                         <Days>30</Days> 

                    </DefaultRetention> 

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体为空。

此接口遵循统一的错误响应和错误码，除了以下错误信息，其他错误码请参见 错误码  文档。

              </Rule> 

       </ObjectLockConfiguration> 

节点名称（关键

字）
父节点 描述 类型

是

否

必

选

ObjectLockC

onfiguration
无 对象锁定配置

Cont

ainer
是

ObjectLockE

nabled
ObjectLockConfiguration 是否开启对象锁定

Strin

g
是

Rule ObjectLockConfiguration 对象锁定规则

Cont

ainer

s

是

DefaultRetent

ion

ObjectLockConfiguration.R

ule
对象锁定默认周期

Cont

ainer

s

是

Days
ObjectLockConfiguration.R

ule.DefaultRetention

对象锁定默认周期时长

（范围为1-36500）
Int 是

注意

ObjectLockEnabled 参数仅支持配置为 Enabled，配置为 Enabled 即为该存储桶开启了对象锁

定功能。

开启对象锁定功能后不支持关闭，请您谨慎操作。

响应

响应头

响应体

错误码

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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以下示例表示对存储桶 examplebucket-1250000000 设置对象锁定，保留期限为1天。

HTTP 

状态码
错误码 描述

409 

Confli

ct

InvalidLock

edTime

当 Days 天数小于原有时间，会返回报错：存储桶对象锁定时间不能小于原

有时间，该值必须在 1 - 36500 天之间

实际案例

请求

PUT /?object-lock= HTTP/1.1

Host: exmaplebucket-1250000000.cos.ap-beijing.myqcloud.com

Content-Length: 281

Content-Type: application/x-www-form-urlencoded

Authorization: Auth String

<ObjectLockConfiguration>

    <ObjectLockEnabled>Enabled</ObjectLockEnabled>

    <Rule>

        <DefaultRetention>

            <Days>1</Days>

        </DefaultRetention>

    </Rule>

</ObjectLockConfiguration>

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Fri, 09 Dec 2022 08:17:20 GMT

Server: tencent-cos

x-cos-request-id: NjM5MmVmMTBfNmM0ZTQ0MGJfMjA4****
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PUT Object Retention
最近更新时间：2023-08-01 17:19:11

该接口用于为对象设置锁定模式和保留期限。

此接口仅使用公共请求头部，详情请参见 公共请求头部 文档。

具体数据描述如下：

功能描述

请求

请求示例

PUT /<object-key>?retention HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String 

说明：

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

<Retention>

    <Mode>COMPLIANCE</Mode>

    <RetainUntilDate>timestamp</RetainUntilDate>

</Retention> 

节点名称（关

键字）
父节点 描述 类型 是否必选

Retention 无 周期 Contai

ner

是

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口仅返回公共响应头部，详情请参见 公共响应头部 文档。

该请求的响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码 文档。

Mode
Retent

ion

对象锁定模式，仅支持枚举值 

COMPLIANCE
Enum 是

RetainUntil

Date

Retent

ion
具体到期日期

String  

Date
是

响应

响应头

响应体

错误码

实际案例

请求

PUT /temp.txt?retention HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Authorization: Auth String

<Retention>

    <Mode>COMPLIANCE</Mode>

    <RetainUntilDate>2022-12-10T08:34:48.000Z</RetainUntilDate>

</Retention>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 87

Connection: keep-alive

Date: Fri, 09 Dec 2022 08:35:49 GMT

Server: tencent-cos

x-cos-request-id: NjM5MmYzNjVfMjBkMDM4MGJfMWM2ND****

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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GET Bucket

ObjectLockConfiguration
最近更新时间：2023-07-26 14:33:42

GET Bucket ObjectLockConfiguration 接口用于获取存储桶的对象锁定配置。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

请求

请求示例

GET /?object-lock HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String 

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

响应体

<?xml version="1.0" encoding="UTF-8" ?>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体数据描述如下：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

<ObjectLockConfiguration>

      <ObjectLockEnabled>Enabled</ObjectLockEnabled> 

      <Rule> 

           <DefaultRetention>

                 <Mode>COMPLIANCE</Mode>

                 <Days>30</Days> 

           </DefaultRetention> 

      </Rule> 

</ObjectLockConfiguration> 

节点名称（关键

字）
父节点 描述 类型

ObjectLockC

onfiguration
无 对象锁定配置

Cont

ainer

ObjectLockE

nabled
ObjectLockConfiguration

是否开启对象锁定，仅支持传入 

Enabled 。对象锁定开启后不支持

关闭

Strin

g

Rule ObjectLockConfiguration

对象锁定规则，用于规定存储桶对象

锁定默认周期和模式，该规则支持删

除、修改，也可能为空

Cont

ainer

DefaultRetent

ion

ObjectLockConfiguration.R

ule

存储桶对象锁定默认周期和模式，未

携带锁定头部的对象遵循桶配置设置

保留期限

Cont

ainer

Days
ObjectLockConfiguration.R

ule.DefaultRetention

对象锁定默认周期时长（范围为1-

36500）
Int

Mode
ObjectLockConfiguration.R

ule.DefaultRetention

对象锁定默认模式，仅支持枚举值

COMPLIANCE

Enu

m

错误码

实际案例

案例一：获取未配置默认锁定模式和保留周期的对象锁定配置信息

请求

https://cloud.tencent.com/document/product/436/7730
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GET /?object-lock HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Authorization: Auth String

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 180

Connection: keep-alive

Date: Fri, 09 Dec 2022 08:31:25 GMT

Server: tencent-cos

x-cos-request-id: NjM5MmYyNWNfMzBkMDM4MGJfMmUzNzFfM****

<ObjectLockConfiguration>

    <ObjectLockEnabled>Enabled</ObjectLockEnabled>

</ObjectLockConfiguration> 

案例二：获取已配置默认锁定模式和保留周期的对象锁定配置信息

请求

GET /?object-lock HTTP/1.1

Host: examplebucket2-1250000000.cos.ap-beijing.myqcloud.com

Authorization: Auth String

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 180

Connection: keep-alive

Date: Fri, 09 Dec 2022 08:31:25 GMT

Server: tencent-cos

x-cos-request-id: NjM5MmYyNWNfMzBkMDM4MGJfMmUzNzFfM****

<ObjectLockConfiguration>

    <ObjectLockEnabled>Enabled</ObjectLockEnabled>

    <Rule>

        <DefaultRetention>

            <Mode>COMPLIANCE</Mode>

            <Days>30</Days>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第284 共1701页

        </DefaultRetention>

    </Rule>

</ObjectLockConfiguration> 
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GET Object retention
最近更新时间：2023-07-26 14:33:42

该接口用于获取对象锁定模式和保留期限。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

请求

请求示例

GET /<object-key>?retention HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String 

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

响应体

<Retention>

         <Mode>COMPLIANCE</Mode>

         <RetainUntilDate>timestamp</RetainUntilDate> 

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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具体数据描述如下：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

</Retention>

节点名称（关键

字）
父节点 描述 类型

Retention 无 周期
Contain

er

Mode
Retentio

n
 对象锁定模式，仅支持枚举值 COMPLIANCE  Enum

RetainUntilDa

te

Retentio

n
具体到期日期

String  

Date

错误码

实际案例

请求

GET /temp.txt?retention HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Authorization: Auth String

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 87

Connection: keep-alive

Date: Fri, 09 Dec 2022 08:35:49 GMT

Server: tencent-cos

x-cos-request-id: NjM5MmYzNjVfMjBkMDM4MGJfMWM2ND****

<Retention>

    <Mode>COMPLIANCE</Mode>

    <RetainUntilDate>2022-12-10T08:34:48.000Z</RetainUntilDate>

</Retention>

https://cloud.tencent.com/document/product/436/7730


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第287 共1701页

回源（Origin）

PUT Bucket Origin
最近更新时间：2022-12-12 11:04:23

PUT Bucket Origin 接口用于设置存储桶的回源。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

请求的请求体为回源规则。

功能描述

请求

请求示例

PUT /?origin HTTP 1.1

Host:<BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

该请求需结合请求体一起使用。

请求参数

请求头

请求体

<OriginConfiguration>

    <OriginRule>

        <RulePriority>Integer</RulePriority>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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        <OriginType>Redirect|Proxy|Mirror</OriginType>

        <OriginCondition>

            <!--回源设置的 HTTP 状态码设置根据回源类型决定，如果是 Proxy、Mirror 是404，如果是

            <HTTPStatusCode>404</HTTPStatusCode>

            <Prefix></Prefix>

        </OriginCondition>

        <OriginParameter>

            <Protocol>HTTP|HTTPS|FOLLOW</Protocol>

            <!--回源是否保留源站的错误码-->

            <TransparentErrorCode>true|false</TransparentErrorCode>

            <!--回源是否保留原始查询参数，支持保留、不保留两种-->

            <FollowQueryString>true|false</FollowQueryString>

            <!--回源的请求头部参数-->

            <HttpHeader>

                <!--回源是否传输全部的请求头部，支持传递、不传递两种-->

                <FollowAllHeaders>true|false</FollowAllHeaders>

                <!--回源新增指定头部，最多10个，自定义头部中一对键值算一个-->

                <!--如果有值则新增头部，如果为空则不新增-->

                <NewHttpHeaders>

                    <Header>

                        <Key>x-cos|oss|amz-ContentType|CacheControl|ContentDisposition|Conte

                        <Value>string</Value>

                    </Header>

                </NewHttpHeaders>

                <!--回源透传原始请求的指定头部-->

                <FollowHttpHeaders>

                    <Header>

                        <Key>x-cos|oss|amz-ContentType|CacheControl|ContentDisposition|Conte

                    </Header>

                </FollowHttpHeaders>

                <!--回源不透传原始请求的指定头部-->

                <ForbidFollowHeaders>

                    <Header>

                        <Key>String</Key>

                    </Header>

                </ForbidFollowHeaders>

            </HttpHeader>

            <!--follow3xx 参数-->

            <FollowRedirection>true|false</FollowRedirection>

            <!--重定向返回码参数只有在回源类型为 Redirect、Proxy 时可选，否则报参数错误-->

            <HttpRedirectCode>301|302|307</HttpRedirectCode>

        </OriginParameter>

    <!--切备错误码，默认5XX 切换备站，添加此选项后支持4XX 切换备站  -->

        <HTTPStandbyCode>                        

            <StatusCode>404</StatusCode>
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具体的数据内容如下：

Container 节点 OriginConfiguration 的内容：

            <StatusCode>403</StatusCode>

        </HTTPStandbyCode>

        <OriginInfo>

            <!--Mirror 模式支持设置多个源站，按比例回源，分担单个源站的回源流量，最多支持填入1

            <HostInfo>

                <HostName>bucketname-appid.cos.region.myqcloud.com</HostName>

                <!--源站权重，按比例回源-->

        <Weight>4</Weight> 

                <!--备份回源地址，最多支持填入10条备份回源地址，节点命名依次按照1-10编号-->

                <StandbyHostName_1>bucketname2-appid.cos.region.myqcloud.com</Standb

                <StandbyHostName_2>bucketname3-appid.cos.region.myqcloud.com</Standb

            </HostInfo>

            <HostInfo>

                <HostName>bucketname4-appid.cos.region.myqcloud.com</HostName>

                <!--源站权重，按比例回源-->

                <Weight>2</Weight> 

                <!--备份回源地址，最多支持填入10条备份回源地址，节点命名依次按照1-10编号-->

                <StandbyHostName_1>bucketname5-appid.cos.region.myqcloud.com</Standb

                <StandbyHostName_2>bucketname6-appid.cos.region.myqcloud.com</Standb

            </HostInfo>

            <FileInfo>

                <!--回源为指定的文件-->

                <FixedFileConfiguration>

                    <FixedFilePath>String</FixedFilePath>

                </FixedFileConfiguration>

                <!--回源文件的新增文件前缀-->

                <PrefixConfiguration>

                    <Prefix></Prefix>

                </PrefixConfiguration>

                <!--回源文件的新增文件后缀-->

                <SuffixConfiguration>

                    <Suffix></Suffix>

                </SuffixConfiguration>

            </FileInfo>

        </OriginInfo>

    </OriginRule>

</OriginConfiguration>

节点名称（关键字） 父节点 描述 类型 是否必选

OriginConfiguration 无 Origin 回源配置 Container 是
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Container 节点 OriginRule 的内容：

节点名称（关

键字）
父节点 描述 类型

是否

必选

OriginRule
OriginConfigu

ration

支持多条 OriginRule，通过优先级区分

规则执行先后

Contai

ner
是

节点

名称

（关

键

字）

父节点 描述
类

型

是

否

必

选

Rule

Prior

ity

OriginConfi

guration.Or

iginRule

通过优先级区分规则执行先后

In

te

g

er

是

Origi

nTyp

e

OriginConfi

guration.Or

iginRule

回源类型，支持异步回源（Proxy）、同步回源（Mirror）和

重定向回源（Redirect）三种模式。 枚举值： Proxy 、

Mirror 、 Redirect

C

o

nt

ai

n

er

是

Origi

nCo

nditi

on

OriginConfi

guration.Or

iginRule

回源配置，配置用户使用的 HTTP 传输协议等信息

C

o

nt

ai

n

er

是

Origi

nPar

amet

er

OriginConfi

guration.Or

iginRule

回源地址相关信息

C

o

nt

ai

n

er

是

Origi

nInfo

OriginConfi

guration.Or

iginRule

源站信息。例如源站域名或者源站 IP 等信息

C

o

nt

ai

n

er

是
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Container 节点 OriginCondition 的内容：

Container 节点 OriginParameter 的内容：

节点名称

（关键

字）

父节点 描述
类

型

是

否

必

选

HTTPS

tatusC

ode

OriginConfigur

ation.OriginRul

e.

OriginConditio

n

触发回源的 HTTP 状态码，Proxy 和 Mirror 模式支

持填写404，Redirect 模式支持填写4XX 和5XX

S

tr

in

g

是

Prefix

OriginConfigur

ation.OriginRul

e.

OriginConditio

n

触发回源的文件前缀，默认为空，任意文件均可触发

S

tr

in

g

否

节

点

名

称

（

关

键

字

）

父节点 描述
类

型

是

否

必

选

Pro

toc

ol

OriginConfig

uration.Origi

nRule.

OriginParam

eter

回源使用的协议，枚举值为 HTTP（使用 HTTP 协议），

HTTPS（使用 HTTPS 协议）、FOLLOW（跟随用户使用

的协议），默认值为 FOLLOW。

S

tr

in

g

是

Fol

low

Qu

ery

Stri

ng

OriginConfig

uration.Origi

nRule.Origin

Parameter

回源是否需要透传 HTTP 请求串，枚举值： true  或 false

，默认为 true

B

o

ol

e

a

n

否

Htt

pH

OriginConfig

uration.Origi

是否需要设置 Http 头部传输配置。 C

o

否
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Container 节点 HttpHeader 的内容：

ea

der

nRule.Origin

Parameter

n

t

ai

n

e

r

Fol

low

Re

dir

ect

ion

OriginConfig

uration.Origi

nRule.Origin

Parameter

源站 3XX  响应策略，枚举值 true  或 false ，选择 true 

时跟随源站 3xx  重定向请求获取到资源，并将资源保存到 

COS 上;选择 false  时透传 3XX  响应，不获取资源），默

认为 true 。

B

o

ol

e

a

n

否

Htt

pR

edi

rec

tCo

de

OriginConfig

uration.Origi

nRule.Origin

Parameter

仅支持 Redirect  和 Proxy  模式，设置重定向返回码参数，

枚举值 301  或 302  或 307 ，默认为 302  。

S

tr

in

g

否

节点名称

（关键

字）

父节点 描述
类

型

是

否

必

选

FollowAll

Headers

OriginConfiguration.OriginRu

le.OriginParameter.HttpHead

er

是否传输全部的请求头部，枚举

值： true  或 false ，默认为 

false 。

Bo

ol

ea

n

否

NewHttp

Headers

OriginConfiguration.OriginRu

le.OriginParameter.HttpHead

er

设置回源新增指定头部，最多10

个。

Co

nt

ain

er

否

FollowHt

tpHeade

rs

OriginConfiguration.OriginRu

le.OriginParameter.HttpHead

er

设置回源透传原始请求的指定头

部。

Co

nt

ain

er

否

ForbidFo

llowHea

ders

OriginConfiguration.OriginRu

le.OriginParameter.HttpHead

er

设置回源不透传的原始请求的指定

头部。

Co

nt

否
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Container 节点 NewHttpHeaders、FollowHttpHeaders、ForbidFollowHeaders 的内容：

Container 节点 Header 的内容：

ain

er

节点名称

（关键

字）

父节点 描述 类型

是

否

必

选

Header

OriginConfiguration.OriginR

ule.OriginParameter.

HttpHeader.NewHttpHeade

r

回源到源站时添加或者指定传递的

自定义头部，默认为空。

Con

tain

er

否

节

点

名

称

（

关

键

字

）

父节点 描述
类

型

是

否

必

选

K

e

y

OriginConfi

guration.Or

iginRule.Ori

ginParamet

er.

HttpHeader

.NewHttpH

eader.User

MetaData

用户设置的头部名称，默认为空。形式如 x-A-B ，A 支持填入 

cos  或 oss  或 amz ，B 支持填入 ContentType  或 

CacheControl  或 ContentDisposition  或 

ContentEncoding  或 HttpExpiresDate  或 

UserMetaData

S

tr

in

g

否

V

al

u

e

OriginConfi

guration.Or

iginRule.Ori

ginParamet

er.

HttpHeader

.NewHttpH

eader.User

MetaData

用户设置的头部值，默认为空。 S

tr

in

g

否
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Container 节点 OriginInfo 的内容：

Container 节点 HostInfo 的内容：

节

点

名

称

（

关

键

字

）

父节点 描述
类

型

是

否

必

选

Ho

stI

nfo

OriginConfig

uration.Origi

nRule.Origin

Info

源站信息。Mirror 模式支持设置多个源站，按比例回源，分担

单个源站的回源流量，最多支持填入10条回源地址，比例按权

重分配；Proxy 和 Redirect 模式仅支持一个源站。

C

o

n

t

ai

n

e

r

是

Fil

eIn

fo

OriginConfig

uration.Origi

nRule.Origin

Info

回源文件信息。

C

o

n

t

ai

n

e

r

是

节点名

称（关

键字）

父节点 描述
类

型

是

否

必

选

Host

Name

OriginCo

nfiguratio

n.OriginR

ule.

OriginInfo

.HostInfo

源站域名或者源站 IP。

S

tr

in

g

是

Weig OriginCo 源站权重，Mirror 模式下配置了多个源站时，会根据权重按比 I 否
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Container 节点 FileInfo 的内容：

Container 节点 FixedFileConfiguration 的内容：

Container 节点 PrefixConfiguration 的内容：

ht nfiguratio

n.OriginR

ule.

OriginInfo

.HostInfo

例回源。 n

t

e

g

e

r

Stand

byHo

stNa

me_N

OriginCo

nfiguratio

n.

OriginRul

e.OriginIn

fo.HostInf

o

备份回源地址，最多支持填入10条备份回源地址，节点命名依次

按照1-10编号，例如 StandbyHostName_1 、

StandbyHostName_2 ...... StandbyHostName_10

S

tr

in

g

是

节点名称（关键

字）
父节点 描述 类型

是否

必选

PrefixConfigur

ation

OriginConfiguration.OriginRule.Ori

ginInfo.FileInfo

回源文件的前

缀设置。

Conta

iner
否

SuffixConfigur

ation

OriginConfiguration.OriginRule.Ori

ginInfo.FileInfo

回源文件的后

缀设置。

Conta

iner
否

FixedFileConfi

guration

OriginConfiguration.OriginRule.Ori

ginInfo.FileInfo

回源到固定的

文件。

Conta

iner
否

节点名称（关键

字）
父节点 描述 类型

是否必

选

FixedFilePat

h

OriginConfiguration.OriginRule.Or

iginInfo.

FileInfo.FixedFileConfiguration

回源的固定文件路

径。

Stri

ng
否

节点名称（关

键字）
父节点 描述

类

型

是否

必选

Prefix

OriginConfiguration.OriginRul

e.OriginInfo.

FileInfo. PrefixConfiguration

回源文件的新增文件前缀，

默认为空。

Str

ing
否
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Container 节点 SuffixConfiguration 的内容：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

普通 Mirror 模式

节点名称（关

键字）
父节点 描述

类

型

是否

必选

Suffix

OriginConfiguration.OriginRul

e.OriginInfo.

FileInfo. SuffixConfiguration

回源文件的新增文件后缀，

默认为空。

Str

ing
否

响应

响应头

响应体

错误码

实际案例

案例1 案例2 案例3 案例4

请求

PUT /?origin= HTTP/1.1

Host: examplebucket-1250000000.cos.ap-shanghai.myqcloud.com

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTS

Content-Length: 347

Date: Sun, 28 Apr 2019 12:02:24 GMT

<?xml version="1.0" encoding="UTF-8"?>

<OriginConfiguration>

  <OriginRule>

    <RulePriority>1</RulePriority>

    <OriginType>Mirror</OriginType>

    <OriginCondition>

      <HTTPStatusCode>404</HTTPStatusCode>

      <Prefix></Prefix>

    </OriginCondition>

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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    <OriginParameter>

      <Protocol>HTTP</Protocol>

      <FollowQueryString>true</FollowQueryString>

      <HttpHeader>

        <FollowAllHeaders>false</FollowAllHeaders>

        <NewHttpHeaders>

          <Header>

            <Key>x-cos</Key>

            <Value>exampleHeader</Value>

          </Header>

        </NewHttpHeaders>

        <FollowHttpHeaders>

          <Header>

            <Key>exampleHeaderKey</Key>

          </Header>

        </FollowHttpHeaders>

      </HttpHeader>

      <FollowRedirection>true</FollowRedirection>

      <HttpRedirectCode>302</HttpRedirectCode>

    </OriginParameter>

    <OriginInfo>

      <HostInfo>

        <HostName>examplebucket-1250000000.cos.ap-shanghai.myqcloud.com</Ho

      </HostInfo>

    </OriginInfo>

  </OriginRule>

</OriginConfiguration>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Date: Sun, 28 Apr 2019 12:02:45 GMT

Server: tencent-cos

x-cos-request-id: NWNjNTk2NTFfMmM4OGY3MGFfNadfadsfY2****
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GET Bucket Origin
最近更新时间：2022-12-12 11:05:02

GET Bucket Origin 接口用于查询存储桶的回源配置。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

请求

请求示例

GET /?origin HTTP 1.1

Host:<BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

该请求需结合请求体一起使用。

请求参数

请求头

请求体

响应

响应头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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响应体为回源规则，结构如下。

响应体

<OriginConfiguration>

    <OriginRule>

        <RulePriority>Integer</RulePriority>

        <OriginType>Redirect|Proxy|Mirror</OriginType>

        <OriginCondition>

            <!--回源设置的 HTTP 状态码设置根据回源类型决定，如果是 Proxy、Mirror 是404，如果是

            <HTTPStatusCode>404</HTTPStatusCode>

            <Prefix></Prefix>

        </OriginCondition>

        <OriginParameter>

            <Protocol>HTTP|HTTPS|FOLLOW</Protocol>

            <!--回源是否保留源站的错误码-->

            <TransparentErrorCode>true|false</TransparentErrorCode>

            <!--回源是否保留原始查询参数，支持保留、不保留两种-->

            <FollowQueryString>true|false</FollowQueryString>

            <!--回源的请求头部参数-->

            <HttpHeader>

                <!--回源是否传输全部的请求头部，支持传递、不传递两种-->

                <FollowAllHeaders>true|false</FollowAllHeaders>

                <!--回源新增指定头部，最多10个，自定义头部中一对键值算一个-->

                <!--如果有值则新增头部，如果为空则不新增-->

                <NewHttpHeaders>

                    <Header>

                        <Key>x-cos|oss|amz-ContentType|CacheControl|ContentDisposition|Conte

                        <Value>string</Value>

                    </Header>

                </NewHttpHeaders>

                <!--回源透传原始请求的指定头部-->

                <FollowHttpHeaders>

                    <Header>

                        <Key>x-cos|oss|amz-ContentType|CacheControl|ContentDisposition|Conte

                    </Header>

                </FollowHttpHeaders>

                <!--回源不透传原始请求的指定头部-->

                <ForbidFollowHeaders>

                    <Header>

                        <Key>String</Key>

                    </Header>

                </ForbidFollowHeaders>

            </HttpHeader>

            <!--follow3xx 参数-->
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            <FollowRedirection>true|false</FollowRedirection>

            <!--重定向返回码参数只有在回源类型为 Redirect、Proxy 时可选，否则报参数错误-->

            <HttpRedirectCode>301|302|307</HttpRedirectCode>

        </OriginParameter>

    <!--切备错误码，默认5XX 切换备站，添加此选项后支持4XX 切换备站  -->

        <HTTPStandbyCode>                        

            <StatusCode>404</StatusCode>

            <StatusCode>403</StatusCode>

        </HTTPStandbyCode>

        <OriginInfo>

            <!--Mirror 模式支持设置多个源站，按比例回源，分担单个源站的回源流量，最多支持填入1

            <HostInfo>

                <HostName>bucketname-appid.cos.region.myqcloud.com</HostName>

                <!--源站权重，按比例回源-->

        <Weight>4</Weight> 

                <!--备份回源地址，最多支持填入10条备份回源地址，节点命名依次按照1-10编号-->

                <StandbyHostName_1>bucketname2-appid.cos.region.myqcloud.com</Standb

                <StandbyHostName_2>bucketname3-appid.cos.region.myqcloud.com</Standb

            </HostInfo>

            <HostInfo>

                <HostName>bucketname4-appid.cos.region.myqcloud.com</HostName>

                <!--源站权重，按比例回源-->

                <Weight>2</Weight> 

                <!--备份回源地址，最多支持填入10条备份回源地址，节点命名依次按照1-10编号-->

                <StandbyHostName_1>bucketname5-appid.cos.region.myqcloud.com</Standb

                <StandbyHostName_2>bucketname6-appid.cos.region.myqcloud.com</Standb

            </HostInfo>

            <FileInfo>

                <!--回源为指定的文件-->

                <FixedFileConfiguration>

                    <FixedFilePath>String</FixedFilePath>

                </FixedFileConfiguration>

                <!--回源文件的新增文件前缀-->

                <PrefixConfiguration>

                    <Prefix></Prefix>

                </PrefixConfiguration>

                <!--回源文件的新增文件后缀-->

                <SuffixConfiguration>

                    <Suffix></Suffix>

                </SuffixConfiguration>

            </FileInfo>

        </OriginInfo>

    </OriginRule>

</OriginConfiguration>
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具体的数据内容如下：

Container 节点 OriginConfiguration 的内容：

Container 节点 OriginRule 的内容：

节点名称（关键字） 父节点 描述 类型

OriginConfiguration 无 Origin 回源配置 Container

节点名称（关键

字）
父节点 描述 类型

OriginRule
OriginConfigura

tion

支持多条 OriginRule，通过优先级区分规则

执行先后

Contain

er

节点名

称（关

键字）

父节点 描述
类

型

Rule

Priori

ty

OriginConfig

uration.Origi

nRule

通过优先级区分规则执行先后

Int

eg

er

Origi

nTyp

e

OriginConfig

uration.Origi

nRule

回源类型，支持异步回源（Proxy）、同步回源（Mirror）和重定

向回源（Redirect）三种模式。 枚举值： Proxy 、 Mirror 、

Redirect

St

rin

g

Origi

nCon

dition

OriginConfig

uration.Origi

nRule

回源配置，配置用户使用的 HTTP 传输协议等信息

C

on

tai

ne

r

Origi

nPar

amet

er

OriginConfig

uration.Origi

nRule

回源地址相关信息

C

on

tai

ne

r

Origi

nInfo

OriginConfig

uration.Origi

nRule

源站信息。例如源站域名或者源站 IP 等信息

C

on

tai

ne

r
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Container 节点 OriginCondition 的内容：

Container 节点 OriginParameter 的内容：

节点名称

（关键

字）

父节点 描述
类

型

HTTPSt

atusCod

e

OriginConfigurat

ion.OriginRule.

OriginCondition

触发回源的 HTTP 状态码，Proxy 和 Mirror 模式支持填

写404，Redirect 模式支持填写4XX 和5XX

S

tr

in

g

Prefix

OriginConfigurat

ion.OriginRule.

OriginCondition

触发回源的文件前缀，默认为空，任意文件均可触发

S

tr

in

g

节点

名称

（关

键

字）

父节点 描述
类

型

Pro

toc

ol

OriginConfigur

ation.OriginRu

le.

OriginParamet

er

回源使用的协议，枚举值为 HTTP（使用 HTTP 协议），HTTPS

（使用 HTTPS 协议）、FOLLOW（跟随用户使用的协议），默

认值为 FOLLOW。

S

tr

in

g

Foll

ow

Qu

ery

Stri

ng

OriginConfigur

ation.OriginRu

le.OriginPara

meter

回源是否需要透传 HTTP 请求串，枚举值： true  或 false ，默认

为 true

B

o

ol

e

a

n

Htt

pH

ead

er

OriginConfigur

ation.OriginRu

le.OriginPara

meter

是否需要设置 Http 头部传输配置。

C

o

n

t

ai

n

e

r
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Container 节点 HttpHeader 的内容：

Container 节点 NewHttpHeaders、FollowHttpHeaders、ForbidFollowHeaders 的内容：

Foll

ow

Re

dire

ctio

n

OriginConfigur

ation.OriginRu

le.OriginPara

meter

源站 3XX  响应策略，枚举值 true  或 false ，选择 true 时跟随

源站 3xx  重定向请求获取到资源，并将资源保存到 COS 上;选择 

false  时透传 3XX  响应，不获取资源），默认为 true 。

B

o

ol

e

a

n

Htt

pR

edir

ect

Co

de

OriginConfigur

ation.OriginRu

le.OriginPara

meter

仅支持 Redirect  和 Proxy  模式，设置重定向返回码参数，枚举

值 301  或 302  或 307 ，默认为 302  。

S

tr

in

g

节点名称

（关键字）
父节点 描述 类型

FollowAll

Headers

OriginConfiguration.OriginRule.

OriginParameter.HttpHeader

是否传输全部的请求头部，枚举值：

true  或 false ，默认为 false 。

Bo

ole

an

NewHttp

Headers

OriginConfiguration.OriginRule.

OriginParameter.HttpHeader
设置回源新增指定头部，最多10个。

Co

nta

ine

r

FollowHtt

pHeaders

OriginConfiguration.OriginRule.

OriginParameter.HttpHeader
设置回源透传原始请求的指定头部。

Co

nta

ine

r

ForbidFol

lowHead

ers

OriginConfiguration.OriginRule.

OriginParameter.HttpHeader

设置回源不透传的原始请求的指定头

部。

Co

nta

ine

r

节点名称

（关键字）
父节点 描述 类型

Header

OriginConfiguration.OriginRule

.OriginParameter.

HttpHeader.NewHttpHeaders

回源到源站时添加或者指定传递的自

定义头部，默认为空。

Cont

ainer
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Container 节点 Header 的内容：

Container 节点 OriginInfo 的内容：

节

点

名

称

（

关

键

字

）

父节点 描述
类

型

K

e

y

OriginConfig

uration.Origi

nRule.Origin

Parameter.

HttpHeader.

NewHttpHe

ader.UserM

etaData

用户设置的头部名称，默认为空。形式如 x-A-B ，A 支持填入 cos  或 

oss  或 amz ，B 支持填入 ContentType  或 CacheControl  或 

ContentDisposition  或 ContentEncoding  或 HttpExpiresDate  

或 UserMetaData

S

tr

in

g

V

al

u

e

OriginConfig

uration.Origi

nRule.Origin

Parameter.

HttpHeader.

NewHttpHe

ader.UserM

etaData

用户设置的头部值，默认为空。

S

tr

in

g

节点

名称

（关

键

字）

父节点 描述
类

型

Ho

stIn

fo

OriginConfigu

ration.OriginR

ule.OriginInfo

源站信息。Mirror 模式支持设置多个源站，按比例回源，分担单个源

站的回源流量，最多支持填入10条回源地址，比例按权重分配；

Proxy 和 Redirect 模式仅支持一个源站。

C

o

n

t

ai

n

e

r
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Container 节点 HostInfo 的内容：

Container 节点 FileInfo 的内容：

File

Info

OriginConfigu

ration.OriginR

ule.OriginInfo

回源文件信息。

C

o

n

t

ai

n

e

r

节点名

称（关

键字）

父节点 描述
类

型

Host

Nam

e

OriginConfigurat

ion.OriginRule.

OriginInfo.HostI

nfo

源站域名或者源站 IP。

S

tr

in

g

Weig

ht

OriginConfigurat

ion.OriginRule.O

riginInfo.HostInf

o

源站权重，Mirror 模式下配置了多个源站时，会根据权重按比

例回源。

I

n

t

e

g

e

r

Stand

byHo

stNa

me_

N

OriginConfigurat

ion.OriginRule.O

riginInfo.HostInf

o

备份回源地址，最多支持填入10条备份回源地址，节点命名依

次按照1-10编号，例如 StandbyHostName_1 、

StandbyHostName_2 ...... StandbyHostName_10

S

tr

in

g

节点名称（关键字） 父节点 描述 类型

PrefixConfigurati

on

OriginConfiguration.OriginRule.OriginI

nfo.FileInfo

回源文件的前缀

设置。

Contai

ner

SuffixConfigurati

on

OriginConfiguration.OriginRule.OriginI

nfo.FileInfo

回源文件的后缀

设置。

Contai

ner

FixedFileConfigu

ration

OriginConfiguration.OriginRule.OriginI

nfo.FileInfo

回源到固定的文

件。

Contai

ner
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Container 节点 FixedFileConfiguration 的内容：

Container 节点 PrefixConfiguration 的内容：

Container 节点 SuffixConfiguration 的内容：

节点名称（关键

字）
父节点 描述 类型

FixedFilePath

OriginConfiguration.OriginRule.OriginI

nfo.

FileInfo.FixedFileConfiguration

回源的固定文件路

径。

Strin

g

节点名称（关键

字）
父节点 描述 类型

Prefix

OriginConfiguration.OriginRule.Or

iginInfo.

FileInfo. PrefixConfiguration

回源文件的新增文件前缀，默

认为空。

Stri

ng

节点名称（关键

字）
父节点 描述 类型

Suffix

OriginConfiguration.OriginRule.Or

iginInfo.

FileInfo. SuffixConfiguration

回源文件的新增文件后缀，默

认为空。

Stri

ng

实际案例

请求

GET /?origin= HTTP/1.1

Host: examplebucket-1250000000.cos.ap-shanghai.myqcloud.com

Authorization: Auth String

Date: Sun, 28 Apr 2019 12:02:24 GMT

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Date: Sun, 28 Apr 2019 12:02:25 GMT

Server: tencent-cos
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x-cos-request-id: NWNjNTk2NTFfMmM4OGY3MGFfNTI1****

<?xml version="1.0" encoding="UTF-8"?>

<OriginConfiguration>

    <OriginRule>

        <OriginType>Proxy</OriginType>

        <OriginCondition>

            <HTTPStatusCode>404</HTTPStatusCode>

            <Prefix></Prefix>

        </OriginCondition>

        <OriginParameter>

            <Protocol>FOLLOW</Protocol>

            <FollowQueryString>true</FollowQueryString>

            <HttpHeader>

                <FollowAllHeaders>true</FollowAllHeaders>

                <NewHttpHeaders>

                    <Header>

                        <Key>x-cos-ContentType</Key>

                        <Value>csv</Value>

                    </Header>

                </NewHttpHeaders>

                <FollowHttpHeaders>

                    <Header>

                        <Key>Content-Type</Key>

                    </Header>

                </FollowHttpHeaders>

            </HttpHeader>

            <FollowRedirection>true</FollowRedirection>

        </OriginParameter>

        <OriginInfo>

            <HostInfo>

                <HostName>examplebucket-1250000000.cos.ap-shanghai.myqcloud.com</Ho

            </HostInfo>

        </OriginInfo>

    </OriginRule>

</OriginConfiguration>
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DELETE Bucket Origin
最近更新时间：2022-11-15 16:59:55

DELETE Bucket Origin 接口用于删除存储桶的回源配置。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

请求

请求示例

DELETE /?origin HTTP 1.1

Host:<BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

该请求需结合请求体一起使用。

请求参数

请求头

请求体

响应

响应头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口响应体为空。

响应体

实际案例

请求

DELETE /?origin= HTTP/1.1

Host: examplebucket-1250000000.cos.ap-shanghai.myqcloud.com

Authorization: Auth String

Date: Sun, 28 Apr 2019 12:02:24 GMT

响应

HTTP/1.1 204 No Content 

Server: tencent-cos

Date: Mon, 28 Aug 2018 02:53:40 GMT

x-cos-request-id: NWNjNTk2NTFfMmM4OGY3MGFfNTI1****
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Object 接口

基本操作

PUT Object
最近更新时间：2023-07-26 14:33:42

PUT Object 接口请求可以将本地的对象（Object）上传至指定存储桶中。该 API 的请求者需要对存储桶有写入

权限。

功能描述

说明

PUT Object 接口最大支持上传5GB文件。如需上传大于5GB的文件，请使用 分块上传  的 API 接

口。

如果请求头的 Content-Length 值小于实际请求体（body）中传输的数据长度，COS 仍将成功创

建文件，但对象大小只等于 Content-Length 中定义的大小，其他数据将被丢弃。

如果试图添加已存在的同名对象且没有启用版本控制，则新上传的对象将覆盖原来的对象，成功时返回

200 OK。

对象存储中本身没有文件夹和目录的概念，如需将对象上传到指定的文件夹或路径，可通过 / 实现，例

如将 picture.png 上传到 doc 文件夹，则对象键设置为 doc/picture.png；如需创建文件夹 doc，

则对象键设置为 doc/。更多说明请参见 文件夹和目录 。

版本控制

如果对存储桶启用版本控制，对象存储将自动为要添加的对象生成唯一的版本 ID。对象存储使用 x-cos-

version-id 响应头部在响应中返回此标识。

如果暂停存储桶的版本控制，则对象存储始终将 null 用作存储在存储桶中的对象的版本 ID，且不返回 x-cos-

version-id 响应头部。

请求

请求示例

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-Type: Content Type

Content-Length: Content Length

Content-MD5: MD5

https://cloud.tencent.com/document/product/436/14112
https://cloud.tencent.com/document/product/436/13324#.E6.96.87.E4.BB.B6.E5.A4.B9.E5.92.8C.E7.9B.AE.E5.BD.95
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此接口无请求参数。

此接口除使用公共请求头部外，还支持以下请求头部，了解公共请求头部详情请参见 公共请求头部  文档。

Authorization: Auth String

[Object Content]

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

名称 描述
类

型

是否

必选

Cache-

Control
RFC 2616 中定义的缓存指令，将作为对象元数据保存

str

ing
否

Content-

Dispositio

n

RFC 2616 中定义的文件名称，将作为对象元数据保存
str

ing
否

Content-

Encoding
RFC 2616 中定义的编码格式，将作为对象元数据保存

str

ing
否

Content-

Type

RFC 2616 中定义的 HTTP 请求内容类型（MIME），此头部用于描

述待上传对象的内容类型，将作为对象元数据保存。

例如 text/html 或 image/jpeg

str

ing
是

Expires RFC 2616 中定义的缓存失效时间，将作为对象元数据保存
str

ing
否

Transfer-

Encoding

如果希望在上传时分块传输，则指定 Transfer-Encoding: 

chunked 请求头部，此时请求体遵循 RFC 2616 中定义的传输编码

格式，且不能指定 Content-Length 请求头部

str

ing
否

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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访问控制列表（ACL）相关头部

在上传对象时可以通过指定下列请求头部来设置对象的访问权限：

x-cos-

meta-*

包括用户自定义元数据头部后缀和用户自定义元数据信息，将作为对象

元数据保存，大小限制为2KB

注意：用户自定义元数据信息支持下划线（_），但用户自定义元数据

头部后缀不支持下划线，仅支持减号（-）

str

ing

否

x-cos-

storage-

class

对象存储类型。枚举值请参见 存储类型概述  文档，例如 

MAZ_STANDARD，MAZ_STANDARD_IA，

INTELLIGENT_TIERING，MAZ_INTELLIGENT_TIERING，

STANDARD_IA，ARCHIVE，DEEP_ARCHIVE。默认值：

STANDARD

en

um
否

x-cos-

traffic-

limit

针对本次上传进行流量控制的限速值，必须为数字，单位默认为 bit/s。

限速值设置范围为819200 - 838860800，即800Kb/s - 

800Mb/s，如果超出该范围将返回400错误

int

eg

er

否

x-cos-

tagging

对象的标签集合，最多可设置10个标签（例如，

Key1=Value1&Key2=Value2）。 标签集合中的 Key 和 Value 

必须先进行 URL 编码。

str

ing
否

名称 描述
类

型

是否

必选

x-cos-acl

定义对象的访问控制列表（ACL）属性。枚举值请参见 ACL 概述  文

档中对象的预设 ACL 部分，例如 default，private，public-

read 等，默认为 default

注意：如果您不需要进行对象 ACL 控制，请设置为 default 或者此

项不进行设置，默认继承存储桶权限

e

n

u

m

否

x-cos-

grant-read

赋予被授权者读取对象的权限，格式为 id="[OwnerUin]"，例如 

id="100000000001"，可使用半角逗号（,）分隔多组被授权者，例

如 id="100000000001",id="100000000002"

st

ri

n

g

否

x-cos-

grant-read-

acp

赋予被授权者读取对象的访问控制列表（ACL）的权限，格式为 id="

[OwnerUin]"，例如 id="100000000001"，可使用半角逗号（,）

分隔多组被授权者，例如

id="100000000001",id="100000000002"

st

ri

n

g

否

x-cos-

grant-write-

acp

赋予被授权者写入对象的访问控制列表（ACL）的权限，格式为 id="

[OwnerUin]"，例如 id="100000000001"，可使用半角逗号（,）

分隔多组被授权者，例如

id="100000000001",id="100000000002"

st

ri

n

g

否

https://cloud.tencent.com/document/product/436/33417
https://cloud.tencent.com/document/product/436/30752#.E9.A2.84.E8.AE.BE.E7.9A.84-acl


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第313 共1701页

服务端加密（SSE）相关头部

在上传对象时可以使用服务端加密，请参见 服务端加密专用头部 。

此接口请求的请求体为对象（文件）内容。

此接口除返回公共响应头部外，还返回以下响应头部，了解公共响应头部详情请参见 公共响应头部  文档。

版本控制相关头部

在启用版本控制的存储桶中上传对象，将返回下列响应头部：

服务端加密（SSE）相关头部

如果在上传对象时使用了服务端加密，则此接口将返回服务端加密专用头部，请参见 服务端加密专用头部 。

此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

x-cos-

grant-full-

control

赋予被授权者操作对象的所有权限，格式为 id="[OwnerUin]"，例

如 id="100000000001"，可使用半角逗号（,）分隔多组被授权

者，例如 id="100000000001",id="100000000002"

st

ri

n

g

否

请求体

响应

响应头

名称 描述 类型

x-cos-version-id 对象的版本 ID string

响应体

错误码

实际案例

案例一：简单案例（未启用版本控制）

请求

PUT /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 09:35:05 GMT

Content-Type: image/jpeg

Content-Length: 16

Content-MD5: 7o3pGNBWQBRbGPcPTDqmAg==

https://cloud.tencent.com/document/product/436/7728#.E6.9C.8D.E5.8A.A1.E7.AB.AF.E5.8A.A0.E5.AF.86.E4.B8.93.E7.94.A8.E5.A4.B4.E9.83.A8
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7729#.E6.9C.8D.E5.8A.A1.E7.AB.AF.E5.8A.A0.E5.AF.86.E4.B8.93.E7.94.A8.E5.A4.B4.E9.83.A8
https://cloud.tencent.com/document/product/436/7730


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第314 共1701页

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

Object Content[ ]

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Fri, 10 Apr 2020 09:35:05 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MDNkYzlfNjRiODJhMDlfMzFmYzhfMTFm****

案例二：使用请求头部指定元数据和 ACL

请求

PUT /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 09:35:28 GMT

Content-Type: image/jpeg

Cache-Control: max-age=86400

Content-Disposition: attachment; filename=example.jpg

x-cos-meta-example-field: example-value

x-cos-acl: public-read

Content-Length: 16

Content-MD5: 7o3pGNBWQBRbGPcPTDqmAg==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

[Object Content]

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close
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Date: Fri, 10 Apr 2020 09:35:28 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MDNkZTBfZjhjMDBiMDlfNzdmN18xMGFi****

案例三：使用服务端加密 SSE-COS

请求

PUT /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 09:35:49 GMT

Content-Type: image/jpeg

x-cos-server-side-encryption: AES256

Content-Length: 16

Content-MD5: 7o3pGNBWQBRbGPcPTDqmAg==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

[Object Content]

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Fri, 10 Apr 2020 09:35:49 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MDNkZjVfYzVjNzJhMDlfMjVhNzNfMWMy****

x-cos-server-side-encryption: AES256

案例四：使用服务端加密 SSE-KMS

请求

PUT /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 09:36:00 GMT
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Content-Type: image/jpeg

x-cos-server-side-encryption: cos/kms

x-cos-server-side-encryption-cos-kms-key-id: 48ba38aa-26c5-11ea-855c-52540085****

x-cos-server-side-encryption-context: eyJhdXRob3IiOiJmeXNudGlhbiIsImNvbXBhbnkiOiJUZ

Content-Length: 16

Content-MD5: 7o3pGNBWQBRbGPcPTDqmAg==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

[Object Content]

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Fri, 10 Apr 2020 09:36:01 GMT

ETag: "840af7c921f4b3230049af8663145bd0"

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MDNlMDFfOThjMjJhMDlfMjhhMl8xNTlm****

x-cos-server-side-encryption: cos/kms

x-cos-server-side-encryption-cos-kms-key-id: 48ba38aa-26c5-11ea-855c-52540085****

案例五：使用服务端加密 SSE-C

请求

PUT /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 09:36:12 GMT

Content-Type: image/jpeg

x-cos-server-side-encryption-customer-algorithm: AES256

x-cos-server-side-encryption-customer-key: MDEyMzQ1Njc4OUFCQ0RFRjAxMjM0NTY3ODlB

x-cos-server-side-encryption-customer-key-MD5: U5L61r7jcwdNvT7frmUG8g==

Content-Length: 16

Content-MD5: 7o3pGNBWQBRbGPcPTDqmAg==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close
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[Object Content]

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Fri, 10 Apr 2020 09:36:13 GMT

ETag: "582d9105f71525f3c161984bc005efb5"

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MDNlMGNfZTFjODJhMDlfMzVlMDFfZTk1****

x-cos-server-side-encryption-customer-algorithm: AES256

x-cos-server-side-encryption-customer-key-MD5: U5L61r7jcwdNvT7frmUG8g==

案例六：启用版本控制

请求

PUT /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 09:36:34 GMT

Content-Type: image/jpeg

Content-Length: 16

Content-MD5: 7o3pGNBWQBRbGPcPTDqmAg==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

[Object Content]

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Fri, 10 Apr 2020 09:36:35 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MDNlMjNfMThiODJhMDlfNGQ1OF8xMWY4****
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本案例请求中使用 Transfer-Encoding: chunked 编码，案例描述的是 HTTP 请求中的原始数据，在使用过

程中根据不同语言和库将有不同的调用方法，请开发者查阅语言和库的相关文档。

x-cos-version-id: MTg0NDUxNTc1NjIzMTQ1MDAwODg

案例七：暂停版本控制

请求

PUT /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 09:37:07 GMT

Content-Type: image/jpeg

Content-Length: 16

Content-MD5: 7o3pGNBWQBRbGPcPTDqmAg==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

[Object Content]

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Fri, 10 Apr 2020 09:37:07 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MDNlNDNfZTZjNzJhMDlfMmYwMDlfMTVi****

案例八：使用 chunked 传输编码分块传输

请求

PUT /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 08 Aug 2019 09:15:29 GMT

Content-Type: text/plain

Transfer-Encoding: chunked

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&
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Connection: close

11

[Chunked Content]

b

[2nd chunk]

b

[3rd chunk]

b

[4th chunk]

0

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Thu, 08 Aug 2019 09:15:29 GMT

ETag: "aa488bb80185a6be87f4a7b936a80752"

Server: tencent-cos

x-cos-hash-crc64ecma: 7188322482464764960

x-cos-request-id: NWQ0YmU4MzFfNzFiNDBiMDlfMWJhYTlfMTY2Njll****
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PUT Object - Copy
最近更新时间：2023-04-13 11:34:15

PUT Object - Copy 接口请求创建一个已存在 COS 的对象的副本，即将一个对象从源路径（对象键）复制到目

标路径（对象键）。建议对象大小为1M到5G，超过5G的对象请使用分块上传 Upload Part - Copy 。

在复制过程中，可以指定元数据的处理方式。默认情况下元数据将被复制到目标对象中，用户也可以选择不复制源对

象的元数据信息，而在此接口请求中指定新的元数据信息。但是，除非在此接口请求中显式指定存储类型、访问控制

列表（ACL）和服务端加密（SSE），否则无论何种处理方式，目标对象均保持为标准存储，继承（default）目

标存储桶的 ACL 且不会使用 SSE。

用户可以通过此接口实现对象移动、重命名、修改对象元数据和创建副本。

该 API 的请求者需要对被复制对象有读取权限，或者被复制对象向所有人开放了读取权限（公有读），且需要对目

标存储桶有写入权限。

功能描述

注意

当 COS 收到复制请求或 COS 正在复制对象时可能会返回错误。如果在复制操作开始之前发生错误，

则会收到标准的错误返回。如果在复制操作执行期间发生错误，则依然会返回 HTTP 200 OK，并将

错误作为响应体返回。这意味着 HTTP 200 OK 响应既可以包含成功也可以包含错误，在使用此接口

时应当进一步根据响应体的内容来判断复制请求的成功与失败并正确的处理结果。

标准存储（多 AZ）类型目前仅支持复制为标准存储（多 AZ）类型，不支持复制为标准存储、低频和归

档存储类型。

低频存储（多 AZ）类型目前仅支持复制为低频存储（多 AZ）类型，不支持复制为标准存储、低频和归

档存储类型。

调用 PUT Object - Copy 等同于在源存储桶请求一次 GET Object，在目标存储桶请求一次 PUT 

Object。请注意该操作产生的计量计费，例如读写请求、存储容量、跨地域复制流量、工作流产生的数

据处理和审核次数等费用。

版本控制

如果源对象所在存储桶启用了版本控制，则默认复制源对象的最新版本，可以在请求头部 x-cos-copy-

source 中指定 versionId 参数来复制指定版本。

如果对目标存储桶启用版本控制，对象存储将自动为目标对象生成唯一的版本 ID。

请求

请求示例

PUT /<ObjectKey> HTTP/1.1

https://cloud.tencent.com/document/product/436/8287
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此接口无请求参数。

此接口除使用公共请求头部外，还支持以下请求头部，了解公共请求头部详情请参见 公共请求头部  文档。

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

x-cos-copy-source: <SourceBucketName-SourceAPPID>.cos.<SourceRegion>.myqcloud.c

Content-Length: 0

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

名称 描述
类

型

是否

必选

x-cos-

copy-

source

源对象的 URL，其中对象键需经过 URLEncode，可以通过 versionId 

参数指定源对象的版本，例如：

sourcebucket-1250000001.cos.ap-

shanghai.myqcloud.com/example-

%E8%85%BE%E8%AE%AF%E4%BA%91.jpg

或 

sourcebucket-1250000001.cos.ap-

shanghai.myqcloud.com/example-

%E8%85%BE%E8%AE%AF%E4%BA%91.jpg?

versionId=MTg0NDUxNzYzMDc0NDMzNDExOTc

st

ri

n

g

是

x-cos-

metada

ta-

directiv

e

是否复制源对象的元数据信息，枚举值：Copy，Replaced，默认为 

Copy。

当目标对象和源对象为同一对象时，即用户试图修改元数据时，则标记必须

为 Replaced

如果标记为 Copy，则复制源对象的元数据信息

如果标记为 Replaced，则按本次请求的请求头中的元数据信息作为目

标对象的元数据信息

E

n

u

m

否

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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x-cos-

copy-

source

-If-

Modifie

d-

Since

当对象在指定时间后被修改，则执行复制操作，否则返回 HTTP 状态码为

412（Precondition Failed）

st

ri

n

g

否

x-cos-

copy-

source

-If-

Unmodi

fied-

Since

当对象在指定时间后未被修改，则执行复制操作，否则返回 HTTP 状态码为

412（Precondition Failed）

st

ri

n

g

否

x-cos-

copy-

source

-If-

Match

当对象的 ETag 与指定的值一致，则执行复制操作，否则返回 HTTP 状态

码为412（Precondition Failed）

st

ri

n

g

否

x-cos-

copy-

source

-If-

None-

Match

当对象的 ETag 与指定的值不一致，则执行复制操作，否则返回 HTTP 状

态码为412（Precondition Failed）

st

ri

n

g

否

x-cos-

storage

-class

目标对象的存储类型。枚举值请参见 存储类型  文档，例如 

INTELLIGENT_TIERING，MAZ_INTELLIGENT_TIERING，

STANDARD_IA，ARCHIVE，DEEP_ARCHIVE。默认值：

STANDARD

E

n

u

m

否

x-cos-

tagging

对象的标签集合，最多可设置10个标签（例如，

Key1=Value1&Key2=Value2）。 标签集合中的 Key 和 Value 必须先

进行 URL 编码

st

ri

n

g

否

x-cos-

tagging

-

directiv

e

是否复制源对象的标签信息，枚举值：Copy，Replaced，默认为 Copy

当目标对象和源对象为同一对象时，即用户试图修改对象标签时，则标记必

须为 Replaced

如果标记为 Copy，则复制源对象的标签信息

如果标记为 Replaced，则按本次请求的请求头中的标签信息作为目标

对象的标签信息

E

n

u

m

否

https://cloud.tencent.com/document/product/436/33417
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目标对象元数据相关头部

在复制对象时可以通过指定下列请求头部来设置目标对象的元数据信息，此时请求头部 x-cos-metadata-

directive 需指定为 Replaced，否则目标对象将使用源对象的元数据信息且不能指定下列任何头部。

目标对象访问控制列表（ACL）相关头部

在复制对象时可以通过指定下列请求头部来设置目标对象的访问权限：

名称 描述
类

型

是否

必选

Cach

e-

Contr

ol

RFC 2616 中定义的缓存指令，将作为目标对象元数据保存

st

ri

n

g

否

Conte

nt-

Dispo

sition

RFC 2616 中定义的文件名称，将作为目标对象元数据保存

st

ri

n

g

否

Conte

nt-

Enco

ding

RFC 2616 中定义的编码格式，将作为目标对象元数据保存

st

ri

n

g

否

Conte

nt-

Type

RFC 2616 中定义的 HTTP 请求内容类型（MIME），此头部用于描述目标

对象的内容类型，将作为目标对象元数据保存

例如 text/html  或 image/jpeg

st

ri

n

g

是

Expir

es
RFC 2616 中定义的缓存失效时间，将作为目标对象元数据保存

st

ri

n

g

否

x-

cos-

meta

-*

包括用户自定义元数据头部后缀和用户自定义元数据信息，将作为目标对象元

数据保存，大小限制为2KB

例如 x-cos-meta-via: homepage，自定义元数据头部为 x-cos-

meta-via，后缀为 via，自定义元数据信息为 homepage

注意：用户自定义元数据信息支持下划线（_），但用户自定义元数据头部后

缀不支持下划线，仅支持减号（-）

st

ri

n

g

否

名称 描述
类

型

是否

必选

x- 定义目标对象的访问控制列表（ACL）属性。枚举值请参见 ACL 概述  文档 E 否

https://cloud.tencent.com/document/product/436/30752#.E9.A2.84.E8.AE.BE.E7.9A.84-acl
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源对象服务端加密（SSE）相关头部

如果源对象使用了服务端加密且加密方式为 SSE-C 时，则需要指定下列请求头部来解密源对象：

cos-

acl

中对象的预设 ACL 部分，例如 default，private，public-read 等，默认

为 default

注意：如果您不需要进行对象 ACL 控制，请设置为 default 或者此项不进行

设置，默认继承存储桶权限

n

u

m

x-

cos-

grant

-read

赋予被授权者读取目标对象的权限，格式为 id="[OwnerUin]"，例如 

id="100000000001"，可使用半角逗号（,）分隔多组被授权者，例如

id="100000000001",id="100000000002"

st

ri

n

g

否

x-

cos-

grant

-

read-

acp

赋予被授权者读取目标对象的访问控制列表（ACL）的权限，格式为 id="

[OwnerUin]"，例如 id="100000000001"，可使用半角逗号（,）分隔多组

被授权者，例如 id="100000000001",id="100000000002"

st

ri

n

g

否

x-

cos-

grant

-

write

-acp

赋予被授权者写入目标对象的访问控制列表（ACL）的权限，格式为 id="

[OwnerUin]"，例如 id="100000000001"，可使用半角逗号（,）分隔多组

被授权者，例如 id="100000000001",id="100000000002"

st

ri

n

g

否

x-

cos-

grant

-full-

contr

ol

赋予被授权者操作目标对象的所有权限，格式为 id="[OwnerUin]"，例如 

id="100000000001"，可使用半角逗号（,）分隔多组被授权者，例如

id="100000000001",id="100000000002"

st

ri

n

g

否

名称 描述
类

型
是否必选               

x-cos-copy-source-

server-side-

encryption-

customer-algorithm

服务端加密算法，目前仅支持 AES256

st

ri

n

g

源对象使用 

SSE-C 时，

此头部是必选

项

x-cos-copy-source-

server-side-

encryption-

customer-key

服务端加密密钥的 Base64 编码，例如

MDEyMzQ1Njc4OUFCQ

0RFRjAxMjM0NTY3ODlBQkNERUY=

st

ri

n

g

源对象使用 

SSE-C 时，

此头部是必选

项
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目标对象服务端加密（SSE）相关头部

在复制对象时可以使用服务端加密，请参见 服务端加密专用头部 。

此接口无请求体。

此接口除返回公共响应头部外，还返回以下响应头部，了解公共响应头部详情请参见 公共响应头部  文档。

版本控制相关头部

当指定了源对象的版本 ID 时，将返回下列响应头部：

服务端加密（SSE）相关头部

如果在复制对象时使用了服务端加密，则此接口将返回服务端加密专用头部，请参见 服务端加密专用头部 。

查询成功，返回 application/xml 数据，包含对象复制结果信息。

具体的节点描述如下：

x-cos-copy-source-

server-side-

encryption-

customer-key-MD5

服务端加密密钥的 MD5 哈希值，使用 

Base64 编码

例如 U5L61r7jcwdNvT7frmUG8g==

st

ri

n

g

源对象使用 

SSE-C 时，

此头部是必选

项

请求体

响应

响应头

名称 描述 类型

x-cos-copy-source-version-id 源对象的版本 ID string

响应体

<?xml version="1.0" encoding="UTF-8"?>

<CopyObjectResult>

            <ETag>string</ETag>

            <CRC64>number</CRC64>

            <LastModified>date</LastModified>

            <VersionId>string</VersionId>

</CopyObjectResult>

节点名称（关键字） 父节点 描述 类型

CopyObjectResult 无 保存 PUT Object - Copy 结果的所有信息 Container

https://cloud.tencent.com/document/product/436/7728#.E6.9C.8D.E5.8A.A1.E7.AB.AF.E5.8A.A0.E5.AF.86.E4.B8.93.E7.94.A8.E5.A4.B4.E9.83.A8
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7729#.E6.9C.8D.E5.8A.A1.E7.AB.AF.E5.8A.A0.E5.AF.86.E4.B8.93.E7.94.A8.E5.A4.B4.E9.83.A8
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Container 节点 CopyObjectResult 的内容：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

此接口响应默认为 Transfer-Encoding: chunked 编码方式，为了方便阅读，本文档实际案例均采用无 

Transfer-Encoding 的方式展示，在使用过程中，不同语言和库可以自动处理这种编码形式，请开发者注意识别

和处理，更多信息请查阅语言和库的相关文档。

节点

名称

（关

键

字）

父节

点
描述

类

型

ETa

g

Cop

yOb

ject

Res

ult

对象的实体标签（Entity Tag），是对象被创建时标识对象内容的信息标签，

可用于检查对象的内容是否发生变化

例如 8e0b617ca298a564c3331da28dcb50df ，此头部并不一定返回对象

的 MD5 值，而是根据对象上传和加密方式而有所不同

stri

ng

CR

C64

Cop

yOb

ject

Res

ult

对象的 CRC64 值，详情请参见 CRC64 校验  文档

nu

mb

er

Las

tMo

difie

d

Cop

yOb

ject

Res

ult

对象最后修改时间，为 ISO8601 格式，例如 2019-05-24T10:56:40Z
dat

e

Ver

sion

Id

Cop

yOb

ject

Res

ult

对象的版本 ID，仅当目标存储桶启用了版本控制时才返回该元素
stri

ng

错误码

实际案例

案例一：简单案例

请求

https://cloud.tencent.com/document/product/436/7730
https://cloud.tencent.com/document/product/436/40334
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PUT /exampleobject HTTP/1.1

Host: destinationbucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 18:20:30 GMT

x-cos-copy-source: sourcebucket-1250000001.cos.ap-shanghai.myqcloud.com/example-%

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 219

Connection: close

Date: Fri, 10 Apr 2020 18:20:30 GMT

Server: tencent-cos

x-cos-request-id: NWU5MGI4ZWVfNzljMDBiMDlfMWM3MjlfMWQ1****

<?xml version="1.0" encoding="UTF-8"?>

<CopyObjectResult>

            <ETag>"ee8de918d05640145b18f70f4c3aa602"</ETag>

            <CRC64>16749565679157681890</CRC64>

            <LastModified>2020-04-10T18:20:30Z</LastModified>

</CopyObjectResult>

案例二：复制时替换元数据

请求

PUT /exampleobject HTTP/1.1

Host: destinationbucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 18:20:41 GMT

x-cos-metadata-directive: Replaced

Content-Type: application/octet-stream

Content-Disposition: attachment; filename=example.jpg

x-cos-copy-source: sourcebucket-1250000001.cos.ap-shanghai.myqcloud.com/example-%

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 219

Connection: close

Date: Fri, 10 Apr 2020 18:20:41 GMT

Server: tencent-cos

x-cos-request-id: NWU5MGI4ZjlfYTZjMDBiMDlfN2Y1YV8xYjI4****

<?xml version="1.0" encoding="UTF-8"?>

<CopyObjectResult>

            <ETag>"ee8de918d05640145b18f70f4c3aa602"</ETag>

            <CRC64>16749565679157681890</CRC64>

            <LastModified>2020-04-10T18:20:41Z</LastModified>

</CopyObjectResult>

案例三：修改对象元数据

请求

PUT /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 18:20:52 GMT

x-cos-metadata-directive: Replaced

Cache-Control: max-age=86400

Content-Type: image/jpeg

x-cos-copy-source: examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleob

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 219

Connection: close

Date: Fri, 10 Apr 2020 18:20:52 GMT

Server: tencent-cos

x-cos-request-id: NWU5MGI5MDRfNmRjMDJhMDlfZGNmYl8yMDVh****
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本案例演示将对象从标准存储转换为归档存储，该使用方法也适合标准存储与低频存储之间的互相转换，如果希望将

归档存储或深度归档存储的对象转换为其他存储类型，需要首先使用 POST Object restore  将归档存储或深度

归档存储的对象回热，才能使用该接口请求转换存储类型。

<?xml version="1.0" encoding="UTF-8"?>

<CopyObjectResult>

            <ETag>"ee8de918d05640145b18f70f4c3aa602"</ETag>

            <CRC64>16749565679157681890</CRC64>

            <LastModified>2020-04-10T18:20:52Z</LastModified>

</CopyObjectResult>

案例四：修改对象存储类型

请求

PUT /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 18:21:02 GMT

x-cos-metadata-directive: Replaced

x-cos-storage-class: ARCHIVE

x-cos-copy-source: examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleob

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 219

Connection: close

Date: Fri, 10 Apr 2020 18:21:02 GMT

Server: tencent-cos

x-cos-request-id: NWU5MGI5MGVfN2RiNDBiMDlfMTk1MjhfMWZm****

<?xml version="1.0" encoding="UTF-8"?>

<CopyObjectResult>

            <ETag>"ee8de918d05640145b18f70f4c3aa602"</ETag>

            <CRC64>16749565679157681890</CRC64>

https://cloud.tencent.com/document/product/436/12633
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            <LastModified>2020-04-10T18:21:55Z</LastModified>

</CopyObjectResult>

案例五：将未加密的对象复制为使用 SSE-COS 加密的目标对象

请求

PUT /exampleobject HTTP/1.1

Host: destinationbucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 18:21:12 GMT

x-cos-server-side-encryption: AES256

x-cos-copy-source: sourcebucket-1250000001.cos.ap-shanghai.myqcloud.com/example-%

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 219

Connection: close

Date: Fri, 10 Apr 2020 18:21:13 GMT

Server: tencent-cos

x-cos-request-id: NWU5MGI5MTlfYmIwMmEwOV9hMmUxXzFkMDQ2****

x-cos-server-side-encryption: AES256

<?xml version="1.0" encoding="UTF-8"?>

<CopyObjectResult>

            <ETag>"ee8de918d05640145b18f70f4c3aa602"</ETag>

            <CRC64>16749565679157681890</CRC64>

            <LastModified>2020-04-10T18:21:13Z</LastModified>

</CopyObjectResult>

案例六：将未加密的对象复制为使用 SSE-KMS 加密的目标对象

请求

PUT /exampleobject HTTP/1.1

Host: destinationbucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 18:21:23 GMT
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x-cos-server-side-encryption: cos/kms

x-cos-server-side-encryption-cos-kms-key-id: 48ba38aa-26c5-11ea-855c-52540085****

x-cos-server-side-encryption-context: eyJhdXRob3IiOiJmeXNudGlhbiIsImNvbXBhbnkiOiJUZ

x-cos-copy-source: sourcebucket-1250000001.cos.ap-shanghai.myqcloud.com/example-%

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 219

Connection: close

Date: Fri, 10 Apr 2020 18:21:23 GMT

Server: tencent-cos

x-cos-request-id: NWU5MGI5MjNfMTliOTJhMDlfMjRiYThfMTdk****

x-cos-server-side-encryption: cos/kms

x-cos-server-side-encryption-cos-kms-key-id: 48ba38aa-26c5-11ea-855c-52540085****

<?xml version="1.0" encoding="UTF-8"?>

<CopyObjectResult>

            <ETag>"f69901ec9755a5defc29057e9ec69126"</ETag>

            <CRC64>16749565679157681890</CRC64>

            <LastModified>2020-04-10T18:22:16Z</LastModified>

</CopyObjectResult>

案例七：复制 SSE-C 加密的对象并更换密钥

请求

PUT /exampleobject HTTP/1.1

Host: destinationbucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 18:21:44 GMT

x-cos-copy-source-server-side-encryption-customer-algorithm: AES256

x-cos-copy-source-server-side-encryption-customer-key: MDEyMzQ1Njc4OUFCQ0RFRjAxM

x-cos-copy-source-server-side-encryption-customer-key-MD5: U5L61r7jcwdNvT7frmUG8g

x-cos-server-side-encryption-customer-algorithm: AES256

x-cos-server-side-encryption-customer-key: MDEyMzQ1Njc4OWFiY2RlZjAxMjM0NTY3ODlhY

x-cos-server-side-encryption-customer-key-MD5: hRasmdxgYDKV3nvbahU1MA==

x-cos-copy-source: sourcebucket-1250000001.cos.ap-shanghai.myqcloud.com/example-%

Content-Length: 0
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Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 219

Connection: close

Date: Fri, 10 Apr 2020 18:21:44 GMT

Server: tencent-cos

x-cos-request-id: NWU5MGI5MzhfZmFjODJhMDlfMTdlYzZfYmU1****

x-cos-server-side-encryption-customer-algorithm: AES256

x-cos-server-side-encryption-customer-key-MD5: hRasmdxgYDKV3nvbahU1MA==

<?xml version="1.0" encoding="UTF-8"?>

<CopyObjectResult>

            <ETag>"bf314b89d34119395d5610982d6581b1"</ETag>

            <CRC64>16749565679157681890</CRC64>

            <LastModified>2020-04-10T18:22:31Z</LastModified>

</CopyObjectResult>

案例八：将 SSE-C 加密的对象修改为不加密

请求

PUT /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 18:22:05 GMT

x-cos-metadata-directive: Replaced

x-cos-copy-source-server-side-encryption-customer-algorithm: AES256

x-cos-copy-source-server-side-encryption-customer-key: MDEyMzQ1Njc4OUFCQ0RFRjAxM

x-cos-copy-source-server-side-encryption-customer-key-MD5: U5L61r7jcwdNvT7frmUG8g

x-cos-copy-source: examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleob

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK
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Content-Type: application/xml

Content-Length: 219

Connection: close

Date: Fri, 10 Apr 2020 18:22:05 GMT

Server: tencent-cos

x-cos-request-id: NWU5MGI5NGRfOWFjOTJhMDlfMjg2NDdfMTA0****

<?xml version="1.0" encoding="UTF-8"?>

<CopyObjectResult>

            <ETag>"ee8de918d05640145b18f70f4c3aa602"</ETag>

            <CRC64>16749565679157681890</CRC64>

            <LastModified>2020-04-10T18:22:58Z</LastModified>

</CopyObjectResult>

案例九：指定源对象的版本

请求

PUT /exampleobject HTTP/1.1

Host: destinationbucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Sat, 11 Apr 2020 17:51:35 GMT

x-cos-copy-source: sourcebucket-1250000001.cos.ap-shanghai.myqcloud.com/example.jp

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 219

Connection: close

Date: Sat, 11 Apr 2020 17:51:35 GMT

Server: tencent-cos

x-cos-copy-source-version-id: MTg0NDUxNTc0NDYyMjQ2MzUzMjQ

x-cos-request-id: NWU5MjAzYTdfMWZjMDJhMDlfNTE4N18zNGU2****

<?xml version="1.0" encoding="UTF-8"?>

<CopyObjectResult>

            <ETag>"ee8de918d05640145b18f70f4c3aa602"</ETag>
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            <CRC64>16749565679157681890</CRC64>

            <LastModified>2020-04-11T17:51:35Z</LastModified>

</CopyObjectResult>

案例十：复制对象到启用版本控制的存储桶

请求

PUT /exampleobject HTTP/1.1

Host: destinationbucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Sat, 11 Apr 2020 17:51:56 GMT

x-cos-copy-source: sourcebucket-1250000001.cos.ap-shanghai.myqcloud.com/example.jp

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 272

Connection: close

Date: Sat, 11 Apr 2020 17:51:56 GMT

Server: tencent-cos

x-cos-request-id: NWU5MjAzYmNfNjRiMDJhMDlfOTE3N18yYWI4****

<?xml version="1.0" encoding="UTF-8"?>

<CopyObjectResult>

            <ETag>"22e024392de860289f0baa7d6cf8a549"</ETag>

            <CRC64>11596229263574363878</CRC64>

            <LastModified>2020-04-11T17:51:56Z</LastModified>

            <VersionId>MTg0NDUxNTc0NDYxOTI4MzU0MDI</VersionId>

</CopyObjectResult>
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POST Object
最近更新时间：2023-07-26 14:33:42

POST Object 接口请求可以将本地不超过5GB的对象（Object）以网页表单（HTML Form）的形式上传至指

定存储桶中。该 API 的请求者需要对存储桶有写入权限。

功能描述

注意

POST Object 接口不使用 COS 对象存储统一的请求签名，而是拥有自己的签名要求，请参见本文档

的 签名保护  及相关字段的描述。

如果试图添加已存在的同名对象且没有启用版本控制，则新上传的对象将覆盖原来的对象，成功时按照

指定的返回方式正常返回。

上传图片时，请参见 PUT Object  接口，可参考代码示例进行数据填充。

版本控制

如果对存储桶启用版本控制，对象存储将自动为要添加的对象生成唯一的版本 ID。对象存储使用 x-cos-

version-id 响应头部在响应中返回此标识。

如果暂停存储桶的版本控制，则对象存储始终将 null 用作存储在存储桶中的对象的版本 ID，且不返回 x-cos-

version-id 响应头部。

请求

请求示例

POST / HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-Type: multipart/form-data  boundary=Multipart Boundary

Content-Length: Content Length

Multipart Form Data

;

[ ]

说明

 Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶概览 

https://cloud.tencent.com/document/product/436/7749
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
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此接口请求体通过 multipart/form-data 编码，在 HTML 网页中通过 <form> 元素发送请求时，需将 <form> 

元素的 enctype 属性设置为 multipart/form-data，随后使用 HTML 表单元素（例如 <input>、<select> 

等）添加所需表单字段。

表单字段

> 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 地域和访

问域名  文档。

请求表单

名称 描述 类型
是否

必选

key
对象键，可在对象键中指定 ${filename} 通配符，此时将使用实

际上传的文件的文件名替换对象键中的通配符，相关示例请参见本

文档的 案例七

stri

ng
是

Cache-

Control
RFC 2616 中定义的缓存指令，将作为对象元数据保存

stri

ng
否

Content-

Disposition
RFC 2616 中定义的文件名称，将作为对象元数据保存

stri

ng
否

Content-

Encoding
RFC 2616 中定义的编码格式，将作为对象元数据保存

stri

ng
否

Content-

Type

RFC 2616 中定义的 HTTP 内容类型（MIME），将作为对象元

数据保存

注意：通过网页表单上传文件时，浏览器会自动把指定文件的 

MIME 类型携带在请求中，但对象存储 COS 并不会使用浏览器

携带的 MIME 类型，您需要显式指定 Content-Type 表单字段

作为对象的内容类型

stri

ng
否

Expires RFC 2616 中定义的缓存失效时间，将作为对象元数据保存
stri

ng
否

success_acti

on_redirect

上传成功时重定向的目标 URL 地址，如果设置，那么在上传成功

时将返回 HTTP 状态码为303（Redirect）及 Location 响应

头部，Location 响应头部的值为该字段指定的 URL 地址，并附

加 bucket、key 和 etag 参数，相关示例请参见本文档的 案例

八

stri

ng
否

success_acti

on_status

上传成功时返回的 HTTP 状态码，可选200、201或204，默认

为204。如果指定了 success_action_redirect 字段，则此字

段会被忽略。相关示例请参见本文档的 案例九

nu

mb

er

否

https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
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访问控制列表（ACL）相关表单字段

在上传对象时可以通过指定下列表单字段来设置对象的访问权限：

x-cos-meta-

*

包括用户自定义元数据头部后缀和用户自定义元数据信息，将作为

对象元数据保存，大小限制为2KB

注意：用户自定义元数据信息支持下划线（_），但用户自定义元

数据头部后缀不支持下划线，仅支持减号（-）

stri

ng

否

x-cos-

storage-

class

对象存储类型。枚举值请参见 存储类型  文档，例如 

MAZ_STANDARD、MAZ_STANDARD_IA、

INTELLIGENT_TIERING、

MAZ_INTELLIGENT_TIERING、STANDARD_IA、

ARCHIVE、DEEP_ARCHIVE。默认值：STANDARD

Enu

m
否

x-cos-

traffic-limit

针对本次上传进行流量控制的限速值，必须为数字，单位默认为 

bit/s。限速值设置范围为819200 - 838860800，即

800Kb/s-800Mb/s，如果超出该范围将返回400错误

inte

ger
否

Content-MD5
经过 Base64 编码的文件内容 MD5 哈希值，用于完整性检查，

验证文件内容在传输过程中是否发生变化

stri

ng
否

file

文件的信息和内容，通过网页表单上传时，浏览器将自动设置该字

段的值为正确的格式

注意：file 字段必须放在整个表单的最后面。

file 是

名称                                  描述
类

型

是否

必选

acl

定义对象的访问控制列表（ACL）属性。枚举值请参见 ACL 概述  

文档中对象的预设 ACL 部分，例如 default，private，public-

read 等，默认为 default

注意：如果您不需要进行对象 ACL 控制，请设置为 default 或者此

项不进行设置，默认继承存储桶权限

En

um
否

x-cos-

grant-read

赋予被授权者读取对象的权限，格式为 id="[OwnerUin]"，例如 

id="100000000001"，可使用半角逗号（,）分隔多组被授权者，

例如 id="100000000001",id="100000000002"

stri

ng
否

x-cos-

grant-read-

acp

赋予被授权者读取对象的访问控制列表（ACL）的权限，格式为 

id="[OwnerUin]"，例如 id="100000000001"，可使用半角逗号

（,）分隔多组被授权者，例如

id="100000000001",id="100000000002"

stri

ng
否

x-cos-

grant-write-

acp

赋予被授权者写入对象的访问控制列表（ACL）的权限，格式为 

id="[OwnerUin]"，例如 id="100000000001"，可使用半角逗号

stri

ng

否

https://cloud.tencent.com/document/product/436/33417
https://cloud.tencent.com/document/product/436/30752#.E9.A2.84.E8.AE.BE.E7.9A.84-acl
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服务端加密（SSE）相关表单字段

在上传对象时可以通过指定下列表单字段来使用服务端加密：

（,）分隔多组被授权者，例如

id="100000000001",id="100000000002"

x-cos-

grant-full-

control

赋予被授权者操作对象的所有权限，格式为 id="[OwnerUin]"，例

如 id="100000000001"，可使用半角逗号（,）分隔多组被授权

者，例如 id="100000000001",id="100000000002"

stri

ng
否

名称 描述
类

型
是否必选

x-cos-server-side-

encryption

服务端加密算法，支持 AES256、

cos/kms

stri

ng

使用 SSE-

COS 或 

SSE-KMS 

时，此字段

为必选项

x-cos-server-side-

encryption-customer-

algorithm

服务端加密算法，支持 AES256
stri

ng

使用 SSE-

C 时，此字

段为必选项

x-cos-server-side-

encryption-cos-kms-key-

id

当 x-cos-server-side-encryption 

值为 cos/kms 时，用于指定 kms 的用

户主密钥 CMK，如不指定则使用 COS 

默认创建的 CMK，更多详细信息可参见 

SSE-KMS 加密

stri

ng
否

x-cos-server-side-

encryption-context

当 x-cos-server-side-encryption 

值为 cos/kms 时，用于指定加密上下

文，值为 JSON 格式加密上下文键值对

的 Base64 编码

例如

eyJhIjoiYXNkZmEiLCJiIjoiMTIzMzIxI

n0=

stri

ng
否

x-cos-server-side-

encryption-customer-key

服务端加密密钥的 Base64 编码

例如

MDEyMzQ1Njc4OUFCQ0RFRjAxMj

M0NTY3ODlBQkNERUY=

stri

ng

使用 SSE-

C 时，此字

段为必选项

x-cos-server-side-

encryption-customer-key-

MD5

服务端加密密钥的 MD5 哈希值，使用 

Base64 编码

例如 U5L61r7jcwdNvT7frmUG8g==

stri

ng

使用 SSE-

C 时，此字

段为必选项

https://cloud.tencent.com/document/product/436/18145#sse-kms-.E5.8A.A0.E5.AF.86
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POST Object 接口要求在请求中携带签名相关字段，COS 服务器端收到消息后，进行身份验证，验证成功则可

接受并执行请求，否则将会返回错误信息并丢弃此请求。

签名流程如下：

在访问管理控制台的 API 密钥管理  页面中获取 SecretId 和 SecretKey。

a. 获取当前时间对应的 Unix 时间戳 StartTimestamp，Unix 时间戳是从 UTC（协调世界时，或 GMT 格林

威治时间）1970年1月1日0时0分0秒（北京时间：1970年1月1日8时0分0秒）起至现在的总秒数。 

b. 根据上述时间戳和期望的签名有效时长算出签名过期时间对应的 Unix 时间戳 EndTimestamp。 

c. 拼接签名有效时间，格式为 StartTimestamp;EndTimestamp ，即为 KeyTime。

策略为一个 JSON 文本，一个典型的策略如下：

其中：

签名保护

1. 准备工作

2. 生成 KeyTime

3. 构造“策略”（Policy）

    "expiration": "2019-08-30T09:38:12.414Z",

    "conditions": 

         "acl": "default" ,

         "bucket": "examplebucket-1250000000" ,

         "starts-with", "$key", "folder/subfolder/" ,

         "starts-with", "$Content-Type", "image/" ,

         "starts-with", "$success_action_redirect", "https://my.website/" ,

         "eq", "$x-cos-server-side-encryption", "AES256" ,

         "q-sign-algorithm": "sha1" ,

         "q-ak": "AKIDQjz3ltompVjBni5LitkWHFlFpwkn9U5q" ,

         "q-sign-time": "1567150692;1567157892" 

    

{

[

{ }

{ }

[ ]

[ ]

[ ]

[ ]

{ }

{ }

{ }

]

}

expiration：该策略的过期时间，ISO8601 格式字符串

conditions：该策略的具体条件限定数组，限定条件的具体规则如下表。

类型 描述

完全

匹配
使用 { "key": "value" } 或 [ "eq", "$key", "value" ] 方式表达，其中 key 为被限定的表单字

段，value 为被限定的值

https://console.cloud.tencent.com/cam/capi
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支持被限定的表单字段如下：

前缀

匹配
使用 [ "starts-with", "$key", "value" ] 方式表达，其中 key 为被限定的表单字段，value 为被

限定的前缀，可为空

范围

匹配
仅适用于 [ "content-length-range", minNum, maxNum ] ，用于限定文件的长度必须在 

minNum 和 maxNum 范围内

字段名称 描述
匹配方

式       

是否

必选

acl 对象的访问控制列表（ACL）属性
完全、

前缀
否

bucket 上传的存储桶 完全 否

key

对象键。如果在上传时对象键使用 ${filename} 通配

符，那么对象键将在验证策略前被处理为最终的对象键，

此时在策略中应该使用前缀匹配，而不应该出现

${filename} 通配符

完全、

前缀
否

content-length-

range
文件长度范围 范围 否

Cache-Control, 

Content-Type, 

Content-

Disposition, 

Content-

Encoding, 

Expires

RFC 2616 中定义的相关头部，将在下载对象时作为响应

头部返回

完全、

前缀
否

success_action_

redirect
上传成功时重定向的目标 URL 地址

完全、

前缀
否

success_action_

status
上传成功时返回的 HTTP 状态码 完全 否

x-cos-meta-* 用户自定义的元数据头部字段
完全、

前缀
否

x-cos-*
本文档中提到的其他 COS 相关表单字段，例如 ACL 和 

SSE 相关字段
完全 否

q-sign-algorithm 签名哈希算法，固定为 sha1 完全 是

q-ak 上文所述的 SecretId 完全 是
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使用 HMAC-SHA1 以 SecretKey 为密钥，以 KeyTime 为消息，计算消息摘要（哈希值，16进制小写形

式），即为 SignKey，例如： 39acc8c9f34ba5b19bce4e965b370cd3f62d2fba 。

使用 SHA1 对上文中构造的策略（Policy）文本计算消息摘要（哈希值，16进制小写形式），即为 

StringToSign，例如： d5d903b8360468bc81c1311f134989bc8c8b5b89 。

使用 HMAC-SHA1 以 SignKey 为密钥（字符串形式，非原始二进制），以 StringToSign 为消息（字符串形

式，非原始二进制），计算消息摘要（哈希值，16进制小写形式），即为 Signature，例如：

7758dc9a832e9d301dca704cacbf9d9f8172fdef 。

将上述策略和签名相关信息，以下表中描述的方式附加到表单中：

q-sign-time 上文所生成的 KeyTime 完全 是

注意

“策略”（Policy）中限定的除 bucket 以外的字段，都必须出现在表单字段中。例如限定了

{ "acl": "default" } ，那么表单中必须出现 acl 且值为 default。

基于安全考虑，强烈建议您对所有可以限定的表单字段进行限定。

4. 生成 SignKey

5. 生成 StringToSign

6. 生成 Signature

7. 将签名附加到表单

名称 描述 类型 是否必选

x-cos-

security-

token

使用临时安全凭证时需要传入的安全令牌字段，详情请参见 临

时安全凭证  相关说明

stri

ng

否，当使

用临时

密钥时，

此表单项

为必选项

policy 经过 Base64 编码的“策略”（Policy）内容
stri

ng
是

q-sign-

algorithm
签名哈希算法，固定为 sha1

stri

ng
是

q-ak 上文所述的 SecretId
stri

ng
是

q-key- 上文所生成的 KeyTime stri 是

https://cloud.tencent.com/document/product/436/31315#.E4.B8.B4.E6.97.B6.E5.AE.89.E5.85.A8.E5.87.AD.E8.AF.81
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签名保护实际案例

准备工作

登录访问管理控制台的 API 密钥管理  页面获取其 APPID、SecretId 和 SecretKey，举例如下：

构造策略

中间变量

签名表单字段

time ng

q-

signature
上文所生成的 Signature

stri

ng
是

注意

签名表单字段需要在 file 表单字段之前。

APPID SecretId SecretKey

12500000

00

AKIDQjz3ltompVjBni5LitkWHFlFpwk

n9U5q

BQYIM75p8x0iWVFSIgqEKwFprp

RSVHlz

    "expiration": "2019-08-30T09:38:12.414Z",

    "conditions": 

         "acl": "default" ,

         "bucket": "examplebucket-1250000000" ,

         "starts-with", "$key", "folder/subfolder/" ,

         "starts-with", "$Content-Type", "image/" ,

         "starts-with", "$success_action_redirect", "https://my.website/" ,

         "eq", "$x-cos-server-side-encryption", "AES256" ,

         "q-sign-algorithm": "sha1" ,

         "q-ak": "AKIDQjz3ltompVjBni5LitkWHFlFpwkn9U5q" ,

         "q-sign-time": "1567150692;1567157892" 

    

{

[

{ }

{ }

[ ]

[ ]

[ ]

[ ]

{ }

{ }

{ }

]

}

KeyTime = 1567150692;1567157892

SignKey = 39acc8c9f34ba5b19bce4e965b370cd3f62d2fba

StringToSign = d5d903b8360468bc81c1311f134989bc8c8b5b89

Signature = 7758dc9a832e9d301dca704cacbf9d9f8172fdef

policy = 

https://console.cloud.tencent.com/cam/capi
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此接口除返回公共响应头部外，还返回以下响应头部，了解公共响应头部详情请参见 公共响应头部  文档。

版本控制相关头部

在启用版本控制的存储桶中上传对象，将返回下列响应头部：

服务端加密（SSE）相关头部

如果在上传对象时使用了服务端加密，则此接口将返回服务端加密专用头部，请参见 服务端加密专用头部 。

此接口响应体为空。

ewogICAgImV4cGlyYXRpb24iOiAiMjAxOS0wOC0zMFQwOTozODoxMi40MTRaIiwKICAgICJjb25kaXR

pb25zIjogWwogICAgICAgIHsgImFjbCI6ICJkZWZhdWx0IiB9LAogICAgICAgIHsgImJ1Y2tldCI6ICJleGFt

cGxlYnVja2V0LTEyNTAwMDAwMDAiIH0sCiAgICAgICAgWyAic3RhcnRzLXdpdGgiLCAiJGtleSIsICJmb2

xkZXIvc3ViZm9sZGVyLyIgXSwKICAgICAgICBbICJzdGFydHMtd2l0aCIsICIkQ29udGVudC1UeXBlIiwgI

mltYWdlLyIgXSwKICAgICAgICBbICJzdGFydHMtd2l0aCIsICIkc3VjY2Vzc19hY3Rpb25fcmVkaXJlY3QiL

CAiaHR0cHM6Ly9teS53ZWJzaXRlLyIgXSwKICAgICAgICBbICJlcSIsICIkeC1jb3Mtc2VydmVyLXNpZGU

tZW5jcnlwdGlvbiIsICJBRVMyNTYiIF0sCiAgICAgICAgeyAicS1zaWduLWFsZ29yaXRobSI6ICJzaGExIiB

9LAogICAgICAgIHsgInEtYWsiOiAiQUtJRFFqejNsdG9tcFZqQm5pNUxpdGtXSEZsRnB3a245VTVxIiB9

LAogICAgICAgIHsgInEtc2lnbi10aW1lIjogIjE1NjcxNTA2OTI7MTU2NzE1Nzg5MiIgfQogICAgXQp9

q-sign-algorithm = sha1

q-ak = AKIDQjz3ltompVjBni5LitkWHFlFpwkn9U5q

q-key-time = 1567150692;1567157892

q-signature = 7758dc9a832e9d301dca704cacbf9d9f8172fdef

响应

响应头

名称 描述
类

型

Loca

tion

当使用 success_action_redirect 表单字段时，此响应头部的值为 

success_action_redirect 指定的 URL 地址，并附加 bucket、key 和 etag 

参数，相关示例请参见本文档的 案例八  

当未使用 success_action_redirect 表单字段时，此响应头部的值为完整的对象

访问 URL 地址，相关示例请参见本文档的 案例一  

str

ing

名称 描述 类型

x-cos-version-id 对象的版本 ID string

响应体

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7729#.E6.9C.8D.E5.8A.A1.E7.AB.AF.E5.8A.A0.E5.AF.86.E4.B8.93.E7.94.A8.E5.A4.B4.E9.83.A8
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

错误码

实际案例

案例一：简单案例（未启用版本控制）

请求

POST / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 29 Aug 2019 07:39:34 GMT

Content-Type: multipart/form-data  boundary=----WebKitFormBoundaryZBPbaoYE2gqeB21

Content-Length: 1119

Connection: close

------WebKitFormBoundaryZBPbaoYE2gqeB21N

Content-Disposition: form-data  name="key"

exampleobject

------WebKitFormBoundaryZBPbaoYE2gqeB21N

Content-Disposition: form-data  name="policy"

eyJjb25kaXRpb25zIjpbeyJxLXNpZ24tYWxnb3JpdGhtIjoic2hhMSJ9LHsicS1hayI6IkFLSUQ4QT

------WebKitFormBoundaryZBPbaoYE2gqeB21N

Content-Disposition: form-data  name="q-sign-algorithm"

sha1

------WebKitFormBoundaryZBPbaoYE2gqeB21N

Content-Disposition: form-data  name="q-ak"

AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****

------WebKitFormBoundaryZBPbaoYE2gqeB21N

Content-Disposition: form-data  name="q-key-time"

1567064374 1567071574

------WebKitFormBoundaryZBPbaoYE2gqeB21N

Content-Disposition: form-data  name="q-signature"

74ba120129a13d8f0e19479fbdc01bca3bca****

------WebKitFormBoundaryZBPbaoYE2gqeB21N

Content-Disposition: form-data  name="file"  filename="example.jpg"

Content-Type: image/jpeg

;

;

;

;

;

;

;

;

; ;

https://cloud.tencent.com/document/product/436/7730
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Object Content

------WebKitFormBoundaryZBPbaoYE2gqeB21N--

[ ]

响应

HTTP/1.1 204 

Content-Length: 0

Connection: close

Date: Thu, 29 Aug 2019 07:39:34 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Location: http://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleobject

Server: tencent-cos

x-cos-request-id: NWQ2NzgxMzZfMmViMDJhMDlfY2NjOF84NGQz****

案例二：使用表单字段指定元数据和 ACL

请求

POST / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 29 Aug 2019 07:39:34 GMT

Content-Type: multipart/form-data  boundary=----WebKitFormBoundary9JtEhEGHSdx8Patg

Content-Length: 2146

Connection: close

------WebKitFormBoundary9JtEhEGHSdx8Patg

Content-Disposition: form-data  name="key"

exampleobject

------WebKitFormBoundary9JtEhEGHSdx8Patg

Content-Disposition: form-data  name="acl"

public-read

------WebKitFormBoundary9JtEhEGHSdx8Patg

Content-Disposition: form-data  name="Cache-Control"

max-age=86400

------WebKitFormBoundary9JtEhEGHSdx8Patg

Content-Disposition: form-data  name="Content-Disposition"

attachment  filename=example.jpg

------WebKitFormBoundary9JtEhEGHSdx8Patg

Content-Disposition: form-data  name="Content-Type"

;

;

;

;

;

;

;
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image/jpeg

------WebKitFormBoundary9JtEhEGHSdx8Patg

Content-Disposition: form-data  name="x-cos-meta-example-field"

example-value

------WebKitFormBoundary9JtEhEGHSdx8Patg

Content-Disposition: form-data  name="Content-MD5"

7o3pGNBWQBRbGPcPTDqmAg==

------WebKitFormBoundary9JtEhEGHSdx8Patg

Content-Disposition: form-data  name="policy"

eyJjb25kaXRpb25zIjpbeyJhY2wiOiJwdWJsaWMtcmVhZCJ9LHsiYnVja2V0IjoiZXhhbXBsZWJ1Y

------WebKitFormBoundary9JtEhEGHSdx8Patg

Content-Disposition: form-data  name="q-sign-algorithm"

sha1

------WebKitFormBoundary9JtEhEGHSdx8Patg

Content-Disposition: form-data  name="q-ak"

AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****

------WebKitFormBoundary9JtEhEGHSdx8Patg

Content-Disposition: form-data  name="q-key-time"

1567064374 1567071574

------WebKitFormBoundary9JtEhEGHSdx8Patg

Content-Disposition: form-data  name="q-signature"

228a89b5f7b8fce7fdfa4a3b36cfb5a5eafb****

------WebKitFormBoundary9JtEhEGHSdx8Patg

Content-Disposition: form-data  name="file"  filename="example.jpg"

Content-Type: image/jpeg

Object Content

------WebKitFormBoundary9JtEhEGHSdx8Patg--

;

;

;

;

;

;

;

;

; ;

[ ]

响应

HTTP/1.1 204 

Content-Length: 0

Connection: close

Date: Thu, 29 Aug 2019 07:39:35 GMT



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第347 共1701页

ETag: "ee8de918d05640145b18f70f4c3aa602"

Location: http://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleobject

Server: tencent-cos

x-cos-request-id: NWQ2NzgxMzdfM2NhZjJhMDlfMTQzYV84Nzhh****

案例三：使用服务端加密 SSE-COS

请求

POST / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 29 Aug 2019 07:39:35 GMT

Content-Type: multipart/form-data  boundary=----WebKitFormBoundaryBVaHvBJQJnQrAxKY

Content-Length: 1296

Connection: close

------WebKitFormBoundaryBVaHvBJQJnQrAxKY

Content-Disposition: form-data  name="key"

exampleobject

------WebKitFormBoundaryBVaHvBJQJnQrAxKY

Content-Disposition: form-data  name="x-cos-server-side-encryption"

AES256

------WebKitFormBoundaryBVaHvBJQJnQrAxKY

Content-Disposition: form-data  name="policy"

eyJjb25kaXRpb25zIjpbeyJ4LWNvcy1zZXJ2ZXItc2lkZS1lbmNyeXB0aW9uIjoiQUVTMjU2In0se

------WebKitFormBoundaryBVaHvBJQJnQrAxKY

Content-Disposition: form-data  name="q-sign-algorithm"

sha1

------WebKitFormBoundaryBVaHvBJQJnQrAxKY

Content-Disposition: form-data  name="q-ak"

AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****

------WebKitFormBoundaryBVaHvBJQJnQrAxKY

Content-Disposition: form-data  name="q-key-time"

1567064375 1567071575

------WebKitFormBoundaryBVaHvBJQJnQrAxKY

Content-Disposition: form-data  name="q-signature"

65f3f8864bb1b271e1235d1ec7d1cb508ffa****

------WebKitFormBoundaryBVaHvBJQJnQrAxKY

;

;

;

;

;

;

;

;

;
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Content-Disposition: form-data  name="file"  filename="example.jpg"

Content-Type: image/jpeg

Object Content

------WebKitFormBoundaryBVaHvBJQJnQrAxKY--

; ;

[ ]

响应

HTTP/1.1 204 

Content-Length: 0

Connection: close

Date: Thu, 29 Aug 2019 07:39:35 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Location: http://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleobject

Server: tencent-cos

x-cos-request-id: NWQ2NzgxMzdfMTljMDJhMDlfNTg4ZF84Njgx****

x-cos-server-side-encryption: AES256

案例四：使用服务端加密 SSE-C

请求

POST / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 29 Aug 2019 07:39:36 GMT

Content-Type: multipart/form-data  boundary=----WebKitFormBoundaryYa6H7Gd4xuhlyfJb

Content-Length: 1667

Connection: close

------WebKitFormBoundaryYa6H7Gd4xuhlyfJb

Content-Disposition: form-data  name="key"

exampleobject

------WebKitFormBoundaryYa6H7Gd4xuhlyfJb

Content-Disposition: form-data  name="x-cos-server-side-encryption-customer-algorithm

AES256

------WebKitFormBoundaryYa6H7Gd4xuhlyfJb

Content-Disposition: form-data  name="x-cos-server-side-encryption-customer-key"

MDEyMzQ1Njc4OUFCQ0RFRjAxMjM0NTY3ODlBQkNERUY=

------WebKitFormBoundaryYa6H7Gd4xuhlyfJb

Content-Disposition: form-data  name="x-cos-server-side-encryption-customer-key-MD5"

;

;

;

;

;
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U5L61r7jcwdNvT7frmUG8g==

------WebKitFormBoundaryYa6H7Gd4xuhlyfJb

Content-Disposition: form-data  name="policy"

eyJjb25kaXRpb25zIjpbeyJ4LWNvcy1zZXJ2ZXItc2lkZS1lbmNyeXB0aW9uLWN1c3RvbWVyLW

------WebKitFormBoundaryYa6H7Gd4xuhlyfJb

Content-Disposition: form-data  name="q-sign-algorithm"

sha1

------WebKitFormBoundaryYa6H7Gd4xuhlyfJb

Content-Disposition: form-data  name="q-ak"

AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****

------WebKitFormBoundaryYa6H7Gd4xuhlyfJb

Content-Disposition: form-data  name="q-key-time"

1567064376 1567071576

------WebKitFormBoundaryYa6H7Gd4xuhlyfJb

Content-Disposition: form-data  name="q-signature"

0273a4b4ede39d0e5162758e145ea0c3e9ef****

------WebKitFormBoundaryYa6H7Gd4xuhlyfJb

Content-Disposition: form-data  name="file"  filename="example.jpg"

Content-Type: image/jpeg

Object Content

------WebKitFormBoundaryYa6H7Gd4xuhlyfJb--

;

;

;

;

;

;

; ;

[ ]

响应

HTTP/1.1 204 

Content-Length: 0

Connection: close

Date: Thu, 29 Aug 2019 07:39:36 GMT

ETag: "582d9105f71525f3c161984bc005efb5"

Location: http://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleobject

Server: tencent-cos

x-cos-request-id: NWQ2NzgxMzhfMzdiMDJhMDlfNDA4YV84MzQx****

x-cos-server-side-encryption-customer-algorithm: AES256

x-cos-server-side-encryption-customer-key-MD5: U5L61r7jcwdNvT7frmUG8g==

案例五：启用版本控制
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请求

POST / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 29 Aug 2019 07:40:07 GMT

Content-Type: multipart/form-data  boundary=----WebKitFormBoundaryJspR3QIUhGJLALwf

Content-Length: 1119

Connection: close

------WebKitFormBoundaryJspR3QIUhGJLALwf

Content-Disposition: form-data  name="key"

exampleobject

------WebKitFormBoundaryJspR3QIUhGJLALwf

Content-Disposition: form-data  name="policy"

eyJjb25kaXRpb25zIjpbeyJxLXNpZ24tYWxnb3JpdGhtIjoic2hhMSJ9LHsicS1hayI6IkFLSUQ4QT

------WebKitFormBoundaryJspR3QIUhGJLALwf

Content-Disposition: form-data  name="q-sign-algorithm"

sha1

------WebKitFormBoundaryJspR3QIUhGJLALwf

Content-Disposition: form-data  name="q-ak"

AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****

------WebKitFormBoundaryJspR3QIUhGJLALwf

Content-Disposition: form-data  name="q-key-time"

1567064407 1567071607

------WebKitFormBoundaryJspR3QIUhGJLALwf

Content-Disposition: form-data  name="q-signature"

699ad0ce7780eb559b75e88f77e95743d829****

------WebKitFormBoundaryJspR3QIUhGJLALwf

Content-Disposition: form-data  name="file"  filename="example.jpg"

Content-Type: image/jpeg

Object Content

------WebKitFormBoundaryJspR3QIUhGJLALwf--

;

;

;

;

;

;

;

;

; ;

[ ]

响应

HTTP/1.1 204 
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Content-Length: 0

Connection: close

Date: Thu, 29 Aug 2019 07:40:07 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Location: http://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleobject

Server: tencent-cos

x-cos-request-id: NWQ2NzgxNTdfNzFiNDBiMDlfMmE3ZmJfODQ1****

x-cos-version-id: MTg0NDUxNzcwMDkzMDE3NDQ0MDU

案例六：暂停版本控制

请求

POST / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 29 Aug 2019 07:40:38 GMT

Content-Type: multipart/form-data  boundary=----WebKitFormBoundaryX8hd2lxTMzIBk5Li

Content-Length: 1119

Connection: close

------WebKitFormBoundaryX8hd2lxTMzIBk5Li

Content-Disposition: form-data  name="key"

exampleobject

------WebKitFormBoundaryX8hd2lxTMzIBk5Li

Content-Disposition: form-data  name="policy"

eyJjb25kaXRpb25zIjpbeyJxLXNpZ24tYWxnb3JpdGhtIjoic2hhMSJ9LHsicS1hayI6IkFLSUQ4QT

------WebKitFormBoundaryX8hd2lxTMzIBk5Li

Content-Disposition: form-data  name="q-sign-algorithm"

sha1

------WebKitFormBoundaryX8hd2lxTMzIBk5Li

Content-Disposition: form-data  name="q-ak"

AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****

------WebKitFormBoundaryX8hd2lxTMzIBk5Li

Content-Disposition: form-data  name="q-key-time"

1567064438 1567071638

------WebKitFormBoundaryX8hd2lxTMzIBk5Li

Content-Disposition: form-data  name="q-signature"

bb04222322bfb17f4d1f43833bbbac0a03aa****

------WebKitFormBoundaryX8hd2lxTMzIBk5Li

;

;

;

;

;

;

;

;
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Content-Disposition: form-data  name="file"  filename="example.jpg"

Content-Type: image/jpeg

Object Content

------WebKitFormBoundaryX8hd2lxTMzIBk5Li--

; ;

[ ]

响应

HTTP/1.1 204 

Content-Length: 0

Connection: close

Date: Thu, 29 Aug 2019 07:40:38 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Location: http://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleobject

Server: tencent-cos

x-cos-request-id: NWQ2NzgxNzZfMjFjOTBiMDlfMWY3YTFfNjY2****

案例七：对象键（表单字段 key）使用 ${filename} 通配符

请求

POST / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 29 Aug 2019 12:35:07 GMT

Content-Type: multipart/form-data  boundary=----WebKitFormBoundaryHrAMWZO4BNyT0

Content-Length: 1188

Connection: close

------WebKitFormBoundaryHrAMWZO4BNyT0rca

Content-Disposition: form-data  name="key"

folder/subfolder/${filename}

------WebKitFormBoundaryHrAMWZO4BNyT0rca

Content-Disposition: form-data  name="policy"

eyJjb25kaXRpb25zIjpbWyJzdGFydHMtd2l0aCIsIiRrZXkiLCJmb2xkZXIvc3ViZm9sZGVyLyJdLH

------WebKitFormBoundaryHrAMWZO4BNyT0rca

Content-Disposition: form-data  name="q-sign-algorithm"

sha1

------WebKitFormBoundaryHrAMWZO4BNyT0rca

Content-Disposition: form-data  name="q-ak"

;

;

;

;

;
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AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****

------WebKitFormBoundaryHrAMWZO4BNyT0rca

Content-Disposition: form-data  name="q-key-time"

1567082107 1567089307

------WebKitFormBoundaryHrAMWZO4BNyT0rca

Content-Disposition: form-data  name="q-signature"

3cc37f8c81e36f57506efa02d0a3b6c9d551****

------WebKitFormBoundaryHrAMWZO4BNyT0rca

Content-Disposition: form-data  name="file"  filename="photo.jpg"

Content-Type: image/jpeg

Object Content

------WebKitFormBoundaryHrAMWZO4BNyT0rca--

;

;

;

; ;

[ ]

响应

HTTP/1.1 204 

Content-Length: 0

Connection: close

Date: Thu, 29 Aug 2019 12:35:08 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Location: http://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/folder/subfolde

Server: tencent-cos

x-cos-request-id: NWQ2N2M2N2NfNWZhZjJhMDlfNmUzMV84OTg4****

案例八：指定 success_action_redirect 表单字段

请求

POST / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 29 Aug 2019 08:02:29 GMT

Content-Type: multipart/form-data  boundary=----WebKitFormBoundaryJ0bRH1MwgMq5eu

Content-Length: 1351

Connection: close

------WebKitFormBoundaryJ0bRH1MwgMq5eu6H

Content-Disposition: form-data  name="key"

exampleobject

------WebKitFormBoundaryJ0bRH1MwgMq5eu6H

;

;
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Content-Disposition: form-data  name="success_action_redirect"

https://my.website/upload_success.html

------WebKitFormBoundaryJ0bRH1MwgMq5eu6H

Content-Disposition: form-data  name="policy"

eyJjb25kaXRpb25zIjpbWyJzdGFydHMtd2l0aCIsIiRzdWNjZXNzX2FjdGlvbl9yZWRpcmVjdCIsIm

------WebKitFormBoundaryJ0bRH1MwgMq5eu6H

Content-Disposition: form-data  name="q-sign-algorithm"

sha1

------WebKitFormBoundaryJ0bRH1MwgMq5eu6H

Content-Disposition: form-data  name="q-ak"

AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****

------WebKitFormBoundaryJ0bRH1MwgMq5eu6H

Content-Disposition: form-data  name="q-key-time"

1567065749 1567072949

------WebKitFormBoundaryJ0bRH1MwgMq5eu6H

Content-Disposition: form-data  name="q-signature"

c4a8ae7411687bc3d6ed2ac9b249e87a50b5****

------WebKitFormBoundaryJ0bRH1MwgMq5eu6H

Content-Disposition: form-data  name="file"  filename="example.jpg"

Content-Type: image/jpeg

Object Content

------WebKitFormBoundaryJ0bRH1MwgMq5eu6H--

;

;

;

;

;

;

;

; ;

[ ]

响应

HTTP/1.1 303 Redirect

Content-Length: 0

Connection: close

Date: Thu, 29 Aug 2019 08:02:29 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Location: https://my.website/upload_success.html?bucket=examplebucket-1250000000&

Server: tencent-cos

x-cos-request-id: NWQ2Nzg2OTVfMTRiYjI0MDlfZGFkOV85MDA4****

案例九：指定 success_action_status 表单字段
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请求

POST / HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 29 Aug 2019 08:04:29 GMT

Content-Type: multipart/form-data  boundary=----WebKitFormBoundaryST9Mz8AGzCDphg

Content-Length: 1270

Connection: close

------WebKitFormBoundaryST9Mz8AGzCDphgJF

Content-Disposition: form-data  name="key"

exampleobject

------WebKitFormBoundaryST9Mz8AGzCDphgJF

Content-Disposition: form-data  name="success_action_status"

200

------WebKitFormBoundaryST9Mz8AGzCDphgJF

Content-Disposition: form-data  name="policy"

eyJjb25kaXRpb25zIjpbeyJzdWNjZXNzX2FjdGlvbl9zdGF0dXMiOiIyMDAifSx7InEtc2lnbi1hbGd

------WebKitFormBoundaryST9Mz8AGzCDphgJF

Content-Disposition: form-data  name="q-sign-algorithm"

sha1

------WebKitFormBoundaryST9Mz8AGzCDphgJF

Content-Disposition: form-data  name="q-ak"

AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****

------WebKitFormBoundaryST9Mz8AGzCDphgJF

Content-Disposition: form-data  name="q-key-time"

1567065869 1567073069

------WebKitFormBoundaryST9Mz8AGzCDphgJF

Content-Disposition: form-data  name="q-signature"

e46285af04d4fb68e0624fdd0a525b6a07ab****

------WebKitFormBoundaryST9Mz8AGzCDphgJF

Content-Disposition: form-data  name="file"  filename="example.jpg"

Content-Type: image/jpeg

Object Content

------WebKitFormBoundaryST9Mz8AGzCDphgJF--

;

;

;

;

;

;

;

;

;

; ;

[ ]
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响应

HTTP/1.1 200 

Content-Length: 0

Connection: close

Date: Thu, 29 Aug 2019 08:04:29 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Location: http://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleobject

Server: tencent-cos

x-cos-request-id: NWQ2Nzg3MGRfZjhjODBiMDlfOGM3N184Nzdl****
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GET Object
最近更新时间：2023-07-24 09:55:13

GET Object 接口请求可以将 COS 存储桶中的对象（Object）下载至本地。该 API 的请求者需要对目标对象有

读取权限，或者目标对象向所有人开放了读取权限（公有读）。

当启用版本控制时，该 GET 操作可以使用 versionId 请求参数指定要返回的版本 ID，此时将返回对象的指定版

本。若指定版本为删除标记，则返回 HTTP 响应码404（Not Found），否则将返回指定对象的最新版本。

如果该 GET 请求操作的对象为归档存储和深度归档存储类型，且没有使用 POST Object restore  进行恢复

（或恢复后的副本已被过期删除），那么该请求将返回 HTTP 响应码403（Forbidden），同时在响应体中包含

错误信息，其中错误码（Code）为 InvalidObjectState，表示对象的当前状态无法被 GET 请求操作，需要先

经过恢复。

功能描述

注意

如果使用了 response-*  请求参数，那么该请求操作不支持匿名请求，必须携带签名。

当通过 COS 控制台 设置回源  ，但未开启同步回源时，需注意，COS 从用户配置的源站拉取数据

时，发起 GET Object 请求将返回 302 并重定向到设置的回源地址（如果该回源地址是不受信任的，

强烈建议在使用 SDK 或自行调用 API 时，不要直接跟随 302，而应该由业务后端验证回源地址的合

法性后再去请求回源地址，否则可能产生 SSRF 等安全风险，例如回源到一个内网地址）。

版本控制

归档类型

请求

请求示例

GET /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/436/13310
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
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概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

名称 描述
类

型

是否

必选

response-cache-

control
设置响应中的 Cache-Control 头部的值

st

ri

n

g

否

response-

content-

disposition

设置响应中的 Content-Disposition 头部的值

st

ri

n

g

否

response-

content-encoding
设置响应中的 Content-Encoding 头部的值

st

ri

n

g

否

response-

content-language
设置响应中的 Content-Language 头部的值

st

ri

n

g

否

response-

content-type
设置响应中的 Content-Type 头部的值

st

ri

n

g

否

response-expires 设置响应中的 Expires 头部的值

st

ri

n

g

否

versionId
当启用版本控制时，指定要下载的版本 ID，如不指定则下载

对象的最新版本

st

ri

n

g

否

请求头

https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口除使用公共请求头部外，还支持以下请求头部，了解公共请求头部详情请参见 公共请求头部  文档。

服务端加密相关头部

如果指定的对象使用了服务端加密且加密方式为 SSE-C 时，则需要指定服务端加密的相关头部来解密对象，请参

见 服务端加密专用头部 。

此接口无请求体。

此接口除返回公共响应头部外，还返回以下响应头部，了解公共响应头部详情请参见 公共响应头部  文档。

名称                            描述 类型

是

否

必

选

Range

RFC 2616 中定义的字节范围，范围值必须使用 bytes=first-last 

格式且仅支持单一范围，不支持多重范围。first 和 last 都是基于0开

始的偏移量。

例如 bytes=0-9，表示下载对象的开头10个字节的数据；bytes=5-

9，表示下载对象的第6到第10个字节。此时返回 HTTP 状态码206

（Partial Content）及 Content-Range 响应头部。

如果 first 超过对象的大小，则返回 HTTP 状态码416（Requested 

Range Not Satisfiable）错误。如果不指定，则表示下载整个对象

stri

ng
否

If-

Modified-

Since

当对象在指定时间后被修改，则返回对象，否则返回 HTTP 状态码为

304（Not Modified）

stri

ng
否

If-

Unmodifie

d-Since

当对象在指定时间后未被修改，则返回对象，否则返回 HTTP 状态码

为412（Precondition Failed）

stri

ng
否

If-Match
当对象的 ETag 与指定的值一致，则返回对象，否则返回 HTTP 状态

码为412（Precondition Failed）

stri

ng
否

If-None-

Match

当对象的 ETag 与指定的值不一致，则返回对象，否则返回 HTTP 状

态码为304（Not Modified）

stri

ng
否

x-cos-

traffic-

limit

针对本次下载进行流量控制的限速值，必须为数字，单位默认为 

bit/s。限速值设置范围为819200 - 838860800，即800Kb/s - 

800Mb/s，如果超出该范围将返回400错误

inte

ger
否

请求体

响应

响应头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7728#.E6.9C.8D.E5.8A.A1.E7.AB.AF.E5.8A.A0.E5.AF.86.E4.B8.93.E7.94.A8.E5.A4.B4.E9.83.A8
https://cloud.tencent.com/document/product/436/7729
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版本控制相关头部

启用版本控制的存储桶内的对象将返回下列响应头部：

服务端加密相关头部

如果指定的对象使用了服务端加密，则此接口将返回服务端加密专用头部，请参见 服务端加密专用头部 。

此接口请求的响应体为对象（文件）内容。

名称                          描述 类型

Cache-

Control

RFC 2616 中定义的缓存指令，仅当对象元数据包含此项或通过请求参数指定了

此项时才会返回该头部

stri

ng

Content-

Dispositio

n

RFC 2616 中定义的文件名称，仅当对象元数据包含此项或通过请求参数指定了

此项时才会返回该头部

stri

ng

Content-

Encoding

RFC 2616 中定义的编码格式，仅当对象元数据包含此项或通过请求参数指定了

此项时才会返回该头部

stri

ng

Content-

Range

RFC 2616 中定义的返回内容的字节范围，仅当请求中指定了 Range 请求头部

时才会返回该头部

stri

ng

Expires
RFC 2616 中定义的缓存失效时间，仅当对象元数据包含此项或通过请求参数指

定了此项时才会返回该头部

stri

ng

x-cos-

meta-*
包括用户自定义元数据头部后缀和用户自定义元数据信息

stri

ng

x-cos-

storage-

class

对象存储类型，枚举值请参见 存储类型  文档，例如 MAZ_STANDARD、

MAZ_STANDARD_IA、INTELLIGENT_TIERING、

MAZ_INTELLIGENT_TIERING、STANDARD_IA、ARCHIVE、

DEEP_ARCHIVE。仅当对象不是标准存储（STANDARD）时才会返回该头

部

enu

m

x-cos-

storage-

tier

当对象的存储类型为智能分层存储时，该头部表示对象所处的存储层，有效值：

FREQUENT、INFREQUENT。

enu

m

名称 描述 类型

x-cos-version-id 对象的版本 ID string

响应体

错误码

https://cloud.tencent.com/document/product/436/7729#.E6.9C.8D.E5.8A.A1.E7.AB.AF.E5.8A.A0.E5.AF.86.E4.B8.93.E7.94.A8.E5.A4.B4.E9.83.A8
https://cloud.tencent.com/document/product/436/33417
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

实际案例

案例一：简单案例（未启用版本控制）

请求

GET /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 09:35:16 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 16

Connection: close

Accept-Ranges: bytes

Date: Fri, 10 Apr 2020 09:35:16 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Last-Modified: Fri, 10 Apr 2020 09:35:05 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MDNkZDRfZDgyNzVkNjRfN2Q5M18xOWVi****

Object Content[ ]

案例二：通过请求参数指定响应头部

请求

GET /exampleobject?response-content-type=application%2Foctet-stream&response-cach

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 09:35:17 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

https://cloud.tencent.com/document/product/436/7730
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HTTP/1.1 200 OK

Content-Type: application/octet-stream

Content-Length: 16

Connection: close

Accept-Ranges: bytes

Cache-Control: max-age=86400

Content-Disposition: attachment  filename=example.jpg

Date: Fri, 10 Apr 2020 09:35:17 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Last-Modified: Fri, 10 Apr 2020 09:35:05 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MDNkZDVfNjZjODJhMDlfMTY2MDdfMThm****

Object Content

;

[ ]

案例三：通过请求头指定查询条件并返回 HTTP 状态码为304（Not Modified）

请求

GET /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 29 Jul 2020 06:51:49 GMT

If-None-Match: "ee8de918d05640145b18f70f4c3aa602"

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 304 Not Modified

Content-Type: image/jpeg

Content-Length: 0

Connection: close

Date: Wed, 29 Jul 2020 06:51:49 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWYyMTFjODVfOGZiNzJhMDlfNDcxZjZfZDY2****

案例四：通过请求头指定查询条件并返回 HTTP 状态码为412（Precondition Failed）
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请求

GET /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 29 Jul 2020 06:51:50 GMT

If-Match: "aa488bb80185a6be87f4a7b936a80752"

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 412 Precondition Failed

Content-Type: application/xml

Content-Length: 480

Connection: close

Date: Wed, 29 Jul 2020 06:51:50 GMT

Server: tencent-cos

x-cos-request-id: NWYyMTFjODZfOGRjOTJhMDlfMmIyMWVfOTJl****

<?xml version='1.0' encoding='utf-8' ?>

<Error>

            <Code>PreconditionFailed</Code>

            <Message>Precondition not match.</Message>

            <Resource>examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleo

            <RequestId>NWYyMTFjODZfOGRjOTJhMDlfMmIyMWVfOTJl****</RequestId>

            <TraceId>OGVmYzZiMmQzYjA2OWNhODk0NTRkMTBiOWVmMDAxODc0OWRkZjk0

</Error>

案例五：使用服务端加密 SSE-COS

请求

GET /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 09:36:00 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应
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HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 16

Connection: close

Accept-Ranges: bytes

Date: Fri, 10 Apr 2020 09:36:00 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Last-Modified: Fri, 10 Apr 2020 09:35:49 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MDNlMDBfMzdiMDJhMDlfYTgyNl8xNjA2****

x-cos-server-side-encryption: AES256

Object Content[ ]

案例六：使用服务端加密 SSE-KMS

请求

GET /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 09:36:11 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 16

Connection: close

Accept-Ranges: bytes

Date: Fri, 10 Apr 2020 09:36:11 GMT

ETag: "840af7c921f4b3230049af8663145bd0"

Last-Modified: Fri, 10 Apr 2020 09:36:01 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MDNlMGJfZGEyNzVkNjRfZDgxY18xYTBj****

x-cos-server-side-encryption: cos/kms

x-cos-server-side-encryption-cos-kms-key-id: 48ba38aa-26c5-11ea-855c-52540085****
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Object Content[ ]

案例七：使用服务端加密 SSE-C

请求

GET /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 09:36:23 GMT

x-cos-server-side-encryption-customer-algorithm: AES256

x-cos-server-side-encryption-customer-key: MDEyMzQ1Njc4OUFCQ0RFRjAxMjM0NTY3ODlB

x-cos-server-side-encryption-customer-key-MD5: U5L61r7jcwdNvT7frmUG8g==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 16

Connection: close

Accept-Ranges: bytes

Date: Fri, 10 Apr 2020 09:36:23 GMT

ETag: "582d9105f71525f3c161984bc005efb5"

Last-Modified: Fri, 10 Apr 2020 09:36:12 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MDNlMTdfNzBiODJhMDlfZTVmMV8xNDAy****

x-cos-server-side-encryption-customer-algorithm: AES256

x-cos-server-side-encryption-customer-key-MD5: U5L61r7jcwdNvT7frmUG8g==

Object Content[ ]

案例八：下载对象最新版本（启用版本控制）

请求

GET /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com
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Date: Fri, 10 Apr 2020 12:30:02 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 26

Connection: close

Accept-Ranges: bytes

Date: Fri, 10 Apr 2020 12:30:02 GMT

ETag: "22e024392de860289f0baa7d6cf8a549"

Last-Modified: Fri, 10 Apr 2020 12:29:52 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 11596229263574363878

x-cos-request-id: NWU5MDY2Y2FfMzFiYjBiMDlfMjE2NzVfMTgz****

x-cos-version-id: MTg0NDUxNTc1NTE5MTc1NjM4MDA

Object Content Version 2[ ]

案例九：下载对象指定版本（启用版本控制）

请求

GET /exampleobject?versionId=MTg0NDUxNTc1NjIzMTQ1MDAwODg HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 09:36:45 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 16

Connection: close

Accept-Ranges: bytes

Date: Fri, 10 Apr 2020 09:36:45 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Last-Modified: Fri, 10 Apr 2020 09:36:35 GMT
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Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MDNlMmRfNzBiODJhMDlfZTYwZl8xM2Fh****

x-cos-version-id: MTg0NDUxNTc1NjIzMTQ1MDAwODg

Object Content[ ]

案例十：指定 Range 请求头部下载部分内容

请求

GET /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 12:32:37 GMT

Range: bytes=8-14

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 206 Partial Content

Content-Type: image/jpeg

Content-Length: 7

Connection: close

Accept-Ranges: bytes

Content-Range: bytes 8-14/16

Date: Fri, 10 Apr 2020 12:32:37 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Last-Modified: Fri, 10 Apr 2020 12:32:25 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MDY3NjVfY2VjODJhMDlfOWVlZl8xNmMy****

Content

案例十一：下载未经恢复的归档（ARCHIVE）存储类型的对象

请求
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GET /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 26 Dec 2019 11:57:24 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 403 Forbidden

Content-Type: application/xml

Content-Length: 513

Connection: close

Date: Thu, 26 Dec 2019 11:57:24 GMT

Server: tencent-cos

x-cos-request-id: NWUwNGEwMjRfZDcyNzVkNjRfNjZlM183Zjcx****

x-cos-storage-class: ARCHIVE

<?xml version='1.0' encoding='utf-8' ?>

<Error>

            <Code>InvalidObjectState</Code>

            <Message>The operation is not valid for the object storage class.</Message>

            <Resource>examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleo

            <RequestId>NWUwNGEwMjRfZDcyNzVkNjRfNjZlM183Zjcx****</RequestId>

            <TraceId>OGVmYzZiMmQzYjA2OWNhODk0NTRkMTBiOWVmMDAxODc0OWRkZjk0

</Error>
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HEAD Object
最近更新时间：2021-11-19 17:20:36

HEAD Object 接口请求可以判断指定对象是否存在和有权限，并在指定对象可访问时获取其元数据。该 API 的请

求者需要对目标对象有读取权限，或者目标对象向所有人开放了读取权限（公有读）。

当启用版本控制时，该 HEAD 操作可以使用 versionId 请求参数指定要返回的版本 ID，此时将返回指定版本的元

数据，如指定版本为删除标记则返回 HTTP 响应码404（Not Found），否则将返回最新版本的元数据。

此接口除使用公共请求头部外，还支持以下请求头部，了解公共请求头部详情请参见 公共请求头部  文档。

功能描述

版本控制

请求

请求示例

HEAD /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

名称 描述 类型
是否必
选

versionI

d

当启用版本控制时，指定要查询的版本 ID，如不指定则查询对象的最

新版本

strin

g
否

请求头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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服务端加密相关头部

如果指定的对象使用了服务端加密且加密方式为 SSE-C 时，则需要指定服务端加密的相关头部来解密对象，请参

见 服务端加密专用头部 。

此接口无请求体。

此接口除返回公共响应头部外，还返回以下响应头部，了解公共响应头部详情请参见 公共响应头部  文档。

名称                           描述 类
型

是
否

必
选

If-

Modified-
Since

当对象在指定时间后被修改，则返回 HTTP 状态码为200（OK），否则

返回 HTTP 状态码为304（Not Modified）

st
ri

n
g

否

If-

Unmodifie
d-Since

当对象在指定时间后未被修改，则返回 HTTP 状态码为200（OK），否
则返回 HTTP 状态码为412（Precondition Failed）

st

ri
n

g

否

If-Match
当对象的 ETag 与指定的值一致，则返回 HTTP 状态码为200
（OK），否则返回 HTTP 状态码为412（Precondition Failed）

st

ri
n

g

否

If-None-

Match

当对象的 ETag 与指定的值不一致，则返回 HTTP 状态码为200

（OK），否则返回 HTTP 状态码为304（Not Modified）

st
ri

n
g

否

请求体

响应

响应头

名称                         描述 类型

Cach

e-
Contr

ol

RFC 2616 中定义的缓存指令，仅当对象元数据包含此项时才会返回该头部
strin
g

Conte RFC 2616 中定义的文件名称，仅当对象元数据包含此项时才会返回该头部 strin

https://cloud.tencent.com/document/product/436/7728#.E6.9C.8D.E5.8A.A1.E7.AB.AF.E5.8A.A0.E5.AF.86.E4.B8.93.E7.94.A8.E5.A4.B4.E9.83.A8
https://cloud.tencent.com/document/product/436/7729
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当对象为归档类型且使用 POST Object restore 请求进行恢复操作时，该 HEAD 请求将返回下列响应头部：

nt-

Dispo
sition

g

Conte

nt-

Enco
ding

RFC 2616 中定义的编码格式，仅当对象元数据包含此项时才会返回该头部
strin

g

Expir

es
RFC 2616 中定义的缓存失效时间，仅当对象元数据包含此项时才会返回该头部

strin

g

x-
cos-

meta
-*

包括用户自定义元数据头部后缀和用户自定义元数据信息
strin

g

x-
cos-

stora
ge-

class

对象存储类型，枚举值请参见 存储类型  文档，例如 MAZ_STANDARD，

MAZ_STANDARD_IA，INTELLIGENT_TIERING，
MAZ_INTELLIGENT_TIERING，STANDARD_IA，ARCHIVE，

DEEP_ARCHIVE。仅当对象不是标准存储（STANDARD）时才会返回该头部

enu
m

x-
cos-

stora
ge-

tier

当对象的存储类型为智能分层存储时，该头部表示对象所处的存储层，有效值：

FREQUENT、INFREQUENT。

enu

m

归档类型对象相关头部

名称                          描述
类

型

x-
cos-

restor
e

指示当前恢复操作的状态：

当恢复操作正在进行中时，该响应头部的值为 ongoing-request="true"

当对象已经恢复时，该响应头部包含 COS 即将删除临时副本的时间，例如

ongoing-request="false", expiry-date="Tue, 19 Nov 2019 16:00:00 GMT"

s
tr

in
g

x-

cos-
restor

e-
status

当恢复操作正在进行中时返回该响应头部，指示当前的恢复模式和恢复操作请求时间，例

如 tier="bulk"; request-date="Mon, 18 Nov 2019 09:34:50 GMT" ，有关恢复模

式请参见 POST Object restore

s

tr
in

g

https://cloud.tencent.com/document/product/436/33417
https://cloud.tencent.com/document/product/436/12633#.E8.AF.B7.E6.B1.82
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版本控制相关头部

启用版本控制的存储桶内的对象将返回下列响应头部：

服务端加密相关头部

如果指定的对象使用了服务端加密，则此接口将返回服务端加密专用头部，请参见 服务端加密专用头部 。

此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

名称 描述 类型

x-cos-version-id 对象的版本 ID string

响应体

错误码

实际案例

案例一：简单案例（未启用版本控制）

请求

HEAD /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 18:17:36 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 16

Connection: close

Date: Fri, 10 Apr 2020 18:17:36 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Last-Modified: Fri, 10 Apr 2020 18:17:25 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MGI4NDBfNjFjODJhMDlfMzY2NjVfMjNi****

案例二：通过请求头指定查询条件并返回 HTTP 状态码为304（Not Modified）

https://cloud.tencent.com/document/product/436/7729#.E6.9C.8D.E5.8A.A1.E7.AB.AF.E5.8A.A0.E5.AF.86.E4.B8.93.E7.94.A8.E5.A4.B4.E9.83.A8
https://cloud.tencent.com/document/product/436/7730
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请求

HEAD /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 29 Jul 2020 06:51:49 GMT

If-None-Match: "ee8de918d05640145b18f70f4c3aa602"

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 304 Not Modified

Content-Type: application/xml

Content-Length: 0

Connection: close

Date: Wed, 29 Jul 2020 06:51:49 GMT

Server: tencent-cos

x-cos-request-id: NWYyMTFjODVfZDNjODJhMDlfMWU1MWVfOTUy****

x-cos-trace-id: OGVmYzZiMmQzYjA2OWNhODk0NTRkMTBiOWVmMDAxODczNTBmNjMwZm

案例三：通过请求头指定查询条件并返回 HTTP 状态码为412（Precondition Failed）

请求

HEAD /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 29 Jul 2020 06:51:50 GMT

If-Match: "aa488bb80185a6be87f4a7b936a80752"

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 412 Precondition Failed

Content-Type: application/xml

Content-Length: 0

Connection: close

Date: Wed, 29 Jul 2020 06:51:50 GMT

Server: tencent-cos

x-cos-request-id: NWYyMTFjODZfMzBjMDJhMDlfMmU3ZF9kYTE4****

x-cos-trace-id: OGVmYzZiMmQzYjA2OWNhODk0NTRkMTBiOWVmMDAxODczNTBmNjMwZm
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案例四：使用服务端加密 SSE-COS

请求

HEAD /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 18:18:19 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 16

Connection: close

Date: Fri, 10 Apr 2020 18:18:19 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Last-Modified: Fri, 10 Apr 2020 18:18:08 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MGI4NmJfNmRjMDJhMDlfZGQwNl8xZmE4****

x-cos-server-side-encryption: AES256

案例五：使用服务端加密 SSE-KMS

请求

HEAD /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 18:18:30 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 16

Connection: close

Date: Fri, 10 Apr 2020 18:18:30 GMT

ETag: "00ca268468481b847fc2d8a9bd84578d"
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Last-Modified: Fri, 10 Apr 2020 18:18:19 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MGI4NzZfN2FjODJhMDlfMjU3N18xYTEz****

x-cos-server-side-encryption: cos/kms

x-cos-server-side-encryption-cos-kms-key-id: 48ba38aa-26c5-11ea-855c-52540085****

案例六：使用服务端加密 SSE-C

请求

HEAD /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 18:18:41 GMT

x-cos-server-side-encryption-customer-algorithm: AES256

x-cos-server-side-encryption-customer-key: MDEyMzQ1Njc4OUFCQ0RFRjAxMjM0NTY3ODlB

x-cos-server-side-encryption-customer-key-MD5: U5L61r7jcwdNvT7frmUG****

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 16

Connection: close

Date: Fri, 10 Apr 2020 18:18:41 GMT

ETag: "582d9105f71525f3c161984bc005efb5"

Last-Modified: Fri, 10 Apr 2020 18:18:31 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MGI4ODFfN2NiODJhMDlfMmFmYTVfMWRh****

x-cos-server-side-encryption-customer-algorithm: AES256

x-cos-server-side-encryption-customer-key-MD5: U5L61r7jcwdNvT7frmUG****

案例七：请求对象最新版本（启用版本控制）

请求

HEAD /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 18:19:15 GMT
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Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 26

Connection: close

Date: Fri, 10 Apr 2020 18:19:15 GMT

ETag: "22e024392de860289f0baa7d6cf8a549"

Last-Modified: Fri, 10 Apr 2020 18:19:04 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 11596229263574363878

x-cos-request-id: NWU5MGI4YTNfZDZjODJhMDlfYmU0MV8xM2Y5****

x-cos-version-id: MTg0NDUxNTc1MzA5NjQ2ODI5MTg

案例八：请求对象指定版本（启用版本控制）

请求

HEAD /exampleobject?versionId=MTg0NDUxNTc1MzA5NzU4ODg1Mjg HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 18:19:04 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 16

Connection: close

Date: Fri, 10 Apr 2020 18:19:04 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Last-Modified: Fri, 10 Apr 2020 18:18:53 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MGI4OThfN2RiNDBiMDlfMTk1MTBfMWZj****

x-cos-version-id: MTg0NDUxNTc1MzA5NzU4ODg1Mjg

案例九：归档存储正在恢复中
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请求

HEAD /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 27 Dec 2019 08:19:35 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 13

Connection: close

Date: Fri, 27 Dec 2019 08:19:35 GMT

ETag: "b62e10bcab55a88240bd9c436cffdcf9"

Last-Modified: Fri, 27 Dec 2019 08:19:23 GMT

Server: tencent-cos

x-cos-request-id: NWUwNWJlOTdfN2VjODJhMDlfOGI1N18yYjYz****

x-cos-restore: ongoing-request="true"

x-cos-restore-status: tier="expedited"  request-date="Fri, 27 Dec 2019 08:19:29 GMT"

x-cos-storage-class: ARCHIVE

;

案例十：归档存储已恢复

请求

HEAD /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 02 Jan 2020 18:09:51 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 16

Connection: close

Date: Fri, 10 Apr 2020 18:17:36 GMT

ETag: "ee8de918d05640145b18f70f4c3aa602"

Last-Modified: Fri, 10 Apr 2020 18:17:25 GMT
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Server: tencent-cos

x-cos-hash-crc64ecma: 16749565679157681890

x-cos-request-id: NWU5MWRiZjFfMmViMDJhMDlfNjIwOF8zNTU0****

x-cos-restore: ongoing-request="false", expiry-date="Mon, 13 Apr 2020 16:00:00 GMT"

x-cos-storage-class: ARCHIVE
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DELETE Object
最近更新时间：2021-07-22 10:18:48

DELETE Object 接口请求可以删除一个指定的对象（Object）。该 API 的请求者需要对存储桶有写入权限。

如需删除对象的指定版本（包括删除标记，下同），请使用 versionId 请求参数指定对应的版本 ID （包括删除标

记的版本 ID，下同），此时响应将返回 x-cos-version-id 响应头部，代表该请求操作删除的版本 ID。

如未指定 versionId 请求参数：

当该 DELETE 操作创建或删除标记，那么将返回 x-cos-delete-marker: true 响应头部，代表该 DELETE 

操作创建或删除了指定对象的删除标记。

有关版本控制的启用或暂停状态说明，请参见 版本控制概述 。

功能描述

版本控制

当版本控制为启用时，该 DELETE 操作将创建一个删除标记作为指定对象的最新版本，此时响应将返回 x-

cos-version-id 响应头部，代表该请求操作创建的删除标记的版本 ID。

当版本控制为暂停时，该 DELETE 操作将创建一个版本 ID 为 null 的删除标记作为指定对象的最新版本，同时

删除任何已存在的版本 ID 为 null 的其他版本（如有）。

请求

请求示例

DELETE /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

名称 描述 类型 是否必选

https://cloud.tencent.com/document/product/436/19883
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口除返回公共响应头部外，还返回以下响应头部，了解公共响应头部详情请参见 公共响应头部  文档。

版本控制相关头部

删除启用版本控制的存储桶内的对象或对象的指定版本将返回下列响应头部：

此响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

versionId 指定要删除的版本 ID string 否

请求头

请求体

响应

响应头

名称 描述
类
型

x-cos-

version-
id

对象的版本 ID 或删除标记的版本 ID

st
ri

n
g

x-cos-
delete-

marker

当使用 versionId 请求参数指定删除标记的版本 ID 时，将返回此响应头部且值

为 true，代表删除的版本 ID 对应的是一个删除标记

当未使用 versionId 请求参数，且指定对象所在的存储桶启用了版本控制时，将

返回此响应头部且值为 true，代表该删除请求创建了一个删除标记作为对象的最
新版本

b

o
ol

e
a

n

响应体

错误码

实际案例

案例一：未启用版本控制

请求

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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DELETE /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 14 Aug 2019 11:59:40 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 204 No Content

Content-Length: 0

Connection: close

Date: Wed, 14 Aug 2019 11:59:40 GMT

Server: tencent-cos

x-cos-request-id: NWQ1M2Y3YWNfMzdiMDJhMDlfODA1Yl8xZThj****

案例二：启用版本控制（创建删除标记）

请求

DELETE /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 14 Aug 2019 12:00:21 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 204 No Content

Content-Length: 0

Connection: close

Date: Wed, 14 Aug 2019 12:00:21 GMT

Server: tencent-cos

x-cos-delete-marker: true

x-cos-request-id: NWQ1M2Y3ZDVfN2RiNDBiMDlfMmMwNmVfMTc4****

x-cos-version-id: MTg0NDUxNzgyODk2ODc1NjY0NzQ

案例三：永久删除指定版本

请求

DELETE /exampleobject?versionId=MTg0NDUxNzgyODk3MDgyMzI4NDY HTTP/1.1
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Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 14 Aug 2019 12:00:32 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 204 No Content

Content-Length: 0

Connection: close

Date: Wed, 14 Aug 2019 12:00:32 GMT

Server: tencent-cos

x-cos-request-id: NWQ1M2Y3ZTBfODhjMjJhMDlfMWNkOF8xZDZi****

x-cos-version-id: MTg0NDUxNzgyODk3MDgyMzI4NDY

案例四：永久删除指定删除标记

请求

DELETE /exampleobject?versionId=MTg0NDUxNzgyODk2ODc1NjY0NzQ HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 14 Aug 2019 12:00:42 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 204 No Content

Content-Length: 0

Connection: close

Date: Wed, 14 Aug 2019 12:00:42 GMT

Server: tencent-cos

x-cos-delete-marker: true

x-cos-request-id: NWQ1M2Y3ZWFfNzljMDBiMDlfMjkyMDJfMWRjNjVm****

x-cos-version-id: MTg0NDUxNzgyODk2ODc1NjY0NzQ
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DELETE Multiple Objects
最近更新时间：2021-07-22 10:19:25

DELETE Multiple Objects 接口请求可以批量删除指定存储桶中的多个对象（Object），单次请求支持最多删

除1000个对象。对于响应结果，COS 提供 Quiet 模式和 Verbose 模式：

该 API 的请求者需要对存储桶有写入权限。

当启用版本控制时，该请求操作可以为每一个要删除的对象指定版本 ID，此时将永久删除对象的指定版本或指定删

除标记，否则将创建一个删除标记作为指定对象的最新版本。

当针对某个对象的删除操作创建或删除了删除标记，那么该对象的删除结果将同时返回 

<DeleteMarker>true</DeleteMarker> 和 <DeleteMarkerVersionId> 元素，代表该请求操作创建或删

除了指定对象的删除标记。

当针对某个对象的删除操作永久删除了特定的版本 ID（包括删除标记的版本 ID），那么该对象的删除结果将返回 

<VersionId> 元素，代表该请求操作删除的版本 ID。

功能描述

Quiet 模式在响应中仅包含删除失败的对象信息和错误信息。

Verbose 模式在响应中包含每个对象的删除结果信息。

版本控制

请求

请求示例

POST /?delete HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-Type: application/xml

Content-Length: Content Length

Content-MD5: MD5

Authorization: Auth String

[Request Body]

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
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此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

提交 application/xml 请求数据，包含要删除的对象信息。

具体的节点描述如下：

Container 节点 Delete 的内容：

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

请求体

<Delete>

    <Quiet>boolean</Quiet>

    <Object>

        <Key>string</Key>

    </Object>

    <Object>

        <Key>string</Key>

        <VersionId>string</VersionId>

    </Object>

</Delete>

节点名称（关键
字）

父节
点

描述 类型
是否必
选

Delete 无
包含 DELETE Multiple Objects 操作的所有
请求信息

Contain
er

是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Quiet
Del

ete

布尔值，默认为 false 
true 为使用 Quiet 模式，在响应中仅包含删除失败

的对象信息和错误信息

false 为使用 Verbose 模式，在响应中包含每个对

象的删除结果

boole

an
是

Object Del 单个要删除的目标对象的信息 Conta 是

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
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Container 节点 Object 的内容：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

请求成功，返回 application/xml 数据，包含删除结果信息。

ete iner

节点名称
（关键

字）

父节
点

描述
类
型

是

否
必

选

Key                          

Del
ete.

Obj

ect

要删除的目标对象的对象键

st
ri

n

g

是

Version

Id

Del
ete.

Obj
ect

当启用版本控制并且要删除对象的指定版本时需指定该元素，值为

要删除的版本 ID。若未开启版本控制或开启版本控制但需要插入删
除标记，则无需指定该元素

st
ri

n
g

是

响应

响应头

响应体

<DeleteResult>

    <Deleted>

        <Key>string</Key>

        <DeleteMarker>boolean</DeleteMarker>

        <DeleteMarkerVersionId>string</DeleteMarkerVersionId>

    </Deleted>

    <Deleted>

        <Key>string</Key>

        <VersionId>string</VersionId>

    </Deleted>

    <Deleted>

        <Key>string</Key>

        <DeleteMarker>boolean</DeleteMarker>

        <DeleteMarkerVersionId>string</DeleteMarkerVersionId>

        <VersionId>string</VersionId>

    </Deleted>

    <Error>

https://cloud.tencent.com/document/product/436/7729
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具体的节点描述如下：

Container 节点 DeleteResult 的内容：

Container 节点 Deleted 的内容：

        <Key>string</Key>

        <VersionId>string</VersionId>

        <Code>string</Code>

        <Message>string</Message>

    </Error>

</DeleteResult>

节点名称（关键字） 父节点 描述 类型

DeleteResult 无 保存 DELETE Multiple Objects 结果的所有信息 Container

节点名称（关键

字）
父节点 描述 类型

Deleted
DeleteRe
sult

单个删除成功的对象条目，仅当使用 Verbose 模式才
会返回该元素

Contai
ner

Error
DeleteRe
sult

单个删除失败的对象条目
Contai
ner

节点名称

（关键
字）

父节点 描述
类

型

Key

DeleteR

esult.Del
eted

删除成功的对象的对象键

st

ri
n

g

DeleteM

arker

DeleteR

esult.Del

eted

仅当对该对象的删除创建了一个删除标记，或删除的是该对象的一个

删除标记时才返回该元素，布尔值，固定为 true

b

o
ol

e
a

n

DeleteM
arkerVer

sionId

DeleteR
esult.Del

eted

仅当对该对象的删除创建了一个删除标记，或删除的是该对象的一个
删除标记时才返回该元素，值为创建或删除的删除标记的版本 ID

st
ri

n

g
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Container 节点 Error 的内容：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

VersionI

d

DeleteR

esult.Del

eted

删除成功的版本 ID，仅当请求中指定了要删除对象的版本 ID 时才返

回该元素

st
ri

n
g

节点名称（关

键字）
父节点 描述

类

型

Key
DeleteResult

.Error
删除失败的对象的对象键

stri

ng

VersionId
DeleteResult
.Error

删除失败的版本 ID，仅当请求中指定了要删除对象的版本 
ID 时才返回该元素

stri
ng

Code
DeleteResult

.Error

删除失败的错误码，用来定位唯一的错误条件和确定错误

场景

stri

ng

Message
DeleteResult

.Error
删除失败的具体错误信息

stri

ng

错误码

实际案例

案例一：简单案例

请求

POST /?delete HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 20 Aug 2019 11:59:35 GMT

Content-Type: application/xml

Content-Length: 158

Content-MD5: zUd/xgzNGDrqJMJUOWV2AQ==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<Delete>

    <Quiet>false</Quiet>

    <Object>

        <Key>example-object-1.jpg</Key>

    </Object>

https://cloud.tencent.com/document/product/436/7730
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    <Object>

        <Key>example-object-2.jpg</Key>

    </Object>

</Delete>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 144

Connection: close

Date: Tue, 20 Aug 2019 11:59:35 GMT

Server: tencent-cos

x-cos-request-id: NWQ1YmUwYTdfM2FiMDJhMDlfYzczN18zMGM1****

<DeleteResult>

    <Deleted>

        <Key>example-object-1.jpg</Key>

    </Deleted>

    <Deleted>

        <Key>example-object-2.jpg</Key>

    </Deleted>

</DeleteResult>

案例二：简单案例（Quiet 模式）

请求

POST /?delete HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 20 Aug 2019 12:12:26 GMT

Content-Type: application/xml

Content-Length: 157

Content-MD5: +iI9kJvM2k/y5y3nHcn8BQ==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<Delete>

    <Quiet>true</Quiet>

    <Object>

        <Key>example-object-1.jpg</Key>

    </Object>

    <Object>

        <Key>example-object-2.jpg</Key>
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    </Object>

</Delete>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 15

Connection: close

Date: Tue, 20 Aug 2019 12:12:27 GMT

Server: tencent-cos

x-cos-request-id: NWQ1YmUzYWFfMTljMDJhMDlfNTg3ZV8zNDI0****

<DeleteResult/>

案例三：启用版本控制（创建删除标记）

请求

POST /?delete HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 21 Aug 2019 12:04:03 GMT

Content-Type: application/xml

Content-Length: 100

Content-MD5: MowFtlG7iwK7Wmk79IVXFA==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<Delete>

    <Quiet>false</Quiet>

    <Object>

        <Key>example-object-1.jpg</Key>

    </Object>

</Delete>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 200

Connection: close

Date: Wed, 21 Aug 2019 12:04:03 GMT

Server: tencent-cos
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x-cos-request-id: NWQ1ZDMzMzNfNDhiNDBiMDlfMmIzNzZfMTBh****

<DeleteResult>

    <Deleted>

        <Key>example-object-1.jpg</Key>

        <DeleteMarker>true</DeleteMarker>

        <DeleteMarkerVersionId>MTg0NDUxNzc2ODQ2NjU3ODM4NTc</DeleteMarkerVersio

    </Deleted>

</DeleteResult>

案例四：删除指定版本

请求

POST /?delete HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 21 Aug 2019 11:24:43 GMT

Content-Type: application/xml

Content-Length: 154

Content-MD5: EwFydeQSMzaHWi0qMTOGWw==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<Delete>

    <Quiet>false</Quiet>

    <Object>

        <Key>example-object-2.jpg</Key>

        <VersionId>MTg0NDUxNzc2ODcwMjYyNjIwMTM</VersionId>

    </Object>

</Delete>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 140

Connection: close

Date: Wed, 21 Aug 2019 11:24:44 GMT

Server: tencent-cos

x-cos-request-id: NWQ1ZDI5ZmJfNDhiNDBiMDlfMmIzODNfMTA0****

<DeleteResult>

    <Deleted>

        <Key>example-object-2.jpg</Key>
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        <VersionId>MTg0NDUxNzc2ODcwMjYyNjIwMTM</VersionId>

    </Deleted>

</DeleteResult>

案例五：删除指定删除标记

请求

POST /?delete HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 21 Aug 2019 12:04:04 GMT

Content-Type: application/xml

Content-Length: 154

Content-MD5: EKphCPpHcKiVqJtMqE+DmA==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<Delete>

    <Quiet>false</Quiet>

    <Object>

        <Key>example-object-1.jpg</Key>

        <VersionId>MTg0NDUxNzc2ODQ2NjU3ODM4NTc</VersionId>

    </Object>

</Delete>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 253

Connection: close

Date: Wed, 21 Aug 2019 12:04:04 GMT

Server: tencent-cos

x-cos-request-id: NWQ1ZDMzMzRfYmIwMmEwOV83YTQzXzEyM2Ri****

<DeleteResult>

    <Deleted>

        <Key>example-object-1.jpg</Key>

        <DeleteMarker>true</DeleteMarker>

        <DeleteMarkerVersionId>MTg0NDUxNzc2ODQ2NjU3ODM4NTc</DeleteMarkerVersio

        <VersionId>MTg0NDUxNzc2ODQ2NjU3ODM4NTc</VersionId>

    </Deleted>

</DeleteResult>
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案例六：部分删除失败

请求

POST /?delete HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 21 Aug 2019 12:04:05 GMT

Content-Type: application/xml

Content-Length: 436

Content-MD5: ZAbgvje31aO+0j7pkEkYvQ==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<Delete>

    <Quiet>false</Quiet>

    <Object>

        <Key>example-object-1.jpg</Key>

    </Object>

    <Object>

        <Key>example-object-2.jpg</Key>

        <VersionId>MTg0NDUxNzc2ODQ2NjQ1MjM5MTk</VersionId>

    </Object>

    <Object>

        <Key>example-object-3.jpg</Key>

        <VersionId>MTg0NDUxNzc2ODQ2NjQwMTIwMDI</VersionId>

    </Object>

    <Object>

        <Key>example-object-4.jpg</Key>

        <VersionId>MTg0NDUxNzc2ODQ2NjQ0NjI0MDQ</VersionId>

    </Object>

</Delete>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 703

Connection: close

Date: Wed, 21 Aug 2019 12:04:06 GMT

Server: tencent-cos

x-cos-request-id: NWQ1ZDMzMzVfOTNjMjJhMDlfMzhiM18xMWY3****

<DeleteResult>

    <Deleted>
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        <Key>example-object-1.jpg</Key>

        <DeleteMarker>true</DeleteMarker>

        <DeleteMarkerVersionId>MTg0NDUxNzc2ODQ2NjM1NTI2NDY</DeleteMarkerVersion

    </Deleted>

    <Deleted>

        <Key>example-object-2.jpg</Key>

        <VersionId>MTg0NDUxNzc2ODQ2NjQ1MjM5MTk</VersionId>

    </Deleted>

    <Deleted>

        <Key>example-object-3.jpg</Key>

        <DeleteMarker>true</DeleteMarker>

        <DeleteMarkerVersionId>MTg0NDUxNzc2ODQ2NjQwMTIwMDI</DeleteMarkerVersio

        <VersionId>MTg0NDUxNzc2ODQ2NjQwMTIwMDI</VersionId>

    </Deleted>

    <Error>

        <Key>example-object-4.jpg</Key>

        <VersionId>MTg0NDUxNzc2ODQ2NjQ0NjI0MDQ</VersionId>

        <Code>PathConflict</Code>

        <Message>Path conflict.</Message>

    </Error>

</DeleteResult>
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OPTIONS Object
最近更新时间：2021-07-22 10:19:39

OPTIONS Object 用于跨域资源共享（CORS）的预检（Preflight）请求。当浏览器发起 CORS 请求时，浏

览器会判断是否有必要发起预检请求，如有必要则浏览器会在发起 CORS 请求前自动发出预检请求，所以在正常情

况下，前端开发者不需要自己去发起这样的请求。

此接口的请求参数由浏览器自动根据跨域访问的目标资源决定，开发者无需关注。

功能描述

如果指定存储桶存在 CORS 配置且预检条件符合存储桶的 CORS 配置，则 COS 正常返回，允许浏览器继续 

CORS 请求。

如果指定存储桶不存在 CORS 配置或预检条件不符合存储桶的 CORS 配置，则 COS 返回 HTTP 403 

Forbidden，此时浏览器将停止 CORS 请求并向前端抛出异常。

有关存储桶的 CORS 配置，可参见 PUT Bucket cors  文档。

请求

请求示例

OPTIONS /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Origin: Origin

Access-Control-Request-Method: RequestMethod

注意

虽然上述示例指定了对象键（ObjectKey），但在实际使用过程中可针对存储桶域名下的任意资源

（包含根目录）发起预检请求，例如 OPTIONS / HTTP/1.1  或者 OPTIONS /?lifecycle HTTP/1.1  

等。

预检请求由浏览器自动发出，因此预检请求无需也无法携带 Authorization 请求签名。

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

请求参数

请求头

https://cloud.tencent.com/document/product/436/8279
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
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此接口的请求头由浏览器自动根据跨域访问的具体行为决定，开发者无需关注。

此接口无请求体。

此接口的响应头由浏览器自动识别处理并控制是否允许 CORS 请求，开发者无需关注。

名称 描述
类

型

是否

必选

Origin 发起 CORS 请求的域名。

st

ri
n

g

是

Access-Control-

Request-Method
发起 CORS 请求所用的方法（Method）

st
ri

n
g

是

Access-Control-

Request-Headers

发起 CORS 请求时使用的 HTTP 请求头部，不区分英文大小

写，可使用英文逗号(,)分隔多个头部

st

ri

n
g

否

请求体

响应

响应头

名称 描述
类
型

Access-

Control-Allow-
Origin

允许发起 CORS 的域名，可能的值有以下两种：

* ：代表允许所有域名

请求头 Origin 中指定的域名：代表允许指定域名

str
ing

Access-

Control-Allow-
Methods

允许发起 CORS 请求所使用的方法（Method），可使用英文逗号(,)分隔

多个方法

str

ing

Access-

Control-

Expose-
Headers

允许浏览器获取的 CORS 请求中的 HTTP 响应头部，不区分英文大小写，

可使用英文逗号(,)分隔多个头部

str

ing

Access- CORS 配置的有效时间，单位为秒，在有效时间内，浏览器无须为同一请求 int
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此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

以下案例均由浏览器根据发起的 CORS 请求自动发起的预检请求，开发者无需关注。

Control-Max-
Age

再次发起预检请求 eg
er

响应体

错误码

实际案例

案例一：针对 PUT Object 发起预检请求

请求

OPTIONS /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 09 Jul 2020 14:49:22 GMT

Origin: https://example.com

Access-Control-Request-Method: PUT

Access-Control-Request-Headers: content-md5,content-type,x-cos-meta-author

Connection: close

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Access-Control-Allow-Credentials: true

Access-Control-Allow-Headers: content-md5,content-type,x-cos-meta-author

Access-Control-Allow-Methods: PUT,GET,POST,DELETE,HEAD

Access-Control-Allow-Origin: https://example.com

Access-Control-Expose-Headers: Content-Length,ETag,x-cos-meta-author

Access-Control-Max-Age: 600

Date: Thu, 09 Jul 2020 14:49:22 GMT

Server: tencent-cos

x-cos-request-id: NWYwNzJlNzJfODRjOTJhMDlfMjU0MWNfMTNmZDM5****

案例二：针对 GET Object 时携带 Range 请求头部发起预检请求

请求

https://cloud.tencent.com/document/product/436/7730
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OPTIONS /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 09 Jul 2020 14:49:22 GMT

Origin: https://example.com

Access-Control-Request-Method: GET

Access-Control-Request-Headers: range

Connection: close

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Access-Control-Allow-Headers: range,x-cos-server-side-encryption-customer-algorithm,x-c

Access-Control-Allow-Methods: GET,HEAD

Access-Control-Allow-Origin: *

Access-Control-Expose-Headers: Content-Length,ETag,x-cos-meta-author

Access-Control-Max-Age: 600

Date: Thu, 09 Jul 2020 14:49:22 GMT

Server: tencent-cos

x-cos-request-id: NWYwNzJlNzJfZDUyNzVkNjRfYTA2Ml8yNGEz****

案例三：针对 PUT Bucket lifecycle 发起预检请求

请求

OPTIONS /?lifecycle HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 09 Jul 2020 14:29:40 GMT

Origin: https://bar.com

Access-Control-Request-Method: PUT

Access-Control-Request-Headers: content-md5,content-type

Connection: close

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Access-Control-Allow-Credentials: true

Access-Control-Allow-Headers: content-md5,content-type

Access-Control-Allow-Methods: PUT,GET,POST,DELETE,HEAD
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Access-Control-Allow-Origin: https://bar.com

Access-Control-Expose-Headers: Content-Length,ETag,x-cos-meta-author

Access-Control-Max-Age: 600

Date: Thu, 09 Jul 2020 14:29:40 GMT

Server: tencent-cos

x-cos-request-id: NWYwNzI5ZDRfNjFiMDJhMDlfYzk2NF8xYmZl****

案例四：指定存储桶不存在 CORS 配置或预检条件不符合存储桶的 CORS 配置

请求

OPTIONS /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 09 Jul 2020 11:45:26 GMT

Origin: https://example.com

Access-Control-Request-Method: PUT

Connection: close

响应

HTTP/1.1 403 Forbidden

Content-Type: application/xml

Content-Length: 687

Connection: close

Date: Thu, 09 Jul 2020 11:45:26 GMT

Server: tencent-cos

x-cos-request-id: NWYwNzAzNTZfNzNjODJhMDlfMzRiM2ZfMThjMjk4****

x-cos-trace-id: OGVmYzZiMmQzYjA2OWNhODk0NTRkMTBiOWVmMDAxODc0OWRkZjk0ZD

<?xml version='1.0' encoding='utf-8' ?>

<Error>

    <Code>AccessForbidden</Code>

    <Message>CORSResponse: This CORS request is not allowed. This is usually because t

    <Resource>examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleobject

    <RequestId>NWYwNzAzNTZfNzNjODJhMDlfMzRiM2ZfMThjMjk4****</RequestId>

    <TraceId>OGVmYzZiMmQzYjA2OWNhODk0NTRkMTBiOWVmMDAxODc0OWRkZjk0ZDM

</Error>
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POST Object restore
最近更新时间：2022-04-26 16:31:59

POST Object restore 接口请求可以对一个归档存储或深度归档存储类型的对象进行恢复（解冻）以便读取该对

象内容，恢复出的可读取对象是临时的，您可以设置需要保持可读以及随后删除该临时副本的时间。您可以用 

Days 参数来指定临时对象的过期时间，若超出该时间且期间您没有发起任何复制、延长等操作，该临时对象将被

系统自动删除。临时对象仅为归档存储类型对象的副本，原始归档存储对象在此期间将始终存在。有关归档存储的进

一步说明，请参见 存储类型 - 归档存储  文档。

当启用版本控制时，该请求操作可以使用 versionId 请求参数指定要恢复的版本 ID，此时将恢复对象的指定版本，

否则将恢复指定对象的最新版本。

功能描述

说明

 POST Object restore 接口请求存在 QPS 限制，限制为100次/秒。

版本控制

请求

请求示例

POST /<ObjectKey>?restore HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-Type: application/xml

Content-Length: Content Length

Content-MD5: MD5

Authorization: Auth String

[Request Body]

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

https://cloud.tencent.com/document/product/436/33417#.E5.BD.92.E6.A1.A3.E5.AD.98.E5.82.A8
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

提交 application/xml 请求数据，包含恢复操作的具体参数。

具体的节点描述如下：

Container 节点 RestoreRequest 的内容：

Container 节点 CASJobParameters 的内容：

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

名称 描述 类型
是否必

选

versionI
d

当启用版本控制时，指定要恢复的版本 ID，如不指定则恢复对象的最
新版本

strin
g

否

请求头

请求体

<RestoreRequest>

   <Days>number</Days>

   <CASJobParameters>

       <Tier>Enum</Tier>

   </CASJobParameters>

</RestoreRequest>

节点名称（关键

字）

父节

点
描述 类型

是否必

选

RestoreReque
st

无
包含 POST Object restore 操作的所有请
求信息

Contain
er

是

节点名称（关键
字）

父节点 描述 类型
是否
必选

Days
RestoreReq

uest

指定恢复出的临时副本的有效时长，单

位为“天”

numbe

r
是

CASJobParam
eters

RestoreReq
uest

恢复工作参数
Contai
ner

是

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

节点名
称（关

键字）

父节点 描述
类

型

是否

必选

Tier

Restore

Reques
t.CASJ

obPara
meters

恢复时，Tier 可以指定为支持的恢复模式。
对于恢复归档存储类型数据，有三种恢复模式，分别为：

对于恢复深度归档存储类型数据，有两种恢复模式，分别

为：

Expedited：快速取回模式，恢复任务在1 - 5分钟内可
完成。

Standard：标准取回模式，恢复任务在3 - 5小时内完
成 

Bulk：批量取回模式，恢复任务在5 - 12小时内完成。

Standard：标准取回模式，恢复时间为12 - 24小时。

Bulk：批量取回模式，恢复时间为24 - 48小时。

En

um
是

响应

响应头

响应体

错误码

实际案例

案例一：简单案例（未启用版本控制）

请求

POST /exampleobject?restore HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 27 Dec 2019 08:19:29 GMT

Content-Type: application/xml

Content-Length: 121

Content-MD5: Nr7RAnRMgrplFvD8bt5+0w==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第402 共1701页

<RestoreRequest>

            <Days>1</Days>

            <CASJobParameters>

                <Tier>Expedited</Tier>

            </CASJobParameters>

</RestoreRequest>

响应

HTTP/1.1 202 Accepted

Content-Length: 0

Connection: close

Date: Fri, 27 Dec 2019 08:19:29 GMT

Server: tencent-cos

x-cos-request-id: NWUwNWJlOTFfMjljOTBiMDlfMTQ2MmNfNzAw****

案例二：恢复对象的指定版本（启用版本控制）

请求

POST /exampleobject?restore&versionId=MTg0NDUxNjQ1NjM4OTkzNzY3NDk HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Mon, 20 Jan 2020 08:43:40 GMT

Content-Type: application/xml

Content-Length: 121

Content-MD5: Nr7RAnRMgrplFvD8bt5+0w==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<RestoreRequest>

            <Days>1</Days>

            <CASJobParameters>

                <Tier>Expedited</Tier>

            </CASJobParameters>

</RestoreRequest>

响应

HTTP/1.1 202 Accepted
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Content-Length: 0

Connection: close

Date: Mon, 20 Jan 2020 08:43:41 GMT

Server: tencent-cos

x-cos-request-id: NWUyNTY4M2NfZTNjODJhMDlfMWZkM2VfNWZm****
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SELECT Object Content
最近更新时间：2023-07-26 14:33:43

COS Select 接口可以使用结构化查询语句（Structured Query Language，SQL）从指定对象（CSV、

JSON 或者 Parquet 格式）中检索内容。在检索过程中，您需要指定对象内容的分隔符，并使用合适的 SQL 函

数进行检索，COS Select 将返回相匹配的检索结果，您可以指定检索结果的保存格式。

如您需要了解 COS Select 的更多介绍，请参见 COS Select 概述 。有关 COS Select 的 SQL 表达式的介

绍，您可以在开发者指南中参见 Select 命令  进一步了解。

使用 COS Select，您必须具有 cos:GetObject 的授权。

COS Select 支持检索以下格式的对象数据：

概述

权限限制

如果您是主账号，则默认拥有该权限。

如果您是子账号，请联系您的主账号获取该操作的权限。有关权限设置，请参见 授权子账号访问 COS  文档。

对象数据格式

CSV 格式：对象以 CSV 格式存储，并以固定的分隔符划分。

JSON 格式：对象以 JSON 格式存储，可以是 JSON 文件或者 JSON 列表。

Parquet 格式：对象以 Parquet 格式存储，可以包含嵌套结构。

注意

COS Select 的对象必须以 UTF-8 格式编码。

COS Select 支持检索 GZIP 或者 BZIP2 压缩的 CSV、JSON 对象；支持检索经过 GZIP 或 

Snappy 列压缩的 Parquet 对象。

COS Select 支持检索 SSE-COS 加密的对象。

请求

请求示例

POST /<ObjectKey>?select&select-type=2 HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: date

Authorization: Auth String

Request body

https://cloud.tencent.com/document/product/436/37635
https://cloud.tencent.com/document/product/436/37636
https://cloud.tencent.com/document/product/436/11714


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第405 共1701页

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

以下请求展示了用户发起一个 COS Select 请求，检索 CSV 格式对象的所有内容，并将结果保存为 CSV 格式对

象。 

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String （详情请参见 请求签名  文档）。

请求参数中 select 和 select-type=2 参数均为必填参数，其中 select 代表发起 select 请求，

select-type=2 代表这一接口的版本信息。

请求头

请求体

<?xml version="1.0" encoding="UTF-8"?>

<SelectRequest>

    <Expression>Select * from COSObject</Expression>

    <ExpressionType>SQL</ExpressionType>

    <InputSerialization>

        <CompressionType>GZIP</CompressionType>

        <CSV>

            <FileHeaderInfo>IGNORE</FileHeaderInfo>

            <RecordDelimiter> n</RecordDelimiter>

            <FieldDelimiter>,</FieldDelimiter>

            <QuoteCharacter>"</QuoteCharacter>

            <QuoteEscapeCharacter>"</QuoteEscapeCharacter>

            <Comments>#</Comments>

            <AllowQuotedRecordDelimiter>FALSE</AllowQuotedRecordDelimiter>

        </CSV>

    </InputSerialization>

    <OutputSerialization>

        <CSV>

            <QuoteFields>ASNEEDED</QuoteFields>

            <RecordDelimiter> n</RecordDelimiter>

            <FieldDelimiter>,</FieldDelimiter>

            <QuoteCharacter>"</QuoteCharacter>

            <QuoteEscapeCharacter>"</QuoteEscapeCharacter>

        </CSV>

    </OutputSerialization>

\

\

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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以下请求展示了用户发起一个 COS Select 请求，检索 JSON 格式对象的所有内容，并将结果保存为 JSON 格

式对象。                    

以下请求展示了用户发起一个 COS Select 请求，检索 Parquet 格式对象的所有内容，并将结果保存为 JSON 

格式对象。

    <RequestProgress>

        <Enabled>FALSE</Enabled>

    </RequestProgress>

</SelectRequest> 

<?xml version="1.0" encoding="UTF-8"?>

<SelectRequest>

    <Expression>Select * from COSObject</Expression>

    <ExpressionType>SQL</ExpressionType>

    <InputSerialization>

        <CompressionType>GZIP</CompressionType>

        <JSON>

            <Type>DOCUMENT</Type>

        </JSON>

    </InputSerialization>

    <OutputSerialization>

        <JSON>

            <RecordDelimiter> n</RecordDelimiter>

        </JSON>                                  

    </OutputSerialization>

    <RequestProgress>

        <Enabled>FALSE</Enabled>

    </RequestProgress>                                  

</SelectRequest> 

\

<?xml version="1.0" encoding="UTF-8"?>

<SelectRequest>

    <Expression>Select * from COSObject</Expression>

    <ExpressionType>SQL</ExpressionType>

    <InputSerialization>

        <CompressionType>GZIP</CompressionType>

        <Parquet>

        </Parquet>

    </InputSerialization>

    <OutputSerialization>

        <JSON>

            <RecordDelimiter> n</RecordDelimiter>\
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下表展示了请求体中的各项元素组成：

InputSerialization container element

        </JSON>                                  

    </OutputSerialization>

    <RequestProgress>

        <Enabled>FALSE</Enabled>

    </RequestProgress>                                  

</SelectRequest> 

说明

InputSerialization 元素描述了待检索的对象格式，为必填参数，该参数可以指定为 CSV 、JSON 

或 Parquet 格式。

OutputSerialization 元素描述了检索结果的保存格式，该参数可以仅可指定为 CSV 或者 JSON 格

式。

待检索的对象格式无需和检索结果的保存格式互相匹配，您可以检索一个 JSON 格式的对象，并将检

索结果保存为 CSV 格式。

名称 父节点 描述 类型

是

否
必

选

Expressio

n

SelectR

equest

SQL   表达式，代表您需要发起的检索操作。例如

SELECT s._1 FROM COSObject s 。这个表达式可以从 

CSV   格式的对象中检索第一列内容。有关 SQL 表达式
的详细介绍，请参见 Select 命令 。

Stri

ng
是

Expressio

nType

SelectR

equest

表达式类型，该项为扩展项，目前只支持 SQL 表达式，

仅支持 SQL 参数。

Stri

ng
是

InputSeria
lization

SelectR
equest

描述待检索对象的格式。

Con

tain
er

是

OutputSer

ialization

SelectR

equest
描述检索结果的输出格式。

Con

tain
er

是

RequestP

rogress

SelectR

equest

是否需要返回查询进度 QueryProgress 信息，如果选

中 COS Select 将周期性返回查询进度。

Con

tain

er

否

https://cloud.tencent.com/document/product/436/37636
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CSV container element (InputSerialization 子元素)

名称 父节点 描述 类型 是
否

必
选

Compressio
nType

InputSeri
alization

描述待检索对象的压缩格式： 如果对象未被压缩过，

则该项为 NONE。如果对象被压缩过，COS 
Select 目前支持的两种压缩格式为 GZIP 和 

BZIP2，可选项为 NONE、GZIP、BZIP2，默认
值为 NONE。

Stri
ng

否

CSV/JSON/P

ARQUET

InputSeri

alization

描述在相应的对象格式下所需的文件参数。例如 CSV 

格式需要指定分隔符。

Con
tain

er

是

名称

父

节

点

描述
类

型

是
否

必
选

RecordDelimiter
CS
V

将 CSV 对象中记录分隔为不同行的字符，默认您通过

\n 进行分隔。您可以指定任意8进制字符，如逗号、分

号、Tab 等。该参数最多支持2个字节，即您可以输入

\r\n 这类格式的分隔符。默认值为 \n 。

Str
ing

否

FieldDelimiter
CS
V

指定分隔 CSV 对象中每一行的字符，默认您通过,进行

分隔。您可以指定任意8进制字符，该参数最多支持1个

字节。默认值为 , 。

Str
ing

否

QuoteCharacter
CS

V

如果您待检索的 CSV 对象中存在包含分隔符的字符串，

您可以使用 QuoteCharacter 进行转义，避免该字符

串被切割成几个部分。如 CSV 对象中存在 "a, b" 这个

字符串，双引号"可以避免这一字符串被分隔成 a  和 

b  两个字符。默认值为 " 。

Str

ing
否

QuoteEscapeCh
aracter

CS
V

如果您待检索的字符串中已经存在 " ，那您需要使用 "

进行转义以保证字符串可以正常转义。如您的字符串 

""" a , b """ 将会被解析为 " a , b  " 。默认值为"。

Str
ing

否

AllowQuotedRec
ordDelimiter

CS
V

指定待检索对象中是否存在与分隔符相同且需要用"转义

的字符。设定为 TRUE 时，COS   Select 将会在检索
进行转义，这会导致检索性能下降；设定为 FALSE 

时，则不会做转义处理。默认值为 FALSE。

Bo

ole
an

否



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第409 共1701页

JSON container element (InputSerialization 子元素)

OutputSerialization container element

CSV container element (OutputSerialization 子元素)

FileHeaderInfo CS

V

待检索对象中是否存在列表头。该参数为存在 NONE、

USE、IGNORE 三个选项。NONE 代表对象中没有列
表头，USE 代表对象中存在列表头并且您可以使用表头

进行检索（例如 SELECT "name" FROM COSObject

），IGNORE 代表对象中存在列表头且您不打算使用表

头进行检索（但您仍然可以通过列索引进行检索，如 

SELECT s._1 FROM COSObject s ）。合法值为 

NONE、USE、IGNORE。

En

um

否

Comments
CS

V

指定某行记录为注释行，该字符会被添加到该行记录的首
字符。如果某一行记录被指定为注释，则 COS Select 

将不对此行做任何分析。默认值为 # 。

Str

ing
否

名
称

父
节

点

描述
类
型

是否
必选

Ty

p
e

JS

O
N

JSON 文件的类型：

合法值为 DOCUMENT 、LINES。

DOCUMENT 表示 JSON 文件仅包含一个独立的 JSON 对象，
且该对象可以被切割成多行。

LINES 表示 JSON 对象中的每一行包含了一个独立的 JSON 对
象。

En

um
是

名称 父节点 描述 类型 是否必选

CSV 
/JSON

OutputSeri
alization

指定检索结果的输出格式，可选项为 
CSV 或者 JSON。

Cont
ainer

是，必须是 CSV 或
者 JSON 中的一个

名称

父

节
点

描述
类
型

是

否
必

选

QuoteFields
C
S

V

指定输出结果为文件时，是否需要使用 " 进行转义。可选项包括 

ALWAYS、ASNEEDED、ALWAYS 代表对所有本次输出的

检索文件应用 " ，ASNEEDED 代表仅在需要时使用。合法值为 

ALWAYS、ASNEEDED，默认值为 ASNEEDED。

St
ri

n

g

是
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JSON container element (OutputSerialization 子元素)

RequestProgress container element

执行成功的检索操作将返回 200 OK 状态码。

RecordDelim
iter

C
S

V

将输出结果中的记录分隔为不同行的字符，默认通过 \n 进行分

隔。您可以指定任意8进制字符，如逗号、分号、Tab 等。该参数

最多支持2个字节，即您可以输入 \r\n 这类格式的分隔符。默认

值为 \n 。

St
ri

n
g

否

FieldDelimite
r

C
S

V

将输出结果中的每一行进行分列的字符，默认通过 , 进行分隔。

您可以指定任意8进制字符，该参数最多支持1个字节。默认值为

, 。

St

ri
n

g

否

QuoteChara

cter

C

S
V

如果输出结果中存在包含分隔符的字符串，可以使用 
QuoteCharacter 进行转义，保证该字符串不会在后续分析中被

切割。如输出结果中存在 a,b 这个字符串，双引号 " 可以避免这

一字符串被分隔成 a 和 b 两个字符，COS Select 将会将其转

为 "a, b" 写入文件。默认值为 " 。

St
ri

n
g

否

QuoteEscap

eCharacter

C
S

V

如果您即将输出的字符串中已经存在 " ，那您需要使用 " 进行转

义以保证该字符串可以正常转义。如您的字符串 " a , b"  将会被

在写入文件时被转换为 """ a , b """ 。默认值为 " 。

St
ri

n
g

否

名称

父

节
点

描述
类

型

是
否

必
选

RecordD
elimiter

J

S
O

N

将输出结果中的记录分隔为不同行的字符，默认通过 \n 进行分隔。

您可以指定任意8进制字符，如逗号、分号、Tab 等。该参数最多支

持2个字节，即您可以输入 \r\n 这类格式的分隔符。默认值为 \n 。

St

ri
n

g

否

名称 父节点 描述 类型
是否
必选

Enab
led

RequestPro
gress

指定是否需要 COS Select 定期返回查询进度。默
认值为 FALSE。

Bool
ean

否

响应
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

由于响应体的大小无法预知，COS 将用户请求响应体以序列化形式展示，即将响应体切分成多个分块返回，如下展

示了返回响应体的概览：

COS 将检索结果切成多个分块，每个分块即一个 Message。每一个 Message 由预响应（prelude）和响应结

果（data）组成。

预响应和响应结果均以4字节的经过大端编码（big-endian）的 CRC 校验码结尾。COS Select 使用 CRC32

计算 CRC 校验码，有关 CRC32的详细信息，请参见 RFC 文档 。除了响应结果之外，COS Select 总共额外花

费了16字节用于传输预响应和校验码信息。

下图展示了分块 Message 以及检索结果中的响应报头 header 是如何构成的。每一个分块 Message 中可能包

含多个 header 。 

响应头

响应体

<Message 1>

<Message 2>

<Message 3>

<Message n>

......

预响应（prelude）和响应结果（data）

预响应包含两个部分：

所在分块 Message 的总长度。

所有头部的总长度。

响应结果包含两个部分：

响应报头（header）。

响应正文（payload）。

注意

所有分块 Message 中的整数值均以网络字节序，即大端编码，传输。

https://cloud.tencent.com/document/product/436/7729
https://www.ietf.org/rfc/rfc1952.txt
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如上图所示，每一个分块 Message 均由预响应 prelude，预响应校验码 prelude CRC（由两个记录字节数的

信息组成），报头信息 header ，响应正文 Payload 和正文校验码 Message CRC 构成。从上图可以看到，整

个响应体的长度计算方式如下：

由于校验码（prelude CRC 和 Message CRC）和预响应 prelude 总长度固定为16字节，因此响应体总长还

可以通过如下方式快速计算：

以下详细介绍响应体各部分组成：

响应体总长度 =  预响应长度 + 预响应校验码长度 + 响应正文长度 + 响应报头长度  + 响应正文校验

响应体总长度 =  响应正文长度 + 响应报头长度 + 16
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同一个分块 Message 中可能记录了多个 header，每一个响应报头 header 由以下几部分组成：

组成                                       描述

预响应 prelude

分别记录了分块 Message 的总长度和所有报头的总长度，每个记录4字节，总长8

字节：

1. total byte-length ：所在分块 Message 的总长度，使用大端编码，包含该记

录本身容量共4字节。

2. headers byte-length ：所有报头的总长度，使用大端编码，不包含该记录所占

空间共4字节。

预响应校验码 

prelude CRC

预响应的 CRC 校验码，使用大端编码，总共4字节。预响应校验码可以帮助程序快速

识别预响应信息是否正确，减少缓冲时的阻塞。

报头信息 header

分块 Message 记录的检索结果的元数据信息，诸如数据类型，正文格式。根据数据

类型的差异，本部分的字节长度也有所差异。响应报头以 kv 键值对形式存储，使用 
UTF-8编码。响应报头中所记录的元数据信息可以以任意顺序展示，但每一项元数据

仅记录一次。根据数据类型的差异，以下响应报头均有可能在 COS Select 返回的
结果中出现：

1. MessageType Header ：该报头代表响应类型。Key 值为":message-

type"，合法的 Value 值为"error"或者"event"，"error"代表本条记录为报错

信息，"event"代表本条记录为具体的事件。

2. EventType Header ：该报头记录事件类型。Key 值为":event-type"，合法

的 Value 值
为"Records"，"Cont"，"Progress"，"Stats"或"End"。"Records"代表事

件为返回检索记录，"Cont"代表事件为保持 TCP 连接，"Progress"代表事件为
定期返回的检索结果，"Stats"代表事件为本次查询的统计信息，"End"代表本次

查询结束。

3. ErrorCode Header ：该报头记录报错类型。Key 值为":error-code"，合法

的 Value 值为  
特殊错误码中的错误码信息。

4. ErrorMessage Header ：该报头记录错误码信息。Key 值为":error-

message"，合法的 Value 值为服务端返回的错误码信息，可用于定位错误。

响应正文 

Payload
记录检索结果，或者与请求相关的正式信息。

正文校验码 
Message CRC

使用大端编码的 CRC 校验码，总长4字节。

组成                                     描述

Header Name 
Byte-Length

记录 Header Name 的字节长度信息。
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COS Select 的响应类型主要可以分为以下几种：

下面将进一步介绍这些响应类型的详情。

Header Name 报头类型，合法值包括 ":message-type"， ":event-type"， ":error-

code"和":error-message"：
":message-type"代表该报头记录了响应类型。

 ":event-type"代表了该报头记录事件类型 。

":error-code"代表该报头记录报错类型。

":error-message"代表该报头记录错误码信息。

Header Value Type
Header Value 的类型，对于 COS Select 而言这个值固定为7，代表类型为 
String。

Value String Byte-

Length
Header Value 的字节长度信息，固定2字节。

Header Value 

String

响应报头的正文，即响应正文的元数据信息，Header Value 的字节长度与响

应类型相关。

响应类型                                 描述

Records 
message

检索信息，可以包含单条记录，部分记录或者多条记录，取决于检索结果的多少。一
个响应体中可能包含多个 Records message。

Continuation 

message

连接信息，COS Select 周期性地发送这些信息以保持 TCP 连接，这些信息随机

出现在响应体中。客户端最好能够自动识别这类信息，并对其做过滤处理以免弄脏检

索结果。

Progress 
message

进度信息，COS Select 周期性地返回这些信息以反馈当前查询进度。

Stats message 统计信息，COS Select 在查询结束后返回本次查询的相关统计信息。

End message
结束信息，代表本次查询已经结束，没有后续响应数据。只有在接受到该类型的信息

时才能认为查询结束。

RequestLevelEr

ror message

报错信息，COS Select 在查询出现错误时将会返回这一信息，包含请求的错误原

因。如果 COS Select 返回了这一信息，则将不会再返回 End message 信息。

Records message

报头格式

Records message 包括":message-type"， ":event-type"， ":content-type"3种类型的报头。如下

所示：
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正文格式

Records message 正文可能包含单条记录，部分记录或者多条记录，取决于检索结果的多少。

Continuation Message

报头格式

Continuation Message 包括":message-type"， ":event-type"2种类型的报头，如下所示： 
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正文格式

Continuation Message 中不包含正文内容。

Progress Message

报头格式

Progress Message 包括":message-type"， ":event-type"， ":content-type"3种类型的报头，如

下所示：
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示例如下：

正文格式

Progress Message 的正文是一个包含了当前查询进度的 XML 文本，主要包含以下信息：

BytesScanned：如果文件是压缩文件，该数值代表文件解压前的字节大小。如果文件不是压缩文件，该

数值即文件的字节大小。

BytesProcessed：如果文件是压缩文件，该数值代表文件解压后的字节大小。如果文件不是压缩文件，

该数值即文件的字节大小。

BytesReturned：COS Select 目前返回的检索结果字节大小。
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<?xml version="1.0" encoding="UTF-8"?>

<Progress>

     <BytesScanned>512</BytesScanned>

     <BytesProcessed>1024</BytesProcessed>

     <BytesReturned>1024</BytesReturned>

</Progress>

Stats Message

报头格式

Stats Message 包括":message-type"， ":event-type"， ":content-type"3种类型的报头，如下所

示：
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示例如下：

正文格式

Stats message 的正文是一个包含了本次查询统计的 XML 文本，主要包含以下信息：

BytesScanned：如果文件是压缩文件，该数值代表文件解压前的字节大小；如果文件不是压缩文件，该

数值即文件的字节大小。

BytesProcessed：如果文件是压缩文件，该数值代表文件解压后的字节大小；如果文件不是压缩文件，

该数值即文件的字节大小。

BytesReturned：COS Select 在本次查询中返回的检索结果字节大小。



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第420 共1701页

<?xml version="1.0" encoding="UTF-8"?>

<Stats>

     <BytesScanned>512</BytesScanned>

     <BytesProcessed>1024</BytesProcessed>

     <BytesReturned>1024</BytesReturned>

</Stats>

End Message

报头格式

End messages 包括":message-type"，":event-type"2种类型的报头，如下所示：

正文格式

End messages 中不包含正文内容。

Request Level Error Message

报头格式
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如果您需要了解 Request Level Error Message 中记录的错误码详情，可以查看 特殊错误码 。

该请求常见的错误信息请参见 错误码  文档，特殊错误码信息如下所示：                     

Request Level Error Message 包括“:error-code”，“:error-message”，“:message-

type”3种类型的报头，如下所示： 

正文格式

Request Level Error Message 信息中不包含正文内容。

特殊错误码

错误码 错误信息 含义 HTTP 

https://cloud.tencent.com/document/product/436/7730
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状态码

InvalidXML The XML is invalid XML 格式不合法

400 
Bad 

Reque
st

MissingRequire

dParameter

The SelectRequest entity is 

missing a required parameter

检索请求缺少必填参数

项

400 

Bad 

Reque
st

MissingExpect
edExpression

The SQL expression is missing 缺少 SQL 表达式

400 

Bad 
Reque

st

MissingInputSe

rialization
The input serialization is missing

未指定输入 CSV 对象

的数据序列化格式

400 
Bad 

Reque

st

InvalidCompres

sionFormat

The file is not in a supported 

compression format. Only GZIP 

and BZIP2 are supported

不合法的文件压缩格

式，仅支持 GZIP 和 

BZIP2 两种格式

400 
Bad 

Reque
st

MissingInputFo
rmat

The input format is missing 缺少输入格式

400 

Bad 
Reque

st

InvalidFileHead
erInfo

The input FileHeaderInfo is 
invalid. Only NONE, USE, and 

IGNORE are supported

输入的文件表头信息不

合法。仅支持 
NONE，USE 和 

IGNORE

400 

Bad 
Reque

st

InvalidRequest

Parameter

The input RecordDelimiter of CSV 

is invalid

输入的 CSV 文件换行

符不合法

400 
Bad 

Reque
st

InvalidRequest

Parameter

The input FieldDelimiter of CSV is 

invalid

输入的 CSV 文件列分

隔符不合法

400 
Bad 

Reque
st
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InvalidRequest

Parameter

The input QuoteCharacter of CSV 

is invalid

输入的 CSV 文件引用

符不合法

400 

Bad 
Reque

st

InvalidRequest

Parameter

The input 
AllowQuoteRecordDelimiter of 

csv is invalid. Only TRUE and 
FALSE are supported

在输入 CSV 文件中启
用转义符的配置不合

法，仅支持 TRUE 和 
FALSE

400 
Bad 

Reque
st

InvalidJsonTyp

e

The JsonType is invalid. Only 

DOCUMENT and LINES are 
supported

不合法的 JSON 类

型，仅支持 

DOCUMENT 和 
LINES

400 

Bad 

Reque
st

MissingOutput
Serialization

The output serialization is 
missing.

未指定输出 CSV 对象
的数据序列格式

400 

Bad 
Reque

st

MissingOutput

Format
The output format is missing 缺少输出格式

400 
Bad 

Reque

st

InvalidQuoteFie

lds

The QuoteFields is invalid. Only 

ALWAYS and ASNEEDED are 

supported

不合法的转义规则，仅

支持 ALWAYS 和 

ASNEEDED

400 
Bad 

Reque
st

InvalidRequest
Parameter

The output RecordDelimiter of 
CSV is invalid

输出的 CSV 文件换行
符不合法

400 

Bad 
Reque

st

InvalidRequest
Parameter

The output FieldDelimiter of CSV 
is invalid

输出的 CSV 文件列分
隔符不合法

400 

Bad 
Reque

st

InvalidRequest

Parameter

The output QuoteCharacter of 

CSV is invalid

输出的 CSV 文件转义

符不合法

400 
Bad 

Reque
st

InvalidRequest
Parameter

The output 
QuoteEscapeCharacter of CSV is 

输出的 CSV 的双引号
转义符不合法

400 
Bad 
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invalid Reque

st

InvalidRequest
Parameter

The output RecordDelimiter of 
JSON is invalid

输出的 JSON 文件换
行符不合法

400 

Bad 
Reque

st

SQLParsingErr

or

Encountered an error parsing the 

SQL expression

解析 SQL 表达式出现

问题

400 
Bad 

Reque
st

SQLParsingErr

or

Other expressions are not 

allowed in the SELECT list when 
'*' is used without dot notation.

SELECT list 不允许

在未使用点符的时候使

用 '*'

400 
Bad 

Reque
st

SQLParsingErr
or

The SQL expression contains an 
empty SELECT

SQL 表达式中包含了
空的 SELECT 子句

400 

Bad 
Reque

st

SQLParsingErr
or

GROUP is not supported in the 
SQL expression

SQL 表达式中不支持 
GROUP 子句

400 

Bad 
Reque

st

SQLParsingErr

or

UNION is not supported in the 

SQL expression

SQL 表达式中不支持 

UNION 子句

400 
Bad 

Reque
st

SQLParsingErr

or

FROM is missing in the SQL 

expression

SQL 表达式中缺少 

FROM 子句

400 
Bad 

Reque
st

SQLParsingErr
or

ORDER is not supported in the 
SQL expression

SQL 表达式中不支持 
ORDER 子句

400 

Bad 
Reque

st

SQLParsingErr
or

The column index is invalid in the 
SQL expression

SQL 表达式中指定的
列索引不合法

400 

Bad 
Reque

st
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SQLParsingErr
or

The table alias is invalid in 
WHERE

WHERE 子句中的表别
名不合法

400 
Bad 

Reque
st

Bzip2Decompr

essError

Encountered an error 

decompressing the bzip2 file

解压 BZIP2 格式的文

件时出现问题

400 

Bad 

Reque
st

Bzip2Decompr
essError

BZIP2 is not applicable to the 
queried object

BZIP2 格式不适用于
解压待查询对象

400 

Bad 
Reque

st

GzipDecompre

ssError

Encountered an error 

decompressing the gzip file

解压 GZIP 格式的文件

时出现问题

400 
Bad 

Reque

st

GzipDecompre

ssError

GZIP is not applicable to the 

queried object

GZIP 格式不适用于解

压待查询对象

400 
Bad 

Reque
st

Busy
The service is busy. Please retry 
later

后端服务阻塞，请稍后
重试

400 

Bad 
Reque

st

Overload
The service is overload. Please 
retry later

后端服务过载，请稍后
重试

400 

Bad 
Reque

st

AmbiguousFiel

dName

Field name matches to multiple 

fields in the file

指定的表头名称存在多

个相同的值

400 
Bad 

Reque
st

ComparisonFail

ed
Attempt to compare failed 匹配失败，请重试

400 
Bad 

Reque
st

CastFailed Attempt to convert from one data 

type to another using CAST failed 

在 SQL 表达式中通过 

CAST 函数转换数据类

400 

Bad 
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in the SQL expression. 型时出现错误 Reque

st

OverMaxRecor

dSize

The length of a record in the input 
or result is greater than 

maxCharsPerRecord of 1 MB

输入或输出的文件中，
单行记录大小超过1MB

限制

400 
Bad 

Reque

st

LastRecordPar

seFail

Please check the last record in 

the input

请检查输入文件的最后

一行记录

400 
Bad 

Reque
st

CSVParsingErr
or

Encountered an error parsing the 
CSV file

解析 CSV 格式文件的
时候出现问题

400 

Bad 
Reque

st

JSONParsingE
rror

Encountered an error parsing the 
JSON file

解析 JSON 格式文件
的时候出现问题

400 

Bad 
Reque

st

ErrorWritingRo

w

Encountered an error parsing the 

SELECT result. Please try again

无法格式化您的查询结

果，请检查文件并重试

400 
Bad 

Reque
st

InvalidRequest

Parameter

The input Comment of CSV is 

invalid

不合法的 CSV 文件注

释符

400 
Bad 

Reque
st

InvalidTextEnc
oding

UTF-8 encoding is required. 

Please check the file and try 
again.

检索文件和检索结果仅
支持UTF-8编码

400 

Bad 
Reque

st

NoSuchKey The specified key does not exist 指定的对象键不存在

404 

Not 
Found

AccessDenied Access Denied
签名或者权限不正确，

拒绝访问

403 

Forbid
den

MethodNotAllo The specified method is not 当前资源不支持该 405 



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第427 共1701页

以下示例展示了调用该接口从 CSV 格式的对象中检索全部内容，并将检索结果输出为 CSV 格式的过程。待检索的

对象名为 exampleobject.csv ，该对象存储于北京地域（ap-beijing）的存储桶 examplebucket-

1250000000 中。

wed allowed against this resource HTTP 方法 Metho
d Not 

Allowe
d

InternalError
We encountered an internal error. 
Please try again

服务端内部错误

500 

Intern
al 

Server

示例

示例 1: 从 CSV 格式的对象中检索内容

POST /exampleobject.csv?select&select-type=2 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 12 Jan 2019 11:49:52 GMT

Authorization: authorization string

Content-Length: content length

<?xml version="1.0" encoding="UTF-8"?>

<SelectRequest>

    <Expression>Select * from COSObject</Expression>

    <ExpressionType>SQL</ExpressionType>

    <InputSerialization>

        <CompressionType>None</CompressionType>

        <CSV>

            <FileHeaderInfo>IGNORE</FileHeaderInfo>

            <RecordDelimiter> n</RecordDelimiter>

            <FieldDelimiter>,</FieldDelimiter>

            <QuoteCharacter>"</QuoteCharacter>

            <QuoteEscapeCharacter>"</QuoteEscapeCharacter>

            <Comments>#</Comments>

        </CSV>

    </InputSerialization>

    <OutputSerialization>

        <CSV>

            <QuoteFields>ASNEEDED</QuoteFields>

            <RecordDelimiter> n</RecordDelimiter>

            <FieldDelimiter>,</FieldDelimiter>

            <QuoteCharacter>"</QuoteCharacter>

\

\
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如果您需要执行不同的检索指令，可以在 Expression 元素中修改 SQL 指令，有关指令的详细介绍，请参见 

Select 命令 ，以下为部分常见检索场景的简介。

如下为响应的例子：

以下示例展示了调用该接口从 JSON 格式的对象中检索全部内容，并将检索结果输出为 CSV 格式的过程。待检索

的对象名为 exampleobject.json ，该对象存储于北京地域（ap-beijing）的存储桶 examplebucket-

1250000000 中。

            <QuoteEscapeCharacter>"</QuoteEscapeCharacter>

        </CSV>                               

    </OutputSerialization>

</SelectRequest> 

假设您使用列索引筛选对象中的内容，您可以使用 s._n 筛选第 n 列的数据， n 最小为1。如下指令将从对象中

筛选第3列数值大于100的记录，并返回这些记录的第1和第2列： 

SELECT s._1, s._2 FROM COSObject s WHERE s._3 > 100

如果您的 CSV 对象中具有列表头，且您打算使用列表头的名称筛选对象中的内容（将 FileHeaderInfo 设置为

Use ），您可以使用 s.name 进行索引，如下指令将从对象中筛选表头名为 Id 和 FirstName 的对象：

SELECT s.Id, s.FirstName FROM COSObject s

您也可以在 SQL 表达式中指定函数，如下指令将统计出第一列中小于1的记录数：

SELECT count *  FROM COSObject s WHERE s._1 < 1( )

HTTP/1.1 200 OK

x-cos-id-2: cos_id_demo

x-cos-request-id: cos_request_id_demo

Date: Tue, 12 Jan 2019 11:50:29 GMT

A series of messages

示例2:  从 JSON 格式的对象中检索内容

POST /exampleobject.json?select&select-type=2 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 12 Jan 2019 11:52:29 GMT

Authorization: authorization string

https://cloud.tencent.com/document/product/436/37636
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同样的，您也可以对 JSON 对象执行不同的检索指令，可以在 Expression 元素中修改 SQL 指令，有关指令的

详细介绍，请参见 Select 命令 ，以下为部分常见检索场景的简介。

与 GET Object  接口不同， SELECT Object Content 不支持以下功能：

Content-Length: content length

<?xml version="1.0" encoding="UTF-8"?>

<SelectRequest>

    <Expression>Select * from COSObject</Expression>

    <ExpressionType>SQL</ExpressionType>

    <InputSerialization>

        <CompressionType>NONE</CompressionType>

        <JSON>

            <Type>DOCUMENT</Type>

        </JSON>

    </InputSerialization>

    <OutputSerialization>

        <CSV>

            <QuoteFields>ASNEEDED</QuoteFields>

            <RecordDelimiter> n</RecordDelimiter>

            <FieldDelimiter>,</FieldDelimiter>

            <QuoteCharacter>"</QuoteCharacter>

            <QuoteEscapeCharacter>"</QuoteEscapeCharacter>

        </CSV>                               

    </OutputSerialization>

</SelectRequest> 

\

您可以通过 JSON 属性名称检索相应的数据，如下指令将从对象中筛选 city 数值为 Seattle 的记录，并返回

这些记录的 country 和 city 信息：

SELECT s.country, s.city from COSObject s where s.city = 'Seattle'

您也可以在 SQL 表达式中指定函数，如下指令将统计出 JSON 对象中的记录总数：

SELECT count *  FROM COSObject s( )

注意事项

返回对象的某一片段：您不能通过 Range 这类参数指定返回对象的某一部分。

对于归档存储（ARCHIVE）和深度归档存储（DEEP_ARCHIVE）类型的对象，COS Select 无法直接进

行检索，您需要取回数据后再进行操作。

https://cloud.tencent.com/document/product/436/37636
https://cloud.tencent.com/document/product/436/7753
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访问控制（acl）

PUT Object acl
最近更新时间：2023-07-13 18:12:31

PUT Object acl 接口用来写入对象的访问控制列表（ACL），您可以通过请求头 x-cos-acl 和 x-cos-grant-*

传入 ACL 信息，或者通过请求体以 XML 格式传入 ACL 信息。

示例一

示例二

功能描述

注意

通过请求头设置 ACL 和通过请求体设置 ACL，两种方式只能选择其中一种。

PUT Object acl 是一个覆盖操作，传入新的 ACL 将覆盖原有 ACL。

仅可对腾讯云 CAM 主账号或匿名用户授予权限，如需授予子用户或用户组权限请使用 PUT Bucket 

policy  接口。有关 ACL 的详细说明，请参见 ACL 概述 。

该 API 的请求者需要对指定对象有写入 ACL 权限。

请求

请求示例

PUT /<ObjectKey>?acl HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-Length: 0

Authorization: Auth String

PUT /<ObjectKey>?acl HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-Type: application/xml

Content-Length: Content Length

Content-MD5: MD5

Authorization: Auth String

https://cloud.tencent.com/document/product/436/8282
https://cloud.tencent.com/document/product/436/30752
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此接口无请求参数。

此接口除使用公共请求头部外，还支持以下请求头部，了解公共请求头部详情请参见 公共请求头部  文档。

[Request Body]

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

名称 描述
类

型

是否

必选

x-cos-

acl

定义对象的访问控制列表（ACL）属性。枚举值请参见 ACL 概述 文档中
对象的预设 ACL 部分，例如 default，private，public-read 等，默

认为 default<br>注意：如果您不需要进行对象 ACL 控制，请设置为 
default 或者此项不进行设置，默认继承存储桶权限

En

um
否

x-cos-
grant-

read

赋予被授权者读取对象的权限。若被授权者为主账号，格式为 id="

[OwnerUin]"，例如 id="100000000001"；若被授权者为子账号，格
式为 id="[OwnerUin/SubUin]"，例如 

id="100000000001/100000000011"。可使用半角逗号（,）分隔多

组被授权者，例如 id="100000000001",id="100000000002"

stri
ng

否

x-cos-

grant-
read-

acp

赋予被授权者读取对象的访问控制列表（ACL）的权限。若被授权者为主
账号，格式为 id="[OwnerUin]"，例如 id="100000000001"；若被

授权者为子账号，格式为 id="[OwnerUin/SubUin]"，例如 
id="100000000001/100000000011"。可使用半角逗号（,）分隔多

组被授权者，例如 id="100000000001",id="100000000002"

stri
ng

否

x-cos-
grant-

write-
acp

赋予被授权者写入对象的访问控制列表（ACL）的权限。若被授权者为主
账号，格式为 id="[OwnerUin]"，例如 id="100000000001"；若被

授权者为子账号，格式为 id="[OwnerUin/SubUin]"，例如 
id="100000000001/100000000011"。可使用半角逗号（,）分隔多

组被授权者，例如 id="100000000001",id="100000000002"

stri

ng
否

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/30752#.E9.A2.84.E8.AE.BE.E7.9A.84-acl
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提交 application/xml 请求数据，包含对象所有者和完整的授权信息。

具体的节点描述如下：

Container 节点 AccessControlPolicy 的内容：

x-cos-
grant-

full-
control

赋予被授权者操作对象的所有权限。若被授权者为主账号，格式为 id="
[OwnerUin]"，例如 id="100000000001"；若被授权者为子账号，格

式为 id="[OwnerUin/SubUin]"，例如 
id="100000000001/100000000011"。可使用半角逗号（,）分隔多

组被授权者，例如 id="100000000001",id="100000000002"

stri
ng

否

请求体

<AccessControlPolicy>

            <Owner>

                <ID>string</ID>

            </Owner>

            <AccessControlList>

                <Grant>

                    <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:typ

                        <URI>string</URI>

                    </Grantee>

                    <Permission>Enum</Permission>

                </Grant>

                <Grant>

                    <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:typ

                        <ID>string</ID>

                    </Grantee>

                    <Permission>Enum</Permission>

                </Grant>

            </AccessControlList>

</AccessControlPolicy>

节点名称（关键字）
父节

点
描述 类型

是否必

选

AccessControlPoli
cy

无
包含 PUT Object acl 操作的所有请求
信息

Contain
er

是

节点名称（关键字） 父节点 描述 类型
是否必
选

Owner AccessControlPoli

cy

对象持有者信息 Containe

r

是
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Container 节点 AccessControlPolicy.Owner 的内容：

Container 节点 AccessControlPolicy.AccessControlList 的内容：

Container 节点 AccessControlPolicy.AccessControlList.Grant 的内容：

AccessControlLi
st

AccessControlPoli
cy

被授权者信息与权限信
息

Containe
r

是

节点名称

（关键
字）

父节点 描述
类

型

是

否

必
选

ID

AccessC

ontrolPol
icy.Own

er

对象持有者的完整 ID，格式为

qcs::cam::uin/[OwnerUin]:uin/[OwnerUin]

例如 qcs::cam::uin/100000000001:uin/100000000001

st

ri
n

g

是

节点名称
（关键字）

父节点 描述 类型
是否
必选

Grant

AccessContr
olPolicy.

AccessContr
olList

单个授权信息，一个 AccessControlList 最

多只能拥有100条 Grant

Cont

ainer
是

节点

名称
（关

键
字）

父节点 描述
类

型

是
否

必

选

Gra

nte
e

Access

Control
Policy.

Access
Control

List.Gr
ant

被授权者信息， xsi:type 可指定为 Group 或 CanonicalUser，

当指定为 Group 时子节点包括且仅允许包括 URI，当指定为 
CanonicalUser 时子节点包括且仅允许包括 ID

C

o
n

t

ai
n

e
r

是

Per

mis

Access

Control
Policy.

授予的权限信息，枚举值请参见 ACL 概述  文档中对象的操作部分，

例如 READ，FULL_CONTROL 等

E

n

是

https://cloud.tencent.com/document/product/436/30752#.E6.93.8D.E4.BD.9C-permission
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Container 节点 AccessControlPolicy.AccessControlList.Grant.Grantee 的内容：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

sio
n

Access
Control

List.Gr
ant

u
m

节点

名称
（关

键
字）

父节点 描述
类
型

是否必选

URI

AccessCon
trolPolicy.

AccessCon
trolList.Gra

nt.Grantee

预设用户组，请参见 ACL 概述  文档中预设用
户组部分

例如

http://cam.qcloud.com/groups/global/All

Users

或

http://cam.qcloud.com/groups/global/Au

thenticatedUsers

st

ri
n

g

当 Grantee 的

xsi:type 指定

为 Group 时，

必选

ID

AccessCon
trolPolicy.

AccessCon
trolList.Gra

nt.Grantee

被授权者的完整 ID，格式为

qcs::cam::uin/[OwnerUin]:uin/[OwnerUi

n]

例如

qcs::cam::uin/100000000001:uin/10000

0000001

st

ri

n
g

当 Grantee 的

xsi:type 指定

为 
CanonicalUs

er 时，必选

响应

响应头

响应体

错误码

实际案例

案例一：通过请求头设置 ACL

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
https://cloud.tencent.com/document/product/436/30752#.E8.BA.AB.E4.BB.BD-grantee
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请求

PUT /exampleobject?acl HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Mon, 09 Sep 2019 13:11:09 GMT

x-cos-acl: public-read

x-cos-grant-read-acp: id="100000000002"

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Mon, 09 Sep 2019 13:11:10 GMT

Server: tencent-cos

x-cos-request-id: NWQ3NjRmNmRfZjZjMjBiMDlfMmE5MWJfMTI3OWZh****

案例二：通过请求体设置 ACL

请求

PUT /exampleobject?acl HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 10 Sep 2019 06:32:02 GMT

Content-Type: application/xml

Content-Length: 594

Content-MD5: zUPEBc1TeGrqTqEfPV7rxg==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<AccessControlPolicy>

            <Owner>

                <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

            </Owner>

            <AccessControlList>

                <Grant>

                    <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:typ

                        <URI>http://cam.qcloud.com/groups/global/AllUsers</URI>
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                    </Grantee>

                    <Permission>READ</Permission>

                </Grant>

                <Grant>

                    <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:typ

                        <ID>qcs::cam::uin/100000000002:uin/100000000002</ID>

                    </Grantee>

                    <Permission>READ_ACP</Permission>

                </Grant>

            </AccessControlList>

</AccessControlPolicy>

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Tue, 10 Sep 2019 06:32:02 GMT

Server: tencent-cos

x-cos-request-id: NWQ3NzQzNjJfZmVhODBiMDlfMjc5MGVfMTM4OTky****
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GET Object acl
最近更新时间：2021-07-22 10:20:31

GET Object acl 接口用来获取对象的访问控制列表（ACL）。该 API 的请求者需要对指定对象有读取 ACL 权

限。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

此接口无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

请求

请求示例

GET /<ObjectKey>?acl HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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查询成功，返回 application/xml 数据，包含对象所有者和完整的授权信息。

具体的节点描述如下：

Container 节点 AccessControlPolicy 的内容：

Container 节点 AccessControlPolicy.Owner 的内容：

<AccessControlPolicy>

    <Owner>

        <ID>string</ID>

        <DisplayName>string</DisplayName>

    </Owner>

    <AccessControlList>

        <Grant>

            <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="G

                <URI>string</URI>

            </Grantee>

            <Permission>Enum</Permission>

        </Grant>

        <Grant>

            <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="C

                <ID>string</ID>

                <DisplayName>string</DisplayName>

            </Grantee>

            <Permission>Enum</Permission>

        </Grant>

    </AccessControlList>

</AccessControlPolicy>

节点名称（关键字） 父节点 描述 类型

AccessControlPolicy 无 保存 GET Object acl 结果的所有信息 Container

节点名称（关键字） 父节点 描述 类型

Owner AccessControlPolicy 对象持有者信息 Container

AccessControlList AccessControlPolicy 被授权者信息与权限信息 Container

节点名称

（关键字）
父节点 描述

类

型

ID AccessControlPoli
cy.Owner

对象持有者的完整 ID，格式为

qcs::cam::uin/[OwnerUin]:uin/[OwnerUin]

str
in
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Container 节点 AccessControlPolicy.AccessControlList 的内容：

Container 节点 AccessControlPolicy.AccessControlList.Grant 的内容：

Container 节点 AccessControlPolicy.AccessControlList.Grant.Grantee 的内容：

例如

qcs::cam::uin/100000000001:uin/100000000

001

g

DisplayNa
me

AccessControlPoli
cy.Owner

对象持有者的名字
str
in

g

节点名称（关键
字）

父节点 描述 类型

Grant
AccessControlPolicy.AccessControlLis
t

单个授权信
息

Container

节点

名称
（关

键
字）

父节点 描述
类

型

Gra

nte
e

AccessControl

Policy.AccessC

ontrolList.Gran
t

被授权者信息， xsi:type 为 Group 或 CanonicalUser，当为 

Group 时子节点包括且仅包括 URI，当指定为 CanonicalUser 
时子节点包括且仅包括 ID 和 DisplayName

C

o
n

t

ai
n

e
r

Per

mis
sio

n

AccessControl

Policy.AccessC
ontrolList.Gran

t

授予的权限信息，枚举值请参见 ACL 概述  文档中对象的操作部
分，例如 READ，FULL_CONTROL 等

E

n
u

m

节点
名称

（关
键

字）

父节点 描述
类

型

https://cloud.tencent.com/document/product/436/30752#.E6.93.8D.E4.BD.9C-permission
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

URI AccessControlPolicy.A

ccessControlList.Gran
t.Grantee

预设用户组，请参见 ACL 概述  文档中预设用户组部分

例如

http://cam.qcloud.com/groups/global/AllUsers 或

http://cam.qcloud.com/groups/global/Authentic

atedUsers

s

tr
in

g

ID
AccessControlPolicy.A
ccessControlList.Gran

t.Grantee

被授权者的完整 ID，格式为

qcs::cam::uin/[OwnerUin]:uin/[OwnerUin]

例如

qcs::cam::uin/100000000001:uin/10000000000

1

s
tr

in
g

Displ

ayNa
me

AccessControlPolicy.A

ccessControlList.Gran
t.Grantee

被授权者的名字

s

tr
in

g

错误码

实际案例

请求

GET /exampleobject?acl HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 10 Sep 2019 08:29:26 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 742

Connection: close

Date: Tue, 10 Sep 2019 08:29:26 GMT

Server: tencent-cos

x-cos-request-id: NWQ3NzVlZTZfYmIwMmEwOV83YTQ5XzEzNTcx****

<AccessControlPolicy>

    <Owner>

        <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

https://cloud.tencent.com/document/product/436/7730
https://cloud.tencent.com/document/product/436/30752#.E8.BA.AB.E4.BB.BD-grantee
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        <DisplayName>qcs::cam::uin/100000000001:uin/100000000001</DisplayName>

    </Owner>

    <AccessControlList>

        <Grant>

            <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="G

                <URI>http://cam.qcloud.com/groups/global/AllUsers</URI>

            </Grantee>

            <Permission>READ</Permission>

        </Grant>

        <Grant>

            <Grantee xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="C

                <ID>qcs::cam::uin/100000000002:uin/100000000002</ID>

                <DisplayName>qcs::cam::uin/100000000002:uin/100000000002</DisplayNam

            </Grantee>

            <Permission>READ_ACP</Permission>

        </Grant>

    </AccessControlList>

</AccessControlPolicy>
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对象标签

PUT Object tagging
最近更新时间：2022-12-30 14:55:34

COS 支持为已存在的对象设置标签。PUT Object tagging 接口通过为对象添加键值对作为对象标签，可以协助

您分组管理已有的对象资源，详情请参见 对象标签概述 。

如您使用子账号调用此项接口，请确保您已经在主账号处获取了 PUT Object tagging 这个接口的权限。

如果您的存储桶开启了版本控制，并且需要对指定版本的对象添加标签，可以在发起请求时携带 VersionId 参数，

对象标签将添加到指定的对象版本中。

功能描述

注意

目前对象标签功能最多支持一个对象下设置10个不同的标签，如果超出设置上限，COS 将覆盖已有的对象

标签为新的对象标签。

版本控制

请求

请求示例

PUT /<ObjectKey>?tagging&VersionId=VersionId HTTP 1.1

Host:<BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

名称 描述 类型 是否必

https://cloud.tencent.com/document/product/436/42993
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求需要设置如下标签集合：

具体的数据描述如下：

选

versio
nId

当启用版本控制时，指定要操作的对象版本 ID，如不指定则将添加标签到
最新版本的对象

stri
ng

否

请求头

请求体

<?xml version="1.0" encoding="UTF-8" ?>

<Tagging>

  <TagSet>

    <Tag>

      <Key>string</Key>

      <Value>string</Value>

    </Tag>

  </TagSet>

</Tagging>

节点名称

（关键
字）

父节点 描述 类型

是
否

必
选

Taggin

g
无 标签集合

Con

tain
er

是

TagSet Tagging 标签集合

Con

tain

er

是

Tag
Tagging.

TagSet
标签集合，最多支持10个标签

Con
tain

ers

是

Key
Tagging.
TagSet.T

ag

标签键，长度小于128字节，支持英文字母、数字、空格、
加号、减号、下划线、等号、点号、冒号、斜线

Stri
ng

是

https://cloud.tencent.com/document/product/436/7728
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该请求响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

如下请求向存储桶 examplebucket-1250000000 中的对象 exampleobject.txt 写入了 {age:18} 和

{name:xiaoming} 两个标签。COS 配置标签成功并返回200成功请求。

Value Tagging.
TagSet.T

ag

标签值，长度小于256字节，支持英文字母、数字、空
格、加号、减号、下划线、等号、点号、冒号、斜线

Stri
ng

是

响应

响应头

响应体

错误码

实际案例

请求

PUT /exampleobject.txt?tagging HTTP/1.1

User-Agent: curl/7.29.0

Accept: */*

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Authorization: Auth String

Content-Length: 127

Content-MD5:MD5 String

Content-Type: application/xml

<Tagging>

    <TagSet>

        <Tag>

            <Key>age</Key>

            <Value>18</Value>

        </Tag>

        <Tag>

            <Key>name</Key>

            <Value>xiaoming</Value>

        </Tag>

    </TagSet>

</Tagging>

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Fri, 19 Jan 2020 11:40:22 GMT

Server: tencent-cos

x-cos-request-id: NWE2MWQ5MjZfMTBhYzM1MGFfMTA5ODVfMTVj****
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GET Object tagging
最近更新时间：2022-06-08 09:01:17

GET Object tagging 接口用于查询指定对象下已有的对象标签。

如您使用子账号调用此项接口，请确保您已经在主账号处获取了 GET Object tagging 这个接口的权限。

如果您的存储桶开启了版本控制，并且需要查询指定版本的对象的标签，可以在发起请求时携带 VersionId 参数，

此时将查询指定版本对象的标签信息。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

版本控制

请求

请求示例

GET /<ObjectKey>?tagging&VersionId=VersionId HTTP 1.1

Host:<BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

名称 描述 类型
是否必
选

versio
nId

当启用版本控制时，指定要操作的对象版本 ID，如不指定则查询最新版本
对象的对象标签

stri
ng

否

请求头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该请求返回的响应体节点描述如下：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

如下请求申请查询存储桶 examplebucket-1250000000 中的对象 exampleobject.txt 下的标签信息，COS 解

析该请求后并返回该存储桶下已有的 {age:18} 和 {name:xiaoming} 两个标签。

请求体

响应

响应头

响应体

节点名称
（关键

字）

父节点 描述 类型
是否
必选

Tagging 无 标签集合
Cont

ainer
是

TagSet Tagging 标签集合
Cont
ainer

是

Tag
Tagging.Ta

gSet
标签集合，最多支持 10 个标签

Cont

ainer

s

是

Key
Tagging.Ta

gSet.Tag

标签键，长度小于 128 字节，支持英文字母、数
字、空格、加号、减号、下划线、等号、点号、冒

号、斜线

Strin

g
是

Value
Tagging.Ta
gSet.Tag

标签值，长度小于 256 字节，支持英文字母、数
字、空格、加号、减号、下划线、等号、点号、冒

号、斜线

Strin
g

是

错误码

实际案例

请求

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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GET /exampleobject.txt?tagging HTTP/1.1

User-Agent: curl/7.29.0

Accept: */*

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Authorization: Auth String

Content-Md5: MD5 String

Content-Length: 127

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Connection: close

Date: Fri, 19 Jan 2020 11:40:22 GMT

Server: tencent-cos

<Tagging>

    <TagSet>

        <Tag>

            <Key>age</Key>

            <Value>18</Value>

        </Tag>

        <Tag>

            <Key>name</Key>

            <Value>xiaoming</Value>

        </Tag>

    </TagSet>

</Tagging>
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DELETE Object tagging
最近更新时间：2021-07-22 10:21:04

DELETE Object tagging 接口用于删除指定对象下已有的对象标签。

如您使用子账号调用此项接口，请确保您已经在主账号处获取了 DELETE Object tagging 这个接口的权限。

版本控制

如果您的存储桶开启了版本控制，并且需要删除指定版本对象的标签，可以在发起请求时携带 VersionId 参数，此

时将删除指定版本 ID 对象的对象标签集。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

请求

请求示例

DELETE /<ObjecKey>?tagging&VersionId=VersionId HTTP 1.1

Host:<BucketName-APPID>.cos.<Region>.myqcloud.com

Date:date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

名称 描述 类型
是否必
选

versio

nId

当启用版本控制时，指定要操作的对象版本 ID，如不指定则删除最新版

本对象的标签

stri

ng
否

请求头

请求体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该请求无特殊响应体信息。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

如下请求申请删除存储桶 examplebucket-1250000000 中的对象 exampleobject.txt 下已有的标签信息。

COS 解析该请求后删除该对象中的所有标签。

响应

响应头

响应体

错误码

实际案例

案例一：删除对象标签（未开启版本控制）

请求

DELETE /exampleobject.txt?tagging HTTP/1.1

User-Agent: curl/7.29.0

Accept: */*

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Authorization: Auth String

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 204 No Content

Content-Type: application/xml

Connection: close

Date: Fri, 19 Jan 2020 11:40:22 GMT

案例二：删除对象标签（开启版本控制）

请求

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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如下请求申请删除存储桶 examplebucket-1250000000 中的对象 exampleobject.txt 下已有的标签信息，删

除时指定对象版本号为 MTg0NDUxNTgwODg2MTEzMTQyOTI 。COS解析该请求后删除该版本的对象中的所

有标签。

DELETE /exampleobject.txt?tagging&VersionId=MTg0NDUxNTgwODg2MTEzMTQyOTI  HTT

User-Agent: curl/7.29.0

Accept: */*

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Authorization: Auth String

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 204 No Content

Content-Type: application/xml

Connection: close

Date: Fri, 19 Jan 2020 11:45:22 GMT



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第452 共1701页

分块上传

Initiate Multipart Upload
最近更新时间：2022-11-25 14:43:24

Initiate Multipart Upload 接口请求实现初始化分块上传，成功执行此请求后将返回 UploadId，用于后续的 

Upload Part 请求。

此接口无请求参数。

此接口除使用公共请求头部外，还支持以下请求头部，了解公共请求头部详情请参见 公共请求头部  文档。

功能描述

说明

只有主账号或者被授权 Initiate Multipart Upload 接口权限的子账号可以调用该接口。

请求

请求示例

POST /<ObjectKey>?uploads HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-Type: Content Type

Content-Length: 0

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

请求头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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名称 描述 类
型

是
否

必
选

Cac

he-
Con

trol

RFC 2616 中定义的缓存指令，将作为对象元数据保存

s

tr
in

g

否

Con

tent
-

Disp
ositi

on

RFC 2616 中定义的文件名称，将作为对象元数据保存

s
tr

in
g

否

Con
tent

-
Enc

odin
g

RFC 2616 中定义的编码格式，将作为对象元数据保存

s

tr
in

g

否

Con
tent

-
Typ

e

RFC 2616 中定义的 HTTP 请求内容类型（MIME），此头部用于描述待上传对

象的内容类型，将作为对象元数据保存。

例如 text/html 或 image/jpeg

s

tr
in

g

是

Expi

res
RFC 2616 中定义的缓存失效时间，将作为对象元数据保存

s
tr

in
g

否

x-
cos

-
met

a-*

包括用户自定义元数据头部后缀和用户自定义元数据信息，将作为对象元数据保存，

大小限制为2KB
注意：用户自定义元数据信息支持下划线（_），但用户自定义元数据头部后缀不支

持下划线，仅支持减号（-）

s

tr
in

g

否

x-
cos

-
stor

age

-

对象存储类型。枚举值请参见 存储类型  文档，例如 MAZ_STANDARD，
MAZ_STANDARD_IA，INTELLIGENT_TIERING，

MAZ_INTELLIGENT_TIERING，STANDARD_IA，ARCHIVE，
DEEP_ARCHIVE。默认值：STANDARD

E
n

u
m

否

https://cloud.tencent.com/document/product/436/33417
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访问控制列表（ACL）相关头部

在上传对象时可以通过指定下列请求头部来设置对象的访问权限：

服务端加密（SSE）相关头部

在上传对象时可以使用服务端加密，请参见 服务端加密专用头部 。

clas
s

x-
cos

-
tagg

ing

对象的标签集合，最多可设置10个标签（例如，

Key1=Value1&Key2=Value2）。 标签集合中的 Key 和 Value 必须先进行 
URL 编码。

s

tr
in

g

否

名称 描述
类
型

是

否
必

选

x-cos-

acl

定义对象的访问控制列表（ACL）属性。枚举值请参见 ACL 概述  文档中对象

的预设 ACL 部分，例如 default，private，public-read 等，默认为 
default。

注意：如果您不需要进行对象 ACL 控制，请设置为 default 或者此项不进行设
置，默认继承存储桶权限

E
n

u
m

否

x-cos-

grant-
read

赋予被授权者读取对象的权限，格式为 id="[OwnerUin]"，例如 

id="100000000001"，可使用半角逗号（,）分隔多组被授权者，例如

id="100000000001",id="100000000002"

s

tr
in

g

否

x-cos-

grant-
read-

acp

赋予被授权者读取对象的访问控制列表（ACL）的权限，格式为 id="
[OwnerUin]"，例如 id="100000000001"，可使用半角逗号（,）分隔多组

被授权者，例如 id="100000000001",id="100000000002"

s

tr
in

g

否

x-cos-
grant-

write-
acp

赋予被授权者写入对象的访问控制列表（ACL）的权限，格式为 id="
[OwnerUin]"，例如 id="100000000001"，可使用半角逗号（,）分隔多组

被授权者，例如 id="100000000001",id="100000000002"

s
tr

in
g

否

x-cos-

grant-

full-
control

赋予被授权者操作对象的所有权限，格式为 id="[OwnerUin]"，例如 

id="100000000001"，可使用半角逗号（,）分隔多组被授权者，例如

id="100000000001",id="100000000002"

s

tr

in
g

否

https://cloud.tencent.com/document/product/436/7728#.E6.9C.8D.E5.8A.A1.E7.AB.AF.E5.8A.A0.E5.AF.86.E4.B8.93.E7.94.A8.E5.A4.B4.E9.83.A8
https://cloud.tencent.com/document/product/436/30752#.E9.A2.84.E8.AE.BE.E7.9A.84-acl
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此接口无请求体。

此接口除返回公共响应头部外，还返回以下响应头部，了解公共响应头部详情请参见 公共响应头部  文档。

服务端加密（SSE）相关头部

如果在上传对象时使用了服务端加密，则此接口将返回服务端加密专用头部，请参见 服务端加密专用头部 。

请求成功，返回 application/xml 数据，包含分块上传初始化信息。

具体的节点描述如下：

Container 节点 InitiateMultipartUploadResult 的内容：

请求体

响应

响应头

响应体

<InitiateMultipartUploadResult>

       <Bucket>string</Bucket>

       <Key>string</Key>

       <UploadId>string</UploadId>

</InitiateMultipartUploadResult>

节点名称（关键字）
父节

点
描述 类型

InitiateMultipartUploadRe
sult

无
保存 Initiate Multipart Upload 结果的所
有信息

Contain
er

节点名称（关键

字）
父节点 描述 类型

Bucket
InitiateMultipartUploadRe

sult
目标存储桶

strin

g

Key
InitiateMultipartUploadRe
sult

目标对象键
strin
g

UploadId
InitiateMultipartUploadRe

sult

在后续 Upload Part 中使用的 

UploadId

strin

g

错误码

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7729#.E6.9C.8D.E5.8A.A1.E7.AB.AF.E5.8A.A0.E5.AF.86.E4.B8.93.E7.94.A8.E5.A4.B4.E9.83.A8
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

实际案例

案例一：简单案例

请求

POST /exampleobject?uploads HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 25 Mar 2020 10:07:01 GMT

Content-Type: video/mp4

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: close

Date: Wed, 25 Mar 2020 10:07:01 GMT

Server: tencent-cos

x-cos-request-id: NWU3YjJkNDVfNDliNTJhMDlfYzZhMl8yOTVj****

<InitiateMultipartUploadResult>

            <Bucket>examplebucket-1250000000</Bucket>

            <Key>exampleobject</Key>

            <UploadId>1585130821cbb7df1d11846c073ad648e8f33b087cec2381df437acdc

</InitiateMultipartUploadResult>

案例二：使用请求头部指定元数据和 ACL

请求

POST /exampleobject?uploads HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 28 May 2020 08:35:34 GMT

Content-Type: video/mp4

Cache-Control: max-age=86400

Content-Disposition: attachment; filename=example.jpg

https://cloud.tencent.com/document/product/436/7730
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x-cos-meta-example-field: example-value

x-cos-acl: public-read

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: close

Date: Thu, 28 May 2020 08:35:34 GMT

Server: tencent-cos

x-cos-request-id: NWVjZjc3ZDZfOThjMjJhMDlfMjg5N18zNWYy****

<InitiateMultipartUploadResult>

            <Bucket>examplebucket-1250000000</Bucket>

            <Key>exampleobject</Key>

            <UploadId>1590654934dfb1343b4323b711afc22569c18af51596d4f2e40faf392fe

</InitiateMultipartUploadResult>

案例三：使用服务端加密 SSE-COS

请求

POST /exampleobject?uploads HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 28 May 2020 08:43:58 GMT

Content-Type: video/mp4

x-cos-server-side-encryption: AES256

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: close
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Date: Thu, 28 May 2020 08:43:58 GMT

Server: tencent-cos

x-cos-request-id: NWVjZjc5Y2VfZjhjODBiMDlfMjIyOGFfMzYxYWVm****

x-cos-server-side-encryption: AES256

<InitiateMultipartUploadResult>

            <Bucket>examplebucket-1250000000</Bucket>

            <Key>exampleobject</Key>

            <UploadId>15906554384f160dd0a272ebb6fbcdb0ffbb61adb2b46fa6b9f2ffabcfb2

</InitiateMultipartUploadResult>

案例四：使用服务端加密 SSE-KMS

请求

POST /exampleobject?uploads HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 28 May 2020 08:44:19 GMT

Content-Type: video/mp4

x-cos-server-side-encryption: cos/kms

x-cos-server-side-encryption-cos-kms-key-id: 48ba38aa-26c5-11ea-855c-52540085****

x-cos-server-side-encryption-context: eyJhdXRob3IiOiJmeXNudGlhbiIsImNvbXBhbnkiOiJUZ

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: close

Date: Thu, 28 May 2020 08:44:20 GMT

Server: tencent-cos

x-cos-request-id: NWVjZjc5ZTNfMmZiOTJhMDlfMzJlNDJfMjkzNGJi****

x-cos-server-side-encryption: cos/kms

x-cos-server-side-encryption-cos-kms-key-id: 48ba38aa-26c5-11ea-855c-52540085****

<InitiateMultipartUploadResult>

            <Bucket>examplebucket-1250000000</Bucket>
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            <Key>exampleobject</Key>

            <UploadId>15906554607990121702e8e4b706eb0f12b8568a3f3b0b76b884e4df6

</InitiateMultipartUploadResult>

案例五：使用服务端加密 SSE-C

请求

POST /exampleobject?uploads HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Thu, 28 May 2020 08:44:41 GMT

Content-Type: video/mp4

x-cos-server-side-encryption-customer-algorithm: AES256

x-cos-server-side-encryption-customer-key: MDEyMzQ1Njc4OUFCQ0RFRjAxMjM0NTY3ODlB

x-cos-server-side-encryption-customer-key-MD5: U5L61r7jcwdNvT7frmUG8g==

Content-Length: 0

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: close

Date: Thu, 28 May 2020 08:44:41 GMT

Server: tencent-cos

x-cos-request-id: NWVjZjc5ZjlfOGJjOTJhMDlfNzJmYV8xOTcy****

x-cos-server-side-encryption-customer-algorithm: AES256

x-cos-server-side-encryption-customer-key-MD5: U5L61r7jcwdNvT7frmUG8g==

<InitiateMultipartUploadResult>

            <Bucket>examplebucket-1250000000</Bucket>

            <Key>exampleobject</Key>

            <UploadId>15906554815fb0c8bda2edae20d895ad7452e949bf51541b31ca14a02

</InitiateMultipartUploadResult>
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Upload Part
最近更新时间：2023-08-14 16:10:12

Upload Part 接口请求实现将对象按照分块的方式上传到 COS。最多支持10000分块，每个分块大小为1MB - 

5GB，最后一个分块可以小于1MB。

1. 分块上传首先需要进行初始化，使用 Initiate Multipart Upload  接口实现，初始化后将得到一个 UploadId

（用于唯一标识本次上传）。

2. 在每次请求 Upload Part 时，需要携带 partNumber（块的编号） 和 uploadId，支持乱序上传。

功能描述

分块上传步骤说明

注意：

如果传入 uploadId 和 partNumber 都相同时，后发起上传请求的块将覆盖之前已传入的块。如

果分块上传的对象刚好为低频存储/低频存储（多 AZ）、归档存储或者深度归档存储类型的对象，则

覆盖操作将会产生提前删除费用，详情请参见 关于提前删除的说明 。

如果传入的 uploadId 不存在，将返回404错误 NoSuchUpload。

只有主账号或者被授权 Upload Part 接口权限的子账号可以调用该接口。

请求

请求示例

PUT /<ObjectKey>?partNumber=PartNumber&uploadId=UploadId HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-Type: Content Type

Content-Length: Content Length

Content-MD5: MD5

Authorization: Auth String

[Object Part]

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

https://cloud.tencent.com/document/product/436/7746
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
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此接口除使用公共请求头部外，还支持以下请求头部，了解公共请求头部详情请参见 公共请求头部  文档。

服务端加密（SSE）相关头部

如果当前分块上传在初始化时使用了 SSE-C，那么在上传分块时需指定与初始化分块上传时所指定的加密算法和

密钥信息，否则不能指定下列头部。

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

名称 描述 类型 是否必选

ObjectKe
y

对象键（Object 的名称），对象在存储桶中的唯一标识，详
情请参见 对象概述 

string 是

partNum

ber
标识本次分块上传的编号，范围在1 - 10000 integer 是

uploadId
标识本次分块上传的 ID，使用 Initiate Multipart Upload 

接口初始化分块上传时得到的 UploadId
string 是

请求头

名称 描述
类

型

是否必

选

x-cos-server-side-
encryption-customer-

algorithm

服务端加密算法，目前仅支持 AES256
str
ing

是

x-cos-server-side-

encryption-customer-key

服务端加密密钥的 Base64 编码

例如

MDEyMzQ1Njc4OUFCQ0RFRjAxMjM0NT

Y3ODlBQkNERUY=

str

ing
是

x-cos-server-side-
encryption-customer-key-

MD5

服务端加密密钥的 MD5 哈希值，使用 
Base64 编码

例如 U5L61r7jcwdNvT7frmUG8g==

str

ing
是

x-cos-traffic-limit

针对本分块上传进行流量控制的限速值，必须
为数字，单位默认为 bit/s。限速值设置范围为

819200 - 838860800，即800Kb/s-
800Mb/s，如果超出该范围将返回400错误

int

eg

er

否

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/13324
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此接口请求的请求体为对象（文件）分块内容。

此接口除返回公共响应头部外，还返回以下响应头部，了解公共响应头部详情请参见 公共响应头部  文档。

服务端加密（SSE）相关头部

如果当前分块上传在初始化时使用了服务端加密，则此接口将返回服务端加密专用头部，请参见 服务端加密专用头

部 。

此接口响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

请求体

响应

响应头

响应体

错误码

实际案例

案例一：简单案例

请求

PUT /exampleobject?partNumber=1&uploadId=1585130821cbb7df1d11846c073ad648e8

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 25 Mar 2020 10:07:14 GMT

Content-Type: application/octet-stream

Content-Length: 1048576

Content-MD5: OScKloo1fSQgfpkRFiUH6w==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

[Object Part]

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Wed, 25 Mar 2020 10:07:14 GMT

ETag: "39270a968a357d24207e9911162507eb"

Server: tencent-cos

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7729#.E6.9C.8D.E5.8A.A1.E7.AB.AF.E5.8A.A0.E5.AF.86.E4.B8.93.E7.94.A8.E5.A4.B4.E9.83.A8
https://cloud.tencent.com/document/product/436/7730
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x-cos-hash-crc64ecma: 9973912126177188060

x-cos-request-id: NWU3YjJkNTJfZDBjODJhMDlfMjU4NTZfMjc5MzBh****

案例二：使用服务端加密 SSE-COS

请求

PUT /exampleobject?partNumber=1&uploadId=1590862540251355295a5c736513d70d4

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Sat, 30 May 2020 18:15:50 GMT

Content-Type: application/octet-stream

Content-Length: 13

Content-MD5: EI9SjrY7Zec08nrjMfX/qg==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

[Object Part]

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Sat, 30 May 2020 18:15:51 GMT

ETag: "108f528eb63b65e734f27ae331f5ffaa"

Server: tencent-cos

x-cos-hash-crc64ecma: 4510578591875220731

x-cos-request-id: NWVkMmEyZDZfYjNjMjJhMDlfMmJlM18zOWI2****

x-cos-server-side-encryption: AES256

案例三：使用服务端加密 SSE-KMS

请求

PUT /exampleobject?partNumber=1&uploadId=15908625793957d71176fa878282d266a

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Sat, 30 May 2020 18:16:29 GMT

Content-Type: application/octet-stream

Content-Length: 13

Content-MD5: EI9SjrY7Zec08nrjMfX/qg==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close
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[Object Part]

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Sat, 30 May 2020 18:16:30 GMT

ETag: "1d3e8ae9da423b440341b09f1616f074"

Server: tencent-cos

x-cos-hash-crc64ecma: 4510578591875220731

x-cos-request-id: NWVkMmEyZmRfYTRiOTJhMDlfMTE0ZGRfMmE3OTk4****

x-cos-server-side-encryption: cos/kms

x-cos-server-side-encryption-cos-kms-key-id: 48ba38aa-26c5-11ea-855c-52540085****

案例四：使用服务端加密 SSE-C

请求

PUT /exampleobject?partNumber=1&uploadId=1590862610acd643927bad05cd3947bf98

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Sat, 30 May 2020 18:17:01 GMT

x-cos-server-side-encryption-customer-algorithm: AES256

x-cos-server-side-encryption-customer-key: MDEyMzQ1Njc4OUFCQ0RFRjAxMjM0NTY3ODlB

x-cos-server-side-encryption-customer-key-MD5: U5L61r7jcwdNvT7frmUG8g==

Content-Type: application/octet-stream

Content-Length: 13

Content-MD5: EI9SjrY7Zec08nrjMfX/qg==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

[Object Part]

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: close

Date: Sat, 30 May 2020 18:17:01 GMT

ETag: "ff14981a35a58eb97bca838b055c573b"

Server: tencent-cos

x-cos-hash-crc64ecma: 4510578591875220731

x-cos-request-id: NWVkMmEzMWRfYjRjOTJhMDlfYWRhXzFhZmYw****
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x-cos-server-side-encryption-customer-algorithm: AES256

x-cos-server-side-encryption-customer-key-MD5: U5L61r7jcwdNvT7frmUG8g==
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Upload Part - Copy
最近更新时间：2022-11-25 14:43:36

Upload Part - Copy  请求用于实现将一个对象的分块内容从源路径复制到目标路径。通过指定 x-cos-copy-

source 来指定源对象，x-cos-copy-source-range 指定字节范围（允许分块的大小为1MB - 5GB）。

当存储桶启用了版本控制，x-cos-copy-source 标识被复制的对象的当前版本。如果当前版本是删除标记，并

且 x-cos-copy-source 不指定版本，则对象存储会认为该对象已删除并返回404错误。如果您在 x-cos-

copy-source 中指定 versionId 且 versionId 是删除标记，则对象存储会返回 HTTP 400错误，因为删除标

记不允许作为 x-cos-copy-source 的版本。

功能描述

说明

以下两种情况拥有调用此 API 的权限：

拥有主账号权限。

拥有源对象 GetObjecet 接口权限，且在目标路径下有 InitiateMultipartUpload、

ListMultipartUploads、ListParts、PutObject、CompleteMultipartUpload、

AbortMultipartUpload 接口权限。

注意

使用 Upload Part - Copy 接口前，需先使用 Initiate Multipart Upload  接口初始化分块上传任

务并指定目标路径。

如果目标对象和源对象不属于同一个地域，且目标对象分块会超过5GB，那么需要使用分块上传或者分

块拷贝的接口来复制对象。

使用上传分块对象，必须先初始化分块上传。在初始化分块上传的响应中，会返回一个唯一的描述符

（upload ID），您需要在分块上传请求中携带此 ID。

版本控制

请求

请求示例

PUT /<ObjectKey>?partNumber=PartNumber&uploadId=UploadId  HTTP/1.1

Host: <Bucketname-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

x-cos-copy-source: <Bucketname>-<APPID>.cos.<Region>.myqcloud.com/filepath

https://cloud.tencent.com/document/product/436/7746
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该请求操作的实现使用公共请求头，了解公共请求头详情请参见 公共请求头部  文档。

必选头部

该请求操作的实现使用如下必选头部：

推荐头部

该请求操作的实现使用如下推荐请求头部信息：

x-cos-copy-source-range: bytes=first-last

x-cos-copy-source-if-match: etag

x-cos-copy-source-if-none-match : etag

x-cos-copy-source-if-unmodified-since: time_stamp

x-cos-copy-source-if-modified-since: time_stamp

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

公共头部

非公共头部

名称 描述 类型
是否必

选

x-cos-copy-
source

源对象 URL 路径，可以通过 versionid 子资源指定历
史版本

Strin
g

是

名称 描述
类

型

是
否

必

选

x-cos-
copy-

source-
range

源对象的字节范围，范围值必须使用 bytes=first-last 格式，first 和 
last 都是基于 0 开始的偏移量。

例如 bytes=0-9 表示您希望拷贝源对象的开头10个字节的数据，如果
不指定，则表示拷贝整个对象

St
ri

n
g

否

x-cos- 当 Object 在指定时间后被修改，则执行操作，否则返回412， St 否

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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该请求的请求体为空。

copy-
source-If-

Modified-
Since

可与 x-cos-copy-source-If-None-Match 一起使用，与其他条
件联合使用返回冲突

ri
n

g

x-cos-
copy-

source-If-
Unmodified-

Since

当 Object 在指定时间后未被修改，则执行操作，否则返回412，

可与 x-cos-copy-source-If-Match 一起使用，与其他条件联合
使用返回冲突

St

ri
n

g

否

x-cos-
copy-

source-If-
Match

当 Object 的 Etag 和给定一致时，则执行操作，否则返回412，
可与 x-cos-copy-source-If-Unmodified-Since 一起使用，与

其他条件联合使用返回冲突

St
ri

n
g

否

x-cos-
copy-

source-If-
None-

Match

当 Object 的 Etag 和给定不一致时，则执行操作，否则返回412，

可与 x-cos-copy-source-If-Modified-Since 一起使用，与其
他条件联合使用返回冲突

St

ri
n

g

否

请求参数

名称 描述
类

型

是
否

必
选

part

Num
ber

分块拷贝的块号

S

tr
in

g

是

uplo
adId

使用上传分块文件，必须先初始化分块上传。在初始化分块上传的响应中，会返回
一个唯一的描述符（upload ID），您需要在分块上传请求中携带此 ID

S

tr
in

g

是

请求体

响应

响应头
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该响应包含公共响应头，了解公共响应头详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的节点描述如下：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

公共响应头

特有响应头

名称                                           描述
类
型

x-cos-copy-

source-version-id
如果已在源存储桶上启用版本控制，则复制源对象的版本

Str

ing

x-cos-server-side-
encryption

如果通过 COS 管理的服务端加密来存储对象，响应将包含此头部和
所使用的加密算法的值，AES256

Str
ing

响应体

<?xml version="1.0" encoding="UTF-8" ?>

<CopyPartResult>

   <ETag>"ba82b57cfdfda8bd17ad4e5879ebb4fe"</ETag>

   <LastModified>2017-09-04T04:45:45</LastModified>

</CopyPartResult>

名称 描述 类型

CopyPartRes
ult

返回复制结果信息
Strin
g

ETag
返回对象的 MD5 算法校验值，ETag 的值可以用于检查 Object 的内容是

否发生变化

Strin

g

LastModified 返回对象最后修改时间，GMT 格式
Strin
g

错误码

实际案例

请求

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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PUT /exampleobject?partNumber=1&uploadId=1505706248ca8373f8a5cd52cb129f4bcf8

User-Agent: curl/7.19.7 x86_64-redhat-linux-gnu  libcurl/7.19.7 NSS/3.13.1.0 zlib/1.2.3 lib

Accept: */*

x-cos-copy-source:examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/exampleo

x-cos-copy-source-range: bytes=10-100

Host: examplebucket-1250000000.cos.ap-shanghai.myqcloud.com

Authorization:q-sign-algorithm=sha1&q-ak=AKIDDNMEycgLRPI2axw9xa2Hhx87wZ3M****

( )

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 133 

Connection: keep-alive 

Date: Mon, 04 Sep 2017 04:45:45 GMT

Server: tencent-cos

x-cos-request-id: NTlkYjFjYWJfMjQ4OGY3MGFfNGIz****

<CopyPartResult>

   <ETag>"ba82b57cfdfda8bd17ad4e5879ebb4fe"</ETag>

   <LastModified>2017-09-04T04:45:45</LastModified>

</CopyPartResult>
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Complete Multipart Upload
最近更新时间：2022-11-25 14:43:41

Complete Multipart Upload 接口请求用来实现完成整个分块上传。当使用 Upload Part 上传所有分块完成

后，必须调用该 API 来完成整个文件的分块上传。在使用该 API 时，您必须在请求体中给出每一个块的 

PartNumber 和 ETag，用来校验块的准确性。

由于分块上传完成后需要合并，而合并需要数分钟时间，因而当合并分块开始时，COS 会立即返回200的状态码并

指定 Transfer-Encoding: chunked 响应头部，在合并的过程中，COS 会周期性的使用 chunked 方式返回

空格信息来保持连接活跃，直到合并完成，COS 会在最后一个 chunk 中返回合并完成后整个对象的信息。

功能描述

当上传的分块小于1MB的时候，在调用该 API 时，会返回400 EntityTooSmall。

当上传块编号不连续的时候，在调用该 API 时，会返回400 InvalidPart。

当请求 Body 中的块信息没有按序号从小到大排列的时候，在调用该 API 时，会返回400 

InvalidPartOrder。

当 UploadId 不存在的时候，在调用该 API 时，会返回404 NoSuchUpload。

说明

只有主账号或者被授权 Complete Multipart Upload 接口权限的子账号可以调用该接口。

注意

 建议您及时完成分块上传或者舍弃分块上传，因为已上传但是未终止的块会占用存储空间进而产生存储费

用。

版本控制

如果对存储桶启用版本控制，对象存储将自动为要添加的对象生成唯一的版本 ID。对象存储使用 x-cos-

version-id 响应头部在响应中返回此标识。

如果暂停存储桶的版本控制，则对象存储始终将 null 用作存储在存储桶中的对象的版本 ID，并返回 x-cos-

version-id: null 响应头部。

请求

请求示例

POST /<ObjectKey>?uploadId=UploadId HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

提交 application/xml 请求数据，包含所有分块信息。

具体的节点描述如下：

Content-Type: application/xml

Content-Length: Content Length

Content-MD5: MD5

Authorization: Auth String

[Request Body]

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

名称 描述
类
型

是否
必选

uplo

adId

标识本次分块上传的 ID，使用 Initiate Multipart Upload 接口初始化分块

上传时得到的 UploadId。

stri

ng
是

请求头

请求体

<CompleteMultipartUpload>

    <Part>

        <PartNumber>integer</PartNumber>

        <ETag>string</ETag>

    </Part>

    <Part>

        <PartNumber>integer</PartNumber>

        <ETag>string</ETag>

    </Part>

</CompleteMultipartUpload>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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Container 节点 CompleteMultipartUpload 的内容：

Container 节点 Part 的内容：

此接口除返回公共响应头部外，还返回以下响应头部，了解公共响应头部详情请参见 公共响应头部  文档。

版本控制相关头部

在启用版本控制的存储桶中上传对象，将返回下列响应头部：

服务端加密（SSE）相关头部

如果在上传对象时使用了服务端加密，则此接口将返回服务端加密专用头部，请参见 服务端加密专用头部 。

请求成功，返回 application/xml 数据，包含合并完成后的整个对象信息。

节点名称（关键字） 父
节

点

描述 类型 是否
必选

CompleteMultipart

Upload
无

包含 Complete Multipart Upload 操作的

所有请求信息

Contai

ner
否

节点名称（关键
字）

父节点 描述 类型
是否必
选

Part
CompleteMultipartU

pload

用来说明本次分块上传中每个

块的信息

Contai

ner
是

节点名称（关
键字）

父节点 描述
类
型

是否
必选

PartNumb

er

CompleteMultipa

rtUpload.Part
块编号

int
eg

er

是

ETag
CompleteMultipa
rtUpload.Part

使用 Upload Part 请求上传分块成功后返
回的 ETag 响应头部的值

stri
ng

是

响应

响应头

名称 描述 类型

x-cos-version-id 对象的版本 ID string

响应体

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7729#.E6.9C.8D.E5.8A.A1.E7.AB.AF.E5.8A.A0.E5.AF.86.E4.B8.93.E7.94.A8.E5.A4.B4.E9.83.A8
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具体的节点描述如下：

Container 节点 CompleteMultipartUploadResult 的内容：

<?xml version="1.0" encoding="UTF-8"?>

<CompleteMultipartUploadResult xmlns="http://www.qcloud.com/document/product/436/

    <Location>string</Location>

    <Bucket>string</Bucket>

    <Key>string</Key>

    <ETag>string</ETag>

</CompleteMultipartUploadResult>

节点名称（关键字）
父节

点
描述 类型

CompleteMultipartUpload
Result

无
保存 Complete Multipart Upload 结果的
所有信息

Contain
er

节

点
名

称
（

关
键

字

）

父节点 描述
类
型

Lo
cat

ion

Complet

eMultipa
rtUpload

Result

分块上传完成的对象位置，格式为

http://<BucketName-APPID>.cos.

<Region>.myqcloud.com/<ObjectKey>

，例如

http://examplebucket-1250000000.cos.ap-

beijing.myqcloud.com/exampleobject

s

tr
in

g

Bu

ck
et

Complet

eMultipa
rtUpload

Result

分块上传的目标存储桶，格式为 <BucketName-APPID> ，例如

examplebucket-1250000000

s

tr
in

g

Ke

y

Complet
eMultipa

rtUpload

Result

对象键

s
tr

in

g
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

此接口响应默认为 Transfer-Encoding: chunked 编码方式，为了方便阅读，本文档实际案例均采用无 

Transfer-Encoding 的方式展示，在使用过程中，不同语言和库可以自动处理这种编码形式，请开发者注意识别

和处理，更多信息请查阅语言和库的相关文档。

ET
ag

Complet
eMultipa

rtUpload
Result

分块合并后的对象 ETag 值 s
tr

in
g

错误码

实际案例

案例一：简单案例（未启用版本控制）

请求

POST /exampleobject?uploadId=1585130821cbb7df1d11846c073ad648e8f33b087cec23

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 25 Mar 2020 10:07:26 GMT

Content-Type: application/xml

Content-Length: 353

Content-MD5: Me/0Gvtc2x4VPIOhoIRllw==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<CompleteMultipartUpload>

    <Part>

        <PartNumber>1</PartNumber>

        <ETag>"39270a968a357d24207e9911162507eb"</ETag>

    </Part>

    <Part>

        <PartNumber>2</PartNumber>

        <ETag>"d899fbd1e06109ea2e4550f5751c88d6"</ETag>

    </Part>

    <Part>

        <PartNumber>3</PartNumber>

        <ETag>"762890d6c9a871b7bd136037cb2260cd"</ETag>

    </Part>

</CompleteMultipartUpload>

响应

https://cloud.tencent.com/document/product/436/7730
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 378

Connection: close

Date: Wed, 25 Mar 2020 10:07:26 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 2290339086971918696

x-cos-request-id: NWU3YjJkNWVfZDFjODJhMDlfMTk2ODJfMmEyNTA0****

<?xml version="1.0" encoding="UTF-8"?>

<CompleteMultipartUploadResult xmlns="http://www.qcloud.com/document/product/436/

    <Location>http://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleo

    <Bucket>examplebucket-1250000000</Bucket>

    <Key>exampleobject</Key>

    <ETag>&quot;aa259a62513358f69e98e72e59856d88-3&quot;</ETag>

</CompleteMultipartUploadResult>

案例二：使用服务端加密 SSE-COS

请求

POST /exampleobject?uploadId=1590862540251355295a5c736513d70d42b92bbde4f0fa

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Sat, 30 May 2020 18:16:08 GMT

Content-Type: application/xml

Content-Length: 153

Content-MD5: wmpyfdr9s/A+VCBwDdC1bA==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<CompleteMultipartUpload>

    <Part>

        <PartNumber>1</PartNumber>

        <ETag>"108f528eb63b65e734f27ae331f5ffaa"</ETag>

    </Part>

</CompleteMultipartUpload>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 378

Connection: close

Date: Sat, 30 May 2020 18:16:08 GMT
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Server: tencent-cos

x-cos-hash-crc64ecma: 4510578591875220731

x-cos-request-id: NWVkMmEyZThfYTJjMjJhMDlfMmQzOV8zYTM5****

x-cos-server-side-encryption: AES256

<?xml version="1.0" encoding="UTF-8"?>

<CompleteMultipartUploadResult xmlns="http://www.qcloud.com/document/product/436/

    <Location>http://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleo

    <Bucket>examplebucket-1250000000</Bucket>

    <Key>exampleobject</Key>

    <ETag>&quot;915fca1c3b2737c262458b3a1a43c683-1&quot;</ETag>

</CompleteMultipartUploadResult>

案例三：使用服务端加密 SSE-KMS

请求

POST /exampleobject?uploadId=15908625793957d71176fa878282d266a95b79dc2aec15

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Sat, 30 May 2020 18:16:40 GMT

Content-Type: application/xml

Content-Length: 153

Content-MD5: jUFgTSZThmPT3qseea0mRQ==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<CompleteMultipartUpload>

    <Part>

        <PartNumber>1</PartNumber>

        <ETag>"1d3e8ae9da423b440341b09f1616f074"</ETag>

    </Part>

</CompleteMultipartUpload>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 378

Connection: close

Date: Sat, 30 May 2020 18:16:40 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 4510578591875220731

x-cos-request-id: NWVkMmEzMDhfYzhjODJhMDlfMjNhYTBfMjdmNjNl****

x-cos-server-side-encryption: cos/kms
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x-cos-server-side-encryption-cos-kms-key-id: 48ba38aa-26c5-11ea-855c-52540085****

<?xml version="1.0" encoding="UTF-8"?>

<CompleteMultipartUploadResult xmlns="http://www.qcloud.com/document/product/436/

    <Location>http://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleo

    <Bucket>examplebucket-1250000000</Bucket>

    <Key>exampleobject</Key>

    <ETag>&quot;8093dc3e18f7070444e6ca21789eb8d4-1&quot;</ETag>

</CompleteMultipartUploadResult>

案例四：使用服务端加密 SSE-C

请求

POST /exampleobject?uploadId=1590862610acd643927bad05cd3947bf98b56b04b0b0b2

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Sat, 30 May 2020 18:17:11 GMT

Content-Type: application/xml

Content-Length: 153

Content-MD5: MnXmb3yvrbwMfBlUwUE1Hg==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<CompleteMultipartUpload>

    <Part>

        <PartNumber>1</PartNumber>

        <ETag>"ff14981a35a58eb97bca838b055c573b"</ETag>

    </Part>

</CompleteMultipartUpload>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 378

Connection: close

Date: Sat, 30 May 2020 18:17:11 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 4510578591875220731

x-cos-request-id: NWVkMmEzMjdfODljOTJhMDlfMzQ2ZDNfMWMwZWYy****

x-cos-server-side-encryption-customer-algorithm: AES256

x-cos-server-side-encryption-customer-key-MD5: U5L61r7jcwdNvT7frmUG8g==
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<?xml version="1.0" encoding="UTF-8"?>

<CompleteMultipartUploadResult xmlns="http://www.qcloud.com/document/product/436/

    <Location>http://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleo

    <Bucket>examplebucket-1250000000</Bucket>

    <Key>exampleobject</Key>

    <ETag>&quot;55973f71e8e892273053617e6b83d1c7-1&quot;</ETag>

</CompleteMultipartUploadResult>

案例五：启用版本控制

请求

POST /exampleobject?uploadId=15908626631e1995018f81a5e563837d6d7f1b51d7c97d

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Sat, 30 May 2020 18:18:04 GMT

Content-Type: application/xml

Content-Length: 153

Content-MD5: wmpyfdr9s/A+VCBwDdC1bA==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<CompleteMultipartUpload>

    <Part>

        <PartNumber>1</PartNumber>

        <ETag>"108f528eb63b65e734f27ae331f5ffaa"</ETag>

    </Part>

</CompleteMultipartUpload>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 378

Connection: close

Date: Sat, 30 May 2020 18:18:04 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 4510578591875220731

x-cos-request-id: NWVkMmEzNWNfOGNjOTJhMDlfMWQ4NjJfMWM0NGUw****

x-cos-version-id: MTg0NDUxNTMyMTEwNDU1NDc3OTc

<?xml version="1.0" encoding="UTF-8"?>

<CompleteMultipartUploadResult xmlns="http://www.qcloud.com/document/product/436/

    <Location>http://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleo

    <Bucket>examplebucket-1250000000</Bucket>
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    <Key>exampleobject</Key>

    <ETag>&quot;42318fc0ec58952b0d9ab4d7a006f595-1&quot;</ETag>

</CompleteMultipartUploadResult>

案例六：暂停版本控制

请求

POST /exampleobject?uploadId=1590862705b4349d597c0db1281e1c666bc431eb468b3

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Sat, 30 May 2020 18:18:45 GMT

Content-Type: application/xml

Content-Length: 153

Content-MD5: wmpyfdr9s/A+VCBwDdC1bA==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<CompleteMultipartUpload>

    <Part>

        <PartNumber>1</PartNumber>

        <ETag>"108f528eb63b65e734f27ae331f5ffaa"</ETag>

    </Part>

</CompleteMultipartUpload>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 378

Connection: close

Date: Sat, 30 May 2020 18:18:45 GMT

Server: tencent-cos

x-cos-hash-crc64ecma: 4510578591875220731

x-cos-request-id: NWVkMmEzODVfZjZjMjBiMDlfNGYzZV8zODc4****

x-cos-version-id: null

<?xml version="1.0" encoding="UTF-8"?>

<CompleteMultipartUploadResult xmlns="http://www.qcloud.com/document/product/436/

    <Location>http://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/exampleo

    <Bucket>examplebucket-1250000000</Bucket>

    <Key>exampleobject</Key>

    <ETag>&quot;491509b1fdf8e13d1f51d323c4a6d0e8-1&quot;</ETag>

</CompleteMultipartUploadResult>
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Abort Multipart Upload
最近更新时间：2022-11-25 14:43:46

Abort Multipart Upload 用来实现舍弃一个分块上传并删除已上传的块。当您调用 Abort Multipart Upload 

时，如果有正在使用这个 Upload Parts 上传块的请求，则 Upload Parts 会返回失败。当该 UploadId 不存在

时，会返回404 NoSuchUpload。

具体内容如下：

功能描述

说明

只有主账号或者被授权 Abort Multipart Upload 接口权限的子账号可以调用该接口。

注意

 建议您及时完成分块上传或者舍弃分块上传，因为已上传但是未终止的块会占用存储空间进而产生存储费

用。

请求

请求示例

DELETE /<ObjectKey>?uploadId=UploadId HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参阅 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参阅 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

参数名 描述 类 是否

https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体为空。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

称 型 必选

uplo

adId

标识本次分块上传的 ID，使用 Initiate Multipart Upload 接口初始化分块

上传时得到的 UploadId

Stri

ng
是

请求头

请求体

响应

响应头

响应体

错误码

实际案例

请求

DELETE /exampleobject?uploadId=1484727270323ddb949d528c629235314a9ead80f0ba

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 26 Oct 2013 21:22:00 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUj***

响应

HTTP/1.1 204 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Tue, 26 Oct 2013 21:22:00 GMT

Server: tencent-cos

x-cos-request-id: NTg3ZjI5MzlfOTgxZjRlXzZhYjNf****

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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List Multipart Uploads
最近更新时间：2022-12-16 15:31:33

List Multipart Uploads 用于查询正在进行中的分块上传任务。单次请求操作最多列出1000个正在进行中的分块

上传。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

具体内容如下：

功能描述

注意

 该请求需要有存储桶的读权限。同时需要主账号或者被授权 List Multipart Upload 接口权限的子账号可

以调用该接口。

请求

请求示例

GET /?uploads HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参见 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参见 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求参数

名称 描述 类型
是否
必选

delimiter 定界符为一个符号，对 Object 名字包含指定前缀且第一次出现 Stri 否

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第486 共1701页

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

delimiter 字符之间的 Object 作为一组元素：common prefix。

若无 prefix，则从路径起点开始。

ng

encoding-

type
规定返回值的编码格式，合法值：url。

Stri

ng
否

prefix
限定返回的 Object key 必须以 Prefix 作为前缀。
注意使用 prefix 查询时，返回的 key 中仍会包含 Prefix。

Stri
ng

否

max-

uploads

设置最大返回的 multipart 数量，合法取值从1到1000，默认

1000。
int 否

key-
marker

与 upload-id-marker 一起使用：

当 upload-id-marker 未被指定时，ObjectName 字母顺序
大于 key-marker 的条目将被列出。

当 upload-id-marker 被指定时，ObjectName 字母顺序大
于 key-marker 的条目被列出，ObjectName 字母顺序等于 

key-marker 同时 UploadId 大于 upload-id-marker 的条
目将被列出。

Stri
ng

否

upload-
id-marker

与 key-marker 一起使用：

当 key-marker 未被指定时，upload-id-marker 将被忽
略。

当 key-marker 被指定时，ObjectName字母顺序大于 key-
marker 的条目被列出，ObjectName 字母顺序等于 key-

marker 同时 UploadId 大于 upload-id-marker 的条目将
被列出。

Stri
ng

否

请求体

响应

响应头

响应体

<ListMultipartUploadsResult>

  <Bucket></Bucket>

  <Encoding-Type></Encoding-Type>

  <KeyMarker></KeyMarker>

https://cloud.tencent.com/document/product/436/7729
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具体的节点描述如下：

Container 节点 ListMultipartUploadsResult 的内容：

  <UploadIdMarker></UploadIdMarker>

  <NextKeyMarker></NextKeyMarker>

  <NextUploadIdMarker></NextUploadIdMarker>

  <MaxUploads></MaxUploads>

  <IsTruncated></IsTruncated>

  <Prefix></Prefix>

  <Delimiter></Delimiter>

  <Upload>

    <Key></Key>

    <UploadId></UploadId>

    <StorageClass></StorageClass>

    <Initiator>

      <ID></ID>

    <DisplayName></DisplayName>

    </Initiator>

    <Owner>

      <ID></ID>

    <DisplayName></DisplayName>

    </Owner>

    <Initiated></Initiated>

  </Upload>

  <CommonPrefixes>

    <Prefix></Prefix>

  </CommonPrefixes>

</ListMultipartUploadsResult>

节点名称（关键字） 父节点 描述 类型

ListMultipartUploadsResult 无 用来表述所有分块上传的信息。 Container

节点名
称（关

键字）

父节点 描述
类

型

Bucke

t

ListMulti
partUplo

adsResul
t

分块上传的目标 Bucket，由用户自定义字符串和系统生成 APPID 数

字串由中划线连接而成，例如 examplebucket-1250000000 。

S
tri

n
g

Encod

ing-

ListMulti

partUplo

规定返回值的编码格式，合法值：url。 S

tri
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Type adsResul

t

n

g

KeyM

arker

ListMulti
partUplo

adsResul
t

列出条目从该 key 值开始。

S
tri

n
g

Uploa

dIdMa
rker

ListMulti
partUplo

adsResul
t

列出条目从该 UploadId 值开始。

S
tri

n
g

NextK

eyMar
ker

ListMulti

partUplo
adsResul

t

假如返回条目被截断，则返回的 NextKeyMarker 就是下一个条目的
起点。

S

tri
n

g

NextU

ploadI
dMark

er

ListMulti

partUplo
adsResul

t

假如返回条目被截断，则返回的 UploadId 就是下一个条目的起点。

S

tri
n

g

MaxU

ploads

ListMulti
partUplo

adsResul
t

设置最大返回的 multipart 数量，合法取值从0 - 1000。
in

t

IsTrun
cated

ListMulti

partUplo
adsResul

t

返回条目是否被截断，布尔值：TRUE，FALSE。

B
o

ol
e

a
n

Prefix

ListMulti

partUplo
adsResul

t

限定返回的 Objectkey 必须以 Prefix 作为前缀。
注意使用 prefix 查询时，返回的 key 中仍会包含 Prefix。

S

tri
n

g

Delimi
ter

ListMulti

partUplo
adsResul

t

定界符为一个符号，对 object 名字包含指定前缀且第一次出现 
delimiter 字符之间的 object 作为一组元素：common prefix。若

无 prefix，则从路径起点开始。

S

tri
n

g

Uploa
d

ListMulti
partUplo

每个 Upload 的信息。 C
o
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Container 节点 Upload 的内容：

Container 节点 Initiator 的内容：

adsResul
t

nt
ai

n
er

Comm
onPref

ixes

ListMulti
partUplo

adsResul
t

将 prefix 到 delimiter 之间的相同路径归为一类，定义为 Common 

Prefix。

C

o
nt

ai
n

er

节点名称

（关键
字）

父节点 描述 类型

Key
ListMultipartUpload

sResult.Upload
Object 的名称。

Stri

ng

UploadI
d

ListMultipartUpload
sResult.Upload

标示本次分块上传的 ID。
Stri
ng

Storage
Class

ListMultipartUpload
sResult.Upload

用来表示分块的存储级别，枚举值：
STANDARD，STANDARD_IA，ARCHIVE。

Stri
ng

Initiator
ListMultipartUpload

sResult.Upload
用来表示本次上传发起者的信息。

Con

tain
er

Owner
ListMultipartUpload

sResult.Upload
用来表示这些分块所有者的信息。

Con

tain

er

Initiated
ListMultipartUpload
sResult.Upload

分块上传的起始时间。
Dat
e

节点名称（关键

字）
父节点 描述 类型

ID
ListMultipartUploadsResult.Upload.I
nitiator

用户唯一的 CAM 身份 
ID。

Stri
ng

DisplayName ListMultipartUploadsResult.Upload.I 用户身份 ID 的简称 Stri
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Container 节点 Owner 的内容：

Container 节点 CommonPrefixes 的内容：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

nitiator （UIN）。 ng

节点名称（关键

字）
父节点 描述 类型

ID
ListMultipartUploadsResult.Upload.
Owner

用户唯一的 CAM 身份 
ID。

Stri
ng

DisplayName
ListMultipartUploadsResult.Upload.

Owner

用户身份 ID 的简称

（UIN）。

Stri

ng

节点名称（关

键字）
父节点 描述 类型

Prefix
ListMultipartUploadsResult.Commo
nPrefixes

显示具体的 
CommonPrefixes。

Stri
ng

错误码

实际案例

请求

GET /?uploads HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 18 Jan 2015 21:32:00 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUj***

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1203

Date: Wed, 18 Jan 2015 21:32:00 GMT

Server: tencent-cos

x-cos-request-id: NTg3ZjI0ZGRfNDQyMDRlXzNhZmRf****

<ListMultipartUploadsResult>

    <Bucket>examplebucket-1250000000</Bucket>

https://cloud.tencent.com/document/product/436/7730
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    <Encoding-Type/>

    <KeyMarker/>

    <UploadIdMarker/>

    <MaxUploads>1000</MaxUploads>

    <Prefix/>

    <Delimiter>/</Delimiter>

    <IsTruncated>false</IsTruncated>

    <Upload>

        <Key>Object</Key>

        <UploadId>1484726657932bcb5b17f7a98a8cad9fc36a340ff204c79bd2f51e7dddf0

        <Initiator>

           <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

        <DisplayName>100000000001</DisplayName>

        </Initiator>

        <Owner>

           <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

        <DisplayName>100000000001</DisplayName>

        </Owner>

        <StorageClass>Standard</StorageClass>

        <Initiated>Wed Jan 18 16:04:17 2017</Initiated>

    </Upload>

    <Upload>

        <Key>Object</Key>

        <UploadId>1484727158f2b8034e5407d18cbf28e84f754b791ecab607d25a2e52de9

        <Initiator>

           <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

        <DisplayName>100000000001</DisplayName>

        </Initiator>

        <Owner>

           <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

        <DisplayName>100000000001</DisplayName>

        </Owner>

        <StorageClass>Standard</StorageClass>

        <Initiated>Wed Jan 18 16:12:38 2017</Initiated>

    </Upload>

    <Upload>

        <Key>exampleobject</Key>

        <UploadId>1484727270323ddb949d528c629235314a9ead80f0ba5d993a3d76b460

        <Initiator>

           <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

        <DisplayName>100000000001</DisplayName>

        </Initiator>

        <Owner>

           <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

        <DisplayName>100000000001</DisplayName>
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        </Owner>

        <StorageClass>Standard</StorageClass>

        <Initiated>Wed Jan 18 16:14:30 2017</Initiated>

    </Upload>

</ListMultipartUploadsResult>
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List Parts
最近更新时间：2022-12-16 15:31:16

List Parts 用来查询特定分块上传中的已上传的块，即罗列出指定 UploadId 所属的所有已上传成功的分块。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

说明

只有主账号或者被授权 List Part 接口权限的子账号可以调用该接口。

请求

请求示例

GET /<ObjectKey>?uploadId=UploadId HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com，其中 <BucketName-

APPID> 为带 APPID 后缀的存储桶名字，例如 examplebucket-1250000000，可参见 存储桶

概览 > 基本信息  和 存储桶概述 > 存储桶命名规范  文档；<Region> 为 COS 的可用地域，可参见 

地域和访问域名  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

请求参数

名称 描述
类
型

是否
必选

UploadId
标识本次分块上传的 ID，使用 Initiate Multipart Upload 接口初

始化分块上传时得到的 UploadId

st

rin

g

是

encoding-
type

规定返回值的编码方式 st
rin

否

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/48921#.E5.9F.BA.E6.9C.AC.E4.BF.A1.E6.81.AF
https://cloud.tencent.com/document/product/436/13312#.E5.AD.98.E5.82.A8.E6.A1.B6.E5.91.BD.E5.90.8D.E8.A7.84.E8.8C.83
http://cloud.tencent.com/document/product/436/6224
https://cloud.tencent.com/document/product/436/7778
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该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

查询成功，返回 application/xml 数据，包含已完成的分片信息。

g

max-parts 单次返回最大的条目数量，最大值为1000，默认值为1000 int 否

part-

number-
marker

默认以  UTF-8 二进制顺序列出条目，所有列出条目从 marker 开
始

st

rin
g

否

请求体

响应

响应头

响应体

<?xml version="1.0" encoding="UTF-8" ?>

<ListPartsResult>

    <Bucket>examplebucket-1250000000</Bucket>

    <Encoding-type/>

    <Key>exampleobject</Key>

    <UploadId>14846420620b1f381e5d7b057692e131dd8d72dfa28f2633cfbbe4d0a9e8b

    <Initiator>

        <ID>1250000000</ID>

        <DisplayName>1250000000</DisplayName>

    </Initiator>

    <Owner>

        <ID>qcs::cam::uin/100000000001:uin/100000000001</ID>

        <DisplayName>100000000001</DisplayName>

    </Owner>

    <PartNumberMarker>0</PartNumberMarker>

    <Part>

        <PartNumber>1</PartNumber>

        <LastModified>Tue Jan 17 16:43:37 2017</LastModified>

        <ETag>"a1f8e5e4d63ac6970a0062a6277e191fe09a1382"</ETag>

        <Size>5242880</Size>

    </Part>

    <NextPartNumberMarker>1</NextPartNumberMarker>

    <StorageClass>STANDARD</StorageClass>

    <MaxParts>1</MaxParts>

https://cloud.tencent.com/document/product/436/7729
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具体的节点描述如下：

Container 节点 ListPartsResult 的内容：

    <IsTruncated>true</IsTruncated>

</ListPartsResult>

节点名称（关键字） 父节点 描述 类型

ListPartsResult 无 保存 List Parts 请求结果的所有信息 Container

节点名称
（关键

字）

父节点 描述 类型

Bucket
ListParts
Result

分块上传的目标 Bucket，存储桶的名字，由用户自定义字符
串和系统生成 APPID 数字串由中划线连接而成，如：

examplebucket-1250000000

string

Encodin

g-Type

ListParts

Result
编码格式 string

Key
ListParts
Result

Object 的名称 string

UploadId
ListParts

Result
标识本次分块上传的 ID string

Initiator
ListParts

Result
用来表示这些分块所有者的信息

Contain

er

Owner
ListParts
Result

用来表示这些分块所有者的信息
Contain
er

Storage

Class

ListParts

Result

用来表示这些分块的存储类型，枚举值：STANDARD，
STANDARD_IA，ARCHIVE，DEEP_ARCHIVE 等，

更多存储类型请参见 存储类型概述

string

PartNum
berMark

er

ListParts
Result

默认以 UTF-8 二进制顺序列出条目，所有列出条目从 
marker 开始

string

NextPart
Number

Marker

ListParts
Result

假如返回条目被截断，则返回 NextMarker 就是下一个条目
的起点

string

MaxPart ListParts 单次返回最大的条目数量 int

https://cloud.tencent.com/document/product/436/33417
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Container 节点 Initiator 的内容：

Container 节点 Owner 的内容：

Container 节点 Part 的内容：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

s Result

IsTrunca
ted

ListParts
Result

响应请求条目是否被截断，布尔值：true，false
boolea
n

Part
ListParts

Result
元数据信息

Contain

er

节点名称（关键字） 父节点 描述 类型

ID ListPartsResult.Initiator 创建者的一个唯一标识 string

DisplayName ListPartsResult.Initiator 创建者的用户名描述 string

节点名称（关键字） 父节点 描述 类型

ID ListPartsResult.Owner 创建者的一个唯一标识 string

DisplayName ListPartsResult.Owner 创建者的用户名描述 string

节点名称（关键字） 父节点 描述 类型

PartNumber ListPartsResult.Part 块的编号 string

LastModified ListPartsResult.Part 说明块最后被修改时间 string

ETag ListPartsResult.Part 块的 MD-5 算法校验值 string

Size ListPartsResult.Part 说明块大小，单位是 Byte string

错误码

实际案例

请求

GET /exampleobject?uploadId=1585130821cbb7df1d11846c073ad648e8f33b087cec238

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Wed, 25 Mar 2020 10:07:25 GMT

https://cloud.tencent.com/document/product/436/7730
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Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1119

Connection: close

Date: Wed, 25 Mar 2020 10:07:25 GMT

Server: tencent-cos

x-cos-request-id: NWU3YjJkNWRfMjNhZjJhMDlfNWY5Ml8zMmUy****

<ListPartsResult>

            <Bucket>examplebucket-1250000000</Bucket>

            <EncodingType/>

            <Key>exampleobject</Key>

            <UploadId>1585130821cbb7df1d11846c073ad648e8f33b087cec2381df437acdc

            <Owner>

                <ID>1250000000</ID>

                <DisplayName>1250000000</DisplayName>

            </Owner>

            <PartNumberMarker>0</PartNumberMarker>

            <Initiator>

                <ID>qcs::cam::uin/100000000001:uin/100000000011</ID>

                <DisplayName>100000000011</DisplayName>

            </Initiator>

            <Part>

                <PartNumber>1</PartNumber>

                <LastModified>2020-03-25T10:07:14.000Z</LastModified>

                <ETag>&quot 39270a968a357d24207e9911162507eb&quot </ETag>

                <Size>1048576</Size>

            </Part>

            <Part>

                <PartNumber>2</PartNumber>

                <LastModified>2020-03-25T10:07:13.000Z</LastModified>

                <ETag>&quot d899fbd1e06109ea2e4550f5751c88d6&quot </ETag>

                <Size>1048576</Size>

            </Part>

            <Part>

                <PartNumber>3</PartNumber>

                <LastModified>2020-03-25T10:07:13.000Z</LastModified>

; ;

; ;
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                <ETag>&quot 762890d6c9a871b7bd136037cb2260cd&quot </ETag>

                <Size>1048576</Size>

            </Part>

            <StorageClass>Standard</StorageClass>

            <MaxParts>1000</MaxParts>

            <IsTruncated>false</IsTruncated>

</ListPartsResult>

; ;
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批量处理接口

CreateJob
最近更新时间：2022-11-16 08:56:36

CreateJob 用于在存储桶中创建批量处理任务。详细信息可参见 批量处理概述 。

调用该请求时，请确保您有足够的权限对存储桶的对象进行操作。存储桶所有者默认拥有该权限，若您无该项权限，

请先向存储桶所有者申请该项操作的权限。

调用 CreateJob 所需的参数。该参数格式如下：

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <UIN>.cos-control.<Region>.myqcloud.com

Date: GMT Date

Content-Type: application/xml

Content-Length: Content Length

Authorization: Auth String

x-cos-appid: <APPID>

<?xml version="1.0" encoding="UTF-8"?>

<CreateJobRequest>

.

</CreateJobRequest>

..

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

参数 描述 是否必选

x-cos-appid 用户的 APPID，长度为1 - 64字节。 是

请求头

https://cloud.tencent.com/document/product/436/38601
https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
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用户在请求体中使用 XML 语言设置清单任务的具体配置信息。配置信息包括清单任务分析的对象，分析的频次，

分析的维度，分析结果的格式及存储的位置等信息。

请求体

<CreateJobRequest>

    <ClientRequestToken>string</ClientRequestToken>

    <ConfirmationRequired>boolean</ConfirmationRequired>

    <Description>string</Description>

    <Manifest>

        <Location>

            <ETag>string</ETag>

            <ObjectArn>string</ObjectArn>

            <ObjectVersionId>string</ObjectVersionId>

        </Location>

        <Spec>

            <Fields>

                <member>string</member>

                <member>string</member>

            </Fields>

            <Format>string</Format>

        </Spec>

    </Manifest>

    <Operation>

        <COSDeleteObject></COSDeleteObject>

        <COSInitiateRestoreObject>   

            <ExpirationInDays> integer </ExpirationInDays>

            <JobTier> string </JobTier>

        </COSInitiateRestoreObject>

        <COSPutObjectCopy> 

            <AccessControlDirective>string</AccessControlDirective>

            <AccessControlGrants>

                <COSGrant>

                    <Grantee>

                        <Identifier>string</Identifier>

                        <TypeIdentifier>string</TypeIdentifier>

                    </Grantee>

                    <Permission>string</Permission>

                </COSGrant>

                <COSGrant>

                    <Grantee>

                        <Identifier>string</Identifier>

                        <TypeIdentifier>string</TypeIdentifier>

                    </Grantee>

                    <Permission>string</Permission>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第501 共1701页

                </COSGrant>

            </AccessControlGrants>

            <PrefixReplace>boolean</PrefixReplace>

            <ResourcesPrefix>string</ResourcesPrefix>

            <TargetKeyPrefix>string</TargetKeyPrefix>

            <CannedAccessControlList>string</CannedAccessControlList>

            <MetadataDirective>string</MetadataDirective>

            <ModifiedSinceConstraint>timestamp</ModifiedSinceConstraint>

            <UnModifiedSinceConstraint>timestamp</UnModifiedSinceConstraint>

            <MetadataDirective>string</MetadataDirective>

            <NewObjectMetadata>

                <CacheControl>string</CacheControl>

                <ContentDisposition>string</ContentDisposition>

                <ContentEncoding>string</ContentEncoding>

                <ContentType>string</ContentType>

                <HttpExpiresDate>timestamp</HttpExpiresDate>

                <SSEAlgorithm>string</SSEAlgorithm>

                <UserMetadata>

                    <member>

                        <Key>string</Key>

                        <Value>string</Value>

                    </member>

                    <member>

                        <Key>string</Key>

                        <Value>string</Value>

                    </member>

                </UserMetadata>

            </NewObjectMetadata>

            <TaggingDirective>string</TaggingDirective>

            <NewObjectTagging>

                <COSTag>

                    <Key>string</Key> 

                    <Value>string</Value>

                </COSTag>

            </NewObjectTagging>

            <StorageClass>string</StorageClass>

            <TargetResource>string</TargetResource>

        </COSPutObjectCopy>

    </Operation>

    <Priority>integer</Priority>

    <Report>

        <Bucket>string</Bucket>

        <Enabled>boolean</Enabled>

        <Format>string</Format>

        <Prefix>string</Prefix>
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请求体内相关元素的具体描述如下。其他元素请参见 批量处理功能公共元素 。

        <ReportScope>string</ReportScope>

    </Report>

    <RoleArn>string</RoleArn>

</CreateJobRequest>

节点名 父节点 描述 类型

是

否

必
选

Client

Reque
stToke

n

Creat

eJob
Requ

est

每个请求唯一的 token，用于避免前端重复发起同一批处理任
务。长度为1 - 64字节，建议使用 uuid。

Strin
g

是

Confir

mation
Requir

ed

Creat

eJob
Requ

est

是否在执行任务前进行确认。默认值为 false。
Bool
ean

否

Descri

ption

Creat
eJob

Requ
est

任务描述。若您在创建任务时配置了此信息，则会返回该项内

容。描述长度范围为0 - 256字节。

Strin

g
否

Manife

st

Creat

eJob

Requ
est

待处理的对象清单。您需要将待处理的对象记录在此对象清单

内。您可以使用 清单功能  生成文件清单。

Mani

fest 

Obje
ct

是

Operat
ion

Creat

eJob
Requ

est

选择对清单文件中的对象将要执行的操作。目前 COS 支持 批
量复制对象 、 批量恢复归档  、 批量删除对象  等操作，您可以据

此处理存储桶内的存量数据。

Oper

ation 
Obje

ct

是

Priorit

y

Creat
eJob

Requ

est

任务优先级。越高的数值代表此项任务的优先级越高。优先级数

值范围为0 - 2147483647。

Integ

er
是

Report

Creat
eJob

Requ
est

任务完成报告。您可配置此参数以在任务完成时输出报告，方便

审计任务执行状况。

Rep
ort 

Obje
ct

是

https://cloud.tencent.com/document/product/436/38607
https://cloud.tencent.com/document/product/436/33702
https://cloud.tencent.com/document/product/436/38603
https://cloud.tencent.com/document/product/436/40961
https://cloud.tencent.com/document/product/436/82858


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第503 共1701页

响应头

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应体

具体内容描述如下：

错误分析

该请求操作可能会出现如下错误信息。其他错误请参见 批量处理功能错误响应 。

RoleAr

n

Creat

eJob
Requ

est

COS 资源标识符，此处用于标识您创建的角色。您需要此资源

标识符以验证您的身份。

Strin

g

是

响应

<CreateJobResult>

   <JobId>string</JobId>

</CreateJobResult>

节点
名

父节点 描述 类型

Job

Id

CreateJobRe

sult

任务 ID。当您成功创建一项任务后，COS 自动返回的 ID，长度1 

- 64字节。

Stri

ng

错误代码 描述
状态
码

API

InvalidRequest 重复的请求 400
CreateJo

b

InvalidRequest 优先级的有效范围是0 - 2147483647的整数 400
CreateJo
b

MalformedXML 请求体的 XML Manifest 字段不符合 XML 语法 400
CreateJo
b

MalformedXML
请求体的 XML Operation 字段不符合 XML 语

法
400

CreateJo

b

MalformedXML 请求体的 XML Report 字段不符合 XML 语法 400
CreateJo
b

ServiceUnavailabl 服务暂不可用，无法建立新的任务 500 CreateJo

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/38610
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e b

TooManyJobs 任务已达上限，服务器不可用 500
CreateJo

b

实际案例

请求

POST /jobs HTTP/1.1

Host: 100000000001.cos-control.ap-chengdu.myqcloud.com

Date: Thu, 19 Dec 2019 18:00:29 GMT

x-cos-appid: 1250000000

Content-Type: application/xml

Content-Length: 1056

Content-MD5: hHcgq5mu8s0YP4WTGiQ+uA==

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

<CreateJobRequest>

    <ClientRequestToken>184ce261-18af-5e3d-3e30-253723cfd937</ClientRequestToken

    <ConfirmationRequired>false</ConfirmationRequired>

    <Description>example-job</Description>

    <Manifest>

        <Location>

            <ETag>"15150651828fa9cdcb8356b6d1c7638b"</ETag>

            <ObjectArn>qcs::cos:ap-chengdu::sourcebucket-1250000000/manifests/batch-co

        </Location>

        <Spec>

            <Fields>

                <member>Bucket</member>

                <member>Key</member>

            </Fields>

            <Format>COSBatchOperations_CSV_V1</Format>

        </Spec>

    </Manifest>

    <Operation>

        <COSPutObjectCopy>

            <TargetResource>qcs::cos:ap-chengdu:uid/1250000000:destinationbucket-12500

        </COSPutObjectCopy>

    </Operation>

    <Priority>10</Priority>

    <Report>

        <Bucket>qcs::cos:ap-chengdu::sourcebucket-1250000000</Bucket>

        <Enabled>true</Enabled>
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上述请求后，COS 返回以下响应，表明该清单任务已经成功设置完毕。

        <Format>Report_CSV_V1</Format>

        <Prefix>job-result</Prefix>

        <ReportScope>AllTasks</ReportScope>

    </Report>

    <RoleArn>qcs::cam::uin/100000000001:roleName/COS_Batch_QcsRole</RoleArn>

</CreateJobRequest>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 89

Connection: close

Date: Thu, 19 Dec 2019 18:00:30 GMT

Server: tencent-cos

x-cos-request-id: NWRmYmJhYmRfMjViMjU4NjRfNmIzYV8xMDE2****

<CreateJobResult>

    <JobId>53dc6228-c50b-46f7-8ad7-65e7159f1aae</JobId>

</CreateJobResult>
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DescribeJob
最近更新时间：2020-07-28 17:01:58

DescribeJob 用于获取您配置的批量处理任务的参数和任务执行状态。有关批量处理任务的详细信息，可参见 批

量处理概述 。

调用 DescribeJob 所需的参数。该参数格式如下：

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能描述

请求

请求示例

GET /jobs/<JobId> HTTP/1.1

Host: <UIN>.cos-control.<Region>.myqcloud.com

Date: GMT Date

Content-Type: application/xml

Content-Length: Content Length

Authorization: Auth String

x-cos-appid: <APPID>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

参数 描述 是否必选

JobId 任务 ID。 是

x-cos-appid 用户的 APPID，长度为1 - 64字节。 是

请求头

请求体

响应

https://cloud.tencent.com/document/product/436/38601
https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应头

响应体

<DescribeJobResult>

    <Job>

        <ConfirmationRequired>boolean</ConfirmationRequired>

        <CreationTime>timestamp</CreationTime>

        <Description>string</Description>

        <FailureReasons>

            <JobFailure>

                <FailureCode>string</FailureCode>

                <FailureReason>string</FailureReason>

            </JobFailure>

        </FailureReasons>

        <JobId>string</JobId>

        <Manifest>

            <Location>

                <ETag>string</ETag>

                <ObjectArn>string</ObjectArn>

            </Location>

            <Spec>

                <Format>string</Format>

            </Spec>

        </Manifest>

        <Operation>

            <COSPutObjectCopy>

                <CannedAccessControlList>string</CannedAccessControlList>

                <MetadataDirective>string</MetadataDirective>

                <NewObjectMetadata>

                    <SSEAlgorithm>string</SSEAlgorithm>

                    <UserMetadata>

                        <member>

                            <Key>string</Key>

                            <Value>string</Value>

                        </member>

                        <member>

                            <Key>string</Key>

                            <Value>string</Value>

                        </member>

                    </UserMetadata>

                </NewObjectMetadata>

                <StorageClass>string</StorageClass>

https://cloud.tencent.com/document/product/436/7729
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具体内容描述如下：

DescribeJobResult

包含待描述批量处理任务的参数和状态信息。

Job

                <TargetResource>string</TargetResource>

            </COSPutObjectCopy>

        </Operation>

        <Priority>integer</Priority>

        <ProgressSummary>

            <NumberOfTasksFailed>integer</NumberOfTasksFailed>

            <NumberOfTasksSucceeded>integer</NumberOfTasksSucceeded>

            <TotalNumberOfTasks>integer</TotalNumberOfTasks>

        </ProgressSummary>

        <Report>

            <Bucket>string</Bucket>

            <Enabled>boolean</Enabled>

            <Format>string</Format>

            <Prefix>string</Prefix>

            <ReportScope>string</ReportScope>

        </Report>

        <RoleArn>string</RoleArn>

        <Status>string</Status>

        <StatusUpdateReason>string</StatusUpdateReason>

        <SuspendedCause>string</SuspendedCause>

        <SuspendedDate>timestamp</SuspendedDate>

        <TerminationDate>timestamp</TerminationDate>

    </Job>

</DescribeJobResult>

节点名 父节点 描述 类型

Job DescribeJobResult 您指定查询的批量处理任务的参数和状态信息。 Job Object

节点名
父
节

点

描述 类型

ClientRe
questTo

ken

J
o

b

每个请求唯一的 token，用于避免前端重复发起同一批处理任务。
长度为1 - 64字节，建议使用 UUID。

String

Creation

Time

J

o

任务创建时间。 Timesta

mp
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b

Descripti
on

J

o
b

任务描述。若您在创建任务时配置了此信息，则会返回该项内容。
长度范围为1 - 256字节。

String

FailureR

easons

J

o
b

如果任务失败，描述失败的原因。

FailureR

easons 
Object

JobId
J
o

b

创建任务成功后，生成的任务 ID。长度1 - 64字节。 String

Manifest
J
o

b

待处理的对象清单。您需要将需要处理的对象记录在此对象清单内。
Manifest 

Object

Operatio
n

J
o

b

您需要对清单内的对象批量执行的操作。
Operatio
n Object

Priority

J

o
b

任务优先级。越高的数值代表此项任务的优先级越高。
优先级数值范围为0 - 2147483647。

Integer

Progres

sSumma
ry

J

o
b

任务执行状况概述。描述您此项任务中所执行的操作总数，成功的操作
数量以及失败的操作数量。

Progres

sSumm
ary 

Object

Report

J

o
b

指定清单报告的相关配置。
Report 
Object

RoleArn

J

o
b

您为该任务分配的角色的标识符。长度1 - 1024字节。 String

Status

J

o

b

任务当前状态。合法参数值包括 Active、Cancelled、

Cancelling、Complete、Completing、Failed、Failing、

New、Paused、Pausing、Preparing、Ready、Suspended

String

StatusU
pdateRe

ason

J
o

b

状态更新原因。长度为0 - 256字节。 String

Suspend J 任务中断的原因。任务仅在您使用控制台创建任务时会进入中断状态， String
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FailureReasons

FailureCode

其他元素请参见 批量处理功能公共元素 。

该请求可能会发生的一些常见的特殊错误如下，其他错误请参见 批量处理功能错误响应 。

edCause o

b

等待您的确认后再进入执行状态。长度为0 - 1024字节。

Suspend
edDate

J

o
b

任务中断的时间。当任务进入中断状态时，会记录任务中断的时间。
Timesta
mp

Termina

tionDate

J

o
b

任务终止的时间。
Timesta

mp

节点名 父节点 描述 类型

JobFailure FailureReasons 任务失败代码和原因。 JobFailure Object

节点名 父节点 描述 类型

FailureCode JobFailure 任务失败代码。长度0 - 64字节。 String

FailureReason JobFailure 任务失败原因。长度0 - 256字节。 String

错误码

错误码 描述 状态码 API

NoSuchJob 指定任务不存在 404 DescribeJob

实际案例

请求

GET /jobs/53dc6228-c50b-46f7-8ad7-65e7159f1aae HTTP/1.1

Host: 100000000001.cos-control.ap-chengdu.myqcloud.com

Date: Thu, 19 Dec 2019 18:01:11 GMT

x-cos-appid: 1250000000

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

https://cloud.tencent.com/document/product/436/38607
https://cloud.tencent.com/document/product/436/38610
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1555

Connection: close

Date: Thu, 19 Dec 2019 18:01:11 GMT

Server: tencent-cos

x-cos-request-id: NWRmYmJhZTdfNGQ5ZTU4NjRfMzQwYl9mZGY2****

<DescribeJobResult>

    <Job>

        <ConfirmationRequired>false</ConfirmationRequired>

        <CreationTime>2019-12-19T18:00:30Z</CreationTime>

        <Description>example-job</Description>

        <FailureReasons>

            <JobFailure>

                <FailureCode/>

                <FailureReason/>

            </JobFailure>

        </FailureReasons>

        <JobId>53dc6228-c50b-46f7-8ad7-65e7159f1aae</JobId>

        <Manifest>

            <Location>

                <ETag>&quot 15150651828fa9cdcb8356b6d1c7638b&quot </ETag>

                <ObjectArn>qcs::cos:ap-chengdu::sourcebucket-1250000000/manifests/batch-

            </Location>

            <Spec>

                <Fields>

                    <member>Bucket</member>

                    <member>Key</member>

                </Fields>

                <Format>COSBatchOperations_CSV_V1</Format>

            </Spec>

        </Manifest>

        <Operation>

            <COSPutObjectCopy>

                <TargetResource>qcs::cos:ap-chengdu::destinationbucket-1250000000</Targe

            </COSPutObjectCopy>

        </Operation>

        <Priority>10</Priority>

        <ProgressSummary>

            <NumberOfTasksFailed>0</NumberOfTasksFailed>

            <NumberOfTasksSucceeded>10</NumberOfTasksSucceeded>

            <TotalNumberOfTasks>10</TotalNumberOfTasks>

; ;



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第512 共1701页

        </ProgressSummary>

        <Report>

            <Bucket>qcs::cos:ap-chengdu::sourcebucket-1250000000</Bucket>

            <Enabled>true</Enabled>

            <Format>Report_CSV_V1</Format>

            <Prefix>job-result</Prefix>

            <ReportScope>AllTasks</ReportScope>

        </Report>

        <RoleArn>qcs::cam::uin/100000000001:roleName/COS_Batch_QcsRole</RoleArn>

        <Status>Complete</Status>

        <StatusUpdateReason>Job complete</StatusUpdateReason>

        <TerminationDate>2019-12-19T18:00:42Z</TerminationDate>

    </Job>

</DescribeJobResult>
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ListJobs
最近更新时间：2020-07-28 16:49:35

ListJobs 用于列出您的批量处理任务。有关批量处理任务的详细介绍，可参见 批量处理概述 。

请求示例

请求参数

调用 ListJobs 所需要使用的参数。该参数格式如下：

功能描述

请求

GET /jobs?jobStatuses=<JobStatuses>&maxResults=<MaxResults>&nextToken=<NextTo

Host: <UIN>.cos-control.<Region>.myqcloud.com

Date: GMT Date

Content-Type: application/xml

Content-Length: Content Length

Authorization: Auth String

x-cos-appid: <APPID>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

参数 描述
是否

必选

jobSt

atuse
s

您所需查询的任务状态信息。如您未指定任务状态，则 COS 将返回所有执行过的任务
状态，包括正在执行的任务。若您指定任务状态，则 COS 将返回指定状态的任务。可

选的任务状态包括：Active、Cancelled、Cancelling、Complete、
Completing、Failed、Failing、New、Paused、Pausing、Preparing、

Ready、Suspended。

否

maxR
esults

COS 返回的任务数量最大值。如您配置了此项参数，每次返回的任务数最多不会超过

这个最大值。您可以配合 nextToken 参数进行分页返回。该参数范围为1 - 1000，
默认为1000。

否

nextT

oken

翻页符。每次 list 操作会返回本次任务列表的最后一个 JobId 作为 nextToken，在

下一次 list 传入该值，即可接续上一次 list 的内容进行 list，用于分页。该参数的长度
限制在1 - 64字节。

否

x- 用户的 APPID，长度为1 - 64字节。 是

https://cloud.tencent.com/document/product/436/38601
https://cloud.tencent.com/document/product/436/7778
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请求头

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

请求体

该请求无请求体。

响应头

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应体

具体内容描述如下：

ListJobsResult 

包含 COS 返回的批量处理任务列表信息。

cos-

appid

响应

<ListJobsResult>

    <Jobs>

        <member>

            <CreationTime>timestamp</CreationTime>

            <Description>string</Description>

            <JobId>string</JobId>

            <Operation>string</Operation>

            <Priority>integer</Priority>

            <ProgressSummary>

                <NumberOfTasksFailed>integer</NumberOfTasksFailed>

                <NumberOfTasksSucceeded>integer</NumberOfTasksSucceeded>

                <TotalNumberOfTasks>integer</TotalNumberOfTasks>

            </ProgressSummary>

            <Status>string</Status>

            <TerminationDate>timestamp</TerminationDate>

        </member>

    </Jobs>

    <NextToken></NextToken>

</ListJobsResult>

节

点
名

父节

点
描述

类

型

J
o

List
Job

包含 COS 返回的多个批量处理任务信息。 Jo
bs 

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第515 共1701页

Jobs

member

b

s

sR

esu

lt

O

bj

ec
t

N

e
xt

T
o

k
e

n

List

Job

sR
esu

lt

每次ListJobs操作会返回本次任务列表的最后一个 JobId 作为 nextToken，在

下一次 ListJobs 传入该值，返回结果即可接续上一次 ListJobs 的内容，用于分
页。该参数的长度限制在1 - 64字节。

St

rin
g

节点名 父节点 描述 类型

member Jobs 包含 COS 返回的某个批量处理任务信息。 member Object

节点名
父节

点
描述 类型

Creati
onTim

e

me
mb

er

任务创建时间。
Timest
amp

Descr
iption

me

mb
er

任务描述。长度限制为0 - 256字节。 String

JobId

me

mb
er

任务 ID。长度限制为1 - 64字节。 String

Opera

tion

me

mb
er

批量处理任务中对对象执行的操作。例如 COSPutObjectCopy String

Priorit

y

me
mb

er

任务优先级。值越大的任务将会被优先执行。

优先级大小限制为0 - 2147483647。
Integer

Progr
essSu

me
mb

任务执行状况概述。描述您此项任务中所执行的操作总数，成功的操作
数量以及失败的操作数量。

Progres
sSumm
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其他元素请参见 批量处理功能公共元素 。

该请求可能会发生的一些常见的特殊错误如下：

其他错误请参见 批量处理功能错误响应 。

mmar
y

er ary 
Object

Statu

s

me

mb
er

任务执行状态。合法参数值包括 Active、Cancelled、
Cancelling、Complete、Completing、Failed、Failing、

New、Paused、Pausing、Preparing、Ready、
Suspended。

String

Termi

nation
Date

me

mb
er

批量处理任务的结束时间。
Timest

amp

错误码

错误码 描述 状态码 API

InvalidArgument Parameter jobStatuses is invalid 400 ListJobs

InvalidArgument maxResults 参数必须为整数 400 ListJobs

InvalidArgument nextToken 参数无效 400 ListJobs

实际案例

请求

GET /jobs?maxResults=2 HTTP/1.1

Host: 100000000001.cos-control.ap-chengdu.myqcloud.com

Date: Fri, 20 Dec 2019 03:31:41 GMT

x-cos-appid: 1250000000

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Connection: close

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 1166

Connection: close

https://cloud.tencent.com/document/product/436/38607
https://cloud.tencent.com/document/product/436/38610
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Date: Fri, 20 Dec 2019 03:31:41 GMT

Server: tencent-cos

x-cos-request-id: NWRmYzQwOWRfNWFiMjU4NjRfNmU1M18xMTFh****

<ListJobsResult>

    <Jobs>

        <member>

            <CreationTime>2019-12-19T11:05:40Z</CreationTime>

            <Description>example-job</Description>

            <JobId>021140d8-67ca-4e89-8089-0de9a1e40943</JobId>

            <Operation>COSPutObjectCopy</Operation>

            <Priority>10</Priority>

            <ProgressSummary>

                <NumberOfTasksFailed>0</NumberOfTasksFailed>

                <NumberOfTasksSucceeded>10</NumberOfTasksSucceeded>

                <TotalNumberOfTasks>10</TotalNumberOfTasks>

            </ProgressSummary>

            <Status>Complete</Status>

            <TerminationDate>2019-12-19T11:05:56Z</TerminationDate>

        </member>

        <member>

            <CreationTime>2019-12-19T11:07:05Z</CreationTime>

            <Description>example-job</Description>

            <JobId>066d919e-49b9-429e-b844-e17ea7b16421</JobId>

            <Operation>COSPutObjectCopy</Operation>

            <Priority>10</Priority>

            <ProgressSummary>

                <NumberOfTasksFailed>0</NumberOfTasksFailed>

                <NumberOfTasksSucceeded>10</NumberOfTasksSucceeded>

                <TotalNumberOfTasks>10</TotalNumberOfTasks>

            </ProgressSummary>

            <Status>Complete</Status>

            <TerminationDate>2019-12-19T11:07:21Z</TerminationDate>

        </member>

    </Jobs>

    <NextToken>066d919e-49b9-429e-b844-e17ea7b16421</NextToken>

</ListJobsResult>
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UpdateJobPriority
最近更新时间：2020-07-28 16:48:32

UpdateJobPriority 用于更新任务优先级。您可以使用这一接口以更新一项任务的优先级，数值越大，优先级越

高，高优先级的 Job 会被优先执行。有关批量处理任务的详细介绍，可参见 批量处理概述 。

请求示例

请求参数

调用 UpdateJobPriority 接口所需的参数。该参数格式如下：

请求头

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

请求体

该请求无请求体。

响应示例

功能描述

请求

POST /jobs/<JobId>/priority?priority=<Priority> HTTP/1.1

x-cos-appid: <appid>

参数 描述 是否必选

JobId 您想要更新的批量处理任务的 ID。长度限制为1 - 64字节。 是

priority 更新后的任务优先级。此项参数大小限制为0 - 2147483647。 是

x-cos-appid 用户的 APPID，长度为1 - 64字节。 是

响应

HTTP/1.1 200

<UpdateJobPriorityResult>

    <JobId>string</JobId>

    <Priority>integer</Priority>

</UpdateJobPriorityResult>

https://cloud.tencent.com/document/product/436/38601
https://cloud.tencent.com/document/product/436/7728
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响应头

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应体

具体内容描述如下：

UpdateJobStatusResult

该请求可能会发生的一些常见的特殊错误如下：

其他错误请参见 批量处理功能错误响应 。

<UpdateJobPriorityResult>

    <JobId>string</JobId>

    <Priority>integer</Priority>

</UpdateJobPriorityResult>

节点名 父节点 描述 类型

JobId
UpdateJobPriorityRe

sult

任务 ID。您所更新的任务的 ID，长度限制为1 - 64

字节。
String

Priori
ty

UpdateJobPriorityRe
sult

任务的当前优先级。大小限制为0 - 
2147483647。

Integ
er

错误分析

错误代码 描述
状态

码
API

InvalidReques
t

未提供任务优先级 400 UpdateJobPriority

NoSuchJob
指定任务不存在或已完
成

404
UpdateJobStatus，
UpdateJobPriority

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/38610
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UpdateJobStatus
最近更新时间：2020-07-28 16:47:37

UpdateJobStatus 用于更新任务状态。您可以使用这一接口以启动一项任务或者取消一项正在进行的任务。有关

批量处理任务的详细介绍，可参见 批量处理概述 。

请求示例

请求参数

调用 UpdateJobStatus 需要使用清单任务名称的参数。该参数格式如下：

请求头

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

请求体

该请求无请求体。

响应示例

功能描述

请求

POST /jobs/<JobId>/status?requestedJobStatus=<RequestedJobStatus>&statusUpdateRe

x-cos-appid: <appid>

参数 描述
是否
必选

JobId 您想要更新的批量处理任务的 ID。 是

requested

JobStatus

您期望的批量处理任务的状态。当您将任务转移至 Ready 状态时，COS 将认

为您已确认此项任务，并将执行此项任务。当您将任务转移至 Cancelled 状态

时，COS 将取消此项任务。可选参数包括：Ready、Cancelled。

是

statusUpd
ateReason

更新任务状态的原因。此项参数长度限制为0 - 256字节。 否

x-cos-

appid
用户的 APPID，长度为1 - 64字节。 是

响应

HTTP/1.1 200

https://cloud.tencent.com/document/product/436/38601
https://cloud.tencent.com/document/product/436/7728
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响应头

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应体

具体内容描述如下。

该请求可能会发生的一些常见的特殊错误如下：

<UpdateJobStatusResult>

    <JobId>string</JobId>

    <Status>string</Status>

    <StatusUpdateReason>string</StatusUpdateReason>

</UpdateJobStatusResult>

<UpdateJobStatusResult>

   <JobId>string</JobId>

   <Status>string</Status>

   <StatusUpdateReason>string</StatusUpdateReason>

</UpdateJobStatusResult>

UpdateJobStatusResult

节点名 父节点 描述 类型

JobId

Update

JobStat
usResul

t

任务 ID。您所更新的任务的 ID，长度限制为5 - 36字节。
Stri
ng

Status

Update
JobStat

usResul
t

任务的当前状态。合法参数项包括：Active、Cancelled、
Cancelling、 Complete、Completing、Failed、Failing、

New、Paused、Pausing、Preparing、Ready、 
Suspended。

Stri

ng

Status
Updat

eReas
on

Update
JobStat

usResul
t

任务更新原因。长度限制为0 - 256字节。
Stri

ng

错误分析

错误代码 描述

状

态
码

API

https://cloud.tencent.com/document/product/436/7729
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其他错误请参见 批量处理功能错误响应 。

InvalidArg

ument

requestedJobStatus 参数必须为 

Cancelled 或 Ready

40

0

UpdateJobStatus

InvalidReq

uest
指定任务已完成

40

0
UpdateJobStatus

InvalidReq
uest

任务状态变更错误
40
0

UpdateJobStatus

NoSuchJo

b
指定任务不存在或已完成

40

4

UpdateJobStatus，

UpdateJobPriority

https://cloud.tencent.com/document/product/436/38610
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公共元素
最近更新时间：2021-06-08 17:23:22

本文提供以下批量处理功能的公共元素。

Manifest

节点
名

父节
点

描述 类型
是否
必选

Loca

tion

Mani

fest
对象清单的位置信息。

Location 

Object
是

Spec
Mani

fest

描述对象清单的格式信息。如果为 CSV 文件，此元素将

描述清单中包含的字段。

Spec 

Object
是

Location

节点名 父节点 描述 类型
是否必
选

ETag
Locati

on
指定对象清单的 etag。长度1 - 1024字节。

Stri

ng
是

ObjectArn
Locati
on

指定对象清单的唯一资源标识符，长度为1 - 
1024字节。

Stri
ng

是

ObjectVersio
nId

Locati
on

指定对象清单的版本 ID，长度为1 - 1024字节。
Stri
ng

否

Spec

节
点

名

父
节

点

描述 类型

是

否
必

选

F
i

e
l

d
s

S

p
ec

描述清单中包含的字段，当 Format 为 

COSBatchOperations_CSV_V1 时，需要使用此元素指定 CSV 文
件字段。合法字段为：Ignore、Bucket、Key、VersionId

Arra

y of 
Strin

gs

否
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F

o
r

m
a

t

S

p
ec

指定对象清单的格式信息。合法字段为： 

COSBatchOperations_CSV_V1、 
COSInventoryReport_CSV_V1

Strin

g

是

Operation

注意

单个任务中 Operation 只能包含下列多种操作中的一个。

节点名
父节

点
描述 类型

是
否

必
选

COSPutObjec
tCopy

Oper
ation

指定对清单内的对象批量复制操作的具体
参数。

COSPutObjec
tCopy Object

否

COSInitiateRe

storeObject

Oper

ation

指定对清单内的归档存储类型对象批量恢

复操作的具体参数。

COSInitiateRe

storeObject
否

COSPutObjectCopy

节
点

名

父
节

点

描述 类型
是否
必选

Ac

ce
ss

Co
ntr

olD
ire

cti
ve

C
O

S

P
ut

O
bj

e
ct

C
o

p
y

该元素指定 ACL 的复制方式，有效值：Copy、Replaced、

Add。
Copy：继承源对象ACL；

Replaced ：替换源 ACL；
Add：在源 ACL 的基础上添加新的 ACL。

String 否

Ac C 控制对象的具体访问权限。 Acce 否
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ce
ss

Co
ntr

ol
Gr

ant
s

O
S

P
ut

O
bj

e
ct

C
o

p
y

ssCo
ntrol

Grant
s 

Objec
t

Ca
nn

ed
Ac

ce

ss
Co

ntr
olL

ist

C
O

S
P

ut
O

bj
e

ct
C

o
p

y

定义对象的 ACL 属性。有效值：private、public-read String 否

Pr

efi

xR
epl

ac
e

C

O
S

P
ut

O
bj

e
ct

C
o

p
y

指定是否需要替换源对象的前缀，值为 true 时，表示替换对象前

缀，需搭配 <ResourcesPrefix> 和 <TargetKeyPrefix> 使用。

默认值：false。

boole
an

否

Re
so

urc
es

Pr

C
O

S
P

ut

当 <PrefixReplace> 值为 true 时，这个字段才有效。指定需要替

换的源对象前缀，替换目录请以/结尾。可以为空，最长1024字节。

string 否
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efi

x

O

bj
e

ct
C

o
p

y

Tar

get
Ke

yPr
efi

x

C
O

S
P

ut

O
bj

e
ct

C
o

p
y

当 <PrefixReplace> 值为 true 时，这个字段才有效。该值表示替

换后的前缀，替换目录请以/结尾。可以为空，最长1024字节。

例：源对象为 picture.jpg，设置 ResourcesPrefix 值为 pic，

TargetKeyPrefix 值为 abc，则执行结果为 picture.jpg 变为 

abcture.jpg。
注意：

ResourcesPrefix 为空、 TargetKeyPrefix 有赋值，可实现增加前

缀操作；

ResourcesPrefix 和 TargetKeyPrefix 同时有赋值，可实现替换前

缀操作；

若 ResourcesPrefix 有赋值、 TargetKeyPrefix 为空，可实现删除

前缀操作。

String 否

Mo

difi

ed
Sin

ce
Co

nst
rai

nt

C

O
S

P

ut
O

bj
e

ct
C

o
p

y

当对象在指定时间后被修改，则执行操作，否则返回412。
Times
tamp

否

Un
Mo

difi
ed

Sin

ce
Co

nst

C
O

S
P

ut

O
bj

e
ct

当对象在指定时间后未被修改，则执行操作，否则返回412。 Times
tamp

否
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rai

nt

C

o

p
y

Me
tad

ata
Dir

ect
ive

C

O
S

P
ut

O
bj

e
ct

C
o

p

y

该元素指定是从源对象复制对象元数据还是替换为

<NewObjectMetadata> 元素中的元数据，有效值为：Copy、

Replaced、Add。Copy：继承源对象元数据；Replaced ：替

换源元数据；Add：在源元数据的基础上添加新的元数据。

String 否

Ne

wO
bje

ct
Me

tad
ata

C
O

S
P

ut
O

bj
e

ct
C

o

p
y

配置对象的元数据。

New

Objec
tMeta

data 
Objec

t

否

Ta
ggi

ng
Dir

ect
ive

C

O
S

P
ut

O
bj

e
ct

C
o

p

y

该元素指定是从源对象复制对象标签还是替换为

<NewObjectTagging> 元素中的标签，有效值为：Copy、

Replaced、Add。Copy：继承源对象标签；Replaced ：替换

源标签；Add：在源标签的基础上添加新的标签。

String 否
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Ne
wO

bje
ctT

ag
gin

g

C
O

S
P

ut
O

bj
e

ct
C

o

p
y

配置对象的标签，当 <TaggingDirective> 值为 Replace 或 Add 

时必须指定。

New
Objec

tTagg
ing

否

St

ora
ge

Cla
ss

C

O
S

P
ut

O
bj

e
ct

C
o

p

y

设置对象的存储级别，枚举值：STANDARD，
STANDARD_IA。默认值：STANDARD

String 否

Tar

get
Re

so
urc

e

C
O

S
P

ut
O

bj
e

ct
C

o

p
y

设置 Copy 的目标存储桶。请使用 qcs 指定，例如

qcs::cos:ap-chengdu:uid/1250000000:examplebucket-

1250000000

String 是

COSInitiateRestoreObject

节点名 父节点 描述 类型 是否
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必选

Expiration

InDays

COSInitiateRest

oreObject

设置副本在多少天后自动过期删除，设置范

围为1 - 365的整数。

Int

ege

r

是

JobTier
COSInitiateRest
oreObject

归档恢复模式选择，可选值：Bulk、
Standard。

Stri
ng

是

AccessControlGrants

节点名 父节点 描述 类型
是否必

选

COSGran
t

AccessControlGrant
s

配置一项权限控
制。

COSGrant 
Object

否

COSGrant

节点名 父节点 描述 类型
是否

必选

Grant
ee

COSG
rant

指定将权限授予给哪个用户。
Grantee 
Object

是

Permi
ssion

COSG
rant

指定要授予的某项权限。枚举值：READ，WRITE，
FULL_CONTROL 。

String 是

Grantee

节点名
父节

点
描述

类

型

是否

必选

Display
Name

Gra
nte

e

用户名称。
St
rin

g

否

Identifie
r

Gra

nte
e

qcs 格式的用户 ID（UIN）。例如：

qcs::cam::uin/100000000001:uin/100000000001

St

rin
g

是

TypeIde

ntifier

Gra

nte
e

指定 Identifier 的类型，目前仅支持用户 ID。枚举值：ID 。

St

rin
g

是
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NewObjectMetadata

节点名 父节点 描述 类型

是
否

必
选

CacheCon

trol

NewObject

Metadata

RFC 2616 中定义的缓存指令，将作

为对象元数据保存。
String 否

ContentDi

sposition

NewObject

Metadata

RFC 2616 中定义的文件名称，将作

为对象元数据保存。
String 否

ContentEn
coding

NewObject
Metadata

RFC 2616 中定义的编码格式，将作
为对象元数据保存。

String 否

ContentTy

pe

NewObject

Metadata

RFC 2616 中定义的内容类型，将作

为对象元数据保存。
String 否

HttpExpire

sDate

NewObject

Metadata

RFC 2616 中定义的缓存失效时间，

将作为对象元数据保存。
String 否

SSEAlgorit
hm

NewObject
Metadata

服务端加密算法，目前仅支持 
AES256。

String 否

UserMeta

data

NewObject

Metadata
包括用户自定义元数据。

Array of Key 

and Value
否

Report

节点名
父
节

点

描述
类

型

是
否

必
选

Buck
et

R
e

p
o

rt

任务完成报告的投递存储桶。

St

rin
g

是

Enab

led

R
e

p
o

rt

是否输出任务完成报告。

Bo
ol

ea
n

是
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Form

at

R

e
p

o
rt

任务完成报告格式信息。合法值： Report_CSV_V1 St

rin
g

是

Prefi
x

R

e
p

o
rt

任务完成报告的前缀信息。长度0 - 256字节
St
rin

g

否

Repo

rtSco
pe

R
e

p
o

rt

任务完成报告所需记录的任务信息，以确定记录所有操作执行信息还是失
败操作的信息。合法值：AllTasks、FailedTasksOnly

St

rin
g

是

ProgressSummary

节点名 父节点 描述 类型

NumberOfTasksFailed ProgressSummary 当前失败的操作数。 Integer

NumberOfTasksSucceeded ProgressSummary 当前成功的操作数。 Integer

TotalNumberOfTasks ProgressSummary 总操作数。 Integer
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错误响应
最近更新时间：2020-07-28 17:00:40

本文提供以下批量处理功能的错误响应。

失败响应格式

HTTP/1.1 400

<Error>

    <Code>string</Code>

    <Message>string</Message>

    <Resource>string</Resource>

    <RequestId>string</RequestId>

    <TraceId>string</TraceId>

</Error>

常见错误代码

错误代码 描述
状
态

码

API

InvalidArgu
ment

参数为空
4
0

0

CreateJob

InvalidArgu
ment

无效参数

4

0
0

CreateJob

InvalidArgu

ment
x-cos-appid 不能为空

4

0
0

Any

InvalidArgu

ment
优先级有效范围为0 - 2147483647的整数

4
0

0

CreateJob

InvalidArgu
ment

requestedJobStatus 参数状态必须为 
Cancelled 或 Ready

4
0

0

UpdateJobStatus

InvalidArgu

ment

jobStatuses 参数无效 4

0

ListJobs
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0

InvalidArgu
ment

maxResults 参数必须为正整数

4

0
0

ListJobs

InvalidArgu

ment
nextToken 参数无效

4

0
0

ListJobs

InvalidRequ

est
请求不合法

4
0

0

Any

InvalidRequ
est

请求体为空
4
0

0

Any

InvalidRequ
est

未提供任务 ID
4
0

0

Any

InvalidRequ
est

未提供任务优先级

4

0
0

UpdateJobPriority

InvalidRequ

est
ClientRequestToken 参数重复

4

0
0

CreateJob

InvalidRequ

est
指定作业已完成

4
0

0

UpdateJobStatus

InvalidRequ
est

任务状态变更错误
4
0

0

UpdateJobStatus

InternalErro
r

格式化响应 xml 失败

5

0
0

Any

Malformed
XML

请求格式不合法

4

0
0

Any

Malformed

XML

提供的 Manifest 格式不正确 4

0

CreateJob
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0

Malformed

XML
提供的 Operation 格式不正确

4
0

0

CreateJob

Malformed
XML

提供的 Report 格式不正确
4
0

0

CreateJob

NoSuchJob 指定作业不存在
4
0

4

DescribeJob

NoSuchJob 指定作业已完成

4

0
4

UpdateJobStatus，
UpdateJobPriority

ServiceUna

vailable
持久化数据错误

5

0
0

Any

ServiceUna

vailable
加载持久性数据出错

5
0

0

Any

ServiceUna
vailable

无法创建新任务
5
0

0

CreateJob

TooManyJo
bs

任务已达上限，服务器不可用

5

0
0

CreateJob
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数据处理接口

图片处理

图片处理机制介绍
最近更新时间：2023-06-02 11:12:28

对象存储提供了一套便捷的图片处理机制，通过这套机制可以对存储桶中的图片进行一系列的图片处理操作。

图片处理机制分为以下三种方式：

您可以通过在图片的 URL 后加上 图片处理参数 ，实现访问图片的时候同步获取到处理后的图片。

简介

方式 类别 说明

下载

时处
理

同步

处理
在图片的 URL 后加上 图片处理参数 。

上传

时处

理

持久

化处

理

上传图片时，在请求包头部中加入 Pic-Operations 项并设置好相应的 图片处理参

数 。

云上
数据

处理

持久
化处

理

针对 COS 上已经存在的图片进行处理，处理方式与上传时处理类似，在请求包头部中

加入 Pic-Operations 项并设置好相应的 图片处理参数 。

下载时处理

请求语法

GET /<ObjectKey>?<图片处理参数> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

示例

请求

GET /filename.jpg?imageMogr2/format/png HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

https://cloud.tencent.com/document/product/436/44879
https://cloud.tencent.com/document/product/436/44879
https://cloud.tencent.com/document/product/436/44879
https://cloud.tencent.com/document/product/436/44879
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上传时处理功能可以帮助使用者在上传时实现图片处理。您只需要在请求包头部中加入 Pic-Operations 项并设置

好相应的 图片处理参数 ，就可在图片上传时实现相应的图片处理，并可将原图和处理结果存入到 COS。目前支持

32M以内的图片处理。

图片上传的请求包与 COS V5 简单上传文件接口一致，只在请求包头部增加图片处理参数。

Pic-Operations 为 json 格式的字符串，具体参数如下：

Date: Wed, 28 Oct 2015 20:32:00 GMT

Authorization:XXXXXXXXXXXX

返回

HTTP/1.1 200 OK

Content-Type: image/png

Content-Length: 565

Date: Fri, 10 Apr 2020 09:35:16 GMT

Last-Modified: Fri, 10 Apr 2020 09:35:05 GMT

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

上传时处理

请求语法

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

说明

COS 简单上传文件接口，请参见 COS PUT Object  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

持久化处理的 QPS 限制为100，如您有更高需求请 联系我们 。

请求内容

参数名称 类型
是否必
选

描述

is_pic_i
nfo

Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

https://cloud.tencent.com/document/product/436/44879
https://cloud.tencent.com/document/product/436/7749
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/37708
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 rules（json 数组）中每一项具体参数如下：

响应包体具体数据内容如下：

 UploadResult 节点内容：

rules
Arr

ay
否

处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则

不进行图片处理

参
数

名
称

类

型

是
否

必
选

描述

bu

ck
et

St
ri

n
g

否
存储结果的目标存储桶名称，格式为 BucketName-APPID，如果不指定的话默认

保存到当前存储桶

file

id

St
ri

n
g

是

处理后文件的保存路径及名称。

当 fileid  与 ObjectKey  相同时，处理后的文件将覆盖原文件存储；不相同时将分

别存储原文件和处理后文件。名称规则说明：

1. 名称需要经过 URL 安全的 Base64 编码

2. 以 / 开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 文件夹中存

储了一个文件名为 test2.jpg 的文件

3. 不以 / 开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 p1 文件夹中

新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文件名为 test2.jpg 的文
件

4. 注意：请不要以 / 结尾，否则会产生空文件名

rul

e

St
ri

n
g

是
图片处理参数 ，若按指定样式处理，则以 style/  开头，后加样式名，如样式名为 

test ，则 rule 字段为 style/test

返回内容

参数名称 类型 描述

UploadResult Container 原图信息

参数名称 类型 描述

OriginalInfo Container 原图信息

https://cloud.tencent.com/document/product/436/44879
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 OriginalInfo 节点内容：

 ImageInfo 节点内容：

ProcessResults Container 图片处理结果

节点名称 类型 描述

Key String 原图文件名

Location String 图片路径

ImageInfo Container 原图图片信息

ETag String 原图 ETag 信息（若处理结果图覆盖原图则为结果图 ETag 信息）

节
点

名
称

类

型
描述

Fo

rm

at

Str

ing
格式

Wi
dth

Int 图片宽度

He

igh
t

Int 图片高度

Qu
alit

y

Int 图片质量

Av
e

Str
ing

图片主色调，格式为：0xRRGGBB （RR、GG、BB都是十六进制数，表示红、绿、蓝
三种颜色）

Ori

ent

ati
on

Int 图片旋转角度，取值为1-8的整数：

1：旋转0°

2：水平翻转
3：旋转180°

4：垂直翻转
5：顺时针旋转90°+水平翻转

6：顺时针旋转90°
7：顺时针旋转90°+垂直翻转
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 ProcessResults 节点内容：

 Object 节点内容：

8：逆时针旋转90°

Fr
am

eC
ou

nt

Int 图片的帧数。静态图为1，动图为对应的帧数。

节点名称 类型 描述

Object Container 每一个图片处理结果

节点名称 类型 描述

Key String 文件名

Location String 图片路径

Format String 图片格式

Width Int 图片宽度

Height Int 图片高度

Size Int 图片大小

Quality Int 图片质量

ETag String 处理结果图 ETag 信息

FrameCount Int 图片的帧数。静态图为1，动图为对应的帧数

示例

请求

PUT /filename.jpg HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Wed, 28 Oct 2015 20:32:00 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations: "is_pic_info":1,"rules": "fileid":"test.png","rule":"imageMogr2/format/pn

Content-Length: 64

{ [{
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Object[ ]

返回

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

        <OriginalInfo>

            <Key>filename.jpg</Key>

            <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/filename

            <ETag>&quot 580cd6930444576523c25f86ce2af9b1fc2d5484&quot </ETag>

            <ImageInfo>

                <Format>JPEG</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Quality>100</Quality>

                <Ave>0xa18454</Ave>

                <Orientation>1</Orientation>

                <FrameCount>1</FrameCount>

            </ImageInfo>

        </OriginalInfo>

        <ProcessResults>

            <Object>

                <Key>test.png</Key>

                <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/test.pn

                <Format>png</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Size>463092</Size>

                <Quality>100</Quality>

                <ETag>&quot eaa4e3d8fd498bbc63be3b71c46b9c61f23e3f0c&quot </ETag>

                <FrameCount>1</FrameCount>

            </Object>

        </ProcessResults>

</UploadResult>

; ;

; ;

注意
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对象存储的图片处理 API 能够对已存储在 COS 的图片进行相应处理操作，并将结果存入到 COS。

Pic-Operations 为 json 格式的字符串，具体参数如下：

 rules（json 数组）中每一项具体参数如下：

上传时处理支持 COS V5 的分块上传功能，您在使用 COS V5 的 Complete Multipart Upload  接口

时只需在请求包头部中加入 Pic-Operations 项，即可实现图片处理。

POST /<ObjectKey>?uploadId=UploadId HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: <PicOperations>

说明

COS 接口请参见 COS Complete Multipart Upload  文档。

云上数据处理

请求语法

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: <PicOperations>

请求内容

参数名称 类型
是否必
选

描述

is_pic_i

nfo
Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules
Arr
ay

否
处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则
不进行图片处理

参 类 是 描述

https://cloud.tencent.com/document/product/436/7742
https://cloud.tencent.com/document/product/436/7742
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 | 

| rule     | String | 是       | 处理参数，参见对象存储图片处理 API。若按指定样式处理，则以 style/  开头，后加

样式名，如样式名为 test ，则 rule 字段为 style/test  |

响应包体具体数据内容如下：

 UploadResult 节点内容：

 OriginalInfo 节点内容：

数
名

称

型 否
必

选

bu
ck

et

St
ri

n

g

否
存储结果的目标 bucket 名称，形如 BucketName-APPID，如果不指定的话默

认保存到当前存储桶

file

id

St
ri

n

g

是

处理后文件的保存路径及名称。

当 fileid  与 ObjectKey  相同时，处理后的文件将覆盖原文件存储；不相同时将

分别存储原文件和处理后文件。名称规则说明：
1. 名称需要经过 URL 安全的 Base64 编码 。

2. 以 /  开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 文件夹

中存储了一个文件名为 test2.jpg 的文件。

3. 不以  /  开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 p1 文件

夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文件名为 

test2.jpg 的文件。

4. 注意：请不要以 /  结尾，否则会产生空文件名。

返回内容

参数名称 类型 描述

UploadResult Container 原图信息

参数名称 类型 描述

OriginalInfo Container 原图信息

ProcessResults Container 图片处理结果

节点名称 类型 描述

Key String 原图文件名

https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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 ImageInfo 节点内容：

 ProcessResults 节点内容：

Location String 图片路径

ImageInfo Container 原图图片信息

ETag String 原图 ETag 信息（若处理结果图覆盖原图则为结果图 ETag 信息）

节点名

称

类

型
描述

Form

at

St
ri

n
g

图片格式

Width
In
t

图片宽度

Heigh

t

In

t
图片高度

Qualit

y

In

t
图片质量

Ave

St
ri

n
g

图片主色调，格式为：0xRRGGBB （RR、GG、BB都是十六进制数，表示红、绿、

蓝三种颜色）

Orient
ation

In
t

图片旋转角度，取值为1-8的整数：

1：旋转0°
2：水平翻转

3：旋转180°

4：垂直翻转
5：顺时针旋转90°+水平翻转

6：顺时针旋转90°
7：顺时针旋转90°+垂直翻转

8：逆时针旋转90°

Fram
eCou

nt

In
t

图片的帧数。静态图为1，动图为对应的帧数。
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 Object 节点内容：

节点名称 类型 描述

Object Container 每一个图片处理结果

节点名称 类型 描述

Key String 文件名

Location String 图片路径

Format String 图片格式

Width Int 图片宽度

Height Int 图片高度

Size Int 图片大小

Quality Int 图片质量

ETag String 处理结果图 ETag 信息

FrameCount Int 图片的帧数。静态图为1，动图为对应的帧数。

示例

请求

POST /filename.jpg?image_process HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Wed，18 Jan 2017 16:17:03 GMT

Authorization: XXXXXXXXXX

Pic-Operations: "is_pic_info":1,"rules": "fileid":"test.png","rule":"imageMogr2/format/pn

Content-Length: XX

{ [{

返回

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****
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<UploadResult>

            <OriginalInfo>

                <Key>filename.jpg</Key>

                <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/filenam

                <ETag>&quot eaa4e3d8fd498bbc63be3b71c46b9c61f23e3f0c&quot </ETag>

                <ImageInfo>

                    <Format>JPEG</Format>

                    <Width>640</Width>

                    <Height>427</Height>

                    <Quality>100</Quality>

                    <Ave>0xa18454</Ave>

                    <Orientation>1</Orientation>

                    <FrameCount>1</FrameCount>

                </ImageInfo>

            </OriginalInfo>

            <ProcessResults>

                <Object>

                    <Key>test.png</Key>

                    <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/test

                    <Format>png</Format>

                    <Width>640</Width>

                    <Height>427</Height>

                    <Size>463092</Size>

                    <Quality>100</Quality>

                    <ETag>&quot eaa4e3d8fd498bbc63be3b71c46b9c61f23e3f0c&quot </ETag

                    <FrameCount>1</FrameCount>

                </Object>

            </ProcessResults>

</UploadResult>

; ;

; ;
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基础图片处理

缩放
最近更新时间：2023-04-20 09:50:57

对象存储通过数据万象 imageMogr2 接口提供图片缩放功能。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过9999像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

注意

 图片处理功能为收费项，由数据万象收取，详细的计费说明请参见数据万象 图片处理费用 。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/thumbnail/<imageSizeAndOffsetGeometry> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

https://cloud.tencent.com/document/product/460/58117
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操作名称：thumbnail。

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/thumbnail/<imageSizeAndOffsetGeometry>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/thumbnail/<imageSizeAndOffsetGeometry>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid  与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid 的值需要经过 URL 安全的 Base64 编码 。

处理参数说明

参数 含义

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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ObjectKey 对象文件名，例如 folder/sample.jpg。

/thumbnail/!

<Scale>p
指定图片的宽高为原图的 Scale%

/thumbnail/!

<Scale>px
指定图片的宽为原图的 Scale%，高度不变

/thumbnail/!x<
Scale>p

指定图片的高为原图的 Scale%，宽度不变

/thumbnail/<

Width>x
指定目标图片宽度为 Width，高度等比缩放

/thumbnail/x<

Height>
指定目标图片高度为 Height，宽度等比缩放

/thumbnail/<
Width>x<Heig

ht>

限定缩略图的宽度和高度的最大值分别为 Width 和 Height，进行等比缩放

/thumbnail/<

Width>x<Heig
ht>>

限定缩略图的宽度和高度的最大值分别为 Width 和 Height，进行等比缩小，比例值
为宽缩放比和高缩放比的较小值，如果目标宽（高）都大于原图宽（高），则不变

/thumbnail/<

Width>x<Heig
ht><

限定缩略图的宽度和高度的最大值分别为 Width 和 Height，进行等比放大，比例值
为宽缩放比和高缩放比的较小值。如果目标宽(高)小于原图宽(高)，则不变

/thumbnail/!

<Width>x<Hei
ght>r

限定缩略图的宽度和高度的最小值分别为 Width 和 Height，进行等比缩放

/thumbnail/<
Width>x<Heig

ht>!

忽略原图宽高比例，指定图片宽度为 Width，高度为 Height，强行缩放图片，可能导

致目标图片变形

/thumbnail/<A
rea>@

等比缩放图片，缩放后的图像，总像素数量不超过 Area

/pad/
将原图缩放为指定 Width 和 Height 的矩形内的最大图片，之后使用 color 参数指定

的颜色居中填充空白部分；取值0或1，0代表不使用 pad 模式，1代表使用 pad 模式

/color/
填充颜色，缺省为白色，需设置为十六进制 RGB 格式（如 #FF0000），详情参考 

RGB 编码表 ，需经过 URL 安全的 Base64 编码 ，默认值为 #FFFFFF

/ignore-
error/1

当处理参数中携带此参数时，针对文件过大导致处理失败的场景，会直接返回原图而不
报错

https://www.rapidtables.com/web/color/RGB_Color.html
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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原图如下：

假设缩放图片宽高为原图50%，示例如下：

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：缩放宽高

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/t

https://cloud.tencent.com/document/product/436/54050
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最终效果如下：

假设缩放指定图片宽度为原图50%，高度不变，示例如下：

案例二：缩放宽度，高度不变

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/t
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最终效果如下：

将原图缩放为600 x 600的矩形内的最大图片，并使用指定颜色填充空白部分，示例如下：

案例三：Pad 模式缩放

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/t
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最终效果如下：

处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

案例四：Pad 模式缩放并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature> 为签名部分，获取方式请参考 请求签名 。

注意事项

https://cloud.tencent.com/document/product/436/7778
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为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
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裁剪
最近更新时间：2023-04-20 09:51:04

对象存储通过数据万象接口 imageMogr2 提供裁剪功能，包括普通裁剪、缩放裁剪、内切圆裁剪、圆角裁剪和人

脸智能裁剪。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

注意

 图片处理功能为收费项，由数据万象收取，详细的计费说明请参见数据万象 图片处理费用 。

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过9999像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/cut/<width>x<height>x<dx>x<dy>

                       /crop/<imageSizeAndOffsetGeometry>

                       /iradius/<radius>

                       /rradius/<radius>

                       /scrop/<Width>x<Height> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

https://cloud.tencent.com/document/product/460/58117
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 请忽略上面的空格与换行符。

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/cut/<width>x<height>x<dx>x<dy>

                       /crop/<imageSizeAndOffsetGeometry>

                       /iradius/<radius>

                       /rradius/<radius>

                       /scrop/<Width>x<Height>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/cut/<width>x<height>x<dx>x<dy>

                       /crop/<imageSizeAndOffsetGeometry>

                       /iradius/<radius>

                       /rradius/<radius>

                       /scrop/<Width>x<Height>"

  }]

}

说明
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操作名称：cut。

操作名称：crop。

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid 与 ObjectKey 相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后图

片。

fileid  的值需要经过 URL 安全的 Base64 编码 。

处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

/ignore-
error/1

当处理参数中携带此参数时，针对文件过大导致处理失败的场景，会直接返回原图而不
报错

普通裁剪参数说明

参数 含义

<width> 指定目标图片的宽为 width

<height> 指定目标图片的高为 height

<dx> 相对于图片左上顶点水平向右偏移 dx

<dy> 相对于图片左上顶点水平向下偏移 dy

说明

 参数取值范围应大于0，小于原图宽高。

缩放裁剪参数说明

参数 含义

/crop/<Width>x 指定目标图片宽度为 Width，高度不变。Width 取值范围应大于0，小于原图宽度

/crop/x<Height> 指定目标图片高度为 Height，宽度不变。Height 取值范围应大于0，小于原图高

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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在进行缩放裁剪操作时，您也可以使用 gravity 参数指定操作的起点位置，详见下文中 缩放裁剪操作示例 。

操作名称：iradius。

操作名称：rradius。

操作名称：scrop。

九宫格方位图可为图片的多种操作提供位置参考。红点为各区域位置的原点（通过 gravity 参数选定各区域后位移

操作会以相应远点为参照）。  

度

/crop/<Width>x<

Height>

指定目标图片宽度为 Width，高度为 Height 。Width 和 Height 取值范围都应

大于0，小于原图宽度/高度

内切圆裁剪参数说明

参数 含义

/iradiu

s/<radi
us>

内切圆裁剪功能，radius 是内切圆的半径，取值范围为大于0且小于原图最小边一半的整数。内

切圆的圆心为图片的中心。图片格式为 gif 时，不支持该参数。
处理后图片如果是PNG、WebP或BMP等支持透明通道的图片，那么图片非圆形区域的部分将

会以透明填充；如果是JPG图片，不支持透明通道，非圆形区域是以白色进行填充。

圆角裁剪参数说明

参数 含义

/rradiu
s/<radi

us>

圆角裁剪功能，radius 为图片圆角边缘的半径，取值范围为大于0且小于原图最小边一半的整

数。圆角与原图边缘相切。图片格式为 gif 时，不支持该参数。
处理后图片如果是PNG、WebP或BMP等支持透明通道的图片，那么图片非圆形区域的部分

将会以透明填充；如果是JPG图片，不支持透明通道，非圆形区域是以白色进行填充。

人脸智能裁剪参数说明

参数 含义

/scrop/<Width>x<Heig

ht>

基于图片中的人脸位置进行缩放裁剪。目标图片的宽度为 Width、高度为 

Height。

九宫格方位图
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注意

当 gravity 参数设置为 center 时，dx、dy 参数无效。

当 gravity 参数设置为 north 或 south 时，dx 参数无效（水印会水平居中）。

当 gravity 参数设置为 west 或 east 时，dy 参数无效（水印会垂直居中）。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：普通裁剪

https://cloud.tencent.com/document/product/436/54050
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相对于图片左上顶点水平向右平移100像素，垂直向下平移10像素，指定目标图片大小为600×600进行裁剪：

原图如下：

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/c
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最终效果如下：

假设以中心点 center 为参考点，缩放裁剪至300×400，示例如下：

案例二：缩放裁剪

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/c
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最终效果如下：

取半径为200，进行内切圆裁剪：

案例三：内切圆裁剪

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/i
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最终效果如下：

取半径为100，进行圆角裁剪：

案例四：圆角裁剪

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/r
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最终效果如下：

基于图片中的人脸位置进行缩放裁剪，目标图片大小为100×600，示例如下：

处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

案例五：人脸智能裁剪

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/s

说明

如果图片中没有识别到人脸，则返回原图。

案例六：人脸智能裁剪并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith
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为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

说明

<signature> 为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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旋转
最近更新时间：2023-04-20 09:51:22

对象存储通过数据万象 imageMogr2 接口提供旋转功能，包括普通旋转和自适应旋转。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

注意

 图片处理功能为收费项，由数据万象收取，详细的计费说明请参见数据万象 图片处理费用 。

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口形式

1. 下载时处理

GET /<ObjectKey>?/rotate/<rotateDegree>

                       /auto-orient HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

注意

 请忽略上面的空格与换行符。

2. 上传时处理

https://cloud.tencent.com/document/product/460/58117
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/rotate/<rotateDegree>

                       /auto-orient"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/rotate/<rotateDegree>

                       /auto-orient"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid  与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码 。

处理参数说明

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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顺时针旋转90度，示例如下：

最终效果如下：

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

/rotate/<rotateDegr

ee>
普通旋转：图片顺时针旋转角度，取值范围0 - 360，默认不旋转。

/auto-orient 自适应旋转：根据原图 EXIF 信息将图片自适应旋转回正。

/flip/<flip> 镜像翻转：flip 值为 vertical 表示垂直翻转，horizontal 表示水平翻转

/ignore-error/1
当处理参数中携带此参数时，针对文件过大导致处理失败的场景，会直接返回原

图而不报错

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：普通旋转

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/r

https://cloud.tencent.com/document/product/436/54050
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处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了防止未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

案例二：普通旋转并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith
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格式转换
最近更新时间：2023-06-05 15:00:39

腾讯云数据万象通过 imageMogr2 接口提供格式转换、渐进显示功能。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

gif、webp、tpg 等动图，支持互相转换。

jpg、png、bmp、webp、avif、tpg、heif 等静态图片，支持互相转换。

转换为avif、tpg、heif需先开通图片高级压缩服务，详情请查看 设置图片高级压缩 。

接口形式

1. 下载时处理

GET /<ObjectKey>?imageMogr2/format/<Format> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/format/<Format>"

           }]

}

https://cloud.tencent.com/document/product/436/48981
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3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/format/<Format>"

           }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片处理机制介绍 。

当 fileid 与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码 。

处理参数说明

参数 含义
是否
必选

ObjectKey 对象文件名，例如 folder/sample.jpg。 是

/format/<Fo

rmat>

有效值：jpg，bmp，gif，png，webp，heif，avif，tpg。

如需转换为avif、tpg、heif，请先开通图片高级压缩服务。
是

/ignore-

error/1

当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场

景，会直接返回原图而不报错
否

实际案例

说明

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/436/54050#.E4.B8.8A.E4.BC.A0.E6.97.B6.E5.A4.84.E7.90.86
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
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处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您可

查阅 图片处理机制介绍  文档并配置上传时处理或云上数据处理。

案例一：将 jpeg 格式的原图片转换为 png 格式

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/f

案例二：将 jpeg 格式的原图片转换为 png 格式并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/436/7778
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质量变换
最近更新时间：2023-04-20 09:55:27

对象存储通过数据万象 imageMogr2 接口对图片质量进行调节。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

说明

图片处理功能为收费项，由数据万象收取，详细的计费说明请参见数据万象 图片处理费用 。

该接口支持 jpg、webp、tpg、heif、avif 格式图片。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/quality/<Quality>

                       /rquality/<quality>

                       /lquality/<quality> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/quality/<Quality>

                       /rquality/<quality>

                       /lquality/<quality>"

https://cloud.tencent.com/document/product/460/58117
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操作名称：quality。

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/quality/<Quality>

                       /rquality/<quality>

                       /lquality/<quality>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid 与 ObjectKey 相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后图

片。

fileid  的值需要经过 URL 安全的 Base64 编码 。

当 fileid  与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后图片

处理参数说明

参数 含义

ObjectK
ey

对象文件名，例如 folder/sample.jpg。

/quality/
<Quality

图片的绝对质量，取值范围0 - 100，默认值为原图质量；取原图质量和指定质量的最小值；

<Quality>后面加“!”表示强制使用指定值，例如： 90! 。

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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假设设置绝对质量为60，示例如下：

>

/rquality/
<quality

>

图片的相对质量，取值范围0 - 100，数值以原图质量为标准。例如原图质量为80，将 

rquality 设置为80后，得到处理结果图的图片质量为64（80x80%）。

/lquality/
<quality

>

图片的最低质量，取值范围0 - 100，设置结果图的质量参数最小值。
例如原图质量为85，将 lquality 设置为80后，处理结果图的图片质量为85。

例如原图质量为60，将 lquality 设置为80后，处理结果图的图片质量会被提升至80。

/ignore-
error/1

当处理参数中携带此参数时，针对文件过大导致处理失败的场景，会直接返回原图而不报错

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：设置绝对质量

http://examples-1251000004.picsh.myqcloud.com/sample.jpeg?imageMogr2/quality/60

https://cloud.tencent.com/document/product/436/54050
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效果如下：

假设设置相对质量为60，示例如下：

案例二：设置相对质量

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/r
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效果如下：

处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

案例三：设置相对质量为60并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature> 为签名部分，获取方式请参考 请求签名 。

注意事项

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith
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渐进显示
最近更新时间：2023-07-31 16:55:32

腾讯云数据万象通过 imageMogr2 接口提供jpg图片的渐进显示功能。

功能概述

限制说明

支持格式：支持处理原图为 JPG、BMP、GIF、PNG、WebP、HEIF的格式，但渐进显示仅支持JPG图进

行显示，其他格式图片需搭配格式转换 format 参数将原图转换为JPG格式。

体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素。

接口示例

GET /<ObjectKey>?imageMogr2/interlace/<Mode> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

参数 含义

ObjectK
ey

对象文件名，例如 folder/sample.gif。

/interlac
e/

输出为渐进式 jpg 格式。Mode 可为0或1。

该参数仅在输出图片格式为 jpg 格式时有效。如果输出非 jpg 图片格式，会忽略该参数，默认

值0。

0：表示不开启渐进式；

1：表示开启渐进式。

/ignore-
error/1

当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场景，会直接返回原
图而不报错。

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第580 共1701页

将原图格式为PNG的图片保存为JPG格式，并设置成渐进显示：

图片将渐进显示，效果图如下：

实际案例

http://ci-document-example-1259788808.cos.ap-shanghai.myqcloud.com/sample.jpeg?im
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为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 预签名授权下载 。

注意事项

https://cloud.tencent.com/document/product/436/14116
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http://ci-document-example-1259788808.cos.ap-

shanghai.myqcloud.com/sample.jpeg?q-sign-algorithm=sha1&q-

ak=AKID********************&q-sign-time=1593342360;1593342720&q-key-

time=1593342360;1593342720&q-header-list=&q-url-param-

list=watermark%252f1%252fimage%252fahr0cdovl2v4yw1wbgvzlteyntewmdawmdqu

cgljc2gubxlxy2xvdwquy29tl3nodwl5aw4uanbn%252fgravity%252fsoutheast&q-

signature=26a429871963375c88081ef60247c5746e834a98&watermark/1/image/aHR

0cDovL2V4YW1wbGVzLTEyNTEwMDAwMDQucGljc2gubXlxY2xvdWQuY29tL3NodWl5aW

4uanBn/gravity/southeast
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动图截帧
最近更新时间：2023-05-30 16:27:59

腾讯云数据万象通过 imageMogr2 接口提供动图截帧功能。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 GIF、WebP 格式。

体积限制：GIF 原图宽 x 高 x 帧数不超过2.5亿像素；WebP原图宽高不超过16383像素。

动图帧数限制：帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/cgif/<FrameNumber>

                           /egif/<FrameInterval> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

 请忽略上面的空格与换行符。

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{
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      "fileid": "exampleobject",

      "rule": "imageMogr2/cgif/<FrameNumber>

                         /egif/<FrameInterval>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/cgif/<FrameNumber>

                         /egif/<FrameInterval>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid  与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码 。

处理参数说明

参数 含义

Obje
ctKe

y

对象文件名，例如 folder/sample.gif。

/fram

e/

动图截单帧（仅支持下载时处理）：可指定截取动图的第N帧，N取值为正整数（1,2,3……），

如果N大于动图的最大帧数，则取最后一帧。例如截取某动图的第1帧，则参数为 /frame/1。

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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对某GIF动图截取前10帧：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

/cgif/ 动图格式优化（截取型）：针对原图为 gif、webp 格式，对动图进行的优化，截帧降颜色。分为
以下两种情况：

FrameNumber=1，则按照默认帧数30处理，如果图片帧数大于该帧数则截取。

FrameNumber 取值(1,100]，则将图片压缩到指定帧数 （FrameNumber）。

/egif/

动图格式优化（抽帧型）：只针对原图为 gif、webp 格式，对动图进行的优化，进行降颜色处

理，并每隔一定帧数（FrameInterval）抽取目标帧进行输出。
FrameInterval 取值[1,10]。

/ignor

e-
error/

1

当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场景，会直接返回原图而
不报错。

注意

 cgif与egif参数同时传递时，优先处理cgif。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

http://examples-125xxxxxx.cos.ap-shanghai.myqcloud.com/sample.gif?imageMogr2/cgif/

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/460/18147
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高斯模糊
最近更新时间：2023-04-20 09:55:58

对象存储通过数据万象接口 imageMogr2 提供图片模糊处理功能。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

download_url?imageMogr2/blur/<radius>x<sigma>       

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/blur/<radius>x<sigma>"

  }]
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操作名称：blur。

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/blur/<radius>x<sigma>"

  }]

}

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

当 fileid  与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码 。

处理参数说明

参数 含义

downl
oad_u

rl

文件的访问链接，具体构成为<BucketName-APPID>.cos.
<Region>.myqcloud.com/<picture name>

例如 examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/picture.jpeg

radius
<radiu

s>

模糊半径，取值范围为1 - 50

sigma

<sigm
a>

正态分布的标准差，必须大于0

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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高斯模糊处理后效果如下：

/ignore
-

error/1

当处理参数中携带此参数时，针对文件过大导致处理失败的场景，会直接返回原图而不报错

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：模糊半径取8，sigma 值取5，进行高斯模糊处理

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/b

https://cloud.tencent.com/document/product/436/54050
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处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

案例二：模糊半径取8，sigma 值取5，进行高斯模糊处理，并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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亮度
最近更新时间：2023-04-20 09:56:04

对象存储通过数据万象 imageMogr2 接口调节图片亮度。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/bright/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{
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操作名称：bright。

      "fileid": "exampleobject",

      "rule": "imageMogr2/bright/<value>"

  }]

}

说明

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid  与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码 。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/bright/<value>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

/bright/<value
>

图片亮度调节功能，value 为亮度参数值，取值范围为[-100, 100]的整数。
取值＜0：降低图片亮度。

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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将图片亮度提高70，示例如下：

最终效果如下：

取值 = 0：不调整图片亮度。

取值＞0：提高图片亮度。

/ignore-

error/1

当处理参数中携带此参数时，针对文件过大导致处理失败的场景，会直接返回原图而不

报错。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：亮度调节

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/b

https://cloud.tencent.com/document/product/436/54050
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处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了防止未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

案例二：亮度调节并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith
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对比度
最近更新时间：2023-04-20 09:56:09

对比度指一幅图像中明暗区域最亮的白和最暗的黑之间不同亮度层级的测量，即指一幅图像灰度反差的大小。对象存

储通过数据万象 imageMogr2 接口调节图片对比度。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/contrast/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,
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操作名称：contrast。

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/contrast/<value>"

  }]

}

说明

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

fileid  与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后图

片。

fileid  的值需要经过 URL 安全的 Base64 编码 。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/contrast/<value>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

/contrast/<valu 图片对比度调节功能，value 为对比度参数值，取值范围为[-100, 100]的整数。

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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将图片对比度降低50，示例如下：

e> 取值＜0：降低图片对比度。

取值 = 0：不调整图片对比度。

取值＞0：提高图片对比度。

/ignore-error/1
当处理参数中携带此参数时，针对文件过大导致处理失败的场景，会直接返回原图而
不报错。

实际案例

案例一：对比度调节

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/c

https://cloud.tencent.com/document/product/436/54050
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最终效果如下：

处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

案例二：对比度调节并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature> 为签名部分，获取方式请参考 请求签名 。

注意事项

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第600 共1701页

锐化
最近更新时间：2023-04-20 09:56:15

对象存储通过数据万象 imageMogr2 接口对图片进行锐化处理。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

注意

 图片处理功能为收费项，由数据万象收取，详细的计费说明请参见数据万象 图片处理费用 。

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/sharpen/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

https://cloud.tencent.com/document/product/460/58117
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操作名称：sharpen。

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/sharpen/<value>"

  }]

}

说明

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid 与 ObjectKey 相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后图

片。

fileid 的值需要经过 URL 安全的 Base64 编码 。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/sharpen/<value>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

参数 含义

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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假设设置锐化参数为70，进行锐化处理，示例如下：

ObjectKey 对象文件名，例如 folder/sample.jpg。

/sharpen/<v
alue>

图片锐化功能，value 为锐化参数值，取值范围为10 - 300间的整数（推荐使用70）。
参数值越大，锐化效果越明显。

/ignore-
error/1

当处理参数中携带此参数时，针对文件过大导致处理失败的场景，会直接返回原图而不报
错。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：锐化

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/s

https://cloud.tencent.com/document/product/436/54050
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最终效果如下：

处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

案例二：锐化并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith
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灰度图
最近更新时间：2023-04-20 09:56:20

对象存储通过数据万象 imageMogr2/grayscale 接口将图片设置为灰度图。

操作名称：grayscale。

功能概述

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

GET /<ObjectKey>?imageMogr2/grayscale/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

当 fileid  与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码 。

处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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将图片变为灰度图，示例如下：

最终效果如下：

/grayscale/<valu

e>

将图片设置为灰度图。

value 取值为0表示不改变图片。

value 取值为1表示将图片变为灰度图。

/ignore-error/1
当处理参数中携带此参数时，针对文件过大导致处理失败的场景，会直接返回原图而
不报错。

实际案例

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/g
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图片水印
最近更新时间：2023-08-02 16:17:42

对象存储通过数据万象 watermark/1 接口提供图片水印处理功能。目前水印图片必须指定为已存储于数据万象绑

定（或新建）的存储桶中的图片。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，开通 图片高级压缩功能  后，可支持AVIF、

HEIF、TPG 格式的解码和处理操作。

静图体积限制：处理图片的原图及结果图的大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像

素。

WebP图片限制：处理图片原图及结果图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像

素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：不超过300帧。

说明

图片处理功能为收费项，由数据万象收取，详细的计费说明请参见数据万象 图片处理费用 。

一张图片上，最多添加10张不同的图片水印。

不支持添加动图作为水印。

接口示例

1. 下载时处理

GET /<ObjectKey>?watermark/1/image/<encodedURL>

                            /image_key/<image_key>

                         /gravity/<gravity>

                         /dx/<dx>

                         /dy/<dy>

                         /blogo/<type> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

https://cloud.tencent.com/document/product/460/47501
https://cloud.tencent.com/document/product/460/58117
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Date: <GMT Date>

Authorization: <Auth String>

说明

 请忽略上面的空格与换行符。

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "watermark/1/image/<encodedURL>

                       /gravity/<gravity>

                       /dx/<dx>

                       /dy/<dy>

                       /blogo/<type>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "watermark/1/image/<encodedURL>

                       /gravity/<gravity>

                       /dx/<dx>

                       /dy/<dy>

                          /blogo/<type>"
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  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid 与 ObjectKey 相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后图

片。

fileid 的值需要经过 URL 安全的 Base64 编码 。

处理参数说明

参数 含义 是否必选

Object

Key
对象文件名，例如 folder/sample.jpg 是

water
mark/1

代表当前的处理为图片水印。 是

/image

/

水印图片地址，需要经过 URL 安全的 Base64 编码 。例如，水印图片为

http://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/shuiyin_2.png

，则该处编码后的字符串为

aHR0cDovL2V4YW1wbGVidWNrZXQtMTI1MDAwMDAwMC5jb3M

uYXAtc2hhbmdoYWkubXlxY2xvdWQuY29tL3NodWl5aW5fMi5wb

mc

与/image_ke

y/参数二选一

/image

_key/

如果您在添加水印时不希望暴露水印所在的图片地址，可使用该参数。

该参数表示存储桶中水印图片所在的路径及名称，需要经过 URL 安全的 

Base64 编码 。例如，水印图片在本存储桶中的路径及名称为：

 image/shuiyin_2.png

则该处编码后的字符串为  

aW1hZ2Uvc2h1aXlpbl8yLnBuZw

与/image/参

数二选一

/gravit

y/

图片水印位置，九宫格位置（ 参考九宫格方位图  ），默认值为 

SouthEast
否

/dx/ 水平（横轴）边距，单位为像素，缺省值为0 否

/dy/ 垂直（纵轴）边距，单位为像素，默认值为0 否

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
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/blogo/ 水印图适配功能，适用于水印图尺寸过大的场景（如水印墙）。一共有两种

类型：
当 blogo 设置为1时，水印图会被缩放至与原图相似大小后添加

当 blogo 设置为2时，水印图会被直接裁剪至与原图相似大小后添加

否

/scaty

pe/

根据原图的大小，缩放调整水印图的大小：
当 scatype 设置为1时，按原图的宽缩放

当 scatype 设置为2时，按原图的高缩放

当 scatype 设置为3时，按原图的整体面积缩放

否

/spcen
t/

与 scatype 搭配使用：

当 scatype 设置为1时，该有效值为[1, 1000]，单位为千分比

当 scatype 设置为2时，该有效值为[1, 1000]，单位为千分比

当 scatype 设置为3时，该有效值为[1, 250]，单位为千分比。示例：

http://examples-1251000004.cos.ap-

shanghai.myqcloud.com/sample.jpeg?

watermark/1/image/xxxxxxx/scatype/3/spcent/250

否

/dissol
ve/

图片水印的透明度，取值为1 - 100，默认90（90%不透明度） 否

/batch/
平铺水印功能，可将图片水印平铺至整张图片。值为1时，表示开启平铺水
印功能

否

/degre

e/

当 batch 值为1时生效。图片水印的旋转角度设置，取值范围为0 - 

360，默认0
否

注意

 指定的水印图片必须同时满足如下3个条件：  

水印图片与原图片必须位于同一个存储桶下。

URL 需使用 COS 域名（不能使用 CDN 加速域名，例如 

examplebucket-1250000000.file.myqcloud.com/shuiyin_2.png  不可用 ），且需保证水印图可

访问（如果水印图读取权限为私有，则需要携带有效签名）。

URL 必须以 http:// 开始，不能省略 HTTP 头，也不能填 HTTPS 头，例如

examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/shuiyin_2.png ，

https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/shuiyin_2.png  为非法

的水印 URL。

九宫格方位图
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九宫格方位图可为图片的多种操作提供位置参考。红点为各区域位置的原点（通过 gravity 参数选定各区域后位移

操作会以相应原点为参照）。  

说明

当 gravity 参数设置为 center 时，dx、dy 参数无效。

当 gravity 参数设置为 north 或 south 时，dx 参数无效（水印会水平居中）。

当 gravity 参数设置为 west 或 east 时，dy 参数无效（水印会垂直居中）。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：添加图片水印

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?watermark/1/i

https://cloud.tencent.com/document/product/436/54050
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添加图片水印后效果如下：

案例二：添加图片水印并设置平铺、透明度

https://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?watermark/1/
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添加图片水印并设置旋转45度平铺、透明度为40%后，效果如下： 

处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 预签名授权下载 。

案例三：添加图片水印并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

 <signature>为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14116
https://cloud.tencent.com/document/product/436/7778
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文字水印
最近更新时间：2023-05-19 15:50:07

对象存储通过数据万象 watermark 接口提供实时文字水印处理功能。

该功能支持以下的处理方式：

功能概述

注意

 图片处理功能为收费项，由数据万象收取，详细的计费说明请参见数据万象 图片处理费用 。

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?watermark/2/text/<encodedText>

                        /font/<encodedFont>

                        /fontsize/<fontSize>

                        /fill/<encodedColor>

                        /dissolve/<dissolve>

                        /gravity/<gravity>

                        /dx/<dx>

                        /dy/<dy>

                        /batch/<type>

                        /degree/<degree>

                        /shadow/<shadow> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

https://cloud.tencent.com/document/product/460/58117
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Date: <GMT Date>

Authorization: <Auth String>

说明

 请忽略上面的空格与换行符。

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "watermark/2/text/<encodedText>

                        /font/<encodedFont>

                        /fontsize/<fontSize>

                        /fill/<encodedColor>

                        /dissolve/<dissolve>

                        /gravity/<gravity>

                        /dx/<dx>

                        /dy/<dy>

                        /batch/<type>

                        /degree/<degree>

                        /shadow/<shadow>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{
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操作名称：watermark，数字2，表示水印类型为文字水印。

      "fileid": "exampleobject",

      "rule": "watermark/2/text/<encodedText>

                        /font/<encodedFont>

                        /fontsize/<fontSize>

                        /fill/<encodedColor>

                        /dissolve/<dissolve>

                        /gravity/<gravity>

                        /dx/<dx>

                        /dy/<dy>

                        /batch/<type>

                        /degree/<degree>

                        /shadow/<shadow>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid 与 ObjectKey 相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后图

片。

fileid 的值需要经过 URL 安全的 Base64 编码 。

处理参数说明

参数 含义

是

否
必

选

Obj

ect
Key

对象文件名，例如 folder/sample.jpg。 是

/tex

t/
水印内容，需要经过 URL 安全的 Base64 编码 是

/fon

t/

水印字体，需要经过 URL 安全的 Base64 编码 ，默认值 tahoma.ttf 。水印字体列表参

考 支持字体列表
否

/fon 水印文字字体大小，单位为磅，缺省值13。如需按照原图片的大小比例缩放文字水印，请将 否

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/460/19568
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九宫格方位图可为图片的多种操作提供位置参考。红点为各区域位置的原点（通过 gravity 参数选定各区域后位移

操作会以相应远点为参照）。

tsiz

e/

文字水印转换为 PNG 图片，并参考 图片水印  文档进行配置

/fill/
字体颜色，缺省为灰色，需设置为十六进制 RGB 格式（例如 #FF0000），详情可参考 
RGB 编码表 ，需经过 URL 安全的 Base64 编码 ，默认值为 #3D3D3D

否

/dis

solv
e/

文字透明度，取值1 - 100，默认90（90%不透明度） 否

/gra
vity/

文字水印位置，九宫格位置（ 参见九宫格方位图 ），默认值 SouthEast 否

/dx/ 水平（横轴）边距，单位为像素，缺省值为0 否

/dy/ 垂直（纵轴）边距，单位为像素，默认值为0 否

/bat
ch/

平铺水印功能，可将文字水印平铺至整张图片。值为1时，表示开启平铺水印功能 否

/sp

aci
ng/

平铺模式下的水平、垂直间距相对文字水印贴图的宽高百分比，范围为[0,100]，默认10 否

/de

gre

e/

当 batch 值为1时生效。文字水印的旋转角度设置，取值范围为0 - 360，默认0 否

/sh
ado

w/

文字阴影效果，有效值为[0,100]，默认为0，表示无阴影 否

/sc
aty

pe/

根据原图的大小，缩放调整文字水印的大小：
当 scatype 设置为1时，按原图的宽缩放

当 scatype 设置为2时，按原图的高缩放

当 scatype 设置为3时，按原图的整体面积缩放

否

/sp

cen
t/

与 scatype 搭配使用：

当 scatype 设置为1时，该有效值为[1, 1000]，单位为千分比

当 scatype 设置为2时，该有效值为[1, 1000]，单位为千分比

当 scatype 设置为3时，该有效值为[1, 250]，单位为千分比。

否

九宫格方位图

https://cloud.tencent.com/document/product/436/44887
https://www.rapidtables.com/web/color/RGB_Color.html
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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注意

当 gravity 参数设置为 center 时，dx、dy 参数无效。

当 gravity 参数设置为 north 或 south 时，dx 参数无效（水印会水平居中）。

当 gravity 参数设置为 west 或 east 时，dy 参数无效（水印会垂直居中）。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：添加文字水印

https://cloud.tencent.com/document/product/436/54050
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添加文字水印后，效果如下：

处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?watermark/2/t

案例二：添加文字水印并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

https://cloud.tencent.com/document/product/436/7778
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为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
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获取图片基本信息
最近更新时间：2023-03-13 14:22:04

对象存储通过数据万象 imageInfo 接口查询图片基本信息，包括格式、长、宽等。

操作名称：imageInfo。

功能概述

注意

 图片处理功能为收费项，由数据万象收取，详细的计费说明请参见数据万象 图片处理费用 。

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

GET /<ObjectKey>?imageInfo HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

请求参数

参数 含义

https://cloud.tencent.com/document/product/460/58117
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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获取方式同上，仅增加签名部分，并与获取参数以“&”连接，示例如下：

ObjectKey 对象文件名，例如 folder/sample.jpg。

响应参数

参数 含义

format 图片类型。例如 png、gif 等

width 图片的宽度。单位为像素（px）

height 图片的高度。单位为像素（px）

size 图片的大小。单位为 Bytes

md5 图片的 md5 值

frame_count 图片的帧数。静态图为1，动图为对应的帧数

bit_depth 图片的位深

vertical_dpi 图片的垂直分辨率

horizontal_dpi 图片的水平分辨率

实际案例

案例一：公有读

请求

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageInfo

响应

{"format": "jpeg", "width": "960", "height": "540", "size": "158421", "md5": "77a16fa70e2

案例二：私有读、携带签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

https://cloud.tencent.com/document/product/436/7778
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为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
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获取图片 EXIF
最近更新时间：2023-02-15 14:45:28

EXIF（Exchangeable Image File）全称为可交换图像文件，可记录数码照片的拍摄参数、缩略图及其他属性

信息。对象存储通过数据万象的 exif 接口获取 EXIF 信息。

操作名称：exif。

功能概述

注意

图片处理功能为收费项，由数据万象收取，详细的计费说明请参见数据万象 图片处理费用 。

如图片无 exif 信息，将返回 {"error" : "no exif data"} 。

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

GET /<ObjectKey>?exif HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

参数 含义

https://cloud.tencent.com/document/product/460/58117
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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获取方式同上，仅增加签名部分，并与获取参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

ObjectKey 对象文件名，例如 folder/sample.jpg。

实际案例

案例一：公有读

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?exif

案例二：私有读、携带签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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获取图片主色调
最近更新时间：2023-02-15 14:45:34

对象存储通过数据万象 imageAve 接口获取图片主色调信息。

操作名称：imageAve

功能概述

注意

 图片处理功能为收费项，由数据万象收取，详细的计费说明请参见数据万象 图片处理费用 。

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

GET /<ObjectKey>?imageAve HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

https://cloud.tencent.com/document/product/460/58117
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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获取方式同上，仅增加签名部分，并与获取参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

实际案例

案例一：公有读

请求

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageAve

响应

{"RGB": "0x736246"}

案例二：私有读、携带签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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去除元信息
最近更新时间：2023-04-20 09:56:53

对象存储通过数据万象 imageMogr2 接口可去除图片元信息，包括 exif 信息。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

注意

 图片处理功能为收费项，由数据万象收取，详细的计费说明请参见数据万象 图片处理费用 。

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/strip HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

https://cloud.tencent.com/document/product/460/58117
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操作名称：strip。

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/strip"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/strip"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid 与 ObjectKey 相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后图

片。

fileid 的值需要经过 URL 安全的 Base64 编码 。

处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

/ignore- 当处理参数中携带此参数时，针对文件过大导致处理失败的场景，会直接返回原图而不

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了防止未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

error/1 报错。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：公有读

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/s

案例二：私有读、携带签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/54050
https://cloud.tencent.com/document/product/436/7778
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快速缩略模板
最近更新时间：2023-07-14 18:11:52

对象存储通过数据万象 imageView2 接口提供常用图片处理模板。开发者根据业务需求，只需在下载 URL 后面

附加相应的参数，就可以生成相应的缩略图。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

注意

 图片处理功能为收费项，由数据万象收取，详细的计费说明请参见数据万象 图片处理费用 。

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过9999像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过9999像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageView2/<mode>/w/<Width>

                 /h/<Height>

                 /format/<Format>

                 /q/<Quality>

                 /rq/<Quality>

                 /lq/<Quality> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

https://cloud.tencent.com/document/product/460/58117
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注意

 质量变换参数仅针对 jpg 和 webp 格式图片。

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageView2/<mode>/w/<Width>

                 /h/<Height>

                 /format/<Format>

                 /q/<Quality>

                 /rq/<Quality>

                 /lq/<Quality>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageView2/<mode>/w/<Width>

                 /h/<Height>

                 /format/<Format>

                 /q/<Quality>

                 /rq/<Quality>

                 /lq/<Quality>"

  }]

}
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说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid 与 ObjectKey 相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后图

片。

fileid 的值需要经过 URL 安全的 Base64 编码 。

处理参数说明

参数 含义

是

否
必

选

ObjectKey 对象文件名，例如 folder/sample.jpg。 是

/0/w/<LongEd
ge>/h/<Short

Edge>

限定缩略图的长边最多为<LongEdge>，短边最多为<ShortEdge>，进行
等比缩放，不裁剪。如果只指定w参数则表示限定长边（短边自适应），只指

定h参数则表示限定短边（长边自适应） 

当图片长宽相同时，默认长边为图片的高

否

/1/w/<Width>/
h/<Height>

限定缩略图的宽高最小值。该操作会将图像等比缩放直至某一边达到设定最小
值，之后将另一边居中裁剪至设定值。若只指定一边，则表示宽高相等的正方

形
例如，原图大小为1000x500，将参数设定为?

imageView2/1/w/500/h/400 后，图像会先等比缩放至800x400，之后
左右各裁剪150，得到500x400大小的图像

否

/2/w/<Width>/

h/<Height>

限定缩略图的宽高最大值。该操作会将图像等比缩放至宽高都小于设定最大值

例如，原图大小为 1000x500，将参数设定为?

imageView2/2/w/500/h/400后，图像会等比缩放至500x250。如果只指
定一边，则另一边自适应

否

/3/w/<Width>/
h/<Height>

限定缩略图的宽高最小值。该操作会将图像等比缩放至宽高都大于设定最小值

例如，原图大小为 1000x500，将参数设定为?
imageView2/3/w/500/h/400后，图像会等比缩放至800x400。如果只指

定一边，则另一边设为相同值

否

/4/w/<LongEd
ge>/h/<Short

Edge>

限定缩略图的长边和短边的最小值分别为 LongEdge 和 ShortEdge，进行
等比压缩；如果只指定一边，代表另外一边为同样的值 

当图片长宽相同时，默认长边为图片的高

否

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
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选用样式1，并限定缩略图的宽高最小值为400 × 600，绝对质量为85：

/5/w/<LongEd

ge>/h/<Short
Edge>

限定缩略图的长边和短边的最大值分别为 LongEdge 和 ShortEdge，进行

等比压缩，居中裁剪；如果只指定一边，则表示宽高相等的正方形；缩放后其
中一边多余的部分会被裁剪掉

当图片长宽相同时，默认长边为图片的高

否

/format/<For
mat>

目标缩略图的图片格式，Format 可为：jpg，bmp，gif，png，webp，
缺省为原图格式

否

/q/<Quality>
图片质量，取值范围0 - 100，默认值为原图质量；取原图质量和指定质量的
最小值；<Quality> 后面加!（注意为英文字符），表示强制使用指定值

否

/rq/<quality>

图片的相对质量，取值范围0 - 100，数值以原图质量为标准。例如原图质量

为80，将 rquality 设置为80后，得到处理结果图的图片质量为64
（80x80%）

否

/lq/<quality>

图片的最低质量，取值范围0 - 100，设置结果图的质量参数最小值。

例如，原图质量为85，将 lquality 设置为80后，处理结果图的图片质量为

85 
例如，原图质量为60，将 lquality 设置为80后，处理结果图的图片质量会被

提升至80

否

/ignore-
error/1

当处理参数中携带此参数时，针对文件过大、文件格式有误等外部因素导致的
处理失败的场景，会直接返回原图而不报错

否

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：选用模板样式1

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageView2/1

https://cloud.tencent.com/document/product/436/54050
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缩略图效果如下：

处理方式同上，仅增加签名部分，并与处理参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

案例二：选用模板样式1并携带私有签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith
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限制图片大小
最近更新时间：2023-03-13 14:12:11

对象存储通过数据万象 imageMogr2/size-limit 接口可限制图片处理（例如缩放、压缩等）后的文件大小。

操作名称：size-limit。

功能概述

限制说明

支持格式：仅支持对处理后为 JPG 格式的图片限制大小。

体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果图宽

高设置不超过50000像素。

接口示例

GET /<ObjectKey>?imageMogr2/size-limit HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

参数 含义

Objec

tKey
对象文件名，例如 folder/sample.jpg。

size-

limit

限制图片转换后的大小，支持以兆字节（m）和千字节（k）为单位

仅支持 JPG 格式的图片，可以用于限制处理后图片的大小

若在尾部加上 ! ，表示用处理后的图片大小与原图大小做比较，如果处理后的图片比原图小，

则返回处理后的图片，否则返回原图。例如：examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/picture.jpg?imageMogr2/size-limit/15k!

建议搭配 strip  参数使用，去除图片的一些冗余信息，会有更好的效果。例如：

examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/picture.png?
imageMogr2/strip/format/jpg/size-limit/15k!

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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将 PNG 图片转换为 JPG 格式，并限制图片大小为15KB，示例如下：

处理方式同上，仅增加签名部分，并与处理参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

/ignor

e-

error/
1

当处理参数中携带此参数时，针对文件过大导致处理失败的场景，会直接返回原图而不报错

实际案例

案例一：转换图片格式并限制大小

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/st

案例二：转换图片格式、限制大小并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.png?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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管道操作符
最近更新时间：2023-02-09 10:31:26

对象存储通过数据万象的管道操作符 | 实现对图片按顺序进行多种处理。用户可以通过管道操作符将多个处理参数

分隔开，从而实现在一次访问中按顺序对图片进行不同处理。处理图片原图大小不超过32MB、宽高不超过50000

像素且总像素不超过2.5亿像素，处理结果图宽高设置不超过50000像素；针对动图，原图宽 x 高 x 帧数不超过

2.5亿像素。

用户在图片 URL 链接后以样式分隔符 ? 与处理样式相连接，多个处理样式之间以管道操作符 | 分隔，样式按照先

后顺序执行，目前最多支持10层管道。

本次案例先将原图缩放为50%，然后在图的右下角添加“数据万象”的文字水印。

假设原图 URL 为：

功能概述

注意

 图片处理功能为收费项，由数据万象收取，详细的计费说明请参见数据万象 图片处理费用 。

接口示例

实际案例

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg

https://cloud.tencent.com/document/product/460/58117
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原图显示如下：  

首先增加缩放操作，则 URL 为：

案例一：对图片进行缩放并添加水印

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/t
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图片显示如下：

使用管道操作符再添加文字水印的样式处理，则最终 URL 为：

图片最终处理效果如下：  

处理方式同上，仅增加签名部分，并与处理参数以“&”连接，示例如下：

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/t

案例二：使用管道操作符并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

https://cloud.tencent.com/document/product/436/7778
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为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
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获取原图
最近更新时间：2023-04-28 10:45:26

如果您开启了 图片原图功能 ，同时在某些场景下希望获取到原图，可通过本接口进行获取。

该接口无特殊请求头。

该接口无请求体。

该接口无特殊响应头。

功能概述

注意

该请求操作不支持匿名请求，必须携带签名。

请求

请求示例

GET /<ObjectKey>?ci-process=originImage HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

请求参数说明

参数 描述 类型
是否必

选

ci-
process

万象通用参数，需要获取原图的时，该参数固定为：
originImage

strin
g

是

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/86437


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第644 共1701页

该接口的响应体为对象（文件）内容。

访问一张已开启了原图保护的存储桶中的图片，并携带获取原图参数：

实际案例

http://example-1250000000.cos.ap-chengdu.myqcloud.com/?ci-process=originImage&q-s

说明

<signature>  为签名部分，获取方式请参考 请求签名 ，计算的签名中需将处理参数 ci-process 也一并

签入。

https://cloud.tencent.com/document/product/436/7778
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图片基础压缩（WebP）
最近更新时间：2022-09-19 15:50:16

图片压缩指在图片质量保持不变的情况，尽可能的减小图片大小，以达到节省图片存储空间、减少图片访问流量、提

升图片访问速度的效果。

对象存储（Cloud Object Storage，COS）基于 数据万象（Cloud Infinite，CI）  产品推出了 WebP 压缩

功能，可将图片转换为 webp 压缩图片格式，其在压缩方面相比 jpg 格式更优越。在相同图片质量的情况下，

webp 格式图片要比 jpg 格式图片减小25%以上，可以适配多终端使用场景。

COS 通过数据万象 imageMogr2 接口提供 WebP 压缩功能。

该功能支持以下的处理方式：

功能描述

限制说明

支持格式：支持将 jpg、png、bmp、gif、tpg、heif、avif 等格式图片转换为 webp 格式。

体积限制：处理图片原图大小不超过32MB、宽高不超过30000像素且总像素不超过2.5亿像素，处理结果图宽

高设置不超过9999像素；针对动图，原图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

使用方式

下载时处理

上传时处理

云上数据处理

说明

WebP 压缩为付费服务，费用同基础图片处理，由数据万象收取，具体费用请参见数据万象 图片处理

费用 。

图片转换为 WebP 格式后，部分浏览器无法读取 WebP 图片的 exif 信息，导致没有旋转。您可参见 

旋转  文档，增加 auto-orient 参数，对原图旋转后再进行压缩。

WebP 压缩默认继承原始图片的质量参数。您可参见 质量变换  文档，通过修改图片质量来调节压缩

率。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/format/webp HTTP/1.1

https://cloud.tencent.com/document/product/460/6962
https://cloud.tencent.com/document/product/460/58117
https://cloud.tencent.com/document/product/436/44882
https://cloud.tencent.com/document/product/436/44884
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Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/webp"

}]

}

说明

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/webp"

}]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

/format/<Format> 压缩格式，此处为 webp。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，请

使用上传时处理或云上数据处理方式。
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假设原图格式为 png，图片大小为1335.2KB，如下图所示： 

将原图转换为 webp 格式，请求 URL 如下：

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/for
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效果如下：

压缩率对比

格式 图片大小

png（原图） 1335.2KB

webp 65KB（压缩率95.13%）
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图片高级压缩
HEIF 压缩
最近更新时间：2021-09-09 18:25:57

图片压缩指在图片质量保持不变的情况，尽可能的减小图片大小，以达到节省图片存储空间、减少图片访问流量、提

升图片访问速度的效果。

对象存储（Cloud Object Storage，COS）基于 数据万象（Cloud Infinite，CI） 产品推出了 HEIF 压缩功

能，可将图片转换为 heif 格式，它具有超高的压缩率，在图片质量相同的情况下，图片大小比 jpg 格式图片减小

80%以上，iOS 系统已将 heif 图片作为相册默认格式，Android P 系统已原生支持 heif。

使用 HEIF 压缩，需要先开通存储桶的图片高级压缩功能，您需要在相应的存储桶配置页中通过开关按钮开启功

能，详情请参见 设置图片高级压缩 。

COS 通过数据万象 imageMogr2 接口提供 HEIF 压缩功能。

该功能支持以下的处理方式：

功能描述

限制说明

支持格式：支持将 jpg、png、bmp、webp、tpg、avif 等格式图片转换为 heif 格式。

体积限制：处理图片原图大小不超过32MB、宽高不超过30000像素且总像素不超过2.5亿像素，处理结果图宽

高设置不超过9999像素；针对动图，原图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

前提条件

使用方式

下载时处理

上传时处理

云上数据处理

说明

 HEIF 压缩为付费服务，计费项为图片高级压缩费用，由数据万象收取，具体费用请参见数据万象 图片处

理费用 。

接口示例

1. 下载时处理

https://cloud.tencent.com/document/product/460/6962
https://cloud.tencent.com/document/product/436/48981
https://cloud.tencent.com/document/product/460/58117
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download_url?imageMogr2/format/heif

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/heif"

}]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/heif"

}]

}

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，请

使用上传时处理或云上数据处理方式。

处理参数说明

参数 含义

downl 文件的访问链接，具体构成为<BucketName-APPID>.cos.
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假设原图格式为 png，图片大小为1335.2KB，如下图所示。 

将原图转换为 heif 格式，请求 URL 如下：

oad_
url

<Region>.myqcloud.com/<picture name>， 例如

examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/picture.jpeg 。

/form

at/<F
ormat

>

压缩格式，此处为 heif。

实际案例
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压缩率对比

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/for

格式 图片大小

png（原图） 1335.2KB

heif 52.87KB（压缩率96.0%）
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TPG 压缩
最近更新时间：2023-08-16 17:20:01

图片压缩指在图片质量保持不变的情况，尽可能的减小图片大小，以达到节省图片存储空间、减少图片访问流量、提

升图片访问速度的效果。

对象存储（Cloud Object Storage，COS）基于 数据万象（Cloud Infinite，CI） 产品推出了 TPG 压缩功

能，可将图片转换为 tpg 格式，它是腾讯推出的自研图片格式，能支持动图，目前 QQ 浏览器、QQ 空间等产品已

默认支持 tpg 图片，在图片质量相同的情况下，图片大小比 gif 格式图片减少90%以上，比 png 图片小50%以

上。

COS 通过数据万象 imageMogr2 接口提供 tpg 压缩功能。

该功能支持以下的处理方式：

功能描述

限制说明

支持格式：支持将 jpg、png、bmp、gif、webp、heif、avif 等格式图片转换为 tpg 格式。

体积限制：处理图片原图大小不超过32MB、宽高不超过30000像素且总像素不超过2.5亿像素，处理结果图宽

高设置不超过9999像素；针对动图，原图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

前提条件

使用 TPG 压缩，需要先开通存储桶的图片高级压缩功能，您需要在相应的存储桶配置页中通过开关按钮开启功

能，详情请参见 设置图片高级压缩 。

TPG 是腾讯自研的图片格式，使用前请确认图片加载环境已支持 TPG 解码，腾讯云数据万象提供集成 TPG 

解码器的 iOS 、 Android 、 Windows  终端 SDK，可帮助您快速接入和使用 TPG。

使用方式

下载时处理

上传时处理

云上数据处理

说明

 TPG 压缩为付费服务，计费项为图片高级压缩费用，由数据万象收取，具体费用请参见数据万象 图片处

理费用 。

接口示例

https://cloud.tencent.com/document/product/460/6962
https://cloud.tencent.com/document/product/436/48981
https://cloud.tencent.com/document/product/460/47732
https://cloud.tencent.com/document/product/460/47737
https://ci-document-example-1259788808.cos.ap-shanghai.myqcloud.com/TPG_win_SDK_2023.zip
https://cloud.tencent.com/document/product/460/58117
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1. 下载时处理

GET /<ObjectKey>?imageMogr2/format/tpg HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/tpg"

}]

}

说明

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/tpg"

}]

}

https://cloud.tencent.com/document/product/460/18147
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说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

参数 含义

download_ur

l

文件的访问链接，具体构成为<BucketName-APPID>.cos.
<Region>.myqcloud.com/<picture name>， 例如

examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/picture.jpeg 。

/format/<For
mat>

压缩格式，此处为 tpg。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，请

使用上传时处理或云上数据处理方式。

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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假设原图格式为 png，图片大小为1335.2KB，如下图所示： 

将原图转换为 tpg 格式，请求 URL 如下：

压缩率对比

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/for

格式 图片大小

png（原图） 1335.2KB

tpg 36.67KB（压缩率97.3%）
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AVIF 压缩
最近更新时间：2022-09-19 15:51:26

图片压缩指在图片质量保持不变的情况，尽可能的减小图片大小，以达到节省图片存储空间、减少图片访问流量、提

升图片访问速度的效果。

对象存储（Cloud Object Storage，COS）基于 数据万象（Cloud Infinite，CI）  产品推出了 AVIF 压缩功

能，可将图片转换为 avif 格式，avif 是基于 av1 的一种全新图片格式，在2020年2月由 Netflix 首次公布于众，

目前已支持 Chrome、Firefox 等浏览器。

使用 AVIF 压缩，需要先开通存储桶的图片高级压缩功能，您需要在相应的存储桶配置页中通过开关按钮开启功

能，详情请参见 设置图片高级压缩 。

COS 通过数据万象 imageMogr2 接口提供 avif 压缩功能。

该功能支持以下的处理方式：

功能描述

限制说明

支持格式：支持将 jpg、png、bmp、gif、webp、tpg、heif 等格式图片转换为 avif 格式。

体积限制：处理图片原图大小不超过32MB、宽高不超过30000像素且总像素不超过2.5亿像素，处理结果图宽

高设置不超过9999像素；针对动图，原图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

前提条件

使用方式

下载时处理

上传时处理

云上数据处理

说明

 AVIF 压缩为付费服务，计费项为图片高级压缩费用，由数据万象收取，具体费用请参见数据万象 图片处

理费用 。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/format/avif HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

https://cloud.tencent.com/document/product/460/6962
https://cloud.tencent.com/document/product/436/48981
https://cloud.tencent.com/document/product/460/58117
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Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/avif"

}]

}

说明

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/avif"

}]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

/format/<Format> 压缩格式，此处为 avif。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，请

使用上传时处理或云上数据处理方式。
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假设原图格式为 png，图片大小为1335.2KB，如下图所示： 

将原图转换为 avif 格式，请求 URL 如下：

压缩率对比

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/for

格式 图片大小

png（原图） 1335.2KB

avif 62.8KB（压缩率95.3%）
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SVG 压缩
最近更新时间：2022-09-19 15:52:08

图片压缩指在图片质量保持不变的情况，尽可能的减小图片大小，以达到节省图片存储空间、减少图片访问流量、提

升图片访问速度的效果。

对象存储（Cloud Object Storage，COS）基于 数据万象（Cloud Infinite，CI）  产品推出了 SVG 压缩功

能，可以在不影响显示效果的情况下，通过一定的优化算法删除 SVG 文件中的冗余信息，最终达到减少SVG文件

体积的目的。

对象存储通过数据万象 imageMogr2 接口提供 SVG 压缩功能。

该功能支持以下的处理方式：

功能描述

限制说明

支持格式：仅支持将 svg 格式图片作为输入。

体积限制：处理图片原图大小不超过32MB。

使用方式

下载时处理

上传时处理

云上数据处理

说明

  SVG 压缩为付费服务，计费项为图片高级压缩费用，由数据万象收取，具体费用请参见数据万象 图片处

理费用 。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/format/svgc HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

https://cloud.tencent.com/document/product/460/6962
https://cloud.tencent.com/document/product/460/58117
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Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/svgc"

}]

}

说明

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/svgc"

}]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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/format/<Format> 压缩格式，此处为 svgc。
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图片盲水印
最近更新时间：2023-03-16 10:37:33

盲水印功能基于腾讯云数据万象，是一种全新的水印模式。通过该功能，您可将水印图以不可见的形式添加到原图信

息中，并且不会对原图质量产生太大影响。当发现图片被盗取后，您可对疑似被盗取的资源进行盲水印提取，验证图

片归属。

通过该 API 接口，您可以：

也可以对已添加盲水印的图片进行盲水印提取。

图片上传时添加盲水印的请求包与 PUT Object  接口一致，只需在请求包头部增加图片处理参数 Pic-

Operations 并使用盲水印参数即可。

功能描述

在上传时为图片添加盲水印

在下载时为图片添加盲水印

对 COS 上的图片添加盲水印

说明

暂不支持为动图（例如 GIF 图片）添加盲水印。

使用盲水印功能，水印图的宽高不得超过原图的1/8。

为保证盲水印效果，水印图请选用黑底白色图片。

文字盲水印当前支持数字[0 - 9]及英文大小写[A - Z,a - z]。

盲水印可抵抗裁剪、涂抹、变色等多种图片盗取攻击，防盗效果与原图大小及攻击程度相关。如需详细

咨询请 提交工单 。

盲水印已支持数据万象所有地域，详情请查看 地域与域名 。

添加盲水印

请求一：上传时添加盲水印

请求示例

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

Object Content[ ]

https://cloud.tencent.com/document/product/436/7749
https://console.cloud.tencent.com/workorder/category
https://cloud.tencent.com/document/product/460/31066
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此接口使用公共请求头部，详情请参见 公共请求头部  文档。

请求包头部增加图片处理参数 Pic-Operations，Pic-Operations 为 json 格式的字符串，具体参数如下：

rules（json 数组）中每一项具体参数如下：

使用盲水印需在 rule 中添加水印图参数（watermark），示例格式如下：

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求头

参数名称 描述 类型
是否

必选

is_pic_i
nfo

是否返回原图信息。0表示不返回原图信息，1表示返回原图信息，默认
为0

Int 否

rules
处理规则，一条规则对应一个处理结果（目前最多支持五条规则），不填
则不进行图片处理

Arr
ay

否

参数
名称

描述
类
型

是

否
必

选

buc
ket

存储结果的目标存储桶名称，格式为：BucketName-APPID，如果不指定的话
默认保存到当前存储桶

Str
ing

否

filei

d

处理后文件的保存路径及名称。名称规则说明：
例如源文件的路径及文件名为：/p1/test1.jpg

1. 以 /  开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 文件夹

中存储了一个文件名为 test2.jpg 的文件

2. 不以 /  开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 p1 文件

夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文件名为 

test2.jpg 的文件

3. 注意：请不要以 /  结尾，否则会产生空文件名

Str

ing
是

rule
处理参数，可参见图片处理 API。 若按指定样式处理，则以 style/ 开头，后加样

式名，如样式名为“test”，则 rule 字段为 style/test

Str
ing

是

watermark/3/type/<type>/image/<imageUrl>/text/<text>/level/<level>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
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示例参数说明如下：

此接口无请求参数。

此接口请求的请求体为需要添加盲水印的原文件（图片）内容。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应体具体数据内容如下：

参数
名称

描述
类
型

是

否
必

选

type 盲水印类型，有效值：1为半盲水印；2为全盲水印；3为文字盲水印
In

t
是

ima
ge

盲水印图片地址，需要经过 URL 安全的  Base64 编码。 当 type 为1或2时必
填，type 为3时无效。 指定的水印图片必须同时满足如下条件：

1. 盲水印图片与原图片必须位于同一个存储桶下

2. URL 必须以 http://  开始，不能省略 http 头，也不能填 https 头，例如以下

地址为非法水印地址：

examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png

https://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png

St

ri
n

g

否

text
盲水印文字，需要经过 URL 安全的 Base64 编码。当 type 为3时必填，type 为

1或2时无效

St
ri

n
g

否

leve

l

只对全盲水印（type=2）有效。level 的取值范围为{1,2,3}，默认值为1，level 

值越大则图片受影响程度越大、盲水印效果越好。

In

t
否

请求参数

请求体

响应

响应头

响应体

参数名称 描述 类型

https://cloud.tencent.com/document/product/436/7729
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UploadResult 节点内容： 

OriginalInfo 节点内容： 

ImageInfo 节点内容： 

ProcessResults 节点内容：

Object 节点内容：

UploadResult 原图信息 Container

参数名称 描述 类型

OriginalInfo 原图信息 Container

ProcessResults 图片处理结果 Container

节点名称 描述 类型

Key 原图文件名 String

Location 图片路径 String

ImageInfo 原图图片信息 Container

节点名称 描述 类型

Format 格式 String

Width 图片宽度 Int

Height 图片高度 Int

Quality 图片质量 Int

Ave 图片主色调 String

Orientation 图片旋转角度 Int

节点名称 描述 类型

Object 每一个图片处理结果 Container

节点名称 描述 类型
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Key 文件名 String

Location 图片路径 String

Format 图片格式 String

Width 图片宽度 Int

Height 图片高度 Int

Size 图片大小 Int

Quality 图片质量 Int

实际案例

请求

PUT /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2018 09:06:15 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations:

    "is_pic_info": 1,

    "rules": 

        "fileid": "exampleobject",

        "rule": "watermark/3/type/1/image/aHR0cDovL2V4YW1wbGVzLTEyNTEwMDAwMDQu

    

Content-Length: 64

Object Content

{

[{

}]

}

[ ]

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>
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图片下载时添加盲水印与添加普通水印操作相同，只需在图片访问链接后使用 watermark 参数即可。

          <OriginalInfo>

              <Key>exampleobject</Key>

              <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exampl

              <ImageInfo>

                   <Format>JPEG</Format>

                   <Width>640</Width>

                   <Height>427</Height>

                   <Quality>100</Quality>

                   <Ave>0xa18454</Ave>

                   <Orientation>1</Orientation>

              </ImageInfo>

          </OriginalInfo>

          <ProcessResults>

              <Object>

                   <Key>exampleobject</Key>

                   <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exam

                   <Format>png</Format>

                   <Width>640</Width>

                   <Height>427</Height>

                   <Size>463092</Size>

                   <Quality>100</Quality>

              </Object>

          </ProcessResults>

</UploadResult>

注意

请求体的 [Object Content] 字段为原图的图片内容(二进制字符串)，请求头 Pic-Operations 的 

rule 字段中，imageUrl 为水印图片的地址。

响应体的 ProcessResults 中的 Location 字段为处理后已经携带盲水印的图片的地址。

请求二：下载时添加盲水印

请求示例

GET /<ObjectKey>?watermark/3/type/<type>/image/<imageUrl>/text/<text> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

请求参数
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请求参数说明如下：

通过 API 能够对已存储在 COS 的图片进行添加盲水印的操作，并将结果存入到 COS。

参数 描述
类
型

是

否
必

选

downl
oad_u

rl

文件的访问链接，具体构成为 http(s)://

<BucketName-APPID>.cos.<Region>.myqcloud.com/<picture 

name>

， 例如

examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/picture.jpeg

St

ri
n

g

是

type 盲水印类型，有效值：1为半盲水印；2为全盲水印；3为文字盲水印
In

t
是

image

盲水印图片地址，需要经过 URL 安全的  Base64 编码。 当 type 为1或2时

必填，type 为3时无效。 图片必须同时满足如下条件： 
1. 盲水印图片与原图片必须位于同一个存储桶下 

2. URL 必须以 http://  开始，不能省略 http 头，也不能填 https 头，例如

以下地址为非法水印地址：

examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/watermark.png

https://examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/watermark.png 

St

ri

n
g

否

text
盲水印文字，需要经过 URL 安全的 Base64 编码。当 type 为3时必填，

type 为1或2时无效

St
ri

n
g

否

level
只对全盲水印（type=2）有效。level 的取值范围为{1,2,3}，默认值为1，

level 值越大则图片受影响程度越大、盲水印效果越好

In

t
否

实际案例

https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/sample.jpeg?waterm

请求三：对 COS 上的图片添加盲水印
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此接口使用公共请求头部，详情请参见 公共请求头部  文档。

请求包头部增加图片处理参数 Pic-Operations，Pic-Operations 为 json 格式的字符串，具体参数如下：

rules（json 数组）中每一项具体参数如下：

请求示例

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

请求头

参数名称 描述 类型
是否
必选

is_pic_i
nfo

是否返回原图信息。0表示不返回原图信息，1表示返回原图信息，默认
为0

Int 否

rules
处理规则，一条规则对应一个处理结果（目前最多支持五条规则），不填

则不进行图片处理

Arr

ay
否

参
数

名
称

描述
类

型

是
否

必
选

bu

ck
et

存储结果的目标存储桶名称，格式为：BucketName-APPID，如果不指定的话

默认保存到当前存储桶

St
ri

n
g

否

file

id

处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg

1. 以 /  开头为绝对路径，例如 fileid 值为/p2/test2.jpg时，表示在 p2 文件夹中

存储了一个文件名为 test2.jpg 的文件

2. 不以 /  开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 p1 文件夹

中新建了一个 p2 文件夹，然后在p2文件夹中存储了一个文件名为 test2.jpg 的

St

ri
n

g

是

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
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使用盲水印需在 rule 中添加水印图参数（watermark），示例格式如下：

示例参数说明如下：

文件

3. 注意：请不要以 /  结尾，否则会产生空文件名

rul
e

处理参数，可参见图片处理 API。 若按指定样式处理，则以 style/ 开头，后加样式

名，如样式名为“test”，则 rule 字段为 style/test

St

ri
n

g

是

watermark/3/type/<type>/image/<imageUrl>/text/<text>/level/<level>

参

数
描述

类

型

是
否

必
选

ty

p
e

盲水印类型，有效值：1为半盲水印；2为全盲水印；3为文字盲水印
In

t
是

im

ag
e

盲水印图片地址，需要经过 URL 安全的 Base64 编码。当 type 为1或2时必填，
type 为3时无效。指定的水印图片必须同时满足如下条件：

1. 盲水印图片与原图片必须位于同一个存储桶下

2. URL 必须以 http://  开始，不能省略 http 头，也不能填 https 头，例如以下地

址为非法水印地址：

examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png

https://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png

St

ri
n

g

否

te

xt

盲水印文字，需要经过 URL 安全的 Base64 编码。当 type 为3时必填，type 为1

或2时无效。

St
ri

n
g

否

le

ve
l

只对全盲水印（type=2）有效。level 的取值范围为{1,2,3}，默认值为1，level 值

越大则图片受影响程度越大、盲水印效果越好

In

t
否

请求参数
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此接口无请求参数。

此接口无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应体具体数据内容如下：

UploadResult 节点内容： 

OriginalInfo 节点内容： 

ImageInfo 节点内容： 

请求体

响应

响应头

响应体

参数名称 描述 类型

UploadResult 原图信息 Container

参数名称 描述 类型

OriginalInfo 原图信息 Container

ProcessResults 图片处理结果 Container

节点名称 描述 类型

Key 原图文件名 String

Location 图片路径 String

ImageInfo 原图图片信息 Container

节点名称 描述 类型

Format 格式 String

Width 图片宽度 Int

Height 图片高度 Int

https://cloud.tencent.com/document/product/436/7729


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第676 共1701页

ProcessResults 节点内容：

Object 节点内容：

Quality 图片质量 Int

Ave 图片主色调 String

Orientation 图片旋转角度 Int

节点名称 描述 类型

Object 每一个图片处理结果 Container

节点名称 描述 类型

Key 文件名 String

Location 图片路径 String

Format 图片格式 String

Width 图片宽度 Int

Height 图片高度 Int

Size 图片大小 Int

Quality 图片质量 Int

实际案例

请求

POST /exampleobject?image_process HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2018 09:06:15 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations:

    "is_pic_info": 1,

    "rules": 

        "fileid": "exampleobject",

        "rule": "watermark/3/type/1/image/aHR0cDovL2V4YW1wbGVzLTEyNTEwMDAwMDQu

    

{

[{

}]

}
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Content-Length: 64

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

          <OriginalInfo>

              <Key>exampleobject</Key>

              <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exampl

              <ImageInfo>

                   <Format>JPEG</Format>

                   <Width>640</Width>

                   <Height>427</Height>

                   <Quality>100</Quality>

                   <Ave>0xa18454</Ave>

                   <Orientation>1</Orientation>

              </ImageInfo>

          </OriginalInfo>

          <ProcessResults>

              <Object>

                   <Key>exampleobject</Key>

                   <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exam

                   <Format>png</Format>

                   <Width>640</Width>

                   <Height>427</Height>

                   <Size>463092</Size>

                   <Quality>100</Quality>

              </Object>

          </ProcessResults>

</UploadResult>

提取盲水印

请求一：上传时提取盲水印

请求示例
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上传图片并提取盲水印的请求包与 PUT Object  接口一致，只需在请求包头部增加图片处理参数 Pic-

Operations 并使用提取盲水印参数（watermark/4）即可。

此接口使用公共请求头部，详情请参见 公共请求头部  文档。

请求包头部增加图片处理参数 Pic-Operations，Pic-Operations 为 json 格式的字符串，具体参数如下：

rules（json 数组）中每一项具体参数如下：

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization:XXXXXXXXXXXX

Pic-Operations: <PicOperations>

Object Content[ ]

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求头

参数名
称

描述
类
型

是否
必选

is_pic_

info
是否返回原图信息。0表示不返回原图信息，1表示返回原图信息，默认为0 Int 否

rules
处理规则，一条规则对应一个处理结果（目前最多支持五条规则），不填则
不进行图片处理

Arr
ay

否

参数

名称
描述

类

型

是
否

必
选

buc
ket

存储结果的目标存储桶名称，格式为：BucketName-APPID，如果不指定的话
默认保存到当前存储桶

St

ri
n

g

否

filei

d

处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg

1. 以 / 开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 文件夹

中存储了一个文件名为 test2.jpg 的文件

St

ri
n

g

是

https://cloud.tencent.com/document/product/436/7749
https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
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提取盲水印需在 rule 中添加水印图参数（watermark），示例格式如下：

示例参数说明如下：

此接口无请求参数。

2. 不以 / 开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 p1 文件夹

中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文件名为 test2.jpg 

的文件

3. 注意：请不要以 / 结尾，否则会产生空文件名

rule
处理参数，请参见图片处理 API。 若按指定样式处理，则以 style/ 开头，后加样

式名，如样式名为“test”，则 rule 字段为 style/test

St

ri
n

g

是

watermark/4/type/<type>/image/<imageUrl>

参数

名称
描述

类

型

是
否

必
选

typ

e

盲水印类型，有效值：1为半盲水印；2为全盲水印；3为文字盲水印，必须跟添加盲水

印时的 type 类型一致。

I
n

t

是

ima

ge

图片地址，根据 type 值填写：

image 需要经过 URL 安全的 Base64 编码，指定的图片必须同时满足如下条件：
1. 图片与存在水印的图片必须位于同一个对象存储桶下；

2. URL 必须以 http:// 开始，不能省略 http 头，也不能填 https 头，例如以下地址

为非法水印地址：

当 type 为1，则 image 必填，且为原图图片地址

当 type 为2，则 image 必填，且为水印图地址

当 type 为3，则 image 无需填写（无效）

 examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png 

https://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png  

S

t
r

i
n

g

否

请求参数

请求体



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第680 共1701页

此接口请求的请求体为图片内容。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应体的 UploadResult.ProcessResults.Object 字段中新增 WatermarkStatus 字段，当盲水印提取的请

求体中 type 参数为2时携带 WatermarkStatus 参数，其他情况不返回该参数。

响应

响应头

响应体

参数名

称

父
节

点

描述
类

型

Water
mark

Statu
s

O
bj

e
c

t

当 type 为2时返回该字段，表示提取到全盲水印的可信度。具体为0-100的数

字，75分以上表示确定有盲水印，60-75表示疑似有盲水印，60以下可认为未
提取到盲水印

I

n
t

实际案例

请求

PUT /exampleobject1 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2018 09:06:15 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations:

    "is_pic_info": 1,

    "rules": 

        "fileid": "exampleobject2",

        "rule": "watermark/4/type/2/image/aHR0cDovL2V4YW1wbGVzLTEyNTEwMDAwMDQu

    

Content-Length: 64

Object Content

{

[{

}]

}

[ ]

响应

https://cloud.tencent.com/document/product/436/7729
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

      <OriginalInfo>

          <Key>exampleobject1</Key>

          <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exampleo

          <ImageInfo>

                <Format>JPEG</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Quality>100</Quality>

                <Ave>0xa18454</Ave>

                <Orientation>1</Orientation>

                <FrameCount>1</FrameCount>

          </ImageInfo>

      </OriginalInfo>

      <ProcessResults>

          <Object>

                <Key>exampleobject2</Key>

                <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/examp

                <Format>png</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Size>463092</Size>

                <Quality>100</Quality>

                <FrameCount>1</FrameCount>

                <WatermarkStatus>86</WatermarkStatus>

          </Object>

      </ProcessResults>

</UploadResult>

注意

对于 type 值为1的请求，请求头 Pic-Operations 的 rule 字段中，imageUrl 为未添加盲水印的原

图地址；对于 type 值为2的请求，包头 Pic-Operations 的 rule 字段中，imageUrl 为水印图的地

址。

响应体 ProcessResults 字段的 url 为提取出来的水印图地址。
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对 COS 上的图片提取盲水印的请求包与 云上数据处理  接口一致，只需在请求包头部增加图片处理参数 Pic-

Operations 并使用提取盲水印参数（watermark/4）即可。

请求二：对 COS 上的图片提取盲水印

https://cloud.tencent.com/document/product/436/54050#.E4.BA.91.E4.B8.8A.E6.95.B0.E6.8D.AE.E5.A4.84.E7.90.86
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异常图片检测
最近更新时间：2023-07-26 16:06:01

对象存储通过数据万象 ImageInspect 接口检测图片中是否隐含其他类型的可疑文件。

操作名称：ImageInspect。

功能概述

注意

 异常图片检测功能为收费项，由数据万象收取，详细的计费说明请参见数据万象 图片处理费用 。

限制说明

支持格式：JPG/JPEG、PNG、BMP、GIF，以及纯TS视频流（更改为任意后缀）。

静态图体积限制：可检测的原图大小不超过32MB，宽高不超过50000像素且总像素不超过2.5亿像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

GET /<ObjectKey>?ci-process=ImageInspect HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

请求参数

参数 含义 类型 是否必选

ObjectKey 对象文件名，例如 folder/sample.jpg String 是

响应参数

https://cloud.tencent.com/document/product/460/58117
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该接口需要携带签名进行使用，签名与检测参数以“&”连接，示例如下：

参数 含义 类型

picSize 检测的原图大小，单位为 Bytes
Strin

g

picType 检测的原图类型。例如 jpg、png 等
Strin
g

suspicious
是否检测到图片格式以外的文件。false 为正常图片文件，true 表示含有其
他格式的可疑文件

Bool
ean

suspiciousBe

ginByte
检测到的可疑文件的起始字节位置，单位为 Bytes

Strin

g

suspiciousEn
dByte

检测到的可疑文件的末尾字节位置，单位为 Bytes
Strin
g

suspiciousSi
ze

检测到的可疑文件的大小
Strin
g

suspiciousTy

pe
检测到的可疑文件的类型，例如 MPEG-TS

Strin

g

实际案例

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature> 为签名部分，需要将检测参数也签入签名中，获取方式请参考 请求签名 。

https://cloud.tencent.com/document/product/436/7778
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图片异步处理

提交任务
最近更新时间：2023-06-06 17:31:33

提交一个图片处理任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>PicProcess</Tag>

    <Input>

        <Object>input/deer.jpg</Object>

    <Operation>

        <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

 

            <Bucket>test-123456789</Bucket>

            <Object>output/out.jpg</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称

（关键字）

父节

点
描述 类型

是
否

必
选

Tag

Re

que
st

创建任务的 Tag：PicProcess
Strin

g
是

Input
Re
que

st

待操作的文件信息
Cont
aine

r

是

Operation
Re
que

st

操作规则
Cont
aine

r

是

CallBackF
ormat

Re

que
st

任务回调格式，JSON 或 XML，默认 XML，优先级高于
队列的回调格式

Strin
g

否

CallBackT

ype

Re

que
st

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队列

的回调类型

Strin

g
否

CallBack Re

que

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Strin

g

否
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Container 类型 Input 的具体数据描述如下：

Container 类型 Operation 的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

st

CallBack

MqConfig

Re

que

st

任务回调TDMQ配置，当 CallBackType 为 TDMQ 时必

填。详情见 CallBackMqConfig

Cont

aine

r

否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

节点名称
（关键字）

父节点 描述 类型
是否
必选

TemplateI

d

Request.Op

eration
模板 ID

Strin

g
否

PicProce

ss

Request.Op

eration

该任务的参数，同创建图片处理模板接口中的 

Request.PicProcess  

Cont

ainer
否

Output
Request.Op
eration

结果输出配置
Cont
ainer

是

UserData
Request.Op

eration

透传用户信息, 可打印的 ASCII 码, 长度不超过

1024

Strin

g
否

JobLevel
Request.Op

eration

任务优先级，级别限制：0 、1 、2 。级别越大任

务优先级越高，默认为0

Strin

g
否

注意

优先使用 TemplateId，无 TemplateId 时使用 PicProcess。

节点名称（关键字） 父节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储桶 String 是

Object Request.Operation.Output 结果文件的名字 String 是

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
https://cloud.tencent.com/document/product/460/84735#PicProcess
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

：

Container 节点 Input 的内容：

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容

节点名称
（关键字）

父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Strin

g

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Strin

g

JobId
Response.J
obsDetail

新创建任务的 ID
Strin
g

Tag
Response.J
obsDetail

新创建任务的 Tag：PicProcess
Strin
g

State
Response.J

obsDetail

任务的状态，为 Submitted、Running、Success、

Failed、Pause、Cancel 其中一个

Strin

g

Creation
Time

Response.J
obsDetail

任务的创建时间
Strin
g

StartTim
e

Response.J
obsDetail

任务的开始时间
Strin
g

EndTime
Response.J

obsDetail
任务的结束时间

Strin

g

QueueId
Response.J
obsDetail

任务所属的队列 ID
Strin
g

Input
Response.J
obsDetail

该任务的输入资源地址
Cont
ainer

Operatio

n

Response.J

obsDetail
该任务的规则

Cont

ainer
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Container 节点 Operation 的内容：

Container 节点 PicProcessResult 的内容： 

同 图片持久化处理  接口中的 UploadResult 节点。

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键

字）
父节点 描述 类型

TemplateId
Response.JobsDetail.O
peration

任务的模板 ID String

TemplateNa

me

Response.JobsDetail.O

peration

任务的模板名称, 当 TemplateId 存

在时返回
String

PicProcess
Response.JobsDetail.O

peration

同请求中的 

Request.Operation.PicProcess

Contai

ner

Output
Response.JobsDetail.O
peration

同请求中的 
Request.Operation.Output

Contai
ner

PicProcessR

esult

Response.JobsDetail.O

peration

图片处理后输出图片的信息，没有时不

返回

Contai

ner

UserData
Response.JobsDetail.O

peration
透传用户信息 String

错误码

实际案例

请求1：使用图片处理模板 ID

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/42867
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<Request>

    <Tag>PicProcess</Tag>

    <Input>

        <Object>input/deer.jpg</Object>

    <Operation>

        <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.jpg</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>
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        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使用图片处理处理参数

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>PicProcess</Tag>

    <Input>

        <Object>input/deer.jpg</Object>

    <Operation>

         <PicProcess>

            <IsPicInfo>true</IsPicInfo>

            <ProcessRule>imageMogr2/rotate/90</ProcessRule>

        </PicProcess>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.jpg</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcess>

                <IsPicInfo>true</IsPicInfo>

                <ProcessRule>imageMogr2/rotate/90</ProcessRule>

            </PicProcess>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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任务回调
最近更新时间：2023-02-16 14:26:56

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数

据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>2022-07-18T15:16:44+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcessResult>

                <ObjectName>output/out.jpg</ObjectName>

                <OriginalInfo>

                    <Etag>"d5a491cd3d8d071e3212c3478e8e35a1"</Etag>

                    <ImageInfo>

                        <Ave>0xc64847</Ave>

                        <Format>JPEG</Format>

                        <Height>417</Height>

                        <Orientation>0</Orientation>

                        <Quality>68</Quality>

                        <Width>500</Width>
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容： 

同提交图片处理任务接口中的 Response.JobsDetail  

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

                    </ImageInfo>

                </OriginalInfo>

                <ProcessResult>

                    <Etag/>

                    <Format>JPEG</Format>

                    <Height>500</Height>

                    <Quality>68</Quality>

                    <Size>24911</Size>

                    <Width>417</Width>

                </ProcessResult>

            </PicProcessResult>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my PicProcess job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <StartTime>2022-07-18T15:16:44+0800</StartTime>

        <State>Success</State>

        <Tag>PicProcess</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container数组

节点名称（关键

字）

父节点 描述 类型

https://cloud.tencent.com/document/product/460/84793#jobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

Key
Response.JobsDetail.Input.CosHead
ers

自定义 Header 的名
称

Strin
g

Value
Response.JobsDetail.Input.CosHead

ers
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>2022-07-18T15:16:44+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcessResult>

                <ObjectName>output/out.jpg</ObjectName>

                <OriginalInfo>
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                    <Etag>"d5a491cd3d8d071e3212c3478e8e35a1"</Etag>

                    <ImageInfo>

                        <Ave>0xc64847</Ave>

                        <Format>JPEG</Format>

                        <Height>417</Height>

                        <Orientation>0</Orientation>

                        <Quality>68</Quality>

                        <Width>500</Width>

                    </ImageInfo>

                </OriginalInfo>

                <ProcessResult>

                    <Etag/>

                    <Format>JPEG</Format>

                    <Height>500</Height>

                    <Quality>68</Quality>

                    <Size>24911</Size>

                    <Width>417</Width>

                </ProcessResult>

            </PicProcessResult>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my PicProcess job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <StartTime>2022-07-18T15:16:44+0800</StartTime>

        <State>Success</State>

        <Tag>PicProcess</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>2022-07-18T15:16:44+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>
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                <Key>Content-Type</Key>

                <Value>image/jpeg</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1024</Value>

            </CosHeaders>

        </Input>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcessResult>

                <ObjectName>output/out.jpg</ObjectName>

                <OriginalInfo>

                    <Etag>"d5a491cd3d8d071e3212c3478e8e35a1"</Etag>

                    <ImageInfo>

                        <Ave>0xc64847</Ave>

                        <Format>JPEG</Format>

                        <Height>417</Height>

                        <Orientation>0</Orientation>

                        <Quality>68</Quality>

                        <Width>500</Width>

                    </ImageInfo>

                </OriginalInfo>

                <ProcessResult>

                    <Etag/>

                    <Format>JPEG</Format>

                    <Height>500</Height>

                    <Quality>68</Quality>

                    <Size>24911</Size>

                    <Width>417</Width>

                </ProcessResult>
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            </PicProcessResult>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my PicProcess job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <StartTime>2022-07-18T15:16:44+0800</StartTime>

        <State>Success</State>

        <Tag>PicProcess</Tag>

        <Workflow>

            <Name>PicProcess_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-07-18T15:16:43+0800",

        "EndTime": "2022-07-18T15:16:44+0800",

        "Input": {

            "BucketId": "test-1234567890",

            "Object": "input/deer.jpg",

            "Region": "ap-chongqing",

            "CosHeaders": [{

                    "Key": "Content-Type",

                    "Value": "image/jpeg"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {
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                    "Key": "Size",

                    "Value": "1024"

                }

            ]

        },

        "JobId": "c93984788066911ed89ed352d4d9d2084",

        "Operation": {

            "Output": {

                "Bucket": "test-1234567890",

                "Object": "output/out.jpg",

                "Region": "ap-chongqing"

            },

            "PicProcessResult": {

                "ObjectName": "output/out.jpg",

                "OriginalInfo": {

                    "Etag": "\"d5a491cd3d8d071e3212c3478e8e35a1\"",

                    "ImageInfo": {

                        "Ave": "0xc64847",

                        "Format": "JPEG",

                        "Height": "417",

                        "Orientation": "0",

                        "Quality": "68",

                        "Width": "500"

                    }

                },

                "ProcessResult": {

                    "Format": "JPEG",

                    "Height": "500",

                    "Quality": "68",

                    "Size": "24911",

                    "Width": "417"

                }

            },

            "TemplateId": "t10461fe2bd5a649db9022452ec71e0381",

            "TemplateName": "test",

            "UserData": "This is my PicProcess job.",

            "JobLevel": 0,

        },

        "QueueId": "p2911917386e148639319e13c285cc774",

        "StartTime": "2022-07-18T15:16:44+0800",

        "State": "Success",

        "Tag": "PicProcess",

        "Workflow": {

            "Name": "PicProcess_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",
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            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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创建模板
最近更新时间：2023-07-18 15:34:42

创建图片处理模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>PicProcess</Tag>

    <Name>TemplateName</Name>

    <PicProcess>

        <IsPicInfo>true</IsPicInfo>

        <ProcessRule>imageMogr2/rotate/90</ProcessRule>

    </PicProcess>

</Request>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

 

 

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关
键字）

父节点 描述 类型
是否
必选

限
制

Tag
Reques

t
模板类型：PicProcess String 是 无

Name
Reques

t

模板名称：仅支持中文、英文、数字、

_、-和*
String 是 无

PicProcess
Reques
t

图片处理参数
Conta
iner

是 无

Container 类型 PicProcess 的具体数据描述如下：

节点名称
（关键

字）

父节点 描述 类型

是
否

必
选

默
认

值

限制

IsPicInf

o

Request.Con

tainer

是否返回原

图信息

Stri

ng
否

fa

ls

e

true、false

Process
Rule

Request.Con
tainer.Rule

图片处理规
则

Stri
ng

是 无

1. 基础图片处理参见 基础
图片处理  文档 

2. 图片压缩参见 图片压
缩  文档 

3. 盲水印参见 盲水印  文
档

响应

响应头

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/44879
https://cloud.tencent.com/document/product/436/60450
https://cloud.tencent.com/document/product/436/46782


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第704 共1701页

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

 

 

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>PicProcess</Tag>

        <TemplateId>t1460606hgd52148c4ab182ffds5163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <PicProcess>

            <IsPicInfo>true</IsPicInfo>

            <ProcessRule>imageMogr2/rotate/90</ProcessRule>

        </PicProcess>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） 父节点 描述 类型

Template Response 保存模板详情的容器 Container

RequestId Response 请求的唯一 ID String

Container 节点 Template 的内容：

节点名称（关键
字）

父节点 描述 类型

TemplateId
Response.Templat

e
模板 ID String
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Name Response.Templat
e

模板名称 String

BucketId
Response.Templat
e

模板所属存储桶 String

Category
Response.Templat

e
模板属性，Custom 或者 Official String

Tag
Response.Templat
e

模板类型，PicProcess String

UpdateTime
Response.Templat
e

更新时间 String

CreateTime
Response.Templat

e
创建时间 String

PicProcess
Response.Templat
e

同请求体中的 
Request.PicProcess

Containe
r

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>PicProcess</Tag>

    <Name>TemplateName</Name>

    <PicProcess>

        <IsPicInfo>true</IsPicInfo>

        <ProcessRule>imageMogr2/rotate/90</ProcessRule>

    </PicProcess>

</Request>

响应

https://cloud.tencent.com/document/product/460/42867
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>PicProcess</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <PicProcess>

            <IsPicInfo>true</IsPicInfo>

            <ProcessRule>imageMogr2/rotate/90</ProcessRule>

        </PicProcess>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-06-06 17:33:14

更新图片处理模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>PicProcess</Tag>

    <Name>TemplateName</Name>

    <PicProcess>

        <IsPicInfo>true</IsPicInfo>

        <ProcessRule>imageMogr2/rotate/90</ProcessRule>

    </PicProcess>

</Request>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 同创建图片处理模板接口的 Request  Container 是

响应

响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>PicProcess</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <PicProcess>

            <IsPicInfo>true</IsPicInfo>

            <ProcessRule>imageMogr2/rotate/90</ProcessRule>

        </PicProcess>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称
（关键

字）

父
节

点

描述 类型

Respon

se
无 同创建图片处理模板接口的 Response  

Con
tain

er

错误码

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84735#Request
https://cloud.tencent.com/document/product/460/84735#Response
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>PicProcess</Tag>

    <Name>TemplateName</Name>

    <PicProcess>

        <IsPicInfo>true</IsPicInfo>

        <ProcessRule>imageMogr2/rotate/90</ProcessRule>

    </PicProcess>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>PicProcess</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <PicProcess>

            <IsPicInfo>true</IsPicInfo>

            <ProcessRule>imageMogr2/rotate/90</ProcessRule>

        </PicProcess>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

https://cloud.tencent.com/document/product/460/42867
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        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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媒体处理

服务与队列配置

开通媒体处理服务
最近更新时间：2022-07-07 16:15:14

CreateMediaBucket 接口用于绑定媒体存储桶操作（授权媒体处理服务角色访问存储桶）。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

POST /mediabucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <MediaBucket>

        <BucketId></BucketId>

        <Region></Region>

        <CreateTime></CreateTime>

    </MediaBucket>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称

（关键字）
父节点 描述 类型

RequestId
Resp
onse

请求的唯一 ID String

MediaBuc
ket

Resp
onse

媒体 Bucket 详情，同 DescribeMediaBuckets  中的 
Response.MediaBucketList

Conta
iner

错误码

实际案例

请求

POST /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/38914
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Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <MediaBucket>

        <BucketId>examplebucket-1250000000</BucketId>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </MediaBucket>

</Response>
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查询媒体处理服务
最近更新时间：2022-07-07 16:15:05

DescribeMediaBuckets 接口用于查询已经开通媒体处理功能的存储桶。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /mediabucket HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

名称 描述
类

型

是
否

必
选

regio

ns

地域信息，例如 ap-shanghai、ap-beijing，若查询多个地域以“,”分隔

字符串，支持中国大陆地域，详情请参见 地域与域名

stri

ng
否

bucke

tNam

存储桶名称，以“,”分隔，支持多个存储桶，精确搜索 stri

ng

否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/31066
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

es

bucke

tNam
e

存储桶名称前缀，前缀搜索
stri
ng

否

page

Numb
er

第几页
stri

ng
否

page
Size

每页个数
stri
ng

否

响应

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <MediaBucketList>

        <BucketId></BucketId>

        <Region></Region>

        <CreateTime></CreateTime>

    </MediaBucketList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

https://cloud.tencent.com/document/product/460/42866
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Container 节点 MediaBucketList 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

TotalCount Response 媒体 Bucket 总数 Int

PageNumber Response 当前页数，同请求中的 pageNumber Int

PageSize Response 每页个数，同请求中的 pageSize Int

MediaBucketList Response 媒体 Bucket 列表 Container

节点名称（关键字） 父节点 描述 类型

BucketId Response.MediaBucketList 存储桶 ID String

Name Response.MediaBucketList 存储桶名称，同 BucketId String

Region Response.MediaBucketList 所在的地域 String

CreateTime Response.MediaBucketList 创建时间 String

错误码

实际案例

请求

GET /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

https://cloud.tencent.com/document/product/460/42867
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<Response>

      <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

      <TotalCount>1</TotalCount>

      <PageNumber>1</PageNumber>

      <PageSize>10</PageSize>

      <MediaBucketList>

            <BucketId></BucketId>

            <Region></Region>

            <CreateTime></CreateTime>

      </MediaBucketList>

      <MediaBucketList>

            <BucketId></BucketId>

            <Region></Region>

            <CreateTime></CreateTime>

      </MediaBucketList>

</Response>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第718 共1701页

搜索媒体处理队列
最近更新时间：2023-07-17 17:08:12

搜索媒体处理队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /queue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名

称（关
键字）

描述 类型

是

否
必

选

queueI

ds
队列 ID，以“,”符号分割字符串。

Stri

ng
否

state 1. Active 表示队列内的作业会被媒体处理服务调度执行。 Stri
ng

否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展示

如下：

2. Paused 表示队列暂停，作业不再会被媒体处理调度执行，队列内的所有
作业状态维持在暂停状态，已经执行中的任务不受影响。

catego
ry

1. CateAll：所有类型。

2. Transcoding：媒体处理队列。

3. SpeedTranscoding：媒体处理倍速转码队列。

4. 默认为 Transcoding。

Stri
ng

否

pageN
umber

第几页，默认值1。
Stri
ng

否

pageSi

ze
每页个数，默认值10。

Stri

ng
否

响应

响应头

响应体

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>queue-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

        <Category>Transcoding</Category>

    </QueueList>

    <QueueList>

        <QueueId>pbf17a810dce74c18a641b663aede6803</QueueId>

        <Name>queue-speed-transcoding-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>SpeedTranscoding</Category>

    </QueueList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId
Respons

e
请求的唯一 ID String

TotalCount
Respons

e
队列总数 Int

PageNumber
Respons
e

当前页数，同请求中的 pageNumber Int

PageSize
Respons

e
每页个数，同请求中的 pageSize Int

QueueList
Respons

e
队列数组

Container数

组
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Container 节点 QueueList 的内容：

Container 节点 NotifyConfig 的内容：

NonExistPIDs Respons
e

不存在的队列 ID 列表 String数组

节点名称（关键字） 父节点 描述 类型

QueueId
Response.QueueLi

st
队列 ID String

Name
Response.QueueLi
st

队列名字 String

State
Response.QueueLi
st

当前状态，Active 或者 Paused String

NotifyConfig
Response.QueueLi

st
回调配置

Contain

er

MaxSize
Response.QueueLi

st
队列最大长度 Int

MaxConcurrent
Response.QueueLi
st

当前队列最大并行执行的任务数 Int

Category
Response.QueueLi

st
队列类型 String

UpdateTime
Response.QueueLi

st
更新时间 String

CreateTime
Response.QueueLi
st

创建时间 String

节点名称（关键

字）
父节点 描述 类型

Url
Response.QueueList.N
otifyConfig

回调地址
Stri
ng

State
Response.QueueList.N
otifyConfig

开关状态，On 或者 Off
Stri
ng

Type
Response.QueueList.N

otifyConfig
回调类型，Url

Stri

ng
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Event Response.QueueList.N
otifyConfig

任务完成：TaskFinish；工作流完成：
WorkflowFinish

Stri
ng

ResultForma
t

Response.QueueList.N
otifyConfig

回调类型，XML 或者 JSON
Stri
ng

错误码

实际案例

请求1：搜索指定队列

GET /queue?queueIds=p4a17eeea29334bf499b7e20e2fbfd99d,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x

<Response>

    <RequestId>NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x</RequestId>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>queue-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

https://cloud.tencent.com/document/product/460/42867
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        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>Transcoding</Category>

    </QueueList>

    <NonExistPIDs>A</NonExistPIDs>

    <NonExistPIDs>B</NonExistPIDs>

</Response>

请求2：查询队列列表

GET /queue?pageSize=10&pageNumber=1&category=CateAll HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应2

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>queue-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>
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        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>Transcoding</Category>

    </QueueList>

    <QueueList>

        <QueueId>pbf17a810dce74c18a641b663aede6803</QueueId>

        <Name>queue-speed-transcoding-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>SpeedTranscoding</Category>

    </QueueList>

</Response>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第725 共1701页

更新媒体处理队列
最近更新时间：2022-09-06 14:08:53

更新媒体处理队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有以下请求体。

功能描述

请求

请求示例

PUT /queue/<queueId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Name>My-Queue-Media</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Request 的内容：

Container 节点 NotifyConfig 的内容：

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选 默认值 限制

Request 无 保存结果的容器。 Container 是 无 无

节点名

称（关

键字）

父

节

点

描述
类

型

是
否

必
选

默

认

值

限

制

Nam

e

R

e

q
u

e
s

t

队列名称，长度不超过128

St
ri

n
g

是 无 无

State

R
e

q
u

e
s

t

1. Active 表示队列内的作业会被媒体处理服务调度执行

2. Paused 表示队列暂停，作业不再会被媒体处理调度执
行，队列内的所有作业状态维持在暂停状态，已经执行中

的任务不受影响

St

ri
n

g

是 无 无

Notif

yCon
fig

R

e
q

u
e

s
t

回调配置

C
o

nt
ai

n

er

是 无 无

节点名

称（关
键字）

父节点 描述
类

型
是否必选

默

认
值

限制

State Reque 回调开 S 否 Off On/Off



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第727 共1701页

st.Notif

yConfi
g

关，

Off/O
n

t

ri
n

g

Event

Reque
st.Notif

yConfi
g

回调事

件

S
t

ri
n

g

当 State=On 

时, 必选
无

任务完成：TaskFinish；工作

流完成：WorkflowFinish

Result
Form

at

Reque
st.Notif

yConfi
g

回调格

式

S

t
ri

n
g

否
XM

L
JSON/XML

Type

Reque

st.Notif
yConfi

g

回调类
型

S

t
ri

n
g

当 State=On 
时, 必选

无 Url 或 TDMQ

Url

Reque

st.Notif
yConfi

g

回调地
址

S
t

ri
n

g

当 State=On, 

且 Type=Url 
时, 必选

无 不能为内网地址

MqMo
de

Reque

st.Notif
yConfi

g

TDM
Q 使

用模式

S

t
ri

n

g

当 State=On, 

且 
Type=TDMQ 

时, 必选

Qu
eu

e

主题订阅：Topic 
队列服务: Queue

MqRe

gion

Reque

st.Notif

yConfi

g

TDM

Q 所

属园区

S
t

ri

n

g

当 State=On, 

且 

Type=TDMQ 

时, 必选

无

目前支持园区 sh（上海）、bj

（北京）、gz（广州）、cd

（成都）、hk（香港）

MqNa

me

Reque

st.Notif

yConfi
g

TDM

Q 主
题名称

S

t

ri
n

g

当 State=On, 

且 

Type=TDMQ 
时, 必选

无 无
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 Queue 的内容：

响应

响应头

响应体

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-Media</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

Queue Response 队列信息 Container

节点名称（关键 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

字）

QueueId
Response.Queu
e

队列 ID String

Name
Response.Queu

e
队列名字 String

State
Response.Queu

e
当前状态，Active 或者 Paused String

NotifyConfig
Response.Queu
e

回调配置，同 
Request.NotifyConfig

Container

MaxSize
Response.Queu

e
队列最大长度 Int

MaxConcurrent
Response.Queu

e
当前队列最大并行执行的任务数 Int

Category
Response.Queu
e

队列类型 String

UpdateTime
Response.Queu

e
更新时间 String

CreateTime
Response.Queu

e
创建时间 String

错误码

实际案例

请求

PUT /queue/p4a17eeea29334bf499b7e20e2fbfd99d HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 162

Content-Type: application/xml

<Request>

    <Name>My-Queue-Media</Name>

    <State>Active</State>

    <NotifyConfig>

https://cloud.tencent.com/document/product/460/42867
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        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-Media</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>
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获取媒体截图
最近更新时间：2022-08-02 11:20:13

GetSnapshot 接口用于获取媒体文件某个时间的截图。

此接口为同步模式，异步模式请参考 任务接口-截图任务 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

参数说明如下：

功能描述

使用说明

请求示例

1. 通过GET请求方式

GET /for-test.mp4?ci-process=snapshot&time=1&format=jpg HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

2. 通过URL地址添加参数方式

https://<BucketName-APPID>.cos.<Region>.myqcloud.com/for-test.mp4?ci-process=sna

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求参数

参数名

称
描述

类

型

是
否

必

选

https://cloud.tencent.com/document/product/460/76910
https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该请求无请求体。

该响应包含公共响应头，详情请参见 公共响应头部  文档。

该响应体为截图文件内容。

ci-
proce

ss

操作类型，固定使用 snapshot St
ri

n

g

是

time 截图的时间点，单位为秒

fl

o

at

是

width 截图的宽。默认为0
In
t

否

height

截图的高。默认为0

当 width 和 height 都为0时，表示使用视频的宽高。如果单个为0，则以另外
一个值按视频宽高比例自动适应

In

t
否

forma

t
截图的格式，支持 jpg 和 png，默认 jpg

St

ri

n
g

否

rotate

图片旋转方式

默认值为 auto

auto：按视频旋转信息进行自动旋转

off：不旋转

St

ri
n

g

否

mode

截帧方式

默认值为 exactframe

keyframe：截取指定时间点之前的最近的一个关键帧

exactframe：截取指定时间点的帧

St
ri

n

g

否

请求体

响应

响应头

响应体

错误码

https://cloud.tencent.com/document/product/436/7729
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

实际案例

请求1 通过GET请求方式

GET /for-test.mp4?ci-process=snapshot&time=1.5 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2016 09:45:46 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG*

Content-Length: 0

请求2 通过URL地址添加参数方式

https://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/for-test.mp4?ci-process

响应

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 266005

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-cos

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZmNw==

<图片内容>

https://cloud.tencent.com/document/product/436/53983
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读取私有 M3U8
GetPrivateM3U8
最近更新时间：2021-11-08 09:05:59

GetPrivateM3U8 接口用于获取私有 M3U8 ts 资源的下载授权。（此方式通过对象存储转发请求至数据万

象）。

参数的具体内容如下：

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

请求

请求示例

GET /for-test.m3u8?ci-process=pm3u8&expires= HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

说明

 Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

参数名称 描述 类型
是否必
选

ci-

process
操作类型，固定使用 pm3u8

Strin

g
是

expires
私有 ts 资源 url 下载凭证的相对有效期，单位为秒，范围为[3600, 

43200]

Strin

g
是

请求头

请求体

https://cloud.tencent.com/document/product/436/53981
https://cloud.tencent.com/document/product/436/7778
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该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体为截图文件内容。

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

响应

响应头

响应体

错误码

实际案例

请求

GET /for-test.pm3u8?ci-process=pm3u8&expires=3600 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2016 09:45:46 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG*

Content-Length: 0

响应

HTTP/1.1 200 OK

Content-Type: application/x-mpegURL

Content-Length: 266005

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-cos

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZm****

<M3U8文件内容>

https://cloud.tencent.com/document/product/436/53982
https://cloud.tencent.com/document/product/436/53983
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音视频转码

提交任务
最近更新时间：2023-06-06 17:30:12

提交一个转码任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemp

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemp

        <RemoveWatermark>

            <Dx>150</Dx>

            <Dy>150</Dy>

            <Width>75</Width>

            <Height>75</Height>

        </RemoveWatermark>

        <Subtitles>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

            </Subtitle>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>

            </Subtitle>

        </Subtitles>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称
（关键字）

父节
点

描述 类型 是
否
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Container 类型 Input 的具体数据描述如下：

：

必

选

Tag

Re

que

st

创建任务的Tag：Transcode
Strin

g
是

Input

Re

que

st

待操作的文件信息

Cont

aine

r

是

Operation

Re

que

st

操作规则

Cont

aine

r

是

QueueTyp

e

Re

que

st

任务所在的队列类型，限制为 SpeedTranscoding, 表示

为开启倍速转码

Strin

g
否

CallBackF

ormat

Re
que

st

任务回调格式，JSON 或 XML，默认 XML，优先级高于

队列的回调格式

Strin

g
否

CallBackT
ype

Re
que

st

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队列
的回调类型

Strin
g

否

CallBack

Re

que
st

任务回调地址，优先级高于队列的回调地址。设置为 no 
时，表示队列的回调地址不产生回调

Strin
g

否

CallBack

MqConfig

Re

que
st

任务回调TDMQ配置，当 CallBackType 为 TDMQ 时必

填。详情见 CallBackMqConfig

Cont

aine
r

否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

Container 类型 Operation 的具体数据描述如下

节点名称（关

键字）

父节点 描述 类型 是

否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 Transcode 的具体数据描述如下：

必

选

TemplateId
Request.

Operation
转码模板 ID

Stri

ng
否

Transcode
Request.
Operation

转码模板参数
Con
tain

er

否

WatermarkT
emplateId

Request.
Operation

水印模板 ID，可以传多个水印模板 ID，最多传3
个。

Stri

ng数
组

否

Watermark
Request.

Operation

水印模板参数，同创建水印模板接口中的 

Request.Watermark  ，最多传3个。

Con

tain
er

否

RemoveWat

ermark

Request.

Operation
去除水印参数, H265、AV1编码暂不支持该参数

Con

tain

er

否

Subtitles
Request.

Operation

字幕参数, H265、AV1编码和非mkv封装 暂不支

持该参数

Con

tain

er

否

DigitalWater

mark

Request.

Operation
数字水印参数，详情见 DigitalWatermark  

Con

tain

er

否

Output
Request.

Operation
结果输出配置

Con

tain

er

是

UserData
Request.

Operation

透传用户信息, 可打印的 ASCII 码, 长度不超过

1024

Stri

ng
否

JobLevel
Request.

Operation

任务优先级，级别限制：0 、1 、2 。级别越大任

务优先级越高，默认为0

Stri

ng
否

说明

 对于转码参数，优先使用优先使用 TemplateId，无 TemplateId 时使用 Transcode；对于水印参

数，可以使用 WatermarkTemplateId 或 Watermark 设置，WatermarkTemplateId 优先级更

高。

https://cloud.tencent.com/document/product/460/84725#Watermark
https://cloud.tencent.com/document/product/460/78927#DigitalWatermark
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Container 类型 RemoveWatermark 的具体数据描述如下：

Container 类型 Subtitles 的具体数据描述如下：

节点名称

（关键字）
父节点 描述 类型

必

选

TimeInter

val

Request.Operation.

Transcode

同创建转码模板接口中的 

Request.TimeInterval  

Contain

er
否

Container
Request.Operation.

Transcode

同创建转码模板接口中的 

Request.Container  

Contain

er
否

Video
Request.Operation.

Transcode

同创建转码模板接口中的 

Request.Video  

Contain

er
否

Audio
Request.Operation.

Transcode

同创建转码模板接口中的 

Request.Audio  

Contain

er
否

TransCon

fig

Request.Operation.

Transcode

同创建转码模板接口中的 

Request.TransConfig  

Contain

er
否

AudioMix
Request.Operation.

Transcode
混音参数，详情见 AudioMix  

Contain

er
否

AudioMix
Array

Request.Operation.
Transcode

混音参数数组, 最多同时传2个。详情见 
AudioMixArray  

Contain
er数组

否

说明

 AudioMix 和 AudioMixArray 同时设置时, AudioMixArray 无效。

节点名称（关

键字）
父节点 描述

类

型

必

选

Dx
Request.Operation.Remove
Watermark

距离左上角原点 x 偏移，范围
为[1, 4096]

stri
ng

是

Dy
Request.Operation.Remove

Watermark

距离左上角原点 y 偏移，范围

为[1, 4096]

stri

ng
是

Width
Request.Operation.Remove

Watermark
宽，范围为[1, 4096]

stri

ng
是

Height
Request.Operation.Remove
Watermark

高，范围为[1, 4096]
stri
ng

是

https://cloud.tencent.com/document/product/460/84733#TimeInterval
https://cloud.tencent.com/document/product/460/84733#Container
https://cloud.tencent.com/document/product/460/84733#Video
https://cloud.tencent.com/document/product/460/84733#Audio
https://cloud.tencent.com/document/product/460/84733#TransConfig
https://cloud.tencent.com/document/product/460/78927#AudioMix
https://cloud.tencent.com/document/product/460/78927#AudioMixArray
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Container 类型 Subtitle 的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

Request.Operation.Output.Object 支持的通配符如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

节点名称（关键字） 父节点 描述 类型 必选

Subtitle Request.Operation.Subtitles 字幕参数 Container数组 是

节点名称（关键

字）
父节点 描述 类型

必

选

Url
Request.Operation.Subtitles.Su

btitle

同 bucket 的字幕

地址

strin

g
是

节点名称（关键字） 父节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储桶 String 是

Object Request.Operation.Output 输出结果的文件名 String 是

通配符 含义

${ext} 封装格式

${jobid} 任务Id

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

https://cloud.tencent.com/document/product/460/42866
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        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <Subtitles>

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

                </Subtitle>

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>

                </Subtitle>

            </Subtitles>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>
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具体的数据内容如下：

Container 节点 Response 的内容：

：

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容

节点名称
（关键

字）

父节点 描述 类型

Code
Response.
JobsDetail

错误码，只有 State 为 Failed 时有意义
Stri
ng

Messag

e

Response.

JobsDetail
错误描述，只有 State 为 Failed 时有意义

Stri

ng

JobId
Response.

JobsDetail
新创建任务的 ID

Stri

ng

Tag
Response.
JobsDetail

新创建任务的 Tag：Transcode
Stri
ng

State
Response.

JobsDetail

任务的状态，为 Submitted、Running、Success、

Failed、Pause、Cancel 其中一个

Stri

ng

Progres

s

Response.

JobsDetail

任务进度百分比，只有在State为 Submitted、Running、

Success、Pause 时有意义，范围为[0, 100]

Stri

ng

Creatio
nTime

Response.
JobsDetail

任务的创建时间
Stri
ng

StartTi

me

Response.

JobsDetail
任务的开始时间

Stri

ng

EndTim Response. 任务的结束时间 Stri
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

e JobsDetail ng

QueueI
d

Response.
JobsDetail

任务所属的队列 ID
Stri
ng

Input
Response.

JobsDetail
该任务的输入资源地址

Con

tain

er

Operati

on

Response.

JobsDetail
该任务的规则

Con

tain

er

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键

字）
父节点 描述 类型

TemplateId
Response.JobsDetai
l.Operation

任务的模板 ID String

TemplateNam

e

Response.JobsDetai

l.Operation

任务的模板名称, 当 TemplateId 存在

时返回
String

Transcode
Response.JobsDetai

l.Operation

同请求中的 

Request.Operation.Transcode

Contain

er

Watermark
Response.JobsDetai

l.Operation

同请求中的 

Request.Operation.Watermark

Contain

er 数组

RemoveWate

rmark

Response.JobsDetai

l.Operation

同请求中的 

Request.Operation.RemoveWat

ermark

Contain

er

WatermarkTe

mplateId

Response.JobsDetai

l.Operation
水印模板 ID

String 数

组

Output Response.JobsDetai 同请求中的 Contain
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Container 节点 MediaInfo 的内容： 

同 GenerateMediaInfo  接口中的 Response.MediaInfo 节点。

Container 节点 MediaResult 的内容： 

详情见 MediaResult </a

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

l.Operation Request.Operation.Output er

MediaInfo
Response.JobsDetai

l.Operation

输出文件的媒体信息，任务未完成时不

返回

Contain

er

MediaResult
Response.JobsDetai

l.Operation

输出文件的基本信息，任务未完成时不

返回

Contain

er

DigitalWaterm

ark

Response.JobsDetai

l.Operation

同请求中的 
Request.Operation.DigitalWater

mark

Contain

er

UserData
Response.JobsDetai
l.Operation

透传用户信息 String

JobLevel
Response.JobsDetai

l.Operation
任务优先级 String

错误码

实际案例

请求1：使用转码模板 ID

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemp

https://cloud.tencent.com/document/product/460/38935
https://cloud.tencent.com/document/product/460/78927#MediaResult
https://cloud.tencent.com/document/product/460/42867
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        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemp

        <RemoveWatermark>

            <Dx>150</Dx>

            <Dy>150</Dy>

            <Width>75</Width>

            <Height>75</Height>

        </RemoveWatermark>

        <Subtitles>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

            </Subtitle>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>

            </Subtitle>

        </Subtitles>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第747 共1701页

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <Subtitles>

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

                </Subtitle>

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>

                </Subtitle>

            </Subtitles>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>
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                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使用转码处理参数

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>
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                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </Transcode>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>水印内容</Text>

                <FontSize>30</FontSize>

                <FontType>simfang.ttf</FontType>
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                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <RemoveWatermark>

            <Dx>150</Dx>

            <Dy>150</Dy>

            <Width>75</Width>

            <Height>75</Height>

        </RemoveWatermark>

        <Subtitles>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

            </Subtitle>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>

            </Subtitle>

        </Subtitles>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应2

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci
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x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Profile>high</Profile>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                    <Preset>medium</Preset>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

                <TransConfig>

                    <AdjDarMethod>scale</AdjDarMethod>

                    <IsCheckReso>false</IsCheckReso>

                    <ResoAdjMethod>1</ResoAdjMethod>

                </TransConfig>

                <TimeInterval>

                    <Start>0</Start>
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                    <Duration>60</Duration>

                </TimeInterval>

                <AudioMixArray>

                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3<

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                    <EffectConfig>

                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>

                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>

                </AudioMixArray>

                <AudioMixArray>

                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3<

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                    <EffectConfig>

                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>

                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>

                </AudioMixArray>

            </Transcode>

            <Watermark>

                <Type>Text</Type>

                <LocMode>Absolute</LocMode>

                <Dx>128</Dx>

                <Dy>128</Dy>

                <Pos>TopRight</Pos>

                <StartTime>0</StartTime>

                <EndTime>100.5</EndTime>

                <Text>

                    <Text>水印内容</Text>

                    <FontSize>30</FontSize>

                    <FontType></FontType>

                    <FontColor>0xRRGGBB</FontColor>

                    <Transparency>30</Transparency>

                </Text>

            </Watermark>
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            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <Subtitles>

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

                </Subtitle>

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>

                </Subtitle>

            </Subtitles>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第754 共1701页

任务回调
最近更新时间：2023-02-16 14:22:53

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数

据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>
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                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/transcode.mp4</ObjectName>
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容： 

同提交转码任务接口中的 Response.JobsDetail  

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

                    </Md5Info>

                    <ObjectName>output/transcode.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <UserData>This is my Transcode job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

节点名称（关键 父节点 描述 类型

https://cloud.tencent.com/document/product/460/84790#jobsDetail


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第757 共1701页

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

字）

Key
Response.JobsDetail.Input.CosHead

ers

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosHead
ers

自定义 Header 的值
Strin
g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>
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                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>
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                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/transcode.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/transcode.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <UserData>This is my Transcode job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>
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            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>
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                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/transcode.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/transcode.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>
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                <Object>output/transcode.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <UserData>This is my Transcode job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

        <Workflow>

            <Name>Transcode_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T15:29:42+0800",

        "EndTime": "2022-06-30T15:30:08+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",
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                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j68427030f84611ecb8546d80f2baf56f",

        "Message": "success",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Duration": "13",

                    "NumStream": "1",

                    "Size": "1909389"

                },

                "Stream": {

                    "Audio": [{

                        "Bitrate": "128000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "13.653",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"

                    }],

                    "Video": [{

                        "AvgFps": "50.000",

                        "Bitrate": "1031968",

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Coding)",

                        "CodecName": "hevc",

                        "CodecTag": "0x31637668",

                        "CodecTagString": "hvc1",

                        "CodecTimeBase": "1/50",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",
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                        "ColorTransfer": "smpte170m",

                        "Duration": "12.960",

                        "FieldOrder": "Unknown",

                        "Fps": "50/1",

                        "HasBFrame": "4",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",

                        "Level": "4",

                        "NumFrames": "648",

                        "PixFormat": "hvc1",

                        "Profile": "Main",

                        "RefFrames": "1",

                        "Rotation": "0",

                        "StartTime": "0.000000",

                        "Timebase": "1/12800",

                        "Width": "540"

                    }]

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": [{

                        "Md5": "2db78d168edf2f883adce89a1b4ca033",

                        "ObjectName": "output/transcode.mp4"

                    }],

                    "ObjectName": ["output/transcode.mp4"],

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/transcode.${ext}",

                "Region": "ap-chongqing"

            },

            "TemplateId": "t1995d523e42df4c5e858f244b4174360c",

            "TemplateName": "trans_993874",

            "UserData": "This is my Transcode job.",

            "JobLevel": 0

        },

        "Progress": "100",

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T15:29:42+0800",

        "State": "Success",
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        "Tag": "Transcode",

        "Workflow": {

            "Name": "Transcode_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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创建模版
最近更新时间：2023-01-04 17:04:25

创建音视频转码模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>
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具体数据描述如下：

 

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称

（关键

字）

父节

点
描述 类型

是

否

必
选

限制

Tag

Re

que

st

模板类型：Transcode String 是 无

Name

Re

que

st

模板名称，仅支持中文、英文、

数字、_、-和*
String 是 无

Containe

r

Re

que

st

容器格式
Contai

ner
是 无

Video

Re

que

st

视频信息
Contai

ner
否

不传 Video，相当

于删除视频信息

TimeInte

rval

Re

que

st

时间区间
Contai

ner
否 无

Audio
Re
que

st

音频信息
Contai

ner
否

不传 Audio，相当

于删除音频信息

TransCo
nfig

Re
que

st

转码配置
Contai
ner

否 无

AudioMi Re 混音参数，详情见 AudioMix  Contai 否 Audio.Remove 为 

https://cloud.tencent.com/document/product/460/78927#AudioMix
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Container 类型 ClipConfig 的具体数据描述如下：

设定 container，音频视频支持的格式如下表所示：

x que

st

ner false 时生效

AudioMi
xArray

Re
que

st

混音参数，最多同时传2个。详情
见 AudioMixArray  

Contai
ner数组

否
Audio.Remove 为 
false 时生效

Container 类型 Container 的具体数据描述如下：

节点名称（关键

字）
父节点 描述 类型

是否必

选

Format
Request.Cont

ainer
封装格式：取值见下表 String 是

ClipConfig
Request.Cont
ainer

分片配置，当 format 为 hls 和 
dash 时有效

Contai
ner

否

节点名称（关键

字）
父节点 描述 类型

是否必

选

Duration
Request.Container.ClipConfi
g

分片时长，默认
5s

Strin
g

否

Container Audio Codecs Video Codecs

mp4/hls/mkv aac、mp3 H.264、H.265、AV1

ts/flv/avi/mov aac、mp3 H.264

dash aac H.264

WebM Vorbis、opus VP8、VP9、AV1

aac aac 不支持

mp3 mp3 不支持

flac flac 不支持

amr amr 不支持

https://cloud.tencent.com/document/product/460/78927#AudioMixArray


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第770 共1701页

 

adts aac 不支持

m4a aac 不支持

wav pcm_s16le 不支持

Container 类型 Video 的具体数据描述如下：

节点

名称

（关

键
字）

父节

点
描述

类

型

是

否

必

选

默认值 限制

Cod
ec

Req

ues
t.Vi

deo

编解
码格

式

S

tr
in

g

否

H.264

当 format 
为 WebM 

时，为 VP8

H.264

H.265

VP8

VP9

AV1

Widt

h

Req

ues

t.Vi

deo

宽

S

tr

in

g

否 视频原始宽度

值范围：[128, 4096]

单位：px

若只设置 Width 时，按照视频原始

比例计算 Height 

必须为偶数

Heig

ht

Req
ues

t.Vi

deo

高

S
tr

in

g

否 视频原始高度

值范围：[128, 4096]

单位：px

若只设置 Height 时，按照视频原始

比例计算 Width

必须为偶数

Fps

Req

ues

t.Vi

deo

帧率

S

tr

in

g

否 无
值范围：(0, 60]

单位：fps

Rem

ove

Req

ues

t.Vi

deo

是否

删除

视频

流

S

tr

in

g

否 false true、false

Profi Req 编码 S 否 high 支持 baseline、main、high、
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le ues
t.Vi

deo

级别 tr
in

g

auto

当 Pixfmt 为 auto 时，该参数仅能

设置为 auto，当设置为其他选项

时，参数值将被设置为 auto

 baseline：适合移动设备

main：适合标准分辨率设备

high：适合高分辨率设备

 仅H.264支持此参数 

Bitra

te

Req

ues

t.Vi

deo

视频

输出

文件

的码
率

S

tr

in

g

否 无

值范围：[10, 50000]，单位：

Kbps

auto 表示自适应码率 

Crf

Req

ues
t.Vi

deo

码

率-

质量
控制

因子

S

tr
in

g

否 无

值范围：(0, 51]

如果设置了 Crf，则 Bitrate 的设置
失效

当 Bitrate 为空时，默认为25

Gop

Req
ues

t.Vi

deo

关键
帧间

最大

帧数

S
tr

in

g

否 无 值范围：[1, 100000]

Pres

et

Req

ues

t.Vi
deo

视频

算法

器预
置

S

tr

in
g

否

medium，当 

Codec 为 

VP8 时，为 
good

H.264支持该参数，取值 
veryfast、fast、medium、

slow、slower 

VP8 支持该参数，取值 good、

realtime 
AV1 支持该参数，取值 

universal、medium

H.265 和 VP9 不支持该参数 

Bufs

ize

Req

ues

t.Vi

deo

缓冲

区大

小

S

tr

in

g

否 无

值范围：[1000, 128000]

单位：Kb

Codec 为 VP8/VP9时不支持此参

数  

Max

rate

Req

ues

t.Vi
deo

视频

码率

峰值

S

tr

in
g

否 无 值范围：[10, 50000]

单位：Kbps

Codec 为 VP8/VP9时不支持此参
数 
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Pixf

mt

Req

ues

t.Vi
deo

视频

颜色

格式

S

tr

in
g

否 无

H.264支持：yuv420p、

yuv422p、yuv444p、
yuvj420p、yuvj422p、

yuvj444p、auto

H.265支持：yuv420p、

yuv420p10le、auto

Codec 为 VP8/VP9/AV1 时不支

持此参数 

Lon

gSh

ortM

ode

Req

ues

t.Vi

deo

长短

边自

适应

S

tr

in

g

否 false

true、false

Codec 为 VP8/VP9/AV1 时不支

持此参数 

Rota

te

Req

ues

t.Vi

deo

旋转

角度

S

tr

in

g

否 无
值范围：[0, 360)

 单位：度 

Container 类型 TimeInterval 的具体数据描述如下：

节点名称

（关键字）
父节点 描述

类

型

是否

必选
默认值 限制

Start
Request.Tim

eInterval

开始

时间

St

rin

g

否 0

[0 视频时长] 

单位为秒

支持 float 格式，执行

精度精确到毫秒 

Duration
Request.Tim

eInterval

持续

时间

St

rin

g

否
视频原

始时长

[0 视频时长] 

单位为秒 

支持 float 格式，执行

精度精确到毫秒 

Container 类型 Audio 的具体数据描述如下：

节点

名称

（关

父

节

点

描

述

类

型

是

否

必

选

默认值 限制
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键

字）

Cod
ec

Re

qu
est

.Au

dio

编

解
码

格

式

S

tr
in

g

否

aac

当 format 

为 WebM 

时，为 
Vorbis

当 format 

为 wav 时，

为 
pcm_s16le

取值 aac、mp3、flac、amr、
Vorbis、opus、pcm_s16le

Sa

mpl

erat
e

Re

qu

est

.Au
dio

采

样

率

S

tr

in
g

否

44100，当 

Codec 为 

opus 时，默认
值为48000

单位：Hz 

可选 8000、11025、12000、

16000、22050、24000、
32000、44100、48000、

88200、96000 

不同的封装，mp3 支持不同的采样

率，如下表所示

当 Codec 设置为 amr 时，只支持

8000 

当 Codec 设置为 opus 时，支持
8000，16000，24000，48000 

Bitr
ate

Re

qu
est

.Au

dio

原

始

音
频

码

率

S

tr
in

g

否 无
单位：Kbps 

值范围：[8，1000]   

Cha

nnel

s

Re
qu

est

.Au

dio

声

道

数

S
tr

in

g

否 无

当 Codec 设置为 aac/flac，支持

1、2、4、5、6、8 

当 Codec 设置为 mp3/opus 时，

支持1、2 

当 Codec 设置为 Vorbis 时，只支

持2 

当 Codec 设置为 amr，只支持1 

当 Codec 设置为 pcm_s16le 时，
只支持1、2   

当封装格式为 dash 时，不支持8  

Re Re 是 S 否 false 取值 true、false
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Audio.Codec 采样率支持情况，如下表所示：

mov

e

qu

est

.Au

dio

否

删

除

源
音

频

流

tr

in

g

Kee
pTw

oTr

ack

s

Re
qu

est

.Au

dio

保
持

双

音

轨

S

tr

in

g

否 false
取值 true、false。 当 Video.Codec 

为H.265时，此参数无效

Swi

tch

Tra
ck

Re

qu

est
.Au

dio

转

换

轨
道

S

tr

in
g

否 false
取值 true、false。 当 Video.Codec 

为H.265时，此参数无效

Sa
mpl

eFo

rma

t

Re
qu

est

.Au

dio

采

样

位

宽

S

tr

in

g

否 无

当 Codec 设置为 aac，支持 fltp 

当 Codec 设置为 mp3，支持 fltp、

s16p、s32p 

当 Codec 设置为 flac，支持s16、

s32、s16p、s32p 

当 Codec 设置为 amr，支持s16、

s16p

当 Codec 设置为 opus，支持s16 

当 Codec 设置为 pcm_s16le，支
持s16

当 Codec 设置为 Vorbis，支持 

fltp 

当 Video.Codec 为 H.265 时，此
参数无效 

说明

 Y 表示支持这种采样率，N 表示不支持。

Audio.Cod

ec      
aac      amr      flac      opus      Vorbis      

pcm_s16l

e      
mp3   
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当 Audio.Codec 为 mp3 时，Container.Format 的采样率兼容情况如下所示：

 

8000 Y Y Y Y Y Y 封装不同，支
持不同

11025 Y N Y N Y Y

12000 Y N Y N Y Y

16000 Y N Y Y Y Y

22050 Y N Y N Y Y

24000 Y N Y Y Y Y

32000 Y N Y N Y Y

44100 Y N Y N Y Y

48000 Y N Y Y Y Y

88200 Y N Y N Y Y

96000 Y N Y N Y Y

封装格式/音频采

样率

8

0

0
0

11

0

2
5

12

0

0
0

16

0

0
0

22

05
0

24

00
0

32

00
0

4

41

0
0

48

00
0

88

20
0

96

00
0

flv N N N N Y N N Y N N N

mp4 N N N Y Y Y Y Y Y N N

hls/ts/mp3/m

kv/avi/mov
Y Y Y Y Y Y Y Y Y N N

Container 类型 TransConfig 的具体数据描述如下：

节
点

名

称

（
关

键

父
节

点

描述 类
型

是
否

必

选

默认
值

限制
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字

）

Adj

Da
rM

eth

od

Re

qu

est
.Tr

an

sC

onf
ig

分辨率调整方式
Str

ing
否

non

e

取值 scale、crop、

pad、none

当输出视频的宽高比

与原视频不等时，根

据此参数做分辨率的

相应调整

IsC
he

ck

Re

so

Re

qu

est
.Tr

an

sC

onf
ig

是否检查分辨率
Str

ing
否

fals

e

true、false

当为 false 时，按照

配置参数转码  

Re
so

Adj

Me

tho

d

Re

qu
est

.Tr

an

sC

onf
ig

分辨率调整方式
Str

ing
否 0

取值0、1；0表示使
用原视频分辨率；1表

示返回转码失败

当 IsCheckReso 

为 true 时生效 

IsC

he
ck

Vid

eo

Bit
rat

e

Re

qu
est

.Tr

an

sC
onf

ig

是否检查视频码率
Str

ing
否

fals

e

true、false 

当为 false 时，按照

配置参数转码

Vid

eo
Bit

rat

eA

dj
Me

Re

qu
est

.Tr

an

sC

视频码率调整方式 Str

ing

否 0 取值0、1；当输出视

频码率大于原视频码
率时，0表示使用原视

频码率；1表示返回转

码失败

当 
IsCheckVideoBitr
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tho

d

onf

ig

ate 为 true 时生效

IsC

he

ck

Au
dio

Bit

rat

e

Re

qu

est

.Tr
an

sC

onf

ig

是否检查音频码率
Str
ing

否
fals
e

true、false

当为 false 时，按照

配置参数转码 

Au

dio

Bit

rat
eA

dj

Me

tho
d

Re

qu

est
.Tr

an

sC

onf
ig

音频码率调整方式
Str

ing
否 0

取值0、1；当输出音

频码率大于原音频码

率时，0 表示使用原
音频码率；1表示返回

转码失败

当 

IsCheckAudioBitr
ate 为 true 时生效  

IsC

he
ck

Vid

eo

Fp
s

Re

qu
est

.Tr

an

sC

onf
ig

是否检查视频帧率
Str

ing
否

fals

e

true、false

当为 false 时，按照

配置参数转码

Vid

eo
Fp

sA

dj

Me
tho

d

Re

qu
est

.Tr

an

sC
onf

ig

视频帧率调整方式
Str

ing
否 0

取值0、1；当输出视

频帧率大于原视频帧
率时，0表示使用原视

频帧率；1表示返回转

码失败

当 
IsCheckVideoFps

      为 true 时生效

Del
ete

Me

tad

ata

Re
qu

est

.Tr

an

sC

是否删除文件中的 MetaData 
信息

Str
ing

否 fals
e

 true、false 

当为 false 时, 保留源

文件信息 
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AdjDarMethod 参数图示：

onf

ig

IsH

dr2

Sd
r

Re
qu

est

.Tr

an
sC

onf

ig

是否开启 HDR 转 SDR
Str

ing
否

fals

e
true/false

Tra

ns

co

deI
nd

ex

Re

qu

est

.Tr

an
sC

onf

ig

指定处理的流编号，对应媒体信

息中的 

Response.MediaInfo.Stre

am.Video.Index 和 
Response.MediaInfo.Stre

am.Audio.Index，详见 获取

媒体信息接口

Str

ing
否 无 无

Hls

En
cry

pt

Re

qu

est

.Tr
an

sC

onf

ig

hls 加密配置

Co

nta
ine

r

否 无 无

Da

sh
En

cry

pt

Re

qu

est

.Tr
an

sC

onf

ig

dash 加密配置

Co

nta
ine

r

否 无 无

https://cloud.tencent.com/document/product/460/49284
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Container 类型 HlsEncrypt 的具体数据描述如下：

节点名称
（关键

字）

父节点 描述
类

型

是
否

必

选

默
认

值

限制

IsHlsEn

crypt

Request.TransCo

nfig.HlsEncrypt

是否开启 

HLS 加

密

S
tr

in

g

否

f
al

s

e

true/false

当 

Container.Format 

为 hls 时支持加密

UriKey Request.TransCo

nfig.HlsEncrypt

HLS 加

密的 key

S

tr

否 无 当 IsHlsEncrypt 为 

true 时，该参数才有意义
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Container 类型 DashEncrypt 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

in
g

节点名称

（关键

字）

父节点 描述
类

型

是

否

必

选

默

认

值

限制

IsEncry

pt

Request.TransCo

nfig.DashEncrypt

是否开启 

DASH 加

密

S

tr

in

g

否

f

al

s

e

 true/false

当 

Container.Format 

为 dash 时支持加密

UriKey
Request.TransCo

nfig.DashEncrypt

DASH 加

密的 key

S

tr

in
g

否 无
当 IsEncrypt 为 true 

时，该参数才有意义

响应

响应头

响应体

<Response>

    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Container>

            <Format>mp4</Format>

        </Container>

        <Video>

            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

https://cloud.tencent.com/document/product/460/42866
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            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>
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具体的数据内容如下：

 

Container节点TransTpl的内容：

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） 父节点 描述 类型

TemplateId Response.Template 模板 ID String

Name Response.Template 模板名称 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 Official String

Tag Response.Template 模板类型，Transcode String

UpdateTime Response.Template 更新时间 String

CreateTime Response.Template 创建时间 String

TransTpl Response.Template 详细的模板参数 Container

节点名称（关键

字）
父节点 描述 类型

TimeInterval
Response.Template.Tr

ansTpl

同请求体中的 

Request.TimeInterval
Container

Container
Response.Template.Tr

ansTpl

同请求体中的 

Request.Container
Container

Video
Response.Template.Tr

ansTpl
同请求体中的 Request.Video Container

Audio
Response.Template.Tr

ansTpl
同请求体中的 Request.Audio Container
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

TransConfig Response.Template.Tr

ansTpl

同请求体中的 

Request.TransConfig

Container

AudioMix
Response.Template.Tr

ansTpl

同请求体中的 

Request.AudioMix
Container

AudioMixArr

ay

Response.Template.Tr

ansTpl

同请求体中的 

Request.AudioMixArray

Container

数组

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

https://cloud.tencent.com/document/product/460/42867
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        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****
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<Response>

    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Container>

            <Format>mp4</Format>

        </Container>

        <Video>

            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>
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            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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创建模板 转码pro（广电专业格式）
最近更新时间：2023-07-14 16:05:42

创建音视频转码 pro 模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>

    </Container>

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

 

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关

键字）

父节

点
描述 类型

是否

必选
限制

Tag
Req
uest

模板类型：TranscodePro
Stri
ng

是 无

Name
Req

uest

模板名称 仅支持中文、英文、

数字、_、-和*

Stri

ng
是 无

Container
Req

uest
容器格式

Con

tain

er

是 无

Video
Req

uest
视频信息

Con

tain

er

是 无
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设定 container，音频视频支持的格式如下表：

 

TimeInterv

al

Req

uest

时间区间 Con

tain

er

否 无

Audio
Req

uest
音频信息

Con
tain

er

否
不传 Audio，相当于

删除音频信息

TransConfi
g

Req
uest

转码配置
Con
tain

er

否 无

Container 类型 Container 的具体数据描述如下：

节点名称（关键

字）
父节点 描述 类型

是否必

选

Format
Request.Containe

r

封装格式：mxf、mov、

mkv

Strin

g
是

Container Audio Codecs Video Codecs

mxf pcm_s24le xavc

mov、mkv aac、mp3 apple_prores

Container 类型 Video 的具体数据描述如下：

节点名称（关

键字）
父节点 描述 类型

是否

必选

默

认

值

限制

Codec
Request.V

ideo
编解码格式

Stri

ng
是 无

xavc、

apple_prores

Profile
Request.V

ideo

视频算法器预

置

Stri

ng
是 无 取值范围见下表

Width
Request.V

ideo
宽

Stri

ng
是 无 取值范围见下表

Height Request.V 高 Stri 是 无 取值范围见下表
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视频参数约束表:

注：'-' 表示留空。码率可选值与帧率可选值序号对应。

当 Video.Codec 为 xavc 时：

ideo ng

Interlaced
Request.V

ideo
场模式

Stri

ng
是 无 取值范围见下表

Fps
Request.V
ideo

帧率
Stri
ng

是 无 取值范围见下表

Bitrate
Request.V

ideo

视频输出文件

的码率

Stri

ng
否 无 取值范围见下表

Rotate
Request.V

ideo
旋转角度

Stri

ng
否 无

1. 值范围：[0, 

360)

2. 2. 单位：度

Profile Width
Heig

ht

Interlac

ed
Fps Bitrate(单位:kbps)

XAVC-

HD_intra_420_

10bit_class50

1440 1080 true

1、25

2、

30000/1001

-

XAVC-

HD_intra_420_

10bit_class50

1440 1080 false

1、25

2、

24000/1001

3、
30000/1001

-

XAVC-

HD_intra_422_

10bit_class100

1280 720 false

1、50

2、

60000/1001

-

XAVC-

HD_intra_422_

10bit_class100

1920 1080 true

1、25

2、

30000/1001

-

XAVC-

HD_intra_422_

10bit_class100

1920 1080 false 1、25

2、50

3、

24000/1001

-
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4、

30000/1001
5、

60000/1001

XAVC-

HD_intra_422_
10bit_class200

1920 1080 true

1、25

2、
30000/1001

-

XAVC-

HD_intra_422_

10bit_class200

1920 1080 false

1、25

2、50
3、

24000/1001

4、

30000/1001
5、

60000/1001

-

XAVC-

4K_intra_422_1

0bit_class100

2048 1080 false

1、25

2、50
3、

24000/1001

4、

30000/1001
5、

60000/1001

-

XAVC-

4K_intra_422_1

0bit_class300

3840 2160 false

1、25
2、50

3、

24000/1001

4、

30000/1001
5、

60000/1001

-

XAVC-

4K_intra_422_1

0bit_class300

4096 2160 false

1、25
2、50

3、

24000/1001

4、
30000/1001

5、

60000/1001

-

XAVC-
4K_intra_422_1

3840 2160 false 1、25
2、50

-



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第792 共1701页

0bit_class480 3、

24000/1001

4、
30000/1001

5、

60000/1001

XAVC-

4K_intra_422_1
0bit_class480

4096 2160 false

1、25

2、50

3、

24000/1001

4、
30000/1001

5、

60000/1001

-

XAVC-

4K_intra_422_1
0bit

2048 1080 false

1、25

2、50

3、

24000/1001
4、

30000/1001

5、

60000/1001

1、93000

2、185000

3、89000
4、111000

5、222000

XAVC-
4K_intra_422_1

0bit

3840 2160 false

1、25

2、50

3、
24000/1001

4、

30000/1001

5、
60000/1001

1、250000或

400000

2、500000或

800000
3、240000或

384000

4、300000或

480000
5、600000或

960000

XAVC-

4K_intra_422_1

0bit

4096 2160 false

1、25
2、50

3、

24000/1001

4、
30000/1001

5、

60000/1001

1、250000或

400000
2、500000或

800000

3、240000或

384000
4、300000或

480000

5、600000或

960000
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当 Video.Codec 为 apple_prores 时：

XAVC-

HD_422_10bit

1280 720 false 1、50

2、

60000/1001

1、50000

2、50000

XAVC-

HD_422_10bit
1920 1080 true

1、25

2、

30000/1001

1、25000或35000

或50000

2、25000或35000

或50000

XAVC-
HD_422_10bit

1920 1080 false

1、25

2、50

3、

24000/1001
4、

30000/1001

5、

60000/1001

1、25000或35000

或50000

2、35000或50000

3、25000或35000
或50000

4、25000或35000

或50000

5、35000或50000

XAVC-

4K_422_10bit
3840 2160 false

1、25

2、50
3、

24000/1001

4、

30000/1001

5、
60000/1001

1、100000或

140000或200000

2、140000或
200000

3、100000或

140000或200000

4、100000或

140000或200000
5、140000或

200000

XAVC-

4K_420_8bit
3840 2160 false

1、25
2、50

3、

24000/1001

4、
30000/1001

5、

60000/1001

1、188000

2、300000

3、188000

4、188000
5、300000

Profile

1.ProRes_422_Proxy
2.ProRes_422_LT

.ProRes_422

4.ProRes_422_HQ
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5.ProRes_4444
6.ProRes_4444_XQ

7.ProRes_4444_alpha

8.ProRes_4444_XQ_alpha

Width Height Interlaced Fps Bitrate(单位:kbps)

720 486 false
1、24000/1001

2、30000/1001
取值范围:[2000,3000000]

720 486 true 1、60000/1001 取值范围:[2000,3000000]

720 576 false 1、25 取值范围:[2000,3000000]

720 576 true 1、50 取值范围:[2000,3000000]

960 720 false

1、25

2、50
3、24000/1001

4、30000/1001

5、60000/1001

取值范围:[2000,3000000]

1280 720 false

1、25
2、50

3、24000/1001

4、30000/1001

5、60000/1001

取值范围:[2000,3000000]

1280 1080 false
1、24000/1001

2、30000/1001
取值范围:[2000,3000000]

1280 1080 true 1、60000/1001 取值范围:[2000,3000000]

1440 1080 false

1、24000/1001

2、25

3、30000/1001

取值范围:[2000,3000000]

1440 1080 true
1、50

2、60000/1001
取值范围:[2000,3000000]

1920 1080 false

1、25

2、50

3、24000/1001

4、30000/1001

5、60000/1001

取值范围:[2000,3000000]

1920 1080 true 1、50 取值范围:[2000,3000000]
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2、60000/1001

2048 1080 false

1、25

2、50

3、24000/1001

4、30000/1001
5、60000/1001

取值范围:[2000,3000000]

2048 1556 false

1、25

2、50
3、24000/1001

4、30000/1001

5、60000/1001

取值范围:[2000,3000000]

3840 2160 false

1、25
2、50

3、24000/1001

4、30000/1001

5、60000/1001

取值范围:[2000,3000000]

4096 2160 false

1、25

2、50

3、24000/1001
4、30000/1001

5、60000/1001

取值范围:[2000,3000000]

5120 2700 false

1、25

2、50
3、24000/1001

4、30000/1001

5、60000/1001

取值范围:[2000,3000000]

6144 3240 false

1、25

2、50

3、24000/1001

4、30000/1001

5、60000/1001

取值范围:[2000,3000000]

8192 4320 false

1、25

2、50

3、24000/1001
4、30000/1001

5、60000/1001

取值范围:[2000,3000000]

Container 类型 TimeInterval 的具体数据描述如下：
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节点名称

（关键字）

父节点 描述 类

型

是否

必选

默认值 限制

Start
Request.Tim

eInterval

开始

时间

St

rin

g

否 0

[0 视频时长]

单位为秒 

支持 float 格式，执行
精度精确到毫秒

Duration
Request.Tim
eInterval

持续
时间

St

rin
g

否
视频原
始时长

[0 视频时长] 

单位为秒 

支持 float 格式，执行

精度精确到毫秒

Container 类型 Audio 的具体数据描述如下：

节点名称（关

键字）
父节点 描述 类型

是否

必选

默

认
值

限制

Codec
Request.A

udio
编解码格式

Stri

ng
是 无

pcm_s24le、

aac、mp3

Remove
Request.A

udio

是否删除源

音频流

Stri

ng
否

fal

se
取值 true、false

Container 类型 TransConfig 的具体数据描述如下：

节点名称
（关键字）

父节点 描述
类
型

是

否
必

选

默

认
值

限制

AdjDarM

ethod

Requ
est.Tr

ansC

onfig

分辨率调整

方式

St
ri

n

g

否

n
o

n

e

取值 scale、crop、pad、
none

当输出视频的宽高比与原视频不等

时，根据此参数做分辨率的相应调

整

IsCheck

Reso

Requ

est.Tr

ansC

onfig

是否检查分

辨率

St

ri

n

g

否 f

a

l

true、false 

当为 false时，按照配置参数转码
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s

e

ResoAdj

Method

Requ

est.Tr

ansC

onfig

分辨率调整

方式

St

ri

n

g

否 0

取值0、1；0 表示使用原视频分辨

率；

1表示返回转码失败

当 IsCheckReso 为 true 时生
效

IsCheck

VideoBitr
ate

Requ

est.Tr
ansC

onfig

是否检查视
频码率

St

ri
n

g

否

f

a

l
s

e

true、false 

当为 false 时，按照配置参数转码

VideoBitr

ateAdjM

ethod

Requ

est.Tr

ansC

onfig

视频码率调

整方式

St

ri

n

g

否 0

取值0、1；当输出视频码率大于
原视频码率时，0表示使用原视频

码率；1表示返回转码失败

当 IsCheckVideoBitrate 为 

true 时生效

IsCheck

AudioBitr
ate

Requ

est.Tr

ansC
onfig

是否检查音

频码率

St

ri

n
g

否

f

a

l
s

e

true、false

当为 false 时，按照配置参数转
码 

AudioBitr
ateAdjM

ethod

Requ
est.Tr

ansC

onfig

音频码率调

整方式

St
ri

n

g

否 0

取值0、1；当输出音频码率大于

原音频码率时，0 表示使用原音频
码率；1表示返回转码失败

当 IsCheckAudioBitrate 为 

true 时生效

IsCheck

VideoFp

s

Requ

est.Tr

ansC

onfig

是否检查视

频帧率

St

ri

n

g

否

f

a

l

s
e

true、false 

当为 false 时，按照配置参数转码

VideoFp
sAdjMet

hod

Requ

est.Tr
ansC

onfig

视频帧率调
整方式

St

ri
n

g

否 0

取值0、1；当输出视频帧率大于

原视频帧率时，0表示使用原视频
帧率；1表示返回转码失败

当 IsCheckVideoFps 为 true 

时生效
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AdjDarMethod 参数图示：

DeleteM

etadata

Requ

est.Tr

ansC

onfig

是否删除文

件中的

MetaData

信息

St

ri

n

g

否 f

a

l

s
e

true、false 

当为 false 时，保留源文件信息

IsHdr2Sd
r

Requ

est.Tr
ansC

onfig

是否开启

HDR转
SDR

St

ri
n

g

否

f

a

l
s

e

true/false

响应
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>TranscodePro</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransProTpl>

            <Container>

                <Format>mxf</Format>

            </Container>

            <Video>

                <Codec>xavc</Codec>

                <Profile>XAVC-HD_422_10bit</Profile>

                <Width>1920</Width>

                <Height>1080</Height>

                <Interlaced>true</Interlaced>

                <Fps>30000/1001</Fps>

                <Bitrate>50000</Bitrate>

            </Video>

            <Audio>

                <Codec>pcm_s24le</Codec>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransProTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

 

 

Container 节点 TransProTpl 的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） 父节点 描述 类型

Template Response 保存模板详情的容器 Container

RequestId Response 请求的唯一 ID String

Container 节点 Template 的内容：

节点名称（关键字） 父节点 描述 类型

TemplateId Response.Template 模板 ID String

Name Response.Template 模板名称 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 Official String

Tag Response.Template 模板类型，TranscodePro String

UpdateTime Response.Template 更新时间 String

CreateTime Response.Template 创建时间 String

TransProTpl Response.Template 详细的模板参数 Container

节点名称（关键

字）
父节点 描述 类型

TimeInterval
Response.Template.Trans

ProTpl

同请求体中的 

Request.TimeInterval

Contain

er

Container Response.Template.Trans

ProTpl

同请求体中的 

Request.Container

Contain

er
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Video
Response.Template.Trans

ProTpl
同请求体中的 Request.Video

Contain

er

Audio
Response.Template.Trans

ProTpl
同请求体中的 Request.Audio

Contain

er

TransConfig
Response.Template.Trans
ProTpl

同请求体中的 
Request.TransConfig

Contain
er

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>

    </Container>

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

https://cloud.tencent.com/document/product/460/42867
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    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>TranscodePro</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransProTpl>

            <Container>

                <Format>mxf</Format>

            </Container>

            <Video>

                <Codec>xavc</Codec>

                <Profile>XAVC-HD_422_10bit</Profile>

                <Width>1920</Width>

                <Height>1080</Height>

                <Interlaced>true</Interlaced>

                <Fps>30000/1001</Fps>

                <Bitrate>50000</Bitrate>

            </Video>

            <Audio>

                <Codec>pcm_s24le</Codec>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>
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                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransProTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-06-02 17:35:59

更新音视频转码模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

</Request>

节点名称（关键字） 父节点 描述 类型 必选

Request 无 同创建转码模板接口的 Request  Container 是

响应

响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Container>

            <Format>mp4</Format>

        </Container>

        <Video>

            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84733#Request
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具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建转码模板接口的 Response  Container

错误码

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84733#Response
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实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>
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            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Container>

            <Format>mp4</Format>

        </Container>

        <Video>
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            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>
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                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板 转码 pro
最近更新时间：2023-06-02 17:35:41

更新音视频转码 pro 模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>

    </Container>

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

节点名称（关键字） 父节点 描述 类型 必选

Request 无 同创建转码 Pro 模板接口的 Request  Container 是

响应

响应头

响应体

<Response>

    <Template>

        <Tag>TranscodePro</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Container>

            <Format>mxf</Format>

        </Container>

        <Video>

            <Codec>xavc</Codec>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84732#Request
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具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

            <Profile>XAVC-HD_422_10bit</Profile>

            <Width>1920</Width>

            <Height>1080</Height>

            <Interlaced>true</Interlaced>

            <Fps>30000/1001</Fps>

            <Bitrate>50000</Bitrate>

        </Video>

        <Audio>

            <Codec>pcm_s24le</Codec>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建转码 Pro 模板接口的 Response  Container

错误码

实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84732#Response
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    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>

    </Container>

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>TranscodePro</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>
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        <Container>

            <Format>mxf</Format>

        </Container>

        <Video>

            <Codec>xavc</Codec>

            <Profile>XAVC-HD_422_10bit</Profile>

            <Width>1920</Width>

            <Height>1080</Height>

            <Interlaced>true</Interlaced>

            <Fps>30000/1001</Fps>

            <Bitrate>50000</Bitrate>

        </Video>

        <Audio>

            <Codec>pcm_s24le</Codec>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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精彩集锦

提交任务
最近更新时间：2023-01-31 14:14:25

提交一个精彩集锦任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoMontage</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称
（关键字）

父节
点

描述 类型

是

否
必

选

Tag

Re

que
st

创建任务的 Tag：VideoMontage
Strin
g

是

Input

Re

que
st

待操作的文件信息

Cont

aine
r

是

Operation

Re

que

st

操作规则

Cont

aine

r

是

CallBackF

ormat

Re

que

st

任务回调格式，JSON 或 XML，默认 XML，优先级高于

队列的回调格式

Strin

g
否

CallBackT

ype

Re

que

st

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队列

的回调类型

Strin

g
否

CallBack Re

que

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Strin

g

否
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Container 类型 Input 的具体数据描述如下：

：

Container 类型 VideoMontage 的具体数据描述如下：

st

CallBack

MqConfig

Re

que

st

任务回调 TDMQ 配置，当 CallBackType 为 TDMQ 时

必填。详情见 CallBackMqConfig

Cont

aine

r

否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

Container 类型 Operation 的具体数据描述如下

节点名称

（关键字）
父节点 描述 类型

是否

必选

VideoMo

ntage

Request.Op

eration
精彩集锦模板参数

Cont

ainer
否

TemplateI

d

Request.Op

eration
模板 ID

Strin

g
否

Output
Request.Op

eration
结果输出配置

Cont

ainer
是

UserData
Request.Op

eration

透传用户信息, 可打印的 ASCII 码, 长度不超过

1024

Strin

g
否

JobLevel
Request.Op

eration

任务优先级，级别限制：0 、1 、2 。级别越大任

务优先级越高，默认为0

Strin

g
否

注意

优先使用 TemplateId，无 TemplateId 时使用 VideoMontage。

节点名称

（关键字）
父节点 描述 类型

必

选

TimeInter

val

Request.Operation.

Transcode

同创建转码模板接口中的 

Request.TimeInterval  

Contain

er
否

Container
Request.Operation.
Transcode

同创建转码模板接口中的 
Request.Container  

Contain
er

否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
https://cloud.tencent.com/document/product/460/84733#TimeInterval
https://cloud.tencent.com/document/product/460/84733#Container
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Container 类型 Output 的具体数据描述如下：

Request.Operation.Output.Object 支持的通配符如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

Video Request.Operation.

Transcode

同创建转码模板接口中的 

Request.Video  

Contain

er

否

Audio
Request.Operation.

Transcode

同创建转码模板接口中的 

Request.Audio  

Contain

er
否

TransCon
fig

Request.Operation.
Transcode

同创建转码模板接口中的 
Request.TransConfig  

Contain
er

否

Scene
Request.Operation.

Transcode

同创建转码模板接口中的 

Request.Scene  

Contain

er
否

AudioMix
Request.Operation.

Transcode
混音参数, 详情见 AudioMix  

Contain

er 数组
否

AudioMix
Array

Request.Operation.
Transcode

混音参数数组, 最多同时传2个。详情
见 AudioMixArray  

Contain
er 数组

否

说明

 AudioMix 和 AudioMixArray 同时设置时, AudioMixArray 无效。

节点名称（关键字） 父节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储桶 String 是

Object Request.Operation.Output 输出结果的文件名 String 是

通配符 含义

${ext} 封装格式

${jobid} 任务 ID

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84733#Video
https://cloud.tencent.com/document/product/460/84733#Audio
https://cloud.tencent.com/document/product/460/84733#TransConfig
https://cloud.tencent.com/document/product/460/84733#Request
https://cloud.tencent.com/document/product/460/78927#AudioMix
https://cloud.tencent.com/document/product/460/78927#AudioMixArray
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 的内容：

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoMontage</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>videomontage_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container

JobsDetail 
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

节点名称

（关键字）
父节点 描述 类型

Code
Response.J
obsDetail

错误码，只有 State 为 Failed 时有意义
Strin
g

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Strin

g

JobId
Response.J

obsDetail
新创建任务的 ID

Strin

g

Tag
Response.J
obsDetail

新创建任务的 Tag：VideoMontage
Strin
g

State
Response.J

obsDetail

任务的状态，为 Submitted、Running、Success、

Failed、Pause、Cancel 其中一个

Strin

g

Creation

Time

Response.J

obsDetail
任务的创建时间

Strin

g

StartTim
e

Response.J
obsDetail

任务的开始时间
Strin
g

EndTime
Response.J

obsDetail
任务的结束时间

Strin

g

QueueId
Response.J

obsDetail
任务所属的队列 ID

Strin

g

Input
Response.J
obsDetail

该任务的输入资源地址
Cont
ainer

Operatio

n

Response.J

obsDetail
该任务的规则

Cont

ainer

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String
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Container 节点 MediaInfo 的内容： 

同 GenerateMediaInfo  接口中的 Response.MediaInfo 节点。

Container 节点 MediaResult 的内容： 

详情见 MediaResult  

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关
键字）

父节点 描述 类型

VideoMont

age

Response.JobsDetail.O

peration

同请求中的 

Request.Operation.VideoMontag
e

Contai

ner

TemplateId
Response.JobsDetail.O

peration
任务的模板 ID String

TemplateN

ame

Response.JobsDetail.O

peration

任务的模板名称, 当 TemplateId 存在

时返回
String

Output
Response.JobsDetail.O
peration

同请求中的 
Request.Operation.Output

Contai
ner

MediaInfo
Response.JobsDetail.O

peration

转码输出视频的信息，任务未完成时不返

回

Contai

ner

MediaResul

t

Response.JobsDetail.O

peration

输出文件的基本信息，任务未完成时不返

回

Contai

ner

UserData
Response.JobsDetail.O
peration

透传用户信息 String

JobLevel
Response.JobsDetail.O

peration
任务优先级 String

错误码

实际案例

案例一：使用精彩集锦模板 ID

请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

https://cloud.tencent.com/document/product/460/38935
https://cloud.tencent.com/document/product/460/78927#MediaResult
https://cloud.tencent.com/document/product/460/42867
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Content-Type: application/xml

<Request>

    <Tag>VideoMontage</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoMontage</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>
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            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>videomontage_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

案例二：使用精彩集锦处理参数

请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoMontage</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <VideoMontage>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

            </Video>

            <Audio>

                <Codec>aac</Codec>
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                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <Duration>15</Duration>

        </VideoMontage>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoMontage</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <VideoMontage>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Height></Height>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

                <AudioMixArray>

                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3<

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>
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                    <EffectConfig>

                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>

                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>

                </AudioMixArray>

                <AudioMixArray>

                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3<

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                    <EffectConfig>

                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>

                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>

                </AudioMixArray>

                <Duration>15</Duration>

            </VideoMontage>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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任务回调
最近更新时间：2023-02-16 14:21:00

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数

据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:55:05+0800</CreationTime>

        <EndTime>2022-06-30T19:55:19+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j7b0dfbe2f86b11ec995acf5cffaf6664</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>14044.868000</Bitrate>

                    <Duration>2.067000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>3628843</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>126.400000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>
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                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>2.066576</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>14664.836000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>1.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>41</Level>

                        <NumFrames>49</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.086000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容： 

同提交精彩集锦任务接口中的 Response.JobsDetail  

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>6080b31ea94defa6c19cc4def539a291</Md5>

                        <ObjectName>output/videoMontage.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/videoMontage.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/videoMontage.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t164ac18da8bdc403fa27ac4b077a962a1</TemplateId>

            <TemplateName>videoMontage</TemplateName>

            <UserData>This is my VideoMontage job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

        <StartTime>2022-06-30T19:55:05+0800</StartTime>

        <State>Success</State>

        <Tag>VideoMontage</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container数组

https://cloud.tencent.com/document/product/460/84778#jobsDetail
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Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键

字）
父节点 描述 类型

Key
Response.JobsDetail.Input.CosHead

ers

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosHead
ers

自定义 Header 的值
Strin
g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:55:05+0800</CreationTime>

        <EndTime>2022-06-30T19:55:19+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j7b0dfbe2f86b11ec995acf5cffaf6664</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>14044.868000</Bitrate>
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                    <Duration>2.067000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>3628843</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>126.400000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>2.066576</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>14664.836000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>1.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>41</Level>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第834 共1701页

                        <NumFrames>49</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.086000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>6080b31ea94defa6c19cc4def539a291</Md5>

                        <ObjectName>output/videoMontage.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/videoMontage.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/videoMontage.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t164ac18da8bdc403fa27ac4b077a962a1</TemplateId>

            <TemplateName>videoMontage</TemplateName>

            <UserData>This is my VideoMontage job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

        <StartTime>2022-06-30T19:55:05+0800</StartTime>

        <State>Success</State>

        <Tag>VideoMontage</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>
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    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:55:05+0800</CreationTime>

        <EndTime>2022-06-30T19:55:19+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j7b0dfbe2f86b11ec995acf5cffaf6664</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>14044.868000</Bitrate>

                    <Duration>2.067000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>3628843</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>126.400000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>
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                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>2.066576</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>14664.836000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>1.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>41</Level>

                        <NumFrames>49</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.086000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第837 共1701页

                    <Md5Info>

                        <Md5>6080b31ea94defa6c19cc4def539a291</Md5>

                        <ObjectName>output/videoMontage.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/videoMontage.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/videoMontage.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t164ac18da8bdc403fa27ac4b077a962a1</TemplateId>

            <TemplateName>videoMontage</TemplateName>

            <UserData>This is my VideoMontage job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

        <StartTime>2022-06-30T19:55:05+0800</StartTime>

        <State>Success</State>

        <Tag>VideoMontage</Tag>

        <Workflow>

            <Name>VideoMontage_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T19:55:05+0800",

        "EndTime": "2022-06-30T19:55:19+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",
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            "CosHeaders": [{

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j7b0dfbe2f86b11ec995acf5cffaf6664",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "14044.868000",

                    "Duration": "2.067000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "3628843",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": [{

                        "Bitrate": "126.400000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "2.066576",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",
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                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"

                    }],

                    "Video": [{

                        "AvgFps": "25.000000",

                        "Bitrate": "14664.836000",

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10",

                        "CodecName": "h264",

                        "CodecTag": "0x31637661",

                        "CodecTagString": "avc1",

                        "CodecTimeBase": "1/90000",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "1.960000",

                        "Fps": "25.000000",

                        "HasBFrame": "2",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",

                        "Level": "41",

                        "NumFrames": "49",

                        "PixFormat": "yuv420p",

                        "Profile": "High",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.086000",

                        "Timebase": "1/90000",

                        "Width": "544"

                    }]

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": [{

                        "Md5": "6080b31ea94defa6c19cc4def539a291",

                        "ObjectName": "output/videoMontage.mp4"

                    }],

                    "ObjectName": ["output/videoMontage.mp4"],

                    "Region": "ap-chongqing"

                }

            },

            "Output": {
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                "Bucket": "test-123456789",

                "Object": "output/videoMontage.${ext}",

                "Region": "ap-chongqing"

            },

            "TemplateId": "t164ac18da8bdc403fa27ac4b077a962a1",

            "TemplateName": "videoMontage",

            "UserData": "This is my VideoMontage job.",

            "JobLevel": 0

        },

        "QueueId": "p09d709939fef48a0a5c247ef39d90cec",

        "StartTime": "2022-06-30T19:55:05+0800",

        "State": "Success",

        "Tag": "VideoMontage",

        "Workflow": {

            "Name": "VideoMontage_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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创建模版
最近更新时间：2023-07-14 18:11:53

创建精彩集锦模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是
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 Container 类型 Request 的具体数据描述如下：

节点名称

（关键
字）

父节

点
描述 类型

是

否

必
选

限制

Tag

Req

ues
t

模板类型: VideoMontage String 是 无

Name

Req

ues
t

模板名称 仅支持中文、英文、

数字、_、-和*
String 是 无

Duration

Req

ues
t

集锦时长 String 否

1. 默认自动分析时长

2. 单位为秒

3. 支持 float 格式，

执行精度精确到毫

秒

Containe

r

Req
ues

t

容器格式
Contai

ner
是 无

Video
Req
ues

t

视频信息
Contai
ner

是 无

Audio

Req

ues
t

音频信息
Contai
ner

否 无

Scene

Req

ues
t

精彩集锦场景 String 否

1.取值范围：

Soccer/Video，默
认值为Video

AudioMi

x

Req

ues

t

混音参数，详情见 AudioMix  
Contai

ner
否

Audio.Remove 为 

false 时生效

AudioMi

xArray

Req

ues

t

混音参数数组，最多同时传2

个。详情见  AudioMixArray  

Contai

ner数组
否

Audio.Remove 为 

false 时生效

https://cloud.tencent.com/document/product/460/78927#AudioMix
https://cloud.tencent.com/document/product/460/78927#AudioMixArray
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设定 container，音频视频支持的格式如下表：

 

说明

 AudioMix 和 AudioMixArray 同时设置时, AudioMixArray 无效。

Container 类型 Container 的具体数据描述如下：

节点名称（关键

字）
父节点 描述 类型

是否必

选

Format
Request.Contain
er

封装格式: mp4、flv、hls、ts、
mkv

Strin
g

是

Container Audio Codecs Video Codecs

mp4/ts/hls/mkv AAC、MP3 H.264、H.265

flv AAC、MP3 H.264

Container 类型 Video 的具体数据描述如下：

节点名称

（关键字）
父节点 描述 类型

是

否

必

选

默认值 限制

Codec
Request

.Video
编解码格式

Stri

ng
否 H.264

1. H.264

 2.H.265

Width
Request

.Video
宽

Stri

ng
否

视频原

始宽度

1. 值范围：[128，

4096]

2. 单位：px

3. 若只设置 Width 
时，按照视频原始比

例计算 Height

4. 必须为偶数

Height Request

.Video

高 Stri

ng

否 视频原

始高度

1. 值范围：[128，

4096]

2. 单位：px

3. 若只设置 Height 
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时，按照视频原始比

例计算 Width

4. 必须为偶数

Fps
Request

.Video
帧率

Stri

ng
否 无

1. 值范围：(0，60]

2. 单位：fps

Bitrate
Request

.Video

视频输出文

件的码率

Stri

ng
否 无

1. 值范围：[10，

50000]

2. 单位：Kbps

Crf
Request

.Video

码率-质量控

制因子

Stri

ng
否 无

1. 值范围：(0, 51]

2. 如果设置了 Crf，则 

Bitrate 的设置失效

3. 当 Bitrate 为空时，
默认为25

Rotate
Request

.Video
旋转角度

Stri

ng
否 无

1. 值范围：[0, 360)

2. 单位：度

Container 类型 Audio 的具体数据描述如下：

节点名称

（关键字）
父节点 描述

类

型

是

否

必

选

默

认

值

限制

Codec
Request

.Audio

编解码格

式

Str

ing
否

a

a

c

取值 aac、mp3

Samplerat

e

Request

.Audio
采样率

Str

ing
否

4

41

0
0

1. 单位：Hz

2. 可选 11025、22050、

32000、44100、48000、

96000

3. 不同的封装，mp3 支持不同

的采样率，如下表所示

Bitrate
Request
.Audio

原始音频
码率

Str
ing

否 无
1. 单位：Kbps

2. 值范围：[8，1000]

Channels Request

.Audio

声道数 Str

ing

否 无 1. 当 Codec 设置为 aac，支持

1、2、4、5、6、8
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

2. 当 Codec 设置为 mp3，支

持1、2

Remove
Request
.Audio

是否删除
音频流

Str
ing

否
fa
ls

e

取值 true、false

说明

 Y 表示支持这种采样率，N 表示不支持。

封装格式/音频采样率 11025 22050 32000 44100 48000 96000

flv N Y N Y N N

mp4 N Y Y Y Y N

hls/ts/mkv Y Y Y Y Y N

响应

响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>VideoMontage</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

            </Audio>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型
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Response 无 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） 父节点 描述 类型

Template Response 保存模板详情的容器 Container

RequestId Response 请求的唯一 ID String

Container 节点 Template 的内容：

节点名称（关键字） 父节点 描述 类型

TemplateId Response.Template 模板 ID String

Name Response.Template 模板名称 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 Official String

Tag Response.Template 模板类型，VideoMontage String

UpdateTime Response.Template 更新时间 String

CreateTime Response.Template 创建时间 String

VideoMontage Response.Template 详细的模板参数 Container

Container节点VideoMontage的内容：

节点名称（关键

字）
父节点 描述

Duration
Response.Template.VideoMont

age
同请求体中的 Request.Duration

TimeInterval
Response.Template.VideoMont

age

同请求体中的 

Request.TimeInterval

Container
Response.Template.VideoMont

age
同请求体中的 Request.Container
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Video Response.Template.VideoMont

age

同请求体中的 Request.Video

Audio
Response.Template.VideoMont

age
同请求体中的 Request.Audio

Scene
Response.Template.VideoMont
age

同请求体中的 Request.Scene

AudioMix
Response.Template.VideoMont

age
同请求体中的 Request.AudioMix

AudioMixArray
Response.Template.VideoMont

age

同请求体中的 

Request.AudioMixArray

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

https://cloud.tencent.com/document/product/460/42867
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        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>
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        <Tag>VideoMontage</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

            </Audio>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>
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                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-06-02 17:34:52

更新精彩集锦模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 同创建精彩集锦模板接口的 Request  Container 是

响应

https://cloud.tencent.com/document/product/460/84724#Request
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>VideoMontage</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

            </Audio>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <AudioMixArray>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建精彩集锦模板接口的 Response  Container

错误码

实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

    <Container>

        <Format>mp4</Format>

    </Container>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84724#Request


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第857 共1701页

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

响应

HTTP/1.1 200 OK
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Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>VideoMontage</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

            </Audio>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <AudioMixArray>
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                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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画质增强

提交任务
最近更新时间：2023-01-31 14:17:12

提交一个画质增强任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoEnhance</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTemp

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

        <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTem

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称

（关键字）

父节

点
描述 类型

是

否

必
选

Tag

Re

que
st

创建任务的 Tag：VideoEnhance
Strin

g
是

Input

Re

que

st

待操作的文件信息

Cont

aine

r

是

Operation

Re

que

st

操作规则

Cont

aine

r

是

CallBackF

ormat

Re

que

任务回调格式，JSON 或 XML，默认 XML，优先级高于

队列的回调格式

Strin

g

否
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

st

CallBackT

ype

Re

que

st

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队列

的回调类型

Strin

g
否

CallBack

Re

que

st

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Strin

g
否

CallBack

MqConfig

Re
que

st

任务回调 TDMQ 配置，当 CallBackType 为 TDMQ 时

必填。详情见 CallBackMqConfig

Cont
aine

r

否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

Operation

节点名称

（关键字）
父节点 描述 类型

是
否

必

选

VideoEnh

ance

Reques
t.Opera

tion

画质增强模板参数，不能与 TemplateId 同时为空。同

创建画质增强模板接口中的 Request.VideoEnhance  

Cont

ainer
否

Template
Id

Reques
t.Opera

tion

画质增强模板 ID，优先使用模板 ID，不能与 
VideoEnhance 同时为空

Strin
g

否

Waterma

rkTempla
teId

Reques

t.Opera
tion

水印模板 ID，可以传多个水印模板 ID，最多传3个

Strin

g 数
组

否

Waterma
rk

Reques

t.Opera
tion

水印模板参数，同创建水印模板接口中的 
Request.Watermark ，最多传3个

Cont

ainer 
数组

否

DigitalWa

termark

Reques

t.Opera
tion

数字水印参数，详情见 DigitalWatermark  
Cont

ainer
否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
https://cloud.tencent.com/document/product/460/84722#VideoEnhance
https://cloud.tencent.com/document/product/460/84725#Watermark
https://cloud.tencent.com/document/product/460/78927#DigitalWatermark
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Container 类型 Output 的具体数据描述如下：

Request.Operation.Output.Object 支持的通配符如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Output Reques

t.Opera
tion

结果输出配置 Cont

ainer

是

UserData

Reques

t.Opera

tion

透传用户信息， 可打印的 ASCII 码, 长度不超过1024
Strin

g
否

JobLevel

Reques

t.Opera

tion

任务优先级，级别限制：0 、1 、2 。级别越大任务优先

级越高，默认为0

Strin

g
否

说明

 对于画质增强参数，优先使用 TemplateId，无 TemplateId 时使用 VideoEnhance；对于水印参

数，可以使用 WatermarkTemplateId 或 Watermark 设置，WatermarkTemplateId 优先级更

高。

节点名称（关键字） 父节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储桶 String 是

Object Request.Operation.Output 输出结果的文件名 String 是

通配符 含义

${ext} 封装格式

${jobid} 任务 ID

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoEnhance</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

              <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

              <TemplateName>VideoEnhance_demo</TemplateName>

              <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTe

              <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</Watermark

              <DigitalWatermark>

                  <Type>Text</Type>

                  <Message>123456789ab</Message>

                  <State>Running</State>

                  <Version>V1</Version>

                  <IgnoreError>false</IgnoreError>

              </DigitalWatermark>

              <Output>

                  <Region>ap-chongqing</Region>

                  <Bucket>test-123456789</Bucket>

                  <Object>output/out.${ext}</Object>

              </Output>

              <UserData>This is my data.</UserData>

              <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型
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Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container

节点名称

（关键

字）

父节点 描述 类型

Code
Response.

JobsDetail
错误码，只有 State 为 Failed 时有意义

Stri

ng

Messag

e

Response.

JobsDetail
错误描述，只有 State 为 Failed 时有意义

Stri

ng

JobId
Response.

JobsDetail
新创建任务的 ID

Stri

ng

Tag
Response.

JobsDetail
新创建任务的 Tag：VideoEnhance

Stri

ng

State
Response.

JobsDetail

任务的状态，为 Submitted、Running、Success、

Failed、Pause、Cancel 其中一个

Stri

ng

Progres

s

Response.

JobsDetail

任务进度百分比，只有在State为 Submitted、Running、

Success、Pause 时有意义，范围为[0, 100]

Stri

ng

Creatio

nTime

Response.

JobsDetail
任务的创建时间

Stri

ng

StartTi

me

Response.

JobsDetail
任务的开始时间

Stri

ng

EndTim

e

Response.

JobsDetail
任务的结束时间

Stri

ng

QueueI

d

Response.

JobsDetail
任务所属的队列 ID

Stri

ng

Input
Response.

JobsDetail
该任务的输入资源地址

Con

tain

er
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

Operati
on

Response.
JobsDetail

该任务的规则 Con
tain

er

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键

字）
父节点 描述 类型

VideoEnhanc

e

Response.JobsDetai

l.Operation

同请求中的 

Request.Operation.VideoEnha

nce

Contain

er

TemplateId
Response.JobsDetai

l.Operation
任务的模板 ID String

TemplateNam
e

Response.JobsDetai
l.Operation

任务的模板名称, 当 TemplateId 存
在时返回

String

Watermark
Response.JobsDetai

l.Operation

同请求中的 

Request.Operation.Watermark

Contain

er 数组

WatermarkTe

mplateId

Response.JobsDetai

l.Operation
水印模板 ID

String 数

组

Output
Response.JobsDetai
l.Operation

同请求中的 
Request.Operation.Output

Contain
er

MediaInfo
Response.JobsDetai

l.Operation

输出文件的媒体信息，任务未完成时不

返回

Contain

er

MediaResult
Response.JobsDetai

l.Operation

输出文件的基本信息，任务未完成时不

返回

Contain

er

DigitalWaterm
ark

Response.JobsDetai
l.Operation

同请求中的 
Request.Operation.DigitalWate

rmark

Contain
er
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Container 节点 MediaInfo 的内容： 

同 GenerateMediaInfo  接口中的 Response.MediaInfo 节点。

Container 节点 MediaResult 的内容： 

详情见 MediaResult  

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

UserData Response.JobsDetai

l.Operation

透传用户信息 String

JobLevel
Response.JobsDetai

l.Operation
任务优先级 String

错误码

实际案例

请求1：使用超分辨率模板 ID

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoEnhance</Tag>

    <Input>

        <Object>test.${ext}</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTemplat

        <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTemp

        <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTem

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

https://cloud.tencent.com/document/product/460/38935
https://cloud.tencent.com/document/product/460/78927#MediaResult
https://cloud.tencent.com/document/product/460/42867
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        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>je8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoEnhance</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>VideoEnhance_demo</TemplateName>

            <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTem

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTe

            <DigitalWatermark>

                <State>Running</State>

                <Type>Text</Type>

                <Message>123456789ab</Message>
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                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使用超分辨率处理参数

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoEnhance</Tag>

    <Input>

        <Object>test.${ext}</Object>

    </Input>

    <Operation>

        <VideoEnhance>

            <Transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>
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                </Audio>

            </Transcode>

            <SuperResolution>

                <Resolution>sdtohd</Resolution>

                <EnableScaleUp>true</EnableScaleUp>

                <Version>Enhance</Version>

            </SuperResolution>

            <ColorEnhance>

                <Contrast>50</Contrast>

                <Correction>100</Correction>

                <Saturation>100</Saturation>

            </ColorEnhance>

            <MsSharpen>

                <SharpenLevel>5</SharpenLevel>

            </MsSharpen>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>        

        </VideoEnhance>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>水印内容</Text>

                <FontSize>30</FontSize>

                <FontType>simfang.ttf</FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>
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        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应2

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>je8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoEnhance</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

           <VideoEnhance>

                <Transcode>

                    <Container>

                        <Format>mp4</Format>

                    </Container>

                    <Video>

                        <Codec>H.264</Codec>

                        <Bitrate>1000</Bitrate>
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                        <Width>1280</Width>

                        <Fps>30</Fps>

                    </Video>

                    <Audio>

                        <Codec>aac</Codec>

                        <Samplerate>44100</Samplerate>

                        <Bitrate>128</Bitrate>

                        <Channels>4</Channels>

                    </Audio>

                </Transcode>

                <SuperResolution>

                    <Resolution>sdtohd</Resolution>

                    <EnableScaleUp>true</EnableScaleUp>

                    <Version>Enhance</Version>

                </SuperResolution>

                <ColorEnhance>

                    <Contrast>50</Contrast>

                    <Correction>100</Correction>

                    <Saturation>100</Saturation>

                </ColorEnhance>

                <MsSharpen>

                    <SharpenLevel>5</SharpenLevel>

                </MsSharpen>

                <SDRtoHDR>

                    <HdrMode>HDR10</HdrMode>

                </SDRtoHDR>        

            </VideoEnhance>

            <Watermark>

                <Type>Text</Type>

                <LocMode>Absolute</LocMode>

                <Dx>128</Dx>

                <Dy>128</Dy>

                <Pos>TopRight</Pos>

                <StartTime>0</StartTime>

                <EndTime>100.5</EndTime>

                <Text>

                    <Text>水印内容</Text>

                    <FontSize>30</FontSize>

                    <FontType>simfang.ttf</FontType>

                    <FontColor>0xRRGGBB</FontColor>

                    <Transparency>30</Transparency>

                </Text>

            </Watermark>

            <DigitalWatermark>

                <State>Running</State>
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                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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任务回调
最近更新时间：2023-01-31 14:15:50

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数

据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T20:02:17+0800</CreationTime>

        <EndTime>2022-06-30T20:02:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j7d0eafdaf86c11ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>10269.090000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>17526771</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>
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                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>10674.365000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容： 

同提交画质增强任务接口中的 Response.JobsDetail  

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>a825aa6c59371509995a47b570c29297</Md5>

                        <ObjectName>output/video-process.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/video-process.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/video-process.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f4ac18da8bdc403fa27ac4bfn77a62a1</TemplateId>

            <TemplateName>VideoEnhance_12654</TemplateName>

            <UserData>This is my VideoEnhance job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T20:02:18+0800</StartTime>

        <State>Success</State>

        <Progress>100</Progress>

        <Tag>VideoEnhance</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

https://cloud.tencent.com/document/product/436/85017#:~:text=Container%20%E8%8A%82%E7%82%B9-,JobsDetail,-%E7%9A%84%E5%86%85%E5%AE%B9%EF%BC%9A
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如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键

字）
父节点 描述 类型

Key
Response.JobsDetail.Input.CosHead

ers

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosHead

ers
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T20:02:17+0800</CreationTime>

        <EndTime>2022-06-30T20:02:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j7d0eafdaf86c11ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>
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                <Format>

                    <Bitrate>10269.090000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>17526771</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>10674.365000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>
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                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>a825aa6c59371509995a47b570c29297</Md5>

                        <ObjectName>output/video-process.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/video-process.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/video-process.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f4ac18da8bdc403fa27ac4bfn77a62a1</TemplateId>

            <TemplateName>VideoEnhance_12654</TemplateName>

            <UserData>This is my VideoEnhance job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T20:02:18+0800</StartTime>

        <State>Success</State>

        <Progress>100</Progress>

        <Tag>VideoEnhance</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T20:02:17+0800</CreationTime>

        <EndTime>2022-06-30T20:02:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j7d0eafdaf86c11ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>10269.090000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>17526771</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>
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                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>10674.365000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>
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            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>a825aa6c59371509995a47b570c29297</Md5>

                        <ObjectName>output/video-process.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/video-process.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/video-process.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f4ac18da8bdc403fa27ac4bfn77a62a1</TemplateId>

            <TemplateName>VideoEnhance_12654</TemplateName>

            <UserData>This is my VideoEnhance job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T20:02:18+0800</StartTime>

        <State>Success</State>

        <Progress>100</Progress>

        <Tag>VideoEnhance</Tag>

        <Workflow>

            <Name>VideoEnhance_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T20:02:17+0800",

        "EndTime": "2022-06-30T20:02:34+0800",
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        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j7d0eafdaf86c11ecbdf419856486c0ab",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "10269.090000",

                    "Duration": "13.654000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "17526771",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": [{

                        "Bitrate": "128.726000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",
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                        "Duration": "13.652993",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"

                    }],

                    "Video": [{

                        "AvgFps": "24.922840",

                        "Bitrate": "10674.365000",

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Coding)",

                        "CodecName": "hevc",

                        "CodecTag": "0x31766568",

                        "CodecTagString": "hev1",

                        "CodecTimeBase": "1/12800",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "12.960000",

                        "FieldOrder": "progressive",

                        "Fps": "25.000000",

                        "HasBFrame": "2",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",

                        "Level": "93",

                        "NumFrames": "323",

                        "PixFormat": "yuv420p",

                        "Profile": "Main",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.000000",

                        "Timebase": "1/12800",

                        "Width": "544"

                    }]

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": [{

                        "Md5": "a825aa6c59371509995a47b570c29297",

                        "ObjectName": "output/video-process.mp4"

                    }],
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                    "ObjectName": ["output/video-process.mp4"],

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/video-process.${ext}",

                "Region": "ap-chongqing"

            },

            "TemplateId": "t1f4ac18da8bdc403fa27ac4bfn77a62a1",

            "TemplateName": "VideoEnhance_12654",

            "UserData": "This is my VideoEnhance job.",

            "JobLevel": 0

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T20:02:18+0800",

        "State": "Success",

        "Progress": "100",

        "Tag": "VideoEnhance",

        "Workflow": {

            "Name": "VideoEnhance_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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创建模版
最近更新时间：2023-07-14 18:11:52

创建画质增强模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoEnhance</Tag>

    <Name>TemplateName</Name>

    <VideoEnhance>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

 

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

        </Transcode>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <ColorEnhance>

            <Contrast>50</Contrast>

            <Correction>100</Correction>

            <Saturation>100</Saturation>

        </ColorEnhance>

        <MsSharpen>

            <SharpenLevel>5</SharpenLevel>

        </MsSharpen>

        <SDRtoHDR>

            <HdrMode>HDR10</HdrMode>

        </SDRtoHDR>

    </VideoEnhance>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键
字）

父节点 描述 类型
是否必
选

限
制

Tag
Requ

est
模板类型： VideoEnhance String 是 无
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Name Requ

est

模板名称：仅支持中文、英文、数字、

_、-和*

String 是 无

VideoEnhan

ce

Requ

est
画质增强参数

Contain

er
是 无

Container 类型 VideoEnhance 的具体数据描述如下：

节点名称

（关键字）
父节点 描述 类型 是否必选

限

制

Trascod

e

Request.

VideoEnh

ance

转码参

数

Cont

ainer
是 无

SuperRe

solution

Request.

VideoEnh

ance

超分辨

率

Cont

ainer

否，SuperResolution 和 SDRtoHDR 

、 ColorEnhance 、 MsSharpen 不

能同时为空

无

SDRtoH

DR

Request.
VideoEnh

ance

SDR to 

HDR

Cont

ainer

否，SuperResolution 和 SDRtoHDR 
、 ColorEnhance 、 MsSharpen 不

能同时为空

无

ColorEn
hance

Request.
VideoEnh

ance

色彩增
强

Cont
ainer

否，SuperResolution 和 SDRtoHDR 
、 ColorEnhance 、 MsSharpen 不

能同时为空

无

MsSharp
en

Request.

VideoEnh
ance

细节增
强

Cont
ainer

否，SuperResolution 和 SDRtoHDR 

、 ColorEnhance 、 MsSharpen 不
能同时为空

无

Container 类型 Transcode 的具体数据描述如下：

节点名称

（关键字）
父节点 描述 类型

是否

必选
限制

Container
Request.VideoEnhance

.Transcode

容器

格式

Cont

ainer
是 无

Video
Request.VideoEnhance
.Transcode

视频
信息

Cont
ainer

是 无

Audio
Request.VideoEnhance

.Transcode

音频

信息

Cont

ainer
否

不传 Audio，相当于删

除音频信息
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Container 类型 Container 的具体数据描述如下：

节点名称（关键字） 父节点 描述 类型 是否必选

Format Request.Container 封装格式:  mp4/webm String 是

Container 类型 Video 的具体数据描述如下：

节点名

称（关
键字）

父节点
描
述

类
型

是

否
必

选

默认值 限制

Code

c

Request.Vid
eoEnhance.

Transcode.

Video

编

解
码

格

式

St
ri

n

g

否
H.264，当 format 为 

WebM 时，为 VP8

H.264

H.265

VP8 

VP9

Widt

h

Request.Tr
anscode.Vi

deo

宽

St
ri

n

g

否

当 

Request.VideoEnha

nce.SuperResolutio

n 参数为空时，默认值
为视频原始宽度

当 

Request.VideoEnha

nce.SuperResolutio
n 参数不为空时，默认

值为视频原始宽度两倍

值范围：[128, 

4096]

单位：px

若只设置 

Width 时, 按照

视频原始比例计

算 Height 

必须为偶数

Heig

ht

Request.Vid

eoEnhance.

Transcode.
Video

高

St

ri

n
g

否

当 

Request.VideoEnha
nce.SuperResolutio

n 参数为空时，默认值

为视频原始高度

当 
Request.VideoEnha

nce.SuperResolutio

n 参数不为空时，默认

值为视频原始高度两倍

值范围：[128, 
4096]

单位：px

若只设置 

Height 时，按
照视频原始比例

计算 Width

必须为偶数

Fps Request.Vid

eoEnhance.

帧

率

St

ri

否 无 值范围：(0, 

60]
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设定 container，音频视频支持的格式如下表所示：

Transcode.
Video

n
g

 单位：fps 

Container 类型 Audio 的具体数据描述如下：

节点名

称（关

键字）

父节点
描

述

类

型

是

否

必

选

默认值 限制

Code

c

Request.Vi

deoEnhanc

e.Transcod
e.Audio

编

解

码

格
式

St

ri

n
g

否

aac，当 

format 为 

WebM 时，为 
Vorbis

取值 aac、mp3、Vorbis、

opus

Sampl

erate

Request.Vi
deoEnhanc

e.Transcod

e.Audio

采

样

率

St
ri

n

g

否

44100，当 
Codec 为 

opus 时，默

认值为48000

单位：Hz

 可选 8000、11025、
12000、16000、

22050、24000、

32000、44100、

48000、88200、
96000 

不同的封装，mp3 支持不

同的采样率，如下表所示 

当 Codec 设置为 amr 
时，只支持8000 

当 Codec 设置为 opus 

时，仅支持8000，

16000，24000，48000

Bitrat
e

Request.Vi

deoEnhanc
e.Transcod

e.Audio

原

始

音
频

码

率

St

ri
n

g

否 无
单位：Kbps 

值范围：[8，1000]   

Chan

nels

Request.Vi
deoEnhanc

e.Transcod

e.Audio

声

道

数

St
ri

n

g

否 无   -
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Container Audio Codecs Video Codecs

mp4 aac、mp3 H.264、H.265

WebM Vorbis、opus VP8、VP9

Container 类型 ColorEnhance 的具体数据描述如下：

节点名称

（关键字）
父节点

描

述

类

型

是
否

必

选

默
认

值

限制

Contrast
Request.VideoEnha

nce.ColorEnhance

对

比

度

St
ri

n

g

是 无
值范围：[0, 100]，auto

（表示自动分析）

Correctio

n

Request.VideoEnha

nce.ColorEnhance

色

彩

校

正

St

ri

n

g

是 无
值范围：[0, 1000]，

auto（表示自动分析）

Saturatio

n

Request.VideoEnha

nce.ColorEnhance

饱

和

度

St

ri

n

g

是 无
值范围：[0, 300]，

auto（表示自动分析）

Container 类型 MsSharpen 的具体数据描述如下：

节点名称

（关键字）
父节点

描

述

类

型

是

否

必

选

默

认

值

限制

SharpenL

evel

Request.VideoEnha

nce.MsSharpen

增

强

等

级

Stri

ng
是 无

值范围：[0, 10]，auto

（表示自动分析）

Container 类型 SuperResolution 的具体数据描述如下：

节点名称 父节点 描述 类 是 默认值 限
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据, 包含完整节点数据的内容展示如下：

（关键字） 型 否

必

选

制

Resolutio

n

Request.VideoEnhance.

SuperResolution

分辨率选

项

St

ri

n
g

是

1. sdtohd：

标清到超清

2. hdto4k：
高清到4K

-

EnableSc
aleUp

Request.VideoEnhance.
SuperResolution

自动缩放

开关，默
认关闭

St

ri
n

g

否 true、false -

Version
Request.VideoEnhance.

SuperResolution

版本，默
认值 

Base

St
ri

n

g

否

1. Base：基

础版

2. Enhance

：增强版

-

Container 类型 SDRtoHDR 的具体数据描述如下：

节点名称（关
键字）

父节点 描述
类
型

是否
必选

默
认

值

限制

HdrMode
Request.VideoEnhance.S
DRtoHDR

HDR 
标准

stri
ng

是 无

1. HL

G

2. HD

R10

响应

响应头

响应体

<Response>

    <Template>

        <Tag>VideoEnhance</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoEnhance> 

            <transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

            </Transcode>

            <SuperResolution>

                <Resolution>sdtohd</Resolution>

                <EnableScaleUp>true</EnableScaleUp>

                <Version>Enhance</Version>

            </SuperResolution>

            <ColorEnhance>

                <Contrast>50</Contrast>

                <Correction>100</Correction>

                <Saturation>100</Saturation>

            </ColorEnhance>

            <MsSharpen>

                <SharpenLevel>5</SharpenLevel>

            </MsSharpen>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

        </VideoEnhance>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Container 节点 VideoEnhance 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） 父节点 描述 类型

TemplateId Response.Template 模板 ID String

Name Response.Template 模板名称 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 Official String

Tag Response.Template 模板类型，SuperResolution String

UpdateTime Response.Template 更新时间 String

CreateTime Response.Template 创建时间 String

VideoEnhance Response.Template 详细的模板参数 Container

节点名称（关

键字）
父节点 描述 类型

Transcode
Response.Template.Video
Enhance

同请求体中的 
Request.Transcode

Contai
ner

SuperResol

ution

Response.Template.Video

Enhance

同请求体中的 

Request.SuperResolution
String

SDRtoHDR
Response.Template.Video

Enhance

同请求体中的 

Request.SDRtoHDR
String

ColorEnhan
ce

Response.Template.Video
Enhance

同请求体中的 
Request.ColorEnhance

String

MsSharpen
Response.Template.Video

Enhance

同请求体中的 

Request.MsSharpen
String

错误码

https://cloud.tencent.com/document/product/460/42867
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实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoEnhance</Tag>

    <Name>TemplateName</Name>

    <VideoEnhance>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

        </Transcode>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <ColorEnhance>

            <Contrast>50</Contrast>

            <Correction>100</Correction>

            <Saturation>100</Saturation>

        </ColorEnhance>

        <MsSharpen>

            <SharpenLevel>5</SharpenLevel>

        </MsSharpen>

        <SDRtoHDR>
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            <HdrMode>HDR10</HdrMode>

        </SDRtoHDR>

    </VideoEnhance>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>VideoEnhance</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoEnhance> 

            <transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

            </Transcode>

            <SuperResolution>

                <Resolution>sdtohd</Resolution>

                <EnableScaleUp>true</EnableScaleUp>

                <Version>Enhance</Version>
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            </SuperResolution>

            <ColorEnhance>

                <Contrast>50</Contrast>

                <Correction>100</Correction>

                <Saturation>100</Saturation>

            </ColorEnhance>

            <MsSharpen>

                <SharpenLevel>5</SharpenLevel>

            </MsSharpen>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

        </VideoEnhance>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-06-02 17:36:13

更新画质增强模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId>  HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoEnhance</Tag>

    <Name>TemplateName</Name>

    <VideoEnhance>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

        </Transcode>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <ColorEnhance>

            <Contrast></Contrast>

            <Correction></Correction>

            <Saturation></Saturation>

        </ColorEnhance>

        <MsSharpen>

            <SharpenLevel></SharpenLevel>

        </MsSharpen>

        <SDRtoHDR>

            <HdrMode>HDR10</HdrMode>

        </SDRtoHDR>

    </VideoEnhance>

</Request>

节点名称

（关键
字）

父

节
点

描述 类型
是否
必选

Reques

t
无 同创建画质增强模板接口的 Request  

Cont

ainer
是

响应

响应头

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84722#Request
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该响应体返回为 application/xml 数据, 包含完整节点数据的内容展示如下：

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>VideoEnhance</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoEnhance> 

            <transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

            </Transcode>

            <SuperResolution>

                <Resolution>sdtohd</Resolution>

                <EnableScaleUp>true</EnableScaleUp>

                <Version>Enhance</Version>

            </SuperResolution>

            <ColorEnhance>

                <Contrast></Contrast>

                <Correction></Correction>

                <Saturation></Saturation>

            </ColorEnhance>

            <MsSharpen>

                <SharpenLevel></SharpenLevel>

            </MsSharpen>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>
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具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

            </SDRtoHDR>

        </VideoEnhance>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称
（关键

字）

父
节

点

描述 类型

Respon

se
无 同创建画质增强模板接口的 Response  

Contai

ner

错误码

实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoEnhance</Tag>

    <Name>TemplateName</Name>

    <VideoEnhance>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84722#Response
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                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

        </Transcode>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <ColorEnhance>

            <Contrast></Contrast>

            <Correction></Correction>

            <Saturation></Saturation>

        </ColorEnhance>

        <MsSharpen>

            <SharpenLevel></SharpenLevel>

        </MsSharpen>

        <SDRtoHDR>

            <HdrMode>HDR10</HdrMode>

        </SDRtoHDR>

    </VideoEnhance>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>VideoEnhance</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoEnhance> 
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            <transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

            </Transcode>

            <SuperResolution>

                <Resolution>sdtohd</Resolution>

                <EnableScaleUp>true</EnableScaleUp>

                <Version>Enhance</Version>

            </SuperResolution>

            <ColorEnhance>

                <Contrast></Contrast>

                <Correction></Correction>

                <Saturation></Saturation>

            </ColorEnhance>

            <MsSharpen>

                <SharpenLevel></SharpenLevel>

            </MsSharpen>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

        </VideoEnhance>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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AI 内容识别

异步服务和队列配置
开通 AI 内容识别
最近更新时间：2022-08-25 11:06:11

开通 AI 内容识别服务并生成队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

POST /ai_bucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 AiBucket 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

<Response>

    <RequestId>NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x</RequestId>

    <AiBucket>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-09T16:23:11+0800></CreateTime>

    </AiBucket>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

AiBucket Response 存储桶信息 Container

节点名称（关键字） 父节点 描述 类型

BucketId Response.AiBucket 存储桶 ID String

Name Response.AiBucket 存储桶名称，同 BucketId String

Region Response.AiBucket 所在的地域 String

CreateTime Response.AiBucket 创建时间 String

错误码

实际案例

请求

POST /ai_bucket HTTP/1.1

https://cloud.tencent.com/document/product/460/42867
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Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x

<Response>

    <RequestId>NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x</RequestId>

    <AiBucket>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-09T16:23:11+0800></CreateTime>

    </AiBucket>

</Response>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第907 共1701页

查询 AI 内容识别
最近更新时间：2023-06-15 08:59:40

查询 AI 内容识别服务状态。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /ai_bucket HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

名称 描述
类

型

是
否

必

选

region

s

地域信息，例如 ap-shanghai、ap-beijing，若查询多个地域以“,”分隔

字符串，支持中国大陆地域，详情请参见 地域与域名

st

ri

n

g

否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/31066


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第908 共1701页

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

bucket

Names

存储桶名称，以“,”分隔，支持多个存储桶，精确搜索 st

ri

n

g

否

bucket

Name
存储桶名称前缀，前缀搜索

st

ri

n
g

否

pageN

umber
第几页，默认值1

In

t
否

pageSi

ze
每页个数，默认值10

In

t
否

响应

响应头

响应体

<Response>

    <RequestId>NjJmMzY1Y2NfOTBmYTUwNjRfNTA5YV8y</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>5</PageSize>

    <AiBucketList>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-08T16:23:11+0800></CreateTime>

    </AiBucketList>

    <AiBucketList>

        <BucketId>test-1-1234567890</BucketId>

        <Name>test-1-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-09T16:23:11+0800></CreateTime>

    </AiBucketList>

</Response>

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点 AiBucketList 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

TotalCount Response 媒体 Bucket 总数 Int

PageNumber Response 当前页数，同请求中的 pageNumber Int

PageSize Response 每页个数，同请求中的 pageSize Int

AiBucketList Response 媒体 Bucket 列表 Container

节点名称（关键字） 父节点 描述 类型

BucketId Response.AiBucketList 存储桶 ID String

Name Response.AiBucketList 存储桶名称，同 BucketId String

Region Response.AiBucketList 所在的地域 String

CreateTime Response.AiBucketList 创建时间 String

错误码

实际案例

请求

GET /ai_bucket?regions=ap-chongqing&pageSize=5&bucketName=t HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

https://cloud.tencent.com/document/product/460/42867
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzY1Y2NfOTBmYTUwNjRfNTA5YV8y

<Response>

    <RequestId>NjJmMzY1Y2NfOTBmYTUwNjRfNTA5YV8y</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>5</PageSize>

    <AiBucketList>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-08T16:23:11+0800></CreateTime>

    </AiBucketList>

    <AiBucketList>

        <BucketId>test-1-1234567890</BucketId>

        <Name>test-1-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-09T16:23:11+0800></CreateTime>

    </AiBucketList>

</Response>
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查询队列
最近更新时间：2023-06-06 17:28:17

搜索 AI 内容识别队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /ai_queue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称

（关键

字）

描述
类

型

是

否

必

选

queueId

s

队列 ID，以“,”符号分割字符串 S

t

r

i

否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展示

如下：

n

g

state

1. Active 表示队列内的作业会被媒体处理服务调度执行

2. Paused 表示队列暂停，作业不再会被媒体处理调度执行，队列内的所有

作业状态维持在暂停状态，已经执行中的任务不受影响

S
t

r

i

n
g

否

pageNu

mber
第几页，默认值1

S

t
r

i

n

g

否

pageSiz

e
每页个数，默认值10

S

t

r

i
n

g

否

响应

响应头

响应体

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p23f69f4779e64b18aa61e70d5416c071</QueueId>

        <Name>queue-ai-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 QueueList 的内容：

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>AIProcess</Category>

    </QueueList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

TotalCount Response 队列总数 Int

PageNumber Response 当前页数，同请求中的 pageNumber Int

PageSize Response 每页个数，同请求中的 pageSize Int

QueueList Response 队列数组 Container数组

NonExistPIDs Response 不存在的队列 ID 列表 String数组

节点名称（关键字） 父节点 描述 类型

QueueId Response.QueueList 队列 ID String

Name Response.QueueList 队列名字 String

State Response.QueueList 当前状态，Active 或者 Paused String

NotifyConfig Response.QueueList 回调配置 Container
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Container 节点 NotifyConfig 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

MaxSize Response.QueueList 队列最大长度 Int

MaxConcurrent Response.QueueList 当前队列最大并行执行的任务数 Int

Category Response.QueueList 队列类型 String

UpdateTime Response.QueueList 更新时间 String

CreateTime Response.QueueList 创建时间 String

节点名称（关

键字）
父节点 描述 类型

Url
Response.QueueList.No

tifyConfig
回调地址

Stri

ng

State
Response.QueueList.No
tifyConfig

开关状态，On 或者 Off
Stri
ng

Type
Response.QueueList.No

tifyConfig
回调类型，Url

Stri

ng

Event
Response.QueueList.No

tifyConfig

任务完成：TaskFinish；工作流完成：

WorkflowFinish

Stri

ng

ResultFor
mat

Response.QueueList.No
tifyConfig

回调类型，XML 或者 JSON
Stri
ng

错误码

实际案例

请求1：搜索指定队列

GET /ai_queue?queueIds=p23f69f4779e64b18aa61e70d5416c071,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应1

https://cloud.tencent.com/document/product/460/42867
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x

<Response>

    <RequestId>NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x</RequestId>

    <QueueList>

        <QueueId>p23f69f4779e64b18aa61e70d5416c071</QueueId>

        <Name>queue-ai-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>AIProcess</Category>

    </QueueList>

    <NonExistPIDs>A</NonExistPIDs>

    <NonExistPIDs>B</NonExistPIDs>

</Response>

请求2：查询队列列表

GET /ai_queue?pageSize=10&pageNumber=1&category=CateAll HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应2

HTTP/1.1 200 OK
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Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p23f69f4779e64b18aa61e70d5416c071</QueueId>

        <Name>queue-ai-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>AIProcess</Category>

    </QueueList>

</Response>
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更新队列
最近更新时间：2022-09-06 14:09:24

更新 AI 内容识别队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有以下请求体。

功能描述

请求

请求示例

PUT /ai_queue/<queueId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Name>My-Queue-AI</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Request 的内容：

Container 节点 NotifyConfig 的内容：

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选 默认值 限制

Request 无 保存结果的容器 Container 是 无 无

节点名

称（关
键字）

父

节
点

描述
类

型

是

否

必
选

默

认
值

限

制

Nam

e

R

e
q

u

e

st

队列名称，长度不超过128

St

rin

g

是 无 无

State

R

e

q

u
e

st

1. Active 表示队列内的作业会被媒体处理服务调度执行

2.  Paused 表示队列暂停，作业不再会被媒体处理调度

执行，队列内的所有作业状态维持在暂停状态，已经执
行中的任务不受影响

St

rin
g

是 无 无

Notif

yCon

fig

R
e

q

u

e
st

回调配置

C
on

tai

ne

r

是 无 无

节点

名称

（关

键

字）

父节点 描述
类

型
是否必选

默

认

值

限制

State Reques

t.Notify

回调

开

S

tr

否 O

ff

On/Off
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

Config 关，
Off/

On

in
g

Even
t

Reques
t.Notify

Config

回调
事件

S

tr
in

g

当 State=On 
时，必选

无
任务完成：TaskFinish；工作
流完成：WorkflowFinish

Resu

ltFor

mat

Reques

t.Notify

Config

回调

格式

S
tr

in

g

否

X

M

L

JSON/XML

Type

Reques

t.Notify

Config

回调

类型

S

tr

in

g

当 State=On 

时，必选
无 Url 或 TDMQ

Url

Reques

t.Notify

Config

回调

地址

S

tr

in

g

当 State=On，

且 Type=Url 

时，必选

无 不能为内网地址

MqM

ode

Reques

t.Notify

Config

TDM

Q 使

用模
式

S

tr

in
g

当 State=On，

且 

Type=TDMQ 
时，必选

Q

u

e

u
e

主题订阅：Topic 

 队列服务: Queue

MqR
egio

n

Reques
t.Notify

Config

TDM

Q 所
属园

区

S

tr
in

g

当 State=On，

且 
Type=TDMQ 

时，必选

无
目前支持园区 sh（上海）、bj
（北京）、gz（广州）、cd（成

都）、hk（香港）

MqN

ame

Reques
t.Notify

Config

TDM
Q 主

题名

称

S
tr

in

g

当 State=On，
且 

Type=TDMQ 

时，必选

无 无

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42866
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 Queue 的内容：

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p23f69f4779e64b18aa61e70d5416c071</QueueId>

        <Name>My-Queue-AI</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

Queue Response 队列信息 Container

节点名称（关键

字）
父节点 描述 类型

QueueId
Response.Queu
e

队列 ID String

Name
Response.Queu

e
队列名字 String
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

State Response.Queu

e

当前状态，Active 或者 Paused String

NotifyConfig
Response.Queu

e

回调配置，同 

Request.NotifyConfig
Container

MaxSize
Response.Queu
e

队列最大长度 Int

MaxConcurrent
Response.Queu

e
当前队列最大并行执行的任务数 Int

Category
Response.Queu

e
队列类型 String

UpdateTime
Response.Queu

e
更新时间 String

CreateTime
Response.Queu

e
创建时间 String

错误码

实际案例

请求

PUT /ai_queue/p23f69f4779e64b18aa61e70d5416c071 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 162

Content-Type: application/xml

<Request>

    <Name>My-Queue-AI</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

https://cloud.tencent.com/document/product/460/42867
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p23f69f4779e64b18aa61e70d5416c071</QueueId>

        <Name>My-Queue-AI</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>
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图片上色
最近更新时间：2022-12-12 16:31:32

腾讯云数据万象通过 AIImageColoring 接口对黑白图像进行上色。

操作名称：AIImageCrop。

功能描述

注意

使用限制：待处理的图片，原图大小不超过5MB。

1. 下载时处理

请求：

原图存储在 COS：  

GET /<ObjectKey>?ci-process=AIImageColoring HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

处理参数说明

参数 含义 类型 是否必选

ObjectKey 对象文件名，例如：folder/document.jpg。 String 是

ci-process 数据万象处理能力，只能裁剪参固定为 AIImageColoring。 String 是

响应：

HTTP/1.1 200 OK

Content-Type: image/png

Content-Length: 98645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

pic-content

,

[ ]
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处理后的图片直接返回至响应体。

处理后的图片存至存储桶，并以 fileid 字段的值作为对象名称。

2.上传时处理

请求

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

  "is_pic_info": 1

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AIImageColoring"

  

. . . .

{

,

[{

,

}]

}

响应：

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

,

. . . . .

. . . .
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处理后的图片存至存储桶，并以 fileid 字段的值作为对象名称。

响应：

</UploadResult>

3.云上数据处理

请求

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AIImageColoring"

  

. . . .

{

[{

,

}]

}

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

,

. . . . .

. . . .
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</UploadResult>
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图像超分
最近更新时间：2023-08-02 16:17:43

腾讯云数据万象通过 AISuperResolution 接口对图像进行超分辨率处理，当前默认超分为宽高的2倍。

操作名称：AIImageCrop。

功能描述

使用限制

待处理的图片，原图大小不超过5MB，分辨率不得超过 1920px * 1080px。

支持处理JPG PNG JPEG格式图片。

1. 下载时处理

请求：

 原图存储在COS：  

GET /<ObjectKey>?ci-process=AISuperResolution HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

原图来自其他链接：

GET /?ci-process=AISuperResolution&detect-url=<detect-url> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

处理参数说明

参数 含义
类

型

是
否

必

选

Objec
tKey

对象文件名，例如：folder/document.jpg。
Str
ing

否

ci- 数据万象处理能力，只能固定为AISuperResolution。 Str 是
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处理后的图片直接返回至响应体。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。 

除公共头部外，还需要传入如下头部

proce
ss

ing

detec

t-url

您可以通过填写 detect-url 处理任意公网可访问的图片链接。不填写 detect-

url 时，后台会默认处理 ObjectKey ，填写了 detect-url 时，后台会处理 
detect-url 链接，无需再填写 ObjectKey detect-url 示例：

http://www.example.com/abc.jpg ，需要进行 UrlEncode，处理后为

http%25253A%25252F%25252Fwww.example.com%25252Fabc.jpg

。

Str

ing
否

响应：

HTTP/1.1 200 OK

Content-Type: image/png

Content-Length: 98645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

pic-content

,

[ ]

2.上传时处理

请求语法

PUT  /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

说明：

Authorization:Auth String （详情请参见 请求签名  文档）。

请求内容

请求头

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
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Pic-Operations 为 json 格式的字符串，具体参数如下：

rules（json 数组）中每一项具体参数如下：

该请求body内容为待上色图片原图 

[Image Content]

此接口返回公共响应头部，详情请参见 公共响应头部  文档。

头部名称 描述 类型

Pic-Operations 对图片进行操作的参数 String

参数名

称

类

型

是否

必选
描述

is_pic
_info

Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules
Arr

ay
否

处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则不进

行图片处理

参数

名称

类

型

是否必

选
描述

buck

et

Str

ing
否

存储结果的目标存储桶名称，格式为 BucketName-AppId，如果不指定

的话默认保存到当前存储桶

fileid
Str
ing

是

处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg

1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 文

件夹中存储了一个文件名为 test2.jpg 的文件

2.  不以/开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 p1 

文件夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文件名

为 test2.jpg 的文件

3. 注意：请不要以/结尾，否则会产生空文件名

4. 如希望修复后的图片覆盖原图，请将 fileid 字段设置为 ObjectKey

rule
Str

ing
是 处理参数，固定为：ci-process=AISuperResolution

请求体

响应

响应头

https://cloud.tencent.com/document/product/460/42866


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第930 共1701页

该响应体返回content-type为 application/xml 数据，具体的数据内容如下：

UploadResult 的内容：

OriginalInfo 节点内容：

ProcessResults 节点内容：

Object 节点内容：

响应体

节点名称（关键字） 父节点 描述 类型

UploadResult 无 请求结果 Container

节点名称（关键字） 父节点 描述 类型

OriginalInfo UploadResult 原图信息 Container

ProcessResults UploadResult 请求处理结果 Container

节点名称 父节点 描述 类型

Key OriginalInfo 原图文件名 String

Location OriginalInfo 原图路径 String

ETag OriginalInfo 原图ETag值 String

节点名称（关键字） 父节点 描述 类型

Object ProcessResults 每个图片的处理结果 Container

节点名称（关键字） 父节点 描述 类型

Key Object 超分后图片文件名 String

Location Object 超分后的图片链接 String

ETag Object 超分后图片的ETag值 String

Size Object 超分后图片大小 Int

示例：

请求
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

  "is_pic_info": 1

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AISuperResolution"

  

. . . .

{

,

[{

,

}]

}

响应：

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

Server: tencent-ci

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

</UploadResult>

,

. . . . .

. . . .

3.云上数据处理

请求语法
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。 

除公共头部外，还需要传入如下头部

Pic-Operations 为 json 格式的字符串，具体参数如下：

rules（json 数组）中每一项具体参数如下：

POST  /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

说明：

Authorization:Auth String （详情请参见 请求签名  文档）。

请求内容

请求头

头部名称 描述 类型

Pic-Operations 对图片进行操作的参数 String

参数名
称

类
型

是否
必选

描述

is_pic

_info
Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules
Arr

ay
否

处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则不进

行图片处理

参

数

名
称

类

型

是否

必选
描述

bu

ck

et

Str

ing
否

存储结果的目标存储桶名称，格式为 BucketName-AppId，如果不指定的

话默认保存到当前存储桶

file

id

Str

ing

是 处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
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该请求body内容为待上色图片原图 

[Image Content]

此接口返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回content-type为 application/xml 数据，具体的数据内容如下：

UploadResult 的内容：

OriginalInfo 节点内容：

1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 文件夹
中存储了一个文件名为 test2.jpg 的文件

2. 不以/开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 p1 文件

夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文件名为 

test2.jpg 的文件

3. 注意：请不要以/结尾，否则会产生空文件名

4. 如希望修复后的图片覆盖原图，请将 fileid 字段设置为 ObjectKey

rul
e

Str
ing

是 处理参数，固定为：ci-process=AISuperResolution

请求体

响应

响应头

响应体

节点名称（关键字） 父节点 描述 类型

UploadResult 无 请求结果 Container

节点名称（关键字） 父节点 描述 类型

OriginalInfo UploadResult 原图信息 Container

ProcessResults UploadResult 请求处理结果 Container

节点名称 父节点 描述 类型

Key OriginalInfo 原图文件名 String

Location OriginalInfo 原图路径 String

ETag OriginalInfo 原图ETag值 String

https://cloud.tencent.com/document/product/460/42866
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ProcessResults 节点内容：

Object 节点内容：

处理后的图片存至存储桶，并以fileid字段的值作为对象名称。

节点名称（关键字） 父节点 描述 类型

Object ProcessResults 每个图片的处理结果 Container

节点名称（关键字） 父节点 描述 类型

Key Object 超分后图片文件名 String

Location Object 超分后的图片链接 String

ETag Object 超分后图片的ETag值 String

Size Object 图片大小 Int

示例

请求

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AISuperResolution"

  

. . . .

{

[{

,

}]

}

响应：

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

,



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第935 共1701页

Server: tencent-ci

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

</UploadResult>

. . . . .

. . . .
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图像增强
最近更新时间：2023-08-02 16:17:43

腾讯云数据万象通过 AIEnhanceImage 接口对图像进行增强处理。

操作名称：AIImageCrop。

功能描述

注意

使用限制：待处理的图片，原图大小不超过5MB。

1. 下载时处理

请求

原图存储在COS：  

GET /<ObjectKey>?ci-process=AIEnhanceImage&denoise=<denoise>&sharpen=<sha

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

原图来自其他链接：

GET /<ObjectKey>?ci-process=AIEnhanceImage&denoise=<denoise>&sharpen=<sha

Host: <BucketName-APPID> pic <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

处理参数说明

参数 含义
类
型

是

否
必

选

Objec
tKey

对象文件名，例如：folder/document.jpg。
Str
ing

是

ci-

proce

数据万象处理能力，只能固定为 AIEnhanceImage。 Str

ing

是



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第937 共1701页

处理后的图片直接返回至响应体。

ss

denoi

se

去噪强度值，取值范围为 0 - 5 之间的整数，值为 0 时不进行去噪操作，默认值

为3。

Int

eg

er

否

sharp

en 

锐化强度值，取值范围为 0 - 5 之间的整数，值为 0 时不进行锐化操作，默认值

为3。

Int

eg

er

否

detec
t-url 

您可以通过填写 detect-url 处理任意公网可访问的图片链接。不填写 

`detect-url ` 时，后台会默认处理  `ObjectKey ` ，填写了  `detect-url ` 

时，后台会处理  `detect-url` 链接，无需再填写  ObjectKey ,  detect-url  
示例：http://www.example.com/abc.jpg ，需要进行 UrlEncode，处理

后为  

http%25253A%25252F%25252Fwww.example.com%25252Fabc.j

pg

Str
ing

否

ignor

e-

error

当此参数为1时，针对文件过大等导致处理失败的场景，会直接返回原图而不报

错。

Int

eg

er

-

响应

HTTP/1.1 200 OK

Content-Type: image/png

Content-Length: 98645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

pic-content

,

[ ]

2.上传时处理

请求

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

Authorization: Auth String

. . . .
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处理后的图片存至存储桶，并以 fileid 字段的值作为对象名称。

Pic-Operations: 

  "is_pic_info": 1

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AIEnhanceImage"

  

{

,

[{

,

}]

}

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

</UploadResult>

,

. . . . .

. . . .

3.云上数据处理

请求

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

. . . .
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处理后的图片存至存储桶，并以 fileid 字段的值作为对象名称。

响应

Content-length: Size

Authorization: Auth String

Pic-Operations: 

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AIEnhanceImage"

  

{

[{

,

}]

}

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

</UploadResult>

,

. . . . .

. . . .
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图像智能裁剪
最近更新时间：2022-12-14 14:10:59

腾讯云数据万象通过 AIImageCrop 接口对图像进行智能裁剪，支持持久化、云上处理及下载时处理。

操作名称：AIImageCrop。

功能描述

注意

使用限制：待处理的图片，原图大小不超过5MB。

1. 下载时处理

请求：

原图存储在 COS：  

GET /<ObjectKey>?ci-process=AIImageCrop&width=<width>&height=<height>&fixe

Host: <BucketName-APPID> pic <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

原图来自其他链接：

GET /<ObjectKey>?ci-process=AIImageCrop&width=<width>&height=<height>&fixe

Host: <BucketName-APPID> pic <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

处理参数说明

参数 含义
类

型

是
否

必

选

Obje

ctKe

y

对象文件名，例如：folder/document.jpg。
Str

ing
是

ci- 数据万象处理能力，只能裁剪参固定为 AIImageCrop。 Str 是
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处理后的图片直接返回至响应体。

proc

ess

ing

dete

ct-

url

您可以通过填写 `detect-url` 对任意公网可访问的图片进行智能裁剪。不填写 
`detect-url` 时，后台会默认处理  `ObjectKey` ；填写了 `detect-url` 时，

后台会处理 `detect-url` 链接，无需再填写 `ObjectKey` ， `detect-url` 示

例： http://www.example.com/abc.jpg 。

Str

ing
否

widt

h

需要裁剪区域的宽度，与 height 共同组成所需裁剪的图片宽高比例；输入数字请

大于0、小于图片宽度的像素值。

Int

eg

er

是

heig

ht

需要裁剪区域的高度，与 width 共同组成所需裁剪的图片宽高比例；输入数字请
大于0、小于图片高度的像素值；width : height 建议取值在[1, 2.5]之间，超过

这个范围可能会影响效果。

Int
eg

er

是

fixed

是否严格按照 width 和 height 的值进行输出。取值为0时，宽高比例（width : 
height）会简化为最简分数，即如果 width 输入10、height 输入20，会简化

为1：2；取值为1时，输出图片的宽度等于 width，高度等于 height；默认值为

0。

Int
eg

er

否

ignor
e-

error

当此参数为1时，针对文件过大等导致处理失败的场景，会直接返回原图而不报

错。

Int
eg

er

否

响应：

HTTP/1.1 200 OK

Content-Type: image/png

Content-Length: 98645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

pic-content

,

[ ]

2.上传时处理

请求

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com. . . .

http://www.example.com/abc.jpg%E3%80%82
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处理后的图片存至存储桶，并以 fileid 字段的值作为对象名称。

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

  "is_pic_info": 1

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AIImageCrop&width=<width>&height=<height>&fixed=<fixed>

  

{

,

[{

,

}]

}

响应：

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

</UploadResult>

,

. . . . .

. . . .

3.云上数据处理

请求

POST /<ObjectKey>?image_process HTTP/1.1
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处理后的图片存至存储桶，并以 fileid 字段的值作为对象名称。

响应：

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AIImageCrop&width=<width>&height=<height>&fixed=<fixed>

  

. . . .

{

[{

,

}]

}

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

</UploadResult>

,

. . . . .

. . . .
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实时文字翻译
最近更新时间：2023-06-27 15:30:21

腾讯云数据万象通过 AutoTranslationBlock  接口对文字块进行翻译，请求时需要携带签名。

文本翻译

请求语法

GET /?ci-process=AutoTranslationBlock&InputText=<InputText>&SourceLang=<SourceLa

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization:Auth String （详情请参见 请求签名  文档）。

请求内容

参数名

称
描述

类

型

是

否

必

选

ci-

proce

ss

数据万象处理能力，文本块翻译固定为 AutoTranslationBlock。

St

ri

n

g

是

Input

Text
待翻译的文本

St

ri

n
g

是

Sourc

eLang
输入语言，如 "zh"

St

ri

n
g

是

Targe

tLang

输出语言，如 "en" St

ri

是

https://cloud.tencent.com/document/product/436/7778
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SourceLang、TargetLang 可填参数参考这个：

英语 en 阿拉伯语 ar 德语 de 西班牙语 es 法语 fr 印尼语 id 意大利语 it / 日语 ja葡萄牙语 pt 俄语 ru 韩语 ko 高

棉语 km 老挝语 lo

中文 zh 阿拉伯语 ar 德语 de 西班牙语 es 法语 fr 印尼语 id 意大利语 it / 日语 ja葡萄牙语 pt 俄语 ru 韩语 ko 高

棉语 km 老挝语 lo其中，中文除了常规的简体中文（zh）外，还有繁体中文（zh-tr）、中国香港繁体中文（zh-

hk）、中国台湾繁体中文（zh-tw）。

(1) 电商：text_domain=ecommerce

(2) 电商标题: text_domain=ecommerce；text_style=title

(3) 网络文学：text_domain=net-literature

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

n

g

TextD

omain

文本所属业务领域，默认值为general， 其他值如：“ecommerce”（电

商）、“net-literature”（网络文学）、“finance”（金融）

St

ri

n

g

否

TextS

tyle
文本类型，默认值为sentence，其他值如：“title”（标题）

St

ri

n

g

否

中文（代码zh）与下列语言之间的双向互译：

英文（代码en）与下列语言之间的双向互译：

我们已开放了数个专业场景，通过text_domain和text_style参数获得相应能力：

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
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该响应体返回为 application/xml 数据，具体的数据内容如下：

节点名称（关键字） 父节点 描述 类型

TranslationResult 无 翻译结果 StringResponse 的内容：

示例

请求

GET /?ci-process=AutoTranslationBlock&InputText=%E6%88%91%E6%98%AF%E6%B5%8

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: xxxxx

Authorization:XXXXXXXXXXXX

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: xxxxxx

Server: tencent-ci

x-cos-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<TranslationResult>I&apos m testing.</TranslationResult>;
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图像修复
最近更新时间：2022-08-18 17:16:56

对象存储通过数据万象 ImageRepair 接口检测图片中的水印并将其擦除。

操作名称：ImageRepair

功能概述

使用限制

待处理的图片，原图大小不超过32MB。

宽高不超过50000像素且总像素不超过2.5亿像素，处理结果图宽高设置不超过9999像素。

接口示例

GET /<ObjectKey>?ci-process=ImageRepair&MaskPic=<MaskPic> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

处理参数说明

请求参数

参数 含义
类

型

是

否

必
选

Obje

ctKe
y

对象文件名，例如 folder/sample.jpg。

St

ri
n

g

是

ci-
proc

ess

数据万象处理能力，图像修复固定为 ImageRepair。

St

ri
n

g

是

Mas
kPic

遮罩（白色区域为需要去除的水印位置）图片地址，需要经过 URL 安全的 
Base64 编码 。例如，遮罩图片为 

St
ri

n

g

否

https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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内容识别相关接口需要携带签名访问，并与获取参数以“&”连接，示例如下：

http://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/shuiyin_2.png

，则该处编码后的字符串为 

aHR0cDovL2V4YW1wbGVidWNrZXQtMTI1MDAwMDAwMC5jb3MuYXAtc

2hhbmdoYWkubXlxY2xvdWQuY29tL3NodWl5aW5fMi5wbmc

。

Mas

kPol

y

例如：

[[[608, 794], [1024, 794], [1024, 842], [608, 842]],[[1295, 62], [1295, 

30], [1597, 32],[1597, 64]]]

，顺时针输入多边形的每个点的坐标,每个多边形: [[x1, y1], [x2, y2]...] , 形式

为三维矩阵（多个多边形： [多边形1, 多边形2] ）或二维矩阵（单个多边形），

且需要经过 URL 安全的 Base64 编码 。MaskPoly 同时与 MaskPic 填写
时，优先采用 MaskPic 的值。

St
ri

n

g

否

实际案例

案例一：私有读、携带签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature> 为签名部分，获取方式请参考 请求签名 。

https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/436/7778
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Logo 识别
最近更新时间：2022-08-30 11:08:56

 对象存储通过数据万象 RecognizeLogo 接口实现对图片内电商 Logo 的识别，返回图片中 Logo 的名称、坐

标、置信度分值。

功能概述

注意

 当前 Logo 识别的图片限制为：图片格式支持 PNG、JPEG、JPG，图片大小不超过10MB，图片宽高

大于50像素 x 50像素。

请求语法

GET /?ci-process=RecognizeLogo&detect-url=<detect-url> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求内容

参数名

称
描述

类

型

是
否

必

选

Object
Key

对象文件名，例如：folder/document.jpg。
Str
ing

是

ci-

proces
s

数据万象处理能力，Logo 识别固定为 RecognizeLogo。
Str

ing
是

detect

-url
您可以通过填写 detect-url  处理任意公网可访问的图片链接。不填写 

detect-url  时，后台会默认处理 ObjectKey  ，填写了 detect-url  时，

后台会处理 detect-url  链接，无需再填写 ObjectKey detect-url  示例：

Str

ing

否

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，具体的数据内容如下：

Response 的内容：

http://www.example.com/abc.jpg  ，需要进行 UrlEncode，处理后为

http%25253A%25252F%25252Fwww.example.com%25252Fabc.jp

g

。

ignore

-error

当此参数为1时，针对文件过大等导致处理失败的场景，会直接返回原图而不报

错。
int 否

注意

通过 ObjectKey 进行商品抠图为内网操作，不会产生额外的外网流量。

通过 detect-url 进行商品抠图，会产生图片所在源站对应的外网流量。

请求头

请求体

响应

响应头

响应体

节点名称（关键字） 父节点 描述 类型

RecognitionResult 无 保存 Logo 识别结果的容器。 Container

节点名称（关键
字）

父节点 描述 类型

Status
RecognitionRes

ult

Logo 识别结果。0表示未识别到，1表示识

别到。
Int

LogoInfo
RecognitionRes

ult
Logo 识别结果，可能有多个。

Contain

er

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
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LogoInfo 节点内容：

Location 节点内容：

内容识别相关接口需要携带签名访问，并与获取参数以“&”连接，示例如下：

节点名称（关键

字）
父节点 描述 类型

Name
LogoInf

o
Logo 的名称。 String

Sorce
LogoInf

o

Logo 的置信度，取值范围为[0-100]。值越高概率越

大。
String

Location
LogoInf

o
图中识别到 Logo 的坐标。

Containe

r

节点名称（关键字） 父节点 描述 类型

Point Location Logo 坐标点（X 坐标，Y 坐标）。 String

实际案例

案例一：对存储桶内的图片进行 Logo 识别

https://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorit

说明

<signature> 为签名部分，获取方式请参考 请求签名 。

响应示例

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: xxxxxx

Server: tencent-ci

x-cos-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<RecognitionResult>

    <Status>1</Status>

    <LogoInfo>

      <Name>xxxxxxxx</Name>

https://cloud.tencent.com/document/product/436/7778
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将第三方图片（链接为 http://www.example.com/abc.jpg ）在下载时进行 Logo 识别，示例如下：

      <Sorce>99</Sorce>

      <Location>

        <Point>100,100</Point>

        <Point>100,200</Point>

        <Point>200,200</Point>

        <Point>200,100</Point>

      </Location>

    </LogoInfo>

    <LogoInfo>

      <Name>xxxxxxxx</Name>

      <Sorce>95</Sorce>

      <Location>

        <Point>1000,1000</Point>

        <Point>1000,2000</Point>

        <Point>2000,2000</Point>

        <Point>2000,1000</Point>

      </Location>

    </LogoInfo>

</RecognitionResult>

案例二：对第三方图片进行 Logo 识别

https://examples-1251000004.cos.ap-shanghai.myqcloud.com/?q-sign-algorithm=<signa
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图片二维码识别
最近更新时间：2023-07-20 10:04:51

对象存储二维码识别功能可识别图片中有效二维码的位置及内容，输出图像中二维码包含的文本信息（每个二维码对

应的 URL 或文本），并可对识别出的二维码添加马赛克。

图片上传时识别二维码的请求包与 COS 简单上传文件接口一致，只需在请求包头部增加图片处理参数 Pic-

Operations，并将请求 Host 更改为对象存储域名即可。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

此接口无请求参数。

Pic-Operations 为 json 格式的字符串，具体参数如下：

功能描述

请求一：上传时识别

请求示例

PUT /<ObjectKey> HTTP/1.1 

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date 

Authorization: Auth String 

Pic-Operations: <PicOperations> 

说明

COS 简单上传文件接口，详细请参见 PUT Object 文档 。

Authorization: Auth String （详细请参见 请求签名  文档）。

请求头

请求参数

请求体

参数名

称
描述

类

型

是否

必选

is_pic
_info

是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0
In
t

否

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7749
https://cloud.tencent.com/document/product/436/7778
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rules（json 数组）中每一项具体参数如下：

使用二维码识别功能需在 rule 中添加二维码识别参数（QRcode），相关内容如下：

示例参数说明如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

rules 处理规则，一条规则对应一个处理结果（目前最多支持五条规则），不填则

不进行图片处理

Ar

ra
y

否

参数
名称

描述
类
型

是否
必选

buc
ket

存储结果的目标存储桶，格式为 BucketName-APPID，如果不指定的话默
认保存到当前存储桶

St

ri
n

g

否

filei

d

处理结果的文件路径名称，例如以 / 开头，则存入指定文件夹中，否则存入与原

图文件相同的目录位置

St
ri

n

g

否

rule

处理参数，参见对象存储图片处理 API。若按指定样式处理，则以 style/ 开

头，后加样式名。

例如样式名为 test ，则 rule 字段为 style/test

St
ri

n

g

是

QRcode/cover/<mode>

参

数
描述

类

型

是否必

选

co

ver

二维码覆盖功能。可为0或1。

功能开启后，将对识别出的二维码覆盖上马赛克，默认值0

0表示不开启二维码覆盖

1表示开启二维码覆盖

In

t
否

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/7729
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响应体具体数据内容如下： 

UploadResult 节点内容： 

OriginalInfo 节点内容： 

ImageInfo 节点内容： 

ProcessResults 节点内容： 

Object 节点内容： 

参数名称 类型 描述

UploadResult Container 原图信息

参数名称 类型 描述

OriginalInfo Container 原图信息

ProcessResults Container 图片处理结果

节点名称 类型 描述

Key String 原图文件名

Location String 图片路径

ImageInfo Container 原图图片信息

节点名称 类型 描述

Format String 格式

Width Int 图片宽度

Height Int 图片高度

Quality Int 图片质量

Ave String 图片主色调

Orientation Int 图片旋转角度

节点名称 类型 描述

Object Container 每一个图片处理结果
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QRcodeInfo 节点内容： 

codelocation 节点内容：

节点名称 类型 描述

Key String 文件名

Location String 图片路径

Format String 图片格式

Width Int 图片宽度

Height Int 图片高度

Size Int 图片大小

Quality Int 图片质量

codeStatus Int 二维码识别结果。0表示未识别到二维码，1表示识别到二维码

QRcodeInfo Container 二维码识别结果，可能有多个

节点名称 类型 描述

codeUrl String 二维码的内容。可能识别不出

codelocation Container 图中识别到的二维码位置坐标

节点名称 类型 描述

point String 二维码坐标点

实际案例

请求

PUT /picture.jpg HTTP/1.1 

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2018 09:06:15 GMT 

Authorization:XXXXXXXXXXXX 

Pic-Operations: "is_pic_info":1,"rules": "fileid":"test.jpg","rule":" QRcode/cover/1"  { [{ }]}
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Content-Length: 64 

Object  [ ]

响应

HTTP/1.1 200 OK 

Content-Type: application/xml 

Content-Length: 645 

Date: Tue, 03 Apr 2018 09:06:16 GMT 

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

      <OriginalInfo>

        <Key>picture.jpg</Key>

        <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/picture.jpg<

        <ImageInfo>

               <Format>JPEG</Format>

               <Width>640</Width>

               <Height>427</Height>

               <Quality>100</Quality>

               <Ave>0xa18454</Ave>

               <Orientation>1</Orientation>

        </ImageInfo>

      </OriginalInfo>

      <ProcessResults>

        <Object>

           <Key>picture-2.jpg</Key>

           <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/picture-2.

           <Format>png</Format>

           <Width>640</Width>

           <Height>427</Height>

           <Size>463092</Size>

           <Quality>100</Quality>

           <codeStatus>1</codeStatus>

           <QRcodeInfo>

              <codeUrl>xxxxxxxxxxxxx</codeUrl>

              <codelocation>

                  <point>100,100</point>
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

                  <point>100,200</point>

                  <point>200,200</point>

                  <point>200,100</point>

              </codelocation>

              </QRcodeInfo>

                  <codeUrl>xxxxxxxxxxxxx</codeUrl>

                  <codelocation>

                      <point>1000,1000</point>

                      <point>1000,2000</point>

                      <point>2000,2000</point>

                      <point>2000,1000</point>

                  </codelocation>

        </Object>

    </ProcessResults>

</UploadResult>

请求二：下载时识别

请求示例

GET /<ObjectKey>?ci-process=QRcode&cover=<cover> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求头

请求参数

参数名

称
描述

是否

必选

类

型

Object
Key

对象文件名，例如 folder/sample.jpg 是
Str
ing

ci-

proces

s

万象处理能力，二维码识别固定为 QRcode 是
Str

ing

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
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该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Response 的内容：

cover 二维码覆盖功能，将对识别出的二维码覆盖上马赛克。取值为0或1。0表示

不开启二维码覆盖，1表示开启二维码覆盖，默认值0

否 Int

请求体

响应

响应头

响应体

<Response>

       <CodeStatus>1</CodeStatus>

       <QRcodeInfo>

             <CodeUrl>xxxx</CodeUrl>

             <CodeLocation>

                   <Point>xxx,xxx</Point>

                   <Point>xxx,xxx</Point>

                   <Point>xxx,xxx</Point>

                   <Point>xxx,xxx</Point>

             </CodeLocation>

       </QRcodeInfo>

       <ResultImage>

            base64编码的图片

       </ResultImage>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

CodeStatus
Respon

se

二维码识别结果。0表示未识别到二维码，1表示识别到

二维码
Int

https://cloud.tencent.com/document/product/436/7729
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QRcodeInfo 节点内容：

CodeLocation 节点内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

QRcodeInfo
Respon

se
二维码识别结果，可能有多个

Contain

er

ResultImage
Respon

se

处理后的图片 base64数据，请求参数 cover 为1时

返回
String

节点名称（关键字） 父节点 描述 类型

CodeUrl QRcodeInfo 二维码的内容。可能识别不到内容 String

CodeLocation QRcodeInfo 图中识别到的二维码位置坐标 Container

节点名称（关键字） 父节点 描述 类型

Point CodeLocation 二维码坐标点（X坐标，Y坐标） String

错误码

实际案例

请求

GET /<ObjectKey>?ci-process=QRcode&cover=1 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-s

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-cos-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

        <CodeStatus>1</CodeStatus>

https://cloud.tencent.com/document/product/460/42867
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           <QRcodeInfo>

               <CodeUrl>xxxxxxxxxxxxx</CodeUrl>

               <CodeLocation>

                      <Point>100,100</Point>

                <Point>100,200</Point>

                <Point>200,200</Point>

                <Point>200,100</Point>

               </CodeLocation>

        </QRcodeInfo>

           <QRcodeInfo>

                <CodeUrl>xxxxxxxxxxxxx</CodeUrl>

                <CodeLocation>

                <Point>1000,1000</Point>

                <Point>1000,2000</Point>

                <Point>2000,2000</Point>

                <Point>2000,1000</Point>

             </CodeLocation>

        </QRcodeInfo>

        <ResultImage>

           base64编码的图片

        </ResultImage>

</Response>
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图片二维码生成
最近更新时间：2023-07-20 10:04:52

对象存储二维码生成功能可根据用户指定的文本信息（URL 或文本），生成对应的二维码或条形码。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能描述

请求

请求示例

GET /?ci-process=qrcode-generate&qrcode-content=<qrcode-content>&mode=<mode>

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

请求参数

参数名称 描述 类型
是否必

选

ci-process 对象存储处理能力，二维码生成参数为 qrcode-generate
Strin

g
是

qrcode-
content

可识别的二维码文本信息
Strin
g

是

mode
生成的二维码类型，可选值：0或1。0为二维码，1为条形码，

默认值为0
Int 否

width 指定生成的二维码或条形码的宽度，高度会进行等比压缩
Strin

g
是

请求头

请求体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

响应

响应头

响应体

<Response>

        <ResultImage>

            base64编码的图片

        </ResultImage>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

ResultImage Response 二维码图片 base64 数据 String

错误码

实际案例

请求

GET /?ci-process=qrcode-generate&qrcode-content=<https://www.example.com>&mode

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 09:35:16 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0****&q-sign-tim

响应

HTTP/1.1 200 OK

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/42867
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Content-Type: application/xml

Content-Length: 414641

Date: Fri, 10 Apr 2020 09:35:16 GMT

Server: tencent-ci

x-cos-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

        <ResultImage>

            base64编码的图片
        </ResultImage>

</Response>
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图片标签
最近更新时间：2021-05-19 16:02:17

图片标签功能通过借助对象存储的持久化处理接口，实现对 COS 存量数据的图片标签识别，返回图片中置信度较

高的主题标签。图片标签识别请求包属于 GET 请求，请求时需要携带签名。

响应包体具体数据内容如下：

RecognitionResult 节点内容：

功能概述

注意

 当前内容识别的图片限制为：图片格式支持 PNG、JPEG、JPG，图片大小不超过3MB，图片宽高大于

50像素 x 50像素。

请求语法

GET /<ObjectKey>?ci-process=detect-label HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Authorization:Auth String （详情请参见 请求签名  文档）。

请求内容

参数名称 类型 是否必选 描述

ObjectKey string 是 对象文件名，例如 picture.jpg

返回内容

参数名称 类型 描述

RecognitionResult Container 图片标签识别结果

参数名称 类型 描述

https://cloud.tencent.com/document/product/436/7778
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标签信息中包含如下内容：

Labels Container 标签信息

参数名称 类型 描述

Confidence Int 该标签的置信度分数，分数越高则该标签准确度越高

Name String 识别出的图片标签

示例

请求

GET /picture.jpg?ci-process=detect-label HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2019 09:06:15 GMT

Authorization:XXXXXXXXXXXX

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<RecognitionResult>

    <Labels>

        <Confidence>88</Confidence>

        <Name>玩具</Name>

    </Labels>

    <Labels>

        <Confidence>87</Confidence>

        <Name>毛绒玩具</Name>

    </Labels>

    <Labels>

        <Confidence>77</Confidence>

        <Name>泰迪熊</Name>

    </Labels>

    <Labels>

        <Confidence>74</Confidence>

        <Name>纺织品</Name>
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    </Labels>

    <Labels>

        <Confidence>15</Confidence>

        <Name>艺术</Name>

    </Labels>

</RecognitionResult>
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图片质量评分
最近更新时间：2023-07-31 16:55:32

图片质量评估功能为同步请求方式，您可以通过本接口对图片文件进行检测，从多方面评估，最终给出综合客观的清

晰度评分和主观的美观度评分。该接口属于 GET 请求。

功能描述

费用说明

成功调用接口会产生 图片质量评估费用  和 COS 读请求费用 。

如果图片属于 COS 上的低频存储类型，成功调用接口会产生 COS 低频数据取回费用 。

不支持对 COS 上的归档存储类型和深度归档存储类型的图片进行处理，如果需要处理此类型图片，请先 恢复归

档文件 。

限制说明

图片支持格式：PNG、JPG、JPEG。

图片大小：所下载图片经 Base64 编码后不超过4MB。

图片像素：建议大于50 * 50像素，否则影响识别效果。

长宽比：建议长边与短边的比例小于5:1。

调用接口需携带签名，具体规则请参见 请求签名  文档。

请求

请求示例

GET /<ObjectKey>?ci-process=AssessQuality HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

 Authorization: Auth String （详情请参见 请求签名  文档）。

请求参数

参数名称 描述 类型 是否必选

ObjectKey 对象文件名，例如：folder/document.jpg。 String 是

https://cloud.tencent.com/document/product/436/58964#.E5.9B.BE.E7.89.87.E8.B4.A8.E9.87.8F.E8.AF.84.E4.BC.B0.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第969 共1701页

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Response 的内容：

ci-process 数据万象处理能力，图像质量检测固定为 AssessQuality。 String 是

请求头

请求体

响应

响应头

响应体

<Response>

  <LongImage>FALSE</LongImage>

  <BlackAndWhite>FALSE</BlackAndWhite>

  <SmallImage>FALSE</SmallImage>

  <BigImage>TRUE</BigImage>

  <PureImage>FALSE</PureImage>

  <ClarityScore>89</ClarityScore>

  <AestheticScore>70</AestheticScore>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器。 Container

参数名称 描述 类型

LongIma
ge

取值为 TRUE 或 FALSE，TRUE 为长图，FALSE 为正常图，长图定义为长宽
比大于等于3或小于等于1/3的图片。

Boo
lea

n

BlackAn 取值为 TRUE 或 FALSE，TRUE 为黑白图，FALSE 为否。黑白图即灰度图， Boo

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

dWhite 指红绿蓝三个通道都是以灰度色阶显示的图片，并非视觉上的“黑白图片”。 lea

n

SmallIm
age

取值为 TRUE 或 FALSE，TRUE 为小图，FALSE 为否, 小图定义为最长边小
于179像素的图片。当一张图片被判断为小图时，不建议做推荐和展示，其他字段

统一输出为0或 FALSE。

Boo
lea

n

BigImag
e

取值为 TRUE 或 FALSE，TRUE 为大图，FALSE 为否，定义为最短边大于
1000像素的图片

Boo
lea

n

PureIma
ge

取值为 TRUE 或 FALSE，TRUE 为纯色图或纯文字图，即没有内容或只有简单
内容的图片，FALSE 为正常图片。

Boo

lea
n

ClarityS

core

综合评分。图像清晰度的得分，对图片的噪声、曝光、模糊、压缩等因素进行综合

评估，取值为[0, 100]，值越大，越清晰。一般大于50为较清晰图片，标准可以自
行把握。

Inte

ger

Aestheti

cScore

综合评分。图像美观度得分，从构图、色彩等多个艺术性维度评价图片，取值为[0, 

100]，值越大，越美观。一般大于50为较美观图片，标准可以自行把握。

Inte

ger

RequestI

d
唯一请求 ID，每次请求都会返回。定位问题时需要提供该次请求的 RequestId。

Stri

ng

错误码

实际案例

请求

GET /<ObjectKey>?ci-process=AssessQuality HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 03 Apr 2019 09:06:15 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

https://cloud.tencent.com/document/product/436/7730
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x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<Response>

  <LongImage>FALSE</LongImage>

  <BlackAndWhite>FALSE</BlackAndWhite>

  <SmallImage>FALSE</SmallImage>

  <BigImage>TRUE</BigImage>

  <PureImage>FALSE</PureImage>

  <ClarityScore>89</ClarityScore>

  <AestheticScore>70</AestheticScore>

  <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

</Response>
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人脸识别
人脸检测
最近更新时间：2023-07-20 16:06:22

人脸检测功能为同步请求方式，您可以通过本接口检测图片中的人脸位置。该接口属于 GET 请求。

功能描述

费用说明

成功调用接口会产生 人脸检测费用  和 COS 读请求费用 。

如果图片属于 COS 上的低频存储类型，成功调用接口会产生 COS 低频数据取回费用 。

不支持对 COS 上的归档存储类型和深度归档存储类型的图片进行处理，如果需要处理此类型图片，请先 恢复归

档文件 。

限制说明

图片支持格式：PNG、JPG、JPEG、BMP。

图片大小：所下载图片经 Base64 编码后不超过5MB。

图片像素：JPG 格式长边像素不可超过4000，其他格式图片长边像素不可超过2000。

调用接口需携带签名，具体规则请参见 请求签名  文档。

请求

请求示例

GET /<ObjectKey>?ci-process=DetectFace&max-face-num=<FaceNum> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求参数

参数名称 描述 类

型

是

否

https://cloud.tencent.com/document/product/436/58964#.E4.BA.BA.E8.84.B8.E8.AF.86.E5.88.AB.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

必

选

ObjectK

ey
对象文件名，例如：folder/document.jpg。

Str

ing
是

ci-
process

数据万象处理能力，人脸特效固定为 DetectFace。
Str
ing

是

max-

face-
num

最多处理的人脸数目。默认值为1（仅检测图片中面积最大的那张人脸），最

大值为120。此参数用于控制处理待检测图片中的人脸个数，值越小，处理
速度越快。

Int

eg
er

否

请求头

请求体

响应

响应头

响应体

<Response>

    <ImageWidth>616</ImageWidth>

    <ImageHeight>442</ImageHeight>

    <FaceModelVersion>3.0</FaceModelVersion>

    <RequestId>NjEzZjBlZGRfOTBmYTUwNjRfZWUx****</RequestId>

    <FaceInfos>

        <X>312</X>

        <Y>-5</Y>

        <Width>117</Width>

        <Height>173</Height>

    </FaceInfos>

</Response>

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7728
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Response 的内容：

FaceInfos 节点的内容：

以下仅列出了接口业务逻辑相关的错误码，其他错误信息请参见 错误码  文档。

Response 无 保存结果的容器。 Container

节点名称（关键

字）
父节点 描述 类型

ImageWidth
Respo

nse
请求的图片宽度。

Intege

r

ImageHeight
Respo
nse

请求的图片高度。
Intege
r

FaceModelV

ersion

Respo

nse
人脸识别所用的算法模型版本。 String

RequestId
Respo

nse

唯一请求 ID，每次请求都会返回。定位问题时需要提供该次

请求的 RequestId。
String

FaceInfos
Respo
nse

人脸信息列表。包含人脸坐标信息。
Contai
ner

节点名称

（关键字）

父节

点
描述

类

型

X
Face
Infos

人脸框左上角横坐标。人脸框包含人脸五官位置并在此基础上进行一定
的扩展，若人脸框超出图片范围，会导致坐标负值。

Int

eg
er

Y
Face

Infos

人脸框左上角纵坐标。人脸框包含人脸五官位置并在此基础上进行一定

的扩展，若人脸框超出图片范围，会导致坐标负值。

Int

eg
er

Width
Face

Infos
人脸框宽度。

Int

eg

er

Height
Face

Infos
人脸框高度。

Int

eg

er

错误码

https://cloud.tencent.com/document/product/436/7730
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错误码 描述

FailedOperation.ConflictOperation 操作冲突，请勿同时操作相同的 Person。

FailedOperation.GroupInDeletedState 当前组正处于删除状态，请等待。

FailedOperation.GroupPersonMapExist 组中已包含对应的人员 ID。

FailedOperation.GroupPersonMapNotExist 组中不包含对应的人员 ID。

FailedOperation.ImageDecodeFailed 图片解码失败。

FailedOperation.ImageDownloadError 图片下载错误。

FailedOperation.ImageFacedetectFailed 人脸检测失败。

FailedOperation.ImageResolutionExceed 图片分辨率过大。

FailedOperation.ImageResolutionTooSmall 图片短边分辨率小于64。

FailedOperation.ImageSizeExceed
base64编码后的图片数据大小不超过

5MB。

FailedOperation.RequestLimitExceeded 请求频率超过限制。

FailedOperation.RequestTimeout 后端服务超时。

FailedOperation.ServerError 算法服务异常，请重试。

InternalError 内部错误。

InvalidParameter.InvalidParameter 参数不合法。

InvalidParameterValue.AccountFaceNumExcee

d
账号脸数量超出限制。

InvalidParameterValue.FaceModelVersionIllega
l

算法模型版本不合法。

InvalidParameterValue.ImageEmpty 图片为空。

InvalidParameterValue.LimitExceed 返回数量超出限制。

InvalidParameterValue.NoFaceInPhoto 图片中没有人脸。

InvalidParameterValue.UrlIllegal URL 格式不合法。

LimitExceeded.ErrorFaceNumExceed 人脸个数超过限制。
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MissingParameter.ErrorParameterEmpty 必选参数为空。

ResourceUnavailable.Freeze 账号已被冻结。

ResourceUnavailable.InArrears 账号已欠费。

ResourceUnavailable.LowBalance 余额不足。

ResourceUnavailable.StopUsing 账号已停服。

ResourceUnavailable.UnknownStatus 计费状态未知。

ResourcesSoldOut.ChargeStatusException 计费状态异常。

UnsupportedOperation.UnknowMethod 未知方法名。

实际案例

请求

GET /test.jpg?max-face-num=1&ci-process=detect-face HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <ImageWidth>616</ImageWidth>

    <ImageHeight>442</ImageHeight>

    <FaceModelVersion>3.0</FaceModelVersion>

    <RequestId>NjEzZjBlZGRfOTBmYTUwNjRfZWUxXzE=</RequestId>

    <FaceInfos>

        <X>312</X>

        <Y>-5</Y>

        <Width>117</Width>

        <Height>173</Height>

    </FaceInfos>

    <FaceInfos>
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        <X>600</X>

        <Y>-5</Y>

        <Width>117</Width>

        <Height>173</Height>

    </FaceInfos>

</Response>
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人脸特效
最近更新时间：2023-07-20 16:06:22

人脸特效支持人脸美颜、人脸性别变换、人脸年龄变化、人像分割的特效功能，适用于社交娱乐、广告营销、互动传

播等场景。

功能描述

功能 说明

人脸美颜
可用于自拍照片等人像美化场景，上传照片即可一键智能实现美白、磨皮、瘦脸、大眼、美

型，支持自定义调整参数，帮助提升个人形象

人脸性别
变换

用户上传一张人脸图片，基于人脸编辑与生成算法，输出一张人脸性别转换的图片。男变女可
实现美颜、淡妆、加刘海和长发的效果；女变男可实现加胡须、变短发的效果

人脸年龄

变化

用户上传一张人脸图片，基于人脸编辑与生成算法，输出一张人脸变老或变年轻的图片，支持

实现人脸不同年龄的变化

人像分割
指对图片中的人体轮廓范围进行识别，将其与背景进行分离，返回分割后的二值图、灰度图、

前景人像图。可应用于人像抠图、照片合成、人像特效等场景，极大提升工具效率

说明

当前人脸特效的图片限制为：图片 base64 编码后大小不可超过5MB。支持 PNG、JPG、JPEG、

BMP 格式，不支持 GIF 图片。当使用人像分割时，图片分辨率须小于2000px × 2000px。

人脸特效为付费服务，计费详情请查看 人脸特效费用 ，数据万象在每个账户首次产生该服务用量后，将

发放一个用量为6000次，有效期为2个月的免费额度资源包，超出用量或资源包到期后将正常计费。

该功能目前仅提供 API 使用方式

请求

请求示例

GET /<ObjectKey>?ci-process=face-effect&type=<type> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

https://cloud.tencent.com/document/product/436/58964#.E4.BA.BA.E8.84.B8.E8.AF.86.E5.88.AB.E8.B4.B9.E7.94.A8
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

Authorization: Auth String （详情请参见 请求签名  文档）。

请求参数

参数名称 描述
类

型

是

否

必
选

Object

Key
对象文件名，例如：folder/document.jpg

Str

ing
是

ci-

proces

s

对象存储处理能力，人脸特效固定为 face-effect
Str

ing
是

type

人脸特效类型。人脸美颜：face-beautify；人脸性别转换：face-

gender-transformation；人脸年龄变化：face-age-

transformation；人像分割：face-segmentation

Str

ing
是

whiteni

ng

type 为 face-beautify  时生效，美白程度，取值范围[0,100]。0表示不

美白，100表示最高程度。默认值30

Int
eg

er

否

smooth
ing

type 为 face-beautify  时生效，磨皮程度，取值范围[0,100]。0表示不
磨皮，100表示最高程度。默认值10

Int
eg

er

否

faceLift
ing

type 为 face-beautify  时生效，瘦脸程度，取值范围[0,100]。0表示不
瘦脸，100表示最高程度。默认值70

Int
eg

er

否

eyeEnl
arging

type 为 face-beautify  时生效，大眼程度，取值范围[0,100]。0表示不
大眼，100表示最高程度。默认值70

Int

eg
er

否

gender

type 为  face-gender-transformation 时生效，选择转换方向，0表示

男变女，1表示女变男。无默认值。注意：仅对图片中面积最大的人脸进行转
换

Int

eg
er

是

age
type 为 face-age-transformation  时生效，变化到的人脸年龄，范围

为[10,80]，无默认值。注意：仅对图片中面积最大的人脸进行转换

Int

eg

er

是

请求头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
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该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Response 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

请求体

响应

响应头

响应体

<Response>

  <ResultImage>base64编码的图片</ResultImage>

  <ResultMask>base64编码的文件</ResultMask>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名

称（关

键字）

父节点 描述
类

型

ResultI

mage

Resp

onse
处理后的图片 base64 数据

St

ri

n
g

Result

Mask

Resp

onse

人像分割输出参数，一个通过 Base64 编码的文件，解码后文件由 Float 

型浮点数组成。这些浮点数代表原图从左上角开始的每一行的每一个像素

点，每一个浮点数的值是原图相应像素点位于人体轮廓内的置信度（0-1）
转化的灰度值（0-255）

St

ri

n
g

错误码

实际案例

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第981 共1701页

请求

GET /test.jpg?ci-process=face-effect&type=face-beautify&whitening=70&smoothing=80&

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <ResultImage>base64编码的图片</ResultImage>

</Response>
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人体识别
最近更新时间：2022-12-08 11:11:39

腾讯云数据万象通过 AIBodyRecognition 接口识别并输出画面中人体，输出其位置（矩形框）和置信度。图片人

体识别请求包属于 GET 请求，请求时需要携带签名。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能概述

说明：

当前人体识别的图片限制为：图片格式支持 PNG、JPEG、JPG，图片大小不超过10MB，图片宽高大

于50像素 x 50像素。

请求语法

GET /?ci-process=AIBodyRecognition HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明：

Authorization:Auth String （详情请参见 请求签名  文档）。

请求内容

参数名称 描述 类型 是否必选

ci-process 数据万象处理能力，人体识别固定为 AIBodyRecognition String 是

请求头

请求体

响应

响应头

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
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该响应体返回为 application/xml 数据，具体的数据内容如下：

Response 的内容：

LogoInfo 节点内容：

Location 节点内容：

响应体

节点名称（关键字） 父节点 描述 类型

RecognitionResult 无 保存 Logo 识别结果的容器 Container

节点名称（关键
字）

父节点 描述 类型

Status
RecognitionRes

ult

人体识别结果。0表示未识别到，1表示识

别到
Int

PedestrianInfo
RecognitionRes

ult
人体识别结果，可能有多个

Containe

r

节点名称（关键

字）
父节点 描述 类型

Name
PedestrianI

nfo
识别类型，人体识别默认：person String

Sorce
PedestrianI

nfo

人体的置信度，取值范围为[0-100]。值越高概率

越大。
String

Location
PedestrianI

nfo
图中识别到人体的坐标

Contain

er

节点名称（关键字） 父节点 描述 类型

Point Location 人体坐标点（X 坐标,Y 坐标） String

示例

请求

GET /?ci-process=RecognizeLogo&detect-url=xxx HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: xxxxx
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Authorization:XXXXXXXXXXXX

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: xxxxxx

Server: tencent-ci

x-cos-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<RecognitionResult>

    <Status>1</Status>

    <PedestrianInfo>

        <Name>person</Name>

        <Score>90</Score>

        <Location>

            <Point>162,266</Point>

            <Point>162,716</Point>

            <Point>392,716</Point>

            <Point>392,266</Point>

        </Location>

        <Name>person</Name>

        <Score>89</Score>

        <Location>

            <Point>682,162</Point>

            <Point>682,479</Point>

            <Point>783,479</Point>

            <Point>783,162</Point>

        </Location>

    </PedestrianInfo>

</RecognitionResult>
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人脸核身

身份证识别
最近更新时间：2022-05-12 16:02:03

支持中国大陆居民二代身份证正反面所有字段的识别，包括姓名、性别、民族、出生日期、住址、公民身份证号、签

发机关、有效期限；具备身份证照片、人像照片的裁剪功能和翻拍、PS、复印件告警功能，以及边框和框内遮挡告

警、临时身份证告警和身份证有效期不合法告警等扩展功能。

身份证图片上传时识别的请求包与 COS 简单上传文件接口一致，只需增加相关处理参数，即可在图片上传时返回

识别结果，并可将原图存入到 COS。

云上数据处理请求能够对已存储在 COS 的身份证图片进行相应处理操作，返回识别结果。

功能描述

说明

当前身份证识别的图片限制为：要求图片经 Base64 编码后不超过7M，分辨率建议500 × 800以

上，支持 PNG、JPG、JPEG、BMP 格式。建议卡片部分占据图片2/3以上。

身份证识别为付费服务，计费详情请参见 内容识别费用 。

该功能目前仅提供 API 使用方式。

请求

上传时处理

PUT /<ObjectKey>?ci-process=IDCardOCR&CardSide=<CardSide>&Config=<Config> HT

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

云上数据处理

GET /<ObjectKey>?ci-process=IDCardOCR&CardSide=<CardSide>&Config=<Config> HT

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

https://cloud.tencent.com/document/product/460/58118
https://cloud.tencent.com/document/product/436/7778
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Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求参数

参数名

称
描述

类

型

是

否

必
选

Objec

tKey
对象文件名，例如：folder/document.jpg

St

ri

n
g

是

ci-

proce
ss

对象存储处理能力，身份证识别固定为 IDCardOCR

St

ri
n

g

是

CardS

ide
该参数如果不填，将为您自动判断身份证正反面

FRONT：身份证有照片的一面（人像面）

BACK：身份证有国徽的一面（国徽面）

St
ri

n

g

否

Confi
g

以下可选字段均为 bool 类型，默认 false：

参数设置方式参考：

Config = {"CropIdCard":true,"CropPortrait":true}

CropIdCard，身份证照片裁剪（去掉证件外多余的边缘、自动矫正拍摄角

度）

CropPortrait，人像照片裁剪（自动抠取身份证头像区域）

CopyWarn，复印件告警

BorderCheckWarn，边框和框内遮挡告警

ReshootWarn，翻拍告警

DetectPsWarn，PS 检测告警

TempIdWarn，临时身份证告警

InvalidDateWarn，身份证有效日期不合法告警

Quality，图片质量分数（评价图片的模糊程度）

MultiCardDetect，是否开启多卡证检测

St
ri

n

g

否

https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Response 的内容：

IdInfo身份证识别信息中包含如下内容：

请求头

请求体

响应

响应头

响应体

<Response>

  <IdInfo>

    身份证识别信息

  </IdInfo>

  <AdvancedInfo>

    身份证识别信息

  </AdvancedInfo>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

IdInfo Response 身份证识别信息 Container

AdvancedInfo Response 扩展信息，不请求则不返回 Container

节点名称（关键字） 父节点 描述 类型

Name IdInfo 姓名（人像面） String

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
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AdvancedInfo扩展信息信息中包含如下内容：

Sex IdInfo 性别（人像面） String

Nation IdInfo 民族（人像面） String

Birth IdInfo 出生日期（人像面） String

Address IdInfo 地址（人像面） String

IdNum IdInfo 身份证号（人像面） String

Authority IdInfo 发证机关（国徽面） String

ValidDate IdInfo 证件有效期（国徽面） String

节点

名称

（关

键
字）

父

节

点

描述
类

型

IdC

ard

A

d

v
a

n

c

e
dI

nf

o

裁剪后身份证照片的 Base64 编码，设置 Config.CropIdCard 为 true 时返

回

Str

ing

Port

rait

A

d

v

a
n

c

e

dI

nf
o

身份证头像照片的 Base64 编码，设置 Config.CropPortrait 为 true 时返回
Str

ing

Qua

lity

A

d

图片质量分数，设置  Config.Quality 为 true 时返回（取值范围：0~100，分

数越低越模糊，建议阈值≥50）

Str

ing
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v

a

n

c
e

dI

nf

o

Bor
der

Cod

eVa

lue

A

d

v
a

n

c

e

dI
nf

o

身份证边框不完整告警阈值分数，设置 Config.BorderCheckWarn 为 true 

时返回（取值范围：0~100，分数越低边框遮挡可能性越低，建议阈值≥50）

Str

ing

War

nInf
os

Id

In
fo

告警信息，Code 告警码列表和释义：

可能存在多个 WarnInfos

9100 身份证有效日期不合法告警

9101 身份证边框不完整告警

9102 身份证复印件告警

9103 身份证翻拍告警

9104 临时身份证告警

9105 身份证框内遮挡告警

9106 身份证 PS 告警

Str
ing

实际案例

请求

GET /test.jpg?ci-process=IDCardOCR&CardSide=FRONT&Config={"CropIdCard"：true, "C

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641
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以下仅列出了接口业务逻辑相关的错误码，其他错误信息请参见 错误码  文档。

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-image

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <IdInfo>

     <Name>李明</Name>

     <Sex>男</Sex>

     <Nation>汉</Nation>

     <Birth>1987/1/1</Birth>

     <Address>北京市石景山区高新技术园腾讯大楼</Address>

     <IdNum>440524198701010014</IdNum>

  </IdInfo>

  <AdvancedInfo>

     <IdCard>裁剪后身份证照片的 Base64 编码</IdCard>

     <Portrait>身份证头像照片的 Base64 编码</Portrait>

  </AdvancedInfo>

</Response>

错误码

错误码 描述

FailedOperation.DownLoadError 文件下载失败

FailedOperation.EmptyImageError 图片内容为空

FailedOperation.IdCardInfoIllegal
身份证信息不合法（身份证号、姓名字段校验非法
等）

FailedOperation.ImageBlur 图片模糊

FailedOperation.ImageDecodeFailed 图片解码失败

FailedOperation.ImageNoIdCard 图片中未检测到身份证

FailedOperation.ImageSizeTooLarge
图片尺寸过大，请参考输出参数中关于图片大小限
制的说明

FailedOperation.MultiCardError 照片中存在多张卡

FailedOperation.OcrFailed OCR 识别失败

FailedOperation.UnKnowError 未知错误

https://cloud.tencent.com/document/product/460/42867
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FailedOperation.UnOpenError 服务未开通

InvalidParameter.ConfigFormatError Config 格式错误

InvalidParameterValue.InvalidParameterVal

ueLimit
参数值错误

LimitExceeded.TooLargeFileError 文件内容太大

ResourcesSoldOut.ChargeStatusException 计费状态异常
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活体人脸核身
最近更新时间：2023-07-20 16:06:22

集成了活体检测和跟权威库进行比对的能力，传入一段视频和姓名、身份证号信息即可进行验证。对录制的自拍视频

进行活体检测，从而确认当前用户为真人，可防止照片、视频、静态3D 建模等各种不同类型的攻击。检测为真人

后，再判断该视频中的人与权威库的证件照是否属于同一个人，实现用户身份信息核实。

视频上传时检测的请求包与对象存储（Cloud Object Storage，COS）简单上传文件接口一致，只需增加相关

处理参数，即可在视频上传时返回检测结果，并可将原视频存入到 COS。

云上数据处理请求能够对已存储在 COS 的人脸视频进行相应识别操作，返回检测结果。

功能描述

说明

当前活体人脸核身的视频片限制为：用于活体检测的视频 BASE64 编码后的大小不超过8M，支持 

mp4、avi、flv 格式。

活体人脸核身为付费服务，由数据万象收取，计费详情请参见 内容审核费用 。

该功能目前仅提供 API 使用方式。

请求

上传时处理

PUT /<ObjectKey>?ci-process=LivenessRecognition&IdCard=<IdCard>&Name=<Name>

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

云上数据处理

GET /<ObjectKey>?ci-process=LivenessRecognition&IdCard=<IdCard>&Name=<Name>

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

https://cloud.tencent.com/document/product/436/58965
https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求参数

参数名称 描述
类

型
是否必选

ObjectK
ey

对象文件名，例如：folder/document.mp4，BASE64 编
码后的大小不超过8M，支持 mp4、avi、flv 格式

Str
ing

是

ci-

process

对象存储处理能力，人脸核身固定为 

LivenessRecognition

Str

ing
是

IdCard 身份证号
Str

ing
是

Name 姓名。中文请使用 UTF-8编码
Str
ing

是

Livenes

sType

活体检测类型，取值：LIP/ACTION/SILENT

LIP 为数字模式，ACTION 为动作模式，SILENT 为静
默模式，三种模式选择一种传入

Str

ing
是

Validate
Data

数字模式传参：数字验证码（1234），需先调用接口获取

数字验证码

动作模式传参：传动作顺序（2，1 or 1，2），需先调用

接口获取动作顺序

静默模式传参：空

Str
ing

是。当 

LivenessTyp
e 填的是 

SILENT 时，

该参数为可选项

BestFra

meNum

需要返回多张最佳截图，取值范围1 - 10，不设置默认返回一

张最佳截图
Int 否

请求头

请求体

响应

响应头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第994 共1701页

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

具体的返回内容如下：

Response 的内容：

响应体

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关
键字）

父节点 描述
类
型

BestFrame
Base64

Resp
onse

验证通过后的视频最佳截图照片，照片为 BASE64 编码后的值，

JPG 格式
注意：此字段可能返回 null，表示取不到有效值

St

ri
n

g

Sim
Resp

onse

相似度，取值范围 [0.00，100.00]。推荐相似度大于等于70时

可判断为同一人，可根据具体场景自行调整阈值（阈值70的误通
过率为千分之一，阈值80的误通过率是万分之一）

检测成功返回

Fl
o

at

BestFrame

List

Resp

onse

最佳截图列表，仅在配置了返回多张最佳截图时返回

注意：此字段可能返回 null，表示取不到有效值

St
ri

n

g

实际案例

请求

GET /test.mp4?ci-process=LivenessRecognition&IdCard=11204416541220243X&Name=

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

https://cloud.tencent.com/document/product/436/7729
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以下仅列出了接口业务逻辑相关的错误码，其他错误信息请参见 错误码  文档。

Server: tencent-ci

x-cos-request-id: NWY2OWFlYjdfNDQ0NjYzNjRfMTBm****

<Response>

      <BestFrameBase64>/9j/4AAQSkZJRgABAQAAAQA</BestFrameBase64>

      <Sim>100</Sim>

</Response>

错误码

错误码 描述

FailedOperation.ActionCloseEye 未检测到闭眼动作

FailedOperation.ActionFaceClose 脸离屏幕太近

FailedOperation.ActionFaceFar 脸离屏幕太远

FailedOperation.ActionFaceLeft 脸离屏幕太左

FailedOperation.ActionFaceRight 脸离屏幕太右

FailedOperation.ActionFirstAction 未检测到第一个动作

FailedOperation.ActionLightDark 光线太暗

FailedOperation.ActionLightStrong 光线太强

FailedOperation.ActionNodetectFace 未能检测到完整人脸

FailedOperation.ActionOpenMouth 未检测到张嘴动作

FailedOperation.CompareFail 比对失败

FailedOperation.CompareLowSimilarity 调用比对引擎接口出错

FailedOperation.FileSaveError 文件存储失败，请稍后重试

FailedOperation.IdFormatError 输入的身份证号有误

FailedOperation.IdNameMisMatch 姓名和身份证号不一致，请核实后重试

FailedOperation.IdNoExistSystem 库中无此号，请到户籍所在地进行核实

https://cloud.tencent.com/document/product/436/7730
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FailedOperation.IdPhotoNoExist 库中无此号照片，请到户籍所在地进行核实

FailedOperation.IdPhotoPoorQuality 证件图片分辨率太低，请重新上传

FailedOperation.IdPhotoSystemNoanswe

r
客户库自建库或认证中心返照失败，请稍后再试

FailedOperation.LifePhotoDetectFaces 检测到多张人脸

FailedOperation.LifePhotoDetectFake 实人比对没通过

FailedOperation.LifePhotoDetectNoFaces 未能检测到完整人脸

FailedOperation.LifePhotoPoorQuality 传入图片分辨率太低，请重新上传

FailedOperation.LifePhotoSizeError 传入图片过大或过小

FailedOperation.LipFaceIncomplete 脸部未完整露出

FailedOperation.LipMoveSmall 嘴唇动作幅度过小

FailedOperation.LipNetFailed 视频拉取失败，请重试

FailedOperation.LipSizeError
视频为空，或大小不合适，请控制录制时长在6s左

右

FailedOperation.LipVideoInvalid 视频格式有误

FailedOperation.LipVideoQuaility 视频像素太低

FailedOperation.LipVoiceDetect 未检测到声音

FailedOperation.LipVoiceLow 视频声音太小

FailedOperation.LipVoiceRecognize 声音识别失败

FailedOperation.LivessBestFrameError 人脸检测失败，无法提取比对照

FailedOperation.LivessDetectFail 活体检测没通过

FailedOperation.LivessDetectFake 疑似非真人录制

FailedOperation.LivessSystemError 调用活体引擎接口出错

FailedOperation.LivessUnknownError 视频实人检测没通过

FailedOperation.NameFormatError 输入的姓名有误

FailedOperation.RequestLimitExceeded 调用次数超出限制
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FailedOperation.SilentDetectFail 实人检测失败

FailedOperation.SilentThreshold 实人检测未达到通过标准

FailedOperation.SilentTooShort 视频录制时间过短，请录制2s以上的视频。

FailedOperation.UnKnown 内部未知错误

InvalidParameter 参数错误

InvalidParameter.RuleId RuleId 不存在

InvalidParameterValue 参数取值错误

InvalidParameterValue.BizTokenExpired BizToken 过期

InvalidParameterValue.RuleIdNotExist RuleId 不存在，请到人脸核身控制台申请

UnauthorizedOperation 未授权操作

UnauthorizedOperation.Arrears 账号已欠费

UnauthorizedOperation.NonAuthorize 账号未实名

UnauthorizedOperation.Nonactivated 未开通服务

UnsupportedOperation 操作不支持
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获取数字验证码
最近更新时间：2023-07-20 16:06:22

使用数字活体检测模式前，需调用本接口获取数字验证码。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

接口描述

请求

请求示例

GET /?ci-process=GetLiveCode HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求参数

参数名称 描述 类型 是否必选

ci-process 对象存储处理能力，获取数字验证码固定为 GetLiveCode String 是

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第999 共1701页

具体的数据内容如下：

Response 的内容：

<Response>

  <LiveCode>数字验证码</LiveCode>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

LiveCode Response 数字验证码，如：1234 String

实际案例

请求

GET /?ci-process=GetLiveCode HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-cos-request-id: NWY2OWFlZjVfOTA0MDYzNjRfNjY5Zl8zNQ==

<Response>

  <LiveCode>0521</LiveCode>

</Response>
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获取动作顺序
最近更新时间：2021-05-19 16:06:49

使用动作活体检测模式前，需调用本接口获取动作顺序。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

接口描述

请求

请求示例

GET /?ci-process=GetActionSequence HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求参数

参数名称 描述 类型
是否必
选

ci-

process

对象存储处理能力，获取动作顺序固定为 

GetActionSequence

Strin

g
是

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Response 的内容：

<Response>

  <ActionSequence>动作顺序</ActionSequence>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

ActionSequence Response 动作顺序（2，1 or 1，2）。1代表张嘴，2代表闭眼 String

实际案例

请求

GET /?ci-process=GetActionSequence HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-image

x-cos-request-id: NWY2OWFlZjVfOTA0MDYzNjRfNjY5Zl8zNQ==

<Response>

  <ActionSequence>2,1</ActionSequence>

</Response>
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车辆车牌识别
最近更新时间：2023-07-20 16:06:23

车辆车牌检测功能为同步请求方式，您可以通过本接口检测图片中的车辆，识别出车辆的品牌、颜色、位置、车牌位

置等信息。该接口属于 GET 请求。

功能描述

费用说明

成功调用接口会产生 车辆车牌检测费用  和 COS 读请求费用 。

如果图片属于 COS 上的低频存储类型，成功调用接口会产生 COS 低频数据取回费用 。

不支持对 COS 上的归档存储类型和深度归档存储类型的图片进行处理，如果需要处理此类型图片，请先 恢复归

档文件 。

限制说明

图片支持格式：PNG、JPG、JPEG。

图片大小：所下载图片经 Base64 编码后不超过4MB。

图片像素：建议大于50 * 50像素，否则影响识别效果。

长宽比：建议长边与短边的比例小于5:1。

调用接口需携带签名，具体规则请参见 请求签名  文档。

请求

请求示例

GET /<ObjectKey>?ci-process=DetectCar HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求参数

参数名称 描述 类型 是否必选

ObjectKey 对象文件名，例如：folder/document.jpg String 是

https://cloud.tencent.com/document/product/436/58964#.E6.B1.BD.E8.BD.A6.E8.AF.86.E5.88.AB.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

ci-process 数据万象处理能力，车辆识别固定为 DetectCar String 是

请求头

请求体

响应

响应头

响应体

<Response>

    <RequestId></RequestId>

    <CarTags>

        <Serial></Serial>

        <Brand></Brand>

        <Type></Type>

        <Color><Color>

        <Confidence></Confidence>

        <Year></Year>

        <CarLocation>

            <X></X>

            <Y></Y>

        </CarLocation>

        <PlateContent>

            <Plate></Plate>

            <Color>Color>

            <Type></Type>

            <PlateLocation>

                <X></X>

                <Y></Y>

            </PlateLocation>

        </PlateContent>

    </CarTags>

</Response>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
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Response 的内容：

CarTags 节点的内容：

CarLocation 节点的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关

键字）
父节点 描述 类型

RequestId
Respo

nse

唯一请求 ID，每次请求都会返回。定位问题时需要提供该次

请求的 RequestId
String

CarTags
Respo
nse

车辆属性识别的结果数组，支持返回多个车辆信息
Contai
ner

节点名称（关键

字）
父节点 描述 类型

Serial
CarTa
gs

车系 String

Brand
CarTa

gs
车辆品牌 String

Type
CarTa

gs
车辆类型 String

Color
CarTa
gs

车辆颜色 String

Confidence
CarTa

gs
置信度，0 - 100 Int

Year
CarTa

gs
年份，识别不出年份时返回0 Int

CarLocation
CarTa
gs

车辆在图片中的坐标信息，可能返回多个坐标点的值
Contain
er

PlateContent
CarTa

gs

车牌信息，包含车牌号、车牌颜色、车牌位置。支持返回

多个车牌

Contain

er

节点名称（关键字） 父节点 描述 类型
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PlateContent 节点的内容：

PlateLocation 节点的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

X CarLocation 横坐标 x Int

Y CarLocation 纵坐标 y Int

节点名称（关键字） 父节点 描述 类型

Plate PlateContent 车牌号信息 String

Color PlateContent 车牌的颜色 String

Type PlateContent 车牌的种类，例如普通蓝牌 String

PlateLocation PlateContent 车牌的位置 Container

节点名称（关键

字）
父节点 描述

类

型

X
PlateLocatio
n

定位出的车牌左上角、右上角、左下角、右下角的 X 
坐标

Int

Y
PlateLocatio

n

定位出的车牌左上角、右上角、左下角、右下角的 Y 

坐标
Int

错误码

实际案例

请求

GET /test.jpg?ci-process=DetectCar HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

https://cloud.tencent.com/document/product/436/7730
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Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjE1MzEyMDlfOTBmYTUwNjRfNzUz****</RequestId>

    <CarTags>

        <Serial>奔驰S级</Serial>

        <Brand>奔驰</Brand>

        <Type>轿车</Type>

        <Color>黑</Color>

        <Confidence>98</Confidence>

        <Year>0</Year>

        <CarLocation>

            <X>8</X>

            <Y>364</Y>

        </CarLocation>

        <CarLocation>

            <X>8</X>

            <Y>5</Y>

        </CarLocation>

        <CarLocation>

            <X>637</X>

            <Y>5</Y>

        </CarLocation>

        <CarLocation>

            <X>637</X>

            <Y>364</Y>

        </CarLocation>

        <PlateContent>

            <Plate>陕ASxxxL</Plate>

            <Color>蓝色</Color>

            <Type>普通蓝牌</Type>

            <PlateLocation>

                <X>263</X>

                <Y>309</Y>

            </PlateLocation>

            <PlateLocation>

                <X>263</X>

                <Y>239</Y>

            </PlateLocation>

            <PlateLocation>

                <X>459</X>

                <Y>239</Y>

            </PlateLocation>

            <PlateLocation>
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                <X>459</X>

                <Y>309</Y>

            </PlateLocation>

        </PlateContent>

    </CarTags>

    <CarTags>

        <Serial>五菱宏光</Serial>

        <Brand>五菱</Brand>

        <Type>面包车</Type>

        <Color>白</Color>

        <Confidence>0</Confidence>

        <Year>0</Year>

        <CarLocation>

            <X>0</X>

            <Y>228</Y>

        </CarLocation>

        <CarLocation>

            <X>0</X>

            <Y>81</Y>

        </CarLocation>

        <CarLocation>

            <X>73</X>

            <Y>81</Y>

        </CarLocation>

        <CarLocation>

            <X>73</X>

            <Y>228</Y>

        </CarLocation>

    </CarTags>

</Response>
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图片文字识别(OCR)
最近更新时间：2022-08-03 15:29:14

通用文字识别功能（Optical Character Recognition，OCR）基于行业前沿的深度学习技术，将图片上的文字

内容，智能识别为可编辑的文本，可应用于随手拍扫描、纸质文档电子化、电商广告审核等多种场景，大幅提升信息

处理效率。

本接口属于 GET 请求，为同步请求方式。

功能描述

费用说明

成功调用接口会产生 通用文字识别费用  和 COS 读请求费用 。

如果图片属于 COS 上的低频存储类型，成功调用接口会产生 COS 低频数据取回费用 。

不支持对 COS 上的归档存储类型和深度归档存储类型的图片进行处理，如果需要处理此类型图片，请先 恢复归

档文件 。

限制说明

图片支持格式：PNG、JPG、JPEG、BMP 及 PDF 文件。

图片大小：所下载文件经 Base64 编码后不超过7MB。

图片分辨率：建议大于600 * 800像素，否则影响识别效果。

调用接口需携带签名，具体规则请参见 请求签名  文档。

请求

请求示例

GET /<ObjectKey>?ci-process=OCR&type=general&language-type=zh&ispdf=true&pdf-p

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求参数

参数

名称

描述 类

型

是

否

https://cloud.tencent.com/document/product/436/58964#.E5.9B.BE.E7.89.87.E6.96.87.E5.AD.97.E8.AF.86.E5.88.AB.EF.BC.88ocr.EF.BC.89.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778
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必

选

Obje

ctKe
y

对象文件名，例如：folder/document.jpg。
Str
ing

是

ci-

proc
ess

数据万象处理能力，图片文字识别固定为 OCR。
Str

ing
是

type

OCR 的识别类型，有效值为 general，accurate，efficient，fast，

handwriting。general 表示通用印刷体识别；accurate 表示印刷体高精度

版；efficient 表示印刷体精简版；fast 表示印刷体高速版；handwriting 表示
手写体识别。默认值为 general。

Str

ing
否

lang

uage
-

type

type 值为 general 时有效，表示识别语言类型。支持自动识别语言类型，同时

支持自选语言种类，默认中英文混合(zh)，各种语言均支持与英文混合的文字识
别。可选值请参见 可识别的语言类型 。

Str
ing

否

ispdf
type 值为 general、fast 时有效，表示是否开启 PDF 识别，有效值为 true 和 
false，默认值为 false，开启后可同时支持图片和 PDF 的识别。

Bo
ole

an

否

pdf-

page
num

ber

type 值为 general、fast 时有效，表示需要识别的 PDF 页面的对应页码，仅
支持 PDF 单页识别，当上传文件为 PDF 且 ispdf 参数值为 true 时有效，默认

值为1。

Int
eg

er

否

iswo
rd

type 值为 general、accurate 时有效，表示识别后是否需要返回单字信息，
有效值为 true 和 false，默认为 false。

Bo
ole

an

否

enab

le-
word

-

poly

gon

type 值为 handwriting 时有效，表示是否开启单字的四点定位坐标输出，有效

值为 true 和 false，默认值为 false。

Bo

ole

an

否

可识别的语言类型

可选值 语言 可选值 语言

zh 中英混合 rus 俄语
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

zh_rare 支持英文、数字、中文生僻字、繁体字，特殊符号等 ita 意大利语

auto 自动 hol 荷兰语

mix 混合语种 swe 瑞典语

jap 日语 fin 芬兰语

kor 韩语 dan 丹麦语

spa 西班牙语 nor 挪威语

fre 法语 hun 匈牙利语

ger 德语 tha 泰语

por 葡萄牙语 hi 印地语

vie 越语 ara 阿拉伯语

may 马来语

请求头

请求体

响应

响应头

响应体

<Response>

  <TextDetections>

    <DetectedText></DetectedText>

    <Confidence></Confidence>

    <Polygon>

      <X></X>

      <Y></Y>

    </Polygon>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
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具体的数据内容如下：

Response 的内容：

    <ItemPolygon>

      <X></X>

      <Y></Y>

      <Width></Width>

      <Height></Height>

    </ItemPolygon>

    <Words>

      <Confidence></Confidence>

      <Character></Character>

      <WordCoordPoint>

        <WordCoordinate>

          <X></X>

          <Y></Y>

        </WordCoordinate>

      </WordCoordPoint>

    </Words>

  </TextDetections>

  <Language></Language>

  <Angel></Angel>

  <PdfPageSize></PdfPageSize>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器。 Container

节点名称

（关键字）
父节点 描述 类型

TextDetec

tions

Resp

onse

检测到的文本信息，包括文本行内容、置信度、文本行坐标以及

文本行旋转纠正后的坐标。

Conta

iner

Language
Resp

onse

检测到的语言类型，目前支持的语言类型可参考入参 

language-type 说明。
String

Angel
Resp

onse

图片旋转角度（角度制），文本的水平方向为0°；顺时针为正，

逆时针为负。
Float

PdfPageSi

ze

Resp

onse
图片为 PDF 时，返回 PDF 的总页数，默认为0。

Integ

er
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TextDetections 节点的内容：

Polygon 节点的内容：

ItemPolygon 节点的内容：

RequestId Resp

onse

唯一请求 ID，每次请求都会返回。定位问题时需要提供该次请求

的 RequestId。

String

节点名称

（关键
字）

父节点 描述 类型

Detect

edText

TextD

etecti
ons

识别出的文本行内容。
Stri

ng

Confid

ence

TextD

etecti

ons

置信度 0 - 100。
Inte

ger

Polygo

n

TextD

etecti

ons

文本行坐标，以顶点坐标表示 注意：此字段可能返回 null，表示取不到

有效值。

Co

ntai

ner

ItemPo

lygon

TextD

etecti

ons

文本行在旋转纠正之后的图像中的像素坐标，表示为（左上角 x, 左上角 

y，宽 width，高 height）。

Co

ntai

ner

Words

TextD

etecti

ons

识别出来的单字信息包括单字（包括单字 Character 和单字置信度 

confidence），支持识别的接口：general、accurate。

Co

ntai

ner

WordP

olygon

TextD

etecti

ons

字的坐标数组，以四个顶点坐标表示。

注意：此字段可能返回 null，表示取不到有效值。支持识别的类型：

handwriting。

Co

ntai

ner

节点名称（关键字） 父节点 描述 类型

X Polygon 横坐标。 Integer

Y Polygon 纵坐标。 Integer

节点名称（关键字） 父节点 描述 类型

X ItemPolygon 左上角 x。 Integer
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Words 节点的内容：

WordCoordPoint 节点的内容：

WordCoordinate 节点的内容：

WordPolygon 节点的内容：

Y ItemPolygon 左上角 y。 Integer

Width ItemPolygon 宽 width。 Integer

Height ItemPolygon 高 height。 Integer

节点名称（关键

字）

父节

点
描述 类型

Confidence
Wor

ds
置信度 0 - 100。 Integer

Character
Wor

ds
识别出来的单词信息。 String

WordCoordP

oint

Wor

ds

单字在原图中的四点坐标，支持识别的接口：general、

accurate。

Contain

er

节点名称（关

键字）
父节点 描述 类型

WordCoor
dinate

WordCoord
Point

单字在原图中的坐标，以四个顶点坐标表示，以左上角为
起点，顺时针返回。

Contai
ner

节点名称（关键字） 父节点 描述 类型

X WordCoordinate 横坐标。 Integer

Y WordCoordinate 纵坐标。 Integer

节点名称（关键字） 父节点 描述 类型

LeftTop WordPolygon 左上顶点坐标。 Container

RightTop WordPolygon 右上顶点坐标。 Container

RightBottom WordPolygon 右下顶点坐标。 Container

LeftBottom WordPolygon 左下顶点坐标。 Container
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LeftTop，RightTop，RightBottom，LeftBottom 节点的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

X WordCoordinate 横坐标。 Integer

Y WordCoordinate 纵坐标。 Integer

错误码

实际案例

请求

GET /<ObjectKey>?ci-process=OCR&type=general&language-type=zh&ispdf=true&iswo

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-image

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<Response>

    <Angel>359.99</Angel>

    <Language>mix</Language>

    <PdfPageSize>0</PdfPageSize>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TextDetections>

        <Confidence>99</Confidence>

        <DetectedText>你好</DetectedText>

        <ItemPolygon>

            <Height>64</Height>

            <Width>123</Width>

            <X>140</X>

            <Y>167</Y>

        </ItemPolygon>

        <Polygon>

            <X>140</X>

https://cloud.tencent.com/document/product/436/7730
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            <Y>167</Y>

        </Polygon>

        <Polygon>

            <X>263</X>

            <Y>167</Y>

        </Polygon>

        <Polygon>

            <X>263</X>

            <Y>231</Y>

        </Polygon>

        <Polygon>

            <X>140</X>

            <Y>231</Y>

        </Polygon>

        <Words>

            <Character>你</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>212</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>341</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>341</X>

                    <Y>231</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>212</X>

                    <Y>231</Y>

                </WordCoordinate>

            </WordCoordPoint>

        </Words>

        <Words>

            <Character>好</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>341</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>
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                    <X>263</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>263</X>

                    <Y>231</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>341</X>

                    <Y>230</Y>

                </WordCoordinate>

            </WordCoordPoint>

        </Words>

    </TextDetections>

    <TextDetections>

        <Confidence>99</Confidence>

        <DetectedText>再见</DetectedText>

        <ItemPolygon>

            <Height>43</Height>

            <Width>245</Width>

            <X>526</X>

            <Y>1444</Y>

        </ItemPolygon>

        <Polygon>

            <X>526</X>

            <Y>1444</Y>

        </Polygon>

        <Polygon>

            <X>771</X>

            <Y>1444</Y>

        </Polygon>

        <Polygon>

            <X>771</X>

            <Y>1487</Y>

        </Polygon>

        <Polygon>

            <X>526</X>

            <Y>1487</Y>

        </Polygon>

        <Words>

            <Character>再</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>564</X>
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                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1487</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>564</X>

                    <Y>1487</Y>

                </WordCoordinate>

            </WordCoordPoint>

        </Words>

        <Words>

            <Character>见</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>641</X>

                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>641</X>

                    <Y>1487</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1487</Y>

                </WordCoordinate>

            </WordCoordPoint>

        </Words>

    </TextDetections>

</Response>
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商品抠图
最近更新时间：2022-08-30 11:09:01

对象存储通过数据万象 GoodsMatting 接口对图像中的商品主体进行抠图。

功能概述

1. 下载时处理

GET /<ObjectKey>?ci-process=GoodsMatting HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

 处理后的图片直接返回至响应体。

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

  "is_pic_info": 1,

  "rules": 

      "fileid": "exampleobject",

      "rule": "ci-process=GoodsMatting"

  

{

[{

}]

}

说明

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

处理后的图片存至存储桶，并以 fileid 字段的值作为对象名称。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

https://cloud.tencent.com/document/product/460/18147
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操作名称：GoodsMatting。

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

  "rules": 

      "fileid": "exampleobject",

      "rule": "ci-process=GoodsMatting",

      "ignore-error": 1

  

{

[{

}]

}

说明

 处理后的图片存至存储桶，并以 fileid 字段的值作为对象名称。

处理参数说明

参数 含义
类

型

是否

必选

Objec

tKey
对象文件名，例如：folder/document.jpg。

Str

ing
是

ci-

proce

ss

数据万象处理能力，商品抠图固定为 GoodsMatting。
Str

ing
是

detec

t-url

您可以通过填写 detect-url  处理任意公网可访问的图片链接。不填写 

detect-url  时，后台会默认处理 ObjectKey  ，填写了 detect-url  时，

后台会处理 detect-url  链接，无需再填写 ObjectKey detect-url  示

例： http://www.example.com/abc.jpg  ，需要进行UrlEncode，处理

后为

http%25253A%25252F%25252Fwww.example.com%25252Fabc.j

pg

。

Str

ing
否

ignor

e-
error

当此参数为1时，针对文件过大等导致处理失败的场景，会直接返回原图而不

报错。
int 否
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内容识别相关接口需要携带签名访问，并与获取参数以“&”连接，示例如下：

将第三方图片（链接为 http://www.example.com/abc.jpg ）在下载时进行抠图，示例如下：

注意

通过 ObjectKey 进行商品抠图为内网操作，不会产生额外的外网流量。

通过 detect-url 进行商品抠图，会产生图片所在源站对应的外网流量。

实际案例

案例一：对存储桶内的图片进行商品抠图

https://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorit

说明

<signature> 为签名部分，获取方式请参考 请求签名 。

案例二：对第三方图片进行商品抠图

https://examples-1251000004.cos.ap-shanghai.myqcloud.com/?q-sign-algorithm=<signa

https://cloud.tencent.com/document/product/436/7778
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以图搜图
开通以图搜图
最近更新时间：2022-11-29 16:12:26

该接口用于开通 Bucket 搜图功能。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /ImageSearchBucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

请求头

请求体

<Request>

    <MaxCapacity>10000</MaxCapacity>

    <MaxQps>10</MaxQps>

</Request>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Request 节点的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应无响应体。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

MaxCapacity Request 图库容量限制 Int 是

MaxQps Request 图库访问限制，默认10 Int 否

说明

 图库容量设置后不允许修改。

响应

响应头

响应体

错误码

实际案例

请求

POST /ImageSearchBucket HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 50

Content-Type: application/xml

<Request>

    <MaxCapacity>10000</MaxCapacity>

    <MaxQps>10</MaxQps>

</Request>

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****
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添加图库图片
最近更新时间：2023-03-13 10:31:36

该接口用于添加图库图片。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /<ObjectKey>?ci-process=ImageSearch&action=AddImage HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

请求头

请求体

<Request>

    <EntityId>apple</EntityId>

    <CustomContent>myapple</CustomContent>

    <Tags>{"key1":"val1","key2":"val2"}</Tags>

</Request>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Request节点的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应无响应体。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称
（关键字）

父节
点

描述
类
型

是

否
必

选

EntityId

Req

ues
t

物品 ID，最多支持64个字符。若 EntityId 已存在，则对其追
加图片

Str
ing

是

CustomC

ontent

Req

ues
t

用户自定义的内容，最多支持4096个字符，查询时原样带回
Str

ing
否

Tags

Req

ues
t

图片自定义标签，最多不超过10个，json 字符串，格式为 

key:value （例 key1>=1 key1>='aa' ）对

Str

ing
否

响应

响应头

响应体

错误码

实际案例

请求

POST /<ObjectKey>?ci-process=ImageSearch&action=AddImage HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Content-Length: 100

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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Content-Type: application/xml

<Request>

    <EntityId>apple</EntityId>

    <CustomContent>myapple</CustomContent>

    <Tags>{"key1":"val1","key2":"val2"}</Tags>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****
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图片搜索接口
最近更新时间：2023-03-27 14:17:52

该接口用于检索图片。

参数的具体内容如下：

功能描述

请求

请求示例

GET /<ObjectKey>?ci-process=ImageSearch&action=SearchImage&MatchThreshold=&O

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

节点名称

（关键字）
描述

类

型

是
否

必

选

MatchThr
eshold

出参 Score 中，只有超过 MatchThreshold 值的结果才会返回。默认
为0

In
t

否

Offset 起始序号，默认值为0
In

t
否

Limit 返回数量，默认值为10，最大值为100
In

t
否

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Filter 针对入库时提交的 Tags 信息进行条件过滤。支持>、>=、<、<=、

=、!=，多个条件之间支持 AND 和 OR 进行连接

St

ri

n

g

否

请求头

请求体

响应

响应头

响应体

<Response>

    <Count>2</Count>

    <ImageInfos>

        <EntityId>apple</EntityId>

        <PicName>ObjectKey1</PicName>

        <Score>99</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

    <ImageInfos>

        <EntityId>apple</EntityId>

        <PicName>ObjectKey2</PicName>

        <Score>90</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
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Response 节点的内容：

ImageInfos 节点为数组，其中每一项内容为

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

Count Response 数量 Int

ImageInfos Response 图片信息 Container

节点名称

（关键字）
父节点 描述

类

型

EntityId

Imag

eInfo

s

物品 ID

St

rin

g

CustomC

ontent

Imag

eInfo

s

图片自定义的内容

St

rin

g

Tags

Imag

eInfo

s

自定义标签信息，最多不超过10个，json 字符串，格式为 

key:value （例 key1>=1 key1>='aa' ）对

St

rin

g

PicName
Imag
eInfo

s

图片名称
St
rin

g

Score
Imag
eInfo

s

相似度 Int

错误码

实际案例

请求

GET /<ObjectKey>?ci-process=ImageSearch&action=SearchImage&MatchThreshold=10&

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Content-Length: 0

https://cloud.tencent.com/document/product/436/7730
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Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 150

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Count>2</Count>

    <ImageInfos>

        <EntityId>apple</EntityId>

        <PicName>ObjectKey</PicName>

        <Score>99</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

    <ImageInfos>

        <EntityId>apple</EntityId>

        <PicName>ObjectKey2</PicName>

        <Score>90</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

</Response>
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删除图库图片
最近更新时间：2021-11-11 16:38:17

该接口用于删除图库图片。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

具体数据描述如下：

功能描述

请求

请求示例

POST /<ObjectKey>?ci-process=ImageSearch&action=DeleteImage HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

请求头

请求体

<Request>

    <EntityId>apple</EntityId>

</Request>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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Request 节点的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应无响应体。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

EntityId Request 物品 ID String 是

响应

响应头

响应体

错误码

实际案例

请求

POST /<ObjectKey>?ci-process=ImageSearch&action=DeleteImage HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-s

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Content-Length: 20

Content-Type: application/xml

<Request>

    <EntityId>apple</EntityId>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****
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视频人像分割

提交任务
最近更新时间：2022-12-16 11:22:35

提交一个视频人像抠图任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>SegmentVideoBody</Tag>

    <Input>

        <Object>input/test.mp4</Object>

    </Input>

    <Operation>

        <SegmentVideoBody>

            <Mode>Mask</Mode>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

        </SegmentVideoBody>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称
（关键字）

父节
点

描述 类型

是

否
必

选

Tag
Re
que

st

创建任务的 Tag：SegmentVideoBody
Strin
g

是

Input

Re

que
st

待操作的对象信息

Cont

aine
r

是

Operation

Re

que
st

操作规则

Cont

aine
r

是

CallBackF

ormat

Re

que

st

任务回调格式，JSON 或 XML，默认 XML，优先级高于

队列的回调格式

Strin

g
否

CallBackT

ype

Re

que

st

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队列

的回调类型

Strin

g
否
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Container 类型 Input 的具体数据描述如下：

Container 类型 Operation 的具体数据描述如下：

Container 类型 SegmentVideoBody 的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

CallBack Re

que

st

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Strin

g

否

CallBack

MqConfig

Re

que

st

任务回调 TDMQ 配置，当 CallBackType 为 TDMQ 时

必填。详情见 CallBackMqConfig

Cont

aine

r

否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

节点名称（关

键字）
父节点 描述 类型

是否

必选

SegmentVi
deoBody

Request.O
peration

视频人像抠图配置
Cont
ainer

否

Output
Request.O

peration
结果输出配置

Cont

ainer
是

UserData
Request.O

peration

透传用户信息，可打印的 ASCII 码，长度不超

过1024

Strin

g
否

JobLevel
Request.O
peration

任务优先级，级别限制：0 、1 、2。级别越大
任务优先级越高，默认为0

Strin
g

否

节点名称

（关键字）
父节点 描述

类

型

是否

必选

Mode
Request.Operation.Segm
entVideoBody

抠图模式，当前只支持 Mask (输
出alpha通道结果)

St

rin
g

否

节点名称（关键字） 父节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储桶 String 是

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Object Request.Operation.Output 输出结果的文件名 String 是

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>SegmentVideoBody</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <SegmentVideoBody>

                <Mode>Mask</Mode>

            </SegmentVideoBody>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

        </Operation>

    </JobsDetail>

</Response>

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

 JobsDetail Response 任务的详细信息
Container 
Container 节点 JobsDetail 的内容：

节点名称

（关键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Strin

g

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Strin

g

JobId
Response.J

obsDetail
新创建任务的 ID

Strin

g

Tag
Response.J

obsDetail
新创建任务的 Tag：SegmentVideoBody

Strin

g

State
Response.J
obsDetail

任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中一个

Strin
g

Creation

Time

Response.J

obsDetail
任务的创建时间

Strin

g

StartTim

e

Response.J

obsDetail
任务的开始时间

Strin

g

EndTime
Response.J
obsDetail

任务的结束时间
Strin
g

QueueId
Response.J

obsDetail
任务所属的队列 ID

Strin

g

Input
Response.J

obsDetail
同请求中的 Request.Input 节点

Cont

ainer

Operatio
n

Response.J
obsDetail

该任务的规则
Cont
ainer
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Container 节点 Operation 的内容：

Container 节点 MediaInfo 的内容： 

同 GenerateMediaInfo  接口中的 Response.MediaInfo 节点。

Container 节点 MediaResult 的内容，详情见 MediaResult 。

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键

字）
父节点 描述 类型

SegmentVid

eoBody

Response.JobsDetail.

Operation

同请求中的 
Request.Operation.SegmentVideo

Body

Conta

iner

Output
Response.JobsDetail.
Operation

同请求中的 
Request.Operation.Output

Conta
iner

UserData
Response.JobsDetail.

Operation
透传用户信息 String

JobLevel
Response.JobsDetail.

Operation
任务优先级 String

MediaInfo
Response.JobsDetail.
Operation

输出文件的媒体信息，任务未完成时不返
回

Conta
iner

MediaResult
Response.JobsDetail.

Operation

输出文件的基本信息，任务未完成时不返

回

Conta

iner

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SegmentVideoBody</Tag>

    <Input>

        <Object>input/test.mp4</Object>

https://cloud.tencent.com/document/product/460/38935
https://cloud.tencent.com/document/product/460/78927#MediaResult
https://cloud.tencent.com/document/product/460/42867
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    </Input>

    <Operation>

        <SegmentVideoBody>

            <Mode>Mask</Mode>

        </SegmentVideoBody>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>SegmentVideoBody</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>
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            <SegmentVideoBody>

                <Mode>Mask</Mode>

            </SegmentVideoBody>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

        </Operation>

    </JobsDetail>

</Response>
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任务回调
最近更新时间：2023-02-16 14:28:17

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数

据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>
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                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/out.mp4</ObjectName>

                    </Md5Info>
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

同提交视频人像抠图接口中的 Response.JobsDetail </a

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

                    <ObjectName>output/out.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <SegmentVideoBody>

                <Mode>Mask</Mode>

            </SegmentVideoBody>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my SegmentVideoBody job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pbde29b842b1b4e2ea4f0b20d264fcec2</QueueId>

        <StartTime>2022-07-25T16:35:39+0800</StartTime>

        <State>Success</State>

        <Tag>SegmentVideoBody</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container数组

节点名称（关键

字）

父节点 描述 类型

https://cloud.tencent.com/document/product/460/84802#jobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

Key
Response.JobsDetail.Input.CosHead

ers

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosHead

ers
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>
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                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>
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            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/out.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/out.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <SegmentVideoBody>

                <Mode>Mask</Mode>

            </SegmentVideoBody>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my SegmentVideoBody job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pbde29b842b1b4e2ea4f0b20d264fcec2</QueueId>

        <StartTime>2022-07-25T16:35:39+0800</StartTime>

        <State>Success</State>

        <Tag>SegmentVideoBody</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务触发的任务回调, 格式为 JSON

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-07-25T16:35:39+0800",

        "EndTime": "2022-07-25T16:35:43+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/test.mp4",

            "Region": "ap-chongqing"

        },
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        "JobId": "ac34be3aa0bf411ed9ce39d7cc972e427",

        "Message": "Success",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Duration": "13",

                    "NumStream": "1",

                    "Size": "1909389"

                },

                "Stream": {

                    "Audio": [{

                        "Bitrate": "128000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "13.653",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"

                    }],

                    "Video": [{

                        "AvgFps": "50.000",

                        "Bitrate": "1031968",

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Coding)",

                        "CodecName": "hevc",

                        "CodecTag": "0x31637668",

                        "CodecTagString": "hvc1",

                        "CodecTimeBase": "1/50",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "12.960",

                        "FieldOrder": "Unknown",

                        "Fps": "50/1",

                        "HasBFrame": "4",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",
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                        "Level": "4",

                        "NumFrames": "648",

                        "PixFormat": "hvc1",

                        "Profile": "Main",

                        "RefFrames": "1",

                        "Rotation": "0",

                        "StartTime": "0.000000",

                        "Timebase": "1/12800",

                        "Width": "540"

                    }]

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": [{

                        "Md5": "2db78d168edf2f883adce89a1b4ca033",

                        "ObjectName": "output/out.mp4"

                    }],

                    "ObjectName": ["output/out.mp4"],

                    "Region": "ap-chongqing"

                }

            },

            "SegmentVideoBody": {

                "Mode": "Mask"

            },

            "Output": {

                "Region": "ap-chongqing",

                "Bucket": "test-123456789",

                "Object": "output/out.mp4"

            },

            "UserData": "This is my SegmentVideoBody job.",

            "JobLevel": "0"

        },

        "QueueId": "pbde29b842b1b4e2ea4f0b20d264fcec2",

        "StartTime": "2022-07-25T16:35:39+0800",

        "State": "Success",

        "Tag": "SegmentVideoBody"

    }]

}
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文档处理
查询文档预览开通状态
最近更新时间：2022-07-07 16:16:01

DescribeDocProcessBuckets 接口用于查询已经开通文档预览功能的 Bucket。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /docbucket?pageNumber=1&pageSize=2 HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

名称 描述 类型
是否必

选

regions
地域信息，以“,”分隔字符串，支持 All、ap-shanghai、

ap-beijing

strin

g
否

bucketNam 存储桶名称，以“,”分隔，支持多个存储桶，精确搜索 strin 否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

es g

bucketNam

e
存储桶名称前缀，前缀搜索

strin

g
否

pageNumb

er
第几页

strin

g
否

pageSize 每页个数
strin

g
否

响应

响应头

响应体

<Response>

        <TotalCount>1</TotalCount>

        <RequestId>RequestId</RequestId>

        <PageNumber>1</PageNumber>

        <PageSize>2</PageSize>

        <DocBucketList>

                <Name>BucketName-APPID</Name>

                <CreateTime>Time</CreateTime>

                <Region>Region</Region>

                <AliasBucketId/>

                <BucketId>BucketName-APPID</BucketId>

        </DocBucketList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

https://cloud.tencent.com/document/product/460/42866
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Container 节点 DocBucketList 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

TotalCount Response 文档预览 Bucket 总数 Int

PageNumber Response 当前页数，同请求中的 pageNumber Int

PageSize Response 每页个数，同请求中的 pageSize Int

DocBucketList Response 文档预览 Bucket 列表 Container

节点名称（关键字） 父节点 描述 类型

BucketId Response.DocBucketList 存储桶 ID String

Name Response.DocBucketList 存储桶名称，同 BucketId String

Region Response.DocBucketList 所在的地域 String

CreateTime Response.DocBucketList 创建时间 String

AliasBucketId Response.DocBucketList 存储桶别名 String

错误码

实际案例

请求

GET /docbucket?regions=ap-chongqing HTTP/1.1

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: ci.ap-chongqing.myqcloud.com

Content-Type: application/xml

Authorization: Authorization

响应

HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 07:00:43 GMT

Content-Type: application/xml

Content-Length: 843

https://cloud.tencent.com/document/product/460/42867
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Connection: keep-alive

Server: tencent-ci

x-ci-request-id: NWYxZTdiOWJfYzc2OTQzNjRfM2Qz****

<?xml version="1.0" encoding="utf-8"?>

<Response>

        <TotalCount>3</TotalCount>

        <RequestId>NWYxZTdiOWJfYzc2OTQzNjRfM2Qz****</RequestId>

        <PageNumber>1</PageNumber>

        <PageSize>10</PageSize>

        <DocBucketList>

                <Name>examplebucket-1250000000</Name>

                <CreateTime>2020-07-27T10:54:42+0800</CreateTime>

                <Region>ap-chongqing</Region>

                <AliasBucketId/>

                <BucketId>examplebucket-1250000000</BucketId>

        </DocBucketList>

        <DocBucketList>

                <Name>examplebucket-1250000000</Name>

                <CreateTime>2020-07-24T22:42:26+0800</CreateTime>

                <Region>ap-chongqing</Region>

                <AliasBucketId/>

                <BucketId>examplebucket-1250000000</BucketId>

        </DocBucketList>

</Response>
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文档转码
文档转码同步请求
最近更新时间：2023-08-02 16:17:43

文档预览功能支持对多种文件类型生成图片格式预览，并可对转换后的图片同步进行基础处理操作，可以解决文档内

容的页面展示问题，满足 PC、App 等多个用户端的文档在线浏览需求，适用于在线教育、企业 OA、网站转码等

业务场景。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

说明

使用时您需要先开通服务，详情请参见 设置文档预览 。开通服务后，对于当前存储桶中的文档资源，使

用相应的文档预览 API 接口即可实现同步或异步文档预览请求。

文档预览为付费功能，由数据万象收取，具体费用请参见 文档处理费用 。

数据万象在每个账户首次产生文档预览转图片用量后，将发放一个用量为6000页，有效期为2个月的文

档预览转图片免费额度资源包，超出用量或资源包到期后将正常计费。

文档转码的转换逻辑与本地的打印逻辑相同，如果您需要改变转换方向（例如将列数较多的 excel 文件

横向输出到一页），需要更改源文件打印设置。

请求

请求示例

GET /<ObjectKey>?ci-process=doc-preview&page=<page>&srcType=<srcType>&Image

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

私有存储桶需要携带下载文件的签名。

请求头

通用请求参数

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/45905
https://cloud.tencent.com/document/product/436/58967
https://cloud.tencent.com/document/product/436/7778
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名称 描述 类

型

是否

必选

Objec

tKey
对象文件名，例如 folder/document.pdf

Str

ing
是

ci-
proce

ss

数据万象处理能力，文档预览固定为 doc-preview
Str
ing

是

srcTy

pe

源数据的后缀类型，当前文档转换根据 COS 对象的后缀名来确定源数据类

型。当 COS 对象没有后缀名时，可以设置该值

Str

ing
否

page
需转换的文档页码，默认从1开始计数；表格文件中 page 表示转换的第 X 

个 sheet 的第 X 张图
Int 否

dstTy

pe

转换输出目标文件类型：

如果传入的格式未能识别，默认使用 jpg 格式

png，转成 png 格式的图片文件

jpg，转成 jpg 格式的图片文件

pdf，转成 pdf 格式的图片文件。无法选择页码，page 参数不生效

Str

ing
否

pass

word
Office 文档的打开密码，如果需要转换有密码的文档，请设置该字段

Str

ing
否

comm

ent

是否隐藏批注和应用修订，默认为 0

0：隐藏批注，应用修订

1：显示批注和修订

Int 否

适用于表格文件（Excel）的参数

名称 描述
类

型

是否

必选

sheet 表格文件参数，转换第 X 个表，默认为1 Int 否

excelPape
rDirection

表格文件转换纸张方向，0代表垂直方向，非0代表水平方向，默认为0 Int 否

excelPape

rSize

设置纸张（画布）大小，对应信息为： 0 → A4  、 1 → A2  、 

2 → A0  ，默认 A4 纸张 （需配合  excelRow   或  excelCol   一

起使用）

Int 否

适用于转码成  png/jpg 图片的参数

名称 描述 类 是否
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该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

型 必选

imagePa
rams

转换后的图片处理参数，支持 基础图片处理  所有处理参数，多个处理参

数可通过 管道操作符  分隔，从而实现在一次访问中按顺序对图片进行不
同处理

Str
ing

否

quality
生成预览图的图片质量，取值范围为 [1, 100]，默认值100。 例如取值为

100，代表生成图片质量为100%
Int 否

scale
预览图片的缩放参数，取值范围为 [10, 200]， 默认值100。 例如取值为

200，代表图片缩放比例为200% 即放大两倍
Int 否

imageDp
i

按指定 dpi 渲染图片，该参数与  scale   共同作用，取值范围  

96-600  ，默认值为  96  。转码后的图片单边宽度需小于65500像素
Int 否

注意

目前支持的输入文件类型包含如下格式：

演示文件：pptx、ppt、pot、potx、pps、ppsx、dps、dpt、pptm、potm、ppsm。

文字文件：doc、dot、wps、wpt、docx、dotx、docm、dotm。

表格文件：xls、xlt、et、ett、xlsx、xltx、csv、xlsb、xlsm、xltm、ets。 

表格文件，一张表可能分割为多页转换，生成多张图片。

其他格式文件： pdf、 lrc、 c、 cpp、 h、 asm、 s、 java、 asp、 bat、 bas、 prg、 

cmd、 rtf、 txt、 log、 xml、 htm、 html。

输入文件大小限制在200MB之内。

输入文件页数限制在5000页之内。

同步接口适用于百页内PDF文件预览少数页的情况，若文件较大建议使用异步接口。

请求体

响应

响应头

响应参数说明

参数名称 描述
类

型

X-Total- 在 http header 中返回文档总页数（表格文件表示当前 sheet 转换后的总图片 Int

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/460/6924
https://cloud.tencent.com/document/product/460/15293


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1057 共1701页

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

案例一：普通文档预览

Page 数），异常时为空

Content-

Type

根据图片实际的格式，返回不同的值，例如 image/jpeg、image/webp，异常

时保持现有值即可

Str

ing

X-ErrNo 当异常时返回错误码，可在 http header 中查看
Str

ing

X-Total-
Sheet

表格文件返回参数，在 http header 中返回文档中总表数 Int

X-Sheet-

Name
表格文件返回参数，在 http header 中返回当前 sheet 名

Str

ing

错误码

实际案例

请求

GET /sample.pdf?ci-process=doc-preview&page=1 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-shanghai.myqcloud.com

响应1：成功预览

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

X-Total-Page: 100

[转码后图片data]

响应2：文件不存在

HTTP/1.1 404 OK

Connection: close

Content-Length: 455

Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3004

https://cloud.tencent.com/document/product/436/7730
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案例二：文档预览并进行缩放和添加文字水印的图片处理

响应3：指定页码不存在

HTTP/1.1 404 OK

Connection: close

Content-Length: 455

Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3013

请求

GET /sample.pdf?ci-process=doc-preview&page=1&ImageParams=imageMogr2/thumbna

Host: examplebucket-1250000000.cos.ap-shanghai.myqcloud.com

响应1：成功预览

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

X-Total-Page: 100

[转码后图片data]

响应2：文件不存在

HTTP/1.1 404 OK

Connection: close

Content-Length: 455

Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3004

响应3：指定页码不存在

HTTP/1.1 404 OK

Connection: close

Content-Length: 455
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Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3015
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异步处理任务接口
提交文档转码任务
最近更新时间：2022-07-20 09:16:27

CreateDocProcessJobs 接口用于提交一个文档转码任务。

功能描述

注意

目前支持的输入文件类型包含如下格式：

演示文件：pptx、ppt、pot、potx、pps、ppsx、dps、dpt、pptm、potm、ppsm。

文字文件：doc、dot、wps、wpt、docx、dotx、docm、dotm。

表格文件：xls、xlt、et、ett、xlsx、xltx、csv、xlsb、xlsm、xltm、ets。 

 表格文件，一张表可能分割为多页转换，生成多张图片。

其他格式文件： pdf、 lrc、 c、 cpp、 h、 asm、 s、 java、 asp、 bat、 bas、 prg、 

cmd、 rtf、 txt、 log、 xml、 htm、 html。

输入文件大小限制在200M之内。

输入文件页数限制在5000页之内。

请求

请求示例

POST /doc_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

请求体

<Request>

  <Tag></Tag>

  <Input>

    <Object></Object>

  </Input>

  <Operation>

    <Output>

      <Region></Region>

      <Bucket></Bucket>

      <Object></Object>

    </Output>

    <DocProcess>

       <StartPage></StartPage>

       <EndPage></EndPage>

       <TgtType></TgtType>

    </DocProcess>

  </Operation>

  <QueueId></QueueId>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称

（关键
字）

父

节
点

描述 类型

是

否
必

选

Tag

Re

qu
est

创建任务的 Tag，目前仅支持：DocProcess
Stri
ng

是

Input Re 待操作的文件对象 Con 是

https://cloud.tencent.com/document/product/460/42865
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Container 类型 Input 的具体数据描述如下：

Container 类型 Operation 的具体数据描述如下：

Container 类型 DocProcess 的具体数据描述如下：

qu
est

tain
er

Operati

on

Re

qu
est

操作规则

Con

tain
er

是

QueueId

Re

qu
est

任务所在的队列 ID，开通预览服务后自动生成，请使用 查询队

列  获取或前往 万象控制台  在存储桶中查询 

Stri

ng
是

节点名称（关键

字）
父节点 描述 类型

是否必

选

Object
Request.In
put

文件在 COS 上的文件路径，Bucket 由 
Host 指定

Stri
ng

是

节点名称（关

键字）
父节点 描述 类型

是否

必选

DocProces

s

Request.Oper

ation

当 Tag 为 DocProcess 时有效，指定

该任务的参数

Contai

ner
是

Output
Request.Oper

ation
结果输出地址

Contai

ner
是

通用请求参数

节点

名称

（关
键

字）

父节点 描述
类

型

是

否

必
选

SrcT
ype

Request.O
peration.D

ocProcess

源数据的后缀类型，当前文档转换根据 cos 对象的后缀名来确
定源数据类型，当 cos 对象没有后缀名时，可以设置该值

S

tr
in

g

否

https://cloud.tencent.com/document/product/460/46946
https://console.cloud.tencent.com/ci
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TgtT
ype

Request.O
peration.D

ocProcess

转换输出目标文件类型：
jpg，转成 jpg 格式的图片文件；如果传入的格式未能识

别，默认使用 jpg 格式

png，转成 png 格式的图片文件

pdf，转成 pdf 格式文件（暂不支持指定页数）

S
tr

in

g

否

Star

tPag

e

Request.O

peration.D

ocProcess

从第 X 页开始转换；在表格文件中，一张表可能分割为多页转

换，生成多张图片。StartPage 表示从指定 SheetId 的第 X 

页开始转换。默认为1

I

n

t

否

End

Pag

e

Request.O

peration.D

ocProcess

转换至第 X 页；在表格文件中，一张表可能分割为多页转换，

生成多张图片。EndPage 表示转换至指定 SheetId 的第 X 

页。默认为-1，即转换全部页

I

n

t

否

适用于表格文件（Excel）的参数

节点名称
（关键

字）

父节点 描述
类
型

是

否
必

选

SheetId
Request.Operati
on.DocProcess

表格文件参数，转换第 X 个表，默认为0；设置 
SheetId 为0，即转换文档中全部表

I
n

t

否

PaperDi
rection

Request.Operati
on.DocProcess

表格文件转换纸张方向，0代表垂直方向，非0代表
水平方向，默认为0

I

n
t

否

PaperSi

ze

Request.Operati

on.DocProcess

设置纸张（画布）大小，对应信息为： 0 → A4  、 

1 → A2  、 2 → A0  ，默认 A4 纸张

I

n
t

否

适用于转码成  png/jpg 图片的参数

节

点

名

称
（

关

键

字

）

父节点 描述
类
型

是

否
必

选
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Container 类型 Output 的具体数据描述如下：

Im

ag
eP

ar

a

ms

Reques

t.Opera
tion.Do

cProce

ss

转换后的图片处理参数，支持 基础图片处理  所有处理参数，多个处理

参数可通过 管道操作符  分隔，从而实现在一次访问中按顺序对图片进
行不同处理

S

tr
in

g

否

Qu

alit

y

Reques

t.Opera

tion.Do

cProce
s

生成预览图的图片质量，取值范围 [1-100]，默认值100。 例：值为

100，代表生成图片质量为100%

I

n

t

否

Zo
o

m

Reques

t.Opera
tion.Do

cProce

s

预览图片的缩放参数，取值范围[10-200]， 默认值100。 例：值为
200，代表图片缩放比例为200% 即放大两倍

I
n

t

否

Im

ag

eD

pi

Reques
t.Opera

tion.Do

cProce

ss

按指定 dpi 渲染图片，该参数与  Zoom   共同作用，取值范围  

96-600  ，默认值为  96  。转码后的图片单边宽度需小于65500像

素

I

n

t

否

Pi

cP

agi

na
tio

n

Reques

t.Opera

tion.Do
cProce

ss

是否转换成单张长图，设置为 1  时，最多仅支持将 20 标准页面合成

单张长图，超过可能会报错，分页范围可以通过 StartPage、

EndPage 控制。默认值为 0  ，按页导出图片，

TgtType="png"/"jpg"  时生效

I

n
t

否

节

点

名
称

（

关

键
字

）

父节

点
描述

类

型

是

否

必

选

R

e

Requ

est.

存储桶的地域 St

ri

是

https://cloud.tencent.com/document/product/460/6924
https://cloud.tencent.com/document/product/460/15293
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

g

i

o
n

Oper

ation

.Out
put

n

g

B

u

c
k

e

t

Requ

est.

Oper
ation

.Out

put

存储结果的存储桶

St

ri
n

g

是

O

b

j

e
c

t

Requ

est.

Oper

ation
.Out

put

输出文件路径。

非表格文件输出文件名需包含 ${Number} 或 ${Page} 参数。多个输出

文件，${Number} 表示序号从1开始，${Page} 表示序号与预览页码一

致。

表格文件输出路径需包含 ${SheetID} 占位符，输出文件名必须包含 

${Number} 参数。

${Number} 表示多个输出文件，序号从1开始，例如输入 

abc_${Number}.jpg，预览某文件5 - 6页，则输出文件名为 

abc_1.jpg，abc_2.jpg

${Page} 表示多个输出文件，序号与预览页码一致，例如输入 
abc_${Page}.jpg，预览某文件5-6页，则输出文件名为 

abc_5.jpg，abc_6.jpg

例如 /${SheetID}/abc_${Number}.jpg ，先根据 excel 转换的表

格数，生成对应数量的文件夹，再在对应的文件夹下，生成对应数量的

图片文件

St

ri

n
g

是

响应

响应头

响应体

<Response>

        <JobsDetail>

                <Code></Code>

                <CreationTime></CreationTime>

                <EndTime></EndTime>

                <Input>

                    <Object></Object>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

                </Input>

                <JobId></JobId>

                <Message/>

                <Operation>

                    <DocProcess>

                        <SrcType></SrcType>

                        <TgtType></TgtType>

                        <StartPage></StartPage>

                        <EndPage></EndPage>

                        <ImageParams></ImageParams>

                    </DocProcess>

                    <Output>

                        <Bucket></Bucket>

                        <Object></Object>

                        <Region></Region>

                    </Output>

                </Operation>

                <QueueId></QueueId>

                <State></State>

                <Tag></Tag>

        </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container

节点名称
（关键字）

父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Strin

g

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Strin

g
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Container 节点 Input 的内容： 

同上面请求中的 Request.Input 节点。

Container 节点 Operation 的内容：

Container 节点 DocProcess 的内容： 

同上面请求中的 Request.Operation.DocProcess 节点。

Container 节点 Output 的内容： 

同上面请求中的 Request.Operation.Output 节点。

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

JobId Response.J
obsDetail

新创建任务的 ID Strin
g

Tag
Response.J

obsDetail
新创建任务的 Tag：DocProcess

Strin

g

State
Response.J

obsDetail

任务的状态，为 Submitted、Running、Success、

Failed、Pause、Cancel 其中一个

Strin

g

Creation
Time

Response.J
obsDetail

任务的创建时间
Strin
g

QueueId
Response.J

obsDetail
任务所属的队列 ID

Strin

g

Input
Response.J

obsDetail
该任务的输入文件路径

Cont

ainer

Operatio
n

Response.J
obsDetail

该任务的规则
Cont
ainer

节点名称（关键字） 父节点 描述 类型

DocProcess Response.JobsDetail.Operation 文档预览任务参数 Container

Output Response.JobsDetail.Operation 文件的输出地址 Container

错误码

实际案例

请求

POST /doc_jobs HTTP/1.1

Connection: keep-alive

https://cloud.tencent.com/document/product/460/42867
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Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: examplebucket-1250000000.ci.ap-chongqing.myqcloud.com

Content-Type: application/xml

Content-Length: 546

Authorization: Authorization

<?xml version="1.0" encoding="UTF-8" ?>

<Request>

    <Input>

        <Object>1.doc</Object>

    </Input>

    <Operation>

      <Output>

          <Region>ap-chongqing</Region>

          <Object>big/test-${Number}</Object>

          <Bucket>examplebucket-1250000000</Bucket>

      </Output>

      <DocProcess>

          <TgtType>png</TgtType>

          <StartPage>1</StartPage>

          <EndPage>-1</EndPage>

          <ImageParams>watermark/1/image/aHR0cDovL3Rlc3QwMDUtMTI1MTcwNDcwOC5

      </DocProcess>

    </Operation>

    <Tag>DocProcess</Tag>

    <QueueId>p532fdead78444e649e1a4467c1cd19d3</QueueId>

</Request>[!http]

响应

HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 07:20:08 GMT

Content-Type: application/xml

Content-Length: 863

Connection: keep-alive

Server: tencent-ci

x-ci-request-id: NWYxZTgwMjhfYzc2OTQzNjRfMzUx****

<?xml version="1.0" encoding="utf-8"?>

<Response>

        <JobsDetail>
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                <Code>Success</Code>

                <CreationTime>2020-07-27T15:20:08+0800</CreationTime>

                <EndTime>-</EndTime>

                <Input>

                        <Object>1.doc</Object>

                </Input>

                <JobId>d99b3127ecfd911eab5e60dedb7c395dd</JobId>

                <Message/>

                <Operation>

                        <DocProcess>

                                <EndPage>5001</EndPage>

                                <ImageParams>watermark/1/image/aHR0cDovL3Rlc3QwMDUtMTI1M

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <Output>

                                <Bucket>examplebucket-1250000000</Bucket>

                                <Object>big/test-${Number}</Object>

                                <Region>ap-chongqing</Region>

                        </Output>

                </Operation>

                <QueueId>p532fdead78444e649e1a4467c1cd19d3</QueueId>

                <State>Submitted</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

</Response>
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查询指定的文档转码任务
最近更新时间：2022-07-07 16:16:25

DescribeDocProcessJob 用于查询指定的文档转码任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /doc_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

        <JobsDetail>

                <Code></Code>

                <CreationTime></CreationTime>

                <EndTime></EndTime>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

                <Input>

                        <Object></Object>

                </Input>

                <JobId></JobId>

                <Message> </Message>

                <Operation>

                        <DocProcess>

                                <EndPage></EndPage>

                                <ImageParams></ImageParams>

                                <SrcType></SrcType>

                                <StartPage></StartPage>

                                <TgtType></TgtType>

                        </DocProcess>

                        <DocProcessResult>

                                <FailPageCount></FailPageCount>

                                <PageInfo>

                                        <PageNo></PageNo>

                                        <TgtUri></TgtUri>

                                </PageInfo>

                                <SuccPageCount></SuccPageCount>

                                <TaskId></TaskId>

                                <TgtType></TgtType/>

                                <TotalPageCount></TotalPageCount>

                        </DocProcessResult>

                        <Output>

                                <Bucket></Bucket>

                                <Object></Object>

                                <Region></Region>

                        </Output>

                </Operation>

                <QueueId></QueueId>

                <State></State>

                <Tag></Tag>

        </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称 父节点 描述 类型
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Container 节点 Operation 的内容：

Container 节点 DocProcessResult 节点的内容

（关键字）

JobsDetail
Resp

onse

任务的详细信息，同 CreateDocProcessJobs  接口的 

Response.JobsDetail 节点

Conta

iner

NonExistJ
obIds

Resp
onse

查询的 ID 中不存在的任务，所有任务都存在时不返回 String

节点名称

（关键

字）

父节点 描述 类型

DocPro

cess

Response.Jobs

Detail.Operation

文档预览任务参数，同 CreateDocProcessJobs  接

口的 Request.Operation.DocProcess 节点

Co

ntai

ner

DocPro
cessRes

ult

Response.Jobs

Detail.Operation

在 job 的类型为 DocProcess 且 job 状态为 success 

时，返回文档预览任务结果详情

Co
ntai

ner

Output
Response.Jobs
Detail.Operation

结果输出地址，同 CreateDocProcessJobs  接口的 
Request.Operation.Output 节点

Co
ntai

ner

节点名称

（关键字）
父节点 描述 类型

PageInfo
Response.JobsDetail.Operation.
DocProcessResult

预览任务产物详情
Cont
ainer

TgtType
Response.JobsDetail.Operation.

DocProcessResult
预览产物目标格式

Strin

g

TotalPag

eCount

Response.JobsDetail.Operation.

DocProcessResult
预览任务产物的总数 Int

SuccPag
eCount

Response.JobsDetail.Operation.
DocProcessResult

预览任务产物的成功数 Int

FailPage

Count

Response.JobsDetail.Operation.

DocProcessResult
预览任务产物的失败数 Int

TotalShe Response.JobsDetail.Operation. 预览任务的 Sheet 总数（源文件 Int

https://cloud.tencent.com/document/product/460/46942#.E5.93.8D.E5.BA.94
https://cloud.tencent.com/document/product/460/46942#.E8.AF.B7.E6.B1.82
https://cloud.tencent.com/document/product/460/46942#.E8.AF.B7.E6.B1.82
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Container 节点 PageInfo 节点的内容

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

etCount DocProcessResult 为 Excel 特有参数）

节点名称

（关键
字）

父节点 描述 类型

PageN

o

Response.JobsDetail.Operation.

DocProcessResult.PageInfo

预览产物页码,源文件为 Excel 格式

时表示 SheetId

Con

tain
er

TgtUri
Response.JobsDetail.Operation.

DocProcessResult.PageInfo
预览产物生成的 cos 桶路径 Int

X-

SheetPi

cs

Response.JobsDetail.Operation.

DocProcessResult.PageInfo

当前 Sheet 生成的图片总数（源文

件为 Excel 特有参数）
Int

PicInde

x

Response.JobsDetail.Operation.

DocProcessResult.PageInfo

当前预览产物在整个源文件中的序号

（源文件为 Excel 特有参数）
Int

PicNum
Response.JobsDetail.Operation.

DocProcessResult.PageInfo

当前预览产物在 Sheet 中的序号

（源文件为 Excel 特有参数）
Int

错误码

实际案例

请求

GET /doc_jobs/d13cfd584cd9011ea820b597ad1785a2f HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

1.非 Excel 文档请求响应

<Response>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-07-24T17:28:47+0800</CreationTime>

                <EndTime>2020-07-24T17:28:49+0800</EndTime>

https://cloud.tencent.com/document/product/460/42867
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                <Input>

                        <Object>1.doc</Object>

                </Input>

                <JobId>d13cfd584cd9011ea820b597ad1785a2f</JobId>

                <Message/>

                <Operation>

                        <DocProcess>

                                <EndPage>0</EndPage>

                                <ImageParams/>

                                <SrcType/>

                                <StartPage>2</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <DocProcessResult>

                                <FailPageCount>0</FailPageCount>

                                <PageInfo>

                                        <PageNo>2</PageNo>

                                        <TgtUri>big/test-1</TgtUri>

                                </PageInfo>

                                <SuccPageCount>1</SuccPageCount>

                                <TaskId/>

                                <TgtType/>

                                <TotalPageCount>2</TotalPageCount>

                        </DocProcessResult>

                        <Output>

                                <Bucket>examplebucket-1250000000</Bucket>

                                <Object>big/test-${Number}</Object>

                                <Region>ap-chongqing</Region>

                        </Output>

                </Operation>

                <QueueId>p50882922b848464fadd222d771438328</QueueId>

                <State>Success</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

</Response>

2. Excel 格式响应

<Response>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-12-03T19:54:10+0800</CreationTime>

                <EndTime>2020-12-03T19:54:13+0800</EndTime>

                <Input>
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                        <Object>1.xlsx</Object>

                </Input>

                <JobId>d13cfd584cd9011ea820b597ad1785a2f</JobId>

                <Message/>

                <Operation>

                        <DocProcess>

                                <Comments>0</Comments>

                                <DocPassword/>

                                <EndPage>2</EndPage>

                                <ImageParams/>

                                <PaperDirection>0</PaperDirection>

                                <PaperSize>0</PaperSize>

                                <Quality>100</Quality>

                                <SheetId>0</SheetId>

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType/>

                                <Zoom>100</Zoom>

                        </DocProcess>

                        <DocProcessResult>

                                <FailPageCount>0</FailPageCount>

                                <PageInfo>

                                        <PageNo>1</PageNo>

                                        <PicIndex>1</PicIndex>

                                        <PicNum>1</PicNum>

                                        <TgtUri>mark2/1/test-1.jpg</TgtUri>

                                        <X-SheetPics>2</X-SheetPics>

                                </PageInfo>

                                <PageInfo>

                                        <PageNo>1</PageNo>

                                        <PicIndex>2</PicIndex>

                                        <PicNum>2</PicNum>

                                        <TgtUri>mark2/1/test-2.jpg</TgtUri>

                                        <X-SheetPics>2</X-SheetPics>

                                </PageInfo>

                                <SuccPageCount>6</SuccPageCount>

                                <TaskId/>

                                <TgtType/>

                                <TotalPageCount>6</TotalPageCount>

                                <TotalSheetCount>3</TotalSheetCount>

                        </DocProcessResult>

                        <Output>

                                <Bucket>markjrzhang-1251704708</Bucket>

                                <Object>mark/${SheetID}/pic-${Page}.jpg</Object>

                                <Region>ap-chongqing</Region>
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                        </Output>

                </Operation>

                <QueueId>p5fdbba9a9b83479f84538d5beb*****</QueueId>

                <State>Success</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

</Response>
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拉取符合条件的文档转码任务
最近更新时间：2023-07-13 14:44:51

DescribeDocProcessJobs 用于拉取符合条件（状态、创建时间等）的文档转码任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

参数的具体内容如下：

功能描述

请求

请求示例

GET /doc_jobs?queueId=<queueId>&tag=DocProcess HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

节点名称

（关键字）

父

节

点

描述 类型

是

否

必

选

tag 无 任务的 Tag：DocProcess。
Stri

ng
是

queueId 无
拉取该队列 ID 下的任务，可在任务响应内容或 控制台  中获
取。

Stri
ng

否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/46487
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

orderByTi

me

无 Desc 或者 Asc。默认为 Desc。 Stri

ng

否

nextToke

n
无 请求的上下文，用于翻页。上次返回的值。

Stri

ng
否

size 无 拉取的最大任务数。默认为10。最大为100。
Inte
ger

否

states 无
拉取该状态的任务，以 , 分割，支持多状态：All、

Submitted、Running、Success、Failed、Pause、
Cancel。默认为 All。

Stri

ng
否

startCrea

tionTime
无

拉取创建时间大于等于该时间的任务。格式为：

%Y-%m-%dT%H:%m:%S%z

Stri

ng
否

endCreati

onTime
无

拉取创建时间小于等于该时间的任务。格式为：

%Y-%m-%dT%H:%m:%S%z

Stri

ng
否

响应

响应头

响应体

<Response>

  <JobsDetail></JobsDetail>

  <NextToken></NextToken>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称

（关键字）
父节点 描述 类型

JobsDetai Resp 任务的详细信息，同 CreateDocProcessJobs  接口中的 Cont

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/46942#.E5.93.8D.E5.BA.94
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

l onse Response.JobsDetail 节点。 ainer

NextToke
n

Resp
onse

翻页的上下文 Token。
Strin
g

错误码

实际案例

请求

GET /doc_jobs/queueId=QueueId&tag=DocProcess HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

<Response>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-07-20T10:43:17+0800</CreationTime>

                <EndTime>-</EndTime>

                <Input>

                        <Object>1.docx</Object>

                </Input>

                <JobId>JobId</JobId>

                <Message/>

                <Operation>

                        <DocProcess>

                                <EndPage>1</EndPage>

                                <ImageParams>ImageParams</ImageParams>

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <Output>

                                <Bucket>BucketId</Bucket>

                                <Object>file/test-${Page}.jpg</Object>

                                <Region>Region</Region>

                        </Output>

                </Operation>

                <QueueId>QueueId</QueueId>

https://cloud.tencent.com/document/product/460/42867
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                <State>Submitted</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-07-20T10:43:17+0800</CreationTime>

                <EndTime>-</EndTime>

                <Input>

                        <Object>test.docx</Object>

                </Input>

                <JobId>JobId</JobId>

                <Message/>

                <Operation>

                        <DocProcess>

                                <EndPage>1</EndPage>

                                <ImageParams>ImageParams</ImageParams>

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <Output>

                                <Bucket>BucketId</Bucket>

                                <Object>file/test-${Page}.jpg</Object>

                                <Region>Region</Region>

                        </Output>

                </Operation>

                <QueueId>QueueId</QueueId>

                <State>Submitted</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

        <NextToken>19193</NextToken>

</Response>
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异步处理队列接口

查询文档转码队列
最近更新时间：2022-07-07 16:16:45

DescribeDocProcessQueues 接口用于查询文档转码队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /docqueue?pageNumber=1&pageSize=2 HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

名称 描述
类

型

是

否

必

选

que

ueI

队列 ID，以“,”符号分割字符串 st

ri

否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据。

响应体1：当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展示如下。

ds n
g

stat

e

1. Active 表示队列内的作业会被文档预览服务调度执行

2. Paused  表示队列暂停，作业不再会被文档预览服务调度执行，队列内的所有
作业状态维持在暂停状态，已经处于执行中的任务将继续执行，不受影响

st

ri

n
g

否

pag

eNu
mb

er

第几页，默认第一页

st

ri
n

g

否

pag
eSiz

e

每页个数，默认10个

st

ri
n

g

否

响应

响应头

响应体

<Response>

        <TotalCount>1</TotalCount>

        <RequestId>RequestId</RequestId>

        <PageNumber>1</PageNumber>

        <PageSize>2</PageSize>

        <QueueList>

                <QueueId>QueueId</QueueId>

                <Name>QueueName</Name>

                <State>Active</State>

                <NotifyConfig>

                        <Url>url</Url>

                        <Event>Event</Event>

                        <Type/></Type>

                        <State>Off</State>

                </NotifyConfig>

                <MaxSize>10000</MaxSize>

                <MaxConcurrent>10</MaxConcurrent>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 QueueList 的内容：

                <CreateTime>CreateTime</CreateTime>

                <UpdateTime>UpdateTime</UpdateTime>

                <BucketId>BucketId</BucketId>

                <Category>DocProcess</Category>

        </QueueList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

TotalCount Response 队列总数 Int

PageNumber Response 当前页数，同请求中的 pageNumber Int

PageSize Response 每页个数，同请求中的 pageSize Int

QueueList Response 队列数组 Container

节点名称（关键字） 父节点 描述 类型

QueueId Response.QueueList 队列 ID String

Name Response.QueueList 队列名字 String

State Response.QueueList 当前状态，Active 或者 Paused String

NotifyConfig Response.QueueList 回调配置 Container

MaxSize Response.QueueList 队列最大长度 Int

MaxConcurrent Response.QueueList 当前队列最大并行执行的任务数 Int

UpdateTime Response.QueueList 更新时间 String

CreateTime Response.QueueList 创建时间 String
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Container 节点 NotifyConfig 的内容：

响应体2：当指定 queueIds 时包含完整节点数据的内容展示如下。

具体的数据内容如下：

Container 节点 Response 的内容：

节点名称（关键
字）

父节点 描述 类型

Url
Response.QueueList.NotifyConfi

g
回调地址 String

State
Response.QueueList.NotifyConfi

g
开关状态，On 或者 Off String

Type
Response.QueueList.NotifyConfi
g

回调类型，Url String

Event
Response.QueueList.NotifyConfi

g
触发回调的事件 String

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <QueueList>

        <QueueId>A</QueueId>

        <Name></Name>

        <State>Active</State>

        <NotifyConfig>

            <Url></Url>

        </NotifyConfig>

    </QueueList>

    <NonExistPIDs>

        <QueueID>B</QueueID>

        <QueueID>C</QueueID>

    </NonExistPIDs>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型
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Container 节点 NonExistPIDs 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

RequestId Response 请求的唯一 ID String

QueueList Response 队列数组，同上面解释的 QueueList Container

NonExistPIDs Response 不存在的队列 ID 列表 Container

节点名称（关键字） 父节点 描述 类型

QueueID Response.NonExistPIDs 队列 ID String

错误码

实际案例

请求

GET /docqueue?pageNumber=1&pageSize=2 HTTP/1.1

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: examplebucket-1250000000.ci.ap-chongqing.myqcloud.com

Content-Type: application/xml

Authorization: Authorization

响应

HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 07:29:28 GMT

Content-Type: application/xml

Content-Length: 677

Connection: keep-alive

Server: tencent-ci

x-ci-request-id: NWYxZTgyNTdfYzc2OTQzNjRfMzUx****

<?xml version="1.0" encoding="utf-8"?>

<Response>

        <TotalCount>1</TotalCount>

        <RequestId>NWYxZTgyNTdfYzc2OTQzNjRfMzUx****</RequestId>

        <PageNumber>1</PageNumber>

        <PageSize>2</PageSize>

https://cloud.tencent.com/document/product/460/42867
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        <QueueList>

                <QueueId>p2505d57bdf4c4329804b58a6a5fb1572</QueueId>

                <Name>queue-doc-process-1</Name>

                <State>Active</State>

                <NotifyConfig>

                        <Url/>

                        <Event/>

                        <Type/>

                        <State>Off</State>

                </NotifyConfig>

                <MaxSize>10000</MaxSize>

                <MaxConcurrent>10</MaxConcurrent>

                <CreateTime>2020-07-24T22:42:27+0800</CreateTime>

                <UpdateTime>2020-07-24T22:42:27+0800</UpdateTime>

                <BucketId>examplebucket-1250000000.</BucketId>

                <Category>DocProcessing</Category>

        </QueueList>

</Response>
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更新文档转码队列
最近更新时间：2022-07-07 16:16:54

UpdateDocProcessQueue 接口用于更新文档转码队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有以下请求体。

功能描述

请求

请求示例

PUT /docqueue/p8eb46b8cc1a94bc09512d16c5c4f4d3a HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Name>Queue Name</Name>

    <QueueID></QueueID>

    <State></State>

    <NotifyConfig>

        <Type></Type>

        <Url></Url>

        <Event></Event>

    </NotifyConfig>

</Request>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 NotifyConfig 的具体数据描述如下：

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名

称（关

键字）

父节

点

描

述
类型

是
否

必

选

限制

Name
Req

uest

队

列

名

称

Strin

g
是 长度限制100字符

Queu

eID

Req

uest

队

列 

ID

Strin

g
是 无

State
Req

uest

队

列

状
态

Strin

g
是

1. Active 表示队列内的作业会被文档预览服务调度转码

执行

2. Paused 表示队列暂停，作业不再会被文档预览服务

调度执行，队列内的所有作业状态维持在已提交状
态，已经处于执行中的任务将继续执行，不受影响     

Notify

Confi
g

Req
uest

通

知
渠

道

Cont
ainer

是 第三方回调 Url

节点名称（关

键字）
父节点 描述 类型

是否

必选
限制

Url
Request.NotifyC

onfig
回调配置

Stri

ng
否

长度限制100

字符

Type Request.NotifyC 回调类型，普通回调： Stri 否 长度限制100
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

onfig Url ng 字符

Event
Request.NotifyC
onfig

回调事件，文档预览任
务完成

Stri
ng

否
长度限制100
字符

State
Request.NotifyC

onfig
回调开关，Off，On

Stri

ng
否

长度限制100

字符

响应

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Queue>

        <QueueId></QueueId>

        <Name></Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>mts-topic-1</Url>

            <Type></Type>

            <Event></Event>

        </NotifyConfig>

        <CreateTime></CreateTime>

        <UpdateTime></UpdateTime>

    </Queue>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称

（关键字）

父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

RequestId
Resp

onse
请求的唯一 ID String

Queue
Resp
onse

队列信息，详情请参见 DescribeDocProcessQueues  中的 
Response.QueueList

Conta
iner

错误码

实际案例

请求

PUT /docqueue/p2505d57bdf4c4329804b58a6a5fb1572 HTTP/1.1

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: examplebucket-1250000000.ci.ap-chongqing.myqcloud.com

Content-Type: application/xml

Content-Length: 279

Authorization: Authorization

<?xml version="1.0" encoding="UTF-8" ?>

<Request>

    <QueueId>p2505d57bdf4c4329804b58a6a5fb1572</QueueId>

    <State>Active</State>

    <Name>markjrzhang4</Name>

    <NotifyConfig>

        <Url>http://google.com/</Url>

    <State>On</State>

        <Type>Url</Type>

        <Event>TransCodingFinish</Event>

    </NotifyConfig>

</Request>[!http]

响应

HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 08:22:41 GMT

Content-Type: application/xml

Content-Length: 641

Connection: keep-alive

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/46946
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Server: tencent-ci

x-ci-request-id: NWYxZThlZDBfYzc2OTQzNjRfMzUxYV8x****

<?xml version="1.0" encoding="utf-8"?>

<Response>

        <RequestId>NWYxZThlZDBfYzc2OTQzNjRfMzUxYV8x****</RequestId>

        <Queue>

                <QueueId>p2505d57bdf4c4329804b58a6a5fb1572</QueueId>

                <Name>markjrzhang4</Name>

                <State>Active</State>

                <NotifyConfig>

                        <Url>http://example.com/</Url>

                        <Event>TransCodingFinish</Event>

                        <Type>Url</Type>

                        <State>On</State>

                </NotifyConfig>

                <MaxSize>10000</MaxSize>

                <MaxConcurrent>10</MaxConcurrent>

                <CreateTime>2020-07-24T22:42:27+0800</CreateTime>

                <UpdateTime>2020-07-27T16:22:40+0800</UpdateTime>

                <BucketId>test007-1251704708</BucketId>

                <Category>DocProcessing</Category>

        </Queue>

</Response>
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支持的功能和效果
最近更新时间：2022-12-02 09:55:26

以下是文档转图片功能支持的功能和效果：

类

型
文件名后缀 支持的功能和效果

演

示

ppt、pptx、pptm、
ppsx、ppsm、pps、

potx、potm、dpt、dps

幻灯片背景、对象边框/填充、对象阴影/倒影、文本（横/竖向文本
框、占位符、形状）、图片、链接、艺术字、形状、表格、图表、

公式、符号、脑图、流程图

文
字

doc、dot、wps、wpt、
docx、dotx、docm、

dotm

字属性、段属性、图片、文字表、链接、形状、代码块、日期、水
印、评论、页眉页脚

表

格

xls、 xlt、et、xlsx、

xltx、xlsm、xltm
字属性、段属性、自选图形、艺术字、公式、图片、流程图、脑图

PD

F
pdf

背景、文字（字体、字号、字色、加粗、斜体）、画笔、高亮、下

划线、删除线
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文档转 HTML
快速入门
最近更新时间：2022-10-26 15:43:24

文档转 HTML 功能支持对多种文档类型的文件生成 HTML 格式预览，满足 PC、App 等多个用户端的文档在线浏

览需求，适用于在线教育、企业 OA、在线知识库、网盘文档预览等业务场景。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

说明

对象存储封装预览 JS SDK，只需要一条 URL 即可接入 HTML 预览服务。

您可在 文档预览接入体验工具  中自行调整参数，体验接入文档预览后的预览效果，同时该工具可以根

据相应配置项生成代码，助力您快速接入文档预览。

如需在小程序内使用，请参考 小程序配置业务域名 。

如需接入 CDN 域名，需要打开 CDN 的高级缓存过期设置，详情请参见 节点缓存过期配置  CDN 文

档。

请求

请求示例

GET /<ObjectKey>?ci-process=doc-preview&dstType=html HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

请求头

请求参数

名称 描述 类型

是

否

必

选

ObjectK

ey
对象文件名，例如 folder/document.pdf

Stri

ng
是

ci- 对象存储处理能力，文档 HTML  预览固定为 doc-preview Stri 是

https://cloud.tencent.com/document/product/436/7728
https://ci-exhibition.cloud.tencent.com/tools/doc-preview/#/
https://cloud.tencent.com/document/product/436/56536#.E5.9C.A8.E5.B0.8F.E7.A8.8B.E5.BA.8F.E5.86.85.E4.BD.BF.E7.94.A8.E6.96.87.E6.A1.A3.E8.BD.AC-html-.E9.A2.84.E8.A7.88.E6.97.B6.E6.8F.90.E7.A4.BA.E2.80.9C.E4.B8.8D.E6.94.AF.E6.8C.81.E6.89.93.E5.BC.80.E9.9D.9E.E4.B8.9A.E5.8A.A1.E5.9F.9F.E5.90.8D.E2.80.9D.EF.BC.8C.E8.AF.A5.E5.A6.82.E4.BD.95.E9.85.8D.E7.BD.AE.EF.BC.9F
https://cloud.tencent.com/document/product/228/41540
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process ng

dstType 转换输出目标文件类型，文档 HTML 预览固定为 html（需为小写字母）
Stri

ng
是

srcType 指定目标文件类型，支持的文件类型请见下方
Stri

ng
否

sign
对象下载签名，如果预览的对象为私有读时，需要传入签名，详情请参见 

请求签名  文档（注意：需要进行 urlencode）

Stri

ng
否

copyabl

e
是否可复制。默认为可复制，填入值为1；不可复制，填入值为0

Stri

ng
否

htmlPar

ams

自定义配置参数，JSON 结构，需要经过 URL 安全  的 Base64 编码，

默认配置为：{ commonOptions: { isShowTopArea: true, 

isShowHeader: true } }，支持的配置参考 自定义配置项说明

Stri

ng
否

htmlwat

erword
水印文字，需要经过 URL 安全  的 Base64 编码，默认为空

Stri

ng
否

htmlfills
tyle

水印 RGBA（颜色和透明度），需要经过 URL 安全  的 Base64 编码，
默认为：rgba(192,192,192,0.6)

Stri
ng

否

htmlfro

nt

水印文字样式，需要经过 URL 安全  的 Base64 编码，默认为：bold 

20px Serif

Stri

ng
否

htmlrot

ate
水印文字旋转角度，0 - 360，默认315度

Stri

ng
否

htmlhori
zontal

水印文字水平间距，单位 px，默认为50
Stri
ng

否

htmlver

tical
水印文字垂直间距，单位 px，默认为100

Stri

ng
否

注意

目前支持的输入文件类型包含如下格式：

演示文件：pptx、ppt、pot、potx、pps、ppsx、dps、dpt、pptm、potm、ppsm。

文字文件：doc、dot、wps、wpt、docx、dotx、docm、dotm。

表格文件：xls、xlt、et、ett、xlsx、xltx、csv、xlsb、xlsm、xltm、ets。

其他格式文件： pdf、 lrc、 c、 cpp、 h、 asm、 s、 java、 asp、 bat、 bas、 prg、 

cmd、 rtf、 txt、 log、 xml、 htm、 html。

输入文件大小限制在200MB之内。

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/436/59408#.E8.87.AA.E5.AE.9A.E4.B9.89.E9.85.8D.E7.BD.AE.E9.80.89.E9.A1.B9
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

此接口请求的响应体为html预览内容，展示效果可参见下方实际案例。

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

将存储桶 examples-1258125638 中的 ObjectKey 为 test.pptx 的 PPT 文件进行在线预览，最终 URL 如

下：

直接在浏览器中打开链接，生成的预览页面如下图所示，对于幻灯片文档，还可进行全屏的幻灯片放映，支持动画、

触发器等效果，并提供虚拟激光笔、演讲者模式等功能。

输入文件页数限制在5000页之内。

请求体

响应

响应头

响应体

错误码

实际案例

案例一：简单预览

https://examples-1258125638.cos.ap-guangzhou.myqcloud.com/test.pptx?ci-process=do

说明

您还可通过 JS-SDK 实现更多功能的定制，详情请参见 自定义配置概述 。

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
https://cloud.tencent.com/document/product/460/59410
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将存储桶 examples-1258125638 中的 ObjectKey 为 test.pptx 的 PPT 文件进行在线预览。

1. 设置不可复制（copyable=0）

2. 设置test 水印（通过 URL 安全的 Base64编码得到 htmlwaterword=dGVzdAog）

3. 设置自定义配置参数（htmlParams为 {"mode":"normal","commonOptions":

{"isShowHeader":false,"isShowTopArea":true},"pptOptions":{"isSlidesStatusPlay": true}}，

通过 URL 安全的 Base64编码得到 

htmlParams=eyJtb2RlIjoibm9ybWFsIiwiY29tbW9uT3B0aW9ucyI6eyJpc1Nob3dIZWFkZXIiO

mZhbHNlLCJpc1Nob3dUb3BBcmVhIjp0cnVlfSwicHB0T3B0aW9ucyI6eyJpc1NsaWRlc1N0

YXR1c1BsYXkiOiB0cnVlfX0=）。

则最终 URL 如下：

案例二：水印 + 自定义配置预览

https://examples-1258125638.cos.ap-guangzhou.myqcloud.com/test.pptx?ci-process=do
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直接在浏览器中打开链接，生成的预览页面如下图所示，对于幻灯片文档，还可进行全屏的幻灯片放映，支持动画、

触发器等效果，并提供虚拟激光笔、演讲者模式等功能。

预览链接也可以作为iframe嵌入到业务页面中，如下所示：

<!DOCTYPE html>

<html>
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<head>

    <meta charset="utf-8">

    <meta name="viewport"

        content="width=device-width, initial-scale=1.0, maximum-scale=1.0, minimum-sca

    <meta http-equiv="Content-Type" content="text/html; charset=UTF-8">

    <meta http-equiv="X-UA-Compatible" content="IE=edge,chrome=1">

    <meta http-equiv="Content-Security-Policy" content="upgrade-insecure-requests">

    <meta name="keywords" content="对象存储,文档预览">

    <meta name="description" content="">

    <title>腾讯云-对象存储-文档预览</title>

    <style>

        html,

        body {

            padding: 0;

            margin: 0;

            height: 100%;

            touch-action: manipulation;

        }

    </style>

</head>

<body>

    <iframe src="https://examples-1258125638.cos.ap-guangzhou.myqcloud.com/test.ppt

</body>

</html>
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自定义配置概述
最近更新时间：2023-06-02 11:16:44

通过使用 JS-SDK，网页开发者可以自定义界面显示、页面状态、监听事件等能力，为用户提供更优质的网页体

验。

功能说明

架构图
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使用环境
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请下载最新版本的 JS-SDK 包 。历史版本前往 更新日志 。

在需要调用的页面引入如下 JS-SDK。示例中 ${version} 表示版本号，请根据下载的实际版本号填写。

通过 JS-SDK（v0.1.1及以上版本）获取在线文档预览地址，示例如下：

配置项说明如下：

平台 支持浏览器

iOS
Safari、QQ 内置浏览器、QQ 小程序、微信内置浏览器、微信小程序（仅支持 webview 

方式接入）

Android QQ 内置浏览器、QQ 小程序、微信内置浏览器、微信小程序（仅支持 webview 方式接入）

Window

s
Chrome、QQ 浏览器（非兼容模式）、EDGE、火狐、IE11

Mac OS 

X
Chrome、Safari、QQ 浏览器、EDGE、火狐

使用说明

1. 下载

2. 引入 JS-SDK

<script src="sdk-${version}.js"></script>

3. 获取在线文档预览地址

方法一：使用 JS-SDK 获取（支持 sdk-v0.1.1及以上版本）

var url = await COSDocPreviewSDK.getPreviewUrl( {

      objectUrl: 'https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/test.p

      credentials: {      // 如果预览文件是私有的，则需要携带访问凭证。

          secretId: '',

          secretKey: '',

          authorization: 'q-sign-algorithmxxxxxxxxxxxxxxx',

      },

      copyable: 0,  // 是否可以复制文件内容

      htmlwaterword: ''  // 水印内容

})

console.log(url)

https://cos-doc-preview-js-sdk-1253960454.cos.ap-guangzhou.myqcloud.com/sdk-v0.2.1.zip
https://cloud.tencent.com/document/product/436/75909
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配置项 说明 是

否
必

选

objectU
rl

需要预览的对象地址，例如：

https://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/test.pptx

是

credent
ials

如果预览的对象是私有，则需要传入 credentials 作为访问凭证。可以传入计算好的 

请求签名  authorization，也可以传入用户的 secretId 和 secretKey（固定密钥
放在前端会有安全风险，不推荐此方式）

否

credent

ials.aut
horizati

on

对象下载签名，详情请参见 请求签名  文档 否

credent

ials.sec
retId

用户的 secretId，可前往访问管理控制台中的 API 密钥管理  页面获取 否

credent

ials.sec
retKey

用户的 secretKey，可前往访问管理控制台中的 API 密钥管理  页面获取 否

copyabl

e
是否可复制。默认为可复制，填入值为1；不可复制，填入值为0 否

htmlwa

terword
水印文字，需要经过 URL 安全  的 Base64 编码，默认为空 否

htmlfills
tyle

水印 RGBA（颜色和透明度），需要经过 URL 安全  的 Base64 编码，默认为：
rgba(192,192,192,0.6)

否

htmlfro

nt
水印文字样式，需要经过 URL 安全  的 Base64 编码，默认为：bold 20px Serif 否

htmlrot

ate
水印文字旋转角度，0 - 360，默认315度 否

htmlhor
izontal

水印文字水平间距，单位 px，默认为50 否

htmlver

tical
水印文字垂直间距，单位 px，默认为100 否

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778
https://console.cloud.tencent.com/cam/capi
https://console.cloud.tencent.com/cam/capi
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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方法二：直接请求获取

请求示例

GET /<ObjectKey>?ci-process=doc-preview&dstType=html&weboffice_url=1&sign=AuthS

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

请求参数

参数名称 描述
是否
必选

ci-

process
预览固定参数，值为 doc-preview 是

dstType 预览类型，如需预览生成类型为 html 则填入 html 是

weboffic

e_url

是否获取预览链接。填入值为1会返回预览链接和 Token 信息；填入值为2只返回 

Token 信息；不传会直接预览
否

tokenuid
是否获取 Token。根据传入的 tokenuid、文件信息等生成 Token，返回 

Token 和有效期；如果不传则不会返回 Token 信息
否

sign

对象下载签名，如果预览的对象为私有读时，需要传入签名，详情请参见 请求签名  

文档

注意：需要进行 urlencode

否

copyabl
e

是否可复制。默认为可复制，填入值为1；不可复制，填入值为0 否

htmlwat

erword
水印文字，需要经过 URL 安全  的 Base64 编码，默认为空 否

htmlfillst

yle

水印 RGBA（颜色和透明度），需要经过 URL 安全  的 Base64 编码，默认为：

rgba(192,192,192,0.6)
否

htmlfron
t

水印文字样式，需要经过 URL 安全  的 Base64 编码，默认为：bold 20px 
Serif

否

htmlrota

te
水印文字旋转角度，0 - 360，默认315度 否

htmlhori

zontal
水印文字水平间距，单位 px，默认为50 否

htmlverti 水印文字垂直间距，单位 px，默认为100 否

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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通过初始化配置，JS-SDK 会在配置的 mount 节点下创建一个 iframe，并自动初始化相关数据和事件。

挂载节点指 JS-SDK 插入 iframe 时挂载的节点。在初始化时，JS-SDK 挂载节点为可配置项。

cal

响应示例

HTTP/1.1 200 OK

Content-Type: text/html

Content-Length: 478

Date: Thu, 25 Feb 2021 07:44:37 GMT

Status: 200 OK

x-cos-request-id: NjAzNzU1NjVfY2MxZTIzMDlfNzc5NF8yMDQ5****

{

        "PreviewUrl": "https://prvsh.myqcloud.com/office/p/xxxx?_w_provider=XXX"

}

4. 初始化

var demo = COSDocPreviewSDK.config({

    url: '在线文档预览地址',  // 步骤3中获取到的在线文档预览地址

})

// 如果需要对 iframe 进行特殊的处理，可以通过以下方式拿到 iframe 的 dom 对象

console.log(demo.iframe)

// 打开文档结果

demo.on('fileOpen', function(data) {

    console.log(data.success)

})

5. 挂载节点

<div class="custom-mount"></div>

var demo = COSDocPreviewSDK.config({

    url: '在线文档预览地址',    // 步骤3中获取到的在线文档预览地址

    mount: document.querySelector('.custom-mount')    // 挂载节点，默认会挂载到 body 下，

})
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JS-SDK 初始化完成后会自动在挂载节点下面插入一个 iframe。

不使用 Token 时，默认使用文档的签名有效期鉴权，过期则无法预览文件。

使用 Token 鉴权可以在预览期间持续进行 Token 鉴权和 Token 续期，由业务侧自主控制预览授权。

Token 鉴权与续期分为以下三个步骤，详情请参见 demo 示例  。

1.  

请求示例

<div class="custom-mount">

    <iframe src="..."></iframe>

</div>

6. Token 鉴权

获取 Token

GET /<ObjectKey>?ci-process=doc-preview&dstType=html&weboffice_url=2&tokenuid

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

https://github.com/tencentyun/cos-demo/blob/main/doc-preview/token-refresh-preview.html


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1106 共1701页

响应示例

2. 设置 Token

3. 配置 refreshToken 方法，超时自动续期 Token 

refreshToken 方法需要请求您的服务端封装的更新 Token 的方法，服务端可以封装上述的获取 Token 的

方法（参考 获取 Token ）。 

以服务端方法 http://your.server.com/refreshToken 为例，配置 refreshToken 函数如下：

HTTP/1.1 200 OK

Content-Type: text/html

Content-Length: 108

Date: Tue, 21 Jun 2022 10:41:10 GMT

Status: 200 OK

x-cos-request-id: NjJiMWEwNDZfMTgyMjYyNjRfYmRlYl9iNTAw****

{

 Token: "ChAJj2vNRiHTc8reToMmJ7T2EJ7FxpUGGhS1mPJanpN03u8PSB17/YKBA/Vo****"

 TokenExpireTime: "1655808670"

}

说明

 为避免 Token 刷新过于频繁，推荐设置的超时时间（timeout）为 10 分钟以上；为避免 refresh 

请求超时，JS-SDK 会提前几分钟去更新 Token。

var demo = COSDocPreviewSDK.config({

 url: '在线文档预览地址',  // 步骤3中获取到的在线文档预览地址

})

// 设置Token

demo.setToken({

  token: 'yourToken', // 填入获取到的token

  timeout: 10 * 60 * 1000, // token超时时间，单位为毫秒，为避免频繁续期，建议设置 10 分钟

});

// 获取 Token 函数

const refreshToken = () => {

  // 调用服务端封装的方法，获取token信息
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  const tokenInfo = await $.get('http://your.server.com/refreshToken')

  // 可以返回 Promise 或者 return { token, timeout }

  return {

 token: tokenInfo.token, // 必需：你需要设置的 Token

 timeout: 10 * 60 * 1000, //  必需：Token 超时时间，单位毫秒

  };

};

var demo = COSDocPreviewSDK.config({

 url: '在线文档预览地址',  

 refreshToken    // Token自动更新方法

})

// 设置Token

demo.setToken({

  token: 'yourToken', // 填入获取到的token

  timeout: 10 * 60 * 1000   // token超时时间，单位为毫秒

});

实际案例

文字文件在线预览案例，参考 DOC 预览案例  。

演示文件在线预览案例，参考 PPT 预览案例  。

表格文件在线预览案例，参考 Excel 预览案例  。

PDF 文件在线预览案例，参考 PDF 预览案例  。

Token 鉴权与续期案例，参考 Token 鉴权与续期案例  。

https://github.com/tencentyun/cos-demo/blob/main/doc-preview/doc-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/ppt-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/xls-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/pdf-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/token-refresh-preview.html
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配置项说明
最近更新时间：2022-06-24 17:54:09

通过初始化配置选项类，开启不同的显示模式：

配置选项说明如下：

初始化 JS-SDK 时，通过分别配置不同文档对应的配置选项，可以开启或关闭文档中的特定配置以及控制文档打

开时的状态。

显示模式

var demo = COSDocPreviewSDK.config({

    mode: 'normal', 

})

mode 选项值 说明 是否默认选项

normal 普通模式，展示所有功能界面 是

simple 极简模式，不显示头部和工具栏 否

自定义配置选项

COSDocPreviewSDK.config({

    //通用选项，适用于所有类型的文档。
    commonOptions: {

      isShowTopArea: false, //隐藏顶部区域（头部和工具栏）。

      isShowHeader: false //隐藏头部区域。

    },

    //WORD文档相关配置。

    wordOptions: {

      isShowDocMap: false,

      isBestScale: true

    },

    //PDF文档相关配置。

    pdfOptions: {

      isShowComment: true,

      isInSafeMode: false

    },

    //演示文档相关配置。

    pptOptions: {



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1109 共1701页

      isShowBottomStatusBar: true

    }

})

通用配置项：commonOptions

配置项 说明 默认值

isShowTopArea 是否显示顶部区域（头部和工具栏） false

isShowHeader 是否显示头部区域 false

isBrowserViewFullscreen 是否在浏览器区域全屏 false

isIframeViewFullscreen 是否在 iframe 区域内全屏 false

文字文件配置项：wordOptions

配置项 说明 默认值

isShowDocMap 是否开启目录功能，默认开启 true

isBestScale 打开文档时，默认以最佳比例显示（适用于 PC） true

isShowBottomStatusBar 是否展示底部状态栏（适用于 PC） false

PDF 配置项：pdfOptions

配置项 说明

默

认
值

isShowComment 是否显示注解，默认显示
tru

e

isInSafeMode
是否处于安全模式（安全模式下不能划选文字，不能复制以及不能通过链

接跳转），默认不是安全模式

fal

se

isShowBottomSt
atusBar

是否展示底部状态栏（适用于 PC）
fal
se

演示文件配置项：pptOptions

配置项 说明 默认值

isShowBottomStatusBar 是否展示底部状态栏（适用于 PC） false
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可以通过 commandBars 选项来隐藏或禁用页面的组件。

目前可用的组件列表如下：

组件状态设置

COSDocPreviewSDK.config({

    //通用选项，适用于所有类型的文档。

    commandBars: [

      {

        cmbId: 'Print', // 组件ID

        attributes: {

          visible: false, // 组件是否显示，默认为true。false：隐藏组件；true：显示组件

          enable: false, // 禁用或者开启组件，默认为true

        },

      },

    ]

})

组件ID 说明 适用范围

Print 打印功能，和 ctrl+P 打印快捷键 所有文档

MobileHeader 客户端的顶部工具栏 所有文档

WriterHoverToolbars 客户端的底部工具栏 文字文件

DownloadImg 双击图片下载按钮图标 演示文件

PlayComponentToolbar 全屏播放时右上角工具栏 演示文件

PlayContextCheckImage 播放时右键 - 查看原图 演示文件

FloatMenuCheckImage 选中图片时浮动菜单栏 - 查看原图 演示文件

WPPMobileCommentButton 客户端底部工具栏的评论按钮 演示文件

PDFMobilePageBar 客户端的页码 PDF文件
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高级功能
最近更新时间：2022-10-26 15:44:09

JS-SDK 提供了高级功能可直接对文档进行操作，以下是高级功能的调用流程。

以下对文字文件、表格文件、演示文件、PDF 文件等类型使用高级功能进行列举介绍，如需了解上述类型支持的文

件格式，请参见 规则与限制 。

1. 等待文档加载完成

await demo.ready() // 务必等待 demo ready 之后再调用高级 api，demo 对象是指 JS-SDK 实例

2. 获取文档对象

// 文字

const wordApp = demo.WordApplication()

// 表格

const excelApp = demo.ExcelApplication()

// 演示

const pptApp = demo.PPTApplication()

// PDF

const pdfApp = demo.PDFApplication()

// 自动识别

const app = demo.Application

3. 使用高级功能

文字文件

展开全部

获取总页数 

获取当前页

跳转到指定页

设置评论显示

https://cloud.tencent.com/document/product/460/36620
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设置目录显示

视图缩放

表格文件

展开全部

获取所有 sheet 名称

获取当前 sheet 名称

切换到指定 sheet

视图缩放

演示文件

展开全部

获取总页数

获取当前页

跳转到指定页

播放幻灯片

退出播放

幻灯片下一步动画

幻灯片上一步动画

获取播放状态

视图缩放
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PDF 文件

展开全部

获取总页数

获取当前页

跳转到指定页

设置页面渲染模式

设置目录显示

视图缩放

事件监听
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支持的字体和动画
最近更新时间：2021-05-17 09:45:17

文档转 HTML 功能支持预览多种字体，并可预览演示文件中的动画效果，具体请参见下方的字体支持表和动画支持

表。

文档预览支持如下所示的字体，部分字体仅支持 Word 文档。不支持的字体会在展示时匹配相近字体，可能会出现

字体效果与本地不符的情况。

简介

说明

 使用文档转 HTML 功能，实际的预览效果可能因文档格式的不同而有所差异。

支持的字体

中文字体（简/繁）

仅支持 Word 文档

字体名称 字体名称 字体名称

幼圆 华文行楷 方正姚体

新宋体 华文仿宋 方正舒体

微软雅黑 华文彩云 等线

微软雅黑 Light 黑体 等线 Light

腾讯体 W3 汉仪智楷繁 PMingLiU-ExtB  （新�明�-ExtB）

腾讯体 W7 汉仪智草繁 MingLiU-ExtB  （�明�-ExtB）

宋体 汉仪赵楷繁 MingLiU_HKSCS-ExtB  （�明�_HKSCS-ExtB）

隶书 汉仪王行繁 Microsoft YaHei UI

楷体 汉仪唐隶繁 Microsoft YaHei UI  Light

华文中宋 汉仪欧行繁 Microsoft JhengHei UI

华文新魏 汉仪陆行繁 Microsoft JhengHei UI  Light

华文细黑 汉仪柳楷繁 Microsoft JhengHei
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华文宋体 汉仪衡方碑繁 Microsoft JhengHei  Light

华文隶书 汉仪褚楷繁 Adobe 宋体 Std

华文楷体 汉仪曹隶繁 -

华文琥珀 仿宋 -

支持全部文档类型

字体名称 字体名称

汉仪中黑 KW 汉仪楷体 KW

汉仪中等线 KW 汉仪君黑 KW 55J

汉仪书宋二 KW 汉仪君黑 KW   85J

汉仪旗黑 KW 85S 汉仪仿宋 KW

汉仪旗黑 KW 55S -

其他语言字体

仅支持 Word 文档

字体名称 字体名称 字体名称

Agency FB Gadugi Palatino Linotype

Algerian Garamond Papyrus

Arial Black Gigi Parchment

Arial Narrow Gill Sans MT Perpetua

Arial Rounded MT 
Bold

Gill Sans MT  Condensed Perpetua Titling MT

Bahnschrift
Gill Sans MT Ext  Condensed 

Bold
Playbill

Baskerville Old Face Gill Sans Ultra Bold Poor Richard

Bauhaus 93
Gill Sans Ultra Bold  

Condensed
Pristina

Bell MT Gloucester MT Extra  Rage Italic
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Condensed

Berlin Sans FB Goudy Old Style Raleway

Berlin Sans FB Demi Goudy Stout Raleway Black

Bernard MT 
Condensed

Haettenschweiler Raleway ExtraBold

Blackadder ITC Harlow Solid Italic Raleway ExtraLight

Bodoni MT Harrington Raleway Light

Bodoni MT Black High Tower Text Raleway Medium

Bodoni MT 
Condensed

HoloLens MDL2 Assets Raleway SemiBold

Bodoni MT Poster  

Compressed
Impact Raleway Thin

Book Antiqua Imprint MT Shadow Ravie

Bookman Old Style Informal Roman Roboto

Bookshelf Symbol 7 Ink Free Roboto Black

Bradley Hand ITC Javanese Text Roboto Light

Britannic Bold Jokerman Roboto Medium

Broadway Juice ITC Roboto Thin

Brush Script MT Kristen ITC Roboto Slab

C059 Kunstler Script Rockwell

Calibri Leelawadee Rockwell Condensed

Calibri Light Leelawadee UI Rockwell Extra Bold

Californian FB Leelawadee UI  Semilight Script MT Bold

Calisto MT Lucida Bright Segoe MDL2 Assets

Cambria Lucida Calligraphy Segoe Print

Cambria Math Lucida Console Segoe Script

Candara Lucida Fax Segoe UI
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Candara Light Lucida Handwriting Segoe UI Black

Castellar Lucida Sans Segoe UI Light

Centaur Lucida Sans  Typewriter Segoe UI Semibold

Century Lucida Sans Unicode Segoe UI Semilight

Century Gothic Magneto Segoe UI Emoji

Century Schoolbook Maiandra GD Segoe UI Historic

Chiller Malgun Gothic (�� ��) Segoe UI Symbol

Colonna MT
Malgun Gothic  Semilight (�� 

�� Semilight)
Showcard Gothic

Consolas Matura MT Script  Capitals SimSun-ExtB

Constantia Merriweather Sitka Banner

Cooper Black Merriweather Black Sitka Display

Copperplate Gothic  

Bold
Merriweather Light Sitka Heading

Copperplate Gothic  

Light
Microsoft Himalaya Sitka Small

Corbel Microsoft New Tai Lue Sitka Subheading

Corbel Light Microsoft PhagsPa Sitka Text

Courier Microsoft Sans Serif Small Fonts

Curlz MT Microsoft Tai Le Snap ITC

D050000L Microsoft Uighur Standard Symbols PS

DejaVu Sans Microsoft Yi Baiti Stencil

DejaVu Sans 

Condensed
Mistral Sylfaen

DejaVu Sans Light Modern No. 20 Symbol

Dubai Mongolian Baiti Symbol Tiger

Dubai Light Monotype Corsiva Symbol Tiger Expert
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Dubai Medium MS Gothic (ＭＳ ゴシック) System

Ebrima MS Outlook Tahoma

Edwardian Script ITC MS Pgothic (ＭＳ Ｐゴシック) Tempus Sans ITC

Elephant MS Reference Sans  Serif
TencentSans Korean W3  

(���� W3)

Engravers MT MS Reference  Specialty
TencentSans Korean W7  

(���� W7)

Eras Bold ITC MS Sans Serif Terminal

Eras Demi ITC MS Serif Tiger

Eras Light ITC MS UI Gothic Tiger Expert

Eras Medium ITC MT Extra Trebuchet MS

Euclid MT Extra Tiger Tw Cen MT

Euclid Extra MV Boli Tw Cen MT Condensed

Euclid Fraktur Myanmar Text
Tw Cen MT Condensed  

Extra Bold

Euclid Math One Niagara Engraved URW Bookman

Euclid Math Two Niagara Solid URW Gothic

Euclid Symbol Nimbus Mono PS Viner Hand ITC

Felix Titling Nimbus Roman Vivaldi

Fences Nimbus Sans Vladimir Script

Fixedsys Nimbus Sans Narrow Wide Latin

Footlight MT Light Nirmala UI Wingdings

Forte Nirmala UI Semilight Wingdings 2

Franklin Gothic Book OCR A Extended Wingdings 3

Franklin Gothic Demi Old English Text MT Yu Gothic (游ゴシック)

Franklin Gothic Demi  

Cond
Onyx

Yu Gothic Light  (游ゴシック 

Light)
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Franklin Gothic Heavy Open Sans Yu Gothic Medium  (游ゴシ

ック Medium)

Franklin Gothic  

Medium
Open Sans Extrabold Yu Gothic UI

Franklin Gothic  

Medium Cond
Open Sans Light Yu Gothic UI Light

Freestyle Script Open Sans Semibold Yu Gothic UI Semibold

French Script MT P052 Yu Gothic UI  Semilight

Gabriola Palace Script MT Z003

支持全部文档类型

字体名称 字体名称 字体名称

Arial Noto Sans Gujarati UI
Noto Sans 

Shavian

Comic Sans MS Noto Sans Gurmukhi Noto Sans Sinhala

Courier New Noto Sans Gurmukhi UI
Noto Sans Sinhala 

UI

Georgia Noto Sans Hanunoo
Noto Sans 

Sundanese

Kingsoft Confetti Noto Sans Hebrew
Noto Sans Syloti 
Nagri

Kingsoft Extra
Noto Sans Imperial Aramaic 

(Noto Sans ImpAramaic)

Noto Sans 

Symbols

Kingsoft Mark

Noto Sans Inscriptional 

Pahlavi (Noto Sans 

InsPahlavi)

Noto Sans 

Symbols2

Kingsoft Math
Noto Sans Inscriptional 
Parthian (Noto Sans 

InsParthi)

Noto Sans Syriac 

Eastern

Kingsoft Sign Noto Sans Javanese
Noto Sans Syriac 
Estrangela

Kingsoft Stress Noto Sans Kaithi Noto Sans Syriac 
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Western

Noto Emoji Noto Sans Kannada
Noto Sans 

Tagalog

Noto Kufi Arabic Noto Sans Kannada UI
Noto Sans 
Tagbanwa

Noto Mono Noto Sans Kayah Li Noto Sans Tai Le

Noto Naskh Arabic Noto Sans Kharoshthi
Noto Sans Tai 

Tham

Noto Naskh Arabic UI Noto Sans Khmer Noto Sans Tai Viet

Noto Nastaliq Urdu Noto Sans Khmer UI Noto Sans Tamil

Noto Sans Noto Sans Lao
Noto Sans Tamil 

UI

Noto Sans Adlam Noto Sans Lao UI Noto Sans Telugu

Noto Sans Adlam Unjoined Noto Sans Lepcha
Noto Sans Telugu 

UI

Noto Sans Anatolian 

Hieroglyphs (Noto Sans 

AnatoHiero)

Noto Sans Limbu Noto Sans Thaana

Noto Sans Arabic Noto Sans Linear B Noto Sans Thai

Noto Sans Arabic UI Noto Sans Lisu Noto Sans Thai UI

Noto Sans Armenian Noto Sans Lycian Noto Sans Tibetan

Noto Sans Avestan Noto Sans Lydian
Noto Sans 

Tifinagh

Noto Sans Balinese Noto Sans Malayalam
Noto Sans 

Ugaritic

Noto Sans Bamum Noto Sans Malayalam UI Noto Sans Vai

Noto Sans Batak Noto Sans Mandaic Noto Sans Yi

Noto Sans Bengali Noto Sans Meetei Mayek Noto Serif

Noto Sans Bengali UI Noto Sans Mongolian
Noto Serif 

Armenian
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Noto Sans Brahmi Noto Sans Mono Noto Serif Bengali

Noto Sans Buginese Noto Sans Myanmar Noto Serif CJK SC

Noto Sans Buhid Noto Sans Myanmar UI Noto Serif CJK TC

Noto Sans Canadian Aboriginal Noto Sans New Tai Lue
Noto Serif 

Devanagari

Noto Sans Carian
Noto Sans Nko (Noto Sans 

N'Ko)

Noto Serif Display 

(Noto Serif Disp)

Noto Sans Chakma Noto Sans Ogham Noto Serif Ethiopic

Noto Sans Cham Noto Sans Ol Chiki
Noto Serif 

Georgian

Noto Sans Cherokee Noto Sans Old Italic Noto Serif Gujarati

Noto Sans Coptic Noto Sans Old Persian Noto Serif Hebrew

Noto Sans Cuneiform
Noto Sans Old South Arabian 

(Noto Sans OldSouArab)

Noto Serif 

Kannada

Noto Sans Cypriot Noto Sans Old Turkic Noto Serif Khmer

Noto Sans Deseret Noto Sans Oriya Noto Serif Lao

Noto Sans Devanagari Noto Sans Oriya UI
Noto Serif 
Malayalam

Noto Sans Devanagari UI Noto Sans Osage
Noto Serif 

Myanmar

Noto Sans Display (Noto Sans 

Disp)
Noto Sans Osmanya Noto Serif Sinhala

Noto Sans Egyptian 
Hieroglyphs (Noto Sans 

EgyptHiero)

Noto Sans Phags Pa Noto Serif Tamil

Noto Sans Ethiopic Noto Sans Phoenician Noto Serif Telugu

Noto Sans Georgian Noto Sans Rejang Noto Serif Thai

Noto Sans Glagolitic Noto Sans Runic
Times New 

Roman

Noto Sans Gothic Noto Sans Samaritan Verdana



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1122 共1701页

演示文件包含的格式有：pptx、ppt、pot、potx、pps、ppsx、dps、dpt、pptm、potm、ppsm。以下表

中的动画，除随机效果外，均支持播放时机、速度、重复和延迟的调节。

Noto Sans Gujarati Noto Sans Saurashtra Webdings

支持的演示文件动画

进入和退出动画

动画名称 属性 动画名称 属性 动画名称 属性

百叶窗 支持方向 圆形扩展
支持方

向
放大 不支持

擦除 支持方向 渐变 不支持 飞旋 不支持

出现 不支持 渐变式回旋 不支持 浮动 不支持

飞入、飞出 支持方向 渐变式缩放 不支持 光速 不支持

盒状 支持方向 展开-细微型 不支持 滑翔 不支持

缓慢进入、缓慢退

出
支持方向

翻转式由远及

近
不支持 挥鞭式 不支持

阶梯状 支持方向 回旋 不支持 挥舞 不支持

菱形 支持方向 渐入,渐出 不支持 空翻 不支持

轮子
支持辐射

状
上升 不支持

螺旋飞入、螺旋飞

出
不支持

劈裂 支持方向 伸展
支持方

向
曲线向上 不支持

棋盘 支持方向 升起 不支持 投掷 不支持

切入 支持方向 缩放
支持缩
放

玩具风车 不支持

闪烁一次 不支持 下降 不支持 线形 不支持

扇形展开 不支持 压缩 不支持 旋转
支持方
向

十字形扩展 支持方向 颜色打字机 不支持 折叠 不支持

随机线条 支持方向 展开-温和型 不支持 字幕式 不支持
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随机效果 不支持 中心旋转 不支持 - -

向内溶解 不支持 弹跳 不支持 - -

强调动画

动画名称 属性 动画名称 属性

放大/缩小 尺寸 忽明忽暗 不支持

更改填充颜色 充填色 混色 颜色

更改线条颜色 线条色 加粗闪烁 不支持

更改字号 字号 加深 不支持

更改字体 字体 添加下划线 不支持

更改字体颜色 字体颜色 着色 颜色

更改字形 字形 温和型 不支持

透明 数量 彩色延伸 颜色

陀螺旋 数量 跷跷板 不支持

细微型 不支持 闪动 颜色

变淡 不支持 闪现 不支持

补色 不支持 华丽型 不支持

补色2 不支持 爆炸 颜色

不饱和 不支持 波浪型 不支持

彩色波纹 颜色 加粗展示 不支持

垂直突出显示 颜色 闪烁 不支持

对比色 不支持 样式强调 颜色



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1124 共1701页

更新日志
最近更新时间：2022-06-24 17:54:17

下载地址： sdk-v0.2.1.zip

下载地址： sdk-v0.1.1.zip

V0.2.1

支持 COS V5 签名鉴权

支持 token 鉴权和续期

支持监听 PPT 中的视频播放状态

V0.1.1

支持在线预览

支持 COS V4 签名鉴权

https://cos-doc-preview-js-sdk-1253960454.file.myqcloud.com/sdk-v0.2.1.zip
https://cos-doc-preview-js-sdk-1253960454.file.myqcloud.com/sdk-v0.1.1.zip
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文件处理

服务和队列配置
开通文件处理服务
最近更新时间：2023-02-09 10:32:33

本接口用于开通文件处理服务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

POST /file_bucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 FileBucket 的内容：

<Response>

    <RequestId>NjJ******************x</RequestId>

    <FileBucket>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2022-08-09T16:23:11+0800></CreateTime>

    </FileBucket>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

FileBucket Response 存储桶信息 Container

节点名称（关键字） 父节点 描述 类型

BucketId Response.FileBucket 存储桶 ID String

Name Response.FileBucket 存储桶名称，同 BucketId String

Region Response.FileBucket 所在的地域 String

CreateTime Response.FileBucket 创建时间 String

实际案例

请求

POST /file_bucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x

<Response>

    <RequestId>NjJmMzRlZG**********I0MV8x</RequestId>

    <FileBucket>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-09T16:23:11+0800></CreateTime>

    </FileBucket>

</Response>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1128 共1701页

更新文件处理队列
最近更新时间：2023-02-09 10:32:41

本接口用于更新文件处理的队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有以下请求体。

功能描述

请求

请求示例

PUT /file_queue/<queueId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Name>My-Queue-file</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Request 的内容：

Container 节点 NotifyConfig 的内容：

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选 默认值 限制

Request 无 保存结果的容器 Container 是 无 无

节点名

称（关
键字）

父节

点
描述 类型

是

否

必
选

默

认
值

限

制

Name
Req

uest
队列名称,长度不超过128

Stri

ng
是 无 无

State
Req

uest

Active 表示队列内的作业会被调度执行。

Paused 表示队列暂停，作业不再会被调度执行，

队列内的所有作业状态维持在暂停状态，已经执行

中的任务不受影响。

Stri

ng
是 无 无

Notify

Confi

g

Req

uest
回调配置

Con

tain

er

是 无 无

节点名
称（关

键字）

父节点 描述
类

型
是否必选

默
认

值

限制

State

Reque
st.Notif

yConfi

g

回调开
关，

Off/O

n

St
ri

n

g

否
O

ff
On/Off

Event

Reque
st.Notif

yConfi

g

回调事

件

St
ri

n

g

当 State=On

时，必选
无

任务完成：TaskFinish；工作流

完成：WorkflowFinish

Result

Form

at

Reque

st.Notif

回调格

式

St

ri

否 X

M

L

JSON/XML
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

yConfi
g

n
g

Type

Reque

st.Notif

yConfi
g

回调类

型

St

ri

n
g

当 State=On

时，必选
无 Url 或 TDMQ

Url

Reque

st.Notif
yConfi

g

回调地
址

St

ri
n

g

当 

State=On，
且Type=Url

时，必选

无 不能为内网地址

MqMo

de

Reque
st.Notif

yConfi

g

TDM
Q 使

用模式

St
ri

n

g

当 

State=On，
且

Type=TDM

Q时，必选

Q

u
e

u

e

主题订阅：Topic 

 队列服务: Queue

MqRe

gion

Reque

st.Notif

yConfi

g

TDM

Q 所

属园区

St

ri

n

g

当 

State=On，

且

Type=TDM
Q时，必选

无

目前支持园区 sh（上海）、bj

（北京）、gz（广州）、cd（成

都）、hk（中国香港）

MqNa
me

Reque

st.Notif
yConfi

g

TDM

Q 主
题名称

St

ri
n

g

当 

State=On，

且
Type=TDM

Q时，必选

无 无

响应

响应头

响应体

<Response>

    <RequestId>NjJmNDczY2R******NTA4ZV85</RequestId>

    <Queue>

        <QueueId>pb926e1dce*******2164f4869</QueueId>

        <Name>My-Queue-file</Name>

        <State>Active</State>

https://cloud.tencent.com/document/product/460/42866


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1131 共1701页

具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 Queue 的内容：

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

Queue Response 队列信息 Container

节点名称（关键

字）
父节点 描述 类型

QueueId
Response.Queu
e

队列 ID String

Name
Response.Queu

e
队列名字 String

State
Response.Queu

e
当前状态，Active 或者 Paused String

NotifyConfig
Response.Queu
e

回调配置，同 
Request.NotifyConfig

Container

MaxSize
Response.Queu

e
队列最大长度 Int
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

MaxConcurrent Response.Queu

e

当前队列最大并行执行的任务数 Int

Category
Response.Queu

e
队列类型 String

UpdateTime
Response.Queu

e
更新时间 String

CreateTime
Response.Queu

e
创建时间 String

错误码

实际案例

请求

PUT /file_queue/pb926e1******69 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 162

Content-Type: application/xml

<Request>

    <Name>My-Queue-file</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

https://cloud.tencent.com/document/product/460/42867
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Server: tencent-ci

x-ci-request-id: NjJm******ZV85

<Response>

    <RequestId>NjJmNDcz******ZV85</RequestId>

    <Queue>

        <QueueId>pb926e1dce******64f4869</QueueId>

        <Name>My-Queue-file</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>
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查询文件处理队列
最近更新时间：2023-02-09 10:32:50

本接口用于搜索文件处理队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /file_queue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称

（关键
字）

描述
类

型

是

否

必
选

queueId
s

队列 ID，以“,”符号分割字符串

S

tri
n

g

否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展示

如下：

state Active 表示队列内的作业会被调度执行。

 Paused 表示队列暂停，作业不再会被调度执行，队列内的所有作业状

态维持在暂停状态，已经执行中的任务不受影响。

S

tri
n

g

否

pageNu

mber
第几页，默认值1

S
tri

n

g

否

pageSiz

e
每页个数，默认值10

S
tri

n

g

否

响应

响应头

响应体

<Response>

    <RequestId>NjJmMzI******cwM18x</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p8366c460c6******eaa3c4b</QueueId>

        <Name>queue-pic-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 QueueList 的内容：

        <Category>PicProcessing</Category>

    </QueueList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

TotalCount Response 队列总数 Int

PageNumber Response 当前页数，同请求中的 pageNumber Int

PageSize Response 每页个数，同请求中的 pageSize Int

QueueList Response 队列数组 Container数组

NonExistPIDs Response 不存在的队列 ID 列表 String数组

节点名称（关键字） 父节点 描述 类型

QueueId Response.QueueList 队列 ID String

Name Response.QueueList 队列名字 String

State Response.QueueList 当前状态，Active 或者 Paused String

NotifyConfig Response.QueueList 回调配置 Container

MaxSize Response.QueueList 队列最大长度 Int

MaxConcurrent Response.QueueList 当前队列最大并行执行的任务数 Int

Category Response.QueueList 队列类型 String

UpdateTime Response.QueueList 更新时间 String

CreateTime Response.QueueList 创建时间 String
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Container 节点 NotifyConfig 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

Url Response.QueueList.NotifyConfig 回调地址 String

State Response.QueueList.NotifyConfig 开关状态 String

Type Response.QueueList.NotifyConfig 回调类型 String

Event Response.QueueList.NotifyConfig 回调事件 String

ResultFormat Response.QueueList.NotifyConfig 回调类型 String

MqMode Response.QueueList.NotifyConfig TDMQ 使用模式 String

MqRegion Response.QueueList.NotifyConfig TDMQ 所属园区 String

MqName Response.QueueList.NotifyConfig TDMQ 主题名称 String

错误码

实际案例

请求1：搜索指定队列

GET /file_queue?queueIds=pb926e1dce******4f4869,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzJj******NjQ5NF8x

<Response>

    <RequestId>NjJmMzJjND******NF8x</RequestId>

https://cloud.tencent.com/document/product/460/42867
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    <QueueList>

        <QueueId>p8366c46******eaa3c4b</QueueId>

        <Name>queue-pic-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>PicProcessing</Category>

    </QueueList>

    <NonExistPIDs>A</NonExistPIDs>

    <NonExistPIDs>B</NonExistPIDs>

</Response>

请求2：查询队列列表

GET /file_queue?pageSize=10&pageNumber=1&category=CateAll HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF*********&q-sign-time=

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应2

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzI5******jcwM18x

<Response>

    <RequestId>NjJmMzI5MmR******cwM18x</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>
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    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p8366c460******1eaa3c4b</QueueId>

        <Name>queue-pic-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>PicProcessing</Category>

    </QueueList>

</Response>
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文件哈希值计算
哈希值计算同步请求
最近更新时间：2023-03-13 14:19:45

以同步请求的方式进行文件哈希值计算，实时返回计算得到的哈希值，该接口属于 GET 请求。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

费用说明

调用接口会产生 哈希值计算费用  和 COS 读请求费用 。

如果文件为 COS 上的低频存储类型，调用会产生 COS 低频数据取回费用 。

不支持处理 COS 上的归档存储类型和深度归档存储类型的文件，如果需要处理此类型文件，请先 恢复归档文

件 。

限制说明

文件大小：支持计算小于 128 MB 大小的文件，更大文件请使用 哈希值计算异步接口 。

请求超时时间：10秒

调用接口需携带签名，具体规则请参见 请求签名  文档。

本接口当前支持以下地域：北京、上海、广州、成都、中国香港、新加坡、硅谷。

请求

请求示例

GET /for-test.mp4?ci-process=filehash&type=md5 HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/82325
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/460/83085
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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参数说明如下：

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

请求参数

节点名称

（关键

字）

描述
类

型

是

否

必
选

ci-

proces
s

操作类型，哈希值计算固定为：filehash
Str

ing
是

type 支持的哈希算法类型，有效值：md5、sha1、sha256
Str

ing
是

addtoh

eader

是否将计算得到的哈希值，自动添加至文件的自定义header，格式为：x-

cos-meta-md5/sha1/sha256;有效值： true、false，不填则默认为

false。

Str

ing
否

请求体

响应

响应头

响应体

<Response>

    <FileHashCodeResult>

        <MD5>0fe771ba515b0525552f59290a50c0ef</MD5>

        <FileSize>1048576</FileSize>

    </FileHashCodeResult>

    <Input>

        <Bucket>test-1234567890</Bucket>

        <Object>wg.txt</Object>

        <Region>ap-chongqing</Region>

    </Input>

</Response>

https://cloud.tencent.com/document/product/436/7729
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 FileHashCodeResult 的内容：

Container 节点 Input 的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

FileHashCodeResult Response 文件哈希值的结果。 Container

Input Response 输入文件的基本信息。 Container

节点名称

（关键

字）

父节点 描述
类

型

MD5
Response.Fil
eHashCodeR

esult

请求时 type 为 md5 时返回
Str

ing

SHA1
Response.Fil
eHashCodeR

esult

请求时 type 为 sha1 时返回
Str
ing

SHA256

Response.Fil

eHashCodeR
esult

请求时 type 为 sha256 时返回
Str
ing

FileSize

Response.Fil

eHashCodeR
esult

文件的大小。 Int

LastMod

ified

Response.Fil

eHashCodeR

esult

对象的最近一次修改的时间。
Str

ing

Etag

Response.Fil

eHashCodeR

esult

ETag 全称为 Entity Tag，是对象被创建时标识对象内容的

信息标签，可用于检查对象的内容是否发生变化。

Str

ing

节点名称（关键字） 父节点 描述 类型
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Region Response.JobsDetail.Input 存储桶所在地域。 String

Bucket Response.JobsDetail.Input 输入文件所在的存储桶。 String

Object Response.JobsDetail.Input 输入文件在存储桶中的名称。 String

错误码

实际案例

请求

GET /for-test.mp4?ci-process=filehash&type=md5 HTTP/1.1

Host: test-1234567890.cos.ap-beijing.myqcloud.com

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG*

Content-Length: 0

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-cos

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZmNw==

<Response>

    <FileHashCodeResult>

        <MD5>0fe771ba515b0525552f59290a50c0ef</MD5>

        <FileSize>1048576</FileSize>

        <LastModified>2022-06-27T15:23:12+0800</LastModified>

        <Etag>"ee8de918d05640145b18f70f4c3aa602"</Etag>

    </FileHashCodeResult>

    <Input>

        <Bucket>test-1234567890</Bucket>

        <Object>wg.txt</Object>

        <Region>ap-chongqing</Region>

    </Input>

</Response>

https://cloud.tencent.com/document/product/436/53983
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提交哈希值计算任务
最近更新时间：2023-05-17 17:05:54

以提交任务的方式进行文件哈希值计算，异步返回计算得到的哈希值，该接口属于 POST 请求。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

费用说明

调用接口会产生 哈希值计算费用  和 COS 读请求费用 。

如果文件为 COS 上的低频存储类型，调用会产生 COS 低频数据取回费用 。

不支持计算 COS 上的归档存储类型和深度归档存储类型的文件哈希值，如果需要计算此类型文件的哈希值，请

先 恢复归档文件 。

限制说明

文件大小支持：支持计算小于 50 GB 大小的文件。

调用接口需携带签名，具体规则请参见 请求签名  文档。

本接口当前支持以下地域：北京、上海、广州、成都、中国香港、新加坡、硅谷。

请求

请求示例

POST /file_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该请求操作的实现需要有如下请求体。

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

请求体

<Request>

    <Tag>FileHashCode</Tag>

    <Input>

        <Object>input/test.mp4</Object>

    </Input>

    <Operation>

        <FileHashCodeConfig>

            <Type>MD5</Type>

            <AddToHeader>true</AddToHeader>

        </FileHashCodeConfig>

        <UserData>This is my data.</UserData>

    </Operation>

    <CallBack>http://test.test.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器。 Container 是

节点名称

（关键字）

父节

点
描述 类型

是否

必选

Tag
Req
uest

表示任务的类型，哈希值计算默认为：
FileHashCode。

String 是

Input
Req

uest
包含待操作的文件信息。

Conta

iner
是

Operation
Req

uest
包含哈希值计算的处理规则。

Conta

iner
是

CallBackF
ormat

Req
uest

任务回调格式，JSON 或 XML，默认 XML，优先级
高于队列的回调格式。

String 否

CallBackT

ype

Req

uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于

队列的回调类型。
String 否
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Container 类型 Input 的具体数据描述如下：

Container 类型 Operation 的具体数据描述如下：

Container 类型 FileHashCodeConfig 的具体数据描述如下：

CallBack Req

uest

任务回调的地址，优先级高于队列的回调地址。 String 否

CallBackM
qConfig

Req
uest

任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情见 CallBackMqConfig

Conta
iner

否

节点名称（关键

字）
父节点 描述 类型

是否必

选

Object
Request.In

put

文件名，取值为文件在当前存储桶中的完整

名称。

Strin

g
是

节点名称（关键
字）

父节点 描述 类型
是否
必选

FileHashCode

Config

Request.Ope

ration
指定哈希值计算的处理规则。

Contai

ner
是

UserData
Request.Ope

ration

透传用户信息, 可打印的 ASCII 码, 长

度不超过1024
String 否

节点名称

（关键
字）

父节点 描述
类

型

是

否

必
选

Type

Request.Op

eration.File
HashCodeC

onfig

哈希值的算法类型，有效值：MD5、SHA1、SHA256。

St

ri
n

g

是

AddTo
Heade

r

Request.Op
eration.File

HashCodeC

onfig

是否将计算得到的哈希值添加至文件自定义header，有效
值：true、false，默认值为 false。自定义header根据

Type 的值变化，例如 Type 值为MD5时，自定义

header为 x-cos-meta-md5。

St
ri

n

g

否

响应

响应头

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器。 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息。 Container

https://cloud.tencent.com/document/product/460/42866
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节点名
称（关

键字）

父节点 描述
类

型

Code
Respons
e.JobsD

etail

错误码，只有 State 为 Failed 时有意义。
Str
ing

Mess
age

Respons

e.JobsD
etail

错误描述，只有 State 为 Failed 时有意义。
Str
ing

JobId

Respons

e.JobsD
etail

新创建任务的 ID。
Str

ing

Tag

Respons

e.JobsD

etail

表示任务的类型，哈希值计算默认为：FileHashCode。
Str

ing

State

Respons

e.JobsD

etail

任务的状态，为 Submitted(已提交)、Running(进行中)、

Success(成功)、Failed(失败)、Pause(已暂停)、Cancel(已取消) 

其中一个

Str

ing

Creati

onTim

e

Respons

e.JobsD

etail

任务的创建时间。
Str

ing

StartT

ime

Respons

e.JobsD

etail

任务的开始时间。
Str

ing

EndTi

me

Respons

e.JobsD

etail

任务的结束时间。
Str

ing

Queu

eId

Respons
e.JobsD

etail

任务所属的队列 ID。
Str

ing

Input
Respons
e.JobsD

etail

被计算哈希值的文件信息。

Co
nt

ain

er

Opera

tion

Respons

e.JobsD

哈希值计算的处理规则。 Co

nt
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

Container 节点 FileHashCodeResult 的内容：

etail ain

er

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶所在地域。 String

Bucket Response.JobsDetail.Input 文件所在的存储桶。 String

Object Response.JobsDetail.Input 被计算哈希值的文件名。 String

节点名称（关键

字）
父节点 描述 类型

UserData
Response.JobsDetail

.Operation
透传用户信息。

Strin

g

FileHashCod

eConfig

Response.JobsDetail

.Operation

同请求中的 

Request.Operation.FileHashCodeC

onfig。

Cont

ainer

FileHashCod

eResult

Response.JobsDetail

.Operation

计算得到的文件 hash 值信息，任务未完成

时不返回。

Cont

ainer

节点名称（关键

字）
父节点 描述 类型

MD5
Response.JobsDetail.Operation.FileHashC

odeResult
MD5 计算结果。

Stri

ng

SHA1
Response.JobsDetail.Operation.FileHashC
odeResult

SHA1 计算结
果。

Stri
ng

SHA256
Response.JobsDetail.Operation.FileHashC

odeResult

SHA256 计算结

果。

Stri

ng

FileSize
Response.JobsDetail.Operation.FileHashC

odeResult
文件大小。 Int

LastModified
Response.JobsDetail.Operation.FileHashC
odeResult

文件的最后修改时
间。

Stri
ng
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Etag Response.JobsDetail.Operation.FileHashC

odeResult

文件的Etag。 Stri

ng

错误码

实际案例

请求

POST /file_jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>FileHashCode</Tag>

    <Input>

        <Object>input/test.mp4</Object>

    </Input>

    <Operation>

        <FileHashCodeConfig>

            <Type>MD5</Type>

            <AddToHeader>true</AddToHeader>

        </FileHashCodeConfig>

        <UserData>This is my data.</UserData>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

https://cloud.tencent.com/document/product/436/53983
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    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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查询哈希值计算结果
最近更新时间：2022-11-18 14:50:34

本接口用于主动查询指定的文件哈希值计算任务结果。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /file_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <FileHashCodeResult>

                <MD5>xxxxxxxx</MD5>

                <FileSize>123</FileSize>

                <LastModified>2022-06-27T15:23:11+0800</LastModified>

                <Etag>xxxxxx</Etag>

            </FileHashCodeResult>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器。 Container

节点名称（关键

字）
父节点 描述 类型

JobsDetail
Respons
e

任务的详细信息。
Containe
r

NonExistJobId

s

Respons

e

查询的 ID 中不存在任务，所有任务都存在时不返

回。
String
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具体参数值，请前往 文件哈希值计算 JobsDetail 查看 。

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

错误码

实际案例

请求

GET /file_jobs/f93984788066911ed89ed352d4d9d2084 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

https://cloud.tencent.com/document/product/460/83085#jobdetail
https://cloud.tencent.com/document/product/460/42867
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                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <FileHashCodeResult>

                <MD5>xxxxxxxx</MD5>

                <FileSize>123</FileSize>

                <LastModified>2022-06-27T15:23:11+0800</LastModified>

                <Etag>xxxxxx</Etag>

            </FileHashCodeResult>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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文件解压

提交文件解压任务
最近更新时间：2023-05-17 17:06:15

以提交任务的方式进行文件解压缩，异步返回压缩包内被解压出来的文件，该接口属于 POST 请求。

功能描述

费用说明

调用接口会产生 文件解压费用  和 COS 读请求费用 。

如果文件为 COS 上的低频存储类型，调用会产生 COS 低频数据取回费用 。

不支持解压 COS 上的归档存储类型和深度归档存储类型的文件，如果解压需要此类型文件，请先 恢复归档文

件 。

限制说明

文件大小支持：支持解压小于 5 TB 的压缩包文件。

文件解压的处理方式为流式解压，会边解压边输出解压文件，如果解压过程中有部分文件损坏导致解压操作中

止，会保留已解压的部分文件。

调用接口需携带签名，具体规则请参见 请求签名  文档。

本接口当前支持以下地域：北京、上海、广州、成都、南京、重庆、中国香港、新加坡、硅谷。

请求

请求示例

POST /file_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

https://cloud.tencent.com/document/product/436/82325
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

请求头

请求体

<Request>

    <Tag>FileUncompress</Tag>

    <Input>

        <Object>input/test.zip</Object>

    </Input>

    <Operation>

        <FileUncompressConfig>

            <Prefix>output/</Prefix>

            <PrefixReplaced>1</PrefixReplaced>

            <UnCompressKey>MTIzNDU2Nzg5MA==</UnCompressKey>

        </FileUncompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器。 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Tag

Req

ues

t

表示任务的类型，文件解压默认为：

FileUncompress。

Strin

g
是

Input Req

ues

包含待操作的文件信息。 Cont

ainer

是

https://cloud.tencent.com/document/product/460/42865
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Container 类型 Input 的具体数据描述如下：

Container 类型 Operation 的具体数据描述如下：

Container 类型 FileUncompressConfig 的具体数据描述如下：

t

Operation

Req

ues

t

包含文件解压的处理规则。
Cont

ainer
是

CallBackF

ormat

Req

ues

t

任务回调格式，JSON 或 XML，默认 XML，优先级高

于队列的回调格式。

Strin

g
否

CallBackT

ype

Req
ues

t

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队

列的回调类型。

Strin

g
否

CallBack
Req
ues

t

任务回调的地址，优先级高于队列的回调地址。
Strin
g

否

CallBackM
qConfig

Req

ues
t

任务回调 TDMQ 配置，当 CallBackType 为 TDMQ 
时必填。详情见 CallBackMqConfig

Cont
ainer

否

节点名称（关键

字）
父节点 描述 类型

是否必

选

Object
Request.In
put

文件名，取值为文件在当前存储桶中的完整
名称。

Strin
g

是

节点名称（关键

字）
父节点 描述 类型

是否

必选

FileUncompres

sConfig

Request.Ope

ration
指定文件解压的处理规则。

Conta

iner
是

UserData
Request.Ope

ration

透传用户信息, 可打印的 ASCII 码, 长

度不超过1024
String 否

Output
Request.Ope

ration
指定解压后的文件保存的存储桶信息。

Conta

iner
是

节 父节点 描述 类 是

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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点

名

称
（

关

键

字
）

型 否

必

选

Pr

efi

x

Requ

est.O
perati

on.Fil

eUnc

ompr

essC
onfig

指定解压后输出文件的前缀，不填则默认保存在存储桶根路径。
Str

ing
否

U

n
C

o

m

pr
es

s

K

ey

Requ
est.O

perati

on.Fil

eUnC
ompr

essC

onfig

解压密钥，传入时需先经过 base64 编码。
Str

ing
否

Pr

efi

x

R
e

pl

ac

e
d

Requ

est.O

perati
on.Fil

eUnc

ompr

essC

onfig

指定解压后的文件路径是否需要替换前缀，有效值：

- 0：不添加额外的前缀，解压缩将保存在Prefix指定的路径下（不

会保留压缩包的名称，仅将压缩包内的文件保存至指定的路径）。
- 1：以压缩包本身的名称作为前缀，解压缩将保存在Prefix指定的路

径下。

- 2：以压缩包完整路径作为前缀，此时如果不指定Prefix，就是解

压到压缩包所在的当前路径（包含压缩包本身名称）。

- 默认值为0。

Str

ing
否

示例：

假设压缩包名为 test.zip，压缩包内的文件为“图片.jpg”，存储在了存储桶 A 的 123 目录下，则压缩包

的完整路径为：123/test.zip。 

对该压缩包进行解压缩，指定解压缩到存储桶A，并指定 Prefix  为 456，则不同的 PrefixReplaced 值

对应解压后的文件保存情况如下：
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Container 类型 Output 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

0：“图片.jpg”会保存在 456 目录下，“图片.jpg”的完整路径为 456/图片.jpg； 

1：“图片.jpg”会以 test 为前缀保存在 456 目录下，“图片.jpg”的完整路径为 456/test/图片.jpg； 

2：“图片.jpg”会以 123/test 为前缀保存在 456 目录下，“图片.jpg”的完整路径为 456/123/test/

图片.jpg。

节点名称（关键

字）
父节点 描述 类型

是否必

选

Region
Request.Operation.Out
put

存储桶的地域。
Strin
g

是

Bucket
Request.Operation.Out

put

保存解压后文件的存储

桶。

Strin

g
是

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

                <PrefixReplaced>1</PrefixReplaced>

                <UnCompressKey>MTIzNDU2Nzg5MA==</UnCompressKey>

            </FileUncompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器。 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息。 Container

JobsDetail

节点名称

（关键

字）

父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义。 String

Messag
e

Response.J
obsDetail

错误描述，只有 State 为 Failed 时有意义。 String

JobId
Response.J

obsDetail
新创建任务的 ID。 String

Tag
Response.J

obsDetail

表示任务的类型，文件解压默认为：

FileUncompress。
String

State
Response.J
obsDetail

任务的状态，为 Submitted(已提交)、Running(进行
中)、Success(成功)、Failed(失败)、Pause(已暂

停)、Cancel(已取消) 其中一个

String
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

Container 节点 FileUncompressResult 的内容：

Creatio
nTime

Response.J
obsDetail

任务的创建时间。 String

StartTi

me

Response.J

obsDetail
任务的开始时间。 String

EndTim

e

Response.J

obsDetail
任务的结束时间。 String

QueueI
d

Response.J
obsDetail

任务所属的队列 ID。 String

Input
Response.J

obsDetail
被解压文件的信息。 Container

Operati

on

Response.J

obsDetail
文件解压的处理规则。 Container

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶所在地域。 String

Bucket Response.JobsDetail.Input 文件所在的存储桶。 String

Object Response.JobsDetail.Input 被解压文件的文件名。 String

节点名称（关键

字）
父节点 描述 类型

UserData
Response.JobsDeta

il.Operation
透传用户信息。

Strin

g

Output
Response.JobsDeta
il.Operation

同请求中的 
Request.Operation.Output

Cont
ainer

FileUncompre

ssConfig

Response.JobsDeta

il.Operation

同请求中的 

Request.Operation.FileUncompres
sConfig。

Cont

ainer

FileUncompre

ssResult

Response.JobsDeta

il.Operation
文件解压的结果，任务未完成时不返回。

Cont

ainer
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关

键字）

父节点 描述 类型

Region
Response.JobsDetail.Operation.FileUnco

mpressResult

解压后文件保存的存储

桶的地域

Stri

ng

Bucket
Response.JobsDetail.Operation.FileUnco

mpressResult

解压后文件保存的存储

桶

Stri

ng

FileCount
Response.JobsDetail.Operation.FileUnco

mpressResult
解压后文件的个数

Stri

ng

错误码

实际案例

请求

POST /file_jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>FileUncompress</Tag>

    <Input>

        <Object>input/test.zip</Object>

    </Input>

    <Operation>

        <FileUncompressConfig>

            <Prefix>output/</Prefix>

            <PrefixReplaced>1</PrefixReplaced>

            <UnCompressKey>MTIzNDU2Nzg5MA==</UnCompressKey>

        </FileUncompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

https://cloud.tencent.com/document/product/460/42867
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

                <PrefixReplaced>1</PrefixReplaced>

                <UnCompressKey>MTIzNDU2Nzg5MA==</UnCompressKey>

            </FileUncompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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查询文件解压结果
最近更新时间：2022-11-18 14:52:13

本接口用于主动查询指定的文件解压任务结果。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /file_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

具体参数值，请前往 文件解压 JobsDetail 查看 。

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

                <PrefixReplaced>1</PrefixReplaced>

            </FileUncompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器。 Container

节点名称（关键

字）
父节点 描述 类型

JobsDetail
Respons
e

任务的详细信息。
Containe
r

NonExistJobId

s

Respons

e

查询的 ID 中不存在任务，所有任务都存在时不返

回。
String

https://cloud.tencent.com/document/product/460/83087#jobdetail
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

错误码

实际案例

请求

GET /file_jobs/f93984788066911ed89ed352d4d9d2084 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

                <PrefixReplaced>1</PrefixReplaced>

https://cloud.tencent.com/document/product/460/42867
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            </FileUncompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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多文件打包压缩
提交多文件打包压缩任务
最近更新时间：2023-05-17 17:06:30

多文件打包压缩功能可以将您的多个文件，打包为 zip 等压缩包格式，以提交任务的方式进行多文件打包压缩，异

步返回打包后的文件，该接口属于 POST 请求。

功能描述

费用说明

调用接口会产生 多文件打包压缩费用  和 COS 读请求费用 。

如果文件为 COS 上的低频存储类型，调用会产生 COS 低频数据取回费用 。

不支持打包 COS 上的归档存储类型和深度归档存储类型的文件，如果打包需要此类型文件，请先 恢复归档文

件 。

限制说明

文件数量支持：最多支持打包 1 万个文件；

文件大小支持：打包压缩后总大小小于 50GB；

调用接口需携带签名，具体规则请参见 请求签名  文档。

本接口当前支持以下地域：北京、上海、广州、成都、南京、重庆、中国香港、新加坡、硅谷。

请求

请求示例

POST /file_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

https://cloud.tencent.com/document/product/436/82325
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

请求头

请求体

<Request>

    <Tag>FileCompress</Tag>

    <Operation>

        <FileCompressConfig>

            <Prefix>test/</Prefix>

            <Format>zip</Format>

            <Flatten>0</Flatten>

            <Type>better</Type>

            <CompressKey>MTIzNDU2Nzg5MA==</CompressKey>

        </FileCompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/test.zip</Object>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器。 Container 是

节点名称

（关键字）

父节

点
描述 类型

是
否

必

选

Tag
Req

uest

表示任务的类型，多文件打包压缩默认为：

FileCompress。

Strin

g
是

Operation Req 包含文件打包压缩的处理规则。 Cont 是

https://cloud.tencent.com/document/product/460/42865
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Container 类型 Operation 的具体数据描述如下：

Container 类型 FileCompressConfig 的具体数据描述如下：

uest ainer

CallBackF

ormat

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先级高于

队列的回调格式。

Strin

g
否

CallBack

Type

Req

uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队列

的回调类型。

Strin

g
否

CallBack
Req

uest
任务回调的地址，优先级高于队列的回调地址。

Strin

g
否

CallBack

MqConfig

Req

uest

任务回调 TDMQ 配置，当 CallBackType 为 TDMQ 时

必填。详情请参见 CallBackMqConfig

Cont

ainer
否

节点名称（关键

字）
父节点 描述 类型

是否

必选

FileCompress

Config

Request.Ope

ration
指定文件打包压缩的处理规则。

Contai

ner
是

UserData
Request.Ope
ration

透传用户信息, 可打印的 ASCII 码, 长
度不超过1024

String 否

Output
Request.Ope

ration

指定打包压缩后的文件保存的地址信

息。

Contai

ner
是

节点
名称

（关

键

字）

父节

点
描述 类型

是
否

必

选

Flat

ten

Requ

est.

Oper

ation
.File

Com

pres

sCon
fig

文件打包时，是否需要去除源文件已有的目录结构，有效值：

例如：源文件 URL 为 https://domain/source/test.mp4, 则源

文件路径为 source/test.mp4，如果为 1，则 ZIP 包中该文件路

径为 test.mp4；如果为0， ZIP 包中该文件路径为 
source/test.mp4。

0：不需要去除目录结构，打包后压缩包中的文件会保留原有的

目录结构；

1：需要，打包后压缩包内的文件会去除原有的目录结构，所有文
件都在同一层级。

Stri

ng
是

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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For
mat

Requ
est.

Oper

ation

.File

Com
pres

sCon

fig

打包压缩的类型，有效值：zip、tar、tar.gz。 Stri
ng

是

Typ
e

Requ

est.

Oper

ation
.File

Com

pres

sCon

fig

压缩类型，仅在Format为tar.gz或zip时有效。

默认值为default

faster：压缩速度较快

better：压缩质量较高，体积较小

default：适中的压缩方式

Stri
ng

否

Co
mpr

ess

Key

Requ

est.

Oper
ation

.File

Com

pres
sCon

fig

压缩包密钥，传入时需先经过 base64 编码, 编码后长度不能超过

128。当 Format 为 zip 时生效

Stri

ng
否

UrlL

ist

Requ

est.
Oper

ation

.File

Com
pres

sCon

fig

支持将需要打包的文件整理成索引文件，后台将根据索引文件内
提供的文件 url，打包为一个压缩包文件。

索引文件需要保存在当前存储桶中，本字段需要提供索引文件的

对象地址，例如：/test/index.csv。

索引文件格式：仅支持 CSV 文件，一行一条 URL（仅支持本存
储桶文件），如有多列字段，默认取第一列作为URL。最多不超

过10000个文件，总大小不超过50G， 否则会导致任务失败。

Stri

ng
否

Pref

ix

Requ

est.

Oper

ation

.File
Com

支持对存储桶中的某个前缀进行打包，如果需要对某个目录进行打

包，需要加/，例如test目录打包，则值为：test/。最多不超过

10000个文件，总大小不超过50G，否则会导致任务失败。

Stri

ng

否
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Container 类型 Output 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

pres

sCon
fig

Key

Requ

est.

Oper
ation

.File

Com

pres
sCon

fig

支持对存储桶中的多个文件进行打包，个数不能超过 1000, 总大小

不超过50G，否则会导致任务失败。

Stri

ng

数组

否

注意

UrlList、Prefix、Key 三者仅能选择一个，不能都为空，也不会同时生效。如果填了多个，会按优先级 

UrlList > Prefix > Key 取最高优先级执行。

节点名称（关键

字）
父节点 描述 类型

是否必

选

Region
Request.Operation.Out

put
存储桶的地域。

Strin

g
是

Bucket
Request.Operation.Out
put

保存压缩后文件的存储
桶。

Strin
g

是

Object
Request.Operation.Out

put
压缩后文件的文件名

Strin

g
是

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>

        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

                <Type>better</Type>

                <CompressKey>MTIzNDU2Nzg5MA==</CompressKey>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器。 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息。 Container

JobsDetail

节点名称
（关键

字）

父节点 描述 类型

Code Respons 错误码，只有 State 为 Failed 时有意义。 String
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Container 节点 Operation 的内容：

e.JobsD

etail

Messag
e

Respons
e.JobsD

etail

错误描述，只有 State 为 Failed 时有意义。 String

JobId

Respons

e.JobsD
etail

新创建任务的 ID。 String

Tag

Respons

e.JobsD
etail

表示任务的类型，多文件打包压缩默认为：FileCompress。 String

State

Respons

e.JobsD

etail

任务的状态，为 Submitted(已提交)、Running(进行中)、

Success(成功)、Failed(失败)、Pause(已暂停)、

Cancel(已取消) 其中一个

String

Creatio

nTime

Respons

e.JobsD

etail

任务的创建时间。 String

StartTi

me

Respons

e.JobsD

etail

任务的开始时间。 String

EndTim

e

Respons

e.JobsD

etail

任务的结束时间。 String

QueueI

d

Respons

e.JobsD

etail

任务所属的队列 ID。 String

Operati

on

Respons

e.JobsD

etail

多文件打包压缩的处理规则。
Conta

iner

节点名称（关键

字）
父节点 描述 类型

UserData
Response.JobsDetail

.Operation
透传用户信息。

Strin

g
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Container 节点 FileCompressResult 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Output Response.JobsDetail
.Operation

同请求中的 
Request.Operation.Output

Cont
ainer

FileCompres

sConfig

Response.JobsDetail

.Operation

同请求中的 

Request.Operation.FileCompressC
onfig。

Cont

ainer

FileCompres

sResult

Response.JobsDetail

.Operation

多文件打包压缩的结果，任务未完成时不返

回。

Cont

ainer

节点名称（关

键字）
父节点 描述

类

型

Region
Response.JobsDetail.Operation.FileC

ompressResult

打包压缩后文件保存的存储

桶的地域。

Stri

ng

Bucket
Response.JobsDetail.Operation.FileC

ompressResult

打包压缩后文件保存的存储

桶。

Stri

ng

Object
Response.JobsDetail.Operation.FileC

ompressResult
打包压缩后文件的名称。

Stri

ng

错误码

实际案例

请求

POST /file_jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>FileCompress</Tag>

    <Operation>

        <FileCompressConfig>

            <Prefix>test/</Prefix>

            <Format>zip</Format>

            <Flatten>0</Flatten>

            <Type>better</Type>

https://cloud.tencent.com/document/product/460/42867
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            <CompressKey>MTIzNDU2Nzg5MA==</CompressKey>

        </FileCompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/test.zip</Object>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>

        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

                <Type>better</Type>

                <CompressKey>MTIzNDU2Nzg5MA==</CompressKey>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>
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                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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查询多文件打包压缩结果
最近更新时间：2022-11-18 14:53:41

本接口用于主动查询指定的多文件打包压缩任务结果。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /file_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

具体参数值，请前往 多文件打包压缩 JobsDetail 查看 。

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>

        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器。 Container

节点名称（关键

字）
父节点 描述 类型

JobsDetail
Respons

e
任务的详细信息。

Containe

r

NonExistJobId
s

Respons
e

查询的 ID 中不存在任务，所有任务都存在时不返
回。

String

错误码

https://cloud.tencent.com/document/product/460/83091#jobdetail
https://cloud.tencent.com/document/product/460/42867
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实际案例

请求

GET /file_jobs/f93984788066911ed89ed352d4d9d2084 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>

        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>
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    </JobsDetail>

</Response>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1184 共1701页

压缩包预览
最近更新时间：2023-06-02 11:14:11

该接口可以在不解压文件的情况下预览压缩包内的内容，包含文件数量、名称、文件时间等，接口为同步请求方式。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

费用说明

调用接口会产生数据万象的 文件解压费用 。

如果文件为 COS 上的低频存储类型，调用会产生 COS 低频数据取回费用 。

不支持处理 COS 上的归档存储类型和深度归档存储类型的文件，如果需要处理此类型文件，请先 恢复归档文

件 。

限制说明

支持预览的压缩包格式：zip、tar、gz、7zip、rar

预览压缩包大小限制：zip/7zip无大小限制，tar/gz/rar需小于128MB

预览压缩包内的文件数限制：仅支持预览内部文件数量小于1000的压缩包

请求超时时间：10秒

调用接口需携带签名，具体规则请参见 请求签名  文档。

本接口当前支持以下地域：北京、上海、广州、成都、南京、重庆、中国香港、新加坡、硅谷。

请求

请求示例

GET /for-test.zip?ci-process=zippreview HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/82325#.E6.96.87.E4.BB.B6.E5.A4.84.E7.90.86.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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参数说明如下：

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

请求参数

节点名称（关键字） 描述 类型 是否必选

ci-process 操作类型，压缩包预览计算固定为：zippreview String 是

请求体

响应

响应头

响应体

<Response>

    <FileNumber>2</FileNumber>

    <Contents>

        <Key>test1.jpg</Key>

        <LastModified>2021-11-21T12:30:42+0000</LastModified>

        <UncompressedSize>46743</UncompressedSize>

    </Contents>

    <Contents>

        <Key>test2.mp3</Key>

        <LastModified>2021-11-22T12:11:26+0000</LastModified>

        <UncompressedSize>733318</UncompressedSize>

    </Contents>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/436/7729
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Container 节点 Contents 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

FileNumber Response 压缩包中的文件数量。 Int

Contents Response 保存文件信息的容器。 Container 数组

节点名称（关键字） 父节点 描述 类型

Key Response.Contents 文件名称 String

LastModified Response.Contents 文件的最近一次修改的时间 String

UncompressedSize Response.Contents 文件压缩前的大小 Int

错误码

实际案例

请求

GET /for-test.zip?ci-process=zippreview HTTP/1.1

Host: test-1234567890.cos.ap-beijing.myqcloud.com

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG*

Content-Length: 0

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-cos

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZmNw==

<Response>

    <FileNumber>2</FileNumber>

    <Contents>

        <Key>test1.jpg</Key>

        <LastModified>2021-11-21T12:30:42+0000</LastModified>

        <UncompressedSize>46743</UncompressedSize>

    </Contents>

    <Contents>

https://cloud.tencent.com/document/product/436/53983
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        <Key>test2.mp3</Key>

        <LastModified>2021-11-22T12:11:26+0000</LastModified>

        <UncompressedSize>733318</UncompressedSize>

    </Contents>

</Response>
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智能语音
服务与队列配置

查询语音识别队列
最近更新时间：2023-06-06 17:29:09

DescribeSpeechQueues 接口用于查询语音识别队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /asrqueue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

名

称 
类型 描述

是

否

必

选

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展示

如下：

qu

eu

eId
s

stri

ng

队列 ID，以“,”符号分割字符串 否

sta

te

stri

ng

1. Active 表示队列内的作业会被语音识别服务调度执行

2. Paused 表示队列暂停，作业不再会被语音识别服务调度执行，队列内的所有
作业状态维持在暂停状态，已经处于识别中的任务将继续执行，不受影响

否

pa

ge
Nu

mb

er

stri
ng

第几页 否

pa
ge

Siz

e

stri

ng
每页个数 否

响应

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>A</QueueId>

        <Name></Name>

        <State>Active</State>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime></UpdateTime>

        <CreateTime></CreateTime>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 QueueList 的内容：

        <NotifyConfig>

            <Url></Url>

            <Type></Type>

            <State></State>

            <Event></Event>

        </NotifyConfig>

    </QueueList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

TotalCount Response 队列总数 Int

PageNumber Response 当前页数，同请求中的 pageNumber Int

PageSize Response 每页个数，同请求中的 pageSize Int

QueueList Response 队列数组 Container

节点名称（关键字） 父节点 描述 类型

QueueId Response.QueueList 队列 ID String

Name Response.QueueList 队列名字 String

State Response.QueueList 当前状态，Active 或者 Paused String

NotifyConfig Response.QueueList 回调配置 Container

MaxSize Response.QueueList 队列最大长度 Int

MaxConcurrent Response.QueueList 当前队列最大并行执行的任务数 Int

UpdateTime Response.QueueList 更新时间 String
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Container 节点 NotifyConfig 的内容：

该响应体返回为 application/xml 数据，当指定queueIds时包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

CreateTime Response.QueueList 创建时间 String

节点名称（关键

字）
父节点 描述 类型

Url
Response.QueueList.NotifyConfi

g
回调地址 String

State
Response.QueueList.NotifyConfi

g
开关状态，On 或者 Off String

Type
Response.QueueList.NotifyConfi
g

回调类型，Url String

Event
Response.QueueList.NotifyConfi

g
触发回调的事件 String

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <QueueList>

        <QueueId>A</QueueId>

        <Name></Name>

        <State>Active</State>

        <NotifyConfig>

            <Url></Url>

        </NotifyConfig>

    </QueueList>

    <NonExistPIDs>

        <QueueID>B</QueueID>

        <QueueID>C</QueueID>

    </NonExistPIDs>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container
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Container 节点 NonExistPIDs 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

QueueList Response 队列数组，同上面解释的 QueueList Container

NonExistPIDs Response 不存在的队列 ID 列表 Container

节点名称（关键字） 父节点 描述 类型

QueueID Response.NonExistPIDs 队列 ID String

错误码

https://cloud.tencent.com/document/product/460/42867


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1193 共1701页

语音识别
提交任务
最近更新时间：2023-02-16 14:38:54

提交一个语音识别任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

极速ASR仅支持100 MB以内且时长不超过2小时的音频文件

普通ASR的音频时长不能长于5小时，文件大小不超过512MB

请求头

请求体

<Request>

    <Tag>SpeechRecognition</Tag>

    <Input>

        <Object>input/test.mp3</Object>

    </Input>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/asr.txt</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称
（关键字）

父节
点

描述 类型

是

否
必

选

Tag
Re
que

st

创建任务的 Tag：SpeechRecognition
Strin
g

是

Input

Re

que
st

待操作的对象信息

Cont

aine
r

是

Operation

Re

que
st

操作规则

Cont

aine
r

是

CallBackF

ormat

Re

que

st

任务回调格式，JSON 或 XML，默认 XML，优先级高于

队列的回调格式

Strin

g
否

CallBackT

ype

Re

que

st

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队列

的回调类型

Strin

g
否
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Container 类型 Input 的具体数据描述如下：

Container 类型 Operation 的具体数据描述如下：

CallBack

Re

que

st

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Strin

g
否

CallBack

MqConfig

Re

que

st

任务回调TDMQ配置，当 CallBackType 为 TDMQ 时必

填。详情见 CallBackMqConfig

Cont

aine

r

否

节点名称

（关键字）
父节点 描述

类

型

是否

必选

Object
Reques

t.Input
文件路径

St

rin

g

否

Url
Reques

t.Input

支持公网下载的Url，与Object必须有其中一个，且当两

者都传入时，优先使用Object

St

rin

g

否

节点名称（关
键字）

父节点 描述 类型

是

否
必

选

TemplateI
d

Request.O
peration

模板 ID
Strin
g

否

SpeechRe

cognition

Request.O

peration

语音识别参数，同创建语音识别模板接口中的 

Request.SpeechRecognition  

Cont

aine

r

否

Output
Request.O

peration
结果输出配置

Cont

aine

r

是

UserData
Request.O

peration

透传用户信息, 可打印的 ASCII 码, 长度不超过

1024

Strin

g
否

JobLevel
Request.O
peration

任务优先级，级别限制：0 、1 、2 。级别越大任务
优先级越高，默认为0

Strin
g

否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
https://cloud.tencent.com/document/product/460/84498#SpeechRecognition
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Container 类型 Output 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

注意

 优先使用 TemplateId，无 TemplateId 时使用 SpeechRecognition。

节点名称（关键字） 父节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储桶 String 是

Object Request.Operation.Output 结果文件的名称 String 是

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2021-08-05T15:43:50+0800</CreationTime>

        <EndTime>-</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s58ccb634149211ed84ce2b1cd7fbb14a</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/asr.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>speech_demo</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

 

        </Operation>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <StartTime>-</StartTime>

        <State>Submitted</State>

        <Tag>SpeechRecognition</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称

（关键字）
父节点 描述 类型

Code
Response.J
obsDetail

错误码，只有 State 为 Failed 时有意义
Strin
g

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Strin

g

JobId
Response.J

obsDetail
新创建任务的 ID

Strin

g

Tag
Response.J
obsDetail

新创建任务的 Tag：SpeechRecognition
Strin
g

State
Response.J

obsDetail

任务的状态，为 Submitted、Running、Success、

Failed、Pause、Cancel 其中一个

Strin

g

Creation

Time

Response.J

obsDetail
任务的创建时间

Strin

g

StartTim
e

Response.J
obsDetail

任务的开始时间
Strin
g
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Container 节点 Operation 的内容：

Container 节点 SpeechRecognitionResult 的内容：

EndTime Response.J

obsDetail

任务的结束时间 Strin

g

QueueId
Response.J

obsDetail
任务所属的队列 ID

Strin

g

Input
Response.J
obsDetail

同请求中的 Request.Input 节点
Cont
ainer

Operatio

n

Response.J

obsDetail
该任务的规则

Cont

ainer

节点名称（关键字） 父节点 描述 类型

TemplateId
Response.JobsDetai

l.Operation
任务的模板 ID

Strin

g

TemplateName
Response.JobsDetai
l.Operation

任务的模板名称, 当 TemplateId 存在
时返回

Strin
g

SpeechRecognit

ion

Response.JobsDetai

l.Operation

同请求中的 

Request.Operation.SpeechReco
gnition

Cont

ainer

Output
Response.JobsDetai

l.Operation

同请求中的 

Request.Operation.Output

Cont

ainer

UserData
Response.JobsDetai

l.Operation
透传用户信息

Strin

g

JobLevel
Response.JobsDetai
l.Operation

任务优先级
Strin
g

SpeechRecognit

ionResult

Response.JobsDetai

l.Operation
语音识别任务结果，没有时不返回

Cont

ainer

节点

名称
（关

键

字）

父节点 描述 类型

Audi Response.JobsDetail. 音频时长(秒) Stri
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Container 节点 FlashResult 的内容：

Container 节点 sentence_list 的内容：

oTi

me

Operation.SpeechRec

ognitionResult

ng

Res

ult

Response.JobsDetail.

Operation.SpeechRec

ognitionResult

语音识别结果
Stri

ng

Flas

hRe

sult

Response.JobsDetail.

Operation.SpeechRec

ognitionResult

极速语音识别结果

Co
ntai

ner 

数组

Res

ultD

etail

Response.JobsDetail.

Operation.SpeechRec

ognitionResult

识别结果详情，包含每个句子中的词时间偏移，一般用

于生成字幕的场景。(语音识别请求中

ResTextFormat=1时该字段不为空)

注意：此字段可能为空，表示取不到有效值。

Co

ntai

ner 

数组

节点名称

（关键
字）

父节点 描述 类型

channel

_id

Response.JobsDetail.Operation.SpeechR

ecognitionResult.FlashResult

声道标识，从0开

始，对应音频声道数
Integer

text
Response.JobsDetail.Operation.SpeechR

ecognitionResult.FlashResult

声道音频完整识别结

果
String

sentenc

e_list

Response.JobsDetail.Operation.SpeechR

ecognitionResult.FlashResult

句子/段落级别的识别

结果列表

Contai
ner 数

组

节点

名称

（关
键

字）

父节点 描述 类型

text

Response.JobsDetail.Operation.S

peechRecognitionResult.FlashRes
ult.sentence_list

句子/段落级别文本
Stri
ng

start

_tim

Response.JobsDetail.Operation.S

peechRecognitionResult.FlashRes

开始时间 Int

ege
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Container 节点 word_list 的内容：

Container 节点 ResultDetail 的内容：

e ult.sentence_list r

end

_tim
e

Response.JobsDetail.Operation.S

peechRecognitionResult.FlashRes
ult.sentence_list

结束时间

Int

ege
r

spe

aker

_id

Response.JobsDetail.Operation.S

peechRecognitionResult.FlashRes

ult.sentence_list

说话人 Id（请求中如果设置了 

speaker_diarization，可以按照 

speaker_id 来区分说话人）

Int

ege

r

wor

d_lis

t

Response.JobsDetail.Operation.S

peechRecognitionResult.FlashRes

ult.sentence_list

词级别的识别结果列表

Co

ntai

ner 
数组

节点名称

（关键

字）

父节点 描述
类

型

word
Response.JobsDetail.Operation.SpeechRecognitionResult.

FlashResult.sentence_list.word_list

词级
别文

本

Str

ing

start_tim
e

Response.JobsDetail.Operation.SpeechRecognitionResult.
FlashResult.sentence_list.word_list

开始
时间

Int
eg

er

end_tim
e

Response.JobsDetail.Operation.SpeechRecognitionResult.
FlashResult.sentence_list.word_list

结束
时间

Int

eg
er

节点

名称

（关

键
字）

父节点 描述 类型

Fina

lSen
tenc

e

Response.JobsDetail.Opera

tion.SpeechRecognitionRes
ult.ResultDetail

单句最终识别结果
Stri
ng

Slic Response.JobsDetail.Opera 单句中间识别结果，使用空格拆分为多个词 Stri
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Container 节点 Words 的内容：

eSe
nten

ce

tion.SpeechRecognitionRes
ult.ResultDetail

ng

Star
tMs

Response.JobsDetail.Opera
tion.SpeechRecognitionRes

ult.ResultDetail

单句开始时间（毫秒）
Stri
ng

End
Ms

Response.JobsDetail.Opera

tion.SpeechRecognitionRes
ult.ResultDetail

单句结束时间（毫秒）
Stri
ng

Wor

dsN
um

Response.JobsDetail.Opera

tion.SpeechRecognitionRes
ult.ResultDetail

单句中词个数
Stri

ng

Spe

ech
Spe

ed

Response.JobsDetail.Opera

tion.SpeechRecognitionRes
ult.ResultDetail

单句语速，单位：字数/秒
Stri
ng

Spe

aker
Id

Response.JobsDetail.Opera

tion.SpeechRecognitionRes
ult.ResultDetail

声道或说话人 Id（请求中如果设置了 
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

错误码

实际案例

请求：使用语音识别模板 ID

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SpeechRecognition</Tag>

    <Input>

        <Object>input/test.mp3</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/asr.txt</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

https://cloud.tencent.com/document/product/460/42867


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1203 共1701页

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2021-08-05T15:43:50+0800</CreationTime>

        <EndTime>-</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s58ccb634149211ed84ce2b1cd7fbb14a</JobId>

        <Message/>

        <Operation>

            <JobLevel>0</JobLevel>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/asr.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>speech_demo</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <StartTime>-</StartTime>

        <State>Submitted</State>

        <Tag>SpeechRecognition</Tag>

    </JobsDetail>

</Response>

请求2：使用语音识别参数

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SpeechRecognition</Tag>

    <Input>

        <Object>input/test.mp3</Object>

    </Input>

    <Operation>
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        <SpeechRecognition>

            <EngineModelType>16k_zh_video</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <FilterDirty>1</ChannelNum>

            <FilterModal>1</ChannelNum>

        </SpeechRecognition>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/asr.txt</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2021-08-05T15:43:50+0800</CreationTime>

        <EndTime>-</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s58ccb634149211ed84ce2b1cd7fbb14a</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1205 共1701页

                <Object>output/asr.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SpeechRecognition>

                <ChannelNum>1</ChannelNum>

                <ConvertNumMode>0</ConvertNumMode>

                <EngineModelType>16k_zh_video</EngineModelType>

                <FilterDirty>0</FilterDirty>

                <FilterModal>0</FilterModal>

                <FilterPunc>0</FilterPunc>

                <OutputFileType>txt</OutputFileType>

                <ResTextFormat>0</ResTextFormat>

                <SpeakerDiarization>0</SpeakerDiarization>

                <SpeakerNumber>0</SpeakerNumber>

            </SpeechRecognition>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <StartTime>-</StartTime>

        <State>Submitted</State>

        <Tag>SpeechRecognition</Tag>

    </JobsDetail>

</Response>
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任务回调
最近更新时间：2023-01-31 14:15:12

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数

据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <State>Success</State>

        <Tag>SpeechRecognition</Tag>

        <Code>Success</Code>

        <CreationTime>2022-09-02T10:25:38+0800</CreationTime>

        <StartTime>2022-09-02T10:25:39+0800</StartTime>

        <EndTime>2022-09-02T10:25:46+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>minnong.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s886c0a7c2a6611ed847a618901112dcf</JobId>

        <QueueId>pe91d0af11fc14337987ff0c34f8b0886</QueueId>

        <Message/>

        <Operation>

            <UserData>This is my SpeechRecognition job.</UserData>

            <JobLevel>0</JobLevel>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>/example.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SpeechRecognitionResult>

                <AudioTime>19.7124</AudioTime>

                <DetailObjectName>/example.txt.detail</DetailObjectName>

                <ObjectName>/example.txt</ObjectName>

                <Result>[0:3.320,0:19.712]  悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒
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                <ResultDetail>

                    <EndMs>19712</EndMs>

                    <FinalSentence>悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒粒皆辛苦。

                    <SliceSentence>悯 农 ， 李 绅 ， 锄禾 日 当午 ， 汗滴 禾 下 土 。 谁知 盘中餐 ， 

                    <SpeakerId>0</SpeakerId>

                    <SpeechSpeed>2.4</SpeechSpeed>

                    <StartMs>3320</StartMs>

                    <Words>

                        <OffsetEndMs>2190</OffsetEndMs>

                        <OffsetStartMs>0</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>悯</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>2625</OffsetEndMs>

                        <OffsetStartMs>2190</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>农</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>2625</OffsetEndMs>

                        <OffsetStartMs>2190</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3060</OffsetEndMs>

                        <OffsetStartMs>2625</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>李</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3825</OffsetEndMs>

                        <OffsetStartMs>3060</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>绅</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3825</OffsetEndMs>

                        <OffsetStartMs>3060</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>5040</OffsetEndMs>
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                        <OffsetStartMs>3825</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>锄禾</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>5475</OffsetEndMs>

                        <OffsetStartMs>5040</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>日</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>6390</OffsetEndMs>

                        <OffsetStartMs>5475</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>当午</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>6390</OffsetEndMs>

                        <OffsetStartMs>5475</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>7365</OffsetEndMs>

                        <OffsetStartMs>6390</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>汗滴</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>7755</OffsetEndMs>

                        <OffsetStartMs>7365</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>禾</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>8130</OffsetEndMs>

                        <OffsetStartMs>7755</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>下</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>8850</OffsetEndMs>

                        <OffsetStartMs>8130</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>土</Word>
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                    </Words>

                    <Words>

                        <OffsetEndMs>8850</OffsetEndMs>

                        <OffsetStartMs>8130</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>。</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>9915</OffsetEndMs>

                        <OffsetStartMs>8850</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>谁知</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>11130</OffsetEndMs>

                        <OffsetStartMs>9915</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>盘中餐</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>11130</OffsetEndMs>

                        <OffsetStartMs>9915</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>12045</OffsetEndMs>

                        <OffsetStartMs>11130</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>粒粒</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>12540</OffsetEndMs>

                        <OffsetStartMs>12045</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>皆</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>14745</OffsetEndMs>

                        <OffsetStartMs>12540</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>辛苦</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>14745</OffsetEndMs>
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容： 

同提交语音识别任务接口中的 Response.JobsDetail  

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

                        <OffsetStartMs>12540</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>。</Word>

                    </Words>

                    <WordsNum>22</WordsNum>

                </ResultDetail>

            </SpeechRecognitionResult>

            <TemplateId>t14aea553bb55c468b963fafa472afc538</TemplateId>

            <TemplateName>test</TemplateName>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container数组

节点名称（关键

字）
父节点 描述 类型

Key
Response.JobsDetail.Input.CosHead

ers

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosHead

ers
自定义 Header 的值

Strin

g

https://cloud.tencent.com/document/product/460/84798#jobsDetail
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节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <State>Success</State>

        <Tag>SpeechRecognition</Tag>

        <Code>Success</Code>

        <CreationTime>2022-09-02T10:25:38+0800</CreationTime>

        <StartTime>2022-09-02T10:25:39+0800</StartTime>

        <EndTime>2022-09-02T10:25:46+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>minnong.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s886c0a7c2a6611ed847a618901112dcf</JobId>

        <QueueId>pe91d0af11fc14337987ff0c34f8b0886</QueueId>

        <Message/>

        <Operation>

            <UserData>This is my SpeechRecognition job.</UserData>

            <JobLevel>0</JobLevel>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>/example.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SpeechRecognitionResult>

                <AudioTime>19.7124</AudioTime>

                <DetailObjectName>/example.txt.detail</DetailObjectName>

                <ObjectName>/example.txt</ObjectName>

                <Result>[0:3.320,0:19.712]  悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒

                <ResultDetail>
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                    <EndMs>19712</EndMs>

                    <FinalSentence>悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒粒皆辛苦。

                    <SliceSentence>悯 农 ， 李 绅 ， 锄禾 日 当午 ， 汗滴 禾 下 土 。 谁知 盘中餐 ， 

                    <SpeakerId>0</SpeakerId>

                    <SpeechSpeed>2.4</SpeechSpeed>

                    <StartMs>3320</StartMs>

                    <Words>

                        <OffsetEndMs>2190</OffsetEndMs>

                        <OffsetStartMs>0</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>悯</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>2625</OffsetEndMs>

                        <OffsetStartMs>2190</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>农</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>2625</OffsetEndMs>

                        <OffsetStartMs>2190</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3060</OffsetEndMs>

                        <OffsetStartMs>2625</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>李</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3825</OffsetEndMs>

                        <OffsetStartMs>3060</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>绅</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3825</OffsetEndMs>

                        <OffsetStartMs>3060</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>5040</OffsetEndMs>

                        <OffsetStartMs>3825</OffsetStartMs>
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                        <VoiceType>0</VoiceType>

                        <Word>锄禾</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>5475</OffsetEndMs>

                        <OffsetStartMs>5040</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>日</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>6390</OffsetEndMs>

                        <OffsetStartMs>5475</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>当午</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>6390</OffsetEndMs>

                        <OffsetStartMs>5475</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>7365</OffsetEndMs>

                        <OffsetStartMs>6390</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>汗滴</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>7755</OffsetEndMs>

                        <OffsetStartMs>7365</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>禾</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>8130</OffsetEndMs>

                        <OffsetStartMs>7755</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>下</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>8850</OffsetEndMs>

                        <OffsetStartMs>8130</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>土</Word>

                    </Words>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1214 共1701页

                    <Words>

                        <OffsetEndMs>8850</OffsetEndMs>

                        <OffsetStartMs>8130</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>。</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>9915</OffsetEndMs>

                        <OffsetStartMs>8850</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>谁知</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>11130</OffsetEndMs>

                        <OffsetStartMs>9915</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>盘中餐</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>11130</OffsetEndMs>

                        <OffsetStartMs>9915</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>12045</OffsetEndMs>

                        <OffsetStartMs>11130</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>粒粒</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>12540</OffsetEndMs>

                        <OffsetStartMs>12045</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>皆</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>14745</OffsetEndMs>

                        <OffsetStartMs>12540</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>辛苦</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>14745</OffsetEndMs>

                        <OffsetStartMs>12540</OffsetStartMs>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1215 共1701页

                        <VoiceType>1</VoiceType>

                        <Word>。</Word>

                    </Words>

                    <WordsNum>22</WordsNum>

                </ResultDetail>

            </SpeechRecognitionResult>

            <TemplateId>t14aea553bb55c468b963fafa472afc538</TemplateId>

            <TemplateName>test</TemplateName>

        </Operation>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-09-02T10:25:38+0800</CreationTime>

        <EndTime>2022-09-02T10:25:46+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>minnong.mp3</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>Audio/mp3</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>s886c0a7c2a6611ed847a618901112dcf</JobId>

        <Message/>

        <Operation>
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            <UserData>This is my SpeechRecognition job.</UserData>

            <JobLevel>0</JobLevel>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>/example.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SpeechRecognitionResult>

                <AudioTime>19.7124</AudioTime>

                <DetailObjectName>/example.txt.detail</DetailObjectName>

                <ObjectName>/example.txt</ObjectName>

                <Result>[0:3.320,0:19.712]  悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒

                <ResultDetail>

                    <EndMs>19712</EndMs>

                    <FinalSentence>悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒粒皆辛苦。

                    <SliceSentence>悯 农 ， 李 绅 ， 锄禾 日 当午 ， 汗滴 禾 下 土 。 谁知 盘中餐 ， 

                    <SpeakerId>0</SpeakerId>

                    <SpeechSpeed>2.4</SpeechSpeed>

                    <StartMs>3320</StartMs>

                    <Words>

                        <OffsetEndMs>2190</OffsetEndMs>

                        <OffsetStartMs>0</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>悯</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>2625</OffsetEndMs>

                        <OffsetStartMs>2190</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>农</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>2625</OffsetEndMs>

                        <OffsetStartMs>2190</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3060</OffsetEndMs>

                        <OffsetStartMs>2625</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>李</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3825</OffsetEndMs>
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                        <OffsetStartMs>3060</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>绅</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3825</OffsetEndMs>

                        <OffsetStartMs>3060</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>5040</OffsetEndMs>

                        <OffsetStartMs>3825</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>锄禾</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>5475</OffsetEndMs>

                        <OffsetStartMs>5040</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>日</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>6390</OffsetEndMs>

                        <OffsetStartMs>5475</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>当午</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>6390</OffsetEndMs>

                        <OffsetStartMs>5475</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>7365</OffsetEndMs>

                        <OffsetStartMs>6390</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>汗滴</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>7755</OffsetEndMs>

                        <OffsetStartMs>7365</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>禾</Word>
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                    </Words>

                    <Words>

                        <OffsetEndMs>8130</OffsetEndMs>

                        <OffsetStartMs>7755</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>下</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>8850</OffsetEndMs>

                        <OffsetStartMs>8130</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>土</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>8850</OffsetEndMs>

                        <OffsetStartMs>8130</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>。</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>9915</OffsetEndMs>

                        <OffsetStartMs>8850</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>谁知</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>11130</OffsetEndMs>

                        <OffsetStartMs>9915</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>盘中餐</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>11130</OffsetEndMs>

                        <OffsetStartMs>9915</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>12045</OffsetEndMs>

                        <OffsetStartMs>11130</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>粒粒</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>12540</OffsetEndMs>
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                        <OffsetStartMs>12045</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>皆</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>14745</OffsetEndMs>

                        <OffsetStartMs>12540</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>辛苦</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>14745</OffsetEndMs>

                        <OffsetStartMs>12540</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>。</Word>

                    </Words>

                    <WordsNum>22</WordsNum>

                </ResultDetail>

            </SpeechRecognitionResult>

            <TemplateId>t14aea553bb55c468b963fafa472afc538</TemplateId>

            <TemplateName>test</TemplateName>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-09-02T10:25:39+0800</StartTime>

        <State>Success</State>

        <Tag>SpeechRecognition</Tag>

        <Workflow>

            <Name>SpeechRecognition_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-09-02T10:25:38+0800",

        "EndTime": "2022-09-02T10:25:46+0800",

        "Input": {



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1220 共1701页

            "BucketId": "test-1234567890",

            "Object": "minnong.mp3",

            "Region": "ap-chongqing",

            "CosHeaders": [{

                    "Key": "Content-Type",

                    "Value": "Audio/mp3"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "s886c0a7c2a6611ed847a618901112dcf",

        "Operation": {

            "UserData": "This is my SpeechRecognition job.",

            "JobLevel": "0",

            "Output": {

                "Bucket": "test-1234567890",

                "Object": "/example.txt",

                "Region": "ap-chongqing"

            },

            "SpeechRecognitionResult": {

                "AudioTime": "19.7124",

                "DetailObjectName": "/example.txt.detail",

                "ObjectName": "/example.txt",

                "Result": "[0:3.320,0:19.712]  悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒

                "ResultDetail": {

                    "EndMs": "19712",

                    "FinalSentence": "悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒粒皆辛苦。

                    "SliceSentence": "悯 农 ， 李 绅 ， 锄禾 日 当午 ， 汗滴 禾 下 土 。 谁知 盘中餐 ，

                    "SpeakerId": "0",

                    "SpeechSpeed": "2.4",

                    "StartMs": "3320",

                    "Words": [{

                            "OffsetEndMs": "2190",

                            "OffsetStartMs": "0",
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                            "VoiceType": "0",

                            "Word": "悯"

                        },

                        {

                            "OffsetEndMs": "2625",

                            "OffsetStartMs": "2190",

                            "VoiceType": "0",

                            "Word": "农"

                        },

                        {

                            "OffsetEndMs": "2625",

                            "OffsetStartMs": "2190",

                            "VoiceType": "1",

                            "Word": "，"

                        },

                        {

                            "OffsetEndMs": "3060",

                            "OffsetStartMs": "2625",

                            "VoiceType": "0",

                            "Word": "李"

                        },

                        {

                            "OffsetEndMs": "3825",

                            "OffsetStartMs": "3060",

                            "VoiceType": "0",

                            "Word": "绅"

                        },

                        {

                            "OffsetEndMs": "3825",

                            "OffsetStartMs": "3060",

                            "VoiceType": "1",

                            "Word": "，"

                        },

                        {

                            "OffsetEndMs": "5040",

                            "OffsetStartMs": "3825",

                            "VoiceType": "0",

                            "Word": "锄禾"

                        },

                        {

                            "OffsetEndMs": "5475",

                            "OffsetStartMs": "5040",

                            "VoiceType": "0",

                            "Word": "日"

                        },
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                        {

                            "OffsetEndMs": "6390",

                            "OffsetStartMs": "5475",

                            "VoiceType": "0",

                            "Word": "当午"

                        },

                        {

                            "OffsetEndMs": "6390",

                            "OffsetStartMs": "5475",

                            "VoiceType": "1",

                            "Word": "，"

                        },

                        {

                            "OffsetEndMs": "7365",

                            "OffsetStartMs": "6390",

                            "VoiceType": "0",

                            "Word": "汗滴"

                        },

                        {

                            "OffsetEndMs": "7755",

                            "OffsetStartMs": "7365",

                            "VoiceType": "0",

                            "Word": "禾"

                        },

                        {

                            "OffsetEndMs": "8130",

                            "OffsetStartMs": "7755",

                            "VoiceType": "0",

                            "Word": "下"

                        },

                        {

                            "OffsetEndMs": "8850",

                            "OffsetStartMs": "8130",

                            "VoiceType": "0",

                            "Word": "土"

                        },

                        {

                            "OffsetEndMs": "8850",

                            "OffsetStartMs": "8130",

                            "VoiceType": "1",

                            "Word": "。"

                        },

                        {

                            "OffsetEndMs": "9915",

                            "OffsetStartMs": "8850",
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                            "VoiceType": "0",

                            "Word": "谁知"

                        },

                        {

                            "OffsetEndMs": "11130",

                            "OffsetStartMs": "9915",

                            "VoiceType": "0",

                            "Word": "盘中餐"

                        },

                        {

                            "OffsetEndMs": "11130",

                            "OffsetStartMs": "9915",

                            "VoiceType": "1",

                            "Word": "，"

                        },

                        {

                            "OffsetEndMs": "12045",

                            "OffsetStartMs": "11130",

                            "VoiceType": "0",

                            "Word": "粒粒"

                        },

                        {

                            "OffsetEndMs": "12540",

                            "OffsetStartMs": "12045",

                            "VoiceType": "0",

                            "Word": "皆"

                        },

                        {

                            "OffsetEndMs": "14745",

                            "OffsetStartMs": "12540",

                            "VoiceType": "0",

                            "Word": "辛苦"

                        },

                        {

                            "OffsetEndMs": "14745",

                            "OffsetStartMs": "12540",

                            "VoiceType": "1",

                            "Word": "。"

                        }

                    ],

                    "WordsNum": "22"

                }

            },

            "TemplateId": "t14aea553bb55c468b963fafa472afc538",

            "TemplateName": "test"
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        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-09-02T10:25:39+0800",

        "State": "Success",

        "Tag": "SpeechRecognition",

        "Workflow": {

            "Name": "SpeechRecognition_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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创建模版
最近更新时间：2023-06-02 17:34:00

创建语音识别模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>

        <ChannelNum>2</ChannelNum>

        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1226 共1701页

具体数据描述如下：

Container 类型 Request 的具体数据描述如下：

C  

        <SpeakerDiarization>1</SpeakerDiarization>

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

    </SpeechRecognition>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关键

字）
父节点 描述 类型

是否

必选

限

制

Tag
Requ

est
模板类型：SpeechRecognition String 是 无

Name
Requ

est

模板名称 仅支持中文、英文、数字、

_、-和*
String 是 无

SpeechRecogn

ition

Requ

est
语音识别参数

Contai

ner
是 无

ontainer 类型 SpeechRecognition 的具体数据描述如下：

节点名称（关

键字）
父节点 描述 类型

是
否

必

选

EngineMod
elType

Request.S
peech

Recognitio

n

引擎模型类型，分为电话场景和非电话场景。
电话场景：

 非电话场景：

8k_zh：电话 8k 中文普通话通用（可用于双

声道音频）； 

8k_zh_s：电话 8k 中文普通话话者分离（仅
适用于单声道音频）；

8k_en：电话 8k 英语；

16k_zh：16k 中文普通话通用；

16k_zh_video：16k 音视频领域；

Strin
g

是
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16k_en：16k 英语；

16k_ca：16k 粤语；

16k_ja：16k 日语；

16k_zh_edu：中文教育；

16k_en_edu：英文教育；

16k_zh_medical：医疗；

16k_th：泰语；

16k_zh_dialect：多方言，支持23种方言。

极速ASR支持8k_zh、16k_zh、16k_en、

16k_zh_video、16k_zh_dialect、
16k_ms（马来语）、16k_zh-PY（中英

粤）

ChannelNu

m

Request.S

peech 

Recognitio

n

仅支持非极速ASR
语音声道数：

1 表示单声道.EngineModelType为非电话场

景仅支持单声道；

2 表示双声道（仅支持 8k_zh 引擎模型 双声道
应分别对应通话双方）。

Integ

er
是

ResTextFor

mat

Request.S

peech 

Recognitio
n

仅支持非极速ASR

识别结果返回形式：

0 表示识别结果文本（含分段时间戳）；

1 词级别粒度的详细识别结果,不含标点，含语速

值.（词时间戳列表，一般用于生成字幕场景）

2 词级别粒度的详细识别结果（包含标点、语速
值）。

3 标点符号分段，包含每段时间戳，特别适用于

字幕场景（包含词级时间、标点、语速值）。

Integ

er
否

FilterDirty

Request.S

peech 

Recognitio
n

是否过滤脏词（目前支持中文普通话引擎）：

0 表示不过滤脏词；

1 表示过滤脏词；

2 表示将脏词替换为 * 。

默认值为 0。

Integ

er
否

FilterModal

Request.S
peech 

Recognitio

n

是否过语气词（目前支持中文普通话引擎）：
0 表示不过滤语气词；

1 表示部分过滤；

2 表示严格过滤 。

默认值为 0。

Integ

er
否
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ConvertNu

mMode

Request.S

peech 

Recognitio
n

是否进行阿拉伯数字智能转换（目前支持中文普通

话引擎）：

0 表示不转换，直接输出中文数字；

1 表示根据场景智能转换为阿拉伯数字。

3 表示打开数学相关数字转换。仅非极速ASR

支持

默认值为 0。

Integ

er

否

SpeakerDia

rization

Request.S
peech 

Recognitio

n

是否开启说话人分离：

0 表示不开启；

1 表示开启(仅支持8k_zh，16k_zh，
16k_zh_video，单声道音频)。

默认值为 0。

注意：8k电话场景建议使用双声道来区分通话

双方，设置ChannelNum=2即可，不用开启
说话人分离。

Integ

er
否

SpeakerNu
mber

Request.S

peech 
Recognitio

n

仅支持非极速ASR

说话人分离人数（需配合开启说话人分离使
用），取值范围：0-10。

0代表自动分离（目前仅支持≤6个人），1-10

代表指定说话人数分离。默认值为 0。

Integ
er

否

FilterPunc

Request.S

peech 

Recognitio

n

是否过滤标点符号（目前支持中文普通话引擎）：

0 表示不过滤。

1 表示过滤句末标点。

2 表示过滤所有标点。

默认值为 0。

Integ

er
否

OutputFileT
ype

Request.S

peech 
Recognitio

n

输出文件类型，可选txt、srt。默认为txt

极速ASR仅支持txt

非极速Asr时，ResTextFormat为3时仅支持

txt

Strin
g

否

FlashAsr

Request.S
peech 

Recognitio

n

是否开启极速ASR，可选true、false。默认为

false

Strin

g
否

Format Request.S
peech 

Recognitio

n

极速ASR音频格式。支持 wav、pcm、ogg-
opus、speex、silk、mp3、m4a、aac。

Strin
g

当
Fl

a

s
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

h

A

sr

为
tr

u

e

时

必
选

FirstChann
elOnly

Request.S

peech 
Recognitio

n

极速ASR参数。表示是否只识别首个声道，默认为
1。0：识别所有声道；1：识别首个声道。

Integ
er

否

WordInfo

Request.S
peech 

Recognitio

n

极速ASR参数。表示是否显示词级别时间戳，默认
为0。0：不显示；1：显示，不包含标点时间戳，

2：显示，包含标点时间戳。

Integ

er
否

SentenceM

axLength

Request.S
peech 

Recognitio

n

单标点最多字数，取值范围：[6，40]。默认为不
开启该功能。该参数可用于字幕生成场景，控制单

行字幕最大字数，当为FlashAsr为false时，仅

ResTextFormat为3时参数有效

Integ

er
否

响应

响应头

响应体

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <Template>

        <Tag>SpeechRecognition</Tag>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>SpeechRecognition</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 Template 的内容：

        <Category>Custom</Category>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ChannelNum>2</ChannelNum>

            <ResTextFormat>1</ResTextFormat>

            <FilterDirty>0</FilterDirty>

            <FilterModal>1</FilterModal>

            <ConvertNumMode>0</ConvertNumMode>

            <SpeakerDiarization>1</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <OutputFileType>txt</OutputFileType>

            <SentenceMaxLength>0</SentenceMaxLength>

        </SpeechRecognition>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

 Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

 Template Response 保存模板详情的容器 Container

RequestId Response 请求的唯一 ID String

节点名称（关键字） 父节点 描述 类型

TemplateId
Response.Templ

ate
模板 ID String

Name
Response.Templ
ate

模板名称 String

BucketId
Response.Templ

ate
模板所属存储桶 String

Category
Response.Templ

ate
模板属性，Custom 或者 Official String
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Tag Response.Templ
ate

模板类型，SpeechRecognition String

UpdateTime
Response.Templ

ate
更新时间 String

CreateTime
Response.Templ

ate
创建时间 String

SpeechRecogni

tion

Response.Templ

ate

同请求体中的 

Request.SpeechRecognition

Contain

er

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>

        <ChannelNum>1</ChannelNum>

        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

        <SpeakerDiarization>1</SpeakerDiarization>

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

        <SentenceMaxLength>0</SentenceMaxLength>

    </SpeechRecognition>

</Request>

响应

https://cloud.tencent.com/document/product/460/42867
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>SpeechRecognition</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <ResTextFormat>0</ResTextFormat>

            <FilterDirty>1</FilterDirty>

            <FilterModal>0</FilterModal>

            <ConvertNumMode>1</ConvertNumMode>

            <SpeakerDiarization>0</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <SentenceMaxLength>0</SentenceMaxLength>

        </SpeechRecognition>

    </Template>

</Response>
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更新模板
最近更新时间：2023-02-16 14:33:06

更新语音识别模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>

        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

        <SpeakerDiarization>1</SpeakerDiarization>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

    </SpeechRecognition>

</Request>

节点名称

（关键

字）

父

节

点

描述 类型
是否

必选

Reques
t

无 同创建语音识别模板接口的 Request  Container 是

响应

响应头

响应体

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>SpeechRecognition</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <ResTextFormat>0</ResTextFormat>

            <FilterDirty>1</FilterDirty>

            <FilterModal>0</FilterModal>

            <ConvertNumMode>1</ConvertNumMode>

            <SpeakerDiarization>0</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84498#Request
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具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

        </SpeechRecognition>

    </Template>

</Response>

节点名称

（关键

字）

父

节

点

描述 类型

Respon

se
无 同创建语音合成模板接口的 Response  

Cont

ainer

错误码

实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>

        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

        <SpeakerDiarization>1</SpeakerDiarization>

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

    </SpeechRecognition>

</Request>

响应

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84498#Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>SpeechRecognition</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <ResTextFormat>0</ResTextFormat>

            <FilterDirty>1</FilterDirty>

            <FilterModal>0</FilterModal>

            <ConvertNumMode>1</ConvertNumMode>

            <SpeakerDiarization>0</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

        </SpeechRecognition>

    </Template>

</Response>
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内容审核接口
图片审核

图片单次审核
最近更新时间：2023-07-07 17:12:12

图片审核功能支持同步、异步请求方式，您可以通过本接口对图片文件进行内容审核。该接口属于 GET 请求。

该接口支持情况如下：

功能描述

注意

支持审核腾讯云 COS 上的图片文件。

支持审核第三方云存储厂商的图片 URL。

支持审核本地图片文件，需要先进行 base64编码。审核本地图片文件请调用 图片批量审核接口 。

支持对 COS 上的图片文件或链接进行检测，通过深度学习技术，识别可能令人反感、不安全或不适宜的违规图

片内容。

支持对 GIF 图进行截帧审核。

支持识别多种违规场景，包括：低俗、违法违规、色情、广告等场景。

支持多种物体检测（实体、广告台标、二维码等）及图片中文本的 OCR 文本识别。

根据不同的业务场景 配置自定义的审核策略 。支持

支持用户通过配置自定义风险库，打击自定义的违规内容。

费用说明

每个审核场景单独计费，例如您选择审核涉黄、广告两种场景，则审核1张图片，计2次审核费用。

调用接口会产生 图片审核费用  和 COS 读请求费用 。

如果图片为 COS 上的低频存储类型，调用审核会产生 COS 低频数据取回费用 。

不支持审核 COS 上的归档存储类型和深度归档存储类型的文件，如果需要审核此类型文件，请先 恢复归档文

件 。

审核第三方云存储厂商的图片 URL 时，将产生所在云厂商的下行流量费用。

限制说明

图片文件大小支持：支持审核32MB以下的图片。对于大小超过5MB的图片，您需要在调用请求时，使用 

large-image-detect 参数。

https://cloud.tencent.com/document/product/436/63593
https://cloud.tencent.com/document/product/436/55206
https://cloud.tencent.com/document/product/436/58965#.E5.9B.BE.E7.89.87.E5.AE.A1.E6.A0.B8.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1238 共1701页

对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

具体参数如下：

图片文件分辨率支持：建议分辨率大于256x256，否则可能会影响识别效果。

图片文件支持格式：PNG、JPG、JPEG、BMP、GIF、WEBP 格式。

图片文件链接支持的传输协议：HTTP、HTTPS。

调用接口需携带签名，具体规则请参见 请求签名  文档。

推荐使用 SDK

请求

请求示例

GET /<ObjectKey>?ci-process=sensitive-content-recognition&detect-url=<detect-url>&in

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求参数

参

数

名

称

描述
类

型

是

否

必

选

O

bj

ec

tK
ey

COS 存储桶中的图片文件名称，COS 存储桶由 Host  指定，例如在北京的 

examplebucket-1250000000存储桶中的目录 test 下的文件 img.jpg，则 

Host  填写 examplebucket-1250000000.cos.ap-

beijing.myqcloud.com， ObjectKey  填写 test/img.jpg。

S

tr

in
g

否

ci 标识数据处理功能的字段，内容审核的值为：sensitive-content-recognition。 S 是

https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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-

pr

oc

es

s

tr

in

g

biz

-

ty
pe

表示审核策略的唯一标识，您可以通过控制台上的审核策略页面，配置您希望审核的

场景，如涉黄、广告、违法违规等，配置指引： 设置公共审核策略 。您可以在控制台

上获取到 biz-type。biz-type 填写时，此条审核请求将按照该审核策略中配置的场
景进行审核。biz-type 不填写时，将自动使用默认的审核策略。

S

tr

in
g

否

de

te

ct
-

url

您可以通过填写 detect-url  审核任意公网可访问的图片链接不填写 detect-url  

时，后台会默认审核 ObjectKey  填写了 detect-url  时，后台会审核 detect-url  

链接，无需再填写 ObjectKey ， detect-url  示例：

http://www.example.com/abc.jpg 。

S

tr
in

g

否

int
er

val

审核 GIF 动图时，可使用该参数进行截帧配置，代表截帧的间隔。例如值设为5，则
表示从第1帧开始截取，每隔5帧截取一帧，默认值5。

I
n

t

否

m
ax

-

fra

m

es

针对 GIF 动图审核的最大截帧数量，需大于0。例如值设为5，则表示最大截取5帧，

默认值为5。

I

n

t

否

lar

ge

-
im

ag

e-

de
te

ct

对于超过大小限制的图片是否进行压缩后再审核，取值为： 0（不压缩），1（压

缩）。默认为0。注：压缩最大支持32MB的图片，且会收取图片压缩费用。对于 

GIF 等动态图过大时，压缩时间较长，可能会导致审核超时失败。

I

n

t

否

da
tai

d

图片标识，该字段在结果中返回原始内容，长度限制为512字节。

S

tr
in

g

否

as
yn

c

是否异步进行审核，取值 0：同步返回结果，1：异步进行审核，默认为0。
I
n

t

否

https://cloud.tencent.com/document/product/460/56345
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该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

ca
llb

ac

k

审核结果（Detail版本）以回调形式发送至您的回调地址，异步审核时生效，支持以 

http://  或者 https://  开头的地址，例如： http://www.callback.com 。

S
tr

in

g

否

注意

通过 ObjectKey 进行审核为内网操作，不会产生额外的外网流量。

通过 detect-url 进行审核，会产生图片所在源站对应的外网流量。

请求体

响应

响应头

响应体

<RecognitionResult>

      <JobId>xxxxxxxxxxxxxxx</JobId>

      <Result>1</Result>

      <Label>Porn</Label>

      <SubLabel>SexBehavior</SubLabel>

      <Score>90</Score>

      <PornInfo>

          <Code>0</Code>

          <Msg>OK</Msg>

          <HitFlag>1</HitFlag>

          <Label>xxx</Label>

          <SubLabel>SexBehavior</SubLabel>

          <Score>100</Score>

          <OcrResults>

            <Text></Text>

            <Keywords></Keywords>

            <Location>

              <X></X>

              <Y></Y>

              <Width></Width>

              <Height></Height>

              <Rotate></Rotate>

            </Location>

https://cloud.tencent.com/document/product/460/42866


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1241 共1701页

响应包体具体数据内容如下：

异步审核返回的RecognitionResult 节点内容：

同步审核返回的RecognitionResult 节点内容：

          </OcrResults>

      </PornInfo>

</RecognitionResult>

参数名称 类型 描述

RecognitionResult Container 图片审核结果。

参数名称 类型 描述

DataId String 图片标识，审核结果会返回原始内容，长度限制为512字节。

JobId String 图片审核任务的 ID。

State String 审核任务的状态，值为Submitted（已提交审核）。

Object String 存储在 COS 桶中的图片名称，创建任务使用 ObjectKey 时返回。

Url String 图片文件的链接地址，创建任务使用 detect-url 时返回。

参数

名称

类

型
描述

Data

Id

S

tr

in

g

图片标识，审核结果会返回原始内容，长度限制为512字节。

JobI

d

S

tr

in
g

图片审核任务的 ID。

Stat
e

S

tr
in

g

审核任务的状态，值为 Success（审核成功）。

Obje

ct

S

tr

存储在 COS 桶中的图片名称，创建任务使用 ObjectKey 时返回。
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in

g

Url

S

tr

in

g

图片文件的链接地址，创建任务使用 detect-url 时返回。

Com

pres

sion

Res
ult

I

n

t

图片是否被压缩处理，值为 0（未压缩），1（正常压缩）。

Res

ult

I

n
t

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业务所

需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规敏感文
件），2（疑似敏感，建议人工复核）。

Lab

el

S

tr

in
g

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结果，建

议您按照业务所需，对不同违规类型与建议值进行处理。返回值：Normal 表示正常，
Porn 表示色情，Ads 表示广告，以及其他不安全或不适宜的类型。

Cate
gory

S

tr
in

g

该字段为 Label  的子集，表示审核命中的具体审核类别。例如 Sexy，表示色情标签中的

性感类别。

Sub
Lab

el

S

tr
in

g

该图命中的二级标签结果。

Scor
e

I
n

t

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度
最高 ），越高代表该内容越有可能属于当前返回审核信息例如：色情 99，则表明该内容非

常有可能属于色情内容。

Text

S

tr
in

g

该图里的文字内容（OCR），当审核策略开启文本内容检测时返回。

Porn
Info

C
o

n

t

ai

审核场景为涉黄的审核结果信息。
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审核信息（PornInfo、AdsInfo）中包含如下内容：

n

e

r

AdsI
nfo

C

o

n

t
ai

n

e

r

审核场景为广告引导的审核结果信息。

参

数
名

称

类
型

描述

C
o

d

e

In

t
错误码，0为正确，其他数字对应相应错误。详情请参见 错误码 。

M

s

g

St
ri

n

g

具体错误信息，如正常则为 OK。

H

it

Fl

a
g

In

t

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内容。2：疑

似为当前场景的违规内容。

S

c

o
r

e

In
t

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度最

高），越高代表该内容越有可能属于当前返回审核信息。其中0 - 60分表示图片正常，61 - 
90分表示图片疑似敏感，91 - 100分表示图片确定敏感。例如：色情 99，表明该内容非常有

可能属于色情内容。

L
a

b

el

St
ri

n

g

该字段表示该截图的综合结果标签（可能为 SubLabel，可能为人物名字等）。

https://cloud.tencent.com/document/product/460/8523#.E5.86.85.E5.AE.B9.E5.AE.A1.E6.A0.B8.E9.94.99.E8.AF.AF.E7.A0.81
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Container 节点 LibResults 的内容：

C
a

t

e

g
o

r

y

St
ri

n

g

该字段为 Label  的子集，表示审核命中的具体审核类别。例如 Sexy，表示色情标签中的性

感类别。

S

u

b

L

a
b

el

St

ri

n
g

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标签。注意：该字段

可能返回空，表示未命中具体的子标签。

O
c

r

R

e
s

ul

t

s

C
o

nt

ai

n
er 

A

rr

a

y

该字段表示 OCR 文本识别的详细检测结果，包括文本识别结果、命中的关键词等信息，有相
关违规内容时返回。

Li

b
R

e

s

ul
t

s

C

o

nt
ai

n

er 

A
rr

a

y

该字段用于返回基于风险库识别的结果。注意：未命中风险库中样本时，此字段不返回。

参

数

名
称

类

型
描述
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Container 节点 OcrResults 的内容：

Container 节点 Location 的内容：

I

m
a

g

eI

d

S

tr
in

g

该字段表示命中的风险库中的图片样本 ID。

S

c
o

r

e

I

n

t
e

g

e

r

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100（置信度最高 ），越
高代表当前的图片越有可能命中库中的样本。例如：色情 99，表明该数据非常有可能命中库中

的色情样本。

参数名

称
类型 描述

Text String 图片 OCR 文本识别出的具体文本内容。

Key
word

s

String 
Array

在当前审核场景下命中的关键词。

Loca

tion

Contai

ner

该参数用于返回 OCR 检测框在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位识别文字的相关信息。

名
称

类
型

描述

X

Fl

o
a

t

该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯一确定
检测框的大小和位置。

Y

Fl

o
a

t

该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯一确定
检测框的大小和位置。

Wi
dt

Fl
o

该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参数可唯一
确定检测框的大小和位置。
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Container 节点 ObjectResults 的内容：

h a

t

H

ei

gh

t

Fl

o

a

t

该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参数可唯一

确定检测框的大小和位置。

R

ot

at
e

Fl

o

a
t

该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测框的具

体位置；取值：0-360（角度制），方向为逆时针旋转。

名称 类型 描述

Nam

e
String 该标签用于返回所识别出的实体名称，例如人名。

Locat

ion

Contai

ner

该参数用于返回检测结果在图片中的位置（左上角 xy 坐标、长宽、旋转角度），以

方便快速定位相关信息。

实际案例

请求1：同步图片审核

GET /picture.jpg?ci-process=sensitive-content-recognition&interval=0&max-frames=1&b

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2019 09:06:15 GMT

Authorization:XXXXXXXXXXXX

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<RecognitionResult>

      <JobId>xxxxxxxxxxxxxxx</JobId>

      <CompressionResult>0</CompressionResult>

      <Result>1</Result>
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      <Label>Porn</Label>

      <SubLabel>SexBehavior</SubLabel>

      <Score>95</Score>

      <PornInfo>

          <Code>0</Code>

          <Msg>OK</Msg>

          <HitFlag>1</HitFlag>

          <Label>xxx</Label>

          <SubLabel>SexBehavior</SubLabel>

          <Score>95</Score>

      </PornInfo>

</RecognitionResult>

请求2：异步图片审核

GET /picture.jpg?ci-process=sensitive-content-recognition&biz-type=***&async=1&callba

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2019 09:06:15 GMT

Authorization:XXXXXXXXXXXX

响应2

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<RecognitionResult>

      <JobId>xxxxxxxxxxxxxxx</JobId>

</RecognitionResult>
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图片批量审核
最近更新时间：2023-03-13 14:17:50

图片批量审核接口支持同步、异步请求方式，您可以通过本接口对多个图片文件进行内容审核。该接口属于 POST 

请求。

根据不同的业务场景 配置自定义的审核策略 。

对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

功能描述

说明

支持审核腾讯云 COS 上的图片文件。

支持审核第三方云存储厂商的图片 URL。

支持审核加密数据，如有需要，请 联系服务人员  咨询。

支持

限制说明

图片文件大小支持：支持审核32MB以下的图片。对于大小超过5MB的图片，您需要在调用请求时，使用 

large-image-detect 参数。

单次请求图片数量不可超过100张。

图片文件分辨率支持：建议分辨率大于256x256，否则可能会影响识别效果。

图片文件支持格式：PNG、JPG/JPEG、BMP、GIF、WEBP、HEIF/HEIC 格式。

图片文件链接支持的传输协议：HTTP、HTTPS。

调用接口需携带签名，具体规则请参见 请求签名  文档。

推荐使用 SDK

请求

请求示例

POST /image/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

https://cloud.tencent.com/document/product/460/56345
https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/online-service?from=ticket-tab
https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Input>

      <DataId></DataId>

      <Url></Url>

      <Object></Object>

      <Content></Content>

      <Interval></Interval>

      <MaxFrames></MaxFrames>

      <LargeImageDetect></LargeImageDetect>

      <UserInfo>

        <TokenId></TokenId>

      </UserInfo>

    </Input>

    <Input>

      <DataId></DataId>

      <Url></Url>

      <Object></Object>

      <Content></Content>

      <Interval></Interval>

      <MaxFrames></MaxFrames>

    </Input>

    <Conf>

      <BizType>b81d45f94b91a683255e9a9506f45a11</BizType>

      <Async></Async>

      <Callback></Callback>

      <Freeze>

        <PornScore></PornScore>

      </Freeze>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下，使用其中一种：

    </Conf>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 图片批量审核的具体配置项。 Container 是

节点名称（关

键字）
父节点 描述 类型

是否

必选

Input
Requ

est

需要审核的内容，如有多个图片，请传入多个 

Input 结构。

Container 

Array
是

Conf
Requ

est
审核规则配置。 Container 是

节点
名称

（关

键

字）

父

节

点

描述
类

型

是

否

必

选

Obje

ct

Re

qu

est
.In

put

存储在 COS 存储桶中的图片文件名称，例如在目录 test 中的文件 

image.jpg，则文件名称为 test/image.jpg。Content，Object 和 

Url 只能选择其中一种，传入多个时仅一个生效，按 Content，
Object， Url 顺序。

Str

ing
否

Url

Re

qu
est

.In

put

图片文件的链接地址，例如 http://a-1250000.cos.ap-
shanghai.myqcloud.com/image.jpg。Content，Object 和 

Url 只能选择其中一种，传入多个时仅一个生效，按 Content，

Object， Url 顺序。

Str

ing
否

Cont

ent

Re

qu

est

.In

put

图片文件的内容，需要先经过 base64 编码。Content，Object 和 

Url 只能选择其中一种，传入多个时仅一个生效，按 Content，

Object， Url 顺序。

Str

ing
否
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Container 节点 UserInfo 的内容：

Inter

val

Re

qu

est
.In

put

截帧频率，GIF 图检测专用，默认值为5，表示从第一帧（包含）开始

每隔5帧截取一帧。

Int 否

Max

Fram

es

Re
qu

est

.In

put

最大截帧数量，GIF 图检测专用，默认值为5，表示只截取 GIF 的5帧

图片进行审核，必须大于0。
Int 否

DataI

d

Re

qu

est

.In
put

图片标识，该字段在结果中返回原始内容，长度限制为512字节。
Str

ing
否

Larg

eIma
geDe

tect

Re

qu
est

.In

put

对于超过大小限制的图片是否进行压缩后再审核，取值为： 0（不压
缩），1（压缩）。默认为0。注：压缩最大支持32M的图片，且会收取

压缩费用。

Int 否

UserI

nfo

Re
qu

est

.In

put

用户业务字段。

Co

nta

ine

r

否

节点名称（关键
字）

描述 类型
是否必
选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin

g
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin
g

否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否
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Container 类型 Conf 的具体数据描述如下：

Room 一般用于表示房间号信息，长度不超过128字节。 Strin

g

否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin
g

否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否

ReceiveTokenI

d

一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin
g

否

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节

点

名
称

（

关

键
字

）

父

节

点

描述
类

型

是

否

必

选

B

iz

T
y

p

e

R
e

q

u

e

s
t.

C

o

n
f

表示审核策略的唯一标识，您可以通过控制台上的审核策略页面，配置您希望审

核的场景，如涉黄、广告、违法违规等，配置指引： 设置公共审核策略 。您可

以在控制台上获取到 BizType。BizType 填写时，此条审核请求将按照该审
核策略中配置的场景进行审核。BizType 不填写时，将自动使用默认的审核策

略。

S

tr
in

g

否

A

s

R

e

是否异步进行审核，0：同步返回结果，1：异步进行审核。默认值为 0。 I

n

否
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Container 类型 Freeze 的具体数据描述如下：

y

n

c

q

u

e

s
t.

C

o

n

f

t

e

g

e
r

C
al

lb

a

c
k

R

e

q
u

e

s

t.
C

o

n

f

审核结果（Detail版本）以回调形式发送至您的回调地址，异步审核时生效，支

持以 http://  或者 https://  开头的地址，例如：

http://www.callback.com 。

S

tr

in

g

否

F

r
e

e

z

e

R

e

q

u
e

s

t.

C
o

n

f

可通过该字段，设置根据审核结果给出的不同分值，对图片进行自动冻结，仅当 

input  中审核的图片为 object  时有效。

C

o

n
t

ai

n

e
r

否

节点名

称（关
键字）

父节点 描述
类

型

是

否

必
选

PornS

core

Request.

Conf.Fre
eze

取值为[0,100]，表示当色情审核结果大于或等于该分数时，自

动进行冻结操作。不填写则表示不自动冻结，默认值为空。

I

n
t

e

g

否
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其他审核场景的冻结参数，请 联系服务人员 咨询。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

e
r

AdsSc

ore

Request.

Conf.Fre

eze

取值为[0,100]，表示当广告审核结果大于或等于该分数时，自

动进行冻结操作。不填写则表示不自动冻结，默认值为空。

I

n
t

e

g

e

r

否

注意

通过 Object 进行审核为内网操作，不会产生额外的外网流量。

通过 Url 进行审核，会产生图片所在源站对应的外网流量。

响应

响应头

响应体

<Response>

  <JobsDetail>

    <DataId></DataId>

    <Url></Url>

    <PornInfo>

      <HitFlag>1</HitFlag>

      <Score>100</Score>

      <Category>xxx</Category>

      <SubLabel>xxx</SubLabel>

    </PornInfo>

  </JobsDetail>

  <JobsDetail>

    <Code>InvalidArgument</Code>

    <Message>Param MaxFrames is illegal</Message>

    <DataId></DataId>

  </JobsDetail>

</Response>

https://cloud.tencent.com/online-service?from=ticket-tab
https://cloud.tencent.com/document/product/460/42866
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响应包体具体数据内容如下：

Container 节点 Response 的内容：

异步审核结果的 JobsDetail 节点内容如下：

同步审核结果的 JobsDetail 节点内容如下：

节点名称（关键字） 父节点 描述

Response Container 图片批量审核返回的具体响应内容。

参数名称 类型 描述

JobsD
etail

Container 
Array

图片审核的结果

Reque

stId
String

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题时，该 ID 

能更快地协助定位问题。

节点名称（关键
字）

类型 描述

Code
Stri

ng
错误码，只有失败时返回。详情请查看 错误码列表 。

Message
Stri

ng
错误描述，只有失败时返回。

DataId
Stri
ng

图片标识，审核结果会返回原始内容，长度限制为512字节。

JobId
Stri

ng
本次审核任务的 ID。

State
Stri

ng

审核任务的状态，值为 Submitted（已提交审核）、Failed（审核失败）

其中一个。

Object
Stri
ng

存储在 COS 存储桶中的图片文件名称，创建任务使用 Object 时返回。

Url
Stri

ng
图片文件的链接地址，创建任务使用Url时返回。

参数名

称

类

型
描述

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Code S

tr

in
g

错误码，只有失败时返回。详情请查看 错误码列表 。

Mess
age

S

tr
in

g

错误描述，只有失败时返回。

DataI
d

S

tr
in

g

图片标识，审核结果会返回原始内容，长度限制为512字节。

JobId

S
tr

in

g

本次审核任务的 ID。

State

S
tr

in

g

审核任务的状态，值为 Success（审核成功）、Failed（审核失败）其中一个。

Objec

t

S

tr

in

g

存储在 COS 存储桶中的图片文件名称，创建任务使用Object时返回。

Url

S

tr

in

g

图片文件的链接地址，创建任务使用Url时返回。

Com

press
ionRe

sult

I

n

t
e

g

e

r

图片是否被压缩处理，值为 0（未压缩），1（正常压缩）。

Label

S

tr

in

g

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结果，

建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：Normal：正常，

Porn：色情，Ads：广告等。

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Resul
t

I

n

t
e

g

e

r

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业务
所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规敏感文

件），2（疑似敏感，建议人工复核）。

Scor
e

I

n

t

e
g

e

r

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度

最高 ），越高代表该内容越有可能属于当前返回审核信息。例如：色情 99，表明该内容
非常有可能属于色情内容。

Cate

gory

S

tr

in

g

该图命中的审核类别结果。

SubL

abel

S

tr

in

g

该图命中的二级标签结果。

Text

S

tr

in

g

该图里的文字内容（OCR），当审核策略开启文本内容检测时返回。

PornI

nfo

C

o

n
t

ai

n

e
r

审核场景为涉黄的审核结果信息。

AdsIn

fo

C

o

n
t

ai

n

审核场景为广告引导的审核结果信息。
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审核信息（PornInfo、AdsInfo等）中的内容如下：

e

r

UserI

nfo

C

o
n

t

ai

n
e

r

请求中设置的 UserInfo 原样返回。

ListIn

fo

C
o

n

t

ai

n
e

r

账号黑白名单结果。

Forbi

dStat

e

I
n

t

e

g
e

r

若您在请求时设置了自动冻结，该字段表示图片的冻结状态。0：未冻结，1：已被冻结。

参

数

名

称

类型 描述

C

od

e

Inte

ger
单个审核场景的错误码，0为成功，其他为失败。详情请参见 错误码 。

M

sg

Stri

ng
具体错误信息，如正常则为 OK。

Hi
tFl

ag

Inte

ger

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内容。

2：疑似为当前场景的违规内容。

https://cloud.tencent.com/document/product/460/8523#.E5.86.85.E5.AE.B9.E5.AE.A1.E6.A0.B8.E9.94.99.E8.AF.AF.E7.A0.81
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Container 节点 LibResults 的内容：

Sc
or

e

Inte
ger

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度
最高 ），越高代表该内容越有可能属于当前返回审核信息例如：色情 99，则表明该内容

非常有可能属于色情内容。

La

be
l

Stri
ng

该图的结果标签（为综合标签，可能为 SubLabel，可能为人物名字等）。

C

at
eg

or

y

Stri
ng

该字段为 Label  的子集，表示审核命中的具体审核类别。例如 Sexy，表示色情标签中

的性感类别。

Su
bL

ab

el

Stri

ng
该图的二级标签结果。

O

cr

Re

su
lts

Con

tain

er 

Arra
y

该字段表示 OCR 文本识别的详细检测结果，包括文本坐标信息、文本识别结果等信息，

有相关违规内容时返回。

Li

bR

es
ult

s

Con

tain

er 
Arra

y

该字段用于返回基于风险库识别的结果。注意：未命中风险库中样本时，此字段不返回。

节点

名称

（关
键

字）

类

型
描述

Imag

eId

S
tr

in

g

该字段表示命中的风险库中的图片样本 ID。

Scor
e

I
n

t

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100（置信度最高 
），越高代表当前的图片越有可能命中库中的样本。例如：色情 99，则表明该数据非常有

可能命中库中的色情样本。
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OcrResults 的内容如下：

ObjectResults 的内容如下：

Location 的内容如下：

UserInfo 的内容（与请求中的UserInfo一致）：

e

g
e

r

节点名称（关键字） 类型 描述

Text String 有敏感信息的 Ocr 文本内容。

Keywords String Array 该段内容中的敏感文字。

Location Container 该段文字在图片中的位置信息。

节点名称（关键字） 类型 描述

Name String 敏感内容的字称。

Location Container 该内容在图片中的位置信息。

节点名称（关键字） 类型 描述

X Float 相对于原点（图片左上角）的 X 坐标。

Y Float 相对于原点（图片左上角）的 Y 坐标。

Height Float 敏感区域的高度。

Width Float 敏感区域的宽度。

Rotate Float 敏感区域的旋转角度。

节点名称（关键

字）
描述 类型

是否必

选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin

g
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin
g

否



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1261 共1701页

Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

DeviceId 一般用于表示设备信息，长度不超过128字节。 Strin

g

否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin
g

否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin

g
否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否

ReceiveTokenI
d

一般用于表示接收消息的用户账号，长度不超过128字
节。

Strin
g

否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin

g
否

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节点名称（关键字） 类型 描述

ListResults Container Array 命中的所有名单结果。

节点名称（关键字） 类型 描述

ListType Integer 命中的名单类型，取值为0（白名单）和1（黑名单）。

ListName String 命中的名单名称。

Entity String 命中了名单中的哪条内容。

实际案例

请求
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POST /image/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-s

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

  <Input>

    <Object>a.jpg</Object>

  </Input>

  <Input>

    <Url>http://exsample.com/b.jpg</Url>

  </Input>

  <Conf>

    <BizType>b81d45f94xxxxxxxxa9506f45a11</BizType>

  </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<Response>

    <JobsDetail>

        <JobId>xxxxxxxxxx</JobId>

        <CompressionResult>0</CompressionResult>

        <Object>a.jpg</Object>

        <Label>Porn</Label>

        <Result>1</Result>

        <Score>100</Score>

        <SubLabel>xxx</SubLabel>

        <PornInfo>

            <Code>0</Code>

            <Msg>OK</Msg>

            <HitFlag>1</HitFlag>

            <Score>100</Score>

            <Label>xxx</Label>

            <SubLabel>xxx</SubLabel>

        </PornInfo>
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    </JobsDetail>

    <JobsDetail>

        <JobId>yyyyyyyyyy</JobId>

        <CompressionResult>0</CompressionResult>

        <Url>http://exsample.com/b.jpg</Url>

        <Label>Porn</Label>

        <Result>1</Result>

        <Score>100</Score>

        <SubLabel>xxx</SubLabel>

        <PornInfo>

            <Code>0</Code>

            <Msg>OK</Msg>

            <HitFlag>1</HitFlag>

            <Score>100</Score>

            <Label>xxx</Label>

            <SubLabel>xxx</SubLabel>

        </PornInfo>

    </JobsDetail>

    <RequestId>xxxxxxxxxxx</RequestId>

</Response>
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查询图片审核任务结果
最近更新时间：2023-05-06 18:03:17

本接口用于主动查询指定的图片审核任务结果。

数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能描述

说明

 图片审核任务结果保存时效为1个月，您可通过本接口查询近1个月的审核结果。

推荐使用 SDK

请求

请求示例

GET /image/auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称 描述 类型 是否必选

jobId 要查询的任务ID，可通过提交审核任务的响应中获取。 String 是

https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应

响应头

响应体

<Response>

  <JobsDetail>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <Object></Object>

    <Label></Label>

    <Result>1</Result>

    <PornInfo>

        <HitFlag>1</HitFlag>

        <Label>xxx</Label>

        <SubLabel>SexBehavior</SubLabel>

        <Score>100</Score>

        <OcrResults>

            <Text></Text>

            <Keywords></Keywords>

            <Location>

                <X></X>

                <Y></Y>

                <Width></Width>

                <Height></Height>

                <Rotate></Rotate>

            </Location>

        </OcrResults>

    </PornInfo>

    <AdsInfo>

        <HitFlag>1</HitFlag>

        <Label>xxx</Label>

        <SubLabel>SexBehavior</SubLabel>

        <Score>100</Score>

        <OcrResults>

            <Text></Text>

            <Keywords></Keywords>

            <Location>

                <X></X>

                <Y></Y>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

                <Width></Width>

                <Height></Height>

                <Rotate></Rotate>

            </Location>

        </OcrResults>

    </AdsInfo>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

参数名称 类型 描述

Response Container 审核任务结果。

参数名称 类型 描述

JobsDe

tail

Contai

ner
任务的详细信息。

Reques
tId

String
每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题时，该 ID 能更
快地协助定位问题。

参数名
称

类
型

描述

Code

S

tr
in

g

错误码，只有 State 为 Failed 时返回。详情请参见 错误码列表 。

Mess

age

S
tr

in

g

错误描述，只有 State 为 Failed 时返回。

DataI

d

S
tr

in

g

提交任务时设置了 DataId 参数时返回，返回原始内容，长度限制为512字节。您可以使

用该字段对待审核的数据进行唯一业务标识。

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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JobId S

tr

in

g

本次审核任务的 ID

State

S

tr

in

g

审核任务的状态，值为 Submitted（已提交审核）、Success（审核成功）、Failed

（审核失败）、Auditing（审核中）其中一个。

Creat

ionTi
me

S

tr

in
g

审核任务的创建时间。

Objec
t

S

tr
in

g

本次审核的文件名称，创建任务使用 Object 时返回。

Url

S

tr
in

g

本次审核的文件链接，创建任务使用 Url 时返回。

Com

press

ionRe

sult

I
n

t

e

g

e
r

图片是否被压缩处理，值为 0（未压缩），1（正常压缩）。

Text

S

tr
in

g

该图里的文字内容（OCR），当审核策略开启文本内容检测时返回。

Label

S
tr

in

g

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结果，
建议您按照业务所需，对不同违规类型与建议值进行处理。返回值：Normal：正常，

Porn：色情，Ads：广告等。

Resul
t

I
n

t

e

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业务
所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规敏感文

件），2（疑似敏感，建议人工复核）。
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g
e

r

Cate

gory

S
tr

in

g

该图命中的审核类别结果。

SubL

abel

S
tr

in

g

该图命中的二级标签结果。

PornI
nfo

C

o

n

t
ai

n

e

r

审核场景为涉黄的审核结果信息。

AdsIn
fo

C

o

n

t
ai

n

e

r

审核场景为广告引导的审核结果信息。

UserI
nfo

C

o

n

t
ai

n

e

r

用户业务字段。创建任务时未设置 UserInfo 则无此字段。

ListIn

fo

C

o

n
t

ai

n

账号黑白名单结果。
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JobsDetail中Container节点PornInfo，AdsInfo的内容：

e

r

Forbi
dStat

e

I

n

t
e

g

e

r

若您在请求时设置了自动冻结，该字段表示图片的冻结状态。0：未冻结，1：已被冻结，
2：已转移文件。

参
数

名

称

类

型
描述

H
it

Fl

a

g

In

te

g

er

用于返回该审核场景的审核结果，返回值：0：正常1：确认为当前场景的违规内容2：疑似为

当前场景的违规内容。

S

c

o

r
e

In

te

g
er

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度最

高），越高代表该内容越有可能属于当前返回审核信息。其中0 - 60分表示图片正常，61 - 

90分表示图片疑似敏感，91 - 100分表示图片确定敏感。例如：色情 99，表明该内容非常有
可能属于色情内容。

L

a
b

el

St

ri
n

g

该字段表示该截图的综合结果标签（可能为 SubLabel，可能为人物名字等）。

C
a

t

e

g

o
r

y

St

ri

n

g

表示命中的具体审核类别。例如 Sexy，表示色情标签中的性感类别。该字段可能为空，表示

未命中或暂无相关的类别。

S
u

St
ri

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标签。
注意：该字段可能返回空，表示未命中具体的子标签。
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Container 节点 LibResults 的内容：

b

L

a
b

el

n

g

O

c

r

R

e
s

ul

t

s

C
o

nt

ai

n
er 

A

rr

a
y

该字段表示 OCR 文本识别的详细检测结果，包括文本识别结果、命中的关键词等信息，有相
关违规内容时返回。

Li

b
R

e

s

ul
t

s

C

o

nt
ai

n

er 

A
rr

a

y

该字段用于返回基于风险库识别的结果。

注意：未命中风险库中样本时，此字段不返回。

参

数
名

称

类
型

描述

I

m
a

g

eI

d

S
tr

in

g

该字段表示命中的风险库中的图片样本 ID。

S

c

o

I

n

t

e

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100（置信度最高 ），越

高代表当前的图片越有可能命中库中的样本。例如：色情 99，表明该数据非常有可能命中库中

的色情样本。
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Container 节点 OcrResults 的内容：

Container 节点 Location 的内容：

Container 节点 ObjectResults 的内容：

r

e

g

e

r

参数名

称
类型 描述

Text String 图片 OCR 文本识别出的具体文本内容。

Key
word

s

String 
Array

在当前审核场景下命中的关键词。

Loca

tion

Contai

ner

该参数用于返回 OCR 检测框在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位识别文字的相关信息。

名
称

类
型

描述

X

Fl

o
at

该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯一确定

检测框的大小和位置。

Y

Fl

o

at

该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯一确定

检测框的大小和位置。

Wi

dth

Fl

o

at

该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参数可唯

一确定检测框的大小和位置。

Hei

ght

Fl

o

at

该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参数可唯

一确定检测框的大小和位置。

Ro

tat

e

Fl

o

at

该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测框的具

体位置；取值：0-360（角度制），方向为逆时针旋转。

名称 类型 描述
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Container 节点 UserInfo 的内容：

Container 节点 ListInfo 的内容：

Nam

e

String 该标签用于返回所识别出的实体名称，例如人名。

Locat
ion

Contai
ner

该参数用于返回检测结果在图片中的位置（左上角 xy 坐标、长宽、旋转角度），以
方便快速定位相关信息。

节点名称（关键
字）

描述 类型
是否必
选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin

g
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin
g

否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin

g
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin
g

否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否

ReceiveTokenI

d

一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin
g

否

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节点名称（关键字） 类型 描述
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Container 节点 ListResults 的内容：

ListResults Container Array 命中的所有名单结果。

节点名称（关键字） 类型 描述

ListType Integer 命中的名单类型，取值为0（白名单）和1（黑名单）。

ListName String 命中的名单名称。

Entity String 命中了名单中的哪条内容。

实际案例

请求

GET /image/auditing/iab1ca9fc8a3ed11ea834c525400863904 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<Response>

    <JobsDetail>

        <JobId>iab1ca9fc8a3ed11ea834c525400863904</JobId>

        <State>Success</State>

        <CreationTime>2021-05-21T10:44:32+08:00</CreationTime>

        <Object>example.jpg</Object>

        <Label>Ads</Label>

        <Result>1</Result>

        <AdsInfo>

            <HitFlag>1</HitFlag>

            <Label>xxx</Label>

            <SubLabel>SexBehavior</SubLabel>

            <Score>100</Score>
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            <OcrResults>

                <Text></Text>

                <Keywords></Keywords>

                <Location>

                    <X></X>

                    <Y></Y>

                    <Width></Width>

                    <Height></Height>

                    <Rotate></Rotate>

                </Location>

            </OcrResults>

        </AdsInfo>

    </JobsDetail>

    <RequestId></RequestId>

</Response>
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图片审核回调内容
最近更新时间：2022-10-17 15:52:04

若您配置了审核回调地址，在图片审核结束后，后台会将审核结果以 json 形式回调至您的回调地址。您可以通过回

调内容，进行后续的文件处理操作。

回调内容分为简洁回调（Simple）和详细回调（Detail）。

功能描述
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回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Simple  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

回调内容说明

简洁回调（Simple）
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具体的数据内容如下：

data 的具体内容如下：

   "code": 0,

   "data": 

       "forbidden_status": 0,

       "event": "ReviewImage",

       "porn_info": 

           "hit_flag": 0,

           "label": "",

           "score": 9

       ,

       "result": 0,

       "trace_id": "test_trace_id",

       "url": "https://examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/test.jpg",

       "cos_headers": 

           "x-cos-meta-xx": "xx"

       

   ,

   "message": "Test request when setting callback url"

{

{

{

}

{

}

}

}

参数名

称
描述 类型

是否必

选

code
错误码，值为0时表示审核成功，非0表示审核失败。详情请查看 内容

审核错误码 。

Integ

er
是

messa
ge

错误描述。
Strin
g

是

data 图片审核结果的详细信息。
Obje

ct
是

参数
名称

描述 类型

是

否
必

选

trac
e_id

唯一 ID 标识。
Stri
ng

是

url 被审核图片的完整 URL 链接。 Stri 是

https://cloud.tencent.com/document/product/460/8523#.E5.86.85.E5.AE.B9.E5.AE.A1.E6.A0.B8.E9.94.99.E8.AF.AF.E7.A0.81
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xx_info 的具体内容如下：

ng

eve

nt
触发的事件，此处固定为 ReviewImage。

Stri

ng
是

res

ult

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您
按照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 

（判定为违规敏感文件），2（疑似敏感，建议人工复核）。

Inte

ger
是

forb
idde

n_s

tatu

s

若您设置了自动冻结，该字段表示图片的冻结状态。0：未冻结，1：已被冻结，

2：已转移文件。

Inte

ger
是

cos

_he

ade

rs

资源上传时设置的自定义 header 内容，若未设置则不返回。
Obj

ect
否

por

n_in

fo

审核场景为涉黄的审核结果信息。
Obj

ect
否

ads

_inf

o

审核场景为广告引导的审核结果信息。
Obj

ect
否

参数
名称

描述
类
型

是

否
必

选

hit_
flag

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内
容。2：疑似为当前场景的违规内容。

Int
eg

er

是

sco
re

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100

（置信度最高 ），越高代表该内容越有可能属于当前返回审核信息。通常[0,60]分
可以认为图片属于正常，[61,90]分表示图片疑似敏感，[91,100]分表示图片为敏

感的。例如：色情 99，表明该内容非常有可能属于色情内容。

Int
eg

er

是

labe
l

命中的标签名称。
Str
ing

是
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回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Detail  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

详细回调（Detail）

{

  "EventName": "ReviewImage",

  "JobsDetail": {

    "JobId": "xxxx",

    "State": "Success",

    "CreationTime": "",

    "Object": "",

    "Url": "https://examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/test.jpg",

    "Label": "Normal",

    "Result": 0,

    "Score": 0,

    "Category": "",

    "SubLabel": "",

    "Text": "",

    "PornInfo": {

      "HitFlag": 0,

      "Score": 0,

      "Label": "",

      "Category": "",

      "SubLabel": ""

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Score": 0,

      "Label": "",

      "Category": "",

      "SubLabel": ""

    },

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}
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JobsDetail 的具体内容如下：

节点名称（关键字） 描述 类型

JobsDetail 任务的详细结果信息 Object

EventName 任务的类型，为 ReviewImage String

节点

名称

（关
键

字）

描述
类

型

Cod

e
错误码，只有 State 为 Failed 时返回。详情请查看 错误码列表 。

Str

ing

Mes

sag

e

错误描述，只有 State 为 Failed 时返回。
Str

ing

Job

Id
审核任务的 ID。

Str

ing

Stat
e

审核任务的状态，值为 Submitted（已提交审核）、Success（审核成功）、Failed
（审核失败）、Auditing（审核中）其中一个。

Str
ing

Cre

atio
nTi

me

审核任务的创建时间。
Str
ing

Co

mpr
essi

onR

esul

t

图片是否被压缩处理，值为 0（未压缩），1（正常压缩）。

Int

eg

er

Obj

ect
被审核的图片文件名称。创建任务使用 Object 时返回。

Str

ing

Url 被审核的图片文件链接。创建任务使用 Url 时返回。
Str
ing

Lab

el

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结果，

建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：Normal：正常，

Str

ing

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Porn：色情，Ads：广告，以及其他不安全或不适宜的类型。

Res
ult

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业务

所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规敏感文
件），2（疑似敏感，建议人工复核）。

Int

eg
er

Sco
re

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度

最高 ），越高代表该内容越有可能属于当前返回审核信息。通常[0,60]分可以认为图片属
于正常，[61,90]分表示图片疑似敏感，[91,100]分表示图片为敏感的。例如：色情 99，

则表明该内容非常有可能属于色情内容。

Int

eg
er

Cat

ego
ry

该字段为 Label 的子集，表示审核命中的具体审核类别。例如 Sexy，表示色情标签中的

性感类别。

Str
ing

Sub

Lab
el

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标签。

注意：该字段可能返回空，表示未命中具体的子标签

Str

ing

Tex

t
图片 OCR 文本识别出的具体文本内容，当审核策略开启 OCR 内容检测时返回。

Str

ing

Por

nInf

o

审核场景为涉黄的审核结果信息。

Ob

jec

t

Ads

Info
审核场景为广告引导的审核结果信息。

Ob

jec

t

Buc
ketI

d

审核操作所属的存储桶名称。
Str

ing

Reg
ion

存储桶所在的地域。
Str
ing

For

bid

Stat
e

若您设置了自动冻结，该字段表示图片的冻结状态。0：未冻结，1：已被冻结，2：已转

移文件。

Int

eg
er

Cos

Hea
der

s

资源上传到 COS 时设置的自定义 Header 内容，如果未设置则不返回。map 结构，
key 为自定义 Header 的名称，value 为内容。

Ob

jec
t
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PornInfo，AdsInfo 的具体内容如下：

节

点

名
称

（

关

键
字

）

描述
类

型

Hi
tF

la

g

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内容。2：疑

似为当前场景的违规内容。

In
te

g

er

S
c

or

e

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度最高 
），越高代表该内容越有可能属于当前返回审核信息。通常[0,60]分可以认为图片属于正常，

[61,90]分表示图片疑似敏感，[91,100]分表示图片为敏感的。例如：色情 99，表明该内容

非常有可能属于色情内容。

In
te

g

er

L

a

b

el

该字段表示该截图的综合结果标签（可能为 SubLabel，可能为人物名字等）。

St

ri

n

g

C

at

e

g
or

y

表示命中的具体审核类别。例如 Sexy，表示色情标签中的性感类别。该字段可能为空，表示

未命中或暂无相关的类别。

St

ri

n
g

S
u

b

L

a
b

el

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标签。

注意：该字段可能返回空，表示未命中具体的子标签。

St

ri

n

g

O

cr
R

e

该字段表示 OCR 文本识别的详细检测结果，包括文本识别结果、命中的关键词等信息，有相

关违规内容时返回。

A

rr
a

y
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Container 节点 LibResults 的内容：

OcrResults 的具体内容如下：

s
ul

ts

Li

b

R

e

s
ul

ts

该字段用于返回基于风险库识别的结果。

注意：未命中风险库中样本时，此字段不返回。

C

o
nt

ai

n

er 
A

rr

a

y

节点
名称

（关

键

字）

描述
类

型

Imag

eId
该字段表示命中的风险库中的图片样本 ID。

S

tr

in

g

Scor
e

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100（置信度最高 
），越高代表当前的图片越有可能命中库中的样本。例如：色情 99，表明该数据非常有可

能命中库中的色情样本。

I

n

t
e

g

e

r

节点名称

（关键字）
描述

类

型

Text 图片 OCR 文本识别出的具体文本内容。
Str

ing

Keyword

s
在当前审核场景下命中的关键词。

Arr

ay
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ObjectResults 的具体内容如下：

Location 的具体内容如下：

Location 该参数用于返回 OCR 检测框在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位识别文字的相关信息。

Ob

jec
t

节点名称（关

键字）
描述 类型

Name 该标签用于返回所识别出的实体名称，例如人名。
Stri
ng

Location
该参数用于返回检测结果在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位相关信息。

Obj

ect

节点名称

（关键
字）

描述
类

型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯
一确定检测框的大小和位置。

Fl

o
a

t

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯
一确定检测框的大小和位置。

Fl

o
a

t

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl
o

a

t

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl
o

a

t

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测

框的具体位置；取值：0 - 360（角度制），方向为逆时针旋转。

Fl

o

a

t
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实际案例

案例一：简洁回调（Simple）

{

   "code": 0,

   "data": {

       "event":"ReviewImage",

       "forbidden_status": 0,

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "score": 9

       },

       "result": 0,

       "trace_id": "ixzt90jl2dfscxxxxxxxxxxxxxxxxx",

       "url": "https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/test.jpg",

       "cos_headers": {

           "x-cos-meta-id": "666666"

       }

   },

   "message": "success"

}

案例二：详细回调（Detail）

{

  "EventName": "ReviewImage",

  "JobsDetail": {

    "JobId": "xxxx",

    "State": "Success",

    "CreationTime": "2021-08-10T21:01:10+08:00",

    "CompressionResult": 0,

    "Object": "1.jpg",

    "Label": "Normal",

    "Result": 0,

    "Score": 0,

    "Category": "",

    "SubLabel": "",

    "Text": "",

    "PornInfo": {

      "HitFlag": 0,

      "Score": 0,

      "Label": "",
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      "Category": "",

      "SubLabel": ""

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Score": 0,

      "Label": "",

      "Category": "",

      "SubLabel": ""

    },

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}
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图片审核结果反馈
最近更新时间：2022-07-06 17:53:53

您可通过本接口反馈与预期不符的审核结果，例如色情图片被审核判定为正常或正常图片被判定为色情时可通过该接

口直接反馈。

本接口不会直接修改审核结果，您反馈的错误审核结果将在后台进行确认，并在后续的审核任务中生效。

数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

推荐使用 SDK

请求

请求示例

POST /report/badcase HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <ContentType></ContentType>

    <JobId></JobId>

https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

    <ModerationTime></ModerationTime>

    <Url></Url>

    <SuggestedLabel></SuggestedLabel>

    <Label></Label>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 反馈审核错误的具体参数 Container 是

节点名称

（关键字）

父节

点
描述

类

型

是否

必选

ContentT
ype

Req
ues

t

需要反馈的数据类型，反馈图片错误样本，取值为2。
Int
eg

er

是

Url

Req

ues
t

图片类型的样本，需要填写图片的 url 链接，ContentType 
为2时必填。

Str
ing

否

Label

Req

ues
t

数据万象审核判定的审核结果标签，例如 Porn。
Str

ing
是

Suggeste

dLabel

Req

ues

t

您自己期望的正确审核结果的标签，例如期望是正常，则填 

Normal。

Str

ing
是

JobId

Req

ues

t

该数据样本对应的审核任务 ID，有助于定位审核记录。
Str

ing
否

Moderati

onTime

Req

ues

t

该数据样本之前审核的时间，有助于定位审核记录。 格式为 

2021-08-07T12:12:12+08:00

Str

ing
否

响应

响应头

https://cloud.tencent.com/document/product/460/42866


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1289 共1701页

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

响应体

<Response>

    <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 返回的具体响应内容 Container

节点名称

（关键字）
父节点 描述

类

型

RequestId
Resp

onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题时，

该 ID 能更快地协助定位问题

Str

ing

错误码

实际案例

请求

POST /report/badcase HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1********&q-s

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 66

Content-Type: application/xml

<Request>

    <ContentType>1</ContentType>

    <Url>http://www.example.com/abc.jpg</Url>

    <Label>Porn</Label>

    <SuggestedLabel>Normal</SuggestedLabel>

</Request>

响应

https://cloud.tencent.com/document/product/460/42867
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 May 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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视频审核

提交视频审核任务
最近更新时间：2023-08-16 17:20:01

本接口用于提交一个视频审核任务。视频审核功能为异步任务方式，您可以通过提交视频审核任务审核您的视频文

件，然后通过 查询视频审核任务接口  或 视频审核回调  查询审核结果。

该接口支持情况如下：

视频的审核分为视频画面审核、视频截帧、视频声音审核，其中：

功能描述

说明

支持审核腾讯云 COS 上的视频文件。

支持审核第三方云存储厂商的视频 URL。

支持审核加密数据，如有需要，请 联系服务人员  咨询。

支持对视频文件进行自动检测，从 OCR 文本识别、物体检测（实体、广告台标、二维码等）、图像识别及音频

审核四个维度，通过深度学习技术，识别视频中的违规内容。

支持设置回调地址 Callback 获取检测结果，或通过 查询视频审核任务结果接口  主动轮询获取审核结果详情。

支持识别多种违规场景，包括：色情、违法、广告等场景。

根据不同的业务场景 配置自定义的审核策略 。支持

支持用户 自定义配置黑白图片库 ，打击自定义违规内容。

费用说明

视频画面审核：基于视频截帧能力，通过视频截帧将视频截取为多张图片进行审核，审核费用与图片审核一致。

视频截帧：会产生相应的 视频截帧费用 。

视频声音审核：将视频声音分离出来进行音频审核，审核费用与音频审核一致。

每个审核场景单独计费，例如您选择审核涉黄、广告两种场景，则审核1个视频，计2次审核费用。

调用接口会产生 图片审核费用 、 音频审核费用  和 COS 读请求费用 。

如果音频文件属于 COS 上的低频存储类型，调用审核会产生 COS 低频数据取回费用 。

不支持审核 COS 上的归档存储类型和深度归档存储类型的音频，如果需要审核此类型音频，请先 恢复归档文

件 。

限制说明

视频文件大小支持：文件 < 5GB。

https://cloud.tencent.com/document/product/436/47317
https://cloud.tencent.com/document/product/436/60768
https://cloud.tencent.com/online-service?from=ticket-tab
https://cloud.tencent.com/document/product/460/46926
https://cloud.tencent.com/document/product/460/56345
https://cloud.tencent.com/document/product/436/59080
https://cloud.tencent.com/document/product/460/58120
https://cloud.tencent.com/document/product/460/58119#.E5.9B.BE.E7.89.87.E5.AE.A1.E6.A0.B8.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/460/58119#.E9.9F.B3.E9.A2.91.E5.AE.A1.E6.A0.B8.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
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对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

视频文件支持格式：flv、mkv、mp4 、rmvb、avi、wmv、3gp、mov、m3u8、m4v 等。

支持用户配置审核视频画面或视频声音。

推荐使用 SDK

请求

请求示例

POST /video/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

  <Input>

    <Object></Object>

    <DataId></DataId>

  </Input>

  <Conf>

    <Snapshot>

        <Mode>Interval</Mode>

        <TimeInterval></TimeInterval>

        <Count></Count>

https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

Container 节点 UserInfo 的内容：

    </Snapshot>

    <Callback></Callback>

    <BizType></BizType>

    <DetectContent></DetectContent>

  </Conf>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 视频审核的具体配置项。
Containe

r
是

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 需要审核的视频。 Container 是

Conf Request 审核规则配置。 Container 是

节点名

称（关

键字）

父节点 描述 类型
是否

必选

Objec

t

Reques

t.Input

当前 COS 存储桶中的视频文件名称，例如在目录 test 

中的文件 video.mp4，则文件名称为 

test/video.mp4。

Strin

g
否

Url
Reques

t.Input

视频文件的链接地址，例如 

http://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/test.mp4

。Object 和 Url 只能选择其中一种。

Strin

g
否

DataI

d

Reques

t.Input

该字段在审核结果中会返回原始内容，长度限制为512字

节。您可以使用该字段对待审核的数据进行唯一业务标

识。

Strin

g
否

UserI

nfo

Reques

t.Input
用户业务字段。

Cont

ainer
否
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Container 类型 Conf 的具体数据描述如下：

节点名称（关键

字）

父节点 描述 类

型

是否必

选

TokenId
Request.Input.

UserInfo

用户业务 TokenId，长度不超过128字

节。

Str

ing
否

Nickname
Request.Input.
UserInfo

用户业务 Nickname，长度不超过128
字节。

Str
ing

否

DeviceId
Request.Input.

UserInfo

用户业务 DeviceId，长度不超过128字

节。

Str

ing
否

AppId
Request.Input.

UserInfo

用户业务 AppId，长度不超过128字

节。

Str

ing
否

Room
Request.Input.
UserInfo

用户业务 Room，长度不超过128字
节。

Str
ing

否

IP
Request.Input.

UserInfo
用户业务 IP，长度不超过128字节。

Str

ing
否

Type
Request.Input.

UserInfo
用户业务 Type，长度不超过128字节。

Str

ing
否

ReceiveToke
nId

Request.Input.
UserInfo

用户业务 ReceiveTokenId，长度不
超过128字节。

Str
ing

否

Gender
Request.Input.

UserInfo

用户业务 Gender，长度不超过128字

节。

Str

ing
否

Level
Request.Input.

UserInfo

用户业务 Level，长度不超过128字

节。

Str

ing
否

Role
Request.Input.
UserInfo

用户业务 Role，长度不超过128字节。
Str
ing

否

节点名称

（关键字）
父节点 描述 类型

是
否

必

选

BizType Reques

t.Conf

表示审核策略的唯一标识，您可以通过控制台上的审核策

略页面，配置您希望审核的场景，如色情、广告、违法违

规等，配置指引： 设置公共审核策略 。您可以在控制台

上获取到 BizType。BizType 填写时，此条审核请求

Strin

g

否

https://cloud.tencent.com/document/product/436/55206
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Container 类型 Snapshot 的具体数据描述如下：

将按照该审核策略中配置的场景进行审核。BizType 不

填写时，将自动使用默认的审核策略。

Snapshot
Reques

t.Conf

视频画面的审核通过视频截帧能力截取出一定量的截图，
通过对截图逐一审核而实现的，该参数用于指定视频截帧

的配置。

Cont
aine

r

是

Callback
Reques
t.Conf

回调地址，以 http://  或者 https://  开头的地址。
Strin
g

否

Callback

Version

Reques

t.Conf

回调内容的结构，有效值：Simple（回调内容包含基本

信息）、Detail（回调内容包含详细信息）。默认为 

Simple。

Strin

g
否

DetectCo

ntent

Reques

t.Conf

用于指定是否审核视频声音，当值为0时：表示只审核视

频画面截图；值为1时：表示同时审核视频画面截图和视

频声音。默认值为0。

Inte

ger
否

Callback

Type

Reques

t.Conf

回调片段类型，有效值：1（回调全部截帧和音频片

段）、2（回调违规截帧和音频片段）。默认为 1。

Inte

ger
否

Freeze
Reques

t.Conf

自动冻结配置项，可配置指定审核分数的结果进行自动冻

结。

Cont
aine

r

否

节点名

称（关
键字）

父节点 描述 类型

是

否

必
选

Mode
Request.Con

f.Snapshot

表示视频的截帧模式，有效值：Interval、

Average、Fps。
Interval 表示间隔模式：每间隔 TimeInterval 

秒截取一帧；当设置 Count，未设置 

TimeInterval 时，表示截取所有帧，共 Count 

帧。

Average 表示平均模式：选择该模式时 

TimeInterval 参数不生效，需要结合 Count 参

数使用，表示整个视频，按平均间隔截取共 

Count 张图片。

Fps 表示固定帧率模式：选择该模式时， 
TimeInterval 参数表示每秒截取多少帧，未设

置 TimeInterval 时，表示截取所有帧，Count 

表示共截取多少帧。

Strin

g
否
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Container 类型 Freeze 的具体数据描述如下：

其他审核场景的冻结参数，请 联系服务人员 咨询。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Count Request.Con

f.Snapshot

视频截帧数量，范围为(0, 10000]。 Inte

ger

是

TimeIn
terval

Request.Con
f.Snapshot

视频截帧频率，范围为(0, 60]，单位为秒，支持 
float 格式，执行精度精确到毫秒。

Floa
t

否

节点名

称（关

键字）

父节点 描述
类

型

是否

必选

PornS

core

Request.C

onf.Freeze

取值为[0,100]，表示当色情审核结果大于或等于该分
数时，自动进行冻结操作。不填写则表示不自动冻结，

默认值为空。

Int
eg

er

否

AdsSc
ore

Request.C
onf.Freeze

取值为[0,100]，表示当广告审核结果大于或等于该分
数时，自动进行冻结操作。不填写则表示不自动冻结，

默认值为空。

Int
eg

er

否

响应

响应头

响应体

<Response>

    <JobsDetail>

      <DataId></DataId>

      <JobId></JobId>

      <State></State>

      <CreationTime></CreationTime>

    </JobsDetail>

    <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/online-service?from=ticket-tab
https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Response 无 视频审核返回的具体响应内容。 Container

节点名称
（关键字）

父节点 描述 类型

JobsDeta

il
Response 视频审核任务的详细信息。

Contai

ner

RequestI

d
Response

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到

问题时，该 ID 能更快地协助定位问题。
String

节点名称

（关键

字）

父节点 描述 类型

DataId
Response.

JobsDetail
请求中添加的唯一业务标识。 String

JobId
Response.
JobsDetail

本次视频审核任务的 ID。 String

State
Response.

JobsDetail

视频审核任务的状态，值为 Submitted（已提交审核）、

Snapshoting（视频截帧中）、Success（审核成功）、
Failed（审核失败）、Auditing（审核中）其中一个。

String

Creation

Time

Response.

JobsDetail
视频审核任务的创建时间。 String

错误码

实际案例

请求

POST /video/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867
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<Request>

  <Input>

    <Object>a.mp4</Object>

    <DataId>123-fdrsg-123</DataID>

  </Input>

  <Conf>

    <Snapshot>

        <Mode>Interval</Mode>

        <TimeInterval>50</TimeInterval>

        <Count>100</Count>

    </Snapshot>

    <Callback>http://callback.com/</Callback>

    <BizType>b81d45f94b91a683255e9a9506f45a11</BizType>

    <DetectContent>1</DetectContent>

  </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <DataId>123-fdrsg-123</DataID>

    <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

    <State>Submitted</State>

    <CreationTime>2021-08-07T12:12:12+0800</CreationTime>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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查询视频审核任务结果
最近更新时间：2023-08-16 17:20:02

本接口用于主动查询指定的视频审核任务结果。视频审核功能为异步任务方式，您可以通过提交视频审核任务审核您

的视频文件，然后通过查询视频审核任务接口查询审核结果。

对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能描述

说明

 视频审核任务结果保存时效为1个月，您可通过本接口查询近1个月的审核结果。

推荐使用 SDK

请求

请求示例

GET /video/auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称 描述 类型 是否必选

https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

jobId 要查询的任务ID，可通过提交审核任务的响应中获取。 String 是

响应

响应头

响应体

<Response>

  <JobsDetail>

    <Code>Success</Code>

    <Message>Success</Message>

    <DataId></DataId>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <Object></Object>

    <SnapshotCount></SnapshotCount>

    <Result>1</Result>

    <PornInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </PornInfo>

    <AdsInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </AdsInfo>

    <Snapshot>

        <Url></Url>

        <Text></Text>

        <SnapshotTime></SnapshotTime>

        <PornInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Label></Label>

            <SubLabel></SubLabel>

        </PornInfo>

        <AdsInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Label></Label>

            <SubLabel></SubLabel>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

        </AdsInfo>

    </Snapshot>

    <AudioSection>

        <Url></Url>

          <OffsetTime>0</OffsetTime>

          <Duration>3000</Duration>

        <Text>哈哈哈</Text>

        <PornInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </PornInfo>

        <AdsInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </AdsInfo>

    </AudioSection>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 视频审核的全部结果信息。 Container

节点名称

（关键字）
父节点 描述 类型

JobsDeta
il

Resp
onse

视频审核任务的详细信息。
Contai
ner

RequestI

d

Resp

onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题

时，该 ID 能更快地协助定位问题。
String

节点名称

（关键
字）

父节点 描述 类型
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Code Response.J
obsDetail

错误码，只有 State 为 Failed 时返回。详情请查看 错误码
列表 。

Strin
g

Messag

e

Response.J

obsDetail
错误描述，只有 State 为 Failed 时返回。

Strin

g

DataId
Response.J

obsDetail

提交任务时设置了 DataId 参数时返回，返回原始内容，长度

限制为512字节。您可以使用该字段对待审核的数据进行唯一

业务标识。

Strin

g

JobId
Response.J

obsDetail
视频审核任务的 ID。

Strin

g

State
Response.J
obsDetail

视频审核任务的状态，值为 Submitted（已提交审核）、

Snapshoting（视频截帧中）、Success（审核成功）、
Failed（审核失败）、Auditing（审核中）其中一个。

Strin
g

Creation

Time

Response.J

obsDetail
视频审核任务的创建时间。

Strin

g

Object
Response.J

obsDetail
本次审核的文件名称，创建任务使用 Object 时返回。

Strin

g

Url
Response.J
obsDetail

本次审核的文件链接，创建任务使用 Url 时返回。
Strin
g

Snapsh

otCount

Response.J

obsDetail
视频截图的总数量。

Strin

g

Label
Response.J

obsDetail

该字段用于返回检测结果中所对应的优先级最高的恶意标签，

表示模型推荐的审核结果，建议您按照业务所需，对不同违规

类型与建议值进行处理。 返回值：Normal：正常，Porn：

色情，Ads：广告，以及其他不安全或不适宜的类型。

Strin

g

Result
Response.J

obsDetail

该字段表示本次判定的审核结果，您可以根据该结果，进行后

续的操作；建议您按照业务所需，对不同的审核结果进行相应

处理。有效值：0（审核正常），1 （判定为违规敏感文
件），2（疑似敏感，建议人工复核）。

Inte

ger

PornInfo
Response.J

obsDetail
审核场景为色情的审核结果信息。

Cont

aine

r

AdsInfo
Response.J

obsDetail
审核场景为广告的审核结果信息。

Cont

aine

r

Snapsh Response.J 该字段用于返回视频中视频画面截图审核的结果。 Cont

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Container 节点 PornInfo，AdsInfo 的内容：

Container 节点 Snapshot 的内容：

ot obsDetail aine

r 
Arra

y

AudioSe

ction

Response.J

obsDetail

该字段用于返回视频中视频声音审核的结果。如果未检测音

频，则不返回。

Cont

aine
r  

Arra

y

UserInfo
Response.J

obsDetail
用户业务字段。创建任务未设置 UserInfo 时无此字段。

Cont

aine

r

ListInfo
Response.J

obsDetail
如果审核结果命中了业务字段风险库，将返回该字段。

Cont

aine

r

ForbidSt
ate

Response.J
obsDetail

若您设置了自动冻结，该字段表示图片的冻结状态。0：未冻
结，1：已被冻结，2：已转移文件。

Inte
ger

节点名称

（关键

字）

父节点 描述 类型

HitFlag
Response.Job

sDetail.*Info

用于返回该审核场景的审核结果，返回值：0：正常。1：确

认为当前场景的违规内容。2：疑似为当前场景的违规内

容。

Inte

ger

Count
Response.Job
sDetail.*Info

命中该审核分类的截图张数。
Inte
ger

Score
Response.Job
sDetail.*Info

该字段表示审核结果命中审核信息的置信度，取值范围：0

（置信度最低）-100（置信度最高），越高代表该内容越有
可能属于当前返回的审核信息。

例如：色情 99，则表明该内容非常有可能属于色情内容。

Inte
ger

节点名称

（关键

字）

父节点 描述 类型

Url Response.JobsDetai 视频截图的访问地址，您可以通过该地址查看该截 Strin
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Container 节点 PornInfo，AdsInfo 的内容：

l.Snapshot 图内容，地址格式为标准 URL 格式。注意：每次

查看数据的有效期为2小时，2小时后如还需查看，

请重新发起查询请求。

g

Snapsh

otTime

Response.JobsDetai

l.Snapshot

该字段用于返回当前截图位于视频中的时间，单位

为毫秒。例如5000（视频开始后5000毫秒）。审

核直播流时，该字段返回当前截图的时间戳，单位
为毫秒。例如1649387157000。

Integ

er

Text
Response.JobsDetai

l.Snapshot

该字段用于返回当前截图的图片 OCR 文本识别的

检测结果，仅在审核策略开启文本内容检测时返

回。

Strin

g

Label
Response.JobsDetai

l.AudioSection

该字段用于返回检测结果中所对应的优先级最高的

恶意标签，表示模型推荐的审核结果，建议您按照

业务所需，对不同违规类型与建议值进行处理。 返
回值：Normal：正常，Porn：色情，Ads：广

告，以及其他不安全或不适宜的类型。

Strin

g

SubLab

el

Response.JobsDetai

l.AudioSection

该字段表示审核命中的具体子标签。注意：该字段

可能返回空。

Strin

g

Result
Response.JobsDetai

l.AudioSection

该字段表示本次判定的审核结果，您可以根据该结

果，进行后续的操作；建议您按照业务所需，对不

同的审核结果进行相应处理。有效值：0（审核正
常），1 （判定为违规敏感文件），2（疑似敏感，

建议人工复核）。

Integ

er

PornInf

o

Response.JobsDetai

l.Snapshot
审核场景为色情的审核结果信息。

Cont

ainer

AdsInfo
Response.JobsDetai

l.Snapshot
审核场景为广告的审核结果信息。

Cont

ainer

节点名称

（关键
字）

父节点 描述 类型

HitFlag
Response.JobsDetail

.Snapshot.*Info

用于返回该审核场景的审核结果，返回值：

0：正常。1：确认为当前场景的违规内容。

2：疑似为当前场景的违规内容。

Integer

Score Response.JobsDetail

.Snapshot.*Info

该字段表示审核结果命中审核信息的置信度，

取值范围：0（置信度最低）-100（置信度

最高 ），越高代表该内容越有可能属于当前

Integer
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Container 节点 LibResults 的内容：

OcrResults 的具体内容如下：

返回的审核信息。例如：色情 99，则表明该

内容非常有可能属于色情内容。

Label
Response.JobsDetail
.Snapshot.*Info

该字段表示该截图的综合结果标签（可能为 
SubLabel，可能为人物名字等）。

String

Categor

y

Response.JobsDetail

.Snapshot.*Info

该字段为 Label  的子集，表示审核命中的

具体审核类别。例如 Sexy，表示色情标签中
的性感类别。

String

SubLab

el

Response.JobsDetail

.Snapshot.*Info

该字段表示审核命中的具体子标签，例如：

Porn 下的 SexBehavior 子标签。注意：

该字段可能返回空，表示未命中具体的子标
签。

String

OcrRes

ults

Response.JobsDetail

.Snapshot.*Info

该字段表示 OCR 文本识别的详细检测结

果，包括文本坐标信息、文本识别结果等信
息，有相关违规内容时返回。

Contain

er Array

LibResul

ts

Response.JobsDetail

.Snapshot.*Info

该字段用于返回基于图文风险库识别的结果。

注意：未命中风险库中样本时，此字段不返

回。

Contain

er Array

节点
名称

（关

键

字）

父节点 描述 类型

Imag

eId

Response.JobsDetail.Snap

shot.*Info.LibResults
该字段表示命中的风险库中的图片样本 ID。

Strin

g

Scor

e

Response.JobsDetail.Snap

shot.*Info.LibResults

该字段用于返回当前标签下的置信度，取值范
围：0（置信度最低）-100（置信度最高），

越高代表当前的图片越有可能命中库中的样本；

如：色情 99，则表明该数据非常有可能命中库

中的色情样本。

Inte

ger

节点名
称（关

键字）

父节点 描述 类型
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ObjectResults 的具体内容如下：

Location 的具体内容如下：

Text Response.JobsDetail.Snaps

hot.*Info.OcrResults

图片 OCR 文本识别出的具体文本内

容。

String

Keywo

rds

Response.JobsDetail.Snaps

hot.*Info.OcrResults
在当前审核场景下命中的关键词。

String 

Array

Locati

on

Response.JobsDetail.Snaps

hot.*Info.OcrResults

该参数用于返回 OCR 检测框在图片中

的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位识别文字的相关信
息。

Contai

ner

节点名

称（关

键字）

父节点 描述 类型

Name
Response.JobsDetail.Snapsh
ot.*Info.ObjectResults

该标签用于返回所识别出的实体名称，例
如人名。

Strin
g

SubL

abel

Response.JobsDetail.Snapsh

ot.*Info.ObjectResults

该字段表示审核命中的具体子标签。注

意：该字段可能返回空。

Strin

g

Locat

ion

Response.JobsDetail.Snapsh

ot.*Info.ObjectResults

该参数用于返回检测结果在图片中的位置

（左上角 xy 坐标、长宽、旋转角度），

以方便快速定位相关信息。

Cont

ainer

节点名称

（关键
字）

描述
类
型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可

唯一确定检测框的大小和位置。

Flo

at

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可

唯一确定检测框的大小和位置。

Flo

at

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参
数可唯一确定检测框的大小和位置。

Flo
at

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参

数可唯一确定检测框的大小和位置。

Flo

at

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检

测框的具体位置；取值：0-360（角度制），方向为逆时针旋转。

Flo

at
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Container 节点 AudioSection 的内容：

Container 节点 PornInfo，AdsInfo 的内容：

节点名称

（关键

字）

父节点 描述 类型

Url
Response.JobsDetai

l.AudioSection

视频声音片段的访问地址，您可以通过该地址获取

该声音片段的内容，地址格式为标准 URL 格式。

注意：每次查看数据的有效期为2小时，2小时后如

还需查看，请重新发起查询请求。

Strin

g

Text
Response.JobsDetai

l.AudioSection

该字段用于返回当前视频声音的 ASR 文本识别的

检测结果。

Strin

g

OffsetT

ime

Response.JobsDetai

l.AudioSection

该字段用于返回当前声音片段位于视频中的时间，
单位为毫秒，例如5000（视频开始后5000毫

秒）。审核直播流时，该字段返回当前声音片段的

时间戳，单位为毫秒，例如1649387157000。

Integ

er

Duratio

n

Response.JobsDetai

l.AudioSection
当前视频声音片段的时长，单位毫秒。

Integ

er

Label
Response.JobsDetai

l.Snapshot

该字段用于返回检测结果中所对应的优先级最高的
恶意标签，表示模型推荐的审核结果，建议您按照

业务所需，对不同违规类型与建议值进行处理。 返

回值：Normal：正常，Porn：色情，Ads：广

告，以及其他不安全或不适宜的类型。

Strin

g

SubLab

el

Response.JobsDetai

l.AudioSection

该字段表示审核命中的具体子标签，例如：Porn 

下的 SexBehavior 子标签。注意：该字段可能返

回空，表示未命中具体的子标签。

Strin

g

Result
Response.JobsDetai

l.Snapshot

该字段表示本次判定的审核结果，您可以根据该结

果，进行后续的操作；建议您按照业务所需，对不

同的审核结果进行相应处理。有效值：0（审核正

常），1 （判定为违规敏感文件），2（疑似敏感，

建议人工复核）。

Integ

er

PornInf

o

Response.JobsDetai

l.AudioSection
审核场景为色情的审核结果信息。

Cont

ainer

AdsInfo
Response.JobsDetai

l.AudioSection
审核场景为广告的审核结果信息。

Cont

ainer

节点名 父节点 描述 类型
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Container 节点 LibResults 的内容：

Container 节点 UserInfo 的内容：

称（关

键字）

HitFla

g

Response.JobsDetail.Au

dioSection.*Info

用于返回该审核场景的审核结果，返回值：

0：正常。1：确认为当前场景的违规内容。

2：疑似为当前场景的违规内容。

String

Score
Response.JobsDetail.Au

dioSection.*Info

该字段表示审核结果命中审核信息的置信

度，取值范围：0（置信度最低）-100（置

信度最高 ），越高代表该内容越有可能属于

当前返回审核信息例如：色情 99，则表明
该内容非常有可能属于色情内容。

String

Categ

ory

Response.JobsDetail.Au

dioSection.*Info

该字段为 Label  的子集，表示审核命中的

具体审核类别。例如 Sexy，表示色情标签
中的性感类别。

String

SubLa

bel

Response.JobsDetail.Au

dioSection.*Info

该字段表示审核命中的具体子标签。注意：

该字段可能返回空。
String

Keywo

rds

Response.JobsDetail.Au

dioSection.*Info

在当前审核场景下命中的关键词，没有时不

返回

String 

Array

LibRes
ults

Response.JobsDetail.Au
dioSection.*Info

该字段用于返回基于图文风险库识别的结
果。注意：未命中风险库中样本时，此字段

不返回。

Contain
er Array

节点名称

（关键

字）

父节点 描述 类型

LibType
Response.JobsDetail.AudioSe

ction.*Info.LibResults

命中的风险库类型，取值为1（预设

图文风险）和2（自定义图文风险

库）。

Integ

er

LibNam

e

Response.JobsDetail.AudioSe

ction.*Info.LibResults
命中的风险库名称。

Strin

g

Keywor
ds

Response.JobsDetail.AudioSe
ction.*Info.LibResults

命中的库中关键词。该参数可能会有

多个返回值，代表命中的多个关键
词。

Strin

g 
Array

节点名称（关键 描述 类型 是否必选
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

字）

TokenId 一般用于表示账号信息，长度不超过128字节。
Stri
ng

否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Stri

ng
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Stri

ng
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Stri
ng

否

Room 一般用于表示房间号信息，长度不超过128字节。
Stri

ng
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Stri

ng
否

Type 一般用于表示业务类型，长度不超过128字节。
Stri
ng

否

ReceiveTokenId
一般用于表示接收消息的用户账号，长度不超过128字

节。

Stri

ng
否

Gender 一般用于表示性别信息，长度不超过128字节。
Stri

ng
否

Level 一般用于表示等级信息，长度不超过128字节。
Stri

ng
否

Role 一般用于表示角色信息，长度不超过128字节。
Stri

ng
否

节点名称（关键

字）
父节点 描述 类型

ListResults
Response.JobsDetail

.ListInfo

命中的所有业务字段风险库结

果。

Container 

Array

节点名称

（关键字）
父节点 描述 类型
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

ListType Response.JobsDetail.L

istInfo.ListResults

命中的业务字段风险库类型，取值为0（白

库）和1（黑库）。

Inte

ger

ListName
Response.JobsDetail.L
istInfo.ListResults

命中的业务字段风险库名称。
Strin
g

Entity
Response.JobsDetail.L

istInfo.ListResults
命中了业务字段风险库中的哪条内容。

Strin

g

错误码

实际案例

请求

GET /video/auditing/vab1ca9fc8a3ed11ea834c525400863904 HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

    <State>Success</State>

    <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    <Object>a.mp4</Object>

    <SnapshotCount>1</SnapshotCount>

    <Label>Normal</Label>

    <Result>0</Result>

    <PornInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

    </PornInfo>

https://cloud.tencent.com/document/product/460/42867
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    <AdsInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

    </AdsInfo>

    <Snapshot>

        <Url>http://examplebucket-1250000000.cos.ap-chongqing.myqcloud.com/0.jpg</U

        <SnapshotTime>0</SnapshotTime>

        <Text>哈哈</Text>

        <Label>Normal</Label>

        <Result>0</Result>

        <PornInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Label></Label>

            <SubLabel></SubLabel>

        </PornInfo>

        <AdsInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Label></Label>

            <SubLabel></SubLabel>

        </AdsInfo>

    </Snapshot>

    <AudioSection>

        <AdsInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

        </AdsInfo>

        <Duration>30000</Duration>

        <OffsetTime>0</OffsetTime>

        <Label>Normal</Label>

        <Result>0</Result>

        <PornInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

        </PornInfo>

        <Text>wc xx</Text>

        <Url>https://auditing-1250000000.cos.ap-guangzhou.myqcloud.com/q9MhdztF/0.m

    </AudioSection>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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视频审核回调内容
最近更新时间：2023-08-16 17:20:02

若您配置了审核回调地址，在视频审核结束后，后台会将审核结果以 json 形式回调至您的回调地址。您可以通过回

调内容，进行后续的文件处理操作。

回调内容分为简洁回调（Simple）和详细回调（Detail）。

功能描述
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回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Simple  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

回调内容说明

简洁回调（Simple）
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具体的数据内容如下：

data 的具体内容如下：

{

   "code": 0,

   "data": {

       "event":"ReviewVideo",

       "forbidden_status": 0,

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "count": 0

       },

       "result": 0,

       "trace_id": "test_trace_id",

       "url": "test_url",

       "cos_headers": {

           "x-cos-meta-xx": "xx"

       }

   },

   "message": "Test request when setting callback url"

}

参数名称 描述 类型

code
错误码，值为0时表示审核成功，非0表示审核失败。详情请查看 内容审核错误

码 。

Intege

r

message 错误描述。 String

data 视频审核结果的详细信息。 Object

参数名称 描述
类

型

trace_id 请求的 ID，如果是接口创建的异步任务，则为接口返回的 JobId。
Str
ing

url 被审核视频的完整 URL 链接。
Str

ing

event 触发的事件，此处固定为 ReviewVideo。
Str

ing

https://cloud.tencent.com/document/product/460/8523#.E5.86.85.E5.AE.B9.E5.AE.A1.E6.A0.B8.E9.94.99.E8.AF.AF.E7.A0.81
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xx_info 的具体内容如下：

回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Detail  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

result 该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按

照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定

为违规敏感文件），2（疑似敏感，建议人工复核）。

Int

eg

er

forbidden

_status

若您设置了自动冻结，该字段表示视频的冻结状态。0：未冻结，1：已被冻结，

2：已转移文件。

Int

eg

er

cos_hea

ders
资源上传时设置的自定义 header 内容，若未设置则不返回。

Ob
jec

t

porn_info 审核场景为涉黄的审核结果信息。
Ob
jec

t

ads_info 审核场景为广告引导的审核结果信息。

Ob

jec
t

data_id 提交任务时设置了 DataId 参数时返回，返回原始内容，长度限制为512字节。
Str

ing

参数名称 描述 类型

hit_flag
用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规

内容。2：疑似为当前场景的违规内容。

Inte

ger

label 命中的标签名称，目前为空。
Strin
g

count 命中该审核分类的敏感截图张数。
Inte

ger

score

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100

（置信度最高），越高代表该内容越有可能属于当前返回审核信息。例如：色情 

99，则表明该内容非常有可能属于色情内容。

Inte

ger

详细回调（Detail）

{
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  "EventName": "ReviewVideo",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "",

    "Object": "",

    "Label": "Normal",

    "Result": 0,

    "SnapshotCount": 1,

    "PornInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "Snapshot": [

      {

        "Url": "",

        "Text": "",

        "SnapshotTime": 0,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Label": "",

          "SubLabel": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Label": "",

          "SubLabel": ""

        }

      }

    ],

    "AudioSection": [

      {

        "Url": "",

        "Text": "",

        "OffsetTime": 0,

        "Duration": 30000,

        "Label": "Normal",
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具体的数据内容如下：

JobsDetail 的具体内容如下：

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0

        }

      }

    ],

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxx"

    }

  }

}

节点名称（关键字） 描述 类型

JobsDetail 任务的详细结果信息。 Object

EventName 任务的类型，为 ReviewVideo 。 String

节点名称
（关键

字）

描述 类型

Code 错误码，只有 State 为 Failed 时返回。详情请查看 错误码列表 。
Strin

g

Messag

e
错误描述，只有 State 为 Failed 时返回。

Strin

g

JobId 审核任务的 ID。
Strin

g

DataId 提交任务时设置了DataId参数时返回，返回原始内容，长度限制为512字节。
Strin

g

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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State 视频审核任务的状态，值为 Submitted（已提交审核）、Snapshoting（截图

中）、Success（审核成功）、Failed（审核失败）、Auditing（审核中）其

中一个。

Strin

g

Creation

Time
视频审核任务的创建时间。

Strin

g

Object 被审核的视频文件的名称，创建任务使用 Object 时返回。
Strin

g

Url 本次审核的文件链接，创建任务使用 Url 时返回。
Strin

g

Snapsh

otCount

视频截图的总数量。直播流状态为 Auditing 的回调中该字段为本次回调包含的

截图数量。

Integ

er

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审

核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。返回值：

Normal：正常，Porn：色情，Ads：广告。

Strin

g

Result
该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您
按照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 

（判定为违规敏感文件），2（疑似敏感，建议人工复核）。

Integ

er

PornInfo 审核场景为涉黄的审核结果信息。
Objec
t

AdsInfo 审核场景为广告引导的审核结果信息。
Objec

t

Snapsh

ot
该字段用于返回视频中视频画面截图审核的结果。 Array

AudioSe
ction

该字段用于返回视频中视频声音审核的结果。如果未检测音频，则不返回。 Array

BucketI

d
创建的审核任务所属的存储桶名称。

Strin

g

Region 存储桶所在的地域。
Strin

g

ForbidSt
ate

若您设置了自动冻结，该字段表示视频的冻结状态。0：未冻结，1：已被冻结，
2：已转移文件。

Integ
er

CosHea

ders

资源上传到 COS 时设置的自定义 Header 内容，如果未设置则不返回。map 

结构，key 为自定义 Header 的名称，value 为内容。

Objec

t
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PornInfo，AdsInfo 的具体内容如下：

Snapshot 的具体内容如下：

UserInfo 用户业务字段。创建任务时未设置 UserInfo 则无此字段。 Objec

t

Type 审核类型，直播流审核返回 live_video。
Strin
g

ListInfo 如果命中了业务字段风险库，则返回该字段。
Objec

t

节点名称
（关键字）

描述 类型

HitFlag
用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规

内容。2：疑似为当前场景的违规内容。

Inte

ger

Count 命中该审核分类的截图张数。
Inte

ger

Score
该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100
（置信度最高），越高代表该内容越有可能属于当前返回审核信息。例如：色情 

99，则表明该内容非常有可能属于色情内容。

Inte
ger

节点名称

（关键

字）

描述 类型

Url

视频截图的访问地址，您可以通过该地址查看该截图内容，地址格式为标准 URL 

格式。

注意：每次查看数据的有效期为2小时，2小时后如还需查看，请发起查询请求。

Strin

g

Snapsh

otTime

该字段用于返回当前截图位于视频中的时间，单位为毫秒。例如5000（视频开始

后5000毫秒）。审核直播流时，该字段返回当前截图的时间戳，单位为毫秒。例

如1649387157000。

Inte

ger

Text
该字段用于返回当前截图的图片 OCR 文本识别的检测结果，仅在审核策略开启文
本内容检测时返回。

Strin
g

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核

结果，建议您按照业务所需，对不同违规类型与建议值进行处理。返回值：
Normal：正常，Porn：色情，Ads：广告。

Strin

g

Result 该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按

照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判

Inte

ger
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Snapshot 中 PornInfo，AdsInfo 的具体内容如下：

Container 节点 LibResults 的内容：

定为违规敏感文件），2（疑似敏感，建议人工复核）。

PornInfo 审核场景为涉黄的审核结果信息。
Obje

ct

AdsInfo 审核场景为广告引导的审核结果信息。
Obje

ct

节点名称

（关键

字）

描述 类型

HitFlag 是否命中该审核分类，0表示未命中，1表示命中，2表示疑似。 Integer

Score

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最

低）-100（置信度最高 ），越高代表该内容越有可能属于当前返回审核信
息。例如：色情 99，则表明该内容非常有可能属于色情内容。

Integer

Label
该字段表示该截图的综合结果标签（可能为 SubLabel，可能为人物名字

等）。
String

Categor

y

表示命中的具体审核类别。例如 Sexy，表示色情标签中的性感类别。该字段

可能为空，表示未命中或暂无相关的类别。
String

SubLab

el

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标
签。

注意：该字段可能返回空，表示未命中具体的子标签。

String

OcrRes
ults

该字段表示 OCR 文本识别的详细检测结果，包括文本坐标信息、文本识别结
果等信息，有相关违规内容时返回。

Array

LibResul

ts

该字段用于返回基于图文风险库识别的结果。注意：未命中风险库中样本时，

此字段不返回。

Object 

Array

节点名称

（关键
字）

描述 类型

ImageId 该字段表示命中的风险库中的图片样本 ID。 String

Score

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100（置信

度最高 ），越高代表当前的图片越有可能命中库中的样本。例如：色情 99，表

明该数据非常有可能命中库中的色情样本。

Intege

r
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OcrResults 的具体内容如下：

ObjectResults 的具体内容如下：

Location 的具体内容如下：

节点名称

（关键字）
描述 类型

Text 图片 OCR 文本识别出的具体文本内容。
Strin

g

Keywords 在当前审核场景下命中的关键词。
Arra

y

SubLabel

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标

签。

注意：该字段可能返回空，表示未命中具体的子标签。

Strin

g

Location
该参数用于返回 OCR 检测框在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位识别文字的相关信息。

Obje

ct

节点名称（关

键字）
描述 类型

Name 该标签用于返回所识别出的实体名称，如人名。
Strin

g

Location
该参数用于返回检测结果在图片中的位置（左上角 xy 坐标、长宽、旋转角
度），以方便快速定位相关信息。

Obje
ct

节点名称

（关键

字）

描述
类

型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可

唯一确定检测框的大小和位置。

Flo

at

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可

唯一确定检测框的大小和位置。

Flo

at

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参

数可唯一确定检测框的大小和位置。

Flo

at

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参

数可唯一确定检测框的大小和位置。

Flo

at
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AudioSection 的具体内容如下：

AudioSection 中 PornInfo，AdsInfo 的具体内容如下：

Rotate 该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检

测框的具体位置；取值：0-360（角度制），方向为逆时针旋转。

Flo

at

节点名
称（关

键字）

描述
类
型

Url
视频声音片段的访问地址，您可以通过该地址获取该声音片段的内容，地址格式为标准 
URL 格式。

注意：每次查看数据的有效期为2小时，2小时后如还需查看，请发起查询请求。

Str
ing

Text 该字段用于返回当前视频声音的 ASR 文本识别的检测结果。
Str

ing

Offse

tTime

该字段用于返回当前声音片段位于视频中的时间，单位为毫秒，例如5000（视频开始后

5000毫秒）。审核直播流时，该字段返回当前声音片段的时间戳，单位为毫秒，例如

1649387157000。

Int

eg

er

Durat

ion
当前视频声音片段的时长，单位毫秒。

Int

eg

er

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结

果，建议您按照业务所需，对不同违规类型与建议值进行处理。返回值：Normal：正

常，Porn：色情，Ads：广告。

Str

ing

Resul

t
供参考的识别结果，0（正常），1（敏感），2（疑似敏感）。

Int

eg

er

PornI

nfo
审核场景为涉黄的审核结果信息。

Ob
jec

t

AdsIn
fo

审核场景为广告引导的审核结果信息。
Ob
jec

t

节点名称

（关键

字）

描述 类型

HitFlag 是否命中该审核分类，0表示未命中，1表示命中，2表示疑似。 Integer
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Container 节点 LibResults 的内容：

UserInfo 的内容：

Score

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最

低）-100（置信度最高 ），越高代表该内容越有可能属于当前返回审核信
息。例如：色情99，表明该内容非常有可能属于色情内容。

Integer

Categor

y

该字段表示命中的审核类别。

注意：该字段可能返回空。
String

SubLab

el

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标

签。

注意：该字段可能返回空，表示未命中具体的子标签。

String

Keywor

ds
在当前审核场景下命中的关键词，没有时不返回。 Array

LibResul

ts

该字段用于返回基于风险库识别的结果。

注意：未命中风险库中样本时，此字段不返回。

Contain

er Array

节点名称（关键
字）

描述 类型

LibType
命中的风险库类型，取值为1（预设图文风险库）和2（自定义图文风

险库）。
Integer

LibName 命中的风险库名称。 String

Keywords
命中的库中关键词。该参数可能会有多个返回值，代表命中的多个关

键词。

String 

Array

节点名称（关键
字）

描述 类型 是否必选

TokenId 一般用于表示账号信息，长度不超过128字节。
Stri

ng
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Stri

ng
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Stri
ng

否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Stri

ng
否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

Room 一般用于表示房间号信息，长度不超过128字节。 Stri

ng

否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Stri
ng

否

Type 一般用于表示业务类型，长度不超过128字节。
Stri

ng
否

ReceiveTokenId
一般用于表示接收消息的用户账号，长度不超过128字

节。

Stri

ng
否

Gender 一般用于表示性别信息，长度不超过128字节。
Stri
ng

否

Level 一般用于表示等级信息，长度不超过128字节。
Stri

ng
否

Role 一般用于表示角色信息，长度不超过128字节。
Stri

ng
否

节点名称（关键字） 描述 类型

ListResults 命中的所有业务字段风险库的结果。 Container Array

节点名称（关键字） 描述 类型

ListType 命中的业务字段风险库类型，取值为0（白库）和1（黑库）。 Integer

ListName 命中的业务字段风险库名称。 String

Entity 命中了业务字段风险库中的哪条内容。 String

实际案例

案例一：简洁回调（Simple）

{

   "code": 0,

   "data": {

       "event":"ReviewVideo",

       "forbidden_status": 0,
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       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "count": 0

       },

       "result": 0,

       "trace_id": "vxzt90jl2dfscxxxxxxxxxxxxxxxxx",

       "url": "https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/video.mp

       "cos_headers": {

           "x-cos-meta-id": "666666"

       }

   },

   "message": "success"

}

案例二：详细回调（Detail）

{

  "EventName": "ReviewVideo",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "2021-08-10T21:01:10+08:00",

    "Object": "1.mp4",

    "Label": "Normal",

    "Result": 0,

    "SnapshotCount": 1,

    "PornInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "Snapshot": [

      {

        "Url": "https://video-1250000000.cos.ap-chongqing.myqcloud.com/test/0.jpg",

        "Text": "",

        "SnapshotTime": 41,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,
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          "Score": 0,

          "Label": "",

          "SubLabel": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Label": "",

          "SubLabel": ""

        }

      }

    ],

    "AudioSection": [

      {

        "Url": "https://audio-1250000000.cos.ap-guangzhou.myqcloud.com/0.mp3",

        "Text": "",

        "OffsetTime": 0,

        "Duration": 30000,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0

        }

      }

    ],

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}
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音频审核
提交音频审核任务
最近更新时间：2023-03-13 14:18:15

本接口用于提交一个音频审核任务。音频审核功能为异步任务方式，您可以通过提交音频审核任务审核您的音频文

件，然后通过 查询音频审核任务接口  或 音频审核回调  查询审核结果。

该接口支持情况如下：

功能描述

说明

支持审核腾讯云 COS 上的音频文件。

支持审核第三方云存储厂商的音频 URL。

支持对音频文件进行自动检测，从 ASR 语音文本识别、色情呻吟两个维度，通过深度学习技术识别音频中的违

规内容。

支持设置回调地址 Callback 获取检测结果，或通过 查询音频审核任务结果接口  主动轮询获取审核结果详情。

支持识别多种违规场景，包括：色情、广告等场景。

根据不同的业务场景 配置自定义的审核策略 。支持

费用说明

每个审核场景单独计费，例如您选择审核涉黄、广告两种场景，则审核1个音频，计2次审核费用。

调用接口会产生 音频审核费用  和 COS 读请求费用 。

如果音频属于 COS 上的低频存储类型，调用审核会产生 COS 低频数据取回费用 。

不支持审核 COS 上的归档存储类型和深度归档存储类型的音频，如果需要审核此类型音频，请先 恢复归档文

件 。

限制说明

音频文件大小支持：文件 < 600MB。

音频文件时长支持：**< 3小时**。

音频码率类型支持：128Kbps - 256Kbps。

音频文件支持格式：mp3、wav、aac、flac、amr、3gp、m4a、wma、ogg、ape。

音频文件内容语言支持：普通话、英语、粤语。

当输入为视频文件时，支持分离视频文件音轨，并对音频内容进行独立审核。

https://cloud.tencent.com/document/product/436/54064
https://cloud.tencent.com/document/product/436/60769
https://cloud.tencent.com/document/product/460/53396
https://cloud.tencent.com/document/product/460/56345
https://cloud.tencent.com/document/product/460/58119#.E9.9F.B3.E9.A2.91.E5.AE.A1.E6.A0.B8.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
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对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

具体的数据描述如下：

推荐使用 SDK

请求

请求示例

POST /audio/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Input>

        <Object></Object>

        <Url></Url>

        <DataId></DataId>

    </Input>

    <Conf>

        <Callback></Callback>

        <BizType></BizType>

    </Conf>

</Request>

https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

Container 节点 UserInfo 的内容：

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 音频审核的具体配置项。 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 需要审核的内容。 Container 是

Conf Request 审核规则配置。 Container 是

节点

名称

（关
键

字）

父节
点

描述
类
型

是

否
必

选

Obje

ct

Req
ues

t.In

put

存储在 COS 存储桶中的音频文件名称，例如在目录 test 中的文件 
audio.mp3，则文件名称为 test/audio.mp3。Object 和 Url 只能

选择其中一种。

St
ri

n

g

否

Url

Req
ues

t.In

put

音频文件的链接地址，例如 http://examplebucket-

1250000000.cos.ap-shanghai.myqcloud.com/audio.mp3。

Object  和 Url 只能选择其中一种。

St
ri

n

g

否

Data

Id

Req

ues

t.In

put

该字段在审核结果中会返回原始内容，长度限制为512字节。您可以使

用该字段对待审核的数据进行唯一业务标识。

St

ri

n

g

否

User

Info

Req

ues

t.In
put

用户业务字段。

C

o

nt

ai
n

er

否

节点名称（关

键字）
父节点 描述 类型

是否

必选

http://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/audio.mp3%E3%80%82Object
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Container 类型 Conf 的具体数据描述如下：

TokenId Request.Input.U

serInfo

用户业务 TokenId，长度不超过128字

节。

Stri

ng

否

Nickname
Request.Input.U

serInfo

用户业务 Nickname，长度不超过128

字节。

Stri

ng
否

DeviceId
Request.Input.U

serInfo

用户业务 DeviceId，长度不超过128字

节。

Stri

ng
否

AppId
Request.Input.U
serInfo

用户业务 AppId，长度不超过128字节。
Stri
ng

否

Room
Request.Input.U

serInfo
用户业务 Room，长度不超过128字节。

Stri

ng
否

IP
Request.Input.U

serInfo
用户业务 IP，长度不超过128字节。

Stri

ng
否

Type
Request.Input.U
serInfo

用户业务 Type，长度不超过128字节。
Stri
ng

否

ReceiveTok

enId

Request.Input.U

serInfo

用户业务 ReceiveTokenId，长度不超

过128字节。

Stri

ng
否

Gender
Request.Input.U

serInfo

用户业务 Gender，长度不超过128字

节。

Stri

ng
否

Level
Request.Input.U
serInfo

用户业务 Level，长度不超过128字节。
Stri
ng

否

Role
Request.Input.U

serInfo
用户业务 Role，长度不超过128字节。

Stri

ng
否

节
点

名

称

（
关

键

字

）

父

节
点

描述
类

型

是

否

必
选

B

iz

R

e

表示审核策略的唯一标识，您可以通过控制台上的审核策略页面，配置您希望审

核的场景，如色情、广告等，配置指引： 设置公共审核策略 。您可以在控制台

S

tr

否
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T
y

p

e

q
u

e

s

t.

C
o

n

f

上获取到 BizType。BizType 填写时，此条审核请求将按照该审核策略中配
置的场景进行审核。BizType 不填写时，将自动使用默认的审核策略。

in
g

C

al
lb

a

c

k

R

e

q

u
e

s

t.

C

o
n

f

审核结果以回调形式发送至您的回调地址，支持以 http://  或者 https://  开

头的地址，例如： http://www.callback.com 。

S
tr

in

g

否

C
al

lb

a

c
k

V

e

r

si
o

n

R
e

q

u

e
s

t.

C

o
n

f

回调内容的结构，有效值：Simple（回调内容包含基本信息）、Detail（回调

内容包含详细信息）。默认为 Simple。

s
tr

in

g

否

C
al

lb

a

c
k

T

y

p
e

R
e

q

u

e
s

t.

C

o
n

f

回调片段类型，有效值：1（回调全部音频片段）、2（回调违规音频片段）。
默认为 1。

I

n

t
e

g

e

r

否
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Container 类型 Freeze 的具体数据描述如下：

其他审核场景的冻结参数，请 联系服务人员 咨询。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

F

r
e

e

z

e

R

e
q

u

e

s
t.

C

o

n
f

可通过该字段，设置根据审核结果给出的不同分值，对音频文件进行自动冻结，

仅当 input 中审核的音频为 object 时有效。

C

o
n

t

ai

n
e

r

否

节点名

称（关

键字）

父节点 描述
类

型

是
否

必

选

PornS

core

Request.

Conf.Fre
eze

取值为[0,100]，表示当色情审核结果大于或等于该分数时，自

动进行冻结操作。不填写则表示不自动冻结，默认值为空。

I

n

t

e
g

e

r

否

AdsSc

ore

Request.

Conf.Fre

eze

取值为[0,100]，表示当广告审核结果大于或等于该分数时，自

动进行冻结操作。不填写则表示不自动冻结，默认值为空。

I
n

t

e

g
e

r

否

响应

响应头

响应体

https://cloud.tencent.com/online-service?from=ticket-tab
https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

<Response>

    <JobsDetail>

        <DataId></DataId>

        <JobId></JobId>

        <State></State>

        <CreationTime></CreationTime>

    </JobsDetail>

    <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 音频审核返回的具体响应内容。 Container

节点名称
（关键字）

父节点 描述 类型

JobsDeta

il

Resp

onse
音频审核任务的详细信息。

Cont

ainer

RequestI

d

Resp

onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题

时，该 ID 能更快地协助定位问题。

Strin

g

节点名

称（关

键字）

父节点 描述
类

型

DataI

d

Respons

e.JobsD

etail

请求中添加的唯一业务标识。

S

tr

in
g

JobId

Respons

e.JobsD
etail

本次音频审核任务的 ID。

S

tr

in
g

State Respons

e.JobsD

音频审核任务的状态，值为 Submitted（已提交审核）、Success

（审核成功）、Failed（审核失败）、Auditing（审核中）其中一个。

S

tr
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

etail in

g

Creati
onTim

e

Respons
e.JobsD

etail

音频审核任务的创建时间。

S
tr

in

g

错误码

实际案例

请求

POST /audio/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Input>

        <Object>a.mp3</Object>

        <DataId>123-fdrsg-123</DataID>

    </Input>

    <Conf>

        <BizType>b81d45f94xxxxxxxxa9506f45a11</BizType>

        <Callback>http://callback.com/</Callback>

    </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

https://cloud.tencent.com/document/product/460/42867
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        <DataId>123-fdrsg-123</DataID>

        <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

        <State>Submitted</State>

        <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    </JobsDetail>

    <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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查询音频审核任务结果
最近更新时间：2023-05-06 18:04:33

本接口用于查询一个音频审核任务的状态或结果。

对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能描述

说明

 音频审核任务结果保存时效为1个月，您可通过本接口查询近1个月的审核结果。

推荐使用 SDK

请求

请求示例

GET /audio/auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称 描述 类型 是否必选

jobId 要查询的任务ID，可通过提交审核任务的响应中获取。 String 是

https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

响应

响应头

响应体

<Response>

  <JobsDetail>

    <Code>Success</Code>

    <Message>Success</Message>

    <DataId></DataId>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <Object></Object>

    <Result>1</Result>

    <AudioText></AudioText>

    <PornInfo>

        <HitFlag></HitFlag>

        <Score></Score>

        <Label></Label>

    </PornInfo>

    <Section>

        <Url>https://cos.ap-guangzhou.myqcloud.com/0.mp3</Url>

          <OffsetTime>0</OffsetTime>

          <Duration>3000</Duration>

        <Text>哈哈哈</Text>

        <PornInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </PornInfo>

    </Section>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

Response 无 音频审核任务结果。 Container

节点名称

（关键字）
父节点 描述 类型

JobsDeta
il

Resp
onse

音频审核任务的详细信息。
Cont
ainer

RequestI

d

Resp

onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题

时，该 ID 能更快地协助定位问题。

Strin

g

节
点

名

称

（
关

键

字

）

父节

点
描述

类

型

Co

de

Res

pon

se.J

obs
Det

ail

错误码，只有 State 为 Failed 时返回。详情请查看 错误码列表 。

St

rin

g

M
es

sa

ge

Res

pon
se.J

obs

Det

ail

错误描述，只有 State 为 Failed 时返回。

St

rin

g

Da

taI
d

Res

pon

se.J
obs

Det

ail

该字段在审核结果中会返回原始内容，长度限制为512字节。您可以使用该字段
对待审核的数据进行唯一业务标识。

St

rin
g

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Jo

bI

d

Res

pon

se.J

obs
Det

ail

本次音频审核任务的 ID。 St

rin

g

St

at

e

Res

pon
se.J

obs

Det

ail

音频审核任务的状态，值为 Submitted（已提交审核）、Success（审核成

功）、Failed（审核失败）、Auditing（审核中）其中一个。

St

rin

g

Cr

ea

tio
nT

im

e

Res

pon

se.J
obs

Det

ail

音频审核任务的创建时间。

St

rin
g

Ob

jec

t

Res
pon

se.J

obs

Det
ail

审核的音频文件为存储在 COS 中的文件时，该字段表示本次审核的音频文件名

称。

St

rin

g

Url

Res

pon

se.J
obs

Det

ail

审核的音频文件为一条文件链接时，该字段表示本次审核的音频文件链接。
St
rin

g

La

bel

Res

pon

se.J

obs
Det

ail

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审

核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：

Normal：正常，Porn：色情，Ads：广告，以及其他不安全或不适宜的类型。

St

rin

g

Re

sul
t

Res

pon
se.J

obs

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您

按照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 
（判定为违规敏感文件），2（疑似敏感，建议人工复核）。

Int

eg
er
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Det
ail

Au

di
oT

ex

t

Res

pon
se.J

obs

Det

ail

该字段用于返回音频文件中已识别的对应文本内容。
St
rin

g

Po

rnI

nf
o

Res

pon

se.J

obs
Det

ail

审核场景为色情的审核结果信息。

Co

nt

ai

ne
r

Ad

sIn

fo

Res
pon

se.J

obs

Det

ail

审核场景为广告的审核结果信息。

Co
nt

ai

ne

r

Se
cti

on

Res

pon
se.J

obs

Det

ail

当音频过长时，会对音频进行分段，该字段用于返回音频片段的审核结果，主要

包括开始时间和音频审核的相应结果。

Co

nt

ai
ne

r 

Ar

ra
y

Us

erI
nf

o

Res

pon

se.J
obs

Det

ail

用户业务字段。创建任务未设置 UserInfo 时无此字段。

Co

nt
ai

ne

r

Lis

tIn

fo

Res

pon

se.J

obs

Det
ail

账号黑白名单结果。

Co

nt

ai

ne
r
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Container 节点 PornInfo，AdsInfo 的内容：

Fo

rbi
dS

tat

e

Res

pon
se.J

obs

Det

ail

若您设置了自动冻结，该字段表示音频文件的冻结状态。0：未冻结，1：已被冻

结，2：已转移文件。

Int

eg
er

节点
名称

（关

键

字）

父节点 描述
类

型

Hit

Fla
g

Respon

se.Jobs
Detail.*I

nfo

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的
违规内容。2：疑似为当前场景的违规内容。

I

n

t

e
g

e

r

Sc

ore

Respon

se.Jobs

Detail.*I
nfo

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最

低）-100（置信度最高 ），越高代表该内容越有可能属于当前返回审核信

息。例如：色情 99，表明该内容非常有可能属于色情内容。

I

n

t

e

g
e

r

Lab

el

Respon
se.Jobs

Detail.*I

nfo

本次审核的综合结果标签，如果命中了敏感的关键词，该字段返回对应的关键

词。

S
tr

in

g

Cat

ego

ry

Respon

se.Jobs

Detail.*I

nfo

该字段表示审核命中的具体审核类别。注意：该字段可能返回空。

S

tr

in

g

Su

bLa

bel

Respon

se.Jobs

Detail.*I

nfo

该字段表示审核命中的具体子标签。注意：该字段可能返回空。

S

tr

in

g
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Container 节点 Section 的内容：

节
点

名

称

（
关

键

字

）

父节点 描述
类
型

Ur

l

Respo

nse.Jo

bsDeta
il.Secti

on

当前音频片段的访问地址，您可以通过该地址获取该音频片段的内容，地址格

式为标准 URL 格式。注意：每次查看数据的有效期为2小时，2小时后如还需
查看，请重新发起查询请求。

S

tr

in
g

Te

xt

Respo

nse.Jo
bsDeta

il.Secti

on

该字段用于返回当前音频片段的 ASR 文本识别的检测结果。

S
tr

in

g

Of

fs

et

Ti
m

e

Respo

nse.Jo

bsDeta

il.Secti
on

该字段用于返回当前音频片段位于总音频中的时间，单位为毫秒，例如5000

（音频开始后5000毫秒）。

I

n

t

e

g
e

r

D

ur

ati

on

Respo

nse.Jo

bsDeta

il.Secti
on

当前音频片段的时长，单位毫秒。

I
n

t

e

g
e

r

La
be

l

Respo

nse.Jo
bsDeta

il.Secti

on

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的
审核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回

值：Normal：正常，Porn：色情，Ads：广告，以及其他不安全或不适宜的

类型。

S
tr

in

g
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Container 节点 PornInfo，AdsInfo 的内容：

Su

bL

ab

el

Respo

nse.Jo

bsDeta

il

该字段表示审核命中的具体子标签。注意：该字段可能返回空。 S

tr

in

g

Re
su

lt

Respo

nse.Jo
bsDeta

il.Secti

on

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议
您按照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），

1 （判定为违规敏感文件），2（疑似敏感，建议人工复核）。

I

n

t
e

g

e

r

Po

rnI
nf

o

Respo

nse.Jo
bsDeta

il.Secti

on

审核场景为色情的审核结果信息。

C

o

n

t
ai

n

e

r

Ad
sI

nf

o

Respo

nse.Jo
bsDeta

il.Secti

on

审核场景为广告的审核结果信息。

C

o

n
t

ai

n

e

r

节
点

名

称

（
关

键

字

）

父节点 描述
类

型

Hit

Fla

g

Response

.JobsDeta

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场

景的违规内容。2：疑似为当前场景的违规内容。

Int

eg

er
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Container 节点 LibResults 的内容：

Container 节点 UserInfo 的内容：

il.Section.

*Info

Sc
ore

Response

.JobsDeta
il.Section.

*Info

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最
低）-100（置信度最高 ），越高代表该内容越有可能属于当前返回审核

信息。例如：色情 99，表明该内容非常有可能属于色情内容。

Int
eg

er

Ca
teg

ory

Response
.JobsDeta

il.Section.

*Info

该字段为 Label  的子集，表示审核命中的具体审核类别。例如 Sexy，

表示色情标签中的性感类别。

Str

ing

Ke
yw

ord

s

Response
.JobsDeta

il.Section.

*Info

本次审核命中的敏感关键词，没有时不返回。

Str
ing 

Arr

ay

Lib

Re

sul
ts

Response

.JobsDeta

il.Section.
*Info

该字段用于返回基于风险库识别的结果。注意：未命中风险库中样本时，

此字段不返回。

Co

nta

ine

r 
Arr

ay

节点名称

（关键

字）

父节点 描述 类型

LibType
Response.JobsDetail.Sec

tion.*Info.LibResults

命中的风险库类型，取值为1（预设风险

库）和2（自定义风险库）。

Integ

er

LibNam
e

Response.JobsDetail.Sec
tion.*Info.LibResults

命中的风险库名称。
Strin
g

Keywor

ds

Response.JobsDetail.Sec

tion.*Info.LibResults

命中的库中关键词。该参数可能会有多个返

回值，代表命中的多个关键词。

Strin

g 

Array

节点名称（关键
字）

描述 类型
是否必
选

TokenId 一般用于表示账号信息，长度不超过128字节。 Strin 否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

g

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin
g

否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin

g
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin
g

否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否

ReceiveTokenI

d

一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin
g

否

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节点名称（关键

字）
父节点 描述 类型

ListResults
Response.JobsDetail.ListIn

fo

命中的所有名单结

果。

Container 

Array

节点名称（关

键字）
父节点 描述 类型

ListType
Response.JobsDetail.ListInf
o.ListResults

命中的名单类型，取值为0（白名单）
和1（黑名单）。

Inte
ger
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

ListName Response.JobsDetail.ListInf

o.ListResults

命中的名单名称。 Stri

ng

Entity
Response.JobsDetail.ListInf

o.ListResults
命中了名单中的哪条内容。

Stri

ng

错误码

实际案例

请求

GET /audio/auditing/vab1ca9fc8a3ed11ea834c525400863904 HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <JobId>aab1ca9fc8a3ed11ea834c525400863904</JobId>

    <State>Success</State>

    <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    <Object>a.mp3</Object>

    <Result>1</Result>

    <AudioText>wc xx</AudioText>

    <PornInfo>

        <HitFlag>1</HitFlag>

        <Score>91</Score>

        <Label>xx</Label>

    </PornInfo>

    <AdsInfo>

        <HitFlag>0</HitFlag>

        <Score>0</Score>

https://cloud.tencent.com/document/product/460/42867
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        <Label></Label>

    </AdsInfo>

    <Section>

        <AdsInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

        </AdsInfo>

        <Duration>30000</Duration>

        <OffsetTime>0</OffsetTime>

        <PornInfo>

            <HitFlag>1</HitFlag>

            <Score>91</Score>

            <Keywords>xx</Keywords>

            <Keywords>wc</Keywords>

        </PornInfo>

        <Text>wc xx</Text>

        <Url>https://auditing-1250000000.cos.ap-guangzhou.myqcloud.com/q9MhdztF/0.m

    </Section>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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音频审核回调内容
最近更新时间：2023-01-10 15:24:45

若您配置了审核回调地址，在音频审核结束后，后台会将审核结果以 json 形式回调至您的回调地址。您可以通过回

调内容，进行后续的文件处理操作。

回调内容分为简洁回调（Simple）和详细回调（Detail）。

功能描述



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1349 共1701页

回调内容说明

简洁回调（Simple）

{

   "code": 0,

   "data": {
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具体的数据内容如下：

data的具体内容如下：

       "event":"RviewAudio",

       "forbidden_status": 0,

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "score": 9

       },

       "result": 0,

       "trace_id": "test_trace_id",

       "url": "test_audio",

       "cos_headers": {

           "x-cos-meta-xx": "xx"

       }

   },

   "message": "Test request when setting callback url"

}

参数名

称
描述 类型

是否必

选

code
错误码，值为0时表示审核成功，非0表示审核失败。详情请查看 内容

审核错误码 。

Integ

er
是

messa

ge
错误描述。

Strin

g
是

data 音频审核结果的详细信息。
Obje

ct
是

参数
名称

描述
类
型

是

否
必

选

trac
e_id

请求的 ID，如果是接口创建的异步任务，则为接口返回的 JobId。

S

tr
in

g

是

url 被审核音频的完整 URL 链接。 S
tr

是

https://cloud.tencent.com/document/product/460/8523#.E5.86.85.E5.AE.B9.E5.AE.A1.E6.A0.B8.E9.94.99.E8.AF.AF.E7.A0.81
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in

g

eve

nt
触发的事件，此处固定为 ReviewAudio。

S

tr

in

g

是

res
ult

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照
业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为

违规敏感文件），2（疑似敏感，建议人工复核）。

I

n

t
e

g

e

r

是

forb

idde

n_s
tatu

s

若您设置了自动冻结，该字段表示音频的冻结状态。0：未冻结，1：已被冻结，2：
已转移文件。

I

n

t

e
g

e

r

是

cos

_he

ade

rs

资源上传时设置的自定义 header 内容，如果未设置则不返回。

O

bj

e

c
t

否

por

n_in
fo

审核场景为涉黄的审核结果信息。

O

bj

e
c

t

否

ads

_inf

o

审核场景为广告引导的审核结果信息。

O
bj

e

c

t

否

dat

a_id
提交任务时设置了 DataId 参数时返回，返回原始内容，长度限制为512字节。

S

tr

in

g

否
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xx_info 的具体内容如下：

回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Detail  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

参
数

名

称

描述
类

型

是
否

必

选

hi

t

_

fl
a

g

是否命中该审核分类，0表示未命中，1表示命中，2表示疑似。

I

n

t

e

g
e

r

是

s

c

o

r
e

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信

度最高 ），越高代表该内容越有可能属于当前返回审核信息。例如：色情 99，表明该

内容非常有可能属于色情内容。

I
n

t

e

g
e

r

是

la
b

el

本次审核的结果标签，如果命中了敏感的关键词，该字段返回对应的关键词。

S

tr
in

g

是

详细回调（Detail）

{

  "EventName": "ReviewAudio",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "",

    "Object": "",

    "Label": "Normal",

    "Result": 0,

    "AudioText": "       ",

    "PornInfo": {

      "HitFlag": 0,
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具体的数据内容如下：

JobsDetail 的具体内容如下：

      "Score": 0,

      "Label": ""

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Score": 0,

      "Label": ""

    },

    "Section": [

      {

        "Url": "",

        "Text": "",

        "OffsetTime": 0,

        "Duration": 30000,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0

        }

      }

    ],

    "BucketId": "",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}

节点名称（关键字） 描述 类型

JobsDetail 任务的详细结果信息 Object

EventName 任务的类型，为 ReviewAudio String
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节点名
称（关

键字）

描述 类
型

Code 错误码，只有 State为 Failed 时返回。详情请查看 错误码列表 。
Str
ing

Mess

age
错误描述，只有 State 为 Failed 时返回。

Str

ing

JobId 本次音频审核任务的 ID。
Str

ing

DataI
d

提交任务时设置了 DataId 参数时返回，返回原始内容，长度限制为512字节。
Str
ing

State
音频审核任务的状态，值为 Submitted（已提交审核）、Success（审核成功）、

Failed（审核失败）、Auditing（审核中）其中一个。

Str

ing

Creati

onTim

e

音频审核任务的创建时间。
Str

ing

Objec

t
本次审核的音频文件名称，创建任务使用 Object 时返回。

Str

ing

Url 本次审核的音频文件链接，创建任务使用 Url 时返回。
Str

ing

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结

果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：Normal：正

常，Porn：色情，Ads：广告。

Str

ing

SubL

abel
该字段表示审核命中的具体子标签。注意：该字段可能返回空。

Str

ing

Resul

t

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业
务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规敏

感文件），2（疑似敏感，建议人工复核）。

Int
eg

er

Audio
Text

该字段用于返回音频文件识别出的对应文本内容。
Str
ing

PornI

nfo
审核场景为涉黄的审核结果信息。

Ob

jec

t

AdsIn 审核场景为广告引导的审核结果信息。 Ob

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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PornInfo，AdsInfo 的具体内容如下：

fo jec
t

Secti

on

当音频过长时，会对音频进行分段，该字段用于返回音频片段的审核结果，主要包括开

始时间和音频审核的相应结果。

Arr

ay

Buck

etId
创建的音频审核任务所属的存储桶名称。

Str

ing

Regio

n
存储桶所在的地域。

Str

ing

Forbi

dStat

e

若您设置了自动冻结，该字段表示音频的冻结状态。0：未冻结，1：已被冻结，2：已

转移文件。

Int

eg

er

CosH

eader

s

资源上传到 COS 时设置的自定义 Header 内容，如果未设置则不返回。map 结构，

key 为自定义 Header 的名称，value 为内容。

Ob

jec

t

UserI

nfo
用户业务字段，创建任务未设置 UserInfo 时无此字段。

Ob

jec

t

ListInf

o
账号黑白名单结果。

Ob

jec

t

节点名称

（关键字）
描述 类型

HitFlag
用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规

内容。2：疑似为当前场景的违规内容。

Int

ege

r

Score 本次审核的结果分数，分数越高表示越敏感。

Int

ege

r

Category 该字段表示审核命中的具体审核类别。注意：该字段可能返回空。
Stri

ng

SubLabel 该字段表示审核命中的具体子标签。注意：该字段可能返回空。
Stri

ng

Label 本次审核的综合结果标签，如果命中了敏感关键词，该字段返回对应的关键词。 Stri
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Section 的具体内容如下：

Section 中的 PornInfo，AdsInfo 的具体内容如下：

ng

节点名

称（关
键字）

描述
类

型

Url

当前音频片段的访问地址，您可以通过该地址获取该音频片段的内容，地址格式为标准 

URL 格式。

注意：每次查看数据的有效期为2小时，2小时后如还需查看，请发起查询请求。

Str

ing

Text 该字段用于返回当前音频片段的 ASR 文本识别的检测结果。
Str

ing

Offset

Time

该字段用于返回当前音频片段位于总音频中的时间，单位为毫秒，例如5000（音频开始

后5000毫秒）。

Int
eg

er

Durati
on

当前音频片段的时长，单位毫秒。
Int
eg

er

Label
该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结
果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：Normal：正

常，Porn：色情，Ads：广告。

Str
ing

SubL

abel
该字段表示审核命中的具体子标签。注意：该字段可能返回空。

Str

ing

Resul

t

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业

务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规敏

感文件），2（疑似敏感，建议人工复核）。

Int

eg

er

PornI

nfo
审核场景为涉黄的审核结果信息。

Ob

jec

t

AdsIn

fo
审核场景为广告引导的审核结果信息。

Ob

jec

t

节点

名称
（关

描述 类型
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Container 节点 LibResults 的内容：

UserInfo 的内容：

键

字）

HitFl

ag

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内容。

2：疑似为当前场景的违规内容。

Inte

ger

Scor
e

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信

度最高 ），越高代表该内容越有可能属于当前返回审核信息。例如：色情99，表明该内
容非常有可能属于色情内容。

Inte
ger

Cate

gory

表示命中的具体审核类别。例如 Sexy，表示色情标签中的性感类别。该字段可能为

空，表示未命中或暂无相关的类别。

Stri

ng

Key

wor

ds

本次审核命中的敏感关键词，没有时不返回。
Arra

y

LibR

esul

ts

该字段用于返回基于风险库识别的结果。

注意：未命中风险库中样本时，此字段不返回。

Con

tain

er 

Arra
y

节点名称（关键

字）
描述 类型

LibType
命中的风险库类型，取值为1（预设黑白库）和2（自定义风险

库）。
Integer

LibName 命中的风险库名称。 String

Keywords
命中的库中关键词。该参数可能会有多个返回值，代表命中的多个关
键词。

String 
Array

节点名称（关键

字）
描述 类型

是否必

选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin

g
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

DeviceId 一般用于表示设备信息，长度不超过128字节。 Strin

g

否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin
g

否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin

g
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin

g
否

Type 一般用于表示业务类型，长度不超过128字节。
Strin
g

否

ReceiveTokenI

d

一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin

g
否

Level 一般用于表示等级信息，长度不超过128字节。
Strin
g

否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节点名称（关键字） 描述 类型

ListResults 命中的所有名单结果。 Container Array

节点名称（关键字） 描述 类型

ListType 命中的名单类型，取值为0（白名单）和1（黑名单）。 Integer

ListName 命中的名单名称。 String

Entity 命中了名单中的哪条内容。 String

实际案例

案例一：简洁回调（Simple）
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{

   "code": 0,

   "data": {

       "event":"ReviewAudio",

       "forbidden_status": 0,

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "score": 9

       },

       "result": 0,

       "trace_id": "ixzt90jl2dfscxxxxxxxxxxxxxxxxx",

       "url": "https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/music.mp

       "cos_headers": {

           "x-cos-meta-id": "666666"

       }

   },

   "message": "success"

}

案例二：详细回调（Detail）

{

  "EventName": "ReviewAudio",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "2021-08-10T21:01:08+08:00",

    "Object": "1.mp3",

    "Result": 0,

    "AudioText": "       ",

    "PornInfo": {

      "HitFlag": 0,

      "Score": 0,

      "Label": ""

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Score": 0,

      "Label": ""

    },

    "Section": [

      {

        "Url": "https://audio-1250000000.cos.ap-guangzhou.myqcloud.com/0.mp3",
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        "Text": "",

        "OffsetTime": 0,

        "Duration": 30000,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0

        }

      }

    ],

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}
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文本审核
文本文件审核
最近更新时间：2023-03-13 14:10:48

本接口用于进行文本文件审核，为异步请求方式，您可以通过本接口提交审核任务，然后通过查询文本审核任务接口

查询审核结果。

该接口支持情况如下：

数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

功能描述

说明

支持审核腾讯云 COS 上的文本文件（仅支持 UTF8 编码和 GBK 编码的内容）。

支持审核第三方云存储厂商的文本文件 URL（仅支持 UTF8 编码和 GBK 编码的内容）。

支持设置回调地址 Callback 获取检测结果，或通过 查询文本审核任务结果接口  主动轮询获取审核结

果详情。

支持识别多种违规场景，包括：色情、违法、广告等场景。

支持根据不同的业务场景 配置自定义的审核策略 。

费用说明

每个审核场景单独计费，例如您选择审核色情、广告两种场景，则审核1个文本，计2次审核费用。

调用接口会产生 文本审核费用  和 COS 读请求费用 。

如果文本属于 COS 上的低频存储类型，调用审核会产生 COS 低频数据取回费用 。

不支持审核 COS 上的归档存储类型和深度归档存储类型的文本，如果需要审核此类型文本，请先 恢复归档文

件 。

限制说明

大小限制：文件不能超过1MB。

文件格式限制：无后缀限制，文件的内容需要是 UTF8 编码和 GBK 编码的。

字数限制：每 10000 个字符算一次，超出部分按多条计费。

语言支持：目前支持中文、中英混合、阿拉伯数字的检测。

推荐使用 SDK

https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/56284
https://cloud.tencent.com/document/product/460/56345
https://cloud.tencent.com/document/product/460/58119#.E6.96.87.E6.9C.AC.E5.AE.A1.E6.A0.B8.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

具体的数据描述如下：

请求

请求示例

POST /text/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

  <Input>

    <Object></Object>

    <Url></Url>

    <DataId></DataId>

  </Input>

  <Conf>

    <Callback></Callback>

    <CallbackVersion></CallbackVersion>

    <CallbackType></CallbackType>

    <BizType></BizType>

    <Freeze>

      <PornScore></PornScore>

    </Freeze>

  </Conf>

</Request>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 文本审核的具体配置项。 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 需要审核的内容。 Container 是

Conf Request 审核规则配置。 Container 是

节点

名称

（关
键

字）

父

节
点

描述
类
型

是

否
必

选

Obj

ect

Re
qu

est

.In

put

当前 COS 存储桶中的文本文件名称，例如在目录 test 中的文件 

test.txt，则文件名称为 test/test.txt，文本文件仅支持 UTF8 编码和 

GBK 编码的内容，且文件大小不得超过1MB。

S
tr

in

g

否

Url

Re

qu

est

.In
put

文本文件的完整链接，例如： https://www.test.com/test.txt 。

S

tr

in

g

否

Dat
aId

Re

qu

est
.In

put

该字段在审核结果中会返回原始内容，长度限制为512字节。您可以使用该
字段对待审核的数据进行唯一业务标识。

S

tr
in

g

否

Use

rInf

o

Re

qu

est

.In
put

用户业务字段。

C
o

n

t

ai
n

e

r

否
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Container 节点 UserInfo 的内容：

Container 类型 Conf 的具体数据描述如下：

节点名称（关键

字）
描述 类型

是否必

选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin

g
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin

g
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin

g
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin

g
否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否

ReceiveTokenI

d

一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin

g
否

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节
点

名

称

（
关

键

父
节

点

描述 类
型

是
否

必

选
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字

）

B
iz

T

y

p
e

R

e

q
u

e

s

t.

C
o

n

f

表示审核策略的唯一标识，您可以通过控制台上的审核策略页面，配置您希望审

核的场景，如色情、广告、违法等，配置指引： 设置公共审核策略 。您可以在

控制台上获取到 BizType。BizType 填写时，此条审核请求将按照该审核策

略中配置的场景进行审核。BizType 不填写时，将自动使用默认的审核策略。

S

tr

in

g

否

C

al
lb

a

c

k

R

e

q

u
e

s

t.

C
o

n

f

审核结果可以回调形式发送至您的回调地址，支持以 http://  或者 https://  

开头的地址，例如： http://www.callback.com 。当 Input 使用 Content 

时，该参数不生效，结果会直接返回。

S
tr

in

g

否

C
al

lb

a

c
k

V

e

r
si

o

n

R

e

q

u

e
s

t.

C

o
n

f

回调内容的结构，有效值：Simple（回调内容包含基本信息）、Detail（回调

内容包含详细信息）。默认为 Simple。

S
tr

in

g

否

C
al

lb

a

c
k

R
e

q

u

e
s

回调片段类型，有效值：1（回调全部文本片段）、2（回调违规文本片段）。
默认为 1。

I
n

t

e

g

否
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Container 类型 Freeze 的具体数据描述如下：

T

y

p
e

t.

C

o
n

f

e

r

F

r

e
e

z

e

R
e

q

u

e
s

t.

C

o

n
f

可通过该字段，设置根据审核结果给出的不同分值，对文本文件进行自动冻结，

仅当 input  中审核的文本为 object  时有效。

C

o

n

t
ai

n

e

r

否

节点名

称（关

键字）

父节点 描述
类

型

是

否

必

选

PornS
core

Request.
Conf.Fre

eze

取值为[0,100]，表示当色情审核结果大于或等于该分数时，自
动进行冻结操作。不填写则表示不自动冻结，默认值为空。

I

n

t
e

g

e

r

否

AdsSc

ore

Request.

Conf.Fre
eze

取值为[0,100]，表示当广告审核结果大于或等于该分数时，自

动进行冻结操作。不填写则表示不自动冻结，默认值为空。

I

n

t

e
g

e

r

否

Illegal
Score

Request.
Conf.Fre

eze

取值为[0,100]，表示当违法审核结果大于或等于该分数时，自
动进行冻结操作。不填写则表示不自动冻结，默认值为空。

I
n

t

e

g

否
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其他审核场景的冻结参数，请 联系服务人员 咨询。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

e

r

Abuse

Score

Request.

Conf.Fre

eze

取值为[0,100]，表示当谩骂审核结果大于或等于该分数时，自

动进行冻结操作。不填写则表示不自动冻结，默认值为空。

I
n

t

e

g
e

r

否

响应

响应头

响应体

<Response>

  <JobsDetail>

    <DataId></DataId>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 文本审核返回的具体响应内容。 Container

节点名称
（关键字）

父节点 描述 类型

JobsDeta

il

Resp

onse

文本审核任务的详细信息。 Cont

ainer

https://cloud.tencent.com/online-service?from=ticket-tab
https://cloud.tencent.com/document/product/460/42866
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Container 节点 JobsDetail 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

RequestI

d

Resp

onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题

时，该 ID 能更快地协助定位问题。

Strin

g

节点名称

（关键

字）

父节点 描述
类

型

DataId

Respons

e.JobsD

etail

请求中添加的唯一业务标识。

St

ri

n

g

JobId

Respons

e.JobsD

etail

本次文本审核任务的 ID。

St

ri

n
g

State

Respons

e.JobsD
etail

文本审核任务的状态，值为 Submitted（已提交审核）、Success

（审核成功）、Failed（审核失败）、Auditing（审核中）其中一
个。

St

ri
n

g

Creatio
nTime

Respons
e.JobsD

etail

文本审核任务的创建时间。

St

ri
n

g

错误码

实际案例

请求

POST /text/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

  <Input>

https://cloud.tencent.com/document/product/460/42867
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    <Object>a.txt</Object>

    <DataId>123-fdrsg-123</DataID>

  </Input>

  <Conf>

    <Callback>http://callback.com/</Callback>

    <BizType>b81d45f94b91a683255e9a9506f45a11</BizType>

  </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

     <DataId>123-fdrsg-123</DataID>

     <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

     <State>Submitted</State>

     <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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文本内容审核
最近更新时间：2023-03-13 14:10:53

本接口用于进行文本内容的直接审核，请求方式为同步请求。

该接口的支持情况如下：

数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

功能描述

说明

直接审核纯文本信息，需要先经过 base64 编码（仅支持 UTF8 编码）。

支持识别多种违规场景，包括：色情、违法、广告等场景。

支持根据不同的业务场景 配置自定义的审核策略 。

费用说明

每个审核场景单独计费，例如您选择审核色情、广告两种场景，则审核1条文本，计2次审核费用。

限制说明

长度限制：当审核的内容为纯文本信息，需要先经过 base64 编码，文本编码前的原文长度不能超过10000个 

UTF8 编码字符。

文本审核语言支持：目前支持中文、中英混合、阿拉伯数字的检测。

推荐使用 SDK

请求

请求示例

POST /text/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/56345
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

  <Input>

    <Content></Content>

    <DataId></DataId>

  </Input>

  <Conf>

    <Callback></Callback>

    <CallbackVersion></CallbackVersion>

    <CallbackType></CallbackType>

    <BizType></BizType>

    <Freeze>

      <PornScore></PornScore>

    </Freeze>

  </Conf>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 文本审核的具体配置项。 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 需要审核的内容。 Container 是

Conf Request 审核规则配置。 Container 是

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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Container 节点 UserInfo 的内容：

节点名

称（关

键字）

父节

点

描述 类

型

是

否

必

选

Cont

ent

Req

uest

.Inp
ut

当传入的内容为纯文本信息，需要先经过 base64 编码，文本编码前

的原文长度不能超过 10000 个 UTF8 编码字符。若超出长度限制，

接口将会报错。
注：目前支持中文、中英混合、阿拉伯数字的检测与审核。如有其他语

言需要，请 联系我们 。

St

ri

n
g

否

DataI
d

Req

uest
.Inp

ut

该字段在审核结果中会返回原始内容，长度限制为512字节。您可以使
用该字段对待审核的数据进行唯一业务标识。

St

ri
n

g

否

UserI

nfo

Req

uest

.Inp

ut

用户业务字段。

C
o

nt

ai

n
er

否

节点名称（关键
字）

描述 类型
是否必
选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin

g
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin
g

否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin

g
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin
g

否

Type 一般用于表示业务类型，长度不超过128字节。 Strin 否

https://console.cloud.tencent.com/workorder/category?level1_id=83&level2_id=86&source=14&data_title=%E6%95%B0%E6%8D%AE%E4%B8%87%E8%B1%A1%20CI&step=1
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Container 类型 Conf 的具体数据描述如下：

g

ReceiveTokenI

d

一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin

g
否

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节

点
名

称

（

关
键

字

）

父

节

点

描述
类

型

是

否

必

选

B

iz

T
y

p

e

R
e

q

u

e
s

t.

C

o
n

f

表示审核策略的唯一标识，您可以通过控制台上的审核策略页面，配置您希望审

核的场景，如色情、广告、违法等，配置指引： 设置公共审核策略 。您可以在
控制台上获取到 BizType。BizType 填写时，此条审核请求将按照该审核策

略中配置的场景进行审核。BizType 不填写时，将自动使用默认的审核策略。

S

tr
in

g

否

C

al
lb

a

c

k

R

e
q

u

e

s
t.

C

审核结果可以回调形式发送至您的回调地址，支持以 http://  或者 https://  

开头的地址，例如： http://www.callback.com 。当 Input 使用 Content 

时，该参数不生效，结果会直接返回。

S

tr
in

g

否



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1374 共1701页

Container 类型 Freeze 的具体数据描述如下：

o
n

f

C

al
lb

a

c

k
V

e

r

si
o

n

R
e

q

u

e

s
t.

C

o

n
f

回调内容的结构，有效值：Simple（回调内容包含基本信息）、Detail（回调
内容包含详细信息）。默认为 Simple。

S

tr
in

g

否

C
al

lb

a

c

k
T

y

p

e

R

e
q

u

e

s
t.

C

o

n
f

回调片段类型，有效值：1（回调全部文本片段）、2（回调违规文本片段）。

默认为 1。

I

n

t

e
g

e

r

否

F

r

e

e
z

e

R

e

q
u

e

s

t.
C

o

n

f

可通过该字段，设置根据审核结果给出的不同分值，对文本文件进行自动冻结，

仅当 input  中审核的文本为 object 时有效。

C
o

n

t

ai
n

e

r

否

节点名
称（关

键字）

父节点 描述 类
型

是
否
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其他审核场景的冻结参数，请 联系服务人员 咨询。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

必

选

PornS
core

Request.

Conf.Fre
eze

取值为[0,100]，表示当色情审核结果大于或等于该分数时，自
动进行冻结操作。不填写则表示不自动冻结，默认值为空。

I

n

t

e
g

e

r

否

AdsSc

ore

Request.

Conf.Fre
eze

取值为[0,100]，表示当广告审核结果大于或等于该分数时，自

动进行冻结操作。不填写则表示不自动冻结，默认值为空。

I

n

t

e
g

e

r

否

Illegal

Score

Request.

Conf.Fre

eze

取值为[0,100]，表示当违法审核结果大于或等于该分数时，自

动进行冻结操作。不填写则表示不自动冻结，默认值为空。

I
n

t

e

g
e

r

否

Abuse

Score

Request.

Conf.Fre

eze

取值为[0,100]，表示当谩骂审核结果大于或等于该分数时，自

动进行冻结操作。不填写则表示不自动冻结，默认值为空。

I

n
t

e

g

e
r

否

响应

响应头

响应体

https://cloud.tencent.com/online-service?from=ticket-tab
https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

<Response>

  <JobsDetail>

    <DataId></DataId>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <Code>Success</Code>

    <Message>Success</Message>

    <SectionCount></SectionCount>

    <Result>1</Result>

    <PornInfo>

      <HitFlag></HitFlag>

      <Count></Count>

    </PornInfo>

    <Section>

      <StartByte></StartByte>

      <PornInfo>

        <HitFlag></HitFlag>

        <Score></Score>

        <Keywords></Keywords>

      </PornInfo>

    </Section>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 文本审核返回的具体响应内容。 Container

节点名称

（关键字）
父节点 描述 类型

JobsDeta

il

Resp

onse
文本审核的详细信息。

Cont

ainer

RequestI
d

Resp
onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题
时，该 ID 能更快地协助定位问题。

Strin
g
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节

点

名

称
（

关

键

字
）

父节

点

描述 类

型

Co
de

Res

pon

se.J
obs

Det

ail

错误码，只有 State 为 Failed 时返回，详情请查看 错误码列表 。
St
rin

g

Da

taI

d

Res

pon

se.J

obs
Det

ail

请求中添加的唯一业务标识。

St

rin

g

M
es

sa

ge

Res

pon
se.J

obs

Det

ail

错误描述，只有 State 为 Failed 时返回。

St

rin

g

Jo

bI
d

Res

pon

se.J
obs

Det

ail

本次文本审核的任务ID。

St

rin
g

Cr
ea

tio

nT

im
e

Res
pon

se.J

obs

Det
ail

文本审核的创建时间。

St

rin

g

St Res 文本审核的状态，值为 Success（审核成功）或者 Failed（审核失败）。 St

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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at
e

pon
se.J

obs

Det

ail

rin
g

Co

nt
en

t

Res

pon

se.J
obs

Det

ail

文本内容的 Base64 编码。

St

rin
g

La

bel

Res
pon

se.J

obs

Det
ail

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审

核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：

Normal：正常，Porn：色情，Ads：广告，以及其他不安全或不适宜的类型。

St

rin

g

Re
sul

t

Res

pon
se.J

obs

Det

ail

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您
按照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 

（判定为违规敏感文件），2（疑似敏感，建议人工复核）。

Int
eg

er

Se

cti

on

Co
un

t

Res

pon

se.J

obs
Det

ail

审核的文本内容分片数，固定为1。

Int

eg

er

Po
rnI

nf

o

Res

pon
se.J

obs

Det

ail

审核场景为色情的审核结果信息。

Co
nt

ai

ne

r

Ad

sIn

fo

Res

pon

se.J
obs

Det

ail

审核场景为广告的审核结果信息。 Co

nt

ai
ne

r
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Container 节点 PornInfo，AdsInfo，IllegalInfo，AbuseInfo 的内容：

Ille

gal

Inf

o

Res
pon

se.J

obs

Det
ail

审核场景为违法的审核结果信息。

Co

nt

ai

ne

r

Ab

us
eI

nf

o

Res

pon
se.J

obs

Det

ail

审核场景为谩骂的审核结果信息。

Co

nt
ai

ne

r

Se

cti
on

Res

pon

se.J
obs

Det

ail

文本审核的具体结果信息。

Co

nt

ai

ne
r 

Ar

ra

y

Us

erI

nf
o

Res

pon

se.J

obs
Det

ail

用户业务字段。

Co

nt

ai
ne

r

Lis

tIn

fo

Res
pon

se.J

obs

Det
ail

账号黑白名单结果。

Co
nt

ai

ne

r

节点名称
（关键

字）

父节点 描述
类

型

HitFlag Response.Jo
bsDetail.*Inf

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为
当前场景的违规内容。2：疑似为当前场景的违规内容。

In
te
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Container 节点 Section 的内容：

o g

er

Count

Response.Jo

bsDetail.*Inf

o

命中该审核分类的分片数。

In

te

g

er

节
点

名

称

（
关

键

字

）

父节点 描述
类

型

St

ar

tB
yt

e

Respo

nse.Jo

bsDeta
il.Secti

on

该分片位于文本中的起始位置信息（即10代表第11个utf8文字）。从0开始。

I

n

t

e
g

e

r

La

be

l

Respo

nse.Jo

bsDeta

il.Secti

on

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的

审核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回

值：Normal：正常，Porn：色情，Ads：广告，以及其他不安全或不适宜的

类型。

S

tr

in

g

Re
su

lt

Respo

nse.Jo
bsDeta

il.Secti

on

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议
您按照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），

1 （判定为违规敏感文件），2（疑似敏感，建议人工复核）。

I

n

t
e

g

e

r

Po

rnI

nf

o

Respo

nse.Jo

bsDeta

审核场景为色情的审核结果信息。 C

o

n

t
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Container 节点 PornInfo，AdsInfo，IllegalInfo，AbuseInfo 的内容：

il.Secti

on

ai

n

e
r

Ad
sI

nf

o

Respo
nse.Jo

bsDeta

il.Secti

on

审核场景为广告的审核结果信息。

C

o

n
t

ai

n

e
r

Ill
eg

alI

nf

o

Respo
nse.Jo

bsDeta

il.Secti

on

审核场景为违法的审核结果信息。

C

o
n

t

ai

n

e
r

Ab
us

eI

nf

o

Respo
nse.Jo

bsDeta

il.Secti

on

审核场景为谩骂的审核结果信息。

C

o
n

t

ai

n
e

r

节点名

称（关

键字）

父节点 描述 类型

HitFl

ag

Response.Job

sDetail.Sectio

n.*Info

用于返回该审核场景的审核结果，返回值：0：正常。1：确

认为当前场景的违规内容。2：疑似为当前场景的违规内容。

Integ

er

Scor

e

Response.Job

sDetail.Sectio

n.*Info

该分片中审核的结果分数，分数越高表示越敏感。
Integ

er



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1382 共1701页

Container 节点 LibResults 的内容：

Container 节点 UserInfo 的内容：

Keyw

ords

Response.Job

sDetail.Sectio

n.*Info

在当前审核场景下命中的关键词，多关键词以 , 分隔。 Strin

g

LibRe

sults

Response.Job

sDetail.Sectio

n.*Info

该字段用于返回基于风险库识别的结果。注意：未命中风险库

中样本时，此字段不返回。

Cont

ainer 

Array

SubL

abel

Response.Job
sDetail.Sectio

n.*Info

该字段表示审核命中的具体子标签，例如：Porn 下的 
SexBehavior 子标签。注意：该字段可能返回空，表示未

命中具体的子标签

Strin

g

节点名称

（关键

字）

父节点 描述 类型

LibType
Response.JobsDetail.Sec

tion.*Info.LibResults

命中的风险库类型，取值为1（预设黑白

库）和2（自定义风险库）。

Integ

er

LibNam
e

Response.JobsDetail.Sec
tion.*Info.LibResults

命中的风险库名称。
Strin
g

Keywor

ds

Response.JobsDetail.Sec

tion.*Info.LibResults

命中的库中关键词。该参数可能会有多个返

回值，代表命中的多个关键词。

Strin

g 
Array

节点名称（关键

字）
描述 类型

是否必

选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin

g
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin

g
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin

g
否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

IP 一般用于表示 IP 地址信息，长度不超过128字节。 Strin
g

否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否

ReceiveTokenI

d

一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin
g

否

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节点名称（关键

字）
父节点 描述 类型

ListResults
Response.JobsDetail.ListIn

fo

命中的所有名单结

果。

Container 

Array

节点名称（关

键字）
父节点 描述 类型

ListType
Response.JobsDetail.ListInf

o.ListResults

命中的名单类型，取值为0（白名单）

和1（黑名单）。

Inte

ger

ListName
Response.JobsDetail.ListInf

o.ListResults
命中的名单名称。

Stri

ng

Entity
Response.JobsDetail.ListInf

o.ListResults
命中了名单中的哪条内容。

Stri

ng

错误码

实际案例

请求

https://cloud.tencent.com/document/product/460/42867
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POST /text/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

  <Input>

    <Content>54uZ5Ye75omL</Content>

  </Input>

  <Conf>

    <BizType>b81d45f94b91a683255e9a9506f45a11</BizType>

  </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

    <Content>54uZ5Ye75omL</Content>

    <State>Success</State>

    <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    <SectionCount>1</SectionCount>

    <Label>Illegal</Label>

    <Result>2</Result>

    <PornInfo>

      <HitFlag>0</HitFlag>

      <Count>0</Count>

    </PornInfo>

    <Section>

      <StartByte>0</StartByte>

      <Label>Illegal</Label>

      <Result>2</Result>

      <PornInfo>

        <HitFlag>0</HitFlag>

        <Score>0</Score>

        <Keywords/>
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      </PornInfo>

    </Section>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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查询文本审核任务结果
最近更新时间：2023-08-16 17:20:02

DescribeAuditingTextJob 接口用于查询指定的文本审核任务。

数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能描述

说明

 文本审核任务结果保存时效为1个月，您可通过本接口查询近1个月的审核结果。

推荐使用 SDK

请求

请求示例

GET /text/auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称 描述 类型 是否必选

jobId 要查询的任务ID，可通过提交审核任务的响应中获取。 String 是

https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应

响应头

响应体

<Response>

  <JobsDetail>

    <Code>Success</Code>

    <Message>Success</Message>

    <DataId></DataId>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <Object></Object>

    <SectionCount></SectionCount>

    <Result>1</Result>

    <PornInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </PornInfo>

    <AdsInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </AdsInfo>

    <IllegalInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </IllegalInfo>

    <AbuseInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </AbuseInfo>

    </Section>

        <StartByte></StartByte>

        <PornInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </PornInfo>

        <AdsInfo>

            <HitFlag></HitFlag>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

            <Score></Score>

            <Keywords></Keywords>

        </AdsInfo>

        <IllegalInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </IllegalInfo>

        <AbuseInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </AbuseInfo>

    </Section>

    </Section>

        <StartByte></StartByte>

        <PornInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </PornInfo>

        <AdsInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </AdsInfo>

        <IllegalInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </IllegalInfo>

        <AbuseInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </AbuseInfo>

    </Section>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型
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Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

Response 无 保存结果的容器。 Container

节点名称

（关键字）
父节点 描述 类型

JobsDeta

il

Resp

onse
任务的详细信息。

Contai

ner

RequestI
d

Resp
onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题
时，该 ID 能更快地协助定位问题。

String

节点名称

（关键

字）

父节点 描述 类型

Code
Response.J

obsDetail

错误码，只有 State 为 Failed 时返回，详情请查看 错误码

列表 。

Strin

g

Messag

e

Response.J

obsDetail
错误描述，只有 State 为 Failed 时返回。

Strin

g

DataId
Response.J

obsDetail

该字段在审核结果中会返回原始内容，长度限制为512字节。

您可以使用该字段对待审核的数据进行唯一业务标识。

Strin

g

JobId
Response.J

obsDetail
本次审核任务的 ID。

Strin

g

State
Response.J
obsDetail

任务的状态，值为 Submitted（已提交审核）、Success

（审核成功）、Failed（审核失败）、Auditing（审核中）
其中一个。

Strin
g

Creatio

nTime

Response.J

obsDetail
任务的创建时间。

Strin

g

Object
Response.J

obsDetail
审核的对象名称，当创建任务使用 Object 时返回。

Strin

g

Conten
t

Response.J
obsDetail

文本内容的 Base64 编码。当创建任务使用 Content 时返
回。

Strin
g

Contex

tText

Response.J

obsDetail

当启用了文本上下文关联审核能力时，会返回该字段，同时返

回当前审核的文本内容及关联的文本内容，以原文形式返回。

Strin

g

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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注意：使用上下文关联能力，在发起文本审核时需要结合

UserInfo字段来使用，表示关联的上下文仅属于某个用户

ID，不同用户ID上传的文本内容不会互相关联。
如需开启上下文关联能力，请 联系服务人员  开通。

Section

Count

Response.J

obsDetail

文本审核会将文本进行分段送审，每10000个 utf8 编码字符

分一段，该参数表示分段的数量。

Inte

ger

Label
Response.J

obsDetail

该字段用于返回检测结果中所对应的优先级最高的恶意标签，

表示模型推荐的审核结果，建议您按照业务所需，对不同违规

类型与建议值进行处理。 返回值：Normal：正常，Porn：

色情，Ads：广告，以及其他不安全或不适宜的类型。

Strin

g

Result
Response.J

obsDetail

该字段表示本次判定的审核结果，您可以根据该结果，进行后

续的操作；建议您按照业务所需，对不同的审核结果进行相应

处理。有效值：0（审核正常），1 （判定为违规敏感文件），
2（疑似敏感，建议人工复核）。

Inte

ger

PornInf

o

Response.J

obsDetail
审核场景为色情的审核结果信息。

Cont

aine

r

AdsInfo
Response.J

obsDetail
审核场景为广告的审核结果信息。

Cont

aine

r

IllegalIn

fo

Response.J

obsDetail
审核场景为违法的审核结果信息。

Cont

aine

r

AbuseI

nfo

Response.J

obsDetail
审核场景为谩骂的审核结果信息。

Cont

aine

r

Section
Response.J

obsDetail
具体文本分片的审核结果信息。

Cont

aine

r 

Arra
y

UserInf

o

Response.J

obsDetail
用户业务字段。

Cont

aine

r

ListInfo
Response.J

obsDetail
审核结果命中业务字段风险库将返回该字段。

Cont

aine

r

https://cloud.tencent.com/online-service?from=connect-us
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Container 节点 PornInfo，AdsInfo 的内容：

Container 节点 Section 的内容：

ForbidS

tate

Response.J

obsDetail

若您设置了自动冻结，该字段表示文本文件的冻结状态。0：

未冻结，1：已被冻结，2：已转移文件。

Inte

ger

节点名

称（关

键字）

父节点 描述 类型

HitFla

g

Response.Jobs

Detail.*Info

用于返回该审核场景的审核结果，返回值：0：正常。

1：确认为当前场景的违规内容。2：疑似为当前场景的

违规内容。

String

Count
Response.Jobs

Detail.*Info
命中该审核分类的分片数。 Integer

Score
Response.Jobs

Detail.*Info

该字段表示审核结果命中审核信息的置信度，取值范
围：0（置信度最低）-100（置信度最高），越高代表

该内容越有可能属于当前返回审核信息。例如：色情 

99，则表明该内容非常有可能属于色情内容。

Integer

节点

名称
（关

键

字）

父节点 描述 类型

Start
Byte

Response.JobsD
etail.Section

该分片位于文本中的起始位置信息（即10代表第11个utf8
文字）。从0开始。

Intege
r

Labe
l

Response.JobsD
etail.Section

该字段用于返回检测结果中所对应的优先级最高的恶意标

签，表示模型推荐的审核结果，建议您按照业务所需，对
不同违规类型与建议值进行处理。 返回值：Normal：正

常，Porn：色情，Ads：广告，以及其他不安全或不适

宜的类型。

String

Res

ult

Response.JobsD

etail.Section

该字段表示本次判定的审核结果，您可以根据该结果，进
行后续的操作；建议您按照业务所需，对不同的审核结果

进行相应处理。有效值：0（审核正常），1 （判定为违规

敏感文件），2（疑似敏感，建议人工复核）。

Intege

r

Porn

Info

Response.JobsD

etail.Section
审核场景为色情的审核结果信息。

Contai

ner

AdsI Response.JobsD 审核场景为广告的审核结果信息。 Contai
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Container 节点 PornInfo，AdsInfo，IllegalInfo，AbuseInfo 的内容：

Container 节点 LibResults 的内容：

nfo etail.Section ner

Illeg

alInf

o

Response.JobsD

etail.Section
审核场景为违法的审核结果信息。

Contai

ner

Abu

seInf

o

Response.JobsD

etail.Section
审核场景为谩骂的审核结果信息。

Contai

ner

节点名
称（关

键字）

父节点 描述 类型

HitFla
g

Response.JobsDetai
l.*Info

用于返回该审核场景的审核结果，返回值：0：

正常。1：确认为当前场景的违规内容。2：疑似
为当前场景的违规内容。

String

Score
Response.JobsDetai

l.Section.*Info

该分片中审核的结果分数，分数越高表示越敏

感。
Integer

Keywo

rds

Response.JobsDetai

l.Section.*Info
在当前审核场景下命中的关键词，多关键词以 ,

分隔。
String

LibRes
ults

Response.JobsDetai
l.Section.*Info

该字段用于返回基于文本风险库识别的结果。
注意：未命中风险库中样本时，此字段不返回。

Contain
er Array

SubLa
bel

Response.JobsDetai
l.Section.*Info

该字段表示审核命中的具体子标签，例如：

Porn 下的 SexBehavior 子标签。
注意：该字段可能返回空，表示未命中具体的子

标签。

String

节点名称

（关键

字）

父节点 描述 类型

LibType
Response.JobsDetail.Secti

on.*Info.LibResults

命中的风险库类型，取值为1（预设文本

风险库）和2（自定义文本风险库）。

Integ

er

LibNam
e

Response.JobsDetail.Secti
on.*Info.LibResults

命中的风险库名称。
Strin
g

Keywor Response.JobsDetail.Secti 命中的库中关键词。该参数可能会有多个 Strin



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1393 共1701页

Container 节点 UserInfo 的内容：

Container 节点 ListInfo 的内容：

ds on.*Info.LibResults 返回值，代表命中的多个关键词。 g 
Array

节点名称（关键

字）
描述 类型 是否必选

TokenId 一般用于表示账号信息，长度不超过128字节。
Stri

ng
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Stri

ng
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Stri

ng
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Stri

ng
否

Room 一般用于表示房间号信息，长度不超过128字节。
Stri

ng
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Stri

ng
否

Type 一般用于表示业务类型，长度不超过128字节。
Stri

ng
否

ReceiveTokenId
一般用于表示接收消息的用户账号，长度不超过128字

节。

Stri

ng
否

Gender 一般用于表示性别信息，长度不超过128字节。
Stri
ng

否

Level 一般用于表示等级信息，长度不超过128字节。
Stri

ng
否

Role 一般用于表示角色信息，长度不超过128字节。
Stri

ng
否

节点名称（关键

字）
父节点 描述 类型

ListResults Response.JobsDetail. 命中的所有业务字段风险库结 Container 
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Container 节点 ListResults 的内容：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

ListInfo 果。 Array

节点名称（关

键字）
父节点 描述 类型

ListType
Response.JobsDetail.Lis

tInfo.ListResults

命中的业务字段风险库类型，取值为0

（白库）和1（黑库）。

Integ

er

ListName
Response.JobsDetail.Lis
tInfo.ListResults

命中的业务字段风险库名称。
Strin
g

Entity
Response.JobsDetail.Lis

tInfo.ListResults
命中了业务字段风险库中的哪条内容。

Strin

g

错误码

实际案例

请求

GET /text/auditing/stb1ca9fc8a3ed11ea834c525400863904 HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <JobId>st78925397b9de11eba532525400946f76</JobId>

    <State>Success</State>

    <CreationTime>2021-05-21T10:44:32+08:00</CreationTime>

https://cloud.tencent.com/document/product/460/42867
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    <Object>test.txt</Object>

    <SectionCount>1</SectionCount>

    <Label>Illegal</Label>

    <Result>1</Result>

    <PornInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

    </PornInfo>

    <AdsInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

    </AdsInfo>

    <IllegalInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

    </IllegalInfo>

    <AbuseInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

    </AbuseInfo>

    <Section>

        <StartByte>0</StartByte>

        <Label>Illegal</Label>

        <Result>1</Result>

        <PornInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Keywords></Keywords>

        </PornInfo>

        <AdsInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Keywords></Keywords>

        </AdsInfo>

        <IllegalInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Keywords></Keywords>

        </IllegalInfo>

        <AbuseInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Keywords></Keywords>

        </AbuseInfo>

    </Section>
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  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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文本审核回调内容
最近更新时间：2023-08-16 17:20:02

若您配置了审核回调地址，在文本审核结束后，后台会将审核结果以 json 形式回调至您的回调地址。您可以通过回

调内容，进行后续的文件处理操作。

回调内容分为简洁回调（Simple）和详细回调（Detail）。

功能描述
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回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Simple  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

回调内容说明

简洁回调（Simple）
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具体的数据内容如下：

data的具体内容如下：

{

   "code": 0,

   "data": {

       "forbidden_status": 0,

       "event": "ReviewText",

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "count": 0

       },

       "result": 0,

       "trace_id": "test_trace_id",

       "url": "test_url",

       "cos_headers": {

           "x-cos-meta-xx": "xx"

       }

   },

   "message": "Test request when setting callback url"

}

参数名称 描述 类型

code
错误码，值为0时表示审核成功，非0表示审核失败。详情请查看 内容审核错误

码 。

Intege

r

messag

e
错误描述。 String

data 文本审核结果的详细信息。 Object

参数名称 描述 类型

trace_id 唯一 ID 标识。如果是通过接口创建的异步任务，则为接口返回的 JobId。
Strin

g

url 被审核文本的完整 URL 链接。
Strin
g

event 触发的事件，此处固定为 ReviewText。
Strin

g

https://cloud.tencent.com/document/product/460/8523#.E5.86.85.E5.AE.B9.E5.AE.A1.E6.A0.B8.E9.94.99.E8.AF.AF.E7.A0.81
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xx_info 的具体内容如下：

回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Detail  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

result 该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您

按照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 

（判定为违规敏感文件），2（疑似敏感，建议人工复核）。

Inte

ger

forbidden

_status

若您设置了自动冻结，该字段表示文本的冻结状态。0：未冻结，1：已被冻结，

2：已转移文件。

Inte

ger

cos_hea
ders

资源上传时设置的自定义 header 内容，若未设置则不返回。
Obje
ct

porn_info 审核场景为涉黄的审核结果信息。
Obje

ct

ads_info 审核场景为广告引导的审核结果信息。
Obje

ct

abuse_in
fo

审核场景为谩骂的审核结果信息。
Obje
ct

illegal_inf

o
审核场景为违法的审核结果信息。

Obje

ct

data_id 提交任务时设置了DataId参数时返回，返回原始内容，长度限制为512字节。
Strin

g

参数

名称
描述 类型

hit_

flag

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内容。

2：疑似为当前场景的违规内容。

Integ

er

lab

el
命中的关键字。

Strin

g

cou

nt
命中该审核分类的敏感文本段数。

Integ

er

sco

re

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信

度最高），越高代表该内容越有可能属于当前返回审核信息。例如：色情 99，则表明

该内容非常有可能属于色情内容。

Integ

er

详细回调（Detail）
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{

  "EventName": "ReviewText",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "",

    "Object": "",

    "Label": "Normal",

    "Result": 0,

    "SectionCount": 1,

    "PornInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "IllegalInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "AbuseInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "Section": [

      {

        "StartByte": 0,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        },

        "IllegalInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        },

        "AbuseInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""
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具体的数据内容如下：

JobsDetail 的具体内容如下：

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        }

      }

    ],

    "BucketId": "",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxxx"

    }

  }

}

节点名称（关键字） 描述 类型

JobsDetail 任务的详细结果信息。 Object

EventName 任务的类型，为 ReviewText 。 String

节点名称

（关键

字）

描述 类型

Code 错误码，只有 State 为 Failed 时返回。详情请查看 错误码列表 。 String

Messag

e
错误描述，只有 State 为 Failed 时返回。 String

JobId 本次文本审核任务的 ID。 String

DataId 提交任务时设置了DataId参数时返回，返回原始内容，长度限制为512字节。 String

State
审核任务的状态，值为 Submitted（已提交审核）、Success（审核成功）、

Failed（审核失败）、Auditing（审核中）其中一个。
String

Creatio
nTime

审核任务的创建时间。 String

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Object 被审核的文本文件的名称，创建任务使用 Object 时返回。 String

Conten

t
本次审核的文本内容的 Base64编码，当创建任务使用 Content 时返回。 String

Contex

tText

当启用了文本上下文关联审核能力时，会返回该字段，同时返回当前审核的文本
内容及关联的文本内容，以原文形式返回。

注意：使用上下文关联能力，在发起文本审核时需要结合UserInfo字段来使用，

表示关联的上下文仅属于某个用户ID，不同用户ID上传的文本内容不会互相关

联。
如需开启上下文关联能力，请 联系服务人员  开通。

String

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审

核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：

Normal：正常，Porn：色情，Ads：广告，Illegal：违法，Abuse：谩骂。

String

Result

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您

按照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 

（判定为违规敏感文件），2（疑似敏感，建议人工复核）。

Intege

r

PornInf

o
审核场景为涉黄的审核结果信息。 Object

AdsInfo 审核场景为广告引导的审核结果信息。 Object

IllegalIn

fo
审核场景为违法的审核结果信息。 Object

AbuseI
nfo

审核场景为谩骂的审核结果信息。 Object

Section

Count

文本审核会将文本进行分段送审，每10000个 utf8 编码字符分一段，该参数表

示分段的数量。

Intege

r

Section 文本内容每一段的审核结果。 Array

BucketI

d
创建的审核任务所属的存储桶名称。 String

Region 存储桶所在的地域。 String

ForbidS
tate

若您设置了自动冻结，该字段表示文本的冻结状态。0：未冻结，1：已被冻结，
2：已转移文件。

Intege
r

CosHe

aders

资源上传到 COS 时设置的自定义 Header 内容，如果未设置则不返回。map 

结构，key 为自定义 Header 的名称，value 为内容。
Object

UserInf 用户业务字段。 Contai

https://cloud.tencent.com/online-service?from=connect-us
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PornInfo，AdsInfo，IllegalInfo，AbuseInfo 的具体内容如下：

Section 的具体内容如下：

o ner

ListInfo 审核结果命中了业务字段风险库，将返回该字段。
Contai
ner

节点名称

（关键字）
描述 类型

HitFlag
用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规
内容。2：疑似为当前场景的违规内容。

Integ
er

Count 命中该审核分类的文本段数。
Integ

er

Score

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100

（置信度最高），越高代表该内容越有可能属于当前返回审核信息。例如：色情 

99，则表明该内容非常有可能属于色情内容。

Integ

er

节点

名称
（关

键

字）

描述
类
型

Start

Byte
该分片位于文本中的起始位置信息（即10代表第11个utf8文字）。从0开始。

Int
eg

er

Labe
l

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结果，
建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：Normal：正常，

Porn：色情，Ads：广告，Illegal：违法，Abuse：谩骂。

Str
ing

Res
ult

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业务

所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规敏感
文件），2（疑似敏感，建议人工复核）。

Int

eg
er

Porn

Info
审核场景为涉黄的审核结果信息。

Ob

jec
t

AdsI

nfo

审核场景为广告引导的审核结果信息。 Ob

jec
t
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Section 中的 PornInfo，AdsInfo，IllegalInfo，AbuseInfo 的具体内容如下：

Container 节点 LibResults 的内容：

Container 节点 UserInfo 的内容：

Illeg

alInf

o

审核场景为违法的审核结果信息。

Ob

jec

t

Abu

seInf

o

审核场景为谩骂的审核结果信息。

Ob

jec

t

节点名
称（关

键字）

描述 类型

HitFla

g

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规

内容。2：疑似为当前场景的违规内容。
Integer

Score

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100

（置信度最高 ），越高代表该内容越有可能属于当前返回审核信息。通常

[0,60]分可以认为图片属于正常，[61,90]分表示图片疑似敏感，[91,100]分表
示图片为敏感的。例如：色情 99，则表明该内容非常有可能属于色情内容。

Integer

Keywo

rds
在当前审核场景下命中的关键词，多关键词以 , 分割。 String

LibRes

ults

该字段用于返回基于风险库识别的结果。注意：未命中风险库中样本时，此字段

不返回。

Contain

er Array

SubLa
bel

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标
签。注意：该字段可能返回空，表示未命中具体的子标签。

String

节点名称（关键

字）
描述 类型

LibType
命中的文本风险库类型，取值为1（预设文本风险库）和2（自定义文本

风险库）。
Integer

LibName 命中的风险库名称。 String

Keywords
命中的库中关键词。该参数可能会有多个返回值，代表命中的多个关键

词。

String 

Array
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

节点名称（关键

字）

描述 类型 是否必选

TokenId 一般用于表示账号信息，长度不超过128字节。
Stri
ng

否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Stri

ng
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Stri

ng
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Stri

ng
否

Room 一般用于表示房间号信息，长度不超过128字节。
Stri

ng
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Stri

ng
否

Type 一般用于表示业务类型，长度不超过128字节。
Stri

ng
否

ReceiveTokenId
一般用于表示接收消息的用户账号，长度不超过128字

节。

Stri

ng
否

Gender 一般用于表示性别信息，长度不超过128字节。
Stri

ng
否

Level 一般用于表示等级信息，长度不超过128字节。
Stri

ng
否

Role 一般用于表示角色信息，长度不超过128字节。
Stri

ng
否

节点名称（关键字） 描述 类型

ListResults 命中的所有业务字段风险库结果。 Container Array

节点名称（关键字） 描述 类型

ListType 命中的业务字段风险库类型，取值为0（白库）和1（黑库）。 Intege

r
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ListName 命中的业务字段风险库名称。 String

Entity 命中了业务字段风险库中的哪条内容。 String

实际案例

案例一：简洁回调（Simple）

{

   "code": 0,

   "data": {

       "event":"ReviewText",

       "forbidden_status": 0,

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "count": 0

       },

       "result": 0,

       "trace_id": "ixzt90jl2dfscxxxxxxxxxxxxxxxxx",

       "url": "https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/test.txt",

       "cos_headers": {

           "x-cos-meta-id": "xxxxxx"

       }

   },

   "message": "success"

}

案例二：详细回调（Detail）

{

  "EventName": "ReviewText",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "2021-08-10T21:01:08+08:00",

    "Object": "1.txt",

    "Label": "Normal",

    "Result": 0,

    "SectionCount": 1,

    "PornInfo": {

      "HitFlag": 0,

      "Count": 0
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    },

    "AdsInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "Section": [

      {

        "StartByte": 0,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        }

      }

    ],

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxx"

    }

  }

}
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文本审核结果反馈
最近更新时间：2022-07-06 17:54:45

您可通过本接口反馈与预期不符的审核结果，例如色情文本被审核判定为正常或正常文本被判定为色情时可通过该接

口直接反馈。

本接口不会直接修改审核结果，您反馈的错误审核结果将在后台进行确认，并在后续的审核任务中生效。

数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

推荐使用 SDK

请求

请求示例

POST /report/badcase HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <ContentType></ContentType>

    <JobId></JobId>

https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

    <ModerationTime></ModerationTime>

    <Text></Text>

    <SuggestedLabel></SuggestedLabel>

    <Label></Label>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 反馈审核错误的具体参数 Container 是

节点名称（关

键字）

父节

点
描述

类

型

是否

必选

ContentTy

pe

Req

ues

t

需要反馈的数据类型，错误文本样本取值为1。

Int

eg

er

是

Text

Req

ues

t

文本类型的样本，需要填写 base64 的文本内容，

ContentType 为1时必填。

Str

ing
否

Label

Req

ues

t

数据万象审核判定的审核结果标签，例如 Porn。
Str

ing
是

Suggested

Label

Req

ues

t

您自己期望的正确审核结果的标签，例如期望是正常，则填 

Normal。

Str

ing
是

JobId
Req
ues

t

该数据样本对应的审核任务 ID，有助于定位审核记录。
Str

ing
否

Moderatio
nTime

Req
ues

t

该数据样本之前审核的时间，有助于定位审核记录。 格式为 
2021-08-07T12:12:12+08:00

Str
ing

否

响应

响应头

https://cloud.tencent.com/document/product/460/42866
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

响应体

<Response>

    <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 返回的具体响应内容 Container

节点名称

（关键字）
父节点 描述

类

型

RequestId
Resp

onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题时，

该 ID 能更快地协助定位问题

Str

ing

错误码

实际案例

请求

POST /report/badcase HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1********&q-s

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 66

Content-Type: application/xml

<Request>

    <ContentType>1</ContentType>

    <Text>6L+Z5piv5Li65LuA5LmI</Text>

    <Label>Porn</Label>

    <SuggestedLabel>Normal</SuggestedLabel>

</Request>

响应

https://cloud.tencent.com/document/product/460/42867


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1412 共1701页

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 May 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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文档审核
提交文档审核任务
最近更新时间：2023-03-13 14:18:23

本接口用于提交一个文档审核任务。文档审核功能为异步任务方式，您可以通过提交文档审核任务审核您的文档文

件，然后通过 查询文档审核任务接口  或 文档审核回调  查询审核结果。

对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

功能描述

说明

支持审核腾讯云 COS 上的文档文件。

支持审核第三方云存储厂商的文档 URL。

目前支持的输入文件类型包含如下格式：

演示文件：pptx、ppt、pot、potx、pps、ppsx、dps、dpt、pptm、potm、ppsm。

文字文件：doc、dot、wps、wpt、docx、dotx、docm、dotm。

表格文件：xls、xlt、et、ett、xlsx、xltx、csv、xlsb、xlsm、xltm、ets。

PDF 文件。

其他格式文件：txt、log、htm、html、lrc、 c、 cpp、 h、 asm、 s、 java、 asp、 

bat、 bas、 prg、 cmd、 rtf、 xml。

表格文件，一张表可能分割为多页转换，生成多张图片。

输入文件大小限制在200MB之内。

输入文件页数限制在5000页之内。

根据不同的业务场景 配置自定义的审核策略 。支持

推荐使用 SDK

请求

请求示例

POST /document/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

https://cloud.tencent.com/document/product/436/59382
https://cloud.tencent.com/document/product/436/62389
https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/56345
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

      <Input>

         <Url></Url>

         <Type></Type>

         <DataId></DataId>

      </Input>

      <Conf>

         <Callback></Callback>

         <BizType></BizType>

      </Conf>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 文档审核的具体配置项 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 需要审核的内容 Container 是

Conf Request 审核规则配置 Container 是

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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Container 类型 Input 的具体数据描述如下：

Container 节点 UserInfo 的内容：

节点名
称（关

键字）

父节
点

描述
类
型

是

否
必

选

Objec

t

Req
uest

.Inp

ut

存储在 COS 存储桶中的文件名称，例如在目录 test 中的文件
test.doc，则文件名称为 test/test.doc。Object 和 Url 只能选择

其中一种。

St
rin

g

否

Url

Req
uest

.Inp

ut

文档文件的链接地址，例如 

http://www.example.com/doctest.doc，Object 和 Url 只能

选择其中一种。

St

rin

g

否

Type

Req

uest

.Inp

ut

指定文档文件的类型，如未指定则默认以文件的后缀为类型。

如果文件没有后缀，该字段必须指定，否则会审核失败。例如：

doc、docx、ppt、pptx 等

St

rin

g

否

DataI

d

Req

uest

.Inp

ut

该字段在审核结果中会返回原始内容，长度限制为512字节。您可以

使用该字段对待审核的数据进行唯一业务标识。

St

rin

g

否

UserI

nfo

Req

uest

.Inp
ut

用户业务字段。

Co

nt

ai
ne

r

否

节点名称（关

键字）
父节点 描述 类型

是否

必选

TokenId
Request.Input.U
serInfo

用户业务TokenId，长度不超过128字
节。

Stri
ng

否

Nickname
Request.Input.U

serInfo

用户业务Nickname，长度不超过128

字节。

Stri

ng
否

DeviceId
Request.Input.U

serInfo

用户业务DeviceId，长度不超过128字

节。

Stri

ng
否



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1416 共1701页

Container 类型 Conf 的具体数据描述如下：

AppId Request.Input.U

serInfo

用户业务AppId，长度不超过128字节。 Stri

ng

否

Room
Request.Input.U

serInfo
用户业务Room，长度不超过128字节。

Stri

ng
否

IP
Request.Input.U

serInfo
用户业务IP，长度不超过128字节。

Stri

ng
否

Type
Request.Input.U

serInfo
用户业务Type，长度不超过128字节。

Stri

ng
否

ReceiveTok

enId

Request.Input.U

serInfo

用户业务ReceiveTokenId，长度不超

过128字节。

Stri

ng
否

Gender
Request.Input.U

serInfo

用户业务Gender，长度不超过128字

节。

Stri

ng
否

Level
Request.Input.U
serInfo

用户业务Level，长度不超过128字节。
Stri
ng

否

Role
Request.Input.U

serInfo
用户业务Role，长度不超过128字节。

Stri

ng
否

节
点

名

称

（
关

键

字

）

父

节
点

描述
类

型

是

否

必
选

Bi

z

T

y
p

e

R

e

q

u
e

s

t.

C
o

n

f

表示审核策略的唯一标识，您可以通过控制台上的审核策略页面，配置您希望

审核的场景，如涉黄、广告、违法违规等，配置指引： 设置公共审核策略 。您

可以在控制台上获取到 BizType。BizType 填写时，此条审核请求将按照该

审核策略中配置的场景进行审核。
BizType 不填写时，将自动使用默认的审核策略。

S

tr

in

g

否
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Container 类型 Freeze 的具体数据描述如下：

C

all
b

a

c

k

R
e

q

u

e
s

t.

C

o
n

f

审核结果可以回调形式发送至您的回调地址，支持以 http://  或者 https://  

开头的地址，例如： http://www.callback.com

S
tr

in

g

否

C
all

b

a

c
k

T

y

p

e

R

e
q

u

e

s
t.

C

o

n
f

回调片段类型，有效值：1（回调全部分页）、2（回调违规分页）。默认为 
1。

I

n

t

e
g

e

r

否

Fr

e

ez
e

R

e

q
u

e

s

t.
C

o

n

f

可通过该字段，设置根据审核结果给出的不同分值，对文档进行自动冻结。仅

当 input 中审核的文档为 object 时有效。

C
o

n

t

ai
n

e

r

否

节点名
称（关

键字）

父节点 描述
类

型

是
否

必

选

PornS
core

Request.
Conf.Fre

取值为[0,100]，表示当色情审核结果大于或等于该分数时，自
动进行冻结操作。不填写则表示不自动冻结，默认值为空。

I
n

否
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其他审核场景的冻结参数，请 联系服务人员 咨询。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

eze t

e
g

e

r

AdsSc

ore

Request.

Conf.Fre

eze

取值为[0,100]，表示当广告审核结果大于或等于该分数时，自

动进行冻结操作。不填写则表示不自动冻结，默认值为空。

I
n

t

e

g
e

r

否

响应

响应头

响应体

<Request>

    <JobsDetail>

       <DataId></DataId>

       <JobId></JobId>

       <State></State>

       <CreationTime></CreationTime>

    </JobsDetail>

    <RequestId></RequestId>

</Request>

节点名称（关键字） 父节点 描述 类型

Response 无 提交文档审核任务返回的具体响应内容 Container

节点名称
（关键字）

父节点 描述 类型

https://cloud.tencent.com/online-service?from=ticket-tab
https://cloud.tencent.com/document/product/460/42866
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Container 节点 JobsDetail 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

JobsDetai

l

Resp

onse
文档审核任务的详细信息

Cont

ainer

RequestId
Resp

onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题

时，该 ID 能更快地协助定位问题

Strin

g

节点名称

（关键

字）

父节点 描述
类

型

DataId

Respons

e.JobsD

etail

请求中添加的唯一业务标识

St

ri

n
g

JobId

Respons

e.JobsD
etail

本次文档审核任务的 ID

St

ri

n
g

State

Respons

e.JobsD
etail

文档审核任务的状态，值为 Submitted（已提交审核）、Success
（审核成功）、Failed（审核失败）、Auditing（审核中）其中一个

St

ri
n

g

Creatio
nTime

Respons
e.JobsD

etail

文档审核任务的创建时间

St

ri
n

g

错误码

实际案例

请求

POST /document/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867
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<Request>

      <Input>

         <Url>http://www.example.com/doctest.doc</Url>

         <DataId>123-fdrsg-123</DataID>

      </Input>

      <Conf>

         <Callback></Callback>

         <BizType>b81d45f94b91a683255e9a9506f4****</BizType>

      </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <DataId>123-fdrsg-123</DataID>

        <JobId>vab1ca9fc8a3ed11ea834c52540086****</JobId>

        <State>Submitted</State>

        <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    </JobsDetail>

    <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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查询文档审核任务结果
最近更新时间：2023-05-06 18:04:59

本接口用于查询指定的文档审核任务结果。

对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能描述

说明

 文档审核任务结果保存时效为1个月，您可通过本接口查询近1个月的审核结果。

推荐使用 SDK

请求

请求示例

GET /document/auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称 描述 类型 是否必选

jobId 要查询的任务ID，可通过提交审核任务的响应中获取。 String 是

https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应

响应头

响应体

<Response>

    <JobsDetail>

      <JobId>aab1ca9fc8a3ed11ea834c525400863904</JobId>

      <State>Success</State>

      <Code>Success</Code>

      <Message>Success</Message>

      <DataId></DataId>

      <Suggestion>1</Suggestion>

      <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

      <Url>http://www.test.com/123</Url>

      <PageCount>3</PageCount>

      <Labels>

        <PornInfo>

          <HitFlag>1</HitFlag>

          <Score>96</Score>

        </PornInfo>

      </Labels>

      <PageSegment>

        <Results>

          <Url></Url>

          <Text></Text>

          <PageNumber>1</PageNumber>

          <SheetNumber>1</SheetNumber>

          <PornInfo>

            <HitFlag></HitFlag>

            <SubLabel></SubLabel>

            <Score></Score>

            <OcrResults>

              <Text></Text>

              <Keywords></Keywords>

            </OcrResults>

          </PornInfo>

        </Results>

      </PageSegment>

    </JobsDetail>

    <RequestId></RequestId>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 文档审核的全部信息 Container

节点名称

（关键字）
父节点 描述 类型

JobsDetai

l

Resp

onse
文档审核任务的详细信息

Cont

ainer

RequestId
Resp

onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题

时，该 ID 能更快地协助定位问题

Strin

g

节点

名称
（关

键

字）

父节
点

描述 类型

Cod

e

Resp
onse

.Job

sDet

ail

错误码，只有 State 为 Failed 时返回，详情请查看 错误码列表
Stri

ng

Mes

sage

Resp

onse

.Job

sDet
ail

错误描述，只有 State 为 Failed 时返回
Stri

ng

Data
Id

Resp

onse
.Job

sDet

ail

该字段在审核结果中会返回原始内容，长度限制为512字节。您可以使用该
字段对待审核的数据进行唯一业务标识。

Stri
ng

JobI Resp 文档审核任务的 ID Stri

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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d onse

.Job

sDet
ail

ng

Stat
e

Resp

onse

.Job
sDet

ail

任务的状态，值为 Submitted（已提交审核）、Success（审核成
功）、Failed（审核失败）、Auditing（审核中）其中一个

Stri
ng

Sugg

estio

n

Resp
onse

.Job

sDet

ail

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建
议您按照业务所需，对不同的审核结果进行相应处理。

有效值：0（审核正常），1 （判定为违规敏感文件），2（疑似敏感，建议

人工复核）

Inte

ger

Labe

l

Resp

onse

.Job

sDet
ail

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐

的审核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返

回值：Normal：正常，Porn：色情，Ads：广告，以及其他不安全或不
适宜的类型。

Stri

ng

Crea
tionT

ime

Resp

onse
.Job

sDet

ail

任务的创建时间
Stri
ng

Obje

ct

Resp
onse

.Job

sDet

ail

审核的文件为存储在 COS 中的文件时，该字段表示本次审核的文件名称
Stri

ng

Url

Resp

onse

.Job
sDet

ail

审核的文件链接，创建任务使用 Url 时返回
Stri

ng

Page
Cou

nt

Resp

onse
.Job

sDet

ail

文档审核会将文档转换为图片进行审核，该字段表示转换的图片总数量
Inte

ger
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Container 节点 Labels 的内容：

Container 节点 PornInfo，AdsInfo 的内容：

Labe

ls

Resp

onse

.Job

sDet
ail

该字段用于返回命中的审核场景及对应的结果 Con

tain

er

Page

Seg
ment

Resp

onse

.Job
sDet

ail

文档转换为图片后，具体每张图片的审核结果信息

Con

tain
er

User

Info

Resp
onse

.Job

sDet

ail

用户业务字段。创建任务时未设置 UserInfo 则无此字段。

Con

tain

er

ListI

nfo

Resp

onse

.Job

sDet
ail

账号黑白名单结果。

Con

tain

er

Forbi
dSta

te

Resp

onse
.Job

sDet

ail

若您设置了自动冻结，该字段表示文档的冻结状态。0：未冻结，1：已被冻
结，2：已转移文件。

Inte
ger

节点名称（关键

字）
父节点 描述 类型

PornInfo
Response.JobsDetail.Labe

ls

审核场景为色情的审核结果信

息

Containe

r

AdsInfo
Response.JobsDetail.Labe
ls

审核场景为广告的审核结果信
息

Containe
r

节点名

称（关

键字）

父节点 描述
类

型
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Container 节点 PageSegment 的内容：

Container 节点 Results 的内容：

HitFl
ag

Response.Jo
bsDetail.Labe

ls.*Info

用于返回该审核场景的审核结果，返回值：
0：正常

1：确认为当前场景的违规内容

2：疑似为当前场景的违规内容

I
n

t

e

g
e

r

Scor

e

Response.Jo

bsDetail.Labe

ls.*Info

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度

最低）-100（置信度最高 ），越高代表该内容越有可能属于当前

返回审核信息

例如：色情 99，则表明该内容非常有可能属于色情内容

I
n

t

e

g

e
r

节点名称（关

键字）
父节点 描述 类型

Results
Response.JobsDetail.Pa
geSegment

文档转换为图片后，每张图片的详
细审核结果信息

Container 
Array

节点

名称

（关

键

字）

父节点 描述
类

型

Url

Response.JobsD

etail.PageSegme
nt.Results

文档转换成图片后，您可以通过该地址查看该图片内容，地址格

式为标准 URL 格式。

注意：每次查看数据的有效期为2小时，2小时后如还需查看，
请重新发起查询请求。

St

ri

n
g

Text

Response.JobsD

etail.PageSegme
nt.Results

该字段用于返回当前图片 OCR 文本识别的检测结果，仅在审
核策略开启文本内容检测时返回。

St

ri
n

g

Pag

eNu
mbe

r

Response.JobsD
etail.PageSegme

nt.Results

该图片的页码，通常是文档的页码

In

te
g

er
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Container 节点 PornInfo，AdsInfo 的内容：

She
etNu

mbe

r

Response.JobsD
etail.PageSegme

nt.Results

如果审核的为表格文件，该字段表示表格内的 Sheet 页码 In
te

g

er

Lab

el

Response.JobsD

etail.PageSegme

nt.Results

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表
示模型推荐的审核结果，建议您按照业务所需，对不同违规类型

与建议值进行处理。

返回值：Normal：正常，Porn：色情，Ads：广告，以及其

他不安全或不适宜的类型。

St

ri

n

g

Sug

gesti
on

Response.JobsD

etail.PageSegme
nt.Results

该字段表示本次判定的审核结果，您可以根据该结果，进行后续

的操作；建议您按照业务所需，对不同的审核结果进行相应处

理。
有效值：0（审核正常），1 （判定为违规敏感文件），2（疑

似敏感，建议人工复核）

In

te

g
er

Porn

Info

Response.JobsD

etail.PageSegme

nt.Results

审核场景为涉黄的审核结果信息

C

o
nt

ai

n

er

AdsI

nfo

Response.JobsD

etail.PageSegme
nt.Results

审核场景为广告引导的审核结果信息

C

o

nt

ai
n

er

节点

名称

（关
键

字）

父节点 描述 类型

HitF

lag

Response.JobsDe
tail.PageSegment.

Results.*Info

用于返回该审核场景的审核结果，返回值：
0：正常。

1：确认为当前场景的违规内容。

2：疑似为当前场景的违规内容。

Inte

ger

Cat Response.JobsDe 该字段为 Label  的子集，表示审核命中的具体审核类别。 Stri
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Container 节点 OcrResults 的内容：

ObjectResults 的具体内容如下：

egor

y

tail.PageSegment.

Results.*Info

例如 Sexy，表示色情标签中的性感类别。 ng

Sub

Lab

el

Response.JobsDe

tail.PageSegment.

Results.*Info

该字段表示审核命中的具体子标签，例如：Porn 下的 

SexBehavior 子标签

注意：该字段可能返回空，表示未命中具体的子标签

Stri

ng

Sco

re

Response.JobsDe

tail.PageSegment.

Results.*Info

该字段表示审核结果命中审核信息的置信度，取值范围：0

（置信度最低）-100（置信度最高 ），越高代表该内容越

有可能属于当前返回审核信息

例如：色情 99，则表明该内容非常有可能属于色情内容

Inte

ger

Ocr

Res

ults

Response.JobsDe

tail.PageSegment.

Results.*Info

该字段表示 OCR 文本识别的详细检测结果，包括文本坐标

信息、文本识别结果等信息，有相关违规内容时返回。

Con

tain

er 

Arra
y

节点

名称

（关

键
字）

父节点 描述
类

型

Text

Response.JobsDetail.Pa

geSegment.Results.*Info

.OcrResults

图片 OCR 文本识别出的具体文本内容。
Str

ing

Key

wor

ds

Response.JobsDetail.Pa

geSegment.Results.*Info

.OcrResults

在当前审核场景下命中的关键词。

Str

ing 

Arr
ay

Loca

tion

Response.JobsDetail.Pa

geSegment.Results.*Info
.OcrResults

该参数用于返回 OCR 检测框在图片中的位置（左上

角 xy 坐标、长宽、旋转角度），以方便快速定位识
别文字的相关信息。

Co

nt

ain
er

节点名

称（关

键字）

父节点 描述
类

型
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Location 的具体内容如下：

Container 节点 UserInfo 的内容：

Nam

e

Response.JobsDetail.Page

Segment.Results.*Info.Obje

ctResults

该标签用于返回所识别出的实体名称，例如人

名。

St

rin

g

Loca

tion

Response.JobsDetail.Page

Segment.Results.*Info.Obje

ctResults

该参数用于返回检测结果在图片中的位置（左上

角 xy 坐标、长宽、旋转角度），以方便快速定

位相关信息。

C

on

tai

ne
r

节点名称

（关键

字）

描述
类

型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Fl

o

a

t

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Fl

o

a

t

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl

o

a

t

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl

o

a
t

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测
框的具体位置；取值：0-360（角度制），方向为逆时针旋转。

Fl

o
a

t

节点名称（关键

字）
描述 类型

是否必

选
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

TokenId 一般用于表示账号信息，长度不超过128字节。 Strin

g

否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin

g
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin

g
否

IP 一般用于表示IP地址信息，长度不超过128字节。
Strin

g
否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否

ReceiveTokenI

d

一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin

g
否

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

错误码

实际案例

请求

GET /document/auditing/stb1ca9fc8a34c525400863904**** HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

https://cloud.tencent.com/document/product/460/42867
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

      <JobId>stb1ca9fc8a34c525400863904****</JobId>

      <State>Success</State>

      <Suggestion>1</Suggestion>

      <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

      <Url>http://www.test.com/123.doc</Url>

      <PageCount>3</PageCount>

      <Labels>

        <PornInfo>

          <HitFlag>1</HitFlag>

          <Score>96</Score>

        </PornInfo>

      </Labels>

      <PageSegment>

        <Results>

          <Url>https://examplebucket-1250000000.cos.ap-nanjing.myqcloud.com/audit-1.jp

          <Text>哈哈哈，您好</Text>

          <PageNumber>1</PageNumber>

          <PornInfo>

            <HitFlag>0</HitFlag>

            <SubLabel>sex</SubLabel>

            <Score>0</Score>

            <OcrResults>

              <Text>哈哈哈，您好</Text>

              <Keywords>您好</Keywords>

            </OcrResults>

          </PornInfo>

        </Results>

        <Results>

          <Url>https://examplebucket-1250000000.cos.ap-nanjing.myqcloud.com/audit-2.jp

          <Text>哈哈哈，您好</Text>

          <PageNumber>1</PageNumber>

          <PornInfo>

            <HitFlag>0</HitFlag>

            <SubLabel>sex</SubLabel>

            <Score>0</Score>

            <OcrResults>
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              <Text>哈哈哈，您好</Text>

              <Keywords>您好</Keywords>

            </OcrResults>

          </PornInfo>

        </Results>

      </PageSegment>

    </JobsDetail>

    <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1433 共1701页

文档审核回调内容
最近更新时间：2022-10-14 10:20:10

若您配置了审核回调地址，在文档审核结束后，后台会将审核结果以 json 形式回调至您的回调地址。您可以通过回

调内容，进行后续的文件处理操作。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

功能描述

回调内容说明

{

  "EventName": "ReviewDocument",

  "JobsDetail": {

    "JobId": "6666666666666666666666666666666666",

    "State": "Success",
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    "CreationTime": "",

    "Url": "",

    "Label": "Normal",

    "Suggestion": 0,

    "PageCount": 1,

    "Labels": {

      "PornInfo": {

        "HitFlag": 0,

        "Score": 0

      },

      "AdsInfo": {

        "HitFlag": 0,

        "Score": 0

      }

    },

    "PageSegment": {

      "Results": [

      {

        "Url": "",

        "Text": "",

        "PageNumber": 0,

        "SheetNumber": 0,

        "Label": "Normal",

        "Suggestion": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "SubLabel": "",

          "OcrResults": [{

            "Text": "",

            "Keywords":["",""],

            "Location": {

              "X": 0,

              "Y": 0,

              "Width": 0,

              "Height": 0,

              "Rotate": 0

            }

          }]

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "SubLabel": ""

        }
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具体的数据内容如下：

JobsDetail 的内容如下：

      }

      ]

    },

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "666666"

    }

  }

}

节点名称（关键字） 描述 类型

JobsDetail 任务的详细结果信息。 Object

EventName 任务的类型，为 ReviewDocument 。 String

节点

名称

（关
键

字）

描述
类

型

Cod
e

错误码，只有 State 为 Failed 时返回。详情请查看 错误码列表 。

S

tr
in

g

Mes
sag

e

错误描述，只有 State 为 Failed 时返回。

S
tr

in

g

JobI

d
审核任务的 ID。

S
tr

in

g

Dat

aId

提交任务时设置了 DataId 参数时返回，返回原始内容，长度限制为512字节。 S

tr

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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in
g

Stat

e

审核任务的状态，值为 Submitted（已提交审核）、Success（审核成功）、Failed

（审核失败）、Auditing（审核中）其中一个。

S

tr

in
g

Lab
el

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结果，建

议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：Normal：正常，
Porn：色情，Ads：广告。

S

tr
in

g

Sug

gest

ion

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业务所

需，对不同的审核结果进行相应处理。 有效值：0（审核正常），1 （判定为违规敏感文

件），2（疑似敏感，建议人工复核）。

In
t

e

g

e

r

Cre

atio

nTi
me

审核任务的创建时间。

S

tr

in
g

Obj

ect
审核的文件为存储在 COS 中的文件时，该字段表示本次审核的文件名称。

S

tr

in
g

Url 审核的文件链接，创建任务使用Url时返回。

S

tr
in

g

Pag

eCo

unt

文档审核会将文档转换为图片进行审核，该字段表示转换的图片总数量。

In
t

e

g

e

r

Lab

els
该字段用于返回命中的审核场景及对应的结果。

O

bj

e
ct
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Labels 的内容如下：

Labels 中 PornInfo，AdsInfo 的内容如下：

Pag

eSe
gme

nt

文档转换为图片后，具体每张图片的审核结果信息。 O

bj
e

ct

For

bidS

tate

若您设置了自动冻结，该字段表示文档的冻结状态。0：未冻结，1：已被冻结，2：已转移

文件。

In
t

e

g

e

r

Cos

Hea

ders

资源上传到 COS 时设置的自定义 Header 内容，如果未设置则不返回。map 结构，key 

为自定义 Header 的名称，value 为内容。

O

bj

e
ct

Use

rInf
o

用户业务字段。创建任务时未设置UserInfo则无此字段。

O

bj

e
ct

ListI

nfo
账号黑白名单结果。

C

o
n

ta

in

e
r

节点名称（关键字） 描述 类型

PornInfo 审核场景为涉黄的审核结果信息。 Object

AdsInfo 审核场景为广告引导的审核结果信息。 Object

节点
名称

（关

键

字）

描述
类

型
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PageSegment 的内容如下：

Results 的内容如下：

HitFl

ag

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内容。2：

疑似为当前场景的违规内容。

I

n

t
e

g

e

r

Scor
e

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度

最高 ），越高代表该内容越有可能属于当前返回审核信息。例如：色情 99，表明该内容非
常有可能属于色情内容。

I

n

t

e
g

e

r

节点名称（关键字） 描述 类型

Results 文档转换为图片后，每张图片的详细审核结果信息。 Array

节点

名称

（关

键

字）

描述
类

型

Url
文档转换成图片后，您可以通过该地址查看该图片内容，地址格式为标准 URL 格式。注

意：每次查看数据的有效期为2小时，2小时后如还需查看，请重新发起查询请求。

S

tr

in
g

Text
该字段用于返回当前图片 OCR 文本识别的检测结果，仅在审核策略开启文本内容检测时返
回。

S

tr
in

g

Pag

eNu
mbe

r

该图片的页码，通常是文档的页码。 I

n
t

e

g



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1439 共1701页

Results 中 PornInfo，AdsInfo 的内容如下：

e

r

She

etN

umb

er

如果审核的为表格文件，该字段表示表格内的 Sheet 页码。

I
n

t

e

g
e

r

Lab
el

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结果，建
议您按照业务所需，对不同违规类型与建议值进行处理。返回值：Normal：正常，

Porn：色情，Ads：广告。

S

tr
in

g

Sug

gest

ion

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业务所

需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规敏感文

件），2（疑似敏感，建议人工复核）。

I
n

t

e

g
e

r

Por
nInf

o

审核场景为涉黄的审核结果信息。

O

bj
e

c

t

AdsI

nfo
审核场景为广告引导的审核结果信息。

O

bj

e

c

t

节
点

名

称

（
关

键

描述 类
型
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字

）

Hi

tF
la

g

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内容。2：疑
似为当前场景的违规内容。

In

te
g

er

S
c

or

e

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度最高 
），越高代表该内容越有可能属于当前返回审核信息。通常[0,60]分可以认为图片属于正常，

[61,90]分表示图片疑似敏感，[91,100]分表示图片为敏感的。例如：色情 99，则表明该内容

非常有可能属于色情内容。

In
te

g

er

C
at

e

g

or
y

表示命中的具体审核类别。例如 Sexy，表示色情标签中的性感类别。该字段可能为空，表示

未命中或暂无相关的类别。

S

tri

n

g

S

u
b

L

a

b

el

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标签。注意：该字段

可能返回空，表示未命中具体的子标签。

S
tri

n

g

O

cr

R
e

s

ul

ts

该字段表示 OCR 文本识别的详细检测结果，包括文本坐标信息、文本识别结果等信息，有相
关违规内容时返回。

A

rr
a

y

Li

b
R

e

s

ul

ts

该字段用于返回基于风险库识别的结果。注意：未命中风险库中样本时，此字段不返回。

C

o

nt

ai
n

er 

A

rr
a

y
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Container 节点 LibResults 的内容：

OcrResults 的具体内容如下：

ObjectResults 的具体内容如下：

节点

名称

（关
键

字）

描述
类

型

Imag
eId

该字段表示命中的风险库中的图片样本 ID。

S

tr
in

g

Scor

e

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100（置信度最高 

），越高代表当前的图片越有可能命中库中的样本。例如：色情 99，表明该数据非常有可

能命中库中的色情样本。

I
n

t

e

g

e
r

节点名称

（关键字）
描述

类

型

Text 图片 OCR 文本识别出的具体文本内容。
Str
ing

Keyword

s
在当前审核场景下命中的关键词。

Arr

ay

Location
该参数用于返回 OCR 检测框在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位识别文字的相关信息。

Ob

jec

t

节点名称（关

键字）
描述 类型

Name 该标签用于返回所识别出的实体名称，例如人名。
Stri

ng

Location
该参数用于返回检测结果在图片中的位置（左上角 xy 坐标、长宽、旋转角
度），以方便快速定位相关信息。

Obj
ect
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Location 的具体内容如下：

UserInfo 的内容：

节点名称

（关键

字）

描述
类

型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Fl
o

a

t

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Fl

o

a

t

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl

o

a

t

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl

o

a
t

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测

框的具体位置；取值：0-360（角度制），方向为逆时针旋转。

Fl

o

a
t

节点名称（关键

字）
描述 类型

是否必

选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin
g

否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin

g
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。 Strin
g

否



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1443 共1701页

Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

Room 一般用于表示房间号信息，长度不超过128字节。
Strin

g
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin

g
否

Type 一般用于表示业务类型，长度不超过128字节。
Strin
g

否

ReceiveTokenI

d

一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin

g
否

Level 一般用于表示等级信息，长度不超过128字节。
Strin
g

否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节点名称（关键字） 描述 类型

ListResults 命中的所有名单结果。 Container Array

节点名称（关键字） 描述 类型

ListType 命中的名单类型，取值为0（白名单）和1（黑名单）。 Integer

ListName 命中的名单名称。 String

Entity 命中了名单中的哪条内容。 String

实际案例

{

  "EventName": "ReviewDocument",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "2021-08-10T21:01:10+08:00",

    "Url": "http://test.com/test.doc",
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    "Label": "Normal",

    "Suggestion": 0,

    "PageCount": 1,

    "Labels": {

      "PornInfo": {

        "HitFlag": 0,

        "Score": 0

      },

      "AdsInfo": {

        "HitFlag": 0,

        "Score": 0

      }

    },

    "PageSegment": {

      "Results": [

      {

        "Url": "http://audit-125000000.cos.ap-chongqing.myqcloud.com/1.jpg",

        "Text": "",

        "PageNumber": 1,

        "SheetNumber": 0,

        "Label": "Normal",

        "Suggestion": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "SubLabel": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "SubLabel": ""

        }

      }

      ]

    },

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}
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网页审核

提交网页审核任务
最近更新时间：2023-03-13 14:18:37

本接口用于提交一个网页审核任务。网页审核功能为异步任务方式，您可以通过提交网页审核任务审核您的网页文

件，然后通过 查询网页审核任务接口  或 网页审核回调  查询审核结果。

该接口支持情况如下：

网页的审核分为网页画面审核、网页文字审核，其中：

对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

功能描述

支持对网页文件进行自动检测，从 OCR 文本识别、物体检测（实体、广告台标、二维码等）、图像识别几个维

度，通过深度学习技术，识别网页中的违规内容。

支持识别多种违规场景，包括：色情、违法、广告等场景。

费用说明

网页画面审核：通过爬取网页内图片的方式，将爬取的多张图片进行审核，审核费用与图片审核一致。

网页文本审核：将网页内的文本分离出来进行文本审核，审核费用与文本审核一致。

每个审核场景单独计费，例如您选择审核涉黄、广告两种场景，则审核1个网页，计2次审核费用。

调用接口会产生 图片审核费用 、 文本审核费用  和 COS 请求费用 。

推荐使用 SDK

请求

请求示例

POST /webpage/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

https://cloud.tencent.com/document/product/436/63959
https://cloud.tencent.com/document/product/436/65810
https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/58119#.E5.9B.BE.E7.89.87.E5.AE.A1.E6.A0.B8.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/460/58119#.E6.96.87.E6.9C.AC.E5.AE.A1.E6.A0.B8.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

  <Input>

    <Url></Url>

        <DataId></DataId>

        <UserInfo></UserInfo>

  </Input>

  <Conf>

    <Biztype></Biztype>

    <Callback></Callback>

    <ReturnHighlightHtml>true</ReturnHighlightHtml>

  </Conf>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 网页审核的具体配置项。 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 需要审核的网页信息。 Container 是

Conf Request 审核规则配置。 Container 是

节点名称

（关键

字）

父节点 描述 类型

是

否

必
选

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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Container 节点 UserInfo 的内容：

Url Requ

est.In
put

网页文件的链接地址，例如 http://www.test.com 。 Stri

ng

是

DataId

Requ

est.In

put

该字段在审核结果中会返回原始内容，长度限制为512字节。您

可以使用该字段对待审核的数据进行唯一业务标识。

Stri

ng
否

UserInf

o

Requ

est.In

put

用户业务字段。

Co

ntai

ner

否

节点名称（关
键字）

父节点 描述
类
型

是否
必选

TokenId
Request.Input.U

serInfo

一般用于表示账号信息，长度不超过128字

节。

Stri

ng
否

Nickname
Request.Input.U

serInfo

一般用于表示昵称信息，长度不超过128字

节。

Stri

ng
否

DeviceId
Request.Input.U
serInfo

一般用于表示设备信息，长度不超过128字
节。

Stri
ng

否

AppId
Request.Input.U

serInfo

一般用于表示 App 的唯一标识，长度不超

过128字节。

Stri

ng
否

Room
Request.Input.U

serInfo

一般用于表示房间号信息，长度不超过128

字节。

Stri

ng
否

IP
Request.Input.U

serInfo

一般用于表示 IP 地址信息，长度不超过

128字节。

Stri

ng
否

Type
Request.Input.U

serInfo

一般用于表示业务类型，长度不超过128字

节。

Stri

ng
否

ReceiveTo

kenId

Request.Input.U

serInfo

一般用于表示接收消息的用户账号，长度不

超过128字节。

Stri

ng
否

Gender
Request.Input.U

serInfo

一般用于表示性别信息，长度不超过128字

节。

Stri

ng
否

Level
Request.Input.U

serInfo

一般用于表示等级信息，长度不超过128字

节。

Stri

ng
否

Role Request.Input.U 一般用于表示角色信息，长度不超过128字 Stri 否
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Container 类型 Conf 的具体数据描述如下：

serInfo 节。 ng

节

点

名
称

（

关

键

字
）

父

节

点

描述
类

型

是
否

必

选

Biz

Ty
pe

R

e
q

u

e

s
t.

C

o

n

f

表示审核策略的唯一标识，您可以通过控制台上的审核策略页面，配置您希望

审核的场景，如涉黄、广告、违法违规等。您可以在控制台上获取到 

BizType。BizType 填写时，此条审核请求将按照该审核策略中配置的场景
进行审核。BizType 不填写时，将自动使用默认的审核策略。

S

tr

in
g

否

Ca

llb

ac

k

R

e

q
u

e

s

t.
C

o

n

f

回调地址，以 http:// 或者 https:// 开头的地址。

S

tr

in

g

否

Re

tur

nH

igh
lig

ht

Ht

ml

R

e

q

u
e

s

t.

C

指定是否需要高亮展示网页内的违规文本，查询及回调结果时会根据此参数决

定是否返回高亮展示的 html 内容。取值为 true 或者 false，默认为 

false。

B

o

ol

e
a

n

否
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

o

n

f

响应

响应头

响应体

<Response>

    <JobsDetail>

      <JobId></JobId>

      <State></State>

      <CreationTime></CreationTime>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 网页审核返回的具体响应内容。 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 网页审核任务的详细信息。 Container

节点名

称（关
键字）

父节点 描述
类

型

DataId

Respons

e.JobsD
etail

请求中添加的 DataId 字段。

S

tr
in

g

JobId Respons 本次网页审核任务的 ID。 S

https://cloud.tencent.com/document/product/460/42866
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

e.JobsD
etail

tr
in

g

State
Respons
e.JobsD

etail

网页审核任务的状态，值为 Submitted（已提交审核）、Success

（审核成功）、Failed（审核失败）、Auditing（审核中）其中一个

S
tr

in

g

Creati

onTim

e

Respons

e.JobsD

etail

网页审核任务的创建时间。

S
tr

in

g

错误码

实际案例

请求

POST /webpage/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

  <Input>

    <Url>http://test.com</Url>

  </Input>

  <Conf>

    <ReturnHighlightHtml>true</ReturnHighlightHtml>

    <DetectType>Porn,Ads</DetectType>

  </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

https://cloud.tencent.com/document/product/460/42867
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Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <CreationTime>2021-11-09T09:55:53+08:00</CreationTime>

        <JobId>sh2c1260a4410011eca1f1525400276c76</JobId>

        <State>Submitted</State>

        <Url>http://test.com</Url>

    </JobsDetail>

    <RequestId>NjE4OWQ1Mjlf*****MzQ0OF85</RequestId>

</Response>
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查询网页审核任务结果
最近更新时间：2023-05-06 18:05:08

本接口用于主动查询指定的网页审核任务结果。网页审核功能为异步任务方式，您可以通过提交网页审核任务审核您

的网页文件，然后通过查询网页审核任务接口查询审核结果。

对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能描述

说明

 网页审核任务结果保存时效为3个月，您可通过本接口查询近3个月的审核结果。

推荐使用 SDK

请求

请求示例

GET /webpage/auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称 描述 类型 是否必选

https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

jobId 要查询的任务ID，可通过提交审核任务的响应中获取。 String 是

响应

响应头

响应体

<Response>

  <JobsDetail>

    <JobId></JobId>

    <State>Success</State>

    <Code>Success</Code>

    <Message>Success</Message>

    <Suggestion>1</Suggestion>

    <CreationTime></CreationTime>

    <Url></Url>

    <PageCount>3</PageCount>

    <Labels>

      <PornInfo>

        <HitFlag>1</HitFlag>

        <Score>96</Score>

      </PornInfo>

    </Labels>

    <ImageResults>

      <Results>

        <Url></Url>

        <Text></Text>

        <PornInfo>

          <HitFlag></HitFlag>

          <SubLabel></SubLabel>

          <Score></Score>

          <OcrResults>

            <Text></Text>

            <Keywords></Keywords>

            <Location>

              <X></X>

              <Y></Y>

              <Width></Width>

              <Height></Height>

              <Rotate></Rotate>

            </Location>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

          </OcrResults>

        </PornInfo>

      </Results>

    </ImageResults>

    <TextResults>

      <Results>

        <Text></Text>

        <PornInfo>

          <HitFlag></HitFlag>

          <Score></Score>

          <Keywords></Keywords>

        </PornInfo>

      </Results>

    </TextResults>

  </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 网页审核的全部结果信息。 Container

节点名称

（关键字）
父节点 描述 类型

JobsDetai

l

Resp

onse
网页审核任务的详细信息。

Cont

ainer

RequestId
Resp
onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题
时，该 ID 能更快地协助定位问题

Strin
g

节点

名称

（关

键
字）

父节点 描述
类

型

Co

de

Resp

onse.

错误码，只有 State 为 Failed 时返回，详情请查看 错误码列表 。 S

tr

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1455 共1701页

Jobs

Detail

in

g

Me

ssa

ge

Resp

onse.

Jobs

Detail

错误描述，只有 State 为 Failed 时返回。

S

tr

in

g

Job

Id

Resp

onse.

Jobs

Detail

网页审核任务的 ID。

S

tr

in

g

Dat

aId

Resp

onse.

Jobs

Detail

提交任务时设置了 DataId 参数时返回，返回原始内容，长度限制为512字节。

您可以使用该字段对待审核的数据进行唯一业务标识。

S

tr

in

g

Sta

te

Resp

onse.

Jobs
Detail

网页审核任务的状态，值为 Submitted（已提交审核）、Success（审核成

功）、Failed（审核失败）、Auditing（审核中）其中一个。

S

tr

in
g

Cre

atio

nTi

me

Resp

onse.

Jobs

Detail

网页审核任务的创建时间。

S

tr

in

g

Url

Resp

onse.
Jobs

Detail

本次审核的文件链接，创建任务使用 Url 时返回。

S

tr
in

g

Lab

els

Resp

onse.

Jobs
Detail

该字段用于返回检测结果中所对应的恶意标签集合。

C

o

n

t

ai
n

e

r

Sug

ges

tion

Resp

onse.

Jobs

Detail

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您

按照业务所需，对不同的审核结果进行相应处理。

有效值：0（审核正常），1 （判定为违规敏感文件），2（疑似敏感，建议人

工复核）

I

n

t

e

g
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e

r

Lab

el

Resp

onse.

Jobs

Detail

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审

核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：

Normal：正常，Porn：色情，Ads：广告等。

S

tr

in

g

Pag

eC

oun

t

Resp

onse.

Jobs

Detail

网页审核会将网页中的图片链接和文本分开送审，该字段表示送审的链接和文本

总数量。

I
n

t

e

g

e

r

Ima

ge

Res

ults

Resp

onse.

Jobs

Detail

网页内图片的审核结果。

C
o

n

t

ai

n

e

r

Tex

tRe

sult

s

Resp

onse.

Jobs

Detail

网页内文字的审核结果。

C
o

n

t

ai

n

e

r

Hig
hlig

htH

tml

Resp
onse.

Jobs

Detail

对违规关键字高亮处理的 Html 网页内容，请求内容指定 

ReturnHighlightHtml 时返回。

S
tr

in

g

Us

erIn

fo

Resp

onse.

Jobs

Detail

用户业务字段。创建任务未设置 UserInfo 时无此字段。 C

o

n

t
ai

n

e

r
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Container 节点 Labels 的内容：

Container 节点 PornInfo，AdsInfo 的内容：

Container 节点 ImageResults 的内容：

Container 节点 Results 的内容：

节点名称（关键

字）
父节点 描述 类型

PornInfo
Response.JobsDetail.La

bels
审核场景为涉黄的审核结果信息。

Contain

er

AdsInfo
Response.JobsDetail.La

bels

审核场景为广告引导的审核结果信

息。

Contain

er

节点

名称

（关

键

字）

父节点 描述
类

型

HitFl
ag

Response

.JobsDet
ail.Labels

.*Info

用于返回该审核场景的审核结果，返回值：

0：正常。

1：确认为当前场景的违规内容。

2：疑似为当前场景的违规内容。

Int
eg

er

Scor

e

Response

.JobsDet

ail.Labels

.*Info

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最

低）-100（置信度最高 ），越高代表该内容越有可能属于当前返回审

核信息

例如：色情 99，则表明该内容非常有可能属于色情内容。

Int

eg

er

节点名称

（关键字）
父节点 描述 类型

Results
Response.JobsDetail.I

mageResults

网页内图片审核的结果，审核多张图片将

返回多个 Results 。

Containe

r Array

节点

名称

（关

键

字）

父节点 描述
类

型
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Container 节点 PornInfo，AdsInfo的内容：

Url Response.JobsD
etail.ImageResult

s.Results

网页中图片审核，被审核图片的访问地址，您可以通过该地址查
看图片，地址格式为标准 URL 格式。

St
ri

n

g

Text

Response.JobsD

etail.ImageResult

s.Results

该字段用于返回当前图片的 OCR 文本识别的检测结果，仅在

审核策略开启文本内容检测时返回。

St

ri

n

g

Lab

el

Response.JobsD

etail.ImageResult

s.Results

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表

示模型推荐的审核结果，建议您按照业务所需，对不同违规类型

与建议值进行处理。

返回值：Normal：正常，Porn：色情，Ads：广告。

St

ri

n

g

Sug

gesti

on

Response.JobsD

etail.ImageResult

s.Results

该字段表示本次判定的审核结果，您可以根据该结果，进行后续

的操作；建议您按照业务所需，对不同的审核结果进行相应处

理。

有效值：0（审核正常），1 （判定为违规敏感文件），2（疑
似敏感，建议人工复核）

In

te

g
er

Porn

Info

Response.JobsD

etail.ImageResult

s.Results

审核场景为涉黄的审核结果信息。

C

o

nt

ai

n

er

AdsI

nfo

Response.JobsD

etail.ImageResult

s.Results

审核场景为广告引导的审核结果信息。

C

o

nt

ai

n

er

节点

名称

（关

键

字）

父节点 描述 类型

HitF

lag

Response.JobsDe

tail.ImageResults.
Results.*Info

用于返回该审核场景的审核结果，返回值：

0：正常。

1：确认为当前场景的违规内容。

Inte

ger
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Container 节点 OcrResults 的内容：

ObjectResults 的具体内容如下：

2：疑似为当前场景的违规内容。

Sco

re

Response.JobsDe

tail.ImageResults.

Results.*Info

该字段表示审核结果命中审核信息的置信度，取值范围：0

（置信度最低）-100（置信度最高 ），越高代表该内容越

有可能属于当前返回审核信息。

例如：色情 99，则表明该内容非常有可能属于色情内容。

Inte

ger

Cat

ego

ry

Response.JobsDe

tail.ImageResults.

Results.*Info

该字段为 Label 的子集，表示审核命中的具体审核类别。例

如 Sexy，表示色情标签中的性感类别。

Stri

ng

Sub

Lab

el

Response.JobsDe

tail.ImageResults.

Results.*Info

该字段表示审核命中的具体子标签，例如：Porn 下的 

SexBehavior 子标签。

注意：该字段可能返回空，表示未命中具体的子标签。

Stri

ng

Ocr

Res

ults

Response.JobsDe

tail.ImageResults.

Results.*Info

该字段表示 OCR 文本识别的详细检测结果，包括文本坐标

信息、文本识别结果等信息，有相关违规内容时返回。

Con
tain

er 

Arr

ay

节点名
称（关

键字）

父节点 描述
类
型

Text

Response.JobsDetail.

ImageResults.Results

.*Info.OcrResults

图片 OCR 文本识别出的具体文本内容。
Str

ing

Keywo
rds

Response.JobsDetail.

ImageResults.Results
.*Info.OcrResults

在当前审核场景下命中的关键词。

Str

ing 
Arr

ay

Locati

on

Response.JobsDetail.

ImageResults.Results

.*Info.OcrResults

该参数用于返回 OCR 检测框在图片中的位置（左上

角 xy 坐标、长宽、旋转角度），以方便快速定位识

别文字的相关信息。

Co

nta

ine

r

节点名

称（关

键字）

父节点 描述
类

型
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Location 的具体内容如下：

Container 节点 TextResults 的内容：

Nam

e

Response.JobsDetail.Image

Results.Results.*Info.Object

Results

该标签用于返回所识别出的实体名称，例如人

名。

St

rin

g

Loca

tion

Response.JobsDetail.Image

Results.Results.*Info.Object

Results

该参数用于返回检测结果在图片中的位置（左上

角 xy 坐标、长宽、旋转角度），以方便快速定

位相关信息。

C

on

tai

ne

r

节点名称

（关键

字）

描述
类

型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Fl

o

a

t

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Fl

o

a

t

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl

o

a
t

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl

o

a

t

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测
框的具体位置；取值：0-360（角度制），方向为逆时针旋转。

Fl

o
a

t

节点名称

（关键字）
父节点 描述 类型
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Container 节点 Results 的内容：

Results Response.JobsDetail.

TextResults

网页内文本审核的结果，审核多条文本将

返回多个 Results 。

Containe

r Array

节

点

名
称

（

关

键

字

）

父节点 描述
类

型

Te
xt

Response.J

obsDetail.Te
xtResults.Re

sults

网页文本将进行分段送审，每10000个 utf8 编码字符分一段，该参数
返回本段文本内容。

S

tr
in

g

La

bel

Response.J

obsDetail.Te

xtResults.Re

sults

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型

推荐的审核结果，建议您按照业务所需，对不同违规类型与建议值进行

处理。 返回值：Normal：正常，Porn：色情，Ads：广告。

S

tr

in

g

Su

gg

est

ion

Response.J

obsDetail.Te

xtResults.Re

sults

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操

作；建议您按照业务所需，对不同的审核结果进行相应处理。

有效值：0（审核正常），1 （判定为违规敏感文件），2（疑似敏感，

建议人工复核）

I
n

t

e

g

e

r

Po

rnI

nfo

Response.J

obsDetail.Te

xtResults.Re

sults

审核场景为涉黄的审核结果信息。

C
o

n

t

ai

n

e

r

Ad
sIn

fo

Response.J
obsDetail.Te

xtResults.Re

sults

审核场景为广告引导的审核结果信息。 C
o

n

t



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1462 共1701页

Container 节点 PornInfo，AdsInfo 的内容：

Container 节点 UserInfo 的内容：

ai

n

e

r

节点

名称

（关

键

字）

父节点 描述
类

型

HitFl

ag

Response.JobsDe

tail.TextResults.R

esults.*Info

用于返回该审核场景的审核结果，返回值：

0：正常。

1：确认为当前场景的违规内容。

2：疑似为当前场景的违规内容。

I
n

t

e

g

e

r

Scor

e

Response.JobsDe

tail.TextResults.R

esults.*Info

该字段表示审核结果命中审核信息的置信度，取值范围：0（置

信度最低）-100（置信度最高 ），越高代表该内容越有可能

属于当前返回审核信息。

I
n

t

e

g

e

r

Key

wor
ds

Response.JobsDe

tail.TextResults.R
esults.*Info

在当前审核场景下命中的关键词，多关键词以 ``,`` 分隔。

S

tr
in

g

节点名称（关键

字）
父节点 描述 类型

TokenId
Response.JobsDetail.Us
erInfo

用户业务 TokenId，长度不超过128
字节。

Stri
ng

Nickname
Response.JobsDetail.Us

erInfo

用户业务 Nickname，长度不超过

128字节。

Stri

ng

DeviceId Response.JobsDetail.Us 用户业务 DeviceId，长度不超过128 Stri
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

erInfo 字节。 ng

AppId
Response.JobsDetail.Us

erInfo

用户业务 AppId，长度不超过128字

节。

Stri

ng

Room
Response.JobsDetail.Us

erInfo

用户业务 Room，长度不超过128字

节。

Stri

ng

IP
Response.JobsDetail.Us

erInfo
用户业务 IP，长度不超过128字节。

Stri

ng

Type
Response.JobsDetail.Us

erInfo

用户业务 Type，长度不超过128字

节。

Stri

ng

错误码

实际案例

请求

GET /webpage/auditing/vab1ca9fc8a3ed11ea834c525400863904 HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Tue, 09 Nov 2021 01:56:09 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <CreationTime>2021-11-09T10:03:32+08:00</CreationTime>

    <HighlightHtml>xxxxx</HighlightHtml>

    <ImageResults>

      <Results>

        <AdsInfo>

          <HitFlag>0</HitFlag>

https://cloud.tencent.com/document/product/460/42867
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          <Score>0</Score>

          <SubLabel/>

        </AdsInfo>

        <Label>Porn</Label>

        <PornInfo>

          <HitFlag>1</HitFlag>

          <Score>99</Score>

          <SubLabel>ACGPorn</SubLabel>

        </PornInfo>

        <Suggestion>1</Suggestion>

        <Text>xxxxxxx</Text>

        <Url>xxxxxx</Url>

      </Results>

    </ImageResults>

    <JobId>sh3dba0967410111eca1f1525400276c76</JobId>

    <Label>Porn</Label>

    <Labels>

      <AdsInfo>

        <HitFlag>0</HitFlag>

        <Score>0</Score>

      </AdsInfo>

      <PornInfo>

        <HitFlag>1</HitFlag>

        <Score>99</Score>

      </PornInfo>

    </Labels>

    <PageCount>2</PageCount>

    <State>Success</State>

    <Suggestion>1</Suggestion>

    <TextResults>

      <Results>

        <AdsInfo>

          <HitFlag>0</HitFlag>

          <Keywords/>

          <Score>0</Score>

        </AdsInfo>

        <Label>Porn</Label>

        <PornInfo>

          <HitFlag>1</HitFlag>

          <Keywords>xxxx</Keywords>

          <Score>98</Score>

        </PornInfo>

        <Suggestion>1</Suggestion>

        <Text>xxxx</Text>

      </Results>
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    </TextResults>

    <Url>https://xxxx</Url>

  </JobsDetail>

  <RequestId>NjE4OWQ3MDNfY****RfMzQ0OF9h</RequestId>

</Response>
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网页审核回调内容
最近更新时间：2022-10-14 10:20:29

若您配置了审核回调地址，在网页审核结束后，后台会将审核结果以 json 形式回调至您的回调地址。您可以通过回

调内容，进行后续的文件处理操作。

功能描述
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该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

回调内容说明

{

  "EventName": "ReviewHtml",

  "JobsDetail": {

    "JobId": "6666666666666666666666666666666666",

    "State": "Success",

    "CreationTime": "",

    "Url": "",

    "Label": "Normal",

    "Suggestion": 0,

    "PageCount": 1,

    "Labels": {

      "PornInfo": {

        "HitFlag": 0,

        "Score": 0

      },

      "AdsInfo": {

        "HitFlag": 0,

        "Score": 0

      }

    },

    "ImageResults": {

      "Results": [

      {

        "Url": "",

        "Text": "",

        "Label": "Normal",

        "Suggestion": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "SubLabel": "",

          "OcrResults": [{

            "Text": "",

            "Keywords":["",""],

            "Location": {

              "X": 0,

              "Y": 0,

              "Width": 0,

              "Height": 0,
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具体的数据内容如下：

              "Rotate": 0

            }

          }]

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "SubLabel": ""

        }

      }

      ]

    },

    "TextResults": {

      "Results": [

      {

        "Text": "",

        "Label": "Normal",

        "Suggestion": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        }

      }

      ]

    },

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "666666"

    }

  }

}

节点名称（关键字） 描述 类型

JobsDetail 任务的详细结果信息。 Object
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JobsDetail 的内容如下：

EventName 任务的类型，为 ReviewHtml 。 String

节点

名称

（关
键

字）

描述
类
型

Cod

e
错误码，只有 State 为 Failed 时返回。详情请查看 错误码列表 。

S

tr

in

g

Mes

sag

e

错误描述，只有 State 为 Failed 时返回。

S

tr

in

g

JobI

d
审核任务的 ID。

S

tr

in

g

Dat

aId

提交任务时设置了 DataId 参数时返回，返回原始内容，长度限制为512字节。您可以使用

该字段对待审核的数据进行唯一业务标识。

S

tr

in

g

Stat

e

审核任务的状态，值为 Submitted（已提交审核）、Success（审核成功）、Failed

（审核失败）、Auditing（审核中）其中一个。

S

tr

in
g

Lab

el

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结果，建

议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：Normal：正常，

Porn：色情，Ads：广告等。

S

tr

in

g

Sug

gest

ion

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业务所

需，对不同的审核结果进行相应处理。 有效值：0（审核正常），1 （判定为违规敏感文

件），2（疑似敏感，建议人工复核）。

In

t
e

g

e

r

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1470 共1701页

Cre

atio

nTi

me

审核任务的创建时间。 S

tr

in

g

Url 审核的网页链接，创建任务使用 Url 时返回。

S

tr

in

g

Pag
eCo

unt

网页审核会将网页中的图片链接和文本分开送审，该字段表示送审的链接和文本总数量。

In

t
e

g

e

r

Lab

els
该字段用于返回命中的审核场景及对应的结果。

O

bj

e

ct

Ima

geR

esul

ts

网页内图片的审核结果。

O

bj

e

ct

Text

Res

ults

网页内文字的审核结果。

O

bj

e
ct

Hig

hlig

htHt

ml

对违规关键字高亮处理的 HTML 网页内容，请求内容指定 ReturnHighlightHtml 时返

回。

S

tr

in

g

Use
rInf

o

用户业务字段。当创建任务时未设置 UserInfo 则无此字段。

O

bj
e

ct

ListI

nfo

账号黑白名单结果。 C

o

n

ta

in
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Labels 的内容如下：

Labels 中 PornInfo，AdsInfo 的内容如下：

ImageResults 的内容如下：

Results 的内容如下：

e

r

节点名称（关键字） 描述 类型

PornInfo 审核场景为涉黄的审核结果信息。 Object

AdsInfo 审核场景为广告引导的审核结果信息。 Object

节点

名称

（关

键
字）

描述
类

型

HitFl

ag

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内容。2：

疑似为当前场景的违规内容。

I

n

t

e

g

e

r

Scor

e

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度

最高 ），越高代表该内容越有可能属于当前返回审核信息。例如：色情 99，表明该内容非

常有可能属于色情内容。

I

n

t

e

g

e

r

节点名称（关键字） 描述 类型

Results 网页内图片审核的结果。 Array

节点

名称

（关

描述 类

型
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Results 中 PornInfo，AdsInfo 的内容如下：

键

字）

Url
网页中图片审核，被审核图片的访问地址，您可以通过该地址查看图片，地址格式为标准 

URL 格式。

S

tr

in
g

Text
该字段用于返回当前图片的 OCR 文本识别的检测结果，仅在审核策略开启文本内容检测时

返回。

S

tr

in

g

Lab
el

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结果，建
议您按照业务所需，对不同违规类型与建议值进行处理。返回值：Normal：正常，

Porn：色情，Ads：广告。

S

tr
in

g

Sug

gest

ion

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业务所

需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规敏感文

件），2（疑似敏感，建议人工复核）。

I

n

t

e

g
e

r

Por

nInf

o

审核场景为涉黄的审核结果信息。

O

bj

e

c

t

AdsI

nfo
审核场景为广告引导的审核结果信息。

O

bj

e

c

t

节
点

名

称

（

关

描述 类
型
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键

字
）

Hi

tF

la

g

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内容。2：疑

似为当前场景的违规内容。

In

te

g

er

S

c
or

e

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度最高 

），越高代表该内容越有可能属于当前返回审核信息。通常[0,60]分可以认为图片属于正常，
[61,90]分表示图片疑似敏感，[91,100]分表示图片为敏感的。例如：色情 99，表明该内容

非常有可能属于色情内容。

In

te
g

er

C

at

e

g

or

y

表示命中的具体审核类别。例如 Sexy，表示色情标签中的性感类别。该字段可能为空，表示

未命中或暂无相关的类别。

St

ri

n

g

S

u

b

L

a

b

el

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标签。

注意：该字段可能返回空，表示未命中具体的子标签。

St

ri

n

g

O

cr

R

e

s

ul

ts

该字段表示 OCR 文本识别的详细检测结果，包括文本坐标信息、文本识别结果等信息，有相

关违规内容时返回。

A

rr

a

y

Li

b

R

e

s

ul

ts

该字段用于返回基于风险库识别的结果。

注意：未命中风险库中样本时，此字段不返回。

C

o

nt

ai

n

er 

A

rr

a
y
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Container 节点 LibResults 的内容：

OcrResults 的具体内容如下：

ObjectResults 的具体内容如下：

节点

名称

（关

键
字）

描述
类

型

Imag

eId
该字段表示命中的风险库中的图片样本 ID。

S

tr

in

g

Scor

e

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100（置信度最高 

），越高代表当前的图片越有可能命中库中的样本。例如：色情 99，表明该数据非常有可

能命中库中的色情样本。

I

n
t

e

g

e

r

节点名称

（关键字）
描述

类

型

Text 图片 OCR 文本识别出的具体文本内容。
Str

ing

Keyword

s
在当前审核场景下命中的关键词。

Arr

ay

Location
该参数用于返回 OCR 检测框在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位识别文字的相关信息。

Ob

jec

t

节点名称（关

键字）
描述 类型

Name 该标签用于返回所识别出的实体名称，例如人名。
Stri

ng

Location 该参数用于返回检测结果在图片中的位置（左上角 xy 坐标、长宽、旋转角 Obj
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Location 的具体内容如下：

TextResults 的具体内容如下：

Results 的具体内容如下：

度），以方便快速定位相关信息。 ect

节点名称

（关键

字）

描述
类

型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Fl

o

a

t

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Fl

o

a

t

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl

o

a
t

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl

o

a

t

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测
框的具体位置；取值：0-360（角度制），方向为逆时针旋转。

Fl

o
a

t

节点名称（关键字） 描述 类型

Results 网页内文本审核的结果。 Array

节点

名称

（关

键

字）

描述
类

型
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PornInfo，AdsInfo 的具体内容如下：

Text 网页文本将进行分段送审，每10000个 utf8 编码字符分一段，该参数返回本段文本内容。 S

tr

in

g

Lab

el

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结果，建

议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：Normal：正常，

Porn：色情，Ads：广告。

S

tr

in

g

Sug

gest

ion

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业务所

需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规敏感文

件），2（疑似敏感，建议人工复核）。

I

n

t

e

g

e

r

Por

nInf

o

审核场景为涉黄的审核结果信息。

O

bj

e

c

t

AdsI
nfo

审核场景为广告引导的审核结果信息。

O

bj

e
c

t

节点名称

（关键

字）

描述 类型

HitFlag
用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规

内容。2：疑似为当前场景的违规内容。

Intege

r

Score
该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100

（置信度最高 ），越高代表该内容越有可能属于当前返回审核信息。

Intege

r

Keywo

rds
在当前审核场景下命中的关键词，多关键词以 , 分割。 String

LibRes

ults

该字段用于返回基于风险库识别的结果。

注意：未命中风险库中样本时，此字段不返回。

Contai

ner 
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Container 节点 LibResults 的内容：

Container 节点 UserInfo 的内容：

Array

节点名称（关键

字）
描述 类型

LibType
命中的风险库类型，取值为1（预设黑白库）和2（自定义风险

库）。
Integer

LibName 命中的风险库名称。 String

Keywords
命中的库中关键词。该参数可能会有多个返回值，代表命中的多个关

键词。

String 

Array

节点名称（关

键字）
父节点 描述

类

型

是否

必选

TokenId
Request.Input.U

serInfo

一般用于表示账号信息，长度不超过128字

节。

Stri

ng
否

Nickname
Request.Input.U

serInfo

一般用于表示昵称信息，长度不超过128字

节。

Stri

ng
否

DeviceId
Request.Input.U

serInfo

一般用于表示设备信息，长度不超过128字

节。

Stri

ng
否

AppId
Request.Input.U

serInfo

一般用于表示 App 的唯一标识，长度不超

过128字节。

Stri

ng
否

Room
Request.Input.U

serInfo

一般用于表示房间号信息，长度不超过128

字节。

Stri

ng
否

IP
Request.Input.U

serInfo

一般用于表示 IP 地址信息，长度不超过

128字节。

Stri

ng
否

Type
Request.Input.U

serInfo

一般用于表示业务类型，长度不超过128字

节。

Stri

ng
否

ReceiveTo
kenId

Request.Input.U
serInfo

一般用于表示接收消息的用户账号，长度不
超过128字节。

Stri
ng

否

Gender
Request.Input.U

serInfo

一般用于表示性别信息，长度不超过128字

节。

Stri

ng
否

Level Request.Input.U 一般用于表示等级信息，长度不超过128字 Stri 否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

serInfo 节。 ng

Role
Request.Input.U
serInfo

一般用于表示角色信息，长度不超过128字
节。

Stri
ng

否

节点名称（关键字） 描述 类型

ListResults 命中的所有名单结果。 Container Array

节点名称（关键字） 描述 类型

ListType 命中的名单类型，取值为0（白名单）和1（黑名单）。 Integer

ListName 命中的名单名称。 String

Entity 命中了名单中的哪条内容。 String

实际案例

{

  "EventName": "ReviewHtml",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "2021-08-10T21:01:10+08:00",

    "Url": "http://test.com/test.html",

    "Label": "Normal",

    "Suggestion": 0,

    "PageCount": 2,

    "Labels": {

      "PornInfo": {

        "HitFlag": 0,

        "Score": 0

      },

      "AdsInfo": {

        "HitFlag": 0,

        "Score": 0

      }

    },

    "ImageResults": {

      "Results": [
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      {

        "Url": "http://xxx.xxx.com/a.jpg",

        "Text": "",

        "Label": "Normal",

        "Suggestion": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "SubLabel": "",

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "SubLabel": ""

        }

      }

      ]

    },

    "TextResults": {

      "Results": [

      {

        "Text": "xxxxxxx",

        "Label": "Normal",

        "Suggestion": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        }

      }

      ]

    },

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}
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直播审核

提交直播审核任务
最近更新时间：2022-11-10 10:20:35

本接口用于提交一个直播流审核任务。直播流审核功能为异步任务方式，您可以通过提交直播流审核任务审核您的直

播流，然后通过查询直播流审核任务接口查询审核结果。

该接口支持情况如下：

直播流的审核分为直播画面审核、直播声音审核，其中：

功能描述

说明

支持审核视频直播，例如娱乐直播、线上授课等场景。

支持审核语音直播，例如语音聊天房、在线会议等场景。

支持对直播流进行自动检测，从 OCR 文本识别、物体检测（实体、广告台标、二维码等）、图像识别及音频审

核四个维度，通过深度学习技术，识别直播流中的违规内容。

支持设置回调地址 Callback 获取检测结果，或通过 查询直播审核任务结果  主动轮询获取审核结果详情。

支持识别多种违规场景，包括：色情、违法、广告等场景。

持根据不同的业务场景 配置自定义的审核策略 。支

支持用户 自定义配置风险库 ，打击自定义违规内容。

费用说明

直播画面审核：通过直播流截帧将直播流截取为多张图片进行审核。

直播声音审核：将直播流声音分离出来进行音频审核。

每个审核场景单独计费，例如您选择审核涉黄、广告两种场景，则审核1个直播流，计2次审核费用。

调用接口会产生 直播审核费用 。

说明

 直播审核不会产生截帧费用，已合并至审核费用中。

限制说明

直播流时长支持：5小时以内。

直播流分辨率支持：最大支持1920x1080 (1080p)。

支持的直播流媒体协议：rmtp、hls、http、https 等主流协议。

https://cloud.tencent.com/document/product/436/76264
https://cloud.tencent.com/document/product/460/56345
https://cloud.tencent.com/document/product/436/59080
https://cloud.tencent.com/document/product/436/58965#.E7.9B.B4.E6.92.AD.E5.AE.A1.E6.A0.B8.E5.AE.9A.E4.BB.B7
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对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

默认并发审核路数限制：10路，超过并发审核路数，接口会返回错误。

推荐使用 SDK

请求

请求示例

POST /video/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 数据万象授权粒度详情  文档。

请求头

请求体

<Request>

  <Type>live_video</Type>

  <Input>

    <Url></Url>

    <DataId></DataId>

  </Input>

  <Conf>

    <BizType></BizType>

    <Callback></Callback>

    <CallbackType></CallbackType>

  </Conf>

https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

Container 节点 UserInfo 的内容：

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 直播流审核的具体配置项。 Container 是

节点名称（关键
字）

父节点 描述 类型
是否必
选

Type
Reque

st

审核的任务类型，直播流审核固定为 

live_video。
String 是

Input
Reque

st
包含需要审核的直播流信息。

Contain

er
是

Conf
Reque
st

包含审核规则的配置信息。
Contain
er

是

StorageConf
Reque

st
包含直播流转存的配置信息。

Contain

er
否

节点名称
（关键

字）

父节点 描述 类型

是
否

必

选

Url

Requ

est.In

put

需要审核的直播流播放地址，例如 

rtmp://example.com/live/123。

Stri

ng
是

DataId
Requ
est.In

put

该字段在审核结果中会返回原始内容，长度限制为512字节。您
可以使用该字段对待审核的数据进行唯一业务标识。

Stri
ng

否

UserInf

o

Requ

est.In

put

自定义字段，可用于辅助行为数据分析。

Co

ntai

ner

否
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Container 类型 Conf 的具体数据描述如下：

节点名称（关

键字）

父节点 描述 类

型

是否

必选

TokenId
Request.Input.U

serInfo

一般用于表示账号信息，长度不超过128字

节。

Stri

ng
否

Nickname
Request.Input.U

serInfo

一般用于表示昵称信息，长度不超过128字

节。

Stri

ng
否

DeviceId
Request.Input.U

serInfo

一般用于表示设备信息，长度不超过128字

节。

Stri

ng
否

AppId
Request.Input.U

serInfo

一般用于表示 App 的唯一标识，长度不超

过128字节。

Stri

ng
否

Room
Request.Input.U

serInfo

一般用于表示房间号信息，长度不超过128

字节。

Stri

ng
否

IP
Request.Input.U

serInfo

一般用于表示 IP 地址信息，长度不超过

128字节。

Stri

ng
否

Type
Request.Input.U

serInfo

一般用于表示业务类型，长度不超过128字

节。

Stri

ng
否

ReceiveTo

kenId

Request.Input.U

serInfo

一般用于表示接收消息的用户账号，长度不

超过128字节。

Stri

ng
否

Gender
Request.Input.U

serInfo

一般用于表示性别信息，长度不超过128字

节。

Stri

ng
否

Level
Request.Input.U

serInfo

一般用于表示等级信息，长度不超过128字

节。

Stri

ng
否

Role
Request.Input.U

serInfo

一般用于表示角色信息，长度不超过128字

节。

Stri

ng
否

节

点

名

称

（

关
键

字

）

父

节

点

描述
类

型

是

否

必
选
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Container 类型 StorageConf 的具体数据描述如下：

B

iz

T

y
p

e

R

e

q

u
e

s

t.

C

o

n

f

表示审核策略的唯一标识，您可以通过控制台上的审核策略页面，配置您希望审

核的场景，例如涉黄、广告、违法违规等，配置指引： 设置审核策略 。您可以

在控制台上获取到 BizType。BizType 填写时，此条审核请求将按照该审核

策略中配置的场景进行审核。BizType 不填写时，将自动使用默认的审核策
略。

S

tr

in

g

是

C

al

lb

a

c

k

R
e

q

u

e

s

t.

C

o
n

f

回调地址，以 http:// 或者 https:// 开头的地址。

S

tr

in

g

否

C

al

lb

a

c

k
T

y

p

e

R

e

q

u

e

s
t.

C

o

n

f

回调片段类型，有效值：1（回调全部截帧和音频片段）、2（仅回调违规截帧

和音频片段）。默认为 1。

I

n

t

e
g

e

r

否

节
点

名

称

（

关

键

父节
点

描述 类
型

是
否

必

选
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

字
）

P

at

h

Req

ues

t.St

ora

geC

onf

表示直播流所要转存的路径，直播流的 ts 文件和 m3u8 文件将保存在本桶

该目录下。m3u8 文件保存文件名为 Path/{$JobId}.m3u8，ts 文件的

保存文件名为 Path/{$JobId}-{$Realtime}.ts，其中 Realtime 为17

位 年月日时分秒毫秒 时间。

S

tr

in

g

否

响应

响应头

响应体

<Response>

    <JobsDetail>

      <DataId></DataId>

      <JobId></JobId>

      <State></State>

      <CreationTime></CreationTime>

    </JobsDetail>

    <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 直播流审核返回的具体响应内容。 Container

节点名称

（关键字）
父节点 描述 类型

JobsDeta

il

Resp

onse
直播流审核任务的详细信息。

Cont

ainer

RequestI

d

Resp

onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题

时，该 ID 能更快地协助定位问题。

Strin

g

https://cloud.tencent.com/document/product/460/42866
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Container 节点 JobsDetail 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名

称（关

键字）

父节点 描述
类

型

DataI

d

Respons

e.JobsD

etail

请求中添加的唯一业务标识。

S

tr

in

g

JobId

Respons

e.JobsD

etail

本次直播流审核任务的 ID。

S

tr

in
g

State

Respons

e.JobsD

etail

直播流审核任务的状态，值为 Submitted（已提交审核）、Success

（审核成功）、Failed（审核失败）、Auditing（审核中）其中一个。

S

tr

in

g

Creati
onTim

e

Respons
e.JobsD

etail

直播流审核任务的创建时间。

S

tr
in

g

错误码

实际案例

请求

POST /video/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

  <Type>live_video</Type>

  <Input>

    <Url>rtmp://example.com/live/123</Url>

    <DataId>123-fdrsg-123</DataID>

https://cloud.tencent.com/document/product/460/42867
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  </Input>

  <Conf>

    <Callback>http://callback.com/</Callback>

    <BizType>b81d45f94b91a683255e9a9506f45a11</BizType>

  </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <DataId>123-fdrsg-123</DataID>

    <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

    <State>Submitted</State>

    <CreationTime>2021-08-07T12:12:12+0800</CreationTime>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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取消直播审核任务
最近更新时间：2022-07-04 11:10:39

本接口用于取消一个在进行中的直播审核任务，成功取消后将返回已终止任务的 JobID。

默认接口请求频率限制：20次/秒。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

限制说明

请求

请求示例

POST /video/cancel_auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

<body>

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 数据万象授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

<Response>

    <JobsDetail>

      <DataId></DataId>

      <JobId></JobId>

      <CreationTime></CreationTime>

    </JobsDetail>

    <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 直播审核返回的具体响应内容。 Container

节点名称

（关键字）
父节点 描述 类型

JobsDeta
il

Resp
onse

直播流审核任务的详细信息。
Cont
ainer

RequestI

d

Resp

onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题

时，该 ID 能更快地协助定位问题。

Strin

g

节点名称（关键字） 父节点 描述 类型

DataId Response.JobsDetail 请求中添加的唯一业务标识。 String

JobId Response.JobsDetail 本次直播审核任务的 ID。 String

CreationTime Response.JobsDetail 直播审核任务的创建时间。 String

错误码

实际案例

请求

POST /video/cancel_auditing/<jobId> HTTP/1.1

https://cloud.tencent.com/document/product/460/42867
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Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <DataId>123-fdrsg-123</DataID>

    <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

    <CreationTime>2021-08-07T12:12:12+0800</CreationTime>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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查询直播审核任务结果
最近更新时间：2023-05-06 18:05:18

本接口用于主动查询指定的直播审核任务结果。直播审核功能为异步任务方式，您可以通过提交直播审核任务审核您

的直播流，然后通过查询直播审核任务接口轮询获取审核结果。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

请求

请求示例

GET /video/auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 数据万象授权粒度详情  文档。

请求头

请求体

请求参数

参数名称 描述 类型 是否必选

jobId 要查询的任务ID，可通过提交审核任务的响应中获取。 String 是

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

<Response>

  <JobsDetail>

    <Code>Success</Code>

    <Message>Success</Message>

    <DataId></DataId>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <Type>live_video</Tpye>

    <SnapshotCount></SnapshotCount>

    <Result>1</Result>

    <Label></Label>

    <PornInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </PornInfo>

    <AdsInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </AdsInfo>

    <Snapshot>

        <Url></Url>

        <Text></Text>

        <Label></Label>

        <Result>1</Result>

        <SnapshotTime></SnapshotTime>

        <PornInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Label></Label>

            <Category></Category>

            <SubLabel></SubLabel>

        </PornInfo>

        <AdsInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Label></Label>

            <Category></Category>

            <SubLabel></SubLabel>

        </AdsInfo>

    </Snapshot>

    <AudioSection>

        <Url></Url>
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

          <OffsetTime>0</OffsetTime>

          <Duration>3000</Duration>

        <Text>哈哈哈</Text>

        <Label></Label>

        <Result>1</Result>

        <PornInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Category></Category>

            <Keywords></Keywords>

        </PornInfo>

        <AdsInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Category></Category>

            <Keywords></Keywords>

        </AdsInfo>

    </AudioSection>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 直播审核的全部结果信息。 Container

节点名称

（关键字）
父节点 描述 类型

JobsDeta

il

Resp

onse
直播审核任务的详细信息。

Cont

ainer

RequestI

d

Resp

onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题

时，该 ID 能更快地协助定位问题。

Strin

g

节
点

名

称

父节
点

描述 类
型
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（

关

键

字

）

Co

de

Res

pon

se.J

obs

Det

ail

错误码，只有 State 为 Failed 时返回。详情请查看 错误码列表 。
Str

ing

M

es

sa

ge

Res
pon

se.J

obs

Det

ail

错误描述，只有 State 为 Failed 时返回。
Str

ing

Da
taI

d

Res

pon
se.J

obs

Det

ail

提交任务时设置了 DataId 参数时返回，返回原始内容，长度限制为512字节。

您可以使用该字段对待审核的数据进行唯一业务标识。

Str

ing

Jo

bI
d

Res

pon

se.J

obs
Det

ail

直播审核任务的 ID。
Str

ing

St

at

e

Res

pon

se.J

obs

Det

ail

直播审核任务的状态，值为 Submitted（已提交审核）、Success（审核成

功）、Failed（审核失败）、Auditing（审核中）其中一个。

Str

ing

Cr

ea

tio

nT

im

e

Res

pon

se.J

obs

Det

ail

直播审核任务的创建时间。 Str

ing

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Sn
ap

sh

ot

Co

un

t

Res

pon

se.J

obs

Det

ail

当审核的直播包含视频流时，该字段表示直播截图的总数量。
Str

ing

La

bel

Res
pon

se.J

obs

Det

ail

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审

核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：

Normal：正常，Porn：色情，Ads：广告，以及其他不安全或不适宜的类

型。

Str

ing

Re
sul

t

Res

pon

se.J
obs

Det

ail

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您

按照业务所需，对不同的审核结果进行相应处理。
有效值：0（审核正常），1 （判定为违规敏感内容），2（疑似敏感内容，建议

人工复核）。

Int
eg

er

Po

rnI

nf

o

Res

pon

se.J

obs

Det
ail

审核场景为涉黄的审核结果信息。

Co

nt

ain

er

Ad

sIn

fo

Res

pon

se.J

obs

Det

ail

审核场景为广告引导的审核结果信息。

Co

nt

ain

er

Sn

ap

sh

ot

Res

pon

se.J

obs

Det

ail

该字段用于返回直播中画面截图审核的结果。

Co

nt

ain

er 

Ar

ra

y

Au

di

Res

pon

当审核的直播包含音频流时，该字段用于返回直播中声音审核的结果。如果未检

测音频，则不返回。

Co

nt
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Container 节点 PornInfo，AdsInfo 的内容：

Container 节点 Snapshot 的内容：

oS

ec

tio

n

se.J

obs

Det

ail

ain

er  

Ar

ra

y

Us

erI

nf

o

Res
pon

se.J

obs

Det

ail

用户业务字段。创建任务未设置 UserInfo 时无此字段。

Co

nt

ain

er

Ty

pe

Res

pon
se.J

obs

Det

ail

审核类型，直播审核固定为 live_video。
Str

ing

节点名称（关

键字）
父节点 描述 类型

HitFlag
Response.JobsDet

ail.*Info

是否命中该审核分类，0表示未命中，1表示命

中，2表示疑似。

Inte

ger

Count
Response.JobsDet

ail.*Info
命中该审核分类的截图张数。

Inte

ger

节点

名称

（关

键

字）

父节点 描述
类

型

Url

Respon

se.Jobs
Detail.S

napshot

直播截图的访问地址，您可以通过该地址查看该截图内容，地址格式为标

准 URL 格式。
注意：每次查看数据的有效期为2小时，2小时后如还需查看，请重新发起

查询请求。

Str
ing

Snap

shot

Respon

se.Jobs

该字段返回当前截图的时间戳，单位为毫秒。例如1649387157000。 Int

eg
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Container 节点 PornInfo，AdsInfo 的内容：

Time Detail.S

napshot

er

Text

Respon

se.Jobs

Detail.S

napshot

该字段用于返回当前截图的图片 OCR 文本识别的检测结果，仅在审核策

略开启文本内容检测时返回。

Str

ing

Labe

l

Respon

se.Jobs

Detail.S

napshot

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推

荐的审核结果，建议您按照业务所需，对不同违规类型与建议值进行处

理。 返回值：Normal：正常，Porn：色情，Ads：广告，以及其他不

安全或不适宜的类型。

Str

ing

Resu

lt

Respon

se.Jobs

Detail.S

napshot

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；

建议您按照业务所需，对不同的审核结果进行相应处理。

有效值：0（审核正常），1 （判定为违规敏感内容），2（疑似敏感内

容，建议人工复核）。

Int

eg

er

Porn

Info

Respon

se.Jobs

Detail.S
napshot

审核场景为涉黄的审核结果信息。

Co

nta

ine
r

AdsI

nfo

Respon

se.Jobs

Detail.S

napshot

审核场景为广告引导的审核结果信息。

Co

nta

ine

r

节点

名称

（关

键

字）

父节点 描述 类型

HitFl

ag

Response.Jo

bsDetail.Snap
shot.*Info

是否命中该审核分类，0表示未命中，1表示命中，2表示疑似。
Inte

ger

Scor

e

Response.Jo

bsDetail.Snap

shot.*Info

该字段表示审核结果命中审核信息的置信度，取值范围：0（置

信度最低）-100（置信度最高 ），越高代表该内容越有可能属

于当前返回的审核信息。

例如：色情 99，则表明该内容非常有可能属于色情内容。

Inte

ger

Lab

el

Response.Jo

bsDetail.Snap

该字段表示该截图的综合结果标签（可能为 SubLabel，可能为

人物名字等）。

Strin

g
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Container 节点 LibResults 的内容：

shot.*Info

Cate

gory

Response.Jo

bsDetail.Snap

shot.*Info

该字段表示命中的审核类别。

注意：该字段可能返回空。

Strin

g

Sub

Lab

el

Response.Jo

bsDetail.Snap

shot.*Info

该字段表示审核命中的具体子标签，例如：Porn 下的 

SexBehavior 子标签。

注意：该字段可能返回空，表示未命中具体的子标签。

Strin

g

Ocr

Res

ults

Response.Jo

bsDetail.Snap

shot.*Info

该字段表示 OCR 文本识别的详细检测结果，包括文本坐标信

息、文本识别结果等信息，有相关违规内容时返回。

Cont

aine

r 

Arra

y

LibR

esult

s

Response.Jo

bsDetail.Snap

shot.*Info

该字段用于返回基于风险库识别的结果。

注意：未命中风险库中样本时，此字段不返回。

Cont
aine

r 

Arra

y

节

点
名

称

（

关

键

字

）

父节点 描述
类

型

Im

ag

eId

Response.Job
sDetail.Snaps

hot.*Info.LibR

esults

该字段表示命中的风险库中的图片样本 ID。

S
tr

in

g

Sc

or
e

Response.Job

sDetail.Snaps

hot.*Info.LibR
esults

该字段用于返回当前标签下的置信度，取值范围：0（置信度最

低）-100（置信度最高 ），越高代表当前的图片越有可能命中库中

的样本；如：色情 99，则表明该数据非常有可能命中库中的色情样
本。

I

n

t

e
g

e

r
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OcrResults 的具体内容如下：

ObjectResults 的具体内容如下：

Location 的具体内容如下：

节点名

称（关

键字）

父节点 描述
类

型

Text

Response.JobsDetai

l.Snapshot.*Info.Ocr

Results

图片 OCR 文本识别出的具体文本内容。
Stri

ng

Keyw

ords

Response.JobsDetai

l.Snapshot.*Info.Ocr

Results

在当前审核场景下命中的关键词。

Stri

ng 

Arr

ay

Loca

tion

Response.JobsDetai

l.Snapshot.*Info.Ocr

Results

该参数用于返回 OCR 检测框在图片中的位置（左上角 

xy 坐标、长宽、旋转角度），以方便快速定位识别文字

的相关信息。

Co

nta

ine

r

节点名

称（关

键字）

父节点 描述
类

型

Name

Response.JobsDetail.S

napshot.*Info.ObjectRe

sults

该标签用于返回所识别出的实体名称，例如人名。
Str

ing

Locati

on

Response.JobsDetail.S
napshot.*Info.ObjectRe

sults

该参数用于返回检测结果在图片中的位置（左上角 
xy 坐标、长宽、旋转角度），以方便快速定位相关

信息。

Co
nt

ain

er

节点名称

（关键
字）

描述
类

型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Fl

o

a

t
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Container 节点 AudioSection 的内容：

Y 该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Fl

o
a

t

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl

o

a

t

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl

o

a

t

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测

框的具体位置；取值：0 - 360（角度制），方向为逆时针旋转。

Fl

o

a

t

节

点

名

称

（
关

键

字

）

父节点 描述
类

型

Ur

l

Respons

e.JobsD

etail.Aud

ioSectio
n

直播声音片段的访问地址，您可以通过该地址获取该声音片段的内容，地址格

式为标准 URL 格式。

注意：每次查看数据的有效期为2小时，2小时后如还需查看，请重新发起查

询请求。

S

tr

in

g

Te

xt

Respons

e.JobsD

etail.Aud

ioSectio

n

该字段用于返回当前直播声音片段的 ASR 文本识别的检测结果。

S

tr

in

g

Of
fs

Respons
e.JobsD

该字段返回当前声音片段的时间戳，单位为毫秒，例如1649387157000。 I
n
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Container 节点 PornInfo，AdsInfo 的内容：

et

Ti

m

e

etail.Aud

ioSectio

n

t

e

g

e

r

D

ur

ati

on

Respons

e.JobsD

etail.Aud

ioSectio

n

当前声音片段的长度，单位毫秒。

I
n

t

e

g

e

r

La
be

l

Respons

e.JobsD
etail.Sna

pshot

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的

审核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回
值：Normal：正常，Porn：色情，Ads：广告，以及其他不安全或不适宜

的类型。

S

tr
in

g

R

es

ult

Respons

e.JobsD

etail.Sna

pshot

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议

您按照业务所需，对不同的审核结果进行相应处理。

有效值：0（审核正常），1 （判定为违规敏感内容），2（疑似敏感内容，

建议人工复核）。

I

n

t

e

g
e

r

P

or

nI

nf
o

Respons

e.JobsD

etail.Aud

ioSectio
n

审核场景为涉黄的审核结果信息。

C

o

n

t

ai

n
e

r

A

ds

Inf

o

Respons

e.JobsD

etail.Aud

ioSectio
n

审核场景为广告引导的审核结果信息。

C

o

n

t

ai

n
e

r
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Container 节点 LibResults 的内容：

节点

名称

（关
键

字）

父节点 描述 类型

HitFl

ag

Response.Jobs

Detail.AudioSe

ction.*Info

是否命中该审核分类，0表示未命中，1表示命中，2表示疑

似。

Strin

g

Scor
e

Response.Jobs
Detail.AudioSe

ction.*Info

该字段表示审核结果命中审核信息的置信度，取值范围：0

（置信度最低）-100（置信度最高 ），越高代表该内容越有
可能属于当前返回审核信息

例如：色情 99，则表明该内容非常有可能属于色情内容。

Strin
g

Cate

gory

Response.Jobs

Detail.AudioSe

ction.*Info

该字段表示命中的审核类别。

注意：该字段可能返回空。

Strin

g

Key
wor

ds

Response.Jobs
Detail.AudioSe

ction.*Info

在当前审核场景下命中的关键词，没有时不返回。

Strin

g 
Arra

y

LibR

esult

s

Response.Jobs

Detail.AudioSe

ction.*Info

该字段用于返回基于风险库识别的结果。注意：未命中风险库

中样本时，此字段不返回。

Cont

aine

r 

Arra

y

节点名称

（关键

字）

父节点 描述 类型

LibTyp

e

Response.JobsDetail.Audio

Section.*Info.LibResults

命中的风险库类型，取值为1（预设风险

库）和2（自定义风险库）。

Integ

er

LibNam

e

Response.JobsDetail.Audio

Section.*Info.LibResults
命中的风险库名称。

Strin

g

Keywor

ds

Response.JobsDetail.Audio

Section.*Info.LibResults

命中的库中关键词。该参数可能会有多个

返回值，代表命中的多个关键词。

Strin

g 

Arra

y
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Container 节点 UserInfo 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关

键字）
父节点 描述

类

型

是否

必选

TokenId
Request.Input.U

serInfo

一般用于表示账号信息，长度不超过128字

节。

Stri

ng
否

Nickname
Request.Input.U
serInfo

一般用于表示昵称信息，长度不超过128字
节。

Stri
ng

否

DeviceId
Request.Input.U

serInfo

一般用于表示设备信息，长度不超过128字

节。

Stri

ng
否

AppId
Request.Input.U

serInfo

一般用于表示 App 的唯一标识，长度不超

过128字节。

Stri

ng
否

Room
Request.Input.U
serInfo

一般用于表示房间号信息，长度不超过128
字节。

Stri
ng

否

IP
Request.Input.U

serInfo

一般用于表示 IP 地址信息，长度不超过

128字节。

Stri

ng
否

Type
Request.Input.U

serInfo

一般用于表示业务类型，长度不超过128字

节。

Stri

ng
否

ReceiveTo
kenId

Request.Input.U
serInfo

一般用于表示接收消息的用户账号，长度不
超过128字节。

Stri
ng

否

Gender
Request.Input.U

serInfo

一般用于表示性别信息，长度不超过128字

节。

Stri

ng
否

Level
Request.Input.U

serInfo

一般用于表示等级信息，长度不超过128字

节。

Stri

ng
否

Role
Request.Input.U
serInfo

一般用于表示角色信息，长度不超过128字
节。

Stri
ng

否

错误码

实际案例

请求

GET /video/auditing/vab1ca9fc8a3ed11ea834c525400863904 HTTP/1.1

https://cloud.tencent.com/document/product/460/42867
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Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

    <State>Success</State>

    <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    <Type>live_video</Tpye>

    <SnapshotCount>1</SnapshotCount>

    <Label>Normal</Label>

    <Result>0</Result>

    <PornInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

    </PornInfo>

    <AdsInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

    </AdsInfo>

    <Snapshot>

        <Url>http://examplebucket-1250000000.cos.ap-chongqing.myqcloud.com/0.jpg</U

        <SnapshotTime>1649387157000</SnapshotTime>

        <Text>哈哈</Text>

        <Label>Normal</Label>

        <Result>0</Result>

        <PornInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Label></Label>

            <SubLabel></SubLabel>

        </PornInfo>

        <AdsInfo>
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            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Label></Label>

            <SubLabel></SubLabel>

        </AdsInfo>

    </Snapshot>

    <AudioSection>

        <AdsInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

        </AdsInfo>

        <Duration>30000</Duration>

        <OffsetTime>1649387157000</OffsetTime>

        <Label>Normal</Label>

        <Result>0</Result>

        <PornInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

        </PornInfo>

        <Text>wc xx</Text>

        <Url>https://auditing-1250000000.cos.ap-guangzhou.myqcloud.com/q9MhdztF/0.m

    </AudioSection>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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直播审核回调内容
最近更新时间：2022-10-18 14:19:01

若您配置了审核回调地址，在直播审核结束后，后台会将审核结果以 JSON 形式回调至您的回调地址。您可以通过

回调内容进行后续的处理操作。

回调内容分为简洁回调（Simple）和详细回调（Detail）。

功能描述
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回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Simple  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

回调内容说明

简洁回调（Simple）
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具体的数据内容如下：

data 的具体内容如下：

{

   "code": 0,

   "data": {

       "event":"ReviewVideo",

       "forbidden_status": 0,

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "count": 0

       },

       "result": 0,

       "trace_id": "test_trace_id",

       "url": "test_url",

       "cos_headers": {

           "x-cos-meta-xx": "xx"

       }

   },

   "message": "Test request when setting callback url"

}

参数名

称
描述 类型

是否必

选

code
错误码，值为0时表示审核成功，非0表示审核失败。详情请查看 内容

审核错误码 。

Integ

er
是

messa

ge
错误描述。

Strin

g
是

data 直播审核结果的详细信息。
Obje

ct
是

参数名称 描述
类

型

是

否

必

选

trace_id 请求的 ID，如果是接口创建的异步任务，则为接口返回的 JobId。
St
rin

g

是

https://cloud.tencent.com/document/product/460/8523#.E5.86.85.E5.AE.B9.E5.AE.A1.E6.A0.B8.E9.94.99.E8.AF.AF.E7.A0.81
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xx_info 的具体内容如下：

url 被审核直播的直播地址。 St

rin

g

是

event 触发的事件，此处固定为 ReviewVideo。
St
rin

g

是

result

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建

议您按照业务所需，对不同的审核结果进行相应处理。

有效值：0（审核正常），1 （判定为违规敏感的内容），2（疑似敏感，建

议人工复核）。

Int

eg

er

是

forbidde
n_statu

s

若您设置了自动冻结，该字段表示冻结状态。直播审核不涉及该字段，默认
为0：未冻结。

Int
eg

er

是

cos_hea

ders
资源上传时设置的自定义 header 内容，若未设置则不返回。

O

bj

ec

t

否

porn_inf

o
审核场景为涉黄的审核结果信息。

O
bj

ec

t

否

ads_info 审核场景为广告引导的审核结果信息。

O

bj

ec

t

否

data_id
提交任务时设置了DataId参数时返回，返回原始内容，长度限制为512字

节。

St

rin

g

否

参数名称 描述 类型 是否必选

hit_flag

用于返回该审核场景的审核结果，返回值：
0：正常。

1：确认为当前场景的违规内容。

2：疑似为当前场景的违规内容。

Integer 是

label 命中的标签名称，目前为空。 String 是
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回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Detail  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

count 命中该审核分类的敏感截图张数。 Integer 是

详细回调（Detail）

{

  "EventName": "ReviewVideo",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "",

    "Object": "",

    "Label": "Normal",

    "Result": 0,

    "SnapshotCount": 1,

    "PornInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "Snapshot": [

      {

        "Url": "",

        "Text": "",

        "SnapshotTime": 0,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Label": "",

          "SubLabel": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Label": "",

          "SubLabel": ""

        }

      }
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具体的数据内容如下：

JobsDetail 的具体内容如下：

    ],

    "AudioSection": [

      {

        "Url": "",

        "Text": "",

        "OffsetTime": 0,

        "Duration": 30000,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0

        }

      }

    ],

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxx"

    }

  }

}

节点名称（关键字） 描述 类型

JobsDetail 任务的详细结果信息。 Object

EventName 任务的类型，为 ReviewVideo 。 String

节点名

称（关

键字）

描述
类

型

Code 错误码，只有 State 为 Failed 时返回。详情请查看 错误码列表 。
Str

ing

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Mess

age

错误描述，只有 State 为 Failed 时返回。 Str

ing

JobId 审核任务的 ID。
Str
ing

DataI

d
提交任务时设置了DataId参数时返回，返回原始内容，长度限制为512字节。

Str

ing

State

直播审核任务的状态，值为 Submitted（已提交审核）、Snapshoting（截图

中）、Success（审核成功）、Failed（审核失败）、Auditing（审核中）其中一

个。

Str

ing

Creati

onTim

e

直播审核任务的创建时间。
Str

ing

Url 本次审核的直播链接。
Str

ing

Snaps

hotCo
unt

截图的总数量。直播流状态为 Auditing 的回调中该字段为本次回调包含的截图数量。

Int

eg
er

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结

果，建议您按照业务所需，对不同违规类型与建议值进行处理。

返回值：Normal：正常，Porn：色情，Ads：广告。

Str

ing

Result

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业

务所需，对不同的审核结果进行相应处理。

有效值：0（审核正常），1 （判定为违规敏感文件），2（疑似敏感，建议人工复
核）。

Int

eg
er

PornI

nfo
审核场景为涉黄的审核结果信息。

Ob

jec

t

AdsInf

o
审核场景为广告引导的审核结果信息。

Ob

jec

t

Snaps

hot
该字段用于返回直播中画面截图审核的结果。

Arr

ay

Audio

Sectio

n

该字段用于返回直播中声音审核的结果。如果未检测到声音，则不返回。
Arr

ay
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PornInfo，AdsInfo 的具体内容如下：

Snapshot 的具体内容如下：

Bucke

tId

创建的审核任务所属的存储桶名称。 Str

ing

Regio

n
存储桶所在的地域。

Str

ing

Forbid

State

若您设置了自动冻结，该字段表示视频的冻结状态。0：未冻结，1：已被冻结，2：已

转移文件。

Int

eg

er

CosH

eader

s

资源上传到 COS 时设置的自定义 Header 内容，如果未设置则不返回。map 结构，

key 为自定义 Header 的名称，value 为内容。

Ob

jec

t

UserI

nfo
用户业务字段。创建任务时未设置 UserInfo 则无此字段。

Ob

jec

t

Type 审核类型，直播流审核返回 live_video。
Str

ing

ListInf

o
账号黑白名单结果。

Co

nta

ine

r

节点名称（关键字） 描述 类型

HitFlag 是否命中该审核分类，0表示未命中，1表示命中，2表示疑似。 Integer

Count 命中该审核分类的截图张数。 Integer

节点名称

（关键

字）

描述
类

型

Url

直播截图的访问地址，您可以通过该地址查看该截图内容，地址格式为标准 URL 格

式。

注意：每次查看数据的有效期为2小时，2小时后如还需查看，请发起查询请求。

St

rin

g

Snapsh

otTime
该字段返回当前截图的时间戳，单位为毫秒。例如1649387157000。

Int

eg

er



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1515 共1701页

Snapshot 中 PornInfo，AdsInfo 的具体内容如下：

Text 该字段用于返回当前截图的图片 OCR 文本识别的检测结果，仅在审核策略开启文本

内容检测时返回。

St

rin

g

Label
该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结
果，建议您按照业务所需，对不同违规类型与建议值进行处理。

返回值：Normal：正常，Porn：色情，Ads：广告。

St
rin

g

Result

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业

务所需，对不同的审核结果进行相应处理。

有效值：0（审核正常），1 （判定为违规敏感文件），2（疑似敏感，建议人工复

核）。

Int

eg

er

PornInf

o
审核场景为涉黄的审核结果信息。

O
bj

ec

t

AdsInfo 审核场景为广告引导的审核结果信息。

O

bj

ec

t

节点名称

（关键

字）

描述 类型

HitFlag 是否命中该审核分类，0表示未命中，1表示命中，2表示疑似。
Intege

r

Score

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100

（置信度最高 ），越高代表该内容越有可能属于当前返回审核信息。

例如：色情 99，则表明该内容非常有可能属于色情内容。

Intege

r

Label 该字段表示该截图的综合结果标签（可能为 SubLabel，可能为人物名字等）。 String

Catego

ry

表示命中的具体审核类别。例如 Sexy，表示色情标签中的性感类别。该字段可能

为空，表示未命中或暂无相关的类别。
注意：该字段可能返回空。

String

SubLa

bel

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标签。

注意：该字段可能返回空，表示未命中具体的子标签。
String

OcrRe

sults

该字段表示 OCR 文本识别的详细检测结果，包括文本坐标信息、文本识别结果

等信息，有相关违规内容时返回。

Array
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Container 节点 LibResults 的内容：

OcrResults 的具体内容如下：

ObjectResults 的具体内容如下：

LibRes
ults

该字段用于返回基于风险库识别的结果。
注意：未命中风险库中样本时，此字段不返回。

Contai

ner 
Array

节点

名称

（关

键
字）

描述
类

型

Imag

eId
该字段表示命中的风险库中的图片样本 ID。

S

tr

in

g

Scor

e

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100（置信度最高 

），越高代表当前的图片越有可能命中库中的样本；如：色情 99，则表明该数据非常有可

能命中库中的色情样本。

I

n
t

e

g

e

r

节点名称

（关键字）
描述

类

型

Text 图片 OCR 文本识别出的具体文本内容。
Str

ing

Keyword

s
在当前审核场景下命中的关键词。

Arr

ay

Location
该参数用于返回 OCR 检测框在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位识别文字的相关信息。

Ob

jec

t

节点名称（关

键字）
描述 类型

Name 该标签用于返回所识别出的实体名称，如人名。 Stri
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Location 的具体内容如下：

AudioSection 的具体内容如下：

ng

Location
该参数用于返回检测结果在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位相关信息。

Obj

ect

节点名称

（关键

字）

描述
类

型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Fl

o

a

t

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Fl

o

a

t

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl

o

a

t

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl

o

a

t

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测

框的具体位置；取值：0 - 360（角度制），方向为逆时针旋转。

Fl

o

a
t

节点名称

（关键

字）

描述
类

型

Url

直播声音片段的访问地址，您可以通过该地址获取该声音片段的内容，地址格式为标准

URL 格式。

注意：每次查看数据的有效期为2小时，2小时后如还需查看，请发起查询请求。

St

rin

g

Text 该字段用于返回当前直播声音片段的 ASR 文本识别的检测结果。 St
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AudioSection 中 PornInfo，AdsInfo 的具体内容如下：

rin

g

OffsetTi
me

该字段返回当前声音片段的时间戳，单位为毫秒，例如1649387157000。
Int
eg

er

Duratio

n
当前声音片段的时长，单位毫秒。

Int

eg

er

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结

果，建议您按照业务所需，对不同违规类型与建议值进行处理。
返回值：Normal：正常，Porn：色情，Ads：广告。

St

rin
g

Result 供参考的识别结果，0（正常），1（敏感），2（疑似敏感）。

Int

eg

er

PornInf

o
审核场景为涉黄的审核结果信息。

O

bj

ec
t

AdsInfo 审核场景为广告引导的审核结果信息。

O

bj

ec

t

节点名称

（关键

字）

描述 类型

HitFlag 是否命中该审核分类，0表示未命中，1表示命中，2表示疑似。 Integer

Score

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100

（置信度最高 ），越高代表该内容越有可能属于当前返回审核信息
例如：色情99，则表明该内容非常有可能属于色情内容。

Integer

Catego

ry

表示命中的具体审核类别。例如 Sexy，表示色情标签中的性感类别。该字段可

能为空，表示未命中或暂无相关的类别。

注意：该字段可能返回空。

String

Keywo

rds
在当前审核场景下命中的关键词，没有时不返回。 Array
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Container 节点 LibResults 的内容：

UserInfo 的内容：

LibRes

ults

该字段用于返回基于风险库识别的结果。注意：未命中风险库中样本时，此字段

不返回。

Contai

ner 

Array

节点名称（关键

字）
描述 类型

LibType
命中的风险库类型，取值为1（预设黑白库）和2（自定义风险

库）。
Integer

LibName 命中的风险库名称。 String

Keywords
命中的库中关键词。该参数可能会有多个返回值，代表命中的多个关

键词。

String 

Array

节点名称（关键

字）
描述 类型

是否必

选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin

g
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin
g

否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin

g
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin

g
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin

g
否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否

ReceiveTokenI

d

一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。 Strin 否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

g

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。
Strin
g

否

节点名称（关键字） 描述 类型

ListResults 命中的所有名单结果。 Container Array

节点名称（关键字） 描述 类型

ListType 命中的名单类型，取值为0（白名单）和1（黑名单）。 Integer

ListName 命中的名单名称。 String

Entity 命中了名单中的哪条内容。 String

实际案例

案例一：简洁回调（Simple）

{

   "code": 0,

   "data": {

       "event":"ReviewVideo",

       "forbidden_status": 0,

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "count": 0

       },

       "result": 0,

       "trace_id": "vxzt90jl2dfscxxxxxxxxxxxxxxxxx",

       "url": "https://66665.livepush.myqcloud.com/video.flv",

       "cos_headers": {

           "x-cos-meta-id": "666666"

       }

   },

   "message": "success"
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}

案例二：详细回调（Detail）

{

  "EventName": "ReviewVideo",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "2021-08-10T21:01:10+08:00",

    "Url": "https://66665.livepush.myqcloud.com/video.flv",

    "Label": "Normal",

    "Result": 0,

    "SnapshotCount": 1,

    "PornInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "Snapshot": [

      {

        "Url": "https://video-1250000000.cos.ap-chongqing.myqcloud.com/test/0.jpg",

        "Text": "",

        "SnapshotTime": 41,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Label": "",

          "SubLabel": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Label": "",

          "SubLabel": ""

        }

      }

    ],

    "AudioSection": [
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      {

        "Url": "https://audio-1250000000.cos.ap-guangzhou.myqcloud.com/0.mp3",

        "Text": "",

        "OffsetTime": 0,

        "Duration": 30000,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0

        }

      }

    ],

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}
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任务与工作流

公共请求头部
最近更新时间：2021-03-26 14:11:38

此篇文档将为您介绍在使用 API 时候会使用到的公共请求头部（Request Header），下文提到的头部在之后的

具体 API 文档中不再赘述。

描述

请求头部列表

Hea

der 

名称

描述
类

型
是否必选

Aut

hori

zati
on

携带鉴权信息，用以验证请求合法性的签名信息。

s

tr

in
g

是。

Con

tent

-

Len

gth

RFC 2616 中定义的 HTTP 请求内容长度（字节）。

in

t

e

g

e

r

否。针对 PUT 和 

POST 请求，此头部是

必选项。

Con

tent

-

Typ

e

RFC 2616 中定义的 HTTP 请求内容类型（MIME），例如 

application/xml。

s

tr

in

g

否。针对有请求体的 

PUT 和 POST 请求，

此头部是必选项。

Con

tent

-
MD

5

RFC 1864 中定义的经过 Base64 编码的请求体内容 MD5 

哈希值，例如 ZzD3iDJdrMAAb00lgLLeig==。此头部用
于完整性检查，验证请求体在传输过程中是否发生变化。

s

tr
in

g

否。

Dat

e

RFC 1123 中定义的 GMT 格式当前时间，例如 Wed, 29 

May 2019 04:10:12 GMT。

s

tr

in

g

否。
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Hos
t

请求的主机，形式为 <BucketName-APPID>.ci.
<Region>.myqcloud.com

s
tr

in

g

是。

x-

ci-

sec

urity
-

toke

n

使用临时安全凭证时需要传入的安全令牌字段。

s

tr

in
g

否。当使用临时密钥并

通过 Authorization 

携带鉴权信息时，此头
部为必选项。
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公共响应头部
最近更新时间：2021-03-26 14:11:43

此篇文档将为您介绍在使用 API 时候会出现的公共返回头部（Response Header），下文提到的头部会在之后

的具体 API 文档中不再赘述。

描述

响应头部列表

Header 名称 描述 类型

Content-
Length

RFC 2616 中定义的 HTTP 响应内容长度（字节）。
stri
ng

Content-

Type
RFC 2616 中定义的 HTTP 响应内容类型（MIME）。

stri

ng

Connection
RFC 2616 中定义，表明响应完成后是否会关闭网络连接。枚举值：keep-

alive，close。

En

um

Date
RFC 1123 中定义的 GMT 格式服务端响应时间，例如Wed, 29 May 2019 
04:10:12 GMT。

stri
ng

Server 接受请求并返回响应的服务器的名称，默认值：tencent-ci。
stri

ng

x-ci-

request-id
每次请求发送时，服务端将会自动为请求生成一个 ID。

stri

ng

x-ci-trace-
id

每次请求出错时，服务端将会自动为这个错误生成一个ID。仅当请求出错时才会
在响应中包含此头部。

stri
ng
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错误码
最近更新时间：2022-03-21 16:03:06

本文将为您介绍请求出错时返回的错误码和对应错误信息。

Content-Type：application/xml

对应 HTTP 状态码：3XX，4XX，5XX。

具体的节点描述如下：

Container 节点 Error 的内容：

概述

错误响应

响应体

<?xml version='1.0' encoding='utf-8' ?>

<Error>

    <Code>string</Code>

    <Message>string</Message>

    <RequestId>string</RequestId>

    <TraceId>string</TraceId>

</Error>

节点名称（关键字） 父节点 描述 类型

Error 无 包含所有的错误信息 Container

节点名称

（关键字）

父

节

点

描述
类

型

Code

Er

ro

r

错误码，用来定位唯一的错误条件和确定错误场景，具体错误码见下文
str

ing

Message

Er

ro

r

具体的错误信息
str

ing

RequestId Er
ro

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题时，该 
ID 能更快地协助定位问题

str
ing
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3XX 类型错误

4XX 类型错误

r

TraceId

Er

ro

r

每次请求出错时，服务端将会自动为这个错误生成一个ID，遇到问题时，

该 ID 能更快地协助定位问题

str

ing

错误码列表

错误码 描述 HTTP状态码

PermanentR

edirect

该资源已经被永久改变了位置，请利用 HTTP Location 响应

头部来重定向到正确的新位置

301 Moved 

Permanently

TemporaryR

edirect

该资源已经被临时改变了位置，请利用 HTTP Location 响应

头部来重定向到正确的新位置

307 Temporary 

Redirect

错误码 描述 HTTP 状态码

InvalidArgument 请求的部分参数不符合要求 400 Bad Request

MissingContent 缺少包体 400 Bad Request

InvalidContent
发送的包体格式不正确或者与 

Content-MD5  值不同
400 Bad Request

InvalidHost Host  验证失败 400 Bad Request

ResourceNotFound 指定的输入资源不存在 400 Bad Request

ResourceAccessDen

ied

没有权限操作指定的资源，请检查是否赋

权
400 Bad Request

ResourceDownloadF

ailed
指定的输入资源下载失败 400 Bad Request

CIRoleNotExist 万象角色CI_QCSRole不存在 400 Bad Request

ResourceNotSupport

ed
文件有问题或不支持 400 Bad Request

MissingAuthorization 缺少 Authorization 401 Unauthorized

InvalidAuthorization Authorization  格式不正确 401 Unauthorized

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42865
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5XX 类型错误

AccessDenied 没有权限 401 Unauthorized

SecretidNotExist 该密钥不存在 401 Unauthorized

SignatureExpired 签名已过期 401 Unauthorized

AccessDenied 禁止此操作 403 Forbidden

MediaBucketAlready

Binded
该存储桶已经被绑定 403 Forbidden

QueueSaturated 该队列已满 403 Forbidden

QueuePaused 该队列已暂停 403 Forbidden

InvalidUrl 请求的 Url 格式不正确 404 Not Found

AuditingJobNotFoun

d
审核Job不存在 404 Not Found

MissingContentLengt

h
Content-Length  请求头部缺失 411 Length Required

InvalidContent 发送的包体过大 413 Payload Too Large

SlowDown 请降低访问频率 429 Too Many Requests

UnavailableForLegal

Reasons
因法律原因不可用。请 联系我们

451 Unavailable For Legal 

Reasons

错误码 描述 HTTP 状态码

InternalError 服务端内部错误 500 Internal Server

NotImplemented 请求尚未实现 501 Not Implemented

ServiceUnavailable 服务暂不可用，请重试 503 Service Unavailable

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/37708
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工作流接口

创建工作流
最近更新时间：2022-12-12 16:32:42

创建工作流。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

对于输入的视频文件进行截图和转码处理。视频转码后, 同时进行转封装处理和生成智能封面, 然后对生成的封

面进行图片处理。

功能描述

请求

请求示例

POST /workflow HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求体1 请求体2

<Request>

    <MediaWorkflow>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCove

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicP

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteOb

                        </Output>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1531 共1701页

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1532 共1701页

具体数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 MediaWorkflow 的具体数据描述如下：

Container 类型 Topology 的具体数据描述如下：

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

MediaWorkflow Request 工作流节点 Container 是

节点名称

（关键字）
父节点 描述 类型

是否

必选
限制

Name
Request.Media

Workflow

工作

流名

称

Strin

g
是

支持中文、英文、数字、—和_，

长度限制128字符

State
Request.Media
Workflow

工作

流状
态

Strin
g

否 Paused/Active

Topology
Request.Media

Workflow

拓扑

信息

Cont

ainer
是 无

节点名称（关键
字）

父节点 描述 类型
是否必
选

限
制

Dependencie

s

Request.MediaWorkflow.To

pology

节点依赖

关系

Contain

er
是 无
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Container 类型 Nodes 的具体数据描述如下：

Nodes Request.MediaWorkflow.To

pology

节点列表 Contain

er

是 无

节点名

称（关

键字）

父节点
描

述

类

型

是

否

必

选

限制

Start

Request.Me
diaWorkflow

.Topology.N

odes

开
始

节

点

C

o

n
t

ai

n

e

r

是 只有唯一一个开始节点

Anim

ation

_*** 

Request.Me
diaWorkflow

.Topology.N

odes

动

图
类

型

节

点

C

o

n
t

ai

n

e

r

否
节点名称以 Animation 为前缀，可能有多个动图

节点

Snap

shot_

*** 

Request.Me

diaWorkflow

.Topology.N

odes

截
图

类

型

节

点

C

o
n

t

ai

n

e

r

否
节点名称以 Snapshot 为前缀，可能有多个截图

节点

Smart

Cover

_***

Request.Me

diaWorkflow

.Topology.N

odes

智
能

封

面

节

点

C

o
n

t

ai

n

e

r

否
节点名称以 SmartCover 为前缀，可能有多个智

能封面节点
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Trans
code

_***

Request.Me
diaWorkflow

.Topology.N

odes

转
码

节

点

C
o

n

t

ai

n

e

r

否 节点名称以 Transcode 为前缀，可能有多个转码
节点

Conc

at_***

Request.Me

diaWorkflow

.Topology.N

odes

音

视

频

拼

接

节

点

C
o

n

t

ai

n

e

r

否
节点名称以 Concat 为前缀，可能有多个音视频拼

接节点

Voice

Separ

ate_*

**

Request.Me

diaWorkflow

.Topology.N

odes

人

声

节

点

C

o

n

t

ai

n

e

r

否
节点名称以 VoiceSeparate 为前缀，可能有多

个人声分离节点 

Video

Mont

age_*

**

Request.Me

diaWorkflow

.Topology.N

odes

精

彩

集

锦

节

点

C

o

n

t

ai

n

e

r

否
节点名称以 VideoMontage 为前缀，可能有多个

精彩集锦节点 

Strea

mPac

kConf

ig_***

Request.Me

diaWorkflow

.Topology.N

odes

自

适

应

码

流

节

点

C

o

n

t

ai

n

e

r

否

节点名称以 StreamPackConfig 为前缀，只能

有一个 自适应码流节点。只能在 start 节点之后，

后面只能是视频子流节点，可以有多个视频子流节

点

Video Request.Me 视 C 否 节点名称以 VideoStream 为前缀，可能有多个
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Strea

m_***

diaWorkflow

.Topology.N

odes

频

子

流

节

点

o

n

t

ai

n

e
r

视频子流节点 ，只能在 StreamPackConfig 节

点之后，后面只能是 StreamPack 节点

Strea

mPac

k_***

Request.Me

diaWorkflow

.Topology.N

odes

自

适

应

码

流

打

包
节

点

C

o

n

t

ai

n
e

r

否

节点名称以 StreamPack 为前缀，只能有一个自

适应码流打包节点 ，只能在视频子流节点之后，后

面只能是 End 节点

SDRt

oHDR

_***

Request.Me

diaWorkflow

.Topology.N

odes

SD

Rt

oH

DR 

节
点

C

o

n

t

ai

n
e

r

否
节点名称以 SDRtoHDR 为前缀，可能有多个 

SDRtoHDR 节点

Video

Proce

ss_**
*

Request.Me

diaWorkflow

.Topology.N
odes

视

频

处

理
节

点

C

o

n

t

ai
n

e

r

否
节点名称以 VideoProcess 为前缀，可能有多个

视频处理节点

SCF_

***

Request.Me

diaWorkflow

.Topology.N
odes

SC

F 

函

数
节

点

C

o

n

t

ai
n

e

r

否
节点名称以 SCF 为前缀，可能有多个 SCF 函数

节点

Super Request.Me 超 C 否 节点名称以 SuperResolution 为前缀，可能有
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Resol

ution

_***

diaWorkflow

.Topology.N

odes

分

辨

率
节

点

o

n

t
ai

n

e

r

多个超分辨率节点

Segm
ent_*

**

Request.Me

diaWorkflow
.Topology.N

odes

音

视

频

转
封

装

节

点

C

o

n

t
ai

n

e

r

否
节点名称以 Segment 为前缀，可能有多个音视频
转封装节点

PicPr
ocess

_***

Request.Me
diaWorkflow

.Topology.N

odes

图

片
处

理

节

点

C

o

n
t

ai

n

e

r

否
节点名称以 PicProcess 为前缀，可能有多个图

片处理节点

Tts_*

**

Request.Me
diaWorkflow

.Topology.N

odes

语

音
合

成

节

点

C

o

n
t

ai

n

e

r

否 节点名称以 Tts 为前缀，可能有多个语音合成节点

Spee
chRe

cogni

tion_*

**

Request.Me
diaWorkflow

.Topology.N

odes

语

音
识

别

节

点

C

o

n
t

ai

n

e

r

否
节点名称以 SpeechRecognition 为前缀，可能

有多个语音识别节点

Video

Enha

Request.Me

diaWorkflow

画

质

C

o

否 节点名称以 VideoEnhance 为前缀，可能有多

个语音识别节点
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Container 类型 Start 的具体数据描述如下：

nce_*

**

.Topology.N

odes

增

强

节

点

n

t

ai

n

e

r

Condi

tion_*

**

Request.Me

diaWorkflow

.Topology.N

odes

条

件

判

断

节

点

C
o

n

t

ai

n

e

r

否
节点名称以 Condition 为前缀，可能有多个条件

判断节点

Media

Info_*

**

Request.Me

diaWorkflow

.Topology.N

odes

媒
体

信

息

获

取

节

点

C
o

n

t

ai

n

e

r

否
节点名称以 MediaInfo 为前缀，可能有多个媒体

信息获取节点

AIRec

ogniti

on_**

*

Request.Me

diaWorkflow

.Topology.N

odes

AI

识

别

节

点

C
o

n

t

ai

n

e

r

否 节点名称以 AIRecognition 为前缀

Segm

entVi

deoB

ody_*

**

Request.Me

diaWorkflow

.Topology.N

odes

视

频

人

像

抠

图

C

o

n

t

ai

n

e

r

否 节点名称以 SegmentVideoBody 为前缀
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Container 类型 Animation_*** 的具体数据描述如下：

Container 类型 Snapshot_*** 的具体数据描述如下：

Container 类型 SmartCover_*** 的具体数据描述如下：

节点名称

（关键字）

父节点 描述 类型 是否

必选

限

制

Type
Request.MediaWorkflow.opolog
y.Nodes.Start

节点类型
Strin
g

是

St

ar
t

Input
Request.MediaWorkflow.Topolo

gy.Nodes.Start

输入信息, 详情

见 Input

Cont

ainer
是 无

节点名称
（关键

字）

父节点 描述 类型

是
否

必

选

限制

Type
Request.MediaWorkflow.Topolo

gy.Nodes.Animation_***
节点类型

Stri

ng
是

Ani

mati

on

Operati
on

Request.MediaWorkflow.Topolo
gy.Nodes.Animation_***

操作规则, 详情
见 Animation

Con
tain

er

是 无

节点名称

（关键

字）

父节点 描述 类型

是

否

必

选

限制

Type
Request.MediaWorkflow.Topolo

gy.Nodes.Snapshot_***
节点类型

Stri

ng
是

Sna

psh

ot

Operati

on

Request.MediaWorkflow.Topolo

gy.Nodes.Snapshot_***

操作规则, 详情

见 Snapshot

Con

tain

er

是 无

节点名称

（关键

字）

父节点 描述 类型

是

否

必

选

限制

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Start_Input
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Animation_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Snapshot_Operation
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Container 类型 Transcode_*** 的具体数据描述如下：

Container 类型 Concat_*** 的具体数据描述如下：

Container 类型 VoiceSeparate_*** 的具体数据描述如下：

Type Request.MediaWorkflow.Topolo
gy.Nodes.SmartCover_***

节点类型 Stri
ng

是 Smar
tCov

er

Operati

on

Request.MediaWorkflow.Topolo

gy.Nodes.SmartCover_***

操作规则, 详情见 

SmartCover

Con

tain

er

是 无

节点名称

（关键

字）

父节点 描述 类型

是

否

必

选

限制

Type
Request.MediaWorkflow.Topolo

gy.Nodes.Transcode_***
节点类型

Stri

ng
是

Tran

scod

e

Operati

on

Request.MediaWorkflow.Topolo

gy.Nodes.Transcode_***

操作规则, 详情见 

Transcode

Con

tain

er

是 无

节点名称
（关键字）

父节点 描述 类型

是

否
必

选

限
制

Type
Request.MediaWorkflow.Topolog

y.Nodes.Concat_***
节点类型

Strin

g
是

Co

nc

at

Operatio
n

Request.MediaWorkflow.Topolog
y.Nodes.Concat_***

操作规则, 详情
见 Concat

Cont

aine
r

是 无

节点名称

（关键

字）

父节点 描述 类型

是

否

必

选

限制

Type Request.MediaWorkflow.Topolo 节点类型 Stri 是 Voice

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_SmartCover_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Transcode_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Concat_Operation
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Container 类型 VideoMontage_*** 的具体数据描述如下：

Container 类型 StreamPackConfig_*** 的具体数据描述如下：

Container 类型 VideoStream_*** 的具体数据描述如下：

gy.Nodes.VoiceSeparate_*** ng Separ

ate

Operat

ion

Request.MediaWorkflow.Topolo

gy.Nodes.VoiceSeparate_***

操作规则, 详情见 

VoiceSeparat

e

Co

nta

ine

r

是 无

节点名称

（关键

字）

父节点 描述 类型

是

否

必

选

限制

Type
Request.MediaWorkflow.Topolo

gy.Nodes.VideoMontage_***
节点类型

Stri

ng
是

Video

Monta

ge

Operati

on

Request.MediaWorkflow.Topolo

gy.Nodes.VideoMontage_***

操作规则, 详情见 

VideoMontag

e

Co

nta

ine

r

是 无

节点名

称（关

键字）

父节点 描述
类

型

是

否

必

选

限制

Type
Request.MediaWorkflow.Topolo
gy.Nodes.StreamPackConfig_**

*

节点类型
Str
ing

是
Stream
PackCo

nfig

Opera

tion

Request.MediaWorkflow.Topolo

gy.Nodes.StreamPackConfig_**

*

操作规则, 详情见 

StreamPackCo

nfig

Co

nt

ain

er

是 无

节点名称

（关键

字）

父节点 描述 类型

是

否

必

选

限制

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_VoiceSeparate_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_VideoMontage_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_StreamPackConfig_Operation
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Container 类型 StreamPack_*** 的具体数据描述如下：

Container 类型 SDRtoHDR_*** 的具体数据描述如下：

Container 类型 VideoProcess_*** 的具体数据描述如下：

Type
Request.MediaWorkflow.Topolo

gy.Nodes.VideoStream_***
节点类型

Stri

ng
是

Video

Strea

m

Operati

on

Request.MediaWorkflow.Topolo

gy.Nodes.VideoStream_***

操作规则, 详情见 

VideoStream

Co

ntai

ner

是 无

节点名称
（关键

字）

父节点 描述 类型

是
否

必

选

限制

Type
Request.MediaWorkflow.Topolo

gy.Nodes.StreamPack_***
节点类型

Stri

ng
是

Strea

mPac

k

Operati
on

Request.MediaWorkflow.Topolo
gy.Nodes.StreamPack_***

操作规则, 详情见 
StreamPack

Con
tain

er

是 无

节点名称

（关键

字）

父节点 描述 类型

是

否

必
选

限制

Type
Request.MediaWorkflow.Topolo

gy.Nodes.SDRtoHDR_***
节点类型

Stri

ng
是

SDRt

oHD

R

Operati

on

Request.MediaWorkflow.Topolo

gy.Nodes.SDRtoHDR_***

操作规则, 详情见 

SDRtoHDR

Con

tain

er

是 无

节点名称

（关键

字）

父节点 描述 类型

是

否

必

选

限制

Type Request.MediaWorkflow.Topolo 节点类型 Stri 是 Video

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_VideoStream_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_StreamPack_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_SDRtoHDR_Operation
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Container 类型 SCF_*** 的具体数据描述如下：

Container 类型 SuperResolution_*** 的具体数据描述如下：

Container 类型 Segment_*** 的具体数据描述如下：

gy.Nodes.VideoProcess_*** ng Proce

ss

Operati

on

Request.MediaWorkflow.Topolo

gy.Nodes.VideoProcess_***

操作规则, 详情见 

VideoProcess

Co

ntai

ner

是 无

节点名称

（关键字）
父节点 描述 类型

是否

必选

限

制

Type
Request.MediaWorkflow.Topolog

y.Nodes.SCF_***
节点类型

Strin

g
是

S

C

F

Operation
Request.MediaWorkflow.Topolog
y.Nodes.SCF_***

操作规则, 详情
见 SCF

Cont
ainer

是 无

节点名

称（关

键字）

父节点 描述
类

型

是

否

必

选

限制

Type
Request.MediaWorkflow.Topolo

gy.Nodes.SuperResolution_***
节点类型

Str

ing
是

Super

Resolu

tion

Operat

ion

Request.MediaWorkflow.Topolo

gy.Nodes.SuperResolution_***

操作规则, 详情见 

SuperResoluti

on

Co

nta

ine

r

是 无

节点名称

（关键

字）

父节点 描述 类型

是

否

必

选

限制

Type
Request.MediaWorkflow.Topolo

gy.Nodes.Segment_***
节点类型

Stri

ng
是

Seg
me

nt

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_VideoProcess_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_SCF_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_SuperResolution_Operation
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Container 类型 PicProcess_*** 的具体数据描述如下：

Container 类型 Tts_*** 的具体数据描述如下：

Container 类型 SpeechRecognition_*** 的具体数据描述如下：

Operatio

n

Request.MediaWorkflow.Topolo

gy.Nodes.Segment_***

操作规则, 详情

见 Segment

Con

tain

er

是 无

节点名称

（关键

字）

父节点 描述 类型

是

否

必

选

限制

Type
Request.MediaWorkflow.Topolo

gy.Nodes.PicProcess_***
节点类型

Stri

ng
是

PicP

roce
ss

Operati

on

Request.MediaWorkflow.Topolo

gy.Nodes.PicProcess_***

操作规则, 详情见 

PicProcess

Con

tain

er

是 无

节点名称
（关键字）

父节点 描述 类型
是否
必选

限
制

Type
Request.MediaWorkflow.Topolog

y.Nodes.Tts_***
节点类型

Strin

g
是

T

t

s

Operation
Request.MediaWorkflow.Topolog

y.Nodes.Tts_***

操作规则, 详

情见 Tts

Cont

ainer
是 无

节点名

称（关

键字）

父节点 描述
类

型

是

否

必

选

限制

Type
Request.MediaWorkflow.Topolo
gy.Nodes.SpeechRecognition_*

**

节点类型
Str
ing

是
Speech
Recogni

tion

Opera

tion

Request.MediaWorkflow.Topolo

gy.Nodes.SpeechRecognition_*

**

操作规则, 详情见 

SpeechRecogn

ition

Co

nt

ain

er

是 无

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Segment_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_PicProcess_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Tts_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_SpeechRecognition_Operation
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Container 类型 VideoEnhance_*** 的具体数据描述如下：

Container 类型 Condition_*** 的具体数据描述如下：

Container 类型 MediaInfo_*** 的具体数据描述如下：

Container 类型 AIRecognition_*** 的具体数据描述如下：

节点名称

（关键

字）

父节点 描述 类型

是

否

必

选

限制

Type
Request.MediaWorkflow.Topolo

gy.Nodes.VideoEnhance_***
节点类型

Stri

ng
是

Video

Enhan

ce

Operati

on

Request.MediaWorkflow.Topolo

gy.Nodes.VideoEnhance_***

操作规则, 详情见 

VideoEnhanc

e

Co

nta

ine

r

是 无

节点名称

（关键

字）

父节点 描述 类型

是
否

必

选

限制

Type
Request.MediaWorkflow.Topolo

gy.Nodes.Condition_***
节点类型

Stri

ng
是

Con

ditio

n

Operati

on

Request.MediaWorkflow.Topolo

gy.Nodes.Condition_***

操作规则, 详情

见 Condition

Con

tain

er

是 无

节点名称

（关键字）
父节点 描述

类

型

是否

必选
限制

Type
Request.MediaWorkflow.Topology.Nod

es.MediaInfo_***

节点

类型

Str

ing
是

Media

Info

节点名称

（关键字）
父节点

描

述

类

型

是否

必选
限制

Type Request.MediaWorkflow.Topology.Nod
es.AIRecognition_***

节
点

St
rin

是 AIReco
gnition

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_VideoEnhance_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Condition_Operation
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Container 类型 SegmentVideoBody_*** 的具体数据描述如下：

工作流节点依赖关系如下：

类

型

g

节点名
称（关

键字）

父节点 描述
类

型

是
否

必

选

限制

Type

Request.MediaWorkflow.Topolo

gy.Nodes.SegmentVideoBody_**

*

节点类型
Str

ing
是

Segmen

tVideoB

ody

Opera

tion

Request.MediaWorkflow.Topolo
gy.Nodes.SegmentVideoBody_**

*

操作规则, 详情
见 

VideoEnhan

ce

Co
nta

ine

r

是 无

工

作

流
节

点

类

型

后面可连接的节点类型

St

art

Snapshot,Animation,SmartCover,Transcode,Concat,VoiceSeparate,VideoMontag

e,StreamPackConfig,SDRtoHDR,VideoProcess,SCF,SuperResolution,Segment,Pi

cProcess,Tts,SpeechRecognition,VideoEnhance,MediaInfo,AIRecognition,VideoE
nhance,SegmentVideoBody

Sn

ap

sh

ot

PicProcess,SCF,End

An

im
ati

on

SCF,End

S

ma

PicProcess,SCF,End

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_SegmentVideoBody_Operation
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rtC

ov

er

Tr

an

sc

od

e

Snapshot,Animation,SmartCover,Concat,VideoMontage,SDRtoHDR,VideoProces

s,SCF,Segment,SpeechRecognition,VideoEnhance,MediaInfo,SegmentVideoBod

y,End

Co

nc
at

Transcode,Snapshot,Animation,SmartCover,SDRtoHDR,VideoProcess,SCF,Seg

ment,VideoEnhance,MediaInfo,VideoEnhance,SegmentVideoBody,End

Vo

ice

Se

pa

rat

e

SCF,SpeechRecognition,End

Vi

de

oM

on

ta

ge

Snapshot,Animation,SDRtoHDR,VideoProcess,SCF,SuperResolution,VideoEnhan

ce,Segment,MediaInfo,VideoEnhance,SegmentVideoBody,End

Str

ea
m

Pa

ck

Co

nfi

g

VideoStream

Vi
de

oS

tre

am

StreamPack

Str

ea

m

End
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Pa

ck

SD

Rt

oH

DR

Transcode,Concat,VideoMontage,VoiceSeparate,SmartCover,Animation,VideoPr

ocess,SCF,SuperResolution,SegmentVideoBody,End

Vi
de

oP

ro

ce

ss

Transcode,Concat,VideoMontage,VoiceSeparate,SmartCover,Animation,SDRtoH

DR,SCF,Segment,SuperResolution,MediaInfo,SegmentVideoBody,End

SC

F

SDRtoHDR,Snapshot,Transcode,Concat,VideoMontage,VoiceSeparate,SmartCov

er,Animation,VideoProcess,End

Su

pe

rR

es

olu

tio

n

VideoMontage,Transcode,SmartCover,Animation,Snapshot,SCF,Segment,SDRto

HDR,VideoProcess,MediaInfo,SegmentVideoBody,End

Se

gm

en

t

VideoEnhance,SegmentVideoBody, End

Pic

Pr

oc

es
s

SCF,End

Tt

s
SCF,Transcode,End

Sp

ee

ch

Re
co

gni

SCF,Tts,End
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工作流支持的通配符：

tio

n

Vi

de
oE

nh

an

ce

Transcode,VideoMontage,SmartCover,Animation,Snapshot,SCF,Segment,Speec

hRecognition,Segment,VoiceSeparate,MediaInfo, End

Me

dia

Inf

o

Condition,End

Co

ndi

tio

n

Transcode,HighSpeedHd,SuperResolution,VideoProcess,Animation,Snapshot,Vi

deoMontage,SmartCover,Concat,VideoEnhance

AI

Re

co
gni

tio

n

End

Se

gm

en

tVi
de

oB

od

y

End

通配符 含义

${InputPath} 输入文件的路径(不包括文件名)

${InputName} 输入文件的文件名(不包括后缀)

${InputNameAndExt

}
输入文件的文件名(包括后缀)
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

对于输入的视频文件进行截图和转码处理。视频转码后, 同时进行转封装处理和生成智能封面, 然后对生成的封

面进行图片处理。

${RunId} 实例 Id

${Ext} 封装格式后缀

${Jobid} 任务Id

${Number}
产物索引, 从0开始计数, 仅支持 Snapshot、SmartCover、Segment 节

点

${Time} 截图时间点(单位:毫秒), 仅支持 Snapshot 节点

响应

响应头

响应体

响应体1 响应体2

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCove

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

https://cloud.tencent.com/document/product/460/78927
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                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicP

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteOb

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>
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具体的数据内容如下：

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>
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Container 节点 Response 的内容：

Container节点 MediaWorkflow 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

对于输入的视频文件进行截图和转码处理。视频转码后，同时进行转封装处理和生成智能封面，然后对生成的

封面进行图片处理。

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

MediaWorkflow Response 工作流数组 Container

节点名称（关

键字）
父节点 描述 类型

Name
Response.MediaW
orkflow

工作流名称 String

WorkflowId
Response.MediaW

orkflow
工作流 ID String

State
Response.MediaW

orkflow
工作流状态 String

CreateTim
e

Response.MediaW
orkflow

创建时间 String

UpdateTim

e

Response.MediaW

orkflow
更新时间 String

Topology
Response.MediaW

orkflow

拓扑信息，同请求中的 

Request.MediaWorkflow.Topology

Contai

ner

错误码

实际案例

请求1 响应1 请求2 响应2

https://cloud.tencent.com/document/product/460/42867
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POST /workflow HTTP/1.1 

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR***

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166 

Content-Type: application/xml

<Request>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCove

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicP

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>
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                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteOb

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>
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                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Request>
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查询工作流
最近更新时间：2022-09-02 11:44:41

查询工作流。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /workflow HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称（关键字） 描述 类型 是否必选

ids 工作流 ID，以 , 符号分割字符串 string 否

name 工作流名称 string 否

pageNumber 第几页 string 否

pageSize 每页个数 string 否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应

响应头

响应体

<Response>

    <RequestId>NjJmMWZiZTFfOTBmYTUwNjRfNjVmNl8x</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <MediaWorkflowList>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

https://cloud.tencent.com/document/product/460/42866
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                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans. Ext </Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}. Ext </Object>

                        </Output>

                    </Operation>

{ }

{ }
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                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}. Ext </Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic. Ext </Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

    <MediaWorkflowList>

        <Name>workflow-2</Name>

        <State>Active</State>

        <WorkflowId>w93aa43ba105347169fa093ed857b2a90</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_

                <StreamPack_1581665960538>End</StreamPack_1581665960538>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

{ }

{ }
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                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Object>

                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>

                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>

                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>
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具体的数据内容如下：

Container 节点 Response 的内容：

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoStreamN

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoStreamN

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

TotalCount Response 工作流总数 Int

PageNumber Response 当前页数，同请求中的 pageNumber Int
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Container节点 MediaWorkflowList 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

PageSize Response 每页个数，同请求中的 pageSize Int

MediaWorkflowList Response 工作流数组 Container

节点名称

（关键字）
父节点 描述 类型

是

否

必
选

限制

Name
Response.Media

WorkflowList

工作

流名

称

Strin

g
是

支持中文、英文、数字、—和

_，长度限制128字符

Workflow

Id

Response.Media

WorkflowList

工作

流 ID

Strin

g
是 工作流唯一 ID

State
Response.Media

WorkflowList

工作

流状

态

Strin

g
是

1. Active 

2. Paused

CreateTi

me

Response.Media

WorkflowList

创建

时间

Strin

g
是 无

UpdateTi

me

Response.Media

WorkflowList

更新

时间

Strin

g
是 无

Topology
Response.Media

WorkflowList

拓扑

信息

Cont

ainer
是

同创建工作流接口的 

Topology  

错误码

实际案例

请求1：工作流 ID

GET /workflow?ids=wc666d0b9f9dd47ae9137a096252d49f7,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应1

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/76856#Topology
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

        <MediaWorkflowList>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>
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                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans. Ext </Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}. Ext </Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

{ }

{ }
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                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}. Ext </Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic. Ext </Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

    <NonExistIDs>A</NonExistIDs>

    <NonExistIDs>B</NonExistIDs>

</Response>

{ }

{ }

请求2：工作流列表

GET /workflow?pageNumber=1&pageSize=10 HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应2

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <MediaWorkflowList>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1567 共1701页

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans. Ext </Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}. Ext </Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}. Ext </Object>

{ }

{ }

{ }
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                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic. Ext </Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

    <MediaWorkflowList>

        <Name>workflow-2</Name>

        <State>Active</State>

        <WorkflowId>w93aa43ba105347169fa093ed857b2a90</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_

                <StreamPack_1581665960538>End</StreamPack_1581665960538>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

{ }
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                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Object>

                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>

                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>

                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>
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                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoStreamN

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoStreamN

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

</Response>
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删除工作流
最近更新时间：2022-09-02 11:44:35

删除工作流。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

DELETE /workflow/<WorkflowId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <WorkflowId>A</WorkflowId>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

<Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

WorkflowId Response 被删除的工作流 ID String

错误码

实际案例

请求

DELETE /workflow/we59a9648e62e48ffb25e4b41f3721799 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <WorkflowId>we59a9648e62e48ffb25e4b41f3721799</WorkflowId>

<Response>

https://cloud.tencent.com/document/product/460/42867
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更新工作流
最近更新时间：2022-09-02 11:44:28

更新工作流。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体: 

功能描述

请求

请求示例

PUT /workflow/<WorkflowId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>
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                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 同创建工作流接口的 Request  Container 是

响应

响应头

响应体

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/76856#Request


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1578 共1701页

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>
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具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>

节点名称（关键字） 父节点 描述 类型 是否必选

Response 无 同创建工作流接口的 Response  Container 是

错误码

实际案例

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/76856#Response
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请求1：更新工作流配置

PUT /workflow/wc666d0b9f9dd47ae9137a096252d49f7 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>
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                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>
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                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Request>

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

                <Segment_15816659605667>End</Segment_15816659605667>
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                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>
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                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>
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请求2：停用工作流

PUT /workflow/wc666d0b9f9dd47ae9137a096252d49f7?paused HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应2

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWRiMDlfOTBmYTUwNjRfNWYzMl80

请求3：启用工作流

PUT /workflow/wc666d0b9f9dd47ae9137a096252d49f7?active HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应3

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWRiMDlfOTBmYTUwNjRfNWYzMl80
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测试工作流
最近更新时间：2022-09-02 11:44:23

测试工作流。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

请求

请求示例

POST /triggerworkflow?workflowId=xxx&object=xxx HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

名称 描述 类型
是否必
选

workflo

wId
需要触发的工作流 ID

Stri

ng
是

object 需要进行工作流处理的对象名称, 需要进行 url 编码
Stri

ng
是

name
存量触发任务名称，支持中文、英文、数字、—和_，长度限制128字
符，默认为空

Stri
ng

否

请求头

请求体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

响应

响应头

响应体

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <InstanceId>i6fc78ca77d6011eba0ac5254008618d9=</InstanceId>

<Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

InstanceId Response 实例 ID String

错误码

实际案例

请求

POST /triggerworkflow?workflowId=we59a9648e62e48ffb25e4b41f3721799&object=test

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/42867
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <InstanceId>i6fc78ca77d6011eba0ac5254008618d9=</InstanceId>

<Response>
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工作流回调
最近更新时间：2022-09-02 11:44:19

数据万象支持自定义设置回调 URL，在工作流开启状态下，每执行一个实例后，系统会向该 URL 发送 HTTP 

POST 请求，请求体中包含通知内容。您可通过配置的回调地址及时了解工作流实例处理的进展和状态，以便进行

其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数

据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>WorkflowFinish</EventName>

    <WorkflowExecution>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <WorkflowName>workflow-3</WorkflowName>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <State>Success</State>

        <BucketId>test-1234567890</BucketId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09 14:54:17+0800</CreateTime>

        <CosHeaders>

            <Key>Content-Type</Key>

            <Value>video/mp4</Value>

        </CosHeaders>

        <CosHeaders>

            <Key>x-cos-request-id</Key>

            <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

        </CosHeaders>

        <Tasks>

            <Type>Snapshot</Type>

            <CreateTime>2022-08-09 14:54:40+0800</CreateTime>

            <EndTime>2022-08-09 14:54:42+0800</EndTime>

            <State>Success</State>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <Name>Snapshot_1581665960536</Name>

            <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

            <TemplateName>snapshot_1280*720_3</TemplateName>

        </Tasks>

        <Tasks>
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 WorkflowExecution 的内容：

            <Type>Transcode</Type>

            <CreateTime>2022-08-09 14:54:18+0800</CreateTime>

            <EndTime>2022-08-09 14:54:39+0800</EndTime>

            <State>Success</State>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <Name>Transcode_1581665960537</Name>

            <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>

            <TemplateName>MP4-265-SD</TemplateName>

        </Tasks>

    </WorkflowExecution>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName Response 固定值，为 WorkflowFinish String

WorkflowExecution Response 工作流的详细信息 Container

节点名称

（关键

字）

父节点 描述 类型

Workflo

wId

Response.Wor

kflowExecution
工作流 ID String

Workflo

wName

Response.Wor

kflowExecution
工作流的名称 String

RunId
Response.Wor

kflowExecution
工作流实例的 ID String

State
Response.Wor

kflowExecution

实例的状态，值为 Success、Failed 其中一个。

Tasks 存在一个 Failed，则此实例视为 Failed
String

BucketI

d

Response.Wor

kflowExecution
被处理文件所属的存储桶 String
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Container 节点 CosHeaders 的内容：

Container 节点 Tasks 的内容：

Object Response.Wor

kflowExecution

该实例处理的文件名 String

Create

Time

Response.Wor

kflowExecution
实例的创建时间 String

CosHe

aders

Response.Wor

kflowExecution

该 Object 上传时设定的自定义 Header 列表，没有设

置时无此内容

Contai

ner 数

组

Tasks
Response.Wor

kflowExecution
任务信息列表

Contai

ner 数

组

节点名称（关键

字）
父节点 描述 类型

Key
Response.WorkflowExecution.CosHea

ders

自定义 Header 的

名称

Strin

g

Value
Response.WorkflowExecution.CosHea
ders

自定义 Header 的
值

Strin
g

节点名称（关键

字）
父节点 描述 类型

Type
Response.WorkflowExecution
.Tasks

任务类型
Stri
ng

Createtime
Response.WorkflowExecution

.Tasks
任务的创建时间

Stri

ng

StartTime
Response.WorkflowExecution

.Tasks
任务开始时间

Stri

ng

EndTime
Response.WorkflowExecution
.Tasks

任务的完成时间
Stri
ng

State
Response.WorkflowExecution

.Tasks

任务的状态，值为 Success、

Failed 等

Stri

ng

JobId
Response.WorkflowExecution

.Tasks
任务的 ID

Stri

ng
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Name Response.WorkflowExecution
.Tasks

任务在工作流中的节点名称 Stri
ng

TemplateId
Response.WorkflowExecution

.Tasks
任务使用的模板 ID

Stri

ng

TemplateNa

me

Response.WorkflowExecution

.Tasks
任务使用的模板名称

Stri

ng

实际案例

案例 1 (XML)

<Response>

    <EventName>WorkflowFinish</EventName>

    <WorkflowExecution>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <WorkflowName>workflow-3</WorkflowName>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <State>Success</State>

        <BucketId>test-1234567890</BucketId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09 14:54:17+0800</CreateTime>

        <CosHeaders>

            <Key>Content-Type</Key>

            <Value>video/mp4</Value>

        </CosHeaders>

        <CosHeaders>

            <Key>x-cos-request-id</Key>

            <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

        </CosHeaders>

        <Tasks>

            <Type>Snapshot</Type>

            <CreateTime>2022-08-09 14:54:40+0800</CreateTime>

            <EndTime>2022-08-09 14:54:42+0800</EndTime>

            <State>Success</State>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <Name>Snapshot_1581665960536</Name>

            <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

            <TemplateName>snapshot_1280*720_3</TemplateName>

        </Tasks>

        <Tasks>

            <Type>Transcode</Type>

            <CreateTime>2022-08-09 14:54:18+0800</CreateTime>

            <EndTime>2022-08-09 14:54:39+0800</EndTime>
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            <State>Success</State>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <Name>Transcode_1581665960537</Name>

            <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>

            <TemplateName>MP4-265-SD</TemplateName>

        </Tasks>

    </WorkflowExecution>

</Response>

案例 2 (JSON)

{

    "EventName": "WorkflowFinish",

    "WorkflowExecution": {

        "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

        "WorkflowName": "workflow-3",

        "RunId": "i166ee19017b011eda8a5525400c540df",

        "State": "Success",

        "BucketId": "test-1234567890",

        "Object": "wk-test/game.mp4",

        "CreateTime": "2022-08-09 14:54:17+0800",

        "CosHeaders": [{

                "Key": "Content-Type",

                "Value": "video/mp4"

            },

            {

                "Key": "x-cos-request-id",

                "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

            }

        ],

        "Tasks": [{

                "Type": "Snapshot",

                "CreateTime": "2022-08-09 14:54:40+0800",

                "EndTime": "2022-08-09 14:54:42+0800",

                "State": "Success",

                "JobId": "j23c11e1e17b011edaab4ab15ec33d076",

                "Name": "Snapshot_1581665960536",

                "TemplateId": "t07740e32081b44ad7a0aea03adcffd54a",

                "TemplateName": "snapshot_1280*720_3"

            },

            {

                "Type": "Transcode",

                "CreateTime": "2022-08-09 14:54:18+0800",

                "EndTime": "2022-08-09 14:54:39+0800",
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                "State": "Success",

                "JobId": "j168668b217b011ed8efb27bb229e2d11",

                "Name": "Transcode_1581665960537",

                "TemplateId": "t01e57db1c2d154d2fb57aa5de9313a897",

                "TemplateName": "MP4-265-SD"

            }

        ]

    }

}
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工作流实例

获取工作流实例详情
最近更新时间：2022-09-02 11:44:06

获取工作流实例详情。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /workflowexecution/<RunId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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    <RequestId>NjJmMjA5MjZfZWM0YTYyNjRfN2U3ZF8yNzk1</RequestId>

    <WorkflowExecution>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Name>workflow-1</Name>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <Object>wk-test/game.mp4</Object>

        <State>Success</State>

        <Topology>

            <Dependencies>

                <Start>Transcode_1581665960537</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960537>Snapshot_1581665960536</Transcode_1581665

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>/wk-test</ObjectPrefix>

                        <ExtFilter>

                            <State>On</State>

                            <Video>false</Video>

                            <Audio>false</Audio>

                            <ContentType>false</ContentType>

                            <Custom>true</Custom>

                            <CustomExts>mp4</CustomExts>

                            <AllFile>false</AllFile>

                            <Image>false</Image>

                        </ExtFilter>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>snapshot-${number}.jpg</Object>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960537>
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具体的数据内容如下：

Container 节点 Response 的内容：

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>trans1.mp4</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960537>

            </Nodes>

        </Topology>

        <Tasks>

            <Type>Snapshot</Type>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <CreateTime>2022-08-09T14:54:40+08:00</CreateTime>

            <Name>Snapshot_1581665960536</Name>

            <State>Success</State>

            <StartTime>2022-08-09T14:54:40+08:00</StartTime>

            <EndTime>2022-08-09T14:54:42+08:00</EndTime>

            <Code>Success</Code>

            <Message></Message>

        </Tasks>

        <Tasks>

            <Type>Transcode</Type>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <CreateTime>2022-08-09T14:54:18+08:00</CreateTime>

            <Name>Transcode_1581665960537</Name>

            <State>Success</State>

            <StartTime>2022-08-09T14:54:18+08:00</StartTime>

            <EndTime>2022-08-09T14:54:39+08:00</EndTime>

            <Code>Success</Code>

            <Message>success</Message>

        </Tasks>

    </WorkflowExecution>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container
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Container 节点 WorkflowExecution 的内容：

Container 节点 Tasks 的内容：

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求 ID String

WorkflowExecution Response 工作流实例详细信息 Container

节点名称（关键

字）
父节点 描述 类型

WorkflowId
Response.WorkflowExec

ution
工作流 ID String

WorkflowNam

e

Response.WorkflowExec

ution
工作流名称 String

RunId
Response.WorkflowExec

ution
工作流实例 ID String

CreateTime
Response.WorkflowExec

ution
创建时间 String

Object
Response.WorkflowExec

ution
COS 对象地址 String

State
Response.WorkflowExec

ution
工作流实例状态 String

Topology
Response.WorkflowExec

ution

同创建工作流接口的 

Topology  
Container

Tasks
Response.WorkflowExec

ution
工作流实例任务

Container 数

组

节点名称（关键

字）
父节点 描述 类型

Type
Response.WorkflowExecution.Task

s
任务所属节点类型

Strin

g

State
Response.WorkflowExecution.Task

s
任务状态

Strin

g

JobId Response.WorkflowExecution.Task

s

任务 ID Strin

g

https://cloud.tencent.com/document/product/460/76856#Topology
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

CreateTime
Response.WorkflowExecution.Task

s
任务创建时间

Strin

g

StartTime
Response.WorkflowExecution.Task

s
任务开始时间

Strin

g

EndTime
Response.WorkflowExecution.Task

s
任务结束时间

Strin

g

Code
Response.WorkflowExecution.Task

s
任务的错误码

Strin

g

Message
Response.WorkflowExecution.Task

s
任务的错误信息

Strin

g

Name
Response.WorkflowExecution.Task

s

工作流节点的节点名

称

Strin

g

错误码

实际案例

请求

GET /workflowexecution/i166ee19017b011eda8a5525400c540df HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjJmMjA5MjZfZWM0YTYyNjRfN2U3ZF8yNzk1</RequestId>

    <WorkflowExecution>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Name>workflow-1</Name>

https://cloud.tencent.com/document/product/460/42867
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        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <Object>wk-test/game.mp4</Object>

        <State>Success</State>

        <Topology>

            <Dependencies>

                <Start>Transcode_1581665960537</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960537>Snapshot_1581665960536</Transcode_1581665

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>/wk-test</ObjectPrefix>

                        <ExtFilter>

                            <State>On</State>

                            <Video>false</Video>

                            <Audio>false</Audio>

                            <ContentType>false</ContentType>

                            <Custom>true</Custom>

                            <CustomExts>mp4</CustomExts>

                            <AllFile>false</AllFile>

                            <Image>false</Image>

                        </ExtFilter>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>snapshot-${number}.jpg</Object>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960537>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>

                        <Output>
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                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>trans1.mp4</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960537>

            </Nodes>

        </Topology>

        <Tasks>

            <Type>Snapshot</Type>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <CreateTime>2022-08-09T14:54:40+08:00</CreateTime>

            <Name>Snapshot_1581665960536</Name>

            <State>Success</State>

            <StartTime>2022-08-09T14:54:40+08:00</StartTime>

            <EndTime>2022-08-09T14:54:42+08:00</EndTime>

            <Code>Success</Code>

            <Message></Message>

        </Tasks>

        <Tasks>

            <Type>Transcode</Type>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <CreateTime>2022-08-09T14:54:18+08:00</CreateTime>

            <Name>Transcode_1581665960537</Name>

            <State>Success</State>

            <StartTime>2022-08-09T14:54:18+08:00</StartTime>

            <EndTime>2022-08-09T14:54:39+08:00</EndTime>

            <Code>Success</Code>

            <Message>success</Message>

        </Tasks>

    </WorkflowExecution>
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获取工作流实例详情列表
最近更新时间：2022-09-02 11:44:10

获取工作流实例列表。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /workflowexecution HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称（关键
字）

描述 类型
是否必
选

workflowId 工作流 ID
Stri

ng
是

name 文件名称
Stri

ng
否

orderByTime Desc 或者 Asc。默认为 Desc Stri
ng

否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

size 拉取的最大任务数。默认为10。最大为100
Stri

ng
否

states
工作流实例状态，以 , 分割支持多状态

 All，Success，Failed，Running，Cancel。默认为 All

Stri

ng
否

startCreation
Time

拉取创建时间大于等于该时间。格式为：

%Y-%m-%dT%H:%m:%S%z

Stri
ng

否

endCreationTi

me

拉取创建时间小于等于该时间。格式为：

%Y-%m-%dT%H:%m:%S%z

Stri

ng
否

nextToken 请求的上下文，用于翻页。下一页输入 token
Stri

ng
否

jobId
批量触发工作流任务 ID，用于扫描出批量触发任务 ID 对应执行
的工作流实例

Stri
ng

否

响应

响应头

响应体

<Response>

    <RequestId>NjJmMjEyMmFfZWM0YTYyNjRfN2U2NV8yNmI0</RequestId>

    <WorkflowExecutionList>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <State>Success</State>

    </WorkflowExecutionList>

    <WorkflowExecutionList>

        <RunId>i769bd26517af11ed917f525400a3c59f</RunId>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:49:49+08:00</CreateTime>

        <State>Success</State>

    </WorkflowExecutionList>

    <NextToken>115716</NextToken>

</Response>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 WorkflowExecutionList 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

WorkflowExecutionList Response 工作流实例详细信息 Container

RequestId Response 请求 ID String

NextToken Response 翻页的上下文 Token String

节点名称（关键字） 父节点 描述 类型

RunId Response.WorkflowExecutionList 工作流实例 ID String

WorkflowId Response.WorkflowExecutionList 工作流 ID String

State Response.WorkflowExecutionList 工作流实例状态 String

CreateTime Response.WorkflowExecutionList 创建时间 String

Object Response.WorkflowExecutionList COS 对象地址 String

错误码

实际案例

请求

GET /workflowexecution?workflowId=web6ac56c1ef54dbfa44d7f4103203be9 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应

https://cloud.tencent.com/document/product/460/42867
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMjEyMmFfZWM0YTYyNjRfN2U2NV8yNmI0

<Response>

    <RequestId>NjJmMjEyMmFfZWM0YTYyNjRfN2U2NV8yNmI0</RequestId>

    <WorkflowExecutionList>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <State>Success</State>

    </WorkflowExecutionList>

    <WorkflowExecutionList>

        <RunId>i769bd26517af11ed917f525400a3c59f</RunId>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:49:49+08:00</CreateTime>

        <State>Success</State>

    </WorkflowExecutionList>

    <NextToken>115716</NextToken>

</Response>
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任务接口

取消任务
最近更新时间：2023-01-04 17:01:25

取消一个任务，只有未执行的任务才可以被取消。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该请求无响应体。

功能描述

请求

请求示例

PUT /jobs/<jobId>?cancel HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

错误码

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

实际案例

请求

PUT /jobs/jb57da17e29c111eda218713081fe2b05?cancel HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjY=

https://cloud.tencent.com/document/product/460/42867
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提交多任务处理
最近更新时间：2023-02-16 14:29:26

提交多个任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Tag>Animation</Tag>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

            <Object>output/animation.gif</Object>

        </Output>

        <UserData>This is my Animation job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <Operation>

        <Tag>Transcode</Tag>

        <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/transcode.mp4</Object>

        </Output>

        <UserData>This is my Trancode job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <Operation>

        <Tag>SmartCover</Tag>

        <SmartCover>

            <Format>jpg</Format>

            <Width>1280</Width>

            <Height>960</Height>

            <Count>5</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>

        </Output>   

        <UserData>This is my SmartCover job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是
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Container 类型 Input 的具体数据描述如下：

对于不同的任务类型，Operation 的内容不同，请参照以下链接：

媒体处理：

图片处理：

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 待操作的文件信息 Container 是

Operation Request 操作规则，个数不超过6个 Container 是

QueueId Request 任务所在的队列 ID String 是

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

超分辨率

画质增强

获取媒体信息

极速高清转码

精彩集锦

视频标签

视频截图

视频明水印

视频增强

视频质量评分

视频转动图

数字水印

提取数字水印

音视频流分离

音视频拼接

音视频转封装

音视频转码

智能封面

SDR to HDR  

视频拆条

图片处理

https://cloud.tencent.com/document/product/460/84774#operation
https://cloud.tencent.com/document/product/460/84775#operation
https://cloud.tencent.com/document/product/460/84776#operation
https://cloud.tencent.com/document/product/460/84777#operation
https://cloud.tencent.com/document/product/460/84778#operation
https://cloud.tencent.com/document/product/460/84779#operation
https://cloud.tencent.com/document/product/460/84780#operation
https://cloud.tencent.com/document/product/460/84781#operation
https://cloud.tencent.com/document/product/460/84782#operation
https://cloud.tencent.com/document/product/460/84783#operation
https://cloud.tencent.com/document/product/460/84784#operation
https://cloud.tencent.com/document/product/460/84785#operation
https://cloud.tencent.com/document/product/460/84786#operation
https://cloud.tencent.com/document/product/460/84787#operation
https://cloud.tencent.com/document/product/460/84788#operation
https://cloud.tencent.com/document/product/460/84789#operation
https://cloud.tencent.com/document/product/460/84790#operation
https://cloud.tencent.com/document/product/460/84791#operation
https://cloud.tencent.com/document/product/460/84792#operation
https://cloud.tencent.com/document/product/460/90888#operation
https://cloud.tencent.com/document/product/460/84793#operation
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智能语音：

AI 内容识别

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

人声分离

听歌识曲

音频降噪

语音合成

语音识别

翻译

分词

视频目标检测

视频人像抠图

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Animation</Tag>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84794#operation
https://cloud.tencent.com/document/product/460/84795#operation
https://cloud.tencent.com/document/product/460/84796#operation
https://cloud.tencent.com/document/product/460/84797#operation
https://cloud.tencent.com/document/product/460/84798#operation
https://cloud.tencent.com/document/product/460/84799#operation
https://cloud.tencent.com/document/product/460/84800#operation
https://cloud.tencent.com/document/product/460/84801#operation
https://cloud.tencent.com/document/product/460/84802#operation
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                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

            </Output>

            <UserData>This is my Animation job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Transcode</Tag>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>transcode_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.mp4</Object>

            </Output>

            <UserData>This is my Trancode job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>
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具体的数据内容如下：

Container 节点 Response 的内容：

对于不同的任务类型，JobsDetail 的内容不同，请参照以下链接：

媒体处理：

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>SmartCover</Tag>

            <SmartCover>

                <Format>jpg</Format>

                <Width>1280</Width>

                <Height>960</Height>

                <Count>5</Count>

                <DeleteDuplicates>true</DeleteDuplicates>

            </SmartCover>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my SmartCover job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container 数组

超分辨率

画质增强

获取媒体信息

极速高清转码

精彩集锦

视频标签

https://cloud.tencent.com/document/product/460/84774#jobsDetail
https://cloud.tencent.com/document/product/460/84775#jobsDetail
https://cloud.tencent.com/document/product/460/84776#jobsDetail
https://cloud.tencent.com/document/product/460/84777#jobsDetail
https://cloud.tencent.com/document/product/460/84778#jobsDetail
https://cloud.tencent.com/document/product/460/84779#jobsDetail
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图片处理：

智能语音：

AI 内容识别

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

视频截图

视频明水印

视频增强

视频质量评分

视频转动图

数字水印

提取数字水印

音视频流分离

音视频拼接

音视频转封装

音视频转码

智能封面

SDR to HDR  

视频拆条

图片处理

人声分离

听歌识曲

音频降噪

语音合成

语音识别

翻译

分词

视频目标检测

视频人像抠图

错误码

实际案例

使用多个模板 ID

请求

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84780#jobsDetail
https://cloud.tencent.com/document/product/460/84781#jobsDetail
https://cloud.tencent.com/document/product/460/84782#jobsDetail
https://cloud.tencent.com/document/product/460/84783#jobsDetail
https://cloud.tencent.com/document/product/460/84784#jobsDetail
https://cloud.tencent.com/document/product/460/84785#jobsDetail
https://cloud.tencent.com/document/product/460/84786#jobsDetail
https://cloud.tencent.com/document/product/460/84787#jobsDetail
https://cloud.tencent.com/document/product/460/84788#jobsDetail
https://cloud.tencent.com/document/product/460/84789#jobsDetailhttps://cloud.tencent.com/document/product/460/84789#jobsDetail
https://cloud.tencent.com/document/product/460/84790#jobsDetail
https://cloud.tencent.com/document/product/460/84791#jobsDetail
https://cloud.tencent.com/document/product/460/84792#jobsDetail
https://cloud.tencent.com/document/product/460/90888#jobsDetail
https://cloud.tencent.com/document/product/460/84793#jobsDetail
https://cloud.tencent.com/document/product/460/84794#jobsDetail
https://cloud.tencent.com/document/product/460/84795#jobsDetail
https://cloud.tencent.com/document/product/460/84796#jobsDetail
https://cloud.tencent.com/document/product/460/84797#jobsDetail
https://cloud.tencent.com/document/product/460/84798#jobsDetail
https://cloud.tencent.com/document/product/460/84799#jobsDetail
https://cloud.tencent.com/document/product/460/84800#jobsDetail
https://cloud.tencent.com/document/product/460/84801#jobsDetail
https://cloud.tencent.com/document/product/460/84802#jobsDetail
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POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Tag>Animation</Tag>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/animation.gif</Object>

        </Output>

        <UserData>This is my Animation job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <Operation>

        <Tag>Transcode</Tag>

        <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/transcode.mp4</Object>

        </Output>

        <UserData>This is my Trancode job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <Operation>

        <Tag>SmartCover</Tag>

        <SmartCover>

            <Format>jpg</Format>

            <Width>1280</Width>

            <Height>960</Height>

            <Count>5</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>
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        </Output>   

        <UserData>This is my SmartCover job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Animation</Tag>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

            </Output>

            <UserData>This is my Animation job.</UserData>
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            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Transcode</Tag>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>trancode_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.mp4</Object>

            </Output>

            <UserData>This is my Trancode job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>
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            <Tag>SmartCover</Tag>

            <SmartCover>

                <Format>jpg</Format>

                <Width>1280</Width>

                <Height>960</Height>

                <Count>5</Count>

                <DeleteDuplicates>true</DeleteDuplicates>

            </SmartCover>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my SmartCover job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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查询指定任务
最近更新时间：2023-02-16 14:29:34

查询指定的任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

jobId 为提交任务时返回的任务Id，支持传多个，以逗号分隔，最多传10个。

请求头

请求体

响应

响应头

响应体

<Response>

    <JobsDetail>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1620 共1701页

具体的数据内容如下：

Container 节点 Response 的内容：

对于不同的任务类型，JobsDetail 的内容不同，请参照以下链接：

媒体处理：

    </JobsDetail>

    <NonExistJobIds></NonExistJobIds>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

JobsDetail
Respons

e
任务的详细信息

Container数

组

NonExistJobId

s

Respons

e

查询的 ID 中不存在任务，所有任务都存在时不

返回
String

超分辨率

画质增强

获取媒体信息

极速高清转码

精彩集锦

视频标签

视频截图

视频明水印

视频增强

视频质量评分

视频转动图

数字水印

提取数字水印

音视频流分离

音视频拼接

音视频转封装

音视频转码

https://cloud.tencent.com/document/product/460/84774#jobsDetail
https://cloud.tencent.com/document/product/460/84775#jobsDetail
https://cloud.tencent.com/document/product/460/84776#jobsDetail
https://cloud.tencent.com/document/product/460/84777#jobsDetail
https://cloud.tencent.com/document/product/460/84778#jobsDetail
https://cloud.tencent.com/document/product/460/84779#jobsDetail
https://cloud.tencent.com/document/product/460/84780#jobsDetail
https://cloud.tencent.com/document/product/460/84781#jobsDetail
https://cloud.tencent.com/document/product/460/84782#jobsDetail
https://cloud.tencent.com/document/product/460/84783#jobsDetail
https://cloud.tencent.com/document/product/460/84784#jobsDetail
https://cloud.tencent.com/document/product/460/84785#jobsDetail
https://cloud.tencent.com/document/product/460/84786#jobsDetail
https://cloud.tencent.com/document/product/460/84787#jobsDetail
https://cloud.tencent.com/document/product/460/84788#jobsDetail
https://cloud.tencent.com/document/product/460/84789#jobsDetailhttps://cloud.tencent.com/document/product/460/84789#jobsDetail
https://cloud.tencent.com/document/product/460/84790#jobsDetail
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图片处理：

智能语音：

AI 内容识别

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

智能封面

SDR to HDR  

视频拆条

图片处理

人声分离

听歌识曲

音频降噪

语音合成

语音识别

翻译

分词

视频目标检测

视频人像抠图

错误码

实际案例

请求1：查询一个音视频转码任务，该任务正在执行中

GET /jobs/j8d121820f5e411ec926ef19d53ba9c6f HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84791#jobsDetail
https://cloud.tencent.com/document/product/460/84792#jobsDetail
https://cloud.tencent.com/document/product/460/90888#jobsDetail
https://cloud.tencent.com/document/product/460/84793#jobsDetail
https://cloud.tencent.com/document/product/460/84794#jobsDetail
https://cloud.tencent.com/document/product/460/84795#jobsDetail
https://cloud.tencent.com/document/product/460/84796#jobsDetail
https://cloud.tencent.com/document/product/460/84797#jobsDetail
https://cloud.tencent.com/document/product/460/84798#jobsDetail
https://cloud.tencent.com/document/product/460/84799#jobsDetail
https://cloud.tencent.com/document/product/460/84800#jobsDetail
https://cloud.tencent.com/document/product/460/84801#jobsDetail
https://cloud.tencent.com/document/product/460/84802#jobsDetail
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        </Message>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Running</State>

        <Progress>30</Progress>

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>2022-06-27T15:23:13+0800</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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请求2：查询一个音视频转码任务，该任务执行成功

GET /jobs/j9c0a4726f6ac11ec96aaa9b64ab18d00 HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:25:22 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjY=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        </Message>

        <JobId>j9c0a4726f6ac11ec96aaa9b64ab18d00</JobId>

        <State>Success</State>

        <Progress>100</Progress>

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>2022-06-27T15:23:13+0800</StartTime>

        <EndTime>2022-06-27T15:24:33+0800</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>
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            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

            <MediaInfo>

                <Format>

                    <Bitrate>834.736000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>1424687</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104.047000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653311</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>
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                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>763.774000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>10</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Region>ap-chongqing</Region>

                    <ObjectName>output/out.mp4</ObjectName>

                    <Md5Info>

                            <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                            <ObjectName>output/out.mp4</ObjectName>

                    </Md5Info>

                </OutputFile>

            </MediaResult>

        </Operation>

    </JobsDetail>

</Response>
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多任务处理

提交多任务处理

MultiJobs
最近更新时间：2022-09-06 14:10:39

提交多个任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

        <Tag>Animation</Tag>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/animation.gif</Object>

        </Output>

        <UserData>This is my Animation job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <Operation>

        <Tag>Transcode</Tag>

        <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/transcode.mp4</Object>

        </Output>

        <UserData>This is my Trancode job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <Operation>

        <Tag>SmartCover</Tag>

        <SmartCover>

            <Format>jpg</Format>

            <Width>1280</Width>

            <Height>960</Height>

            <Count>5</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>

        </Output>   

        <UserData>This is my SmartCover job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>
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Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

对于不同的任务类型，Operation 的内容不同，请参照以下链接：

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则，个数不超过6个 Container 是

QueueId Request 任务所在的队列 ID String 是

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 媒体文件名 String 是

音视频转码

极速高清转码

视频转动图

视频截帧

智能封面

音视频拼接

人声分离

精彩集锦

SDR to HDR  

视频增强

超分辨率

音视频转封装

数字水印

提取数字水印

视频标签

获取媒体信息

音视频流分离

视频质量分析

语音合成

https://cloud.tencent.com/document/product/460/76913#operation
https://cloud.tencent.com/document/product/460/78248#operation
https://cloud.tencent.com/document/product/460/76900#operation
https://cloud.tencent.com/document/product/460/76910#operation
https://cloud.tencent.com/document/product/460/76909#operation
https://cloud.tencent.com/document/product/460/76901#operation
https://cloud.tencent.com/document/product/460/76918#operation
https://cloud.tencent.com/document/product/460/76915#operation
https://cloud.tencent.com/document/product/460/76907#operation
https://cloud.tencent.com/document/product/460/76916#operation
https://cloud.tencent.com/document/product/460/76912#operation
https://cloud.tencent.com/document/product/460/76908#operation
https://cloud.tencent.com/document/product/460/76902#operation
https://cloud.tencent.com/document/product/460/76903#operation
https://cloud.tencent.com/document/product/460/76917#operation
https://cloud.tencent.com/document/product/460/76904#operation
https://cloud.tencent.com/document/product/460/76911#operation
https://cloud.tencent.com/document/product/460/76906#operation
https://cloud.tencent.com/document/product/460/76914#operation
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

音频降噪

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Animation</Tag>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

            </Output>

            <UserData>This is my Animation job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/76905#operation
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        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Transcode</Tag>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>transcode_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.mp4</Object>

            </Output>

            <UserData>This is my Trancode job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>SmartCover</Tag>

            <SmartCover>

                <Format>jpg</Format>

                <Width>1280</Width>

                <Height>960</Height>

                <Count>5</Count>

                <DeleteDuplicates>true</DeleteDuplicates>

            </SmartCover>

            <Output>
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具体的数据内容如下：

Container 节点 Response 的内容：

对于不同的任务类型，JobsDetail 的内容不同，请参照以下链接：

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my SmartCover job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container 数组

音视频转码

极速高清转码

视频转动图

视频截帧

智能封面

音视频拼接

人声分离

精彩集锦

SDR to HDR  

视频增强

超分辨率

音视频转封装

数字水印

提取数字水印

视频标签

获取媒体信息

音视频流分离

https://cloud.tencent.com/document/product/460/76913#jobsDetail
https://cloud.tencent.com/document/product/460/78248#jobsDetail
https://cloud.tencent.com/document/product/460/76900#jobsDetail
https://cloud.tencent.com/document/product/460/76910#jobsDetail
https://cloud.tencent.com/document/product/460/76909#jobsDetail
https://cloud.tencent.com/document/product/460/76901#jobsDetail
https://cloud.tencent.com/document/product/460/76918#jobsDetail
https://cloud.tencent.com/document/product/460/76915#jobsDetail
https://cloud.tencent.com/document/product/460/76907#jobsDetail
https://cloud.tencent.com/document/product/460/76916#jobsDetail
https://cloud.tencent.com/document/product/460/76912#jobsDetail
https://cloud.tencent.com/document/product/460/76908#jobsDetail
https://cloud.tencent.com/document/product/460/76902#jobsDetail
https://cloud.tencent.com/document/product/460/76903#jobsDetail
https://cloud.tencent.com/document/product/460/76917#jobsDetail
https://cloud.tencent.com/document/product/460/76904#jobsDetail
https://cloud.tencent.com/document/product/460/76911#jobsDetail
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

视频质量分析

语音合成

音频降噪

错误码

实际案例

使用多个模板 ID

请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Tag>Animation</Tag>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/animation.gif</Object>

        </Output>

        <UserData>This is my Animation job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <Operation>

        <Tag>Transcode</Tag>

        <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/transcode.mp4</Object>

        </Output>

        <UserData>This is my Trancode job.</UserData>

        <JobLevel>0</JobLevel>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/76906#jobsDetail
https://cloud.tencent.com/document/product/460/76914#jobsDetail
https://cloud.tencent.com/document/product/460/76905#jobsDetail


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1633 共1701页

    </Operation>

    <Operation>

        <Tag>SmartCover</Tag>

        <SmartCover>

            <Format>jpg</Format>

            <Width>1280</Width>

            <Height>960</Height>

            <Count>5</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>

        </Output>   

        <UserData>This is my SmartCover job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>
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            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Animation</Tag>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

            </Output>

            <UserData>This is my Animation job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Transcode</Tag>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>trancode_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.mp4</Object>

            </Output>

            <UserData>This is my Trancode job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>
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        <Code>Success</Code>

        <Message/>

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>SmartCover</Tag>

            <SmartCover>

                <Format>jpg</Format>

                <Width>1280</Width>

                <Height>960</Height>

                <Count>5</Count>

                <DeleteDuplicates>true</DeleteDuplicates>

            </SmartCover>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my SmartCover job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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模板接口

删除模板
最近更新时间：2023-01-04 17:14:50

删除模板。

该请求操作的实现使用公共请求头，了解公共请求头详情请参见 公共请求头部  文档。

该请求操作无特殊的请求头部信息。

该请求的请求体为空。

功能描述

请求

请求实例

DELETE /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求头

公共头部

非公共头部

请求体

响应

响应头

公共响应头

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
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该响应包含公共响应头，了解公共响应头详情请参见 公共响应头部  文档。

该响应无特殊的响应头。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

特有响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TemplateId>A</TemplateId>

<Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

TemplateId Response 被删除的模板的 ID String

错误码

实际案例

请求

DELETE /template/t143ae6e040af6431aa772c9ec3f0a3f36 HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/42867
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJjYmU0YmRfOTBmYTUwNjRfODhjXzE=

<Response>

    <RequestId>NjJjYmU0YmRfOTBmYTUwNjRfODhjXzE=</RequestId>

    <TemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</TemplateId>

<Response>
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查询模板
最近更新时间：2023-01-10 14:14:52

查询模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

参数的具体内容如下：

功能描述

请求

请求示例

GET /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求头

请求体

请求参数

节点名称（关键

字）

父节

点
描述 类型

必

选

tag 无 模板类型，默认值: All
Strin
g

否

category 无
Official(系统预设模板)，Custom(自定义模板)，默认

值: Custom

Strin

g
否

ids 无 模板 ID，以 , 符号分割字符串 Strin

g

否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
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tag 支持以下几种类型:

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

name 无 模板名称前缀
Strin
g

否

pageNumber 无 第几页，默认值:1
Integ

er
否

pageSize 无 每页个数，默认值:10
Integ

er
否

模板类型 tag

音视频转码 Transcode

视频转动图 Animation

视频截图 Snapshot

智能封面 SmartCover

音视频拼接 Concat

人声分离 VoiceSeparate

精彩集锦 VideoMontage

视频增强 VideoProcess

超级分辨率 SuperResolution

图片/文字水印 Watermark

语音合成 Tts

音视频转码Pro TranscodePro

极速高清 HighSpeedHd

图片处理 PicProcess

语音识别 SpeechRecognition

响应

响应头

https://cloud.tencent.com/document/product/460/42866
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <TemplateList>

        <TemplateId>A</TemplateId>

        <Name>TemplateName</Name>

        <Tag>Transcode</Tag>

        <TransTpl>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

</Response>
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具体的数据内容如下：

Container 节点 Response 的内容：

对于不同的模板类型，TemplateList 内容同创建模板接口的 Response，请参照以下链接：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

案例一：按照模板 ID 维度查询

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

TotalCount Response 模板总数 Int

PageNumber Response 当前页数，同请求中的 pageNumber Int

PageSize Response 每页个数，同请求中的 pageSize Int

TemplateList Response 模板数组 Container 数组

音视频转码

视频转动图

视频截图

智能封面

音视频拼接

人声分离

精彩集锦

视频增强

超级分辨率

图片/文字水印  

语音合成

音视频转码Pro  

极速高清

错误码

实际案例

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/77093#Response
https://cloud.tencent.com/document/product/460/77088#Response
https://cloud.tencent.com/document/product/460/77091#Response
https://cloud.tencent.com/document/product/460/84734#Response
https://cloud.tencent.com/document/product/460/77089#Response
https://cloud.tencent.com/document/product/460/77098#Response
https://cloud.tencent.com/document/product/460/77096#Response
https://cloud.tencent.com/document/product/460/77097#Response
https://cloud.tencent.com/document/product/460/77092#Response
https://cloud.tencent.com/document/product/460/77099#Response
https://cloud.tencent.com/document/product/460/77095#Response
https://cloud.tencent.com/document/product/460/77094#Response
https://cloud.tencent.com/document/product/460/77090#Response
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请求

GET /template?ids=t1847cd4ca57f543e89f551dbe68169eb9,t1a30a323f55434a29b25bf2

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TemplateList>

        <TemplateId>t1847cd4ca57f543e89f551dbe68169eb9</TemplateId>

        <Name>TemplateName</Name>

        <Tag>Transcode</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransTpl>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>
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            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

    <TemplateList>

        <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

        <Name>template_name3544697</Name>

        <Tag>Concat</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/input/ad.mp4<

            </ConcatFragment>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate/>

                <Bitrate/>

                <Channels/>

                <Remove>false</Remove>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Width>1280</Width>

                <Height>960</Height>

                <Fps>15</Fps>

                <Remove>false</Remove>

                <Crf>25</Crf>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <DirectConcat>false</DirectConcat>

        </ConcatTemplate>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>
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案例二：按照分页列表维度查询

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

    </TemplateList>

    <NonExistTIDs>

        <TemplateId>C</TemplateId>

    </NonExistTIDs>

</Response>

请求

GET /template?pageSize=10&pageNumber=1 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <TemplateList>

        <TemplateId>t1847cd4ca57f543e89f551dbe68169eb9</TemplateId>

        <Name>TemplateName</Name>

        <Tag>Transcode</Tag>

        <TransTpl>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>
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                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

    <TemplateList>

        <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

        <Name>template_name3544697</Name>

        <Tag>Concat</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/input/ad.mp4<

            </ConcatFragment>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate/>

                <Bitrate/>

                <Channels/>

                <Remove>false</Remove>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Width>1280</Width>

                <Height>960</Height>
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                <Fps>15</Fps>

                <Remove>false</Remove>

                <Crf>25</Crf>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <DirectConcat>false</DirectConcat>

        </ConcatTemplate>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

    </TemplateList>

</Response>



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1648 共1701页

批量任务接口

触发任务（独立节点）
最近更新时间：2023-06-15 08:59:26

通过独立任务参数触发批量数据处理任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /inventorytriggerjob HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Name>demo</Name>

    <Type>Job</Type>

    <Input>

        <Prefix>input</Prefix>

    </Input>

    <Operation>

        <TimeInterval>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

        </TimeInterval>

        <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

        <UserData>this is my inventorytriggerjob</UserData>

        <CallBack>https://www.callback.com</CallBack>

        <Tag>Transcode</Tag>

        <JobParam>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        </JobParam>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

        </Output>

        <JobLevel>0</JobLevel>

    </Operation>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Name
Requ
est

存量触发任务名称，支持中文、英文、数字、—和_，
长度限制128字符

String 是

Type
Requ

est
批量处理任务类型：Job String 是

Input
Requ

est
待操作的文件信息

Contai

ner
是

Operation
Requ
est

操作规则
Contai
ner

是

节点名称（关

键字）

父节点 描述 类型 是否

必选



对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1650 共1701页

Container 类型 Operation 的具体数据描述如下：

Manifest
Request.I
nput

COS 清单列表文件名，COS 清单生成的 
manifest.json 文件

Stri
ng

否

UrlFile
Request.I

nput

URL 文件名，文件中每行的 URL 为一个 COS 

中对象的访问地址

Stri

ng
否

Prefix
Request.I

nput
Object 前缀

Stri

ng
否

Object
Request.I
nput

文件路径
Stri
ng

否

节点名称

（关键

字）

父节点 描述
类

型

是

否

必

选

TimeInt

erval

Reques

t.Opera

tion

按时间过滤的触发范围

Co

nt

ain

er

否

Tag

Reques

t.Opera

tion

创建的媒体任务类型 Tag
Str

ing
是

Output

Reques

t.Opera

tion

输出地址信息  

当媒体任务类型不为 VideoTag 、 

ExtractDigitalWatermark 、 MediaInfo 、 

QualityEstimate 时，该参数必选

Co

nt

ain

er

否

JobPar

am

Reques

t.Opera

tion

任务参数

Co

nt

ain
er

是

QueueI

d

Reques

t.Opera

tion

队列 ID
Str

ing
否

Queue

Type

Reques

t.Opera

tion

队列类型，限制为 SpeedTranscoding ，当 Tag 为 

Transcode 且 QueueId 为空时生效，表示为开启倍速转码

Str

ing
否
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Container 类型 CallBackMqConfig 的具体数据描述如下：

UserDa

ta

Reques

t.Opera

tion

用户信息 Str

ing

否

JobLev

el

Reques

t.Opera

tion

任务优先级，级别限制：0 、1 、2。级别越大任务优先级越

高，默认为0
Int 否

CallBa

ckFor

mat

Reques

t.Opera

tion

任务回调格式，JSON 或 XML，默认 XML，优先级高于队

列的回调格式

Str

ing
否

CallBa

ckType

Reques

t.Opera

tion

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队列的

回调类型

Str

ing
否

CallBa

ck

Reques

t.Opera

tion

任务回调地址，优先级高于队列的回调地址。设置为 no 时，表

示队列的回调地址不产生回调

Str

ing
否

CallBa

ckMqC

onfig

Reques

t.Opera

tion

任务回调 TDMQ 配置，当 CallBackType 为 TDMQ 时必

填

Co

nt

ain

er

否

节点名

称（关

键字）

父节点 描述
类

型

是

否

必

选

MqRe
gion

Request.Operatio
n.CallBackMqCon

fig

消息队列所属园区，目前支持园区 sh（上海）、bj
（北京）、gz（广州）、cd（成都）、hk（香港）

S

tr
in

g

是

MqMo

de

Request.Operatio

n.CallBackMqCon

fig

消息队列使用模式，默认 Queue ：

主题订阅：Topic

 队列服务: Queue

S

tr

in

g

是

MqNa

me

Request.Operatio

n.CallBackMqCon

fig

TDMQ 主题名称

S
tr

in

g

是
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Operation.Tag 支持的类型如下：

Container 类型 TimeInterval 的具体数据描述如下：

任务类型 Tag

视频转动图 Animatin

智能封面 SmartCover

音视频转码 Transcode

视频截图 Snapshot

语音识别 SpeechRecognition

音视频拼接 Concat

人声分离 VoiceSpearte

精彩集锦 VideoMontage

SDR to HDR SDRtoHDR

人声分离 VoiceSeparate

视频增强 VideoProcess

超级分辨率 SuperResolution

音视频转封装 Segment

视频标签 VideoTag

图片处理 PicProcess

数字水印 DigitalWatermark

提取数字水印 ExtractDigitalWatermark

异步获取媒体信息 MediaInfo

音视频流分离 StreamExtract

语音合成 Tts

音频降噪 NoiseReduction

视频质量分析 QualityEstimate
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Container 类型 Output 的具体数据描述如下：

节点名称

（关键字）

父节点 描

述

类

型

是

否

必

选

默

认

值

限制

Start
Request.Operation.

TimeInterval

开

始

时

间

St

rin

g

否 0

扫描对象的上传时间 

%Y-%m-

%dT%H:%m:%S

%z 

End
Request.Operation.

TimeInterval

结

束

时

间

St

rin

g

否

当

前

时

间

 扫描对象的上传时间

%Y-%m-

%dT%H:%m:%S

%z 

节点名称

（关键字）

父节

点
描述 类型

是

否

必

选

限制

Region

Requ

est.

Oper
ation

.Out

put

存储桶的地域 String 是 无

Bucket

Requ

est.

Oper

ation

.Out
put

存储桶的名称 String 是 无

Object Requ

est.

Oper

ation

.Out

put

结果文件名称 String 否 当媒体任务类型不为 Snapshot 、 

VoiceSeparate 、 

StreamExtract 时，该参数必选

当媒体任务类型为SmartCover，且

Request.Operation.JobParam.

SmartCover.Count 大于1时，必须

包含 ${Number} 参数

当媒体任务类型为 Snapshot，且 

Snapshot.Count 大于1时，必须包
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Container 类型 StreamExtract 的具体数据描述如下：

Container 类型 JobParam 的具体数据描述如下：

含  ${Number} 参数

AuObjec

t

Requ

est.

Oper

ation
.Out

put

人声结果文件

名
String 否

当媒体任务类型为 VideoSeParete 

时，该参数有效，且不能和 Object 同时
为空

SpriteOb

ject

Requ

est.

Oper

ation

.Out
put

雪碧图名 String 否

当媒体任务类型为 Snapshot 时，该

参数有效，且不能和 Object 同时为

空

当 Snapshot.Count 大于1时，必须

包含 ${Number} 参数

仅支持 jpg

StreamE

xtract

Requ

est.

Oper

ation

.Out
put

流分离结果文

件配置信息，

当媒体任务类

型为 

StreamExt

ract 时该参
数有效，且必

选

Conta

iner
是 无

节点

名称

（关

键
字）

父节点 描述
类

型

是

否

必
选

Inde

x

Request.Operat

ion.Output.Stre

amExtract

流的编号，对应媒体信息中的 

Response.MediaInfo.Stream.Video.Index

和 Response.MediaInfo.Stream.Audio.Index，

详见 获取媒体信息接口 ，当输入媒体格式为 mxf 格式

时，只支持提取 video 流

S

tr

in

g

是

Obje

ct

Request.Operat

ion.Output.Stre

amExtract

结果输出文件名

S
tr

in

g

是

https://cloud.tencent.com/document/product/460/49284
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节点名

称（关
键字）

父节点 描述 类型 是

否
必

选

Templ

ateId

Reques

t.Opera

tion.Job

Param

模板 ID
Strin

g
否

Trans
code

Templ

ateId

Reques
t.Opera

tion.Job

Param

转码模板 ID，当媒体任务类型为 VideoProcess 、

SuperResolution 、 SDR2HDR 时有效

Cont

ainer
否

Anim

ation

Reques

t.Opera

tion.Job

Param

动图任务参数，当媒体任务类型为 Animation 时有效
Cont

ainer
否

Trans

code

Reques

t.Opera

tion.Job

Param

转码任务参数，当媒体任务类型为 Transcode 、

VideoProcess 、SuperResolution 、 SDR2HDR 时该

参数有效

Strin

g
否

Smart

Cover

Reques

t.Opera

tion.Job
Param

智能封面任务参数，当媒体任务类型为 SmartCover 时有效
Cont

ainer
否

Digital

Water

mark

Reques

t.Opera

tion.Job

Param

数字水印参数，当媒体任务类型为 Transcode 、

VideoProcess 、SuperResolution 、 

DigitalWatermark 时该参数有效

Cont

ainer
否

Water
mark

Reques

t.Opera
tion.Job

Param

水印模板参数，同创建水印模板 CreateMediaTemplate 

接口的 Request.Watermark，当媒体任务类型为 
Transcode 、 SDR2HDR 、 VideoProcess 、 

SuperResolution 时该参数有效

Cont
ainer

否

Water

mark

Templ

ateId

Reques

t.Opera

tion.Job

Param

水印模板参数，同创建水印模板 CreateMediaTemplate 

接口的 Request.Watermark ，当媒体任务类型为 

Transcode 、 SDR2HDR 、 VideoProcess 、 

SuperResolution 时该参数有效

Cont

ainer
否

Remo
veWat

Reques
t.Opera

去除水印参数，当媒体任务类型为 Transcode 时有效 Cont
ainer

否
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ermar

k

tion.Job

Param

Subtit

les

Reques

t.Opera

tion.Job

Param

字幕参数，当媒体任务类型为 Transcode 时有效
Cont

ainer
否

Snap

shot

Reques

t.Opera

tion.Job

Param

截图任务参数，当媒体任务类型为 Snapshot 时有效
Cont

ainer
否

Spee

chRe

cognit
ion

Reques

t.Opera

tion.Job
Param

语音识别任务参数，当媒体任务类型为 

SpeechRecognition 时有效

Cont

ainer
否

Conc

atTe

mplat

e

Reques

t.Opera

tion.Job

Param

拼接任务参数，当媒体任务类型为 Concat 时有效
Cont

ainer
否

Voice

Separ
ate

Reques

t.Opera
tion.Job

Param

人声分离任务参数，当媒体任务类型为 VoiceSeparate 时
有效

Cont
ainer

否

Video

Mont

age

Reques

t.Opera

tion.Job

Param

精彩集锦任务参数，当媒体任务类型为 VideoMontage 时有

效

Cont

ainer
否

SDRt

oHDR

Reques
t.Opera

tion.Job

Param

SDR2HDR 任务参数，当媒体任务类型为 SDRtoHDR 时有

效

Cont

ainer
否

Video

Proce

ss

Reques

t.Opera

tion.Job

Param

视频增强任务参数，当媒体任务类型为 VideoProcess 时有

效

Cont

ainer
否

Super

Resol

ution

Reques

t.Opera

tion.Job

Param

超分辨率任务参数，当媒体任务类型为 SuperResolution 

时有效

Cont

ainer
否
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Container 类型 DigitalWatermark 的具体数据描述如下：

Segm

ent

Reques

t.Opera

tion.Job

Param

转封装任务参数，当媒体任务类型为 Segment 时有效 Cont

ainer

否

Extra

ctDigi

talWa

terma

rk

Reques

t.Opera

tion.Job

Param

提取数字水印任务参数，当媒体任务类型为 

ExtractDigitalWatermark 时有效

Cont

ainer
否

Video
Tag

Reques

t.Opera
tion.Job

Param

视频标签任务参数，当媒体任务类型为 VideoTag 时有效
Cont
ainer

否

TtsTp

l

Reques

t.Opera

tion.Job

Param

语音合成模板参数，当媒体任务类型为 Tts 时有效
Cont

ainer
否

Noise

Redu

ction

Reques
t.Opera

tion.Job

Param

音频降噪模板参数，当媒体任务类型为 NoiseReduction 时

有效

Cont

ainer
否

注意

 优先使用 TemplateId，无 TemplateId 时使用对应任务类型的参数。

节点

名称

（关

键

字）

父节点 描述
类

型

是

否

必

选

Mess

age

Request.Op
eration.Job

Param.Digit

alWatermar

k

数字水印嵌入的字符串信息，长度不超过64个字符，仅支持

中文、英文、数字、_、-和*

St

ri

n

g

是

Type Request.Op

eration.Job

水印类型，当前仅可设置为 Text St

ri

是
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Container 类型 Animation 的内容： 

同 提交动图任务  的 Request.Operation.Animation

Container 类型 Transcode 的内容： 

同 提交音视频转码任务  的 Request.Operation.Transcode

Container 类型 Watermark 的内容： 

同 提交音视频转码任务  的 Request.Operation.Watermark

Container 类型 RemoveWatermark 的内容： 

同 提交音视频转码任务  的 Request.Operation.RemoveWatermark

Container 类型 SmartCover 的内容： 

同 提交智能封面任务  的 Request.Operation.SmartCover

Container 类型 Snapshot 的内容： 

同 提交截图任务  的 Request.Operation.Snapshot

Container 类型 SpeechRecognition 的内容： 

同 提交语音识别任务  的 Request.Operation.SpeechRecognition

Container 类型 ConcatTemplate 的内容： 

同 提交拼接任务  的 Request.Operation.ConcatTemplate

Container 类型 VoiceSeparate 的内容： 

同 提交人声分离任务  的 Request.Operation.VoiceSeparate

Container 类型 VideoMontage 的内容： 

同 提交精彩锦集任务  的 Request.Operation.VideoMontage

Container 类型 SDRtoHDR 的内容： 

同 提交SDRtoHDR任务  的 Request.Operation.SDRtoHDR

Container 类型 VideoProcess 的内容： 

同 提交视频增强任务  的 Request.Operation.VideoProcess

Container 类型 SuperResolution 的内容： 

同 提交超分辨率任务  的 Request.Operation.SuperResolution

Param.Digit
alWatermar

k

n
g

Versi

on

Request.Op

eration.Job

Param.Digit

alWatermar

k

水印版本，当前仅可设置为 V1

St

ri

n

g

是

Ignor

eErr

or

Request.Op

eration.Job

Param.Digit

alWatermar

k

 当添加水印失败是否忽略错误继续执行任务，限制为 

true/false，默认为false

 当 Request.Operation.Tag 为 

DigitalWatermark 时，该参数无效，添加水印失败任

务失败 

B

o

ol

否

https://cloud.tencent.com/document/product/460/84784
https://cloud.tencent.com/document/product/460/84790
https://cloud.tencent.com/document/product/460/84781
https://cloud.tencent.com/document/product/460/84790
https://cloud.tencent.com/document/product/460/84791
https://cloud.tencent.com/document/product/460/84780
https://cloud.tencent.com/document/product/460/84798
https://cloud.tencent.com/document/product/460/84788
https://cloud.tencent.com/document/product/460/84794
https://cloud.tencent.com/document/product/460/84794
https://cloud.tencent.com/document/product/460/84792
https://cloud.tencent.com/document/product/460/84782
https://cloud.tencent.com/document/product/460/84774
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Container 类型 Segment 的内容： 

同 提交转封装任务  的 Request.Operation.Segment

Container 类型 ExtractDigitalWatermark 的内容： 

同 提交提取数字水印任务  的 Request.Operation.ExtractDigitalWatermark

Container 类型 VideoTag 的内容： 

同 提交智能视频标签任务  的 Request.Operation.VideoTag

Container 类型 TtsTpl 的内容： 

同 提交语音合成任务  的 Request.Operation.TtsTpl

Container 类型 NoiseReduction 的内容： 

同 提交音频降噪任务  的 Request.Operation.NoiseReduction

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应

响应头

响应体

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==<RequestId>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Job</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>be8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>2022-06-27T15:23:11+0800</StartTime>    

        <EndTime>2022-06-27T15:25:10+0800</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

            <UserData>this is my inventorytriggerjob</UserData>

            <CallBack>https://www.callback.com</CallBack>

            <Tag>Transcode</Tag>

https://cloud.tencent.com/document/product/460/84789
https://cloud.tencent.com/document/product/460/84786
https://cloud.tencent.com/document/product/460/84779
https://cloud.tencent.com/document/product/460/84797
https://cloud.tencent.com/document/product/436/85045
https://cloud.tencent.com/document/product/460/42866


对象存储

版权所有：腾讯云计算（北京）有限责任公司 第1660 共1701页

具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

            <JobParam>

                <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            </JobParam>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

            </Output>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

JobsDetail Response 任务的详细信息 Container

节点名称

（关键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State为 Failed 时有意义

Strin

g

Message
Response.J

obsDetail
错误描述，只有 State为 Failed 时有意义

Strin

g

Type
Response.J

obsDetail
批量处理任务类型，Job

Strin

g

Name
Response.J

obsDetail
新创建任务的名称

Strin

g

JobId
Response.J

obsDetail
新创建任务的 ID

Strin

g
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

State Response.J

obsDetail

任务的状态，为 Submitted、Running、Success、

Failed、Pause、Cancel 其中一个

Strin

g

Creation

Time

Response.J

obsDetail
任务的创建时间

Strin

g

StartTim

e

Response.J

obsDetail
任务的开始时间

Strin

g

EndTime
Response.J

obsDetail
任务的结束时间

Strin

g

Input
Response.J

obsDetail
该任务的输入资源地址，同请求中的 Request.Input 节点

Cont

ainer

Operatio

n

Response.J

obsDetail

该任务的操作规则，同请求中的 Request.Input 

Operation

Cont

ainer

错误码

实际案例

请求

POST /inventorytriggerjob HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Name>demo</Name>

    <Type>Job</Type>

    <Input>

        <Prefix>input</Prefix>

    </Input>

    <Operation>

        <TimeInterval>

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

        </TimeInterval>

        <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

        <UserData>this is my inventorytriggerjob</UserData>

        <CallBack>https://www.callback.com</CallBack>

https://cloud.tencent.com/document/product/460/42867
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        <Tag>Transcode</Tag>

        <JobParam>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        </JobParam>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

        </Output>

        <JobLevel>0</JobLevel>

    </Operation>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==<RequestId>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Job</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>be8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>2022-06-27T15:23:11+0800</StartTime>    

        <EndTime>2022-06-27T15:25:10+0800</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>
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            <UserData>this is my inventorytriggerjob</UserData>

            <CallBack>https://www.callback.com</CallBack>

            <Tag>Transcode</Tag>

            <JobParam>

                <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            </JobParam>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

            </Output>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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触发任务（工作流）
最近更新时间：2022-09-05 11:38:23

通过工作流触发批量数据处理任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /inventorytriggerjob HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Name>demo</Name>

    <Type>Workflow</Type>

    <Input>

        <Prefix>input</Prefix>

    </Input>

    <Operation>

        <TimeInterval>

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

Container 类型 Operation 的具体数据描述如下：

        </TimeInterval>

        <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

    </Operation>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Name
Requ

est

批量触发任务名称，支持中文、英文、数字、—和_，

长度限制128字符
String 是

Type
Requ
est

批量处理任务类型: Workflow String 否

Input
Requ

est
待操作的媒体信息

Contai

ner
是

Operation
Requ

est
操作规则

Contai

ner
是

节点名称（关

键字）
父节点 描述 类型

是否

必选

Manifest
Request.I

nput

COS 清单列表文件名，COS 清单生成的 

manifest.json 文件

Stri

ng
否

UrlFile
Request.I
nput

URL 文件名，文件中每行的 URL 为一个 COS 
中对象的访问地址

Stri
ng

否

Prefix
Request.I

nput
Object 前缀

Stri

ng
否

Object
Request.I

nput
媒体文件名

Stri

ng
否
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Container 类型 TimeInterval 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

节点名称（关键字） 父节点 描述 类型 是否必选

WorkflowIds
Request.Operati

on
触发的工作流 ID String 是

TimeInterval
Request.Operati

on
按时间过滤的触发范围

Contain

er
否

节点名称

（关键

字）

父节点
描

述
类型

是

否

必

选

默认

值
限制

Start
Request
.TimeInt

erval

开
始

时

间

Stri

ng
否 0

扫描对象的上传时间 

%Y-%m-%dT%H:%m:%S%z 

End

Request

.TimeInt

erval

结

束

时

间

Stri

ng
否

当前

时间

扫描对象的上传时间 

%Y-%m-%dT%H:%m:%S%z 

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <Type>Workflow</Type>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

 

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称

（关键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Strin

g

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Strin

g

Type
Response.J

obsDetail
批量处理任务类型

Strin

g

Name
Response.J

obsDetail
新创建任务的名称

Strin

g

JobId Response.J 新创建任务的 ID Strin
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

obsDetail g

State
Response.J

obsDetail

任务的状态，为 Submitted、Running、Success、

Failed、Pause、Cancel 其中一个

Strin

g

Creation

Time

Response.J

obsDetail
任务的创建时间

Strin

g

StartTim

e

Response.J

obsDetail
任务的开始时间

Strin

g

EndTime
Response.J

obsDetail
任务的结束时间

Strin

g

Input
Response.J

obsDetail
同请求中的 Request.Input

Cont

ainer

Operatio

n

Response.J

obsDetail
同请求中的 Request.Operation

Cont

ainer

错误码

实际案例

请求

POST /inventorytriggerjob HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Name>demo</Name>

    <Type>Workflow</Name>

    <Input>

        <Prefix>input</Prefix>

    </Input>

    <Operation>

        <TimeInterval>

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

        </TimeInterval>

        <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

https://cloud.tencent.com/document/product/460/42867
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    </Operation>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Workflow</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

</Response>
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取消任务
最近更新时间：2022-09-05 11:38:28

取消批量数据处理任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该请求无响应体。

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

功能描述

请求

请求示例

PUT /inventorytriggerjob/<jobId>?cancel HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

错误码

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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实际案例

请求

PUT /inventorytriggerjob/b-xxx-xxx-xxx-xxxx?cancel HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=
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查询任务
最近更新时间：2022-09-09 11:29:43

查询批量数据处理任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /inventorytriggerjob/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

    <RequestId><RequestId>

    <JobsDetail>

    ...

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

对于不同的触发方式，JobsDetail 的内容不同，请参照以下链接：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

    </JobsDetail>

    <NonExistJobIds></NonExistJobIds>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

RequestId
Respons

e
请求的唯一 ID String

JobsDetail
Respons

e
任务的详细信息

Containe

r

NonExistJobId

s

Respons

e

查询的 ID 中不存在的任务，所有任务都存在时不返

回
String

工作流

独立任务

错误码

实际案例

请求

GET /inventorytriggerjob/b3deffea2f84911ec9cb15254008618d9 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

响应

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/76887#jobsDetail
https://cloud.tencent.com/document/product/460/80155#jobsDetail
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==</RequestId>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Workflow</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

</Response>
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批量拉取任务
最近更新时间：2022-09-09 11:29:57

拉取批量数据处理任务列表。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

参数的具体内容如下：

功能描述

请求

请求示例

GET /inventorytriggerjob?size=&states=&startCreationTime=&endCreationTime= HTTP/1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

节点名称（关
键字）

父
节

点

描述 类型
必
选

nextToken 无 请求的上下文，用于翻页。上次返回的值
Stri

ng
否

size 无 拉取的最大任务数。默认为10。最大为100
Inte

ger
否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

type 无 拉取批量任务类型，工作流类型 Workflow 、任务类型 Job Stri

ng

否

orderByTim

e
无 Desc 或者 Asc。默认为 Desc

Stri

ng
否

states 无
拉取该状态的任务，以 ， 分割支持多状态 

 All，Submitted，Running，Success，Failed，
Pause，Cancel。默认为 All

Stri

ng
否

startCreatio

nTime
无

拉取创建时间大于等于该时间的任务。格式为：

%Y-%m-%dT%H:%m:%S%z 

Stri

ng
否

endCreatio

nTime
无

拉取创建时间小于等于该时间的任务。格式为：

%Y-%m-%dT%H:%m:%S%z

Stri

ng
否

workflowId 无 工作流 ID
Stri
ng

否

jobId 无 批量触发任务 ID
Stri

ng
否

name 无 批量触发任务名称
Stri

ng
否

响应

响应头

响应体

<Response>

    <RequestId></RequestId>

    <JobsDetail>

    .

    </JobsDetail>

    <NextToken></NextToken>

</Response>

..

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

对于不同的触发方式，JobsDetail 的内容不同，请参照以下链接：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

JobsDetail Response 任务的详细信息 Container 数组

NextToken Response 翻页的上下文 Token String

工作流

独立任务

错误码

实际案例

请求

GET /inventorytriggerjob HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==</RequestId>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Workflow</Type>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/76887#jobsDetail
https://cloud.tencent.com/document/product/460/80155#jobsDetail
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        <Message/>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Job</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>be8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>2022-06-27T15:23:11+0800</StartTime>    

        <EndTime>2022-06-27T15:25:10+0800</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

            <UserData>this is my inventorytriggerjob</UserData>

            <CallBack>https://www.callback.com</CallBack>

            <JobParam>

                <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            </JobParam>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>
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                <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

            </Output>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <NextToken>25</NextToken>

</Response>
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附录
结构体
最近更新时间：2023-07-17 20:14:42

Container 类型  的具体数据描述如下：

MediaWorkflow_Topology_Nodes_Start_Input

节点名称（关键字） 描述 类型 是否必选
限

制

ObjectPrefix Object 前缀 String 是 无

QueueId 队列 ID String 是 无

PicProcessQueue

Id
图片处理队列 ID String

当存在图片处理节

点时必选
无

SpeechRecogniti

onQueueId
语音识别队列 ID String

当存在语音识别节

点时必选
无

AIProcessQueueI

d
AI 处理队列 ID String

当存在 AI 识别节

点时必选
无

NotifyConfig
回调信息，如果不设置，则使用队列

的回调信息

Conta

iner
否 无

ExtFilter 文件后缀过滤器
Conta

iner
否 无

NotifyConfig

节点名称（关

键字）
描述

类

型

是否

必选

默

认

值

限制

Url 回调地址
Str
ing

是 无 不能为内网地址

Type 回调类型
Str

ing
是 无

Url：url 回调 

TDMQ：tdmq 消息回调 

Event 回调信息
Str

ing
是 无

TaskFinish：任务完成 

WorkflowFinish：工作流完成 

支持多种事件，以逗号分隔
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Container 类型  的具体数据描述如下：

ResultFor

mat

回调格式 Str

ing

否 X

ML

XML：xml 格式 

JSON：json 格式

MqRegion
TDMQ 所

属园区

Str

ing
否 无

当回调类型为 TDMQ 时必填，支持园区详

见 TDMQ请求地域说明 文档

MqMode
TDMQ 使
用模式

Str
ing

否 无

当回调类型为 TDMQ 时必填。

Topic：主题订阅 

Queue：队列服务 

MqName
TDMQ 主

题名称

Str

ing
否 无 当回调类型为 TDMQ 时必填。

ExtFilter

节点名称（关
键字）

描述
类
型

是否
必选

默
认

值

限制

State 开关
Stri

ng
否 Off On/Off

Video 打开视频后缀限制
Stri

ng
否

fal

se
false/true

Audio 打开音频后缀限制
Stri

ng
否

fal

se
false/true

Image 打开图片后缀限制
Stri

ng
否

fal

se
false/true

ContentTyp

e

打开 

ContentType 

限制

Stri

ng
否

fal

se
false/true

Custom
打开自定义后缀限

制

Stri

ng
否

fal

se
false/true

CustomExts 自定义后缀
Stri

ng
否 无

多种文件后缀以/分隔，后缀个

数不超过10个

当 Custom 为 true 时，该参

数必填

AllFile 所有文件
Stri

ng
否

fal

se
false/true

https://cloud.tencent.com/document/product/406/12667
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MediaWorkflow_Topology_Nodes_***_Operation_Output

节点名称

（关键
字）

描述 类型

是

否

必
选

限制

Region

存储

桶的

地域

Stri

ng
是 无

Bucket

存储

桶的
名称

Stri

ng
是 无

Object

结果

文件

名称

Stri

ng
是

当工作流节点类型为 Snapshot 或 SmartCover，且结果

文件不止一个时，必须包含 ${Number} $

当工作流节点类型为 Segment，设置了 Duration，且 

Format 不为 HLS 或 m3u8 时，必须包含 ${Number} 

SpriteOb
ject

雪碧

图的
名称

Stri
ng

否
当工作流节点类型为 Snapshot，且打开了雪碧图时，该字段必
填

AuObjec

t

人声

结果

文件

名称

Stri

ng
否

当工作流节点类型为 VoiceSeparate，且有人声输出时，该字

段必填

MediaWorkflow_Topology_Nodes_Snapshot_***_Operation

节点名称（关键字） 描述 类型 是否必选
限

制

TemplateId 截图模板 ID String 是 无

Output 输出地址 Container，详情请参见 Output 是 无

MediaWorkflow_Topology_Nodes_Animation_***_Operation

节点名称（关键字） 描述 类型 是否必选
限

制

TemplateId 视频转动图模板 ID String 是 无
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Container 类型 MediaWorkflow_Topology_Nodes_Transcode_***_Operation.Input 的具体数据描

述如下：

Output 输出地址 Container，详情请参见 

Output

是 无

MediaWorkflow_Topology_Nodes_SmartCover_***_Operation

节点名称（关键字） 描述 类型
是否必

选

限

制

TemplateId 智能封面模板 ID String 否 无

SmartCover 智能封面参数
Container，详情请参见 

SmartCover
否 无

Output 输出地址 Container，详情请参见 Output 是 无

说明

 TemplateId 和 SmartCover 都可以不设置，默认以原视频大小生成3张封面。如果同时设置 

TemplateId 和 SmartCover，TemplateId 优先生效。

MediaWorkflow_Topology_Nodes_Transcode_***_Operation

节点名称（关

键字）
描述 类型

是否

必选
限制

TemplateId
音视频转码

模板 ID
String 否 无

WatermarkT

emplateId
水印模板 ID String 数组 否

可以使用多个水印模

板，不超过3个

RemoveWat

ermark

去除水印参

数

Container，详情请参见 

RemoveWatermark
否 无

DigitalWater

mark

数字水印参

数

Container，详情请参见 

DigitalWatermark
否 无

Output 输出地址
Container，详情请参见 

Output
是 无

Input 输入配置 Container 否 无

节点名称（关键字） 描述 类型 必选 限制
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SpeedTranscodingQueueId 倍速转码队列 String 否 无

MediaWorkflow_Topology_Nodes_Concat_***_Operation

节点名称（关键字） 描述 类型 是否必选
限

制

TemplateId 拼接模板 ID String 是 无

Output 输出地址 Container，详情请参见 Output 是 无

MediaWorkflow_Topology_Nodes_VoiceSeparate_***_Operation

节点名称（关键字） 描述 类型 是否必选
限
制

TemplateId 人声分离模板 ID String 是 无

Output 输出地址
Container，详情请参见 

Output
是 无

MediaWorkflow_Topology_Nodes_VideoMontage_***_Operation

节点名称（关键字） 描述 类型 是否必选
限

制

TemplateId 精彩集锦模板 ID String 是 无

Output 输出地址
Container，详情请参见 

Output
是 无

MediaWorkflow_Topology_Nodes_SDRtoHDR_***_Operation

节点名称（关键

字）
描述 类型

是否

必选
限制

SDRtoHDR
SDRtoHDR 

配置
Container 是 无

TranscodeTe
mplateId

音视频转码模
板 ID

String 是 无

WatermarkTe

mplateId
水印模板 ID String 数组 否

可以使用多个水印模板，

不超过3个
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Container 类型 SDRtoHDR 的具体数据描述如下：

Container 类型 SCF 的具体数据描述如下：

Output 输出地址 Container，详情请参

见 Output

是 无

节点名称（关键字） 描述 类型 是否必选 限制

HdrMode HDR 标准 String 是
HLG

HDR10 

MediaWorkflow_Topology_Nodes_VideoProcess_***_Operation

节点名称（关键

字）
描述 类型

是否

必选
限制

TemplateId
视频增强模

板 ID
String 是 无

TranscodeT

emplateId

音视频转码

模板 ID
String 是 无

WatermarkT

emplateId
水印模板 ID String 数组 否

可以使用多个水印模

板，不超过3个

DigitalWater

mark

数字水印参

数

Container，详情请参见 

DigitalWatermark
否 无

Output 输出地址
Container，详情请参见 

Output
是 无

MediaWorkflow_Topology_Nodes_SCF_***_Operation

节点名称（关键字） 描述 类型 是否必选 限制

SCF SCF 函数信息 Container 是 无

节点名称（关键字） 描述 类型 是否必选 限制

Region 函数地域 String 是 无

FunctionName 函数名称 String 是 无

Namespace 命名空间 String 否 无
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Container 类型 Segment 的具体数据描述如下：

Alias 函数别名 String 否 无

MediaWorkflow_Topology_Nodes_SuperResolution_***_Operati

on

节点名称（关键

字）
描述 类型

是否

必选
限制

TemplateId
超级分辨率

模板 ID
String 是 无

TranscodeT

emplateId

音视频转码

模板 ID
String 是 无

WatermarkT

emplateId
水印模板 ID String 数组 否

可以使用多个水印模

板，不超过3个

DigitalWater

mark

数字水印参

数

Container，详情请参见 

DigitalWatermark
否 无

Output 输出地址
Container，详情请参见 

Output
是 无

MediaWorkflow_Topology_Nodes_Segment_***_Operation

节点名称（关键字） 描述 类型
是否必

选

限

制

Segment 音视频转封装参数 Container 是 无

Output 输出地址
Container，详情请参见 

Output
是 无

节点名称（关键

字）
描述 类型

是否

必选
限制

Format 封装格式 String 是
aac、mp3、flac、mp4、ts、mkv、

avi、hls、m3u8

Duration
转封装时长,单

位:秒
String 否 不小于5的整数

HlsEncrypt hls 加密配置 Conta

iner

否 只有当封装格式为 hls 时生效，详情请参见 

HlsEncrypt
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Container 类型 StreamPackConfig 的具体数据描述如下：

MediaWorkflow_Topology_Nodes_PicProcess_***_Operation

节点名称（关键字） 描述 类型 是否必选
限

制

TemplateId 图片处理模板 ID String 是 无

Output 输出地址
Container，详情请参见 

Output
是 无

MediaWorkflow_Topology_Nodes_Tts_***_Operation

节点名称（关键字） 描述 类型 是否必选
限
制

TemplateId 语音合成模板 ID String 是 无

Output 输出地址
Container，详情请参见 

Output
是 无

MediaWorkflow_Topology_Nodes_SpeechRecognition_***_Oper
ation

节点名称（关键字） 描述 类型 是否必选
限

制

Output 输出地址 Container，详情请参见 Output 是 无

StreamPackConfig 打包配置 Container 是 无

MediaWorkflow_Topology_Nodes_StreamPackConfig_***_Opera

tion

节点名称（关键字） 描述 类型 是否必选 限制

StreamPackConfig 打包配置 Container 否 无

节点名称（关键

字）
描述 类型

是否必

选
限制

PackType 打包类型。默认值：HLS Stri

ng

否 HLS/DA

SH
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Container 类型 StreamPackInfo 的具体数据描述如下：

Container 类型 VideoStreamConfig 的具体数据描述如下：

IgnoreFailedStr
eam

忽略转码失败的子流，继续打包。默认值：
true

Stri
ng

否
true/fal
se

MediaWorkflow_Topology_Nodes_VideoStream_***_Operation

节点名称（关

键字）
描述 类型

是否

必选
限制

TemplateId
音视频转码
模板 ID

String 否 无

WatermarkT

emplateId
水印模板 ID String 数组 否

可以使用多个水印模

板，不超过3个

RemoveWat

ermark

去除水印参

数

Container，详情请参见 

RemoveWatermark
否 无

Output 输出地址
Container，详情请参见 
Output

是 无

MediaWorkflow_Topology_Nodes_StreamPack_***_Operation

节点名称（关键字） 描述 类型 是否必选 限制

StreamPackInfo 打包规则 Container 否 无

节点名称（关键字） 描述 类型 是否必选 限制

VideoStreamConfig 视频子流配置 Container 否 无

节点名称（关
键字）

描述
类
型

是否
必选

限制

VideoStre

amName
视频子流名称

Str

ing
是

必须和存在的视频

节点对应

BandWidth
视频子流带宽限制，单位b/s，范围[0, 

2000000000]，0表示不限制

Str

ing
否

大于等于0，默认

值是0

AudioMix
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Container 类型 EffectConfig 的具体数据描述如下：

节点名称（关

键字）

描述 类型 必

选

默

认

值

限制

AudioSour

ce
需要被混音的音轨媒体地址

Strin

g
是 无

需与Input媒体文件存储

于同一bucket

MixMode 混音模式
Strin

g
否

Re

pe

at

Repeat:背景音循环

Once:背景音一次播

放

Replace
是否用混音音轨媒体替换Input

媒体文件的原音频

Strin

g
否

fal

se
true/false

EffectConf

ig
混音淡入淡出配置

Cont

ainer
否

fal

se
无

节点名称（关键字） 描述 类型 必选 默认值 限制

EnableStartFadei

n
开启淡入

Strin

g
否 false true/false

StartFadeinTime 淡入时长
Strin
g

否 无 大于0, 支持浮点数

EnableEndFadeou

t
开启淡出

Strin

g
否 false true/false

EndFadeoutTime 淡出时长
Strin

g
否 无 大于0, 支持浮点数

EnableBgmFade 开启bgm转换淡入
Strin
g

否 false true/false

BgmFadeTime bgm转换淡入时长
Strin

g
否 无 大于0, 支持浮点数

CallBackMqConfig

节点名称（关

键字）
描述

类

型

是
否

必

选

MqRegion 消息队列所属园区，目前支持园区 sh（上海）、bj（北京）、gz（广 St 是
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州）、cd（成都）、hk（香港） ri

n

g

MqMode

消息队列使用模式，默认 Queue ：

主题订阅：Topic 

 队列服务: Queue

St

ri

n

g

是

MqName TDMQ 主题名称

St

ri

n
g

是

DigitalWatermark

节点名称

（关键

字）

描述
类

型

是

否

必

选

限制

Messag

e
嵌入数字水印的水印信息

Str

ing
是

长度不超过64个字符，仅支持

中文、

英文、数字、_、-和*

Type 数字水印类型
Str

ing
是 当前仅可设置为 Text

Version 数字水印版本
Str

ing
是 当前仅可设置为 V1

IgnoreE

rror

当添加水印失败是否忽略错误继续执

行任务

Str

ing
是 限制为 true/false

State

添加水印是否成功，执行中为

Running，成功为 Success，失败

为 Failed

Str

ing
否

该字段不能主动设置，当任务提

交成功时，会返回该字段

DashEncrypt

节点名称（关键

字）
描述

类

型

是否

必选

默

认

值

限制

IsEncrypt
是否开启 DASH 

加密

Str

ing
否

fal

se
true/false
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UriKey DASH 加密的 

key

Str

ing

否 无 当 IsEncrypt 为 true 时，该参

数才有意义

HlsEncrypt

节点名称（关键

字）
描述

类

型

是否

必选

默

认

值

限制

IsEncrypt
是否开启 HLS 

加密

Str

ing
否

fal

se
true/false

UriKey
HLS 加密的 

key

Str

ing
否 无

当 IsEncrypt 为 true 时，该参

数才有意义

RemoveWatermark

节点名称（关键字） 描述 类型 是否必选 限制

Dx 距离左上角原点 x 偏移
Strin

g
是

值范围：[0, 

4096]

单位：px

Dy 距离左上角原点 y 偏移
Strin
g

是

值范围：[0, 

4096]

单位：px

Width 水印的宽度
Strin

g
是

值范围：(0, 

4096]

单位：px

Height 水印的高度
Strin
g

是

值范围：(0, 

4096]

单位：px

SmartCover

节点名称（关

键字）
描述 类型

是否

必选

默认

值
限制

Format
图片
格式

Strin
g

否 jpg jpg、png  、webp

Width 宽 Strin 否 视频 值范围：[128，4096]
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g 原始

宽度

单位：px

若只设置 Width 时，按照视频原始比例

计算 Height

Height 高
Strin

g
否

视频

原始

高度

值范围：[128，4096]

单位：px

若只设置 Height 时，按照视频原始比

例计算 Width

Count
截图

数量

Strin

g
否 3 [1,10]

DeleteDupli
cates

封面
去重

Strin
g

否 false true/false
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云查毒接口
提交病毒检测任务
最近更新时间：2022-04-15 10:02:27

云查毒功能为异步请求方式，您可以通过本接口对云上的文件进行文件病毒（例如木马病毒、蠕虫病毒等）检测，然

后通过查询病毒检测结果接口，查询病毒检测的结果。

功能描述

费用说明

如果文件属于 COS 上的低频存储类型，调用检测会产生 COS 低频数据取回费用 。

不支持检测 COS 上的归档存储类型和深度归档存储类型的文件，此类型文件请先 恢复归档文件 。

限制说明

文件大小支持：文件 < 1GB。

文件支持格式：EXE、DLL、SCR、SYS、MSI、SWF、JAR、APPLETJAR、JS、VBS、HTML、

BAT、WSF、PS1、HTM、MHT、HTA、CHM、LNK、DOC、DOCX、DOCX、DOTX、DOCM、

DOTM、XLS、XLSX、XLSM、XLSB、XLTM、 XLTX、XLAM、PPT、PPTX、POTX、

PPSX、PPTM、POTM、PPSM、XML、RTF、PDF、ELF、 XML、MAC、VBE、3DMAX、ISO、

CPIO、RPM、XZ、DEB。

支持检测压缩文件，例如：zip、7z、rar4、rar5、inno、cab、autoit、nsis、gz、tar、iso、mime、

chm、jar、dmg、apk 等。

请求

请求示例

POST /virus/detect HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

 Authorization: Auth String（详情请参见 请求签名  文档）。

https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

请求头

请求体

<Request>

  <Input>

    <Object></Object>

    <Url></Url>

  </Input>

  <Conf>

    <DetectType>Virus</DetectType>

    <Callback></Callback>

  </Conf>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 病毒检测的具体配置项。 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 需要检测的文件信息。 Container 是

Conf Request 检测规则配置。 Container 是

节点名称

（关键

字）

父节点 描述
类

型

是

否

必

选

Object

Requ

est.In

put

存储在 COS 存储桶中的病毒文件名称，例如在目录 test 中的文

件 virus.doc，则文件名称为 test/virus.doc。

注意：Object 和 Url 只能选择其中一种。

S

tr

in

g

是

https://cloud.tencent.com/document/product/436/7728
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Container 类型 Conf 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Url Requ

est.In

put

病毒文件的链接地址，例如 

http://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/virus.doc。

注意：Object 和 Url 只能选择其中一种。

S

tr

in

g

否

节点名称

（关键

字）

父节点 描述
类

型

是

否

必

选

Detect

Type

Requ

est.C

onf

检测的病毒类型，当前固定为：Virus

S

tr

in

g

是

Callbac

k

Requ

est.C

onf

检测结果回调通知到您设置的地址，支持以 http://  或者 

https://  开头的地址，例如： http://www.callback.com

S

tr

in

g

否

响应

响应头

响应体

<Response>

  <JobsDetail>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

  </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 病毒检测返回的具体响应内容。 Container

https://cloud.tencent.com/document/product/436/7729
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Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 病毒检测任务的详细信息。 Container

节点名
称（关

键字）

父节点 描述
类

型

JobId

Respons

e.JobsD

etail

本次病毒检测任务的 ID。

S

tr

in

g

State

Respons

e.JobsD

etail

病毒检测任务的状态，值为 Submitted（已提交检测）、Success

（检测成功）、Failed（检测失败）、Auditing（检测中）其中一个

S
tr

in

g

Creati

onTim

e

Respons

e.JobsD

etail

病毒检测任务的创建时间。

S

tr

in

g

错误码

实际案例

请求

POST /virus/detect HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

  <Input>

    <Object>a.doc</Object>

  </Input>

  <Conf>

https://cloud.tencent.com/document/product/436/7730
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    <DetectType>Virus</DetectType>

    <Callback>http://callback.com/</Callback>

  </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <JobId>ssb1ca9fc8a3ed11ea834c525400863904</JobId>

    <State>Submitted</State>

    <CreationTime>2021-07-07T12:12:12+0800</CreationTime>

  </JobsDetail>

</Response>
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查询病毒检测任务结果
最近更新时间：2023-07-27 16:37:32

本接口用于查询一个病毒检测任务的状态或结果。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /virus/detect/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

 Authorization: Auth String （详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

响应体

<Response>

  <JobsDetail>

    <Code></Code>

    <Message></Message>

    <JobId></JobId>

    <State></State>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7778
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

    <CreationTime></CreationTime>

    <Object></Object>

    <Suggestion></Suggestion>

    <DetectDetail>

      <Result>  

        <VirusName></VirusName>

      </Result>

      <Result>  

        <FileName></FileName>

        <VirusName></VirusName>

      </Result>

    </DetectDetail>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 病毒检测任务结果。 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 病毒检测任务的详细信息。 Container

节点名称

（关键字）
父节点 描述 类型

Code
Response.Jo

bsDetail
错误码，只有 State 为 Failed 时有意义。 String

Message
Response.Jo

bsDetail
错误描述，只有 State 为 Failed 时有意义。 String

JobId
Response.Jo

bsDetail
本次病毒检测任务的 ID。 String

State
Response.Jo

bsDetail

病毒检测任务的状态，值为 Submitted（已提交检

测）、Success（检测成功）、Failed（检测失

败）、Auditing（检测中）其中一个。

String
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Container 节点 DetectDetail 的内容：

Array 节点 Result 的内容：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

CreationT

ime

Response.Jo

bsDetail

病毒检测任务的创建时间。 String

Object
Response.Jo
bsDetail

检测的文件为存储在 COS 中的文件时，该字段表示本
次检测的文件名称。

String

Url
Response.Jo

bsDetail

检测的文件为一条文件链接时，该字段表示本次检测的

文件链接。
String

Suggestio

n

Response.Jo

bsDetail

该字段表示本次判定的检测结果，您可以根据该结果，

进行后续的操作；建议您按照业务所需，对不同的检测

结果进行相应处理。有效值：normal（检测正常），

block （检测到文件含有病毒）。

String

DetectDe

tail

Response.Jo

bsDetail
本次检测的详细信息。

Contain

er 

Array

节点名称（关键

字）
父节点 描述

类

型

Result
Response.JobsDetail.De

tectDetail

单个文件的检测结果，可能有多个结

果。

Arr

ay

节点名称（关键

字）
父节点 描述

类

型

VirusName
Response.JobsDetail.Dete

ctDetail.Result
检测到的病毒名称。

Str

ing

错误码

实际案例

请求

GET /virus/detect/ssb1ca9fc8a3ed11ea834c525400863904 HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

https://cloud.tencent.com/document/product/436/7730
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <Code>Success</Code>

    <Message>Success</Message>

    <JobId>ss364c726b370211ec8fb35254008618d9</JobId>

    <State>Success</State>

    <CreationTime>2021-07-07T12:12:12+0800</CreationTime>

    <Object>a.doc</Object>

    <Suggestion>block</Suggestion>

    <DetectDetail>

      <Result>

        <FileName>xxx</FileName>

        <VirusName>Bk.YDWebShell.Php.Small.11100752</VirusName>

      </Result>

      <Result>

      <FileName>xxx</FileName>

        <VirusName>Bk.YDWebShell.Php.Small.11100752</VirusName>

      </Result>

      </DetectDetail>  

  </JobsDetail>

</Response>


